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Welcome 
Thank you for choosing Samplitude! 

You now possess one of the most successful complete solutions for professional audio 
editing. This PC-based Digital Audio Workstation (DAW) features extensive application 
options for recording, editing, mixing, media authoring, and mastering. The program stands 
for unique functionality & sound neutrality, outstanding cutting & editing options, perfect 
CD/DVD mastering, and the flexible customization of individual workflows. Also this version 
was developed in close collaboration with musicians, sound engineers, producers, and 
users, it boasts numerous innovative functions as well as incorporating the advanced 
development of tried and tested performance features. 

Samplitude Pro X and Samplitude Pro X Suite are now available as either a 64-bit version 
or 32-bit version. You can continue to rely on the superior sound and absolute phase 
stability of Samplitude. 

In addition to this manual, we also recommend reviewing the "Help" file, which may be 
accessed via the "Help" menu; this includes more information about the individual functions 
in more detail. Please also use the included PDF documents (manual.pdf, Effects_Plug-
ins_and_Instruments.pdf, Hardware_Controller.pdf, Tutorials.pdf) for further 
information. 

You can also visit our support area and the user forum online at 
http://www.samplitude.com to find out more. 

The Samplitude team 
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System Requirements 
64-Bit Version. Should I switch? 
By switching to the 64-bit version you increase the available amount of RAM On a 32-bit 
system the upper limit of addressable memory is 3.5 GB, for many programs it's only 2 
GB. In contrast on a 64-bit system the theoretical upper limit is a lot higher, namely 264 = 
16 Exabytes. Practical values are 16 GB for Windows 7 Home/Premium and 192 GB for 
Windows 7 Professional/Ultimate. If you work with very large projects or memory-intensive 
VST instruments such as samples, it is recommendable to change to a 64-bit system.  
Before changing to a 64-bit system make sure that your computer has at least 4 GB of 
virtual memory and that 64-bit drivers are available for connected devices (soundcards, 
controllers etc). 

 

Samplitude on Windows x64 (64-Bit) 
If you have installed the 64-bit version of Windows on your system you can use Samplitude 
as a 64-bit or 32-bit version. The internal VST bridge makes it possible to use both 32- and 
64-bit plug-ins. 

Be aware that certain functions and technology will only be available when using Windows 
x64. Find more info on our website. 

 

Samplitude on Windows x86 (32-Bit) 
If you have installed the 32-bit version of Windows on your system you can only use 32-bit 
version of Samplitude. 

 

General system requirements 
 1 GB RAM for Windows XP; 1GB RAM for Windows Vista/Windows 7 32-Bit; 4GB RAM 

for Windows Vista/Windows 7 64-Bit 
 Recommended: Windows 7 
 500 MB disk space on hard disk for minimal installation 
 Graphics card with a minimum resolution: 1024 x 768  
 ASIO and/or WDM-compatible sound card 
 DVD-ROM drive 
 Optional: CD-/DVD burner, MIDI interface 
Samplitude is compatible with Windows 7. 

 

Hard disk 
The maximum number of audio tracks depends on the rotation speed, access time, and 
data transfer rate of the hard disk. Nowadays, modern UltraDMA hard disks are very fast 
and enable the simultaneous use of many audio tracks. Ideally, your hard disk should have 
a rotation speed of 7200 RPM (or faster) as well as an access time of under 9 milliseconds. 
The audio data should be saved on a hard disk separate from the operating system. 
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Contact 
Product activation: 
For questions about product activation, please contact the Samplitude service team: 

Telephone:  +49 (0) 5741 3455 30 (Mon - Fri 9:00 to 5:00) 

Fax:   +49 (0)5741 310 768 

Or send an email to servicesfr@magix.net 

Support 
Registered users have access to technical support: 

The current terms and conditions for support services apply. 

You can find the terms and conditions and more information at: 

http://rdir.magix.net/?page=DNIZMJ03VM2M 

Sales 
If you have questions regarding licensing and upgrades/crossgrades, please contact our 
sales department: 

Telephone: +49 (0) 5741 3455 25 

Fax:   +49 (0) 5741 3107 68 

Email:   samplitude@magix.net 

Addresses: 

MAGIX AG 
Friedrichstr. 200  
10117 Berlin 

MAGIX AG 
Borsigstrasse 24 
32312 Lübbecke 
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Installation 
1. Place the installation CD into the CD-ROM drive. 

2. The installation program will launch automatically. If it does not, open Explorer and click 
the letter of the DVD drive. Open start.exe by double clicking it. The contents of the 
installation CD are displayed, you may visit our website, or install additional programs such 
as CodeMeter Runtime (view page 23). 

 

3. To begin the installation of Samplitude click on "Install program > Samplitude Pro X / 
Samplitude Pro X Suite". 

4. The Samplitude installation wizard will now start. Just follow the appearing dialogs. If you 
choose the "User defined" installation style, you can also specify the target folder for the 
program and choose whether you want to install additional components such as impulses 
responses too. In the selection screen you will see the necessary memory requirements for 
the installation.  
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After installation you can add or remove components by starting this installation program 
again and selecting/deselecting the respective components. 

Click "Continue" to proceed with the installation. 

Once all the files have been copied to the hard disk, a program group will be created. The 
installation is now complete. Complete the installation by clicking "Finish". 

Next choose the language in which you want to install Samplitude. In the corresponding 
dialog you can choose between English, German, French, Italian and Spanish.  

You are able to change language at any time after the first installation by accessing the 
program folder "Samplitude" and then double clicking the file "Install.cfg"; in the code line 
titled "language=", enter the abbreviation for the desired program language: 

 E or US for English   
 D for German 
 F for French 
 I for Italian 
 ES for Spanish 

If another language code is entered, Samplitude will reinstall in the language featured by 
your Windows system settings.  

After you have saved "Install.cfg", the program will display the desired language version 
the next time it is started.  

After the initial installation, you may start the program at any time via the Windows "Start" 
menu. Under "Programs > MAGIX > Samplitude" you can find start menu entries such as: 

 Samplitude 
 Samplitude Help 
 README 
 License terms 
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Activating Samplitude 
After the program has started, the "Program activation" dialog appears. Select "Register". 

Step 1: Enter the serial number in the next dialog. You will be able to find this on the case 
of the software DVD. 

Step 2: Samplitude calculates a user code once the serial number has been entered.  

The actual activation code is generated from this code later. An online connection to our 
authorization server is necessary for this to work. If your computer has an Internet 
connection, press "Activate online" now. 

Alternatively, you can of course transfer the data onto a separate PC if your studio PC does 
not have an Internet connection. Simply click on the button to create a text file. You can 
then save it on a USB stick or any other portable medium and then copy the content  (the 
entire URL) into the address box of a web browser.  

Activation may even be completed by fax, by email or by filling out the form provided via 
the corresponding button, printing it, and sending it to the address indicated.  

You will now be directed to the support area of the Samplitude website. If problems 
occur with the automatic connection, then open your web browser, type 
http://www.samplitude.com into the address bar, and select "Register product" in the 
support area.  

 

You will now proceed to online product registration. Please use your email address and 
password to log in. If you do not have access to the support portal, register first by filling in 
the required fields. 
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Note: Ensure sure when entering your data that your email address is correct so that we 
will be able to send you the activation code once the registration process has been 
completed. 

 

Enter the user code to register a new product. 

 

Click on "Continue". In the next window, continue with activation by clicking the 
corresponding button. 

The activation code will now be displayed. This will also be sent to your email address 
automatically. Use the activation code to complete the final step: 

Step 3: Now copy the activation code into the corresponding box in the dialog and then 
click on the button beside this to activate.  

Samplitude is now fully authenticated and ready for unrestricted use. 
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On the support page under "My Products", you will now see the most recently activated 
product in the list of registered products: 

 

Note: Please keep your serial number and activation code in a safe place. If you lose it, 
you will not be able to activate the product again. Substantial changes to the hardware 
configuration of your system may require reactivation as it may change the user code. You 
can activate the product three times in total. After that you will have to contact our support. 

 

Use Samplitude with CodeMeter dongle 
If you already own a dongle of a previous version or purchased a dongle through a 
distributor you can use it with the current version of Samplitude: 

1. In the "Program activation" dialog select the "Use dongle" button or in the Menu 
click "Help" then "Dongle Activation". 

2. An information window will inform you of the CodeMeter lease's activation. Shut the 
program down first. 

3. Insert the dongle into a free USB port on the computer. 

4. Restart the program. 

Now Samplitude searches for CodeMeter Runtime and the license entries on startup. If 
your dongle is already registered, Samplitude will start and you may continue with program 
activation. If a license is not found, the "CodeMeter License Update" or "CodeMeter Start 
Wizard" will open.  

If you do not own a CodeMeter dongle, you can purchase one from our distributors. 
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Introduction to Samplitude network installation 
Network installation – configuring the CodeMeter stick 
1. Install a current CodeMeter Runtime on a network server or on a network PC 
(Windows, Linux, Mac OS X). You can find the newest Runtime at www.codemeter.de 

2. Insert the CodeMeter dongle into an available USB port on the server. 

3. Start the CodeMeter Control Center via "Start/Programs/CodeMeter/CodeMeter 
Control Center". 

4. Now open "WebAdmin" in the CodeMeter Control Center on the bottom left. Your 
internet browser will open. 

5. In WebAdmin, go to "Settings", check the option "Start as server", and press "Apply". 

Note: The tab "Contents -> Licenses" features a list of available license numbers. 

6. Return to the CodeMeter Control Center and exit the runtime in the menu via "Exit 
file/CodeMeter". Restart CodeMeter again by clicking "File/Start CodeMeter". 

The server is now ready. 

 

Network installation - Program installation 
The program DVD may now be installed on a Windows client PC. 

You should also install the current CodeMeter Runtime on the Client PCs in order to 
guarantee optimum network performance. 

Please make sure your firewall is set up properly. If you have any problems, please 
deactivate your firewall as a test. 

Register the dongle by first inserting it locally into a client PC or install Samplitude on the 
server and register straight away after starting the program. This is necessary to gain 
access to the latest updates on our homepage www.samplitude.com. 

Please contact our MAGIX support (view page 17) if you have any questions about 
installation or if you require technical support. 
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CodeMeter Control Center 
 You can find the newest Runtime in the download section at www.codemeter.de. 
 Insert the CodeMeter into an available USB port on the server. 
 Start the CodeMeter Control Center via Start/Programs/CodeMeter/CodeMeter 

Control Center. 

 Now open "WebAdmin" in the CodeMeter Control Center on the bottom. Your internet 
browser will open. 

 In WebAdmin go to the register Content > CmStick. In the CmStick line you will see 
your dongle's serial number. 

 If you want to add, change and delete further licenses, click on "Update License" and 
then "Create license request". You can also create license questions or  install license 
updates. 

 Now go back to the CodeMeter Control Center and exit the runtime in the menu via 
"Exit file/CodeMeter". 
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System settings 
Before you start working with Samplitude, you should configure your sound card after 
starting the system for the first time. 

Press the "Y" key on your keyboard or open the global system settings via "File > Program 
preferences > System/Audio". 

This allows you to access information about any connected playback and recording 
devices as well as MIDI, metronome, or program settings, and change them if necessary. 
You may also select the target folders for projects and VST plug-ins and the view options 
and coloring of screen elements. The most important dialogs are explained briefly in the 
following. 

 

Audio setup 
Enter all essential settings for the driver system, buffers, driver communications, and 
monitoring here. 

 

Driver system: A so-called "driver system" is used for the necessary communication 
between Samplitude and your sound card. In order to take full advantage of the program, 
we recommend that you use ASIO. 

MME is the standard Windows multimedia driver system with the best compatibility. It also 
supports 16-bit playback. If you are recording 24/32-bit audio material, then you can use 
MME/WDM. This driver system is suitable for multi-track recordings of up to 64 tracks that 
don't place severe requirements on the monitoring processes. For performance critical 
recordings, this provides greater security compared to ASIO drivers; in any case, for many 
sound cards, multi-track recordings will not be synchronous. 

ASIO: Use a sound card model fitted with ASIO drivers if possible. This offers a number of 
decisive advantages over the MME/WDM driver system: 
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 Lower latency (input/output delay) in terms of the driver system. Resulting response 
times during real-time editing are clearly reduced. This provides the possibility to use the 
software monitoring for inputs and VST instruments. 

 ASIO is intended for editing multi-track recordings featuring several sound cards that are 
all using the same ASIO drivers. The sound cards are synchronized by the ASIO driver. 

 Advanced hardware monitoring options are also available by using ASIO direct 
monitoring. 

 

ASIO settings 
ASIO device: Choose the sound card driver that you would like to work with. The drivers 
for all ASIO devices installed on the system will be listed here. Clicking the "Control panel" 
button opens the settings dialog for the sound card driver. In the display field beside "ASIO 
buffer", you'll see the buffer size and bit rate set for the driver. Samplitude also displays the 
relevant output and input latencies.  

Buffer settings: The VIP object buffer indicates the buffer size for internal processing of 
object effects and economy tracks in hybrid mode.  In every other monitoring mode, the 
buffer size also determines the editing of track effects. With a smaller VIP object buffer size, 
the amount of playback delay also sinks (latency). In these cases, the processor may 
become overloaded, which will result in dropouts during playback. Large buffer sizes 
actually increase stability, but they also increase the latency of the system. The field below 
displays the resulting latency in relation to the buffer settings. 

Tip: The VIP object buffer size should normally be bigger than the ASIO buffer size and be 
set between 1024 and 8096 samples. 

Device Resolution/Driver Communication: This option enables you to select the bit 
resolution for communication with audio devices. The preset value correlates with that of 
the sound card installed on your system. 

The ASIO driver system specifies the bit resolution of the ASIO drivers. Samplitude always 
assumes the bit resolution set for the ASIO drivers. The settings options displayed for 
device resolution/driver communication only specifies the bit depth applied by dithering 
(view page 498). For 32-bit data transfer, dithering is 24-bit or 16-bit. The settings for 32-
bit are recommended especially for Samplitude  

 in case no dithering is intended.  
 in case the input is not fed by the sound card's converter unit, but rather directly by a 

DSP card. 

If MME driver system is selected, Samplitude opens the drivers with the it depth set under 
Device resolution/driver communication. If the output device cannot process the set bit 
resolution, then the corresponding lower resolution will be produced and this will be 
transmitted to the MME driver. 

To specify the plug-in buffer and the path to your VST plug-ins, switch to the dialog 
"System options (Y) > Effects > VST/DirectX/ReWire (view page 176)". 
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Monitoring settings 
Monitoring is defined as listening to the input signals, for example with the intention of 
returning these to the incoming music. The routing of monitor signals is an important and 
complex process that is subject to various requirements. 

In most cases, we recommend using the "Mixer FX Monitoring/Hybrid Engine". 

 

For each selected monitoring setting, a matrix display also opens to indicate which buffer 
sizes are used and what effect the currently selected engine mode has on the latencies. 
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Hybrid Audio Engine 

 

In general, "Hybrid" refers to a system in which two separate technologies are combined 
with one another. Samplitude's Hybrid Audio Engine is a special combination of a Low 
Latency Engine and the classic Samplitude Playback engine with higher latency. The Low 
Latency Engine calculates live input signals and the output of the playback engine. This 
provides short reaction times for calculating track effects and also provides monitoring with 
low latency. The classic playback engine saves resources and enables integration of high-
performance effects. 

The Hybrid Engine provides a combination of Low Latency Engine and a classic engine for 
calculating the track and effects. For example, processor-intensive VST instruments may 
be played via the so-called "Economy" tracks (see below), while only the VST instrument 
that is being recorded is calculated by the Low Latency Engine. 

Go to system settings (shortcut "Y") ->"Audio Setup" -> "Driver System" and select 
"ASIO". "Monitoring settings" features the mode "Mixer FX monitoring/Hybrid Engine". 

Mixer FX monitoring provides audio monitoring including all insert and AUX effects and also 
calculates the playback tracks with the least mount of latency. The entire mixer may 
therefore operate in "Low latency" mode, including the bus and master effects, and it may 
also be used for editing input signals. 
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Economy track 
If you have selected the ASIO Hybrid Engine as the driver system, you may take individual 
tracks from the Low Latency Engine and calculate the track effects with a larger VIP buffer 
size for VIP objects during playback. This saves the system's processor from being 
overloaded. 

To switch a track to "Economy", select the menu item "Track -> Track properties -> 
Economy track". 

 

Economy tracks are indicated by a green dot in the volume display of the mixer's 
corresponding channel and in the track editor. The "Volume" button for the track is framed 
in green. 

Note: The Hybrid Engine compensates for latency of track effects in economy tracks so 
that the total latency of the mixer does not increase for other tracks. 

 

Overview of monitoring/engine modes 
No audio monitoring (peak meter only): Displays the input level, but muted. 

Hardware monitoring: Audio monitoring via sound card or external mixer hardware. This is 
the only monitoring type for MME drivers; for ASIO, many sound cards are able to process 
functions directly such as mute/solo, volume, and pan. For large  ASIO or VIP buffers, 
minimal latency is able to be achieved with just a few samples. Effects may not be applied 
to the input signal. 

Software monitoring/economy engine: Audio monitoring includes the recording track 
levels and software instruments. This monitoring option is only available with ASIO drivers. 
No effects are applied to the input signals, and latency and CPU load remains the same, 
even for complex projects. 

Track FX monitoring: Audio monitoring including the track effects of the recording track. 
This monitoring option is only available when using ASIO drivers. Connected effects may 
therefore be monitored in recording tracks. Bus or master effects will not be included. 

Hardware monitoring/Hybrid Engine: In this case, the complete mixer operates in "Low 
latency" mode. This produces low playback latency. Monitoring of the input signals 
depends on the sound card being used. 

Mixer FX monitoring/Hybrid Engine: The Hybrid Audio Engine enables audio monitoring 
throughout the entire mixer and also calculates playback tracks in the mixer with short 
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latency. You may therefore also mix data from the hard drive with the lowest possible 
playback delay. We recommend this mode for input signals as well as for live mixing with 
hardware controllers, since this guarantees access to all bus and master effects. 

Applies to all monitoring modes: Track effects in the recording track will not be included 
when recording. However, the recorded track may be saved along with all track effects 
afterwards via the "Trackbouncing (view page 456)" function. 

Note: If you use "TotalMix" from RME in combination with a hardware monitoring mode, 
then set the panning law in "TotalMix" to -6dB. This helps ensure that the recording level in 
Samplitude matches the monitoring levels in "TotalMix". 

 

Mode switching 
Tape monitoring (preset): In STOP and RECORD states, the input signal is played; in 
PLAY state, the track content is played. 

Manual monitoring: With the help of the loudspeaker button in the track head or the track 
editor, you can manually switch on the input signal for monitoring. This mode is only 
effective when the ASIO driver system is used. 

Mix input and playback: If you put a check mark here, then you will be able to hear the 
input signal during running playback too, if track monitoring is active. 

Other than the system options in the audio setup, the monitoring settings and switching 
processes are available to you by right clicking "Mon" directly. This displays two more MIDI 
recording options: 

Automatic MIDI record switch on current track: This option ensures that MIDI tracks are 
always ready for recording as soon as they are selected. You can recognize this by the lit-
up pink record buttons. 

Automatic MIDI monitoring (thru): If this option is selected, then every MIDI track which 
you activate for recording will be switched on, i .e. you will always immediately hear the 
input signal for this track. 
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Audio devices 
Select the inputs and outputs (devices) for the installed sound cards used by the program 
in this dialog. 

 

By clicking the box to the left of each respective device, you can activate and deactivate 
them as desired. Set the sequence with the arrow keys. The "Reset" button activates all of 
the devices displayed. For ASIO, only the first 4 stereo channels will be activated 
(standard). If you hold the "Shift" key, then all devices will be activated. Clicking the button 
"Device info" opens the control panel for your sound card. Press "Rename" to customize 
each device name individually. 

 

MIDI setup 
Samplitude offers comprehensive MIDI functions. MIDI files may be imported, inserted, 
edited with an external editor, and played back. In addition to MIDI timecode 
synchronization, the other main use is for accessing external and internal sound sources 
such as synthesizers and VST instruments. External hardware controllers may be accessed 
remotely via MIDI access signals. 

Note: For seamless work with MIDI, please always use the monitoring settings "Track FX 
monitoring", "Hardware monitoring/Hybrid Engine", or "Mixer FX monitoring/Hybrid 
Engine". 
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Global MIDI devices 

 

Open the System options – MIDI via "File > Program preferences > MIDI options" and 
then set the global playback and global record device. The set devices are used to play 
back MIDI files directly, and they are also used for the standard settings for new tracks. 
You can rename the devices at any time.  

 

Record offset 
Enter a recording offset value in milliseconds to determine the time difference which passes 
between a MIDI command and placement in the arrangement.  

Samplitude places played notes in the MIDI object on the right according to the set time, 
i. e. MIDI notes are delayed and displayed later in the timeline. 

 

Retrospective MIDI recording 
Activate the "Retrospective recording" option here for the same function available under 
"Play/Rec -> Retrospective MIDI recording (view page 596)". Samplitude creates a MIDI 
object to the selected, recording-ready MIDI track that may be adjusted in terms of buffer 
length. 

 

Audio/MIDI synchronization 
Force sync specifies how precisely Samplitude synchronizes MIDI tracks with audio 
tracks. On faster systems, this setting should be at 100% in order to achieve the closest 
sync between the MIDI and the audio. . If your system experiences difficulties synchronizing 
the MIDI tracks with the audio tracks, select a lower sync reciprocation value. Normally, 
you will also want to use sample-exact reference times from your audio device (e.g. 
sound card) for audio/MIDI synchronization. 
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Automatic volume fader mode for MIDI tracks 
The behavior of the MIDI track's volume fader is preset to controller 7 (MIDI volume). 

Alternatively, you can also select that "Volume fader" mode should not change for MIDI 
tracks or that the volume fader for MIDI tracks should match the MIDI velocity scaling. New 
MIDI tracks will assume the currently set Volume fader mode (view page 161). 

 

Activate SysEx input 
Selecting this option causes Samplitude to receive SysEx data from external devices. 

 

Use system time for MIDI timestamps 
If this option is activated, the MIDI device driver's timestamp will be ignored. This is helpful 
if drivers provide a timestamp that is not synchronized with the audio or is completely 
incorrect.  

This function detects invalid driver timestamps and then falls back to the system time 
automatically. This helps fix MIDI recording problems with MIDI devices. 

 

Link VIP Q and MIDI editor Q 
This option links the grid or quantization settings between the VIP and MIDI editor, i.e. 
changing the grid/quantization settings in the VIP will automatically be assumed for the 
grid/quantization settings in the MIDI editor and vice versa. 

 

Deactivate all MIDI functions 
You can switch off all MIDI functions in the MIDI projects or VIP projects. In this case, the 
MIDI menu is removed from the menu list and the MIDI functions in the arranger, track 
editor, and track settings dialog are no longer available. 

 

Note On Chasing 
"Note On Chasing" has the effect that held MIDI notes are also played back when they 
receive their "Note On" command in the arrangement before playback starts . The MIDI 
level activity display also for chased notes. 

 

Send "All Notes Off" to VST instruments 
As an alternative to the "All Notes Off" mechanism, an individual "Note Off" mechanism is 
available for VST instruments, since "All Notes Off" is ignored by some VST instruments. 
You can completely shut off "All Notes Off" for VSTis in the MIDI systems settings. 

 

General 
Shortcut: I, Ctrl + Shift + ´ 
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Here you can see the most important information about the current project at a glance. 
This includes beat/BPM, recording, editing, and snap/grid settings. 

 
 

Project options– Project 
Sample rate (Hz): This indicates the project's sample rate. You can also change the 
sample rate for the project and adjust Audio and MIDI objects to the modified sample rate. 

Damping: Set level decreases in 6 dB stages. Volume reduction can be necessary when 
working on multitrack virtual projects if you are working with 16-bit internal precision. 

0 dB editing is definitely possible when working with 32-bit float internal accuracy, since 
this prevents internal overmodulation. Simply set the sum levels to 0 dB via the master 
mixer faders. 

Note: Bear in mind that Samplitude reduces the volume of wave projects by the value set 
in the virtual project. This way you can quickly toggle between virtual projects and wave 
projects without the volume level changing. If, on the other hand, a wave project is the only 
project opened (that is, without the virtual project it uses), it will always be played at 
maximum volume. 

Project start time: Specify the project's starting time here. 

Project length: The project length is displayed here in bars and beats. 

 

System options - Recording/Editing 
Here you'll find various presets for recording and editing: 

 Lock recorded Objects: Protects against unintentional moving of recorded objects. 
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 Group object according to Multirecord: Objects that belong together will be grouped in a 
multitrack recording. 

 Offline audio editing (only for Wave projects): Detailed information about destructive 
editing is available in the chapter"Working in the project window -> Samplitude as a 
wave editor (view page 108)". 

 Auto Crossfade Mode: Use this function to activate a mode which adds a crossfade to 
all newly recorded objects created from cuts or from wave projects which were dragged 
into your project. Every object may be assigned a standard fade-in, and this can be 
edited via the "Object editor fade" menu via "Get/set global crossfade". If two objects 
overlap in this mode, a realtime crossfade will occur at the intersection. 

 CD arrange mode: If this is activated, Samplitude arranges newly added objects to insert 
a Red Book Standard-compatible pause between the objects. 

 

Project options - Bar/BPM 
Bar/BPM/PPQ: Enter the bar type (counter/signature), the tempo in beats per minute 
(BPM), and the timer resolution in peaks per quarter (PPQ/clicks per quarter note) here. 

Get BPM from selected range: If you enter the number of beats into the field beside 
"Selected range has beats:", then Samplitude will calculate the BPM based on the 
selected range when the button is pressed. 

 

Project options – Snap/Grid 
Snap to: Switches the global snap on/off. 

Objects: This option activates the object grid. This lets objects snap exactly to the edges 
of other objects. 

Range: Activates the range grid and enables the current range to be used as the basis 
for snapping. 

Beats/bars: Activates a grid with bars as the basis for snapping. 

Bar grid (relative): Activates a grid with bars as the basis for snapping. The selected 
object will maintain a relative distance to the snap markings when moved. 

Grid/frames: Activates the frame-based grid. 

Snap offset to project start: Sets the snap offset relative to the beginning of the project. 
"Use current position for offset" specifies the current position as the grid's zero position. 

Show grid: If a check is placed here, then the grid will be displayed for the project 
according to the unit set in the selection box beside it. 

Use snap offset also for grid: The snap offset is used as a reference size for the grid. 

 

Project options - Standard pitch for tuner (Hz) 
This field indicates a standard pitch of A at 440 Hz. You can change this value anytime you 
like. 
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What's new in Samplitude Pro X/Pro X Suite? 
64 Bit Version 
 Sequoia_x64.exe or. Sam_x64.exe with 64 Bit memory addressing for 64 Bit-operating 

systems (view page 16), i. e. no 2 GB limit. 
 VST plug-in handling: Automatic "bridge" handling i. e. you can load 32-bit plug-ins in 

the 64-bit system and vice versa. 
 You can change projects from 32-bit to 64-bit. 
 In the 32.bit version, by pressing the shift key, the 32-bit plug-in will run with the bridge - 

meaning that there is more memory available in the 32-bit version. 

Restrictions:  

  -Restricted video functions (only MXV and WMV) 
  -No Rewire 
  -VST Bridge: no VST MIDI Out Support 
 

Tempo-Map and Tempo track 
Changes in tempo can be made using the marker or graphically using aTempo track (view 
page 305). A tempo track contains the project's tempo map as an automation curve.  

The tempo map displays all the tempo markers and determines the musical positioning 
for each time position.  

In the Tempo-Map dialog (view page 308) you can specify which objects or markers in 
your position should be adjusted when tempo changes are made. 

 

Revised visualizations 
The visualizations (view page 798)have been completely reworked. They have a new 
design. 

 

The new interface allows you to design multi-visualizations individually. You can integrate 
the visualization interface into the Docking Bay (view page 51) or open it in its own window. 
A surround visualization (view page 806) is now also built in. 
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SE-cleaning effects 
DeClipper SE, DeClicker/Decrackler SE, DeHisser SE, DeNoiser SE are called the new 
SE-Cleaning-effects. These restoration tools (view page 666)offer a range of functions that 
are straightforward to use, practical on a day to day basis. With as few faders and little 
space on the screen you get an overview of multiple instances in the project. The SE 
restoration tools in Samplitude don't use many resources. With the optional "Cleaning / 
Restoration Suite" you have access to the full versions with an enhanced range of 
functions. 

 

Advanced Docking-/Manager concept 
Advanced Docking-/Manager concept 

In addition to the Manager windows now Visualization, Time display, Transport 
console, Sound pool, Object Editor and MIDI Editor are grouped by default in a 
"Docker" (view page 50). This allows you to individually choose the display windows you 
need for your workflow. 

 

Advanced Docking concept (view page 51) 

Moreover you can dock certain dialogs and windows to areas in the VIP interface or to the 
docking bay.  

Undocked windows may be docked to the areas provided in the VIP by double clicking the 
title bar or by clicking the title bar and moving with the "Ctrl" key pressed. 

 

Vice versa, an individual window may be undocked by clicking the title bar or by double 
clicking the handle area. 
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Revised Object Editor 
Object Editor (view page 114) and MIDI Object Editor (view page 244) have been revised 
and have new graphic interface designs. 

 Integration in the new docker   
  "To all" is now a status button: 
- Changes (Volume, Fades, EQ....) are immediately transferred  

- Changes in effect dialogs after closing the editor 

- edited plug-ins are transferred individually   

- volume changes are transferred relatively 

- EQ is always completely transferred  

 Configure using right click 
 Mute/Inverse button for individual channels available in the Context menu 
 Volume fader up to +12 dB 
 Comments field 
 4 slots for copy & paste purposes (global)  
 Solo button   
 Object Automation for EQ, Pan (not for 2-channel volume / pan), Object-surround 

(Drawing of a range is supported) 
 FX presets (*.obj) 
 Offline FX menu 

 

Advanced essentialFX Suite 
The essentialFX Suite (view page 685) has been endowed with 10 first-class effect plug-ins 
and is suited for all every day studio applications. In addition to high-quality algorithms, 
great importance was placed on practical icons for the individual parameters and the 
effectiveness of the function. The uniform operation concept, combined with low resources 
demands for top quality production, makes the essentialFX suite a collection of high-quality 
audio tools for all-around tasks. 

The essentialFX Suite consists of the following plug-ins: 

efx_Compressor 
Classic compressor with soft clip function and advanced sidechain filter feature. 

eFX_Gate 
Flexible gate with optional soft knee characteristics and sidechain filter function for ducking 
effects. 

eFX_DeEsser 
Dynamic plug-in for reducing unwanted sibilants in recordings containing speech and 
vocals.  
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eFX_VocalStrip 
Optimized channel strip with compressor, DeEsser, gate, Highpass filter and one shaping 
for recordings containing vocals or speech.  

eFX_Tubestage 
Authentic analog tube amplifier with oversampling mode simulation. 

eFX_Reverb 
Reverb plug-in for creating versatile reverb effects - from short to long reverberations.  

eFX_StereoDelay 
Stereo delay with individually adjustable delays for both channels, as well as tempo sync 
function.   

eFX_ChorusFlanger 
Traditional chorus/flanger effect with adjustable rate, depth, feedback and mix settings. 

eFX_Phaser 
Classic phaser effect with adjustable rate, depth, feedback and mix settings. 

eFX_TremoloPan 
Tremolo effect with optional tempo sync function and parameters for rate, shape, tremolo 
and panorama. 

 

Soundpool manager 
In the Docker's Soundpool Manager (view page 157) you can integrate, listen to and 
arrange loops effortlessly. 

 

Independence 
Included in the package is the "Independence" sampler with 12 GB of content for 
Samplitude Pro X and 70 GB Content for Samplitude Pro X suite or Sequoia.  

This gives you access to hundreds of customized, music based software functions. The 
intuitive user interface and file management system, the ultra fast streaming integration, 
multi-core processor support and the Auto-RAM-Cleaner will enable you to store and use 
an huge number of instruments in seconds. 

Note: Detailed information about "Independence" can be found in the PDF document. 

 

Content Packs 
 The Content Pack 1 puts 3 GB of current drum-, percussion-, guitars- , bass-, brass-, 

vocals-, woodwinds-, piano-, harp- and effect-loops at your disposal for use with 
Samplitude Pro X. The loops are divided into numerous music styles and varying 
tempos (BPM). 

 The Content Pack 2 makes 4 GB of content categorized by music styles, instruments 
and BPM available for Samplitude Pro X Suite and Sequoia 12. 
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True Resynthesis Timestretching (TRTS) (offline) 
In "True Resynthesis Time Stretching (TRTS)" the signal is broken down into individual 
components, with the amplitude and frequency modulated oscillators - simple synthesizers 
-are reproduced faithfully. If these synths play longer or shorter a Timestretching effect will 
be created. 

You can do Timeline stretching (view page 651) using TRTS. The typical compression 
artifacts and associated non-uniformities will not occur. The algorithm is universally 
applicable. Due to linear work practices TRTS is particularly suitable for very small and very 
large Timestretch factors. 

 

Spectral view 
 The Spectral view (view page 496) is split for the left and right stereo channels (stereo 

representation) 
 Activate Spectral view by going to "File > Program Preferences > System/Audio > 

Design > View options". 
 Spectral display and Comparisonics view are now available for individual VIP objects: 

"Object > Object color/name" 
 Various colour palettes are available 
 Graphical data is saved as *hs files. 

 

Spectral mode 

Menu "Edit > Mouse mode > Spectral mode" 

With the new "Spectral mode (view page 72)" you can remove noise from a track object, 
without the wanted signal being audibly influenced. Editing can be done directly in the 
Arranger window by dragging a range. 

 

Multifunction input field with help-function 
Command search bar for Finding menu commands and help topics (view page 78) 

 A maximum of five results from the main menu are displayed, which can be directly 
selected.  

 Moreover up to four results will be displayed in the help index. 
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Controller Artist Series support 

 

Samplitude supports the Controller Artist Series (view page 374). Artist Mix, Artist Control 
and Artist Transport are all part of this. These controllers are controlled using the EUCON 
protocol, which can be activated in the Hardware Controller Settings (view page 360). 

Note: Windows 7 is a requirement if you want to use the Artist series. 

 

New MIDI functions 
The MIDI Editor is now integrated into the Docker (view page 50) in the new version. 

Transposition: (view page 253) Here you can transpose the pitch of selected events into 
half steps. 

MIDI Timestretching: With this function you can make various changes to selected 
events, e.g  

 double the tempo 
 halve the tempo 
 scale to range length. 
 manual stretch. This allows you to enter individual values in the Stretch Factor field. 

Reverse: With this function you can reverse the playback sequence. The events move by a 
further quantization step each time they are reversed again. 

Mirror melody: This function mirrors the selected events in terms of the pitch of the re-
selected event. 

Further new MIDI features: 

 New Snap setting bars (view page 66) for bar snap and quantization. 
 Only one button for the mouse mode "Pen". Now there is a graphic selection menu for 

pen mode. 
 Score anti-aliasing (binds, beams). 
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New functions 
 Access to automation directly in the effect dialog: In many effect dialogs you now have 

direct access to the automation button and therefore to the automation menu. This is 
made possible by a newly created header (view page 179) in the respective dialogs, 
which also provide presets and, where needed, A / B comparison functions. 

 The new command Menu Edit > Tempo > Create click track creates an audio track, 
which contains all metronome click as objects. 

 BitMachine (view page 663) for creating „Lo-Fi“-Sound. 
 AAF/OMF Import and Export. Export: File > Export project as AAF/OMF (view page 

461) Import: File > Open > Import AAF/OMF (view page 441) 

 

 EUCONTM Interface for Euphonix Controller Artist Series (view page 360). 
 Surround functions (view page 224) for Samplitude Pro X. 

 

What's new in 11.2? 
Options administration/Remote/User administration 

Note: If you work with "Remote Logins", please extract the contents from 
"RemoteSetupTools.zip" in your remote directory, because changes were made to 
"AdminCreator.exe" as well as "remote_setup_copy_from_server.bat". 

 User-specific templates are now stored in "fx-preset/user_name/templates". 
 If user-specific templates are available, they will only be shown to the user when creating 

a new project. If these templates don't exist then the templates of the local admin will be 
displayed. 

 The auto jam session continues working with the templates in the template directory of 
the local admin, not with the user-specific path. 

 Templates are now also saved in the INZ container. If there are no user specific 
templates available, the templates of the local admin will be saved. 

 When importing INZ containers, previously available user-specific templates are deleted.  
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 "Recent Files list" and work paths for remote users are saved separately for each remote 
user in the "audio.ini" of the admin (in other sections) 

 Current "Recent files list" is kept if you import INZ containers. You will only encounter 
troubles if the "audio.ini" e. g. is overwritten by an admin when loading INZ containers. 

 Query when deleting a user profile in user administration. 

 

New functions 
 Cue mode: Objects that are split by crossfades of hard cuts are seen as a group. 
 Clipstore: When transferring clips that contain multiple objects into the VIP, all clips will 

be renamed with the clip name 
 Marker manager: double clicking on the marker opens the Name Editor 
 Object manager: Dragging & dropping objects in the Arranger is possible 
 Object manager: Context menu entry "Duplicate object" 
 Root VIP editing now also for surround objects 
 Hardware Controller: updated HUI templates (HUI, Mackie HUI, DM2000, O2R) 
 

 

What’s New in Version 11.1? 
Multi-track selection 
To execute the multi-track selection (view page 98) option, select multiple tracks by 
clicking the respective track numbers/track ranges while holding down the "Ctrl" key 
or the "Shift" key. 

 Track box context menu: "Track properties > Group track controls" 

In order to remove a track from an existing multi-track selection, hold down the "Ctrl" 
key and click the track name.  

In order to clear the selection, click a track below the selection or use the 

 Track box context menu: "Track > Ungroup track controls" 

Note: Multi-channel selection in the mixer functions exactly like multi-track selection in the 
arranger, i.e. by clicking the track number/name while holding down the "Ctrl" key or 
"Shift". In order to clear a group of channels, click a channel before than the selection. 
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Multi-language version – one EXE for all languages 
The program will be installed in the language corresponding with your Windows system 
settings. After installation, you may select freely between English, German, French, 
Spanish, and Italian by accessing the program folder "Samplitude" and then double 
clicking the file "Install.cfg"; in the code line titled "language=", enter the abbreviation for 
the desired program language: 

 E or US for English  
 D for German 
 F for French 
 I for Italian 
 ES for Spanish 

If another language code is entered, Samplitude will reinstall in the language featured by 
your Windows system settings.  

After you have saved "Install.cfg", the program will display the desired language version 
the next time it is started.  

 

Options management 
 During loading, the current state will be saved as a "Backup" (view page 483). 
 During saving, check boxes and the file name may be preset. 
 Check boxes may be changed during loading. 
 Loading via the "Load and restart" button. 

INI patches for easily setting INI options 

 INI patches: (view page 483) Collection of diverse INI entries in the "Customize" folder. 
 INI patches: Load via the "Load" button in "Option administration". 
 INI patches: Displays a short info text. 
 INI patch: Option to apply or reset. 

 

Metronome 
 New option for metronome pre-counting with or without VIP playback: "Play VIP during 

pre-count (view page 84)" 
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Vandal 
(Vandal in Samplitude Pro X Suite/Vandal SE in Samplitude Pro X) 

 New presets and floor effects (view page 750) 

Visit http://www.vandalamps.com for more information. 

Version limits of Vandal SE versus Vandal: 

1. The SE version of Vandal only includes the following stomp boxes (floor effects): 

 La Crema Overdrive 
 Hellfire Distortion 
 Chorus 
 PhaseShifter/tremolo 

2.MIDI scenes & MIDI control are not included. 

3.Guitar and bass amp, detailed microphone settings, and pre and power amps cannot be 
selected manually, rather only via "Presets & templates". 

4. The SE version does not feature "Scene memory"; in this case, a preset only includes 
one individual scene. If a preset was created using the full version, then only the first scene 
will be used. 

 

MIDI 
 Updated presets for "Create MIDI object": MIDI drums and MIDI phrases (filter sweep, 6 

octave sequence, etc.) 
 New MIDI tracks now assume the set volume fader mode (view page 161) 
 Groove template selection is now in the drum editor and drum map editor as well 
 <ALL> may now be selected as the MIDI input device (view page 88) for a track 
 Improved SMF MIDI file import (view page 242)/export (view page 456) 

 

System options > Design > View options > VIP 
The system options also allow you to set the following parameters via "Design > View 
options > VIP (view page 491)": 

 CPU peak meter: If this option is activated, the peak meter in the track header 
displays the CPU load per track. The upper peak meter displays the load on the 
Economy Engine for the left channel, while the peak meter below this displays the load 
on the Low Latency Engine for the right channel. In this case, a display value of 0dB 
equals a load of 100%.  

 Compressed wave display: This display option causes the waveform to be distorted 
according to the zoom level. The transition from silence (less than –90 dB) to signals with 
lower levels (e.g. noise) is also shown more clearly. 
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System options -> Performance 
 The maximum CPU number for audio processing may now be set via !System options > 

Performance (view page 477)" (new standard: 3) 

 

New functions 
 New menu command "Tempo > Hard quantize object position" 
 New menu command "Tempo > Soft quantize object position" 
 The "Insert" buttons on the mixer (view page 158) now activate all effects (effects 

inserts + plug-ins) for the individual tracks as well as in the master module. A visual 
indicator (*) is displayed for plug-ins that were previously active and are active the next 
time "Insert" button is pressed. For old projects with a deactivated "FX" button, this is 
activated as the individual plug-ins are deactivated. 

 The upper "AUX" button in the mixer now switches all AUX paths between active and 
inactive, effectively making it an AUX bypass switch. 

 Object mode "Lock objects (view page 77)": Holding down the "Alt" key at the same 
time temporarily removes the mode for the selected objects. 

 CD-Text character count in the CD-Text editor 
 File manager (view page 138): Folders may now be deleted in the directory tree 
 Improved recording performance 
 Improved synchronization (view page 347) with SMPTE and APP 
 Additional improvements to details and bug fixes 
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Screen Elements 
What is a VIP? 
VIP (virtual project) refers to the basic project window for a Samplitude project. This 
provides a graphical framework for you to edit the project and navigate throughout the 
arrangement. The VIP covers all toolbars and buttons, the arranger, track header, track 
editor, transport console, and status display. 

Furthermore, .vip is the file extension for virtual projects in Samplitude. 

 

Program interface – Overview 
VIP window: 

 
 

1. Title bar: The title bar is located at the top of the window. This contains the name of the 
application and the project. To move the entire window, simply click the title bar and move 
it as desired. You may also move dialog windows by dragging them by their title bar. 

 

2. Menu bar: Menus are located directly beneath Samplitude's title bar. Every menu entry 
may be assigned to a keyboard shortcut. Click the icon in the above left of the mixer's title 
bar or in the arranger to select different skins for the program. 
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Detailed information about how to use menu items and keyboard shortcuts is provided in 
the menu reference, help file, or in the "manual.pdf" documentation under "Menu File -> 
Program Preferences -> Edit keyboard shortcuts and menus (view page 488)". 

 

3. Toolbars: Toolbars consist of buttons that execute specific commands or specify 
states. They are ordered above and below the arranger in groups. You can move a toolbar 
group by clicking on the left separator and dragging with the mouse.  

Right clicking an icon opens a context menu. Hide the selected bar or show large 
symbols in it. "Edit Toolbar" opens a dialog to individually remove current buttons or add 
other available buttons for the selected bar.  

 

The command "Edit Workspace" may also be used to activate and edit the individual 
toolbars and to show or hide menu items.  

More information about the toolbars is available in "Toolbars - Overview". 

The context menu entries "Camo", "Canis", "Star Gray", "Samplitude 10", "Samplitude 
9" and "Samplitude 8" provide options concerning how the buttons are displayed (view 
page 481).  

 

4. Grid/marker bar: The grid/marker bars are positioned above the first track in the VIP. In 
the upper half (if two grid bars are displayed between both grid bars), you'll find the marker 
bar, where the markers and playback cursors can be positioned. The grid bars display the 
project time in relation to the selected measurement unit. You can also open various 
ranges. You can use two grid bars, for example one for beats and one for SMPTE time. To 
show both grids, move the play cursor by dragging with it the mouse across the upper 
grid. If only one grid is displayed, then the play cursor can be moved by dragging the 
mouse in the marker bar. 
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Display second grid bar: Use the grid bar's context menu to activate a second grid bar 
in the arranger and set your own measurement unit (2. Show grid bar).  

 

Both grid bar positions can be exchanged (Swap grid). If you select "Independent time 
format" in the transport window, the upper grid will adapt to a chosen BPM grid, unlike the 
lower grid.  

 

This way it's possible to select an SMPTE format independent of the project frame rate, 
which provides an overview of two different SMPTE displays. The option "Activate 
docking for transport window" switches on docking options for the transport window. 

 

5. Arranger: Displays the VIP project tracks together with the audio and MIDI objects. 

There are many commands for moving (scrolling (view page 101)) the visible portion of the 
arranger and customizing its size (zooming (view page 99)). These can be opened via the 
"View" menu, the grid/marker bar, and the shortcut keys. 

 

6. Track header: The track header is at the left in front of a VIP track. Besides the track 
name, it contains various control elements, like mixer functions and automation. More 
information about the individual controls of the track header can be found in the track 
header (view page 60) overview. 

 

7. Track editor 

 

8. Setup / Zoom / Position buttons: This part of the work area helps manage each of the 
four different setup and zoom settings (range and zoom settings of the VIP window shown 
in the project clip). Similarly, the "Pos", "Len", "End", "Mouse", and "Mixer" fields can be 
configured by right clicking them. 
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9. Status bar: The status bar appears at the bottom border of the VIP window. Here, you 
will find about CPU overload, latency, buffer, and current operations like loading, saving, 
effect calculation, etc. You can open the status bar also via menu "View >  Toolbars > 
Status bar". 

 

10. Transport console (view page 52) 

 

11. Manager / Docker (view page 50) 

 

12. Visualization (view page 798) 

 

Managers / Docker 

Menu "View > Managers / Docker" 

In addition to the manager windows (view page 138) now visualization, time display, 
transport console, sound pool, object editor and MIDI editor are grouped as a tab window 
by default in a "Docker". This allows you to individually choose the display windows you 
need for your workflow. 

 

Every docker can be minimized by minimizing an opened tab window. If you click a tab 
again, the docker will be maximized again. 

 

Using the "+" key, you can open a new tab in the docker. 

   

To remove a listed tab window again, just drag this out of the Docker lead or double-click 
on the appropriate tab window. The corresponding dialog window will now appear in its 
own window. 

You can return the window to the docker through repeated double clicks or by dragging 
the window onto the tab bar. 
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Docking 
In Samplitude you can dock certain dialogs and windows to areas in the VIP interface or to 
the docking bay. The docking handle ranges for docking and undocking are found at the 
top of the respective window and, in a docked state are distinguished from the selected 
skin by a bar or double line. 

 

In a undocked state the corresponding dialog appears with a conventional title bar. 

 

Undocked windows may be docked to the areas provided in the VIP by double clicking the 
title bar or by clicking the title bar and moving with the "Ctrl" key pressed. When moving 
windows an arrow symbol appears on the interface. Move an undocked window with the 
mouse pointer onto one of the arrow symbols this results in the area which docks when 
you release being displayed as a transparent rectangle. 
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Vice versa, an individual window may be uncoupled by clicking the title bar or by double 
clicking the handle area. 

 

Also inside the docking bay you can place and arrange new windows. Move the respective 
window using the mouse pointer onto one of the arrow symbols in the docking bay. 

 

The docking function is available for the following windows:  

 Manager 
 Visualization 
 Time display 
 Soundpool 
 Object Editor 
 MIDI-Editor 
 Transport console 
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Transport console 
Shortcut:  Ctrl + Shift + T 

 

Transport console with "Camo" skin 

The transport console contains the most important commands for playback, recording, 
and positioning. 

 

Transport console with "Star Gray" skin 

Play / Stop / Fast forward / Rewind buttons: Use these buttons to control the 
positioning like a cassette player. 

Right mouse click on play button: Opens the playback parameter window for stereo 
master operation. This allows you to specify the sample rate, playback device, and 
scrubbing/varipitch options, etc. 

Right mouse click on record button: This opens a dialog for setting recording options. 
You may also start stereo or mono recording from here directly. 

Record button: This button begins recording for all active tracks, i. e. tracks featuring a 
red "R" button in the track box. 

Time display: Displays the current playback position. The unit of measurement can be 
selected by clicking on the small triangle. 

Range buttons: You can save ranges with buttons "1" and "2". Using the arrow symbol 
you can open previously used ranges. 

L/E time display:  Displays the length and end position of an area and can be edited by 
double clicking. 

"Marker" button: This button opens the marker manager for further marker editing. 

More information can be found in the chapter "Manager -> Marker manager" (view page 
147). 
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Marker buttons 1...12: The current play position may be saved to one of the 12 marker 
buttons by clicking. If one position has been saved, the marker will appear bright. Another 
click on the same marker moves the play position to the corresponding marker. Right-
clicking deletes the saved marker again, making it available again to be allocated. 

Recording modes: Here you can set up the appropriate recording mode. 

Standard mode (playback while recording): This is the typical recording mode for multi-
track productions. Here, the currently active tracks are recorded. The other tracks are also 
played back. 

Record without playback:  If this option is selected, playback of existing objects is 
deactivated during recording, and the play cursor remains at the beginning of the 
recording. Playback may be started manually, for example in case "read after write" is 
required. Set the play cursor at a different position and start playback by pressing the 
"Play" button. The recording will not be interrupted by doing so. This way, changes to 
previously recorded material can be made without affecting the recording process. 

Only Sequoia:  In record mode  Record without playback/read after write You can use 
the export function even during recording. 

Punch marker mode: In this mode, only the range between the punch start marker and 
punch end marker is recorded. This setting corresponds to the "Punch" button (see below). 

Auto Jam Session: Opens the "Auto Jam Session“ window. 

Detailed information about "Auto JamSession" is available in the reference manual, the help 
file, and in the "manual.pdf" documentation under "Playback -> Auto JamSession (view 
page 591)" 

"Mon" button: This button activates the Samplitude's record monitoring feature; all tracks 
with an active "R" button display the relevant input signals in the peak meters. Right 
clicking the "REC M" button lets you select from the various monitoring modes. 

Please also read the chapter "System options > Global audio options > Monitoring settings 
(view page 27)" for more details. 

"Sync" button: This button opens the dialog with the synchronization setup. 

More information is available in the chapter "Synchronization (view page 345)". 

"Punch" button:  This button switches Samplitude into Punch Marker mode. In this mode, 
only the range between the punch starter marker and the punch end marker is recorded. 

If you have not previously created a punch marker, one will be set automatically when you 
press the record button. If the recording is started when punch markers already exist, the 
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recording button will flash until the start marker has been reached as well as once the end 
marker has been passed. It will light continuously during the actual recording between the 
markers. End the punch recording by pressing the record button again; playback will not 
be interrupted. Playback will stop if you press the "Stop" button. 

"In" button: This button sets the starting point for a Punch recording. 
"Out" button: This button sets the end point for a Punch recording. 

Additional Punch In/Out markers can be set by holding down the Alt key. 

"Loop" button: Use this to switch into Loop mode, that is, a specific range is played 
repeatedly. 

MIDI record modes: The following MIDI record modes are available: normal, overdub, 
multi-overdub, and replace. The different modes determine how the newly recorded MIDI 
files will be added to the VIP.  

More information can be found in the chapter "Samplitudequick start -> Workshop: 
recording (view page 80)". 

Tempo section:  The tempo section displays the tempo at the current position. You may 
change the playback speed and the tempo of the complete arrangement. All objects in the 
VIP are adjusted to the most recent speed value by moving them or stretching them. 

 The "Beat grid/snap (view page 66)" button enables you to activate and display 
the beat grid. 

 Use the "CLICK" button to switch on the metronome click. Right clicking the 
"CLICK" button opens the metronome options window (view page 84) to 
configure the pre-counter and click volume. 

Scrub control: The scrub control wheel can be used to adjust playback speed. This can 
be used to find audio passages. 

The buttons beneath it can be used to start playback forwards and backwards at a slower 
speed. This too can be used to improve control over audio passages, like editing out 
crackles or other errors later. 
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Track Editor 
Located at the left border of the arrangement window, the track editor enables quick 
access to all of the most important track parameters of the selected track. Record and 
monitoring status, volume, panorama, MIDI/audio in and outputs, plug-ins, AUX 
sends, and EQ settings are displayed in well-arranged sections and can also be edited 
via this view. All relevant settings of the corresponding track may be viewed without 
opening the mixer or the track view in the arranger window. 

Open the track editor via the corresponding track button at the bottom-left of the arranger 
window beside the "Workspace" selection field or via the menu item "View -> Track editor". 

 

1. Track number and track name:  Double clicking on the track names allows them to be 
edited. Right clicking the track name opens the "Track Options" dialog. 
2. "S" button: Mutes all tracks except the selected one (track solo function). 

Detailed information on the global solo modes can be found in  "Global buttons -> Global 
solo modes (view page 171)". 
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3. "M" button: This button mutes the active track (track mute function). 
4. The "REC" button: This activates the track for recording. 
5. The "Lock" button: Protects objects in the track and prevents them from being 
unintentionally moved or deleted. 
6. The "Panorama" dial: This controls the position within the mix. Right click one of these 
two control elements and the stereo panorama dialog (view page 220) will open to adjust 
additional settings like panning laws or the stereo width. 
7. The "Phase reverse" button reverses the signal phase 180 degrees. Right click on one 
of these two control elements and the stereo panorama dialog (view page 220) will open 
allowing you to adjust additional settings like panning laws or the stereo width. 
Detailed information about the stereo editor can be found in the chapter "Stereo panorama 
dialog (view page 220)". 
8. The "Mono" button: This switches the track to mono processing from the input to the 
pan controller. In particular, all track effects preceding the pan controller operate in mono, 
which saves considerable CPU resources. The submix and AUX return buses always 
remain stereo, however. If stereo objects are located in mono tracks, the mono share (L+R) 
is generally played. 
Right click one of these two control elements and the stereo panorama dialog (view page 
220) will open to adjust additional settings like panning laws or the stereo width. 
For standard routing, only the post DX/VST plug-ins and post AUX sends are arranged 
after the panorama controller, and are therefore calculated as a stereo signal. The routing 
position of the pan controller, however, may be freely adjusted in the "FX routing" dialog. 
If AUX sends are used, the AUX send panorama controller can be used for panning the 
mono signals. 
9. The "FX" button: Opens the dialog for specifying the effect sequences (view page 174) 
and adding VST/DirectX plug-ins; right clicking this button also provides access to the 
track effects settings for the active track. These may be copied, inserted, reset, saved, or 
loaded. Save your personal track effect settings in the program directory in "FX presets -> 
Track FX". Of course, new subfolders may also be created. We've already included a 
selection of useful presets, e. g. "Mid-side processing". The track effects settings of a VST 
instrument may also be saved (including parameters and all subsequent track effects), and 
transferred to other tracks. 
10. The "MIDI" button This switches the track to MIDI recording and opens the MIDI 
section (view page 58) of the track editor. 
11. Volume input box and volume controller. 
12. The loudspeaker symbol switches on monitoring/playback of the incoming signals 
when the "REC" button is active and if "Manual monitoring" is selected in the system 
options. "MIDI thru" will be active here for MIDI tracks. 
13. Control display: Shows both of the track's LED chains for the input and output signal. 
14. The "Automation" button: This activates automation (view page 327) for the track. 
15. Automations parameter selection field and automations control: Select automation 
parameters and adjust the values with the corresponding controllers. 
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MIDI 

 

1. Arrow:  Opens and closes the dialog box. 
2. In: Opens the MIDI Input device menu. 
3. Out: Opens the MIDI Output device menu. 
4. Channel in: Set the MIDI Input channel. 
5. Channel out:  Set the MIDI Output channel. 
6. Program:  This button is used in MIDI mode for program selection of the MIDI 
instrument. The first click activates this field, and the second mouse click opens the 
program selection. When the menu is open, use the arrow and page up/down keys to 
make your selection. 
7. Bank MSB: Set the MSB byte for the "Bank select" MIDI message for controlling your 
external instruments here. 
8. Bank LSB: Set the LSB byte for the "Bank select" MIDI message for controlling your 
external instruments here. The bank number is MSB value* 128 + LSB value. 
9. Drum map: Here you can select a drum map (view page 270) for allocating MIDI notes 
to the device-specific sound. If a drum map is selected, the transpose function will not be 
available because the pitch is firmly assigned by the drum map. 
10. Transpose: You can transpose the notes of the respective MIDI input or output up or 
down here. This function works in real time, meaning that the MIDI files in the MIDI objects 
will not be changed. 
11. Velocity dyn: This button activates velocity dynamics as a real-time track effect. 

Detailed information about this MIDI effect, which processes the MIDI velocity dynamics, 
can be found in "MIDI editors -> MIDI functions -> Velocity dynamics (view page 255)". 

12. Input Q:  In this case, the MIDI quantize settings (view page 259) are used to quantize 
every recording offline. The original position may be restored via the menu item "Object -> 
Quantize -> Reset Quantization". 
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Audio 

 

1. The "In" slot determines the audio input device, 
e.g. your sound card inputs. 

2. The "Out" slot determines the audio output 
device. For example, this might be a sound card 
output. 

3. Delay: This sets the delay value for the track 

4. Gain: This regulates the amplification level of the 
input signal. 

5. Plug-ins: You can use FX inserts, MAGIX plug-
ins, DirectX, and VST effects for this track. Click the 
button to the right of the field beside "Plug-ins" to 
activate and open the "DirectX/VST plug-ins (view 
page 174)" dialog to specify a plug-in setup for this 
track. 

6. AUX: Specify the input for the aux sends (view 
page 172) here 

7. EQ: Contains the parametric EQ for this track. 
Right clicking opens a convenient input window. 

8. Comments: Track info section for quickly adding 
notes on tracks. 
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Track header 
1. Control display: Shows both LED chains for the input and output signal for the track. 
2. The "S" button (view page 171): Mutes all tracks except the selected one (track solo 
function).  
3. "M" button: This button mutes the active track. 
4. The "R" button (view page 82): This activates the track for recording. 
5. The loudspeaker symbol switches on monitoring (view page 27). 
6. The "Lock" button: This protects objects in the track and prevents them from being 
unintentionally moved or deleted. 

 

7. Clicking the track name or the track number selects the track. Repeated clicking the 
track number causes the track's display height to switch between flat and high. Double 
clicking on the track names enables them to be edited. If you want to add or remove a 
track from the multi-track selection (view page 98), then hold down "Ctrl" while clicking the 
track name. Right click the track name to open the track settings dialog; click the arrow to 
select additional track-relevant functions from the context menu. 
8. Revolver tracks: Revolver tracks (view page 62) may be used to compile objects 
differently for each individual track. The combinations created for the corresponding track 
may be accessed at any time in the revolver tracks menu. 
9. Vol: This button switches on the level automation curve (view page 327). This allows 
level adjustments in the track to be controlled via an automation curve and drawn by 
moving the channel fader. 
10. Pan: Switch on panorama automation with this button. 
11. Volume controller 
12. Panorama controller (view page 220) 
13. PL: The plug-in selector (view page 92) assigns various insert effects, VST, or DirectX 
plug-ins to a track. 
14. Color selection (view page 74): If the right edge of a track header is clicked, a 
selection menu will appear for you to specify the color of the track and its objects. 
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Folder tracks 
The command "Track > Insert new tracks > New folder track" adds a folder track in 
front of the selected track. If a range across several tracks is selected before creating the 
folder track, each of these tracks will be added to the new folder track. 

 

The tracks in the folder track are displayed within a frame, and the folder track number is 
appended with an "F" in the track manager. 

 

If you want to delete a folder track, a dialog will ask to confirm if you really want to delete all 
of the tracks contained in the folder as well. 

Tracks can be moved into the folder via drag & drop by clicking on a free area in the 
corresponding track box. The mouse pointer turns into a hand. Now drag the track into the 
track header of the folder track. 

 

Individual tracks can be removed from the expanded folder track again in the same way. 
You can also copy folder tracks. 
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The following functions work for all tracks found in the folder track: 

 Hide them via the track minimization button (-/+ symbols in the track header of the track 
folder). All tracks included in the track folder are displayed in reduced size. 

 Mute, lock, and solo 
 Volume regulation All individual volume fader tracks are scaled relative to each other. 
 Focus for recording 

All tracks in the folder track are displayed when the folder track is open. Each track 
receives a border with the track color of the folder track. When minimized, the tracks found 
in the folder will be hidden in the arranger. They will still be visible in the Mixer. Tracks of a 
folder track are marked with the border color of the folder track in the mixer. Normally, all 
tracks can be seen in the folder track along with their objects in a minimized state. 

Section marking in the folder track is carried out across all tracks. You can use this function 
for section-based cut operations across all tracks of the folder track. 

Right clicking the track header of the folder track allows you to select a contained track as 
a reference track. The objects of this track are displayed in the folder and may be used for 
simultaneous object-based cutting operations. 

Working with folder tracks and reference tracks: 

1. Initiate a multi-track recording. This creates several grouped objects, one below the 
other. 

2. Select an area over all the objects that you wish to edit together. You can now create 
a folder track. 

3. Minimize the folder track and choose one of the contained tracks as a reference 
track. 

4. The object of the reference track can be seen now in the folder track instead of the 
emblematic display of all contained tracks. All object editings, cuts, fades, and object 
editor effects for this object are now applied to all objects of the track folder. 

 

Revolver tracks 
In Samplitude Revolver tracks are at your disposal. Revolver tracks can be used to compile 
objects differently for each individual track. The combinations created for the 
corresponding track may be accessed at any time in the revolver tracks menu.  

Open the Revolver Tracks menu by holding down "Ctrl" and right clicking the track name in 
the track header. If the new "Camo" or "Canis" skin is being used, then a button 
specifically for this function is present beside the lock symbol. 
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Before track objects are rearranged, select the option "New Revolver Track (copy)". The 
track objects are copied as a new revolver track and a asterisk will appear before the track 
name. The original objects may now be edited or repositioned to produce a different 
version of the track. 

Of course, the context menu may also be used to create a new, empty revolver track, to 
delete the current one, or to display the the previous or next revolver track (shortcut: "Alt + 
Page up" or "Alt + page down"). The command "delete revolver track" deletes the current 
revolver track and displays the previous revolver track.  

In the lower section of the dialog you can select which revolver track you would like to hear 
next from the list of existing revolver tracks. The individual revolver tracks are numbered 
and are listed by creation date and time. 

Revolver Tracks are stored in the "TrackData" project subfolder. 

To edit  or view existing revolver tracks in the overview, open the take composer (view 
page 152) for a particular track. This editor enables Revolver Tracks and object takes to be 
edited, and the created Revolver Tracks are displayed under the individual takes. 

 

Workspaces 
The purpose of workspaces is to sort menu entries and toolbars in such a manner that you 
have a good overview of the functions of Samplitude. Workspaces bundle commands for 
certain tasks like mastering, editing, or recording. 

As well as the Hide menu entries option (File > Program Preferences > Edit keyboard 
shortcuts and menu... > Hide menu) and redesigning toolbars (right mouse click on the 
toolbar), you can also save your settings as a presets. 

You will see the selection box for the workspace at the bottom left corner of the Arranger 
window. Some workspaces are already predefined. "Power User" shows collectively both 
toolbar lists and commands. 

Creating a new workspace: To create a new workspace, open the context menu by right 
clicking on the workspace bar and then selecting "New workspace". You will now be 
asked to enter a name for your workspace. The new workspace contains all settings of the 
previously activated workspace as well as your current changes.  All further adjustments 
are automatically saved in the workspace. Manual saving is not required 

Adjust the workspace: Open the context menu and click "Edit Workspace". Here you 
can select which toolbar you want to have displayed in your new workspace. You can 
activate or deactivate each bar individually, or add/remove individual symbols. You 
may also hide menu items with the "Edit menu" command. Simply select the 
corresponding menu item from the keyboard shortcuts and then press the button "Show 
menu item" or "Hide menu item". 
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Toolbars – Overview 
All toolbars may be moved freely on the screen. To do so, click on the separator at the left 
edge of the group of icons and drag the toolbar to the desired location. These will snap in 
at different positions in the window. For example, you can also easily swap the position bar 
with the toolbar. 

Right clicking on an icon enables the skin for the buttons to be swapped, the size of the 
buttons to be increased, shows or hides tools, or otherwise customizes the different 
toolbars. You can also access the dialog "Edit Keyboard Shortcuts, Menu, and Mouse" via 
"File > Program Preferences > "Edit Keyboard Shortcuts and Menu". The menus may be 
individually edited via the corresponding buttons by either showing or hiding the different 
items. 

 

Detailed information about how to use menu items and keyboard shortcuts is provided in 
the menu reference, help file, or in the "manual.pdf" documentation under "Menu File -> 
Program Preferences -> Edit Keyboard Shortcuts and Menu (view page 488)". 
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To quickly sort a toolbar's individual buttons, click on the corresponding icon and drag it 
to the desired position while holding down the "Alt" key. You can use the same method 
to remove icons from the toolbar by holding the "Alt" key, dragging the icon outside the 
boundaries of the toolbar, and then releasing it. 

The following overview shows the presets: 

 

Toolbar: (left section) 

 

 New Virtual Project 

 Load virtual project 

 Load audio file 

 saving 

 Cut 

 Copy 

 Insert clip 

 Split Object 

 Glue objects 

 Undo the last action 

 Undo the last action 

 Auto crossfade mode 

 Crossfade Editor 

 grouping 

 Cancel grouping 

 Mixer 
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Toolbar: (right section) 

 

 Set Marker 

 Set CD track index 

 Set CD sub index 

 Set CD pause index 

 Set CD end index 

 Automatically set CD track Markers 

 Create CD 

 Create DVD Audio 

  

Grid toolbar/snap buttons 

 

The grid toolbar is available in the toolbar. This enables important changes to be made to 
the snap settings, without always needing to access the project options dialog (view page 
33). Click the magnet button to activate the snap grid. Activating the button to the right 
opens a context menu with the following snap settings options available: 

Objects: his option activates the object grid. This lets objects snap exactly to the edges of 
other objects. 

Snap to range: Activates the range grid and enables the current range to be used as the 
basis for snapping. 

Beats/bars: Activates a grid with bars as the basis for snapping. 

Bar grid (relative): Activates a grid with bars as the basis for snapping. The selected 
object will maintain a relative distance to the snap markings when moved. 
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Grid/frames: Activates the frame-based grid. 

Specify the snap length (for beat snapping only). Values range from every 4 beats, every 2 
beats, every beat, musical measure and same as quantization. 

The setting Musical measure means that, signatures based on quarter notes serve as a 
quarter snap unit, and time signatures based on eighth notes serve as a eighth snap unit. 
The snap therefore follows the time signature and observes any time signature changes. 

Note: When snap is activated the play cursor jumps in the transport console according to 
the snap values, even when using the fast forward and rewind buttons. If you would like to 
temporarily shut off the transport controls, press the "Alt" key simultaneously. 

Snap active: Switches the global snap on/off. 
Shortcut:  Ctrl + # 

Snap and grid setup: This option jumps to the Project options - general (view page 33) 
dialog to specify settings for the snap and grid. 

The area indicated by a Q to the side you can specify the quantization value used for MIDI 
(view page 259) and audio quantization (view page 550), "same as quantization" sets the 
snap setting accordingly. This causes audio and MIDI quantization to be linked (view page 
33). Right clicking the field opens the MIDI quantize settings. 

Note about "Input Q": In the interface skins (e .g. "Camo"), you will see the button 
"Input Q" in the MIDI area of the track editor (beside the button for velocity dynamics). If 
this function is active, then recorded MIDI notes will be quantized according to the current 
settings immediately. The original position may be restored at any time via the menu item 
"Object -> Quantize -> Reset Quantization". 

 

Details about audio quantization are provided in the menu reference "Object > Quantize > 
Audio quantization wizard (view page 550)". 
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Punch / Playback bar 

 

 Play to cut start 

 Play from cut start 

 Play to cut end 

 Play from cut end 

 Play beyond cut 

 Punch In mode 

 Punch recording 

 Set punch in marker 

 Set punch out marker 

 Delete punch marker 

 Cue mode: Playback stops after each object 
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Mouse mode bar 

 
 

Universal Mode 
This is the preset mouse mode in Samplitude. All necessary functions are available by left 
clicking. Depending on the relative position within the track, various functions will be 
executed. Right clicking always opens a context menu. 

The vertical position of the mouse distinguishes between object handling and range 
manipulation within every VIP track: In the upper half, you can select ranges and set the 
play cursor position. In the lower half, objects may be selected and moved. 

 

Range Mode 
In this mode, only ranges and the play cursor (position line) may be manipulated. 

Additional functions are also available via the following keys: 

Period key "." - Press this button to switch Samplitude to "Object" mode temporarily. 
Objects may now be selected and moved. 

Hyphen key "-" - Press this button to switch Samplitude to "Curve" mode temporarily. The 
volume and panorama curves may now be edited. 
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These special functions enable all important functions to be reached quickly, and 
accidental movement of an object cannot occur. 

 

Curve Mode 
This mode is strictly for editing automation curves (view page 327). This mode may be 
opened temporarily via "Universal/range" mode by pressing and holding down the hyphen 
"-" key. 

Place the cursor over a curve and click with the left mouse button to set a new curve point. 
Curve points that have already been set can be moved easily using drag & drop. 

In case you want to select several curve points for editing, simply span a range in the 
desired length. This is similar to using the object lasso, but for curve points. You can also 
select curve points vertically over multiple tracks. 

 

Object Mode 
This mode allows you to move objects and edit their start & end positions, the fade in & 
fade out phases, and the object volume. 

Object mode is especially useful together with range mode, which may be accessed 
temporarily from within it. Press and hold the period key "." while using range mode. Once 
you let it go, Samplitude switches back to range mode. 

 

Detailed information about how to assign keyboard shortcuts for temporary function is 
provided in the menu reference, help file, or in the "manual.pdf" documentation under 
"Menu File -> Program Preferences -> Edit Keyboard Shortcuts and Menu (view page 
488)". 

 

Object/Curve Mode 
In this mode, objects may be moved and curves may be edited with the left mouse button. 

 

Mouse Mode Samplitude 4.0 
Use this function to switch to the Samplitude 4.0 mouse mode. The right mouse button 
then controls object functions, and the left one controls range manipulations. 

 

Detailed information about how the functions of the individual mouse modes is provided in 
the menu reference, help file, or in the "manual.pdf" documentation under "Menu > File 
options -> Program settings -> VIP mouse mode" (view page 505). 
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Cut Mode 
Click on the object to separate it at the corresponding position. If the grid is switched on, 
then the scissors tool which appears will move according to the grid settings.  

Under "System options -> Keyboard/menu -> Special keys -> Temporary key for cut mode 
(view page 488)", you can specify a keyboard shortcut to keep "Object cut" mode active 
(provided the shortcut is held down). 

 

Pitchshift/timestretch mode 
The object handles below to the right and those in the object centre can be used for 
directly setting the playback speed and pitch. Advanced functions are available for Tempo 
marker manipulation in the timeline (view page 511). 

Detailed information about how to use "Timestretch/pitchshift" mouse mode can be found 
in the menu reference, help file, or documentation "manual.pdf"  under "Edit > Tempo > 
Tempo Map Dialog (view page 308)" 

 

Volume Draw Mode 
This mode allows volume automation curves (view page 327) to be drawn with the left 
mouse button. 

 

Automation Draw Mode 
In order to draw an automation curve or a MIDI controller curve, select "Automation Draw 
Mode". Selected curve points can be deleted using the "Del" key. If you move individual 
points using the "Alt" key, the bordering can be lifted using the neighboring points to the 
right. Holding down the "Shift" key while drawing fader movements produces a soft curve. 

Object automation 

Select "Object automation" in the track editor and place a check mark for the desired 
parameters. The object curves for the object automation (view page 333) will be added. 
Now draw the corresponding automation curve by dragging with the mouse. 

Track automation 

This mode allows automation curves to be drawn for the selected track (view page 328) by 
using the left mouse button. Activate the automated parameters of the embedded plug-in 
beforehand with the shortcut "Ctrl + Alt" move the corresponding plug-in's handle as 
desired. Next, click the "Track automation" field in the track editor and place a check mark 
for the desired parameters in the context menu. Now you can draw the curve of the 
selected parameter onto the track ("Automation Draw Mode"). 

The selected parameter's curve can be seen in the track in the foreground; all other curves 
may be displayed as thin lines by selecting this option in the context menu. 

This mode also enables panorama curves, etc. to be drawn with the left mouse button. The 
panorama curve on the respective track can be deactivated and activated again anytime 
with the "Pan" button to the left in the track head. 
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Tip: You may also move any plug-in parameter at any time via the small horizontal faders in 
the track editor's automation box while in an automation drawing mode mode (e.g. touch, 
latch, overwrite, or trim). 

 

Draw waveform in the wave window 
In "Wave editing" mode, use the left mouse button to draw the waveform of a file. 
Waveform display shows the suitable zoom level, and the mouse pointer becomes a pencil. 
Changing the waveform in the wave window is useful if you want to remove very short 
impulse disturbances manually. 

 

Spectral mode 

Menu "Edit > Mouse mode > Spectral mode" 

With the new "Spectral mode" you can remove noise from an object. You can also edit the 
signal of the left and right channels individually too. Editing can be done directly in the 
Arranger window. 

To be able to work with "Spectral mode" particularly effectively set the Spectral display 
(view page 496) in display options.  

The graphical interpretation of the music is displayed in the Spectral display using a 
spectrogram. This displays the frequency proportions in a time curve. The volume of 
frequencies is visualized via a color code or via its brightness. 

Audible distortion noises louder than the wanted signal are usually limited to a certain 
frequency spectrum. They are highlighted with colors in the Spectrogram. So you can 
easily select the interference with the mouse and remove it.  

A continuous sound is displayed by a pattern consisting of horizontal lines, which 
correspond to the sound components or overtones of the sound. A distortion with an 
impulse quality is seen as a vertical line. 
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After calling up "Spectral mode" highlight the unwanted noise by drawing a rectangle 
around it using the mouse. With help from the handle you can adjust the selected area. 

 

So that there is no audible gap, removed components of the original frequency spectrum 
from the wanted signal that surrounds the distortion are recalculated into the recording. 
After making the correction, you can see the results in the Wave/Spectral display in the 
Arranger window. 

 

Scrub Mouse Mode 
This mouse mode enables you to monitor and control the playback speed (view page 107). 
In this case, the project may be played back in the forwards or reverse scrubbing direction. 

 

Zoom Mode 
use the right mouse button to zoom out of the project, and click with the left button to 
zoom into it (view page 99). 
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Color mode 
Color mode enables you to color objects or entire tracks. Click on the arrow next to the 
brush symbol first. Next, select the desired color. Now move the mouse over the objects 
and tracks in the arranger: the pointer turns to a paint bucket symbol. Click on the object 
or track box you would like to color.  

 

You may also apply color to multiple objects across different tracks by dragging the lasso 
over the desired objects (the lasso appears when you drag the paint bucket). Release to 
color all selected objects. 

If you hold down the "Shift" key while doing this, you will not color the object, but rather 
the wave form instead. 

If you hold down the "Ctrl" key while doing this, then you will not color the object itself, but 
rather the object's background instead. 

If the preset color selection is not sufficient, then you may also select your own color or 
even create your own personal color palette. 

The option is also available to access the color palette for each track by clicking the color 
selector on the right edge of the track header; this also enables a new color to be assigned 
to a track. If multiple tracks are selected (view page 98) beforehand, the color selection will 
apply to all of these. 
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Left mouse button: Changes the background color of the object 

Right mouse button: Changes the object's wave form color 

 

Position bar 1 

 

 Section to start 

 One section left 

 Half section left 

 Half section right 

 One section right 

 Section to end 

 Play cursor to previous object edge 

 Play cursor to next object edge 

 Play cursor to previous marker 

 Play cursor to next marker 

 Increase clip size (zoom in) 

 Reduce clip size (zoom out) 

 Show all 

 Zoom to range 

 1 pixel = 1 sample 

 Predefined zoom range: 
1 second, 10 seconds, 60 seconds, 1 minute 
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Position bar 2 

 

 Freely defined zoom areas 1-4 

 Increase section vertically (zoom in) 

 Reduce section vertically (zoom out) 

 Show all vertically 

 Show range vertically 

 Zoom into waveform 

 Zoom out of waveform 

 Overview mode 

 

Range bar 

 

 Play cursor back to range start 

 Play cursor to range end 

 Fold range to left 

 Flip Range right 

 Range start to previous zero crossover 

 Range start to next zero crossover 

 Range end to previous zero stage 

 Range end to next zero stage 
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 Range Editor 

 Move object start left 

 Move object start right 

 Move object(s) left 

 Move object(s) right 

 Move object end left 

 Move object end right 

 Step size for moving objects 

  

Object modes: 

 
 

Normal Object Mode 
This mode moves objects and edits the end and start positions, fade in and out phases, 
and object volume. 

 

"Lock all audio in time" 
This mode locks all objects to stop them from being moved accidentally. Object mode 
"Lock all audio in time": Holding down the "Alt" key at the same time temporarily removes 
the mode for the selected objects. 

 

Link curves with objects 
In this mode you can shift track automation curves when moving objects together with the 
objects. 

 

Link objects until pause 
The means that the chosen object is selected and moved together with all subsequent 
objects on this track. This way partial ranges of a project, if separated by pauses, remain 
unaffected from moves. 
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This function also applies to multiple selected objects arranged along various tracks. 

 

Link objects on active track 
In this mode, all objects on the current track are selected and moved together. 

 

Link objects on all tracks 
In this mode, all objects appearing in the arrangement are selected and moved together 
from the mouse position. 

Note: By using the object modes "Connect objects until pause" and "Connect objects on a 
track" together, the markers in the top arranger track may also be moved when objects are 
moved. Moving objects in object mode "Group objects", simultaneously moves the marker, 
independent of the selected track. 

 

More information about using the object modes is available in the chapter "Working with 
object modes (view page 123)". 

 

Multifunction input field with help-function 
Samplitude provides a command search bar for finding menu commands and help topics.  

 

Enter a character combination into the search field which is relevant to a search term. 
Immediately up to five commands from the main menu will be displayed that contain the 
desired character combination.  
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Moreover, in the section below you will see up to four help topics that contain your search 
terms. 

 

All results that are listed can be directly selected. The commands in the upper section are 
listed straight away. 

By clicking on the appropriate help topic the program help will open up displaying 
explanations from selected topic areas. You can see a list of recent commands by clicking 
on the little arrow of the magnifying glass. 

 

You can actually execute a command by clicking on the commands that are listed.  
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Samplitude Quick Start 
Initial navigation in the virtual project (VIP) 
 To start playback, press the space bar. 
 To end playback, press the space bar, the pause button, or the "0" on the keyboard. 
 To set the play cursor, click on the desired position in the timeline. 
 To move the playback cursor, use the left and right arrow keys. 
 In order to jump to the most recent position, press the back space key 
 To move the VIP under the play cursor, use the keyboard shortcut Alt + Arrow left / Alt + 

Arrow right. 
 To create a range, use the mouse to draw in the grid list. 
 To move a range, move it with the mouse while holding down the Shift key. 
 To increase the size of a range, drag the end of the range using the mouse. 
 To reactivate a deactivated range, use the shortcut keys "Shift + back space". 
 To move an object, click on the lower half and drag it into its new position. 
 To jump to the object edges with the playback cursor, select the shortcut keys Ctrl + Q / 

Ctrl + W. 
 To create markers at the play cursor position, select "Shift + 1...0" in the letter keys 

block on your keyboard. 0“ im Buchstabenblock Ihrer Tastatur 
 To jump to a marker position with the play cursor, select the corresponding number 1...0 

in the letter key block of your keyboard. 0“ im Buchstabenblock Ihrer Tastatur 

Detailed explanations of numerous additional navigation functions can be found in the 
chapters: "Working in the project window", "Object-oriented audio editing (view page 123)" 
and in the menu reference, help file, or complete documentation "manual.pdf" under "Edit 
> Range (view page 519)". A complete overview of all keyboard shortcuts can be found in 
the chapter "Preset keyboard shortcuts". 

 

Workshop: Recording 
This chapter features information about recording audio material in Samplitude. This 
explains the basic functions involved. 
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Creating a VIP 
First of all, create a new project by clicking the "New multi-track project (VIP)" button in the 
start wizard on program launch. If you already have Samplitude open, select "New Virtual 
Project (VIP)..." in the "File" menu. 

 

Name your new project and select the file path where you would like to save the VIP. You 
may also create a new folder where all files relating to this project may be saved. Select "[0] 
Stereo Master" as the mixer setup. 

In the "Track number" field, enter how many tracks you wish to use. This doesn't mean 
that the project is limited to this number; new tracks may be added at any time. Adapt the 
"Sample rate" to the sample rate supported by your sound card and confirm it with "OK". 

Note: If the preset project length is exceeded, the VIP adapts itself to the actual project 
length. 
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Preparing to record 
To record from your internal CD/DVD drive or from an external sound source using a 
cable/microphone connection, it's important that your sound card is connected to the 
sound source. You can check this by switching on the track which you wish to record. 
Click the record button in the track header to do this; the button will glow red. The 
source's input level peak meter now appears in the bar. 

 

If you can't to see the input level peak meter, check in the track editor (menu "View -> 
Track editor" to ensure the sound device is connected to the same port listed under 
"Audio -> In". If this is not the case, set the track's input device to the port of the sound 
card input of the sound source by clicking "Audio -> In". 

If the level is in fact visible as a bar but sound is not yet audible, then make sure that the 
output device of the track correlates to the output of your sound card. 

If you have selected "Manual Monitoring" as your monitoring mode (Shortcut "Y -> Audio 
Setup"), please click on the loudspeaker symbol next to the level display on the track 
in order to view and hear the input signal. 

Now right click the record button in the transport window. 
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This will open up Record Options: 

 

Select the format for the recording first. Detailed settings for the desired audio format 
available via "Format options".  

If record mode is set to 16-bit at a sample rate of 44.1 kHz, then this is equivalent to CD 
quality. A bit resolution of 24-bit or even 32-bit (float) makes sure that hissing during 
subsequent editing of the sound material remains at a minimum. On the other hand, the 
higher the bit resolution, the more space that is required. 

Now specify if the track should be recorded in mono or stereo. While a stereo recording 
mode is usually selected for CD/DVD recordings, consider whether it would be better for 
single instruments, like bass or guitar, to be recorded as mono tracks, since this could 
improve future sound editing and addition of the instrument into the mix. 
In "Mono (mix)" mode, the track input is switched to mono, the signal is recorded like a 
stereo recording (dual channels), and then mixed into a single channel. 

 

Detailed information about the recording options is available in "Play/rec -> Record options 
(view page 582)" 
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Metronome settings 
The dialog "Options > Program settings > Metronome settings" allows you to activate the 
metronome function. The metronome may also be set as an audio metronome or as a MIDI 
metronome. 

 

Active while playback: This option activates the metronome click during playback. 

Active while record: This activates the metronome click during recording. 

Pre-count for recording (measures): Specify the number of beats that the metronome 
will pre-count prior to recording. If you activate "Pre-count clicks only", the metronome 
will stop before recording.  

The "Punch recording" button in the toolbar (view page 67)" blinks during pre-counting and 
the "Record" button blinks in the transport console (view page 52). When recording begins, 
both buttons remain active until the end of the respective recording period.  

 

Detailed information about different punch functions is provided in the "manual.pdf" 
documentation, in the help file, and under "Play/rec -> Record mode/punch in -> Punch 
marker mode (view page 581)". 

 

Audio metronome 
First beat/beats: This setting allows you to specify individual samples for the metronome 
("volume") for the first beat of each measure ("beats") or the remaining beats of the 
measure ("beat"). 
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Both metronome sounds "Metronom1.wav" and "Metronom2.wav" are preset; these are 
located in the folder "fx-preset" in the program directory. 

Volume: This controller regulates the volume of the audio metronome's sounds. 

Device: Set the audio device for the metronome here. Stereo master is preset, but this 
may be changed to another audio device output as the source of the metronome. 

 

MIDI metronome 
MIDI output device: Set the device that should produce the metronome click here. This is 
normally the sound card. 

MIDI channel: Set the MIDI channel via which the MIDI commands are sent here. 

First beat/beats/note value/velocity: Set various note values and the velocity for the first 
beat of each bar or the other beats of the bar here. 

 

Volume Adjustment 
Click the "Visualizer" button under the recording information display. Various functions are 
presented to aid visual orientation. Select "Setup > Peak Meter".  If there is no visual 
display of levels is shown, then press the "Monitor" button under "Options" in the recording 
dialog. You should now be able to see a signal. 

Detailed information about "Visualization" is available in the reference manual, the help file, 
and in the "manual.pdf" documentation under "View > Visualization (view page 798)" 

Note: Connect your input signal to your external amplifier/your sound card's input in such a 
way that the peak meter is as close as possible to 0db, but doesn't quite reach this value. 

The recording starts from the current position of the play cursor. If you wish to record 
from the fifth bar (for example), place the play cursor at the beginning of the fifth bar. To do 
so, open the project options under "View > Grid > Snap and grid setup" (shortcut: "I") 
and check the "Snap to", "Grid/Bars" and "Show grid" boxes. In the "Show grid" "selection 
menu, select "Bars/beats" as the grid unit, and confirm by clicking "OK". 

 

Now you can see the grid lines in the VIP. These divide the project window, and the grid 
toolbar now indicates the bars. Switch the display in the transport window (view page 52) 
to "Beats". Since "Bars/Beats" is selected as the grid unit, you can easily use the left/right 
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arrows on the keyboard to jump to the beginning of the fifth bar. Simultaneously, you can 
read the bar and beat position in the play cursor of the transport window. 

If you click on the "Record" button now; recording will start. As soon as you have 
recorded enough, press the stop button. You will be asked if you wish to save your 
recording. If you are happy with this, press the "Yes" button. 

Your recording appears in the project window as a virtual object. Now activate the next 
track by clicking on the "R" button  in the second track. As you can see from the level 
bars, the input signal is now selected for this track, which is ready for recording. 

Note: You can bypass the dialog window in case settings have already been specified and 
record straight into the VIP. Simply press the "R" key on the keyboard. If a track is 
activated, recording will begin immediately. 

 

Loop recordings 
If you would like to record in a loop, select the section in the arranger that you want to 
record first. Activate the "Loop" button in the transport control and start the recording. The 
range will repeat until recording is ended. A new take will be created for every run. If you 
hold down "Ctrl" and click with the right mouse button on the last take created for the 
recorded track, you will be able to see all of the takes produced using loop recording. To 
listen to a specific take, select it from the menu that is displayed.  

 

The Take manager (view page 150) is useful for organizing and editing recording runs. Use 
it together with the Take composer (view page 152) to produce the perfect take. 

 

Punch recording with markers 
If you know the exact range in which a punch recording prior to recording, then use punch 
recording with markers. To do this, select the area with the mouse where you want to 
use punch recording, and then activate the "In" and "Out" buttons in the transport 
control above the red "Record" button. Position the play cursor next. 

If "Punch" is activated, start the process with the "Record" button on the transport 
console. The actual recording will occur within the punch range. While this is happening, 
the "Record" button will flash when the play cursor is in front of the "In" marker. The 
button remains red during the punch recording. 
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Example:  An error between beats 23 and 25 needs to be corrected. Playback starts 
before the punch in position so that the introduction to the recording is made as easy as 
possible. During the punch process the "Record" button flashes; the recording will start 
automatically from the "In" marker (bar 23). Since the section following the object is already 
satisfactory, the recording is ended automatically at the "Out" marker (bar 25). 

 

Detailed information about different punch functions is provided in the "manual.pdf" 
documentation, in the help file, and under "Play/rec -> Record mode/punch in -> Punch 
marker mode (view page 581)". 

 

Multi-track recording 
The "Project options - mixer setup" dialog can be very useful for configuring multiple 
tracks in multi-track recordings in a single step. 

1. Open "Project options - mixer setup" via the key combination "Ctrl + Shift + M". You 
can also access it via "Options -> Project properties -> Mixer setup...". 

2. Click the "Routing" box and select the option "Route all tracks to existing stereo 
devices" if you want to record in stereo. For mono recordings, select the option 
"Route all tracks directly to existing mono devices". 

3. If the recording doesn't start at the current track, enter the corresponding track 
number into the "Start with track" field. 

4. In the "Device setup (track in/output assignment, routing)" area, click the "I/O 
devices" box and select "Record" from the dropdown list. 

5. For example, if you have four recording devices, enter "4" into the "Track number" 
field. The devices will then be set up across the next four tracks. 

6. Click "OK" to confirm. 
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Preparing to record 
 For each track you want to record on, press the "R" button to activate the track, i.e. to 

prepare it for recording. 
 Click on the button with the loudspeaker to activate monitoring. 
 You can set the maximum gain of your signal from your recording sources. To monitor 

the peak levels, open the peak meter via each track's context menu (track header -> 
"Track visualization"). 

 

Starting recording 
Once you have everything set up and the signal has been adjusted, start recording by 
pressing "R". End recording by pressing the space bar (only in "Playback while 
recording" mode) – or by pressing the "R" key again. Accept the recording by pressing 
the "OK" button in the dialog window that opens. 

Now you will see one object for each recorded track. 

 

MIDI recording 
In Samplitude, there is basically no separation between audio and MIDI tracks. Each 
track may contain audio and MIDI objects. You may therefore work on audio and MIDI 
material in a single project without having to split tracks. This enables you to manage VST 
instruments entirely from within a single track. When freezing the track, the MIDI data is 
converted into audio data. However, a track may only record from a certain device, 
which means that audio and MIDI files cannot be recorded simultaneously onto one track. 

In a Samplitude VIP track, MIDI data is recorded in the same way as audio data. An object 
is created for each recording, which overlaps existing objects. 

Note: Samplitude offers special MIDI recording modes (view page 90), in which already 
existing MIDI objects are inserted either via mixing (overdub) or via local replacement 
(replace). 

 

Preparing a MIDI recording 
If the "MIDI" button is activated in the track editor, the MIDI section opens to prepare the 
track for MIDI recording.  

Indicate to Samplitude which MIDI input device the program should use. Select the input 
device via the MIDI in slot (e.g. MIDI keyboard or fingerboard) to do this.  

If you have integrated multiple MIDI input devices with your system, you may also select 
<ALL> as the MIDI input device for a track. 
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As the playback device (MIDI output device), select the MIDI port you use via the MIDI out 
slot (e.g. MIDI out of your sound card or a VST instrument). 

 

If sound cannot be heard when the keys on your device are played, then monitoring likely 
needs to be activated. Activate this via the loudspeaker button (MIDI thru) for the respective 
MIDI track. 

 

By right clicking the "Mon" button in the transport control provides access to the behavior 
of the "Record" and "Monitoring" button. If you activate the options "Automatic MIDI 
record switch on current track" and "Automatic MIDI monitoring (Thru)", then the 
respectively selected MIDI tracks will be immediately activated for the recording and 
monitoring will be switched on for the input signal. If you want to record multiple MIDI 
tracks simultaneously, then deactivate the option "Automatic MIDI record switch on 
current track". 

 

If you still don't hear anything when you play the keys,  make sure that the MIDI out 
channel of the MIDI keyboard matches the "channel in" slot in the track editor for the 
selected MIDI track. 

 

Ensure that your MIDI synthesizer is sending to the same MIDI channel that you have 
selected in the "channel out" slot in the track editor. 
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Note: Many drum computers send to MIDI channel 10, since this is preferably used as the 
percussion channel and is even specified as such according to the General MIDI (GM1) 
specifications. 

 

MIDI recording modes 
The following MIDI record modes are available: normal, overdub, and replace. The 
different modes determine how the newly recorded MIDI files will be added to the VIP. 

You can specify the settings for MIDI Record Modes in the transport control. Click on the 
arrow on the left beside the "Close" button in the transport control to display this section. 

Alternatively, you can select the MIDI recording modes from "MIDI record" mode via "Play / 
Rec > MIDI record mode". 

Normal: Recording mode matches that of the audio recording. This means that a new 
MIDI object is created over the existing object for each recording. The old object remains, 
but it may be covered partially or completely by the most recently recorded one (both 
visually and acoustically). This way, you can record multiple takes of a passage and then 
compare them in the take manager (view page 150) later on. 

Overdub: The data is recorded into an already existing object, available and newly 
recorded MIDI data is mixed together. 

Replace: The data is recorded to an existing object, and any existing MIDI data is 
overwritten. 

After selecting the mode, make sure that the recording is activated for the track. The 
record button, which is set to standby, changes to violet to signal that this MIDI track 
should record MIDI data. 

 

Now you can now start the MIDI recording using the shortcut key "R". After ending 
recording with the "Stop" button, you will be asked whether you want to keep or delete the 
recording. After confirming this with "OK", your newly recorded material will appear as a 
"MIDI take" in the VIP. In case you have recorded several takes in normal mode for the 
same selected range, you can select and play back the individual MIDI takes in the Take 
manager (view page 150). 

Note: You can switch between the individual recording passes even quicker by holding the 
"Ctrl" button down and then right clicking the MIDI object. Now a menu will appear in 
which you can select the desired take and play it right away. 

If you record within a previously created MIDI object (Object -> New MIDI object), then you 
can follow the recording via the arranger track. The created events are displayed as blue 
bars. If individual MIDI events are muted after recording in the MIDI editor, these will appear 
in the MIDI object as gray bars. 
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Objects in the virtual project (VIP) 

 
 

Audio and MIDI 
Audio objects in a VIP always reference one wave file or one partial section of a wave file. 
MIDI objects also reference a single corresponding MIDI file. In contrast to audio, in which 
case wave files are saved visibly on the hard disk, MIDI files are saved together with their 
objects, which links them directly to these objects. 

 

Cutting and editing 
Audio and MIDI objects are cut in the same way. 

Place the play cursor at the cut position. Now click the object to be cut and press the "T" 
key on the keyboard. If "Auto crossfade" mode is activated, then Samplitude will create a 
fade for audio objects between the two newly created objects. 

Detailed information on this can be found in the chapters: "Object-oriented audio editing 
(view page 113)", "Object editor (view page 114)","Working with objects (view page 123)" 
and "MIDI in Samplitude (view page 242)". 
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Mixer 

 

Use the mixer (keyboard shortcut "M") to adjust the volume and panorama of the recorded 
tracks as well as automate fader and panorama movements. There are also multiple plug-
ins, submix and AUX buses, a four-band parametric equalizer, inserts for the integration of 
effects and VST instruments as well as many configuration and bouncing options available, 
not only for each individual channel, but also for the complete stereo track. 

Detailed information is available in the chapter "Mixer (view page 158)". 

 

Effects 

Note:You can find more detailed information on effects in the accompanying PDF 
("Manual" and "Effects, plug-ins and instruments"). 

In Samplitude, effects can be used at various "levels", offline or virtual effects, for objects, 
tracks in the mixer channel or as master effects. 

 

Offline effects 
The effects can be used in Wave projects and on objects. A Wave project represents an 
audio file. Objects in a virtual project refer to this audio file. Offline effects change the audio 
data in the wave project and may be set via "Effects -> Process Effects Offline". 

 

Real time effects 
Unlike offline effects, real-time effects are not calculated into the wave files that the objects 
refer to. These effects are recalculated every time they are played and can be modified, 
varied, without changing your original audio material. 
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What effects are there? 
In general, the following effect categories are available in objects, tracks, and in the master 
area: 

 Dynamics 
 Frequency / Filter 
 Delay / Reverb 
 Distortion 
 Restoration 
 Stereo / Phase 
 Modulation / Special 
 MAGIX Plug-ins  
 essentialFX 
 DirectX (only available if DirectX effects are installed) 
 VST FX (only available should the VST effects be installed) 
 ReWire (only available for tracks and if ReWire clients are installed) 
 Analog Modeling Suite: am-track, am-pulse, am-phibia (Samplitude Pro X Suite and 

Sequoia only) 
 am-munition (Samplitude Pro X Suite and Sequoia only) 
 Vintage Effects Suite: CORVEX (Chorus, Flanger), ECOX (Echo, Delay), FILTOX 

(Modulation, Filter). These are special internal plug-in effects for dynamics, sound editing, 
and simulation of analog switching. 

 

Effects - Signal flow 
Offline effects are applied before all real-time effects, as they are immediately calculated 
into the audio material. Real-time effects on the other hand, do not change the original 
audio material. They are calculated during playback in "real-time". 

The signal passes through the real-time effects in the following order:  

1. Object effects 
2. Track effects 
3. Master effects 

 

Effects in audio objects 
Object-based virtual effects are set in the object editor. These may be opened by double 
clicking on an audio object. The effect view is opened here by default. To display the full-
size object editor, place a check next to "Max". 

Object effects are applied only to the selected object. All other objects in the VIP are not 
affected by these settings. 

 

Effects in tracks 
Track-related effects may be set either in the VIP window or in the mixer. These may be 
internal effects or VST FX or DirectX effects. 
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Now click on the arrow symbol for the corresponding field. A menu with the various effect 
categories will open. 

 
 

Mixer effects 
To set track effects in the mixer, open the mixer by pressing the "M" key. In the "Ins" 
section, click the arrow symbol of an effect slot in the corresponding channel. Selecting 
effects is done the same way as described above. Use the "FX" button directly below the 
track's channel fader to open a dialog to change the series of effects within the track. 

 
 

Master effects 
Master effects are applied to the entire material in a multi-track project. The signal is routed 
through the effect, i.e. your audio card, before reaching the master output. 

Master effects may only be set in the mixer, which may be opened by pressing "M". The 
sum range of the mixer is wider than normal tracks and can be identified via the differently 
colored faders. 

The effect slots for MAGIX plug-ins as well as VST and DirectX effects are located at the 
very top. All of Samplitude's internal master effects are located under this. The equalizer 
may be used directly from the mixer or the equalizer dialog, which may also be opened by 
right clicking one of the EQ controls. 
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The sequence of the master effects may be set in the FX routing dialog, which opens 
via the FX button beneath the master faders. 

 

CD mastering 
CDs may be burned directly from within the project, without having to export the 
project as a wave file beforehand. Burning requires that a blank disc be inserted into the 
drive and a valid TOC (Table of Contents) exists. Place at least one CD track marker and 
a CD end marker to do this. 

 

Set CD tracks 
Position the play cursor where you wish to set the CD track marker. The marker menu is 
located above the track head boxes in the VIP. Open this and select "Set CD track index". 
Repeat this process until all markers that you want to set are in place. 

Now position the play cursor where you want the CD to end. Open the marker menu again 
and select "Set CD end marker". 

Note: The burning process only starts from the first CD track marker. 

 

Burn CD 
Now play the project again and at Samplitude's status bar to see how much CPU is 
required to play the project. This is important in order to estimate the speed that the project 
may be burned to audio CD. 

Now click the button with the CD symbol. Alternately, select the "Make CD..." option in the 
"CD/DVD" menu. The CD burning dialog now opens. 

 

Make CD 
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Mode: Select  whether you want to burn your project directly "on-the-fly" (without prior 
rendering) or whether Samplitude should create a new file beforehand (bouncing). 

Click "Burn CD". 

CDR write settings: Enter the desired burn speed here. 

If to wish to use CD text, open the "CD-Text/MP3 ID editor" by clicking "CD-Text 
settings" and entering the desired CD text for your tracks. 

Click on the "Write" button to begin burning. During burning, the play cursor runs through 
the project to provide a progress display. 

After burning, a message appears indicating that the process is complete. Confirm this by 
clicking "OK". 

 

Detailed information about CD mastering is available in the menu reference under 
"CD/DVD". (view page 777) 
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General Functions in the Project Window 
Section 
"Section" refers to the visible part of a project in the project window. 

There are many commands for moving (scrolling) the visible section and for customizing its 
size (zooming). The corresponding commands can be opened via the "View" menu, via the 
position bar, and via the shortcut keys. 

Up to three different sections may be displayed at a time in a project (shortcut: "B"). This 
allows you to display the entire project in the upper section while special passages of your 
arrangement are displayed in the other sections, e.g. at loop start and loop end. 

The simplified view may be restored via the keyboard shortcut "Shift + B". 

 
 

Active section 
If you display your project in several parts only one can be shown at a time. Activate a part 
by clicking on it or clicking on its control. By clicking on both double arrow buttons at the 
left, lower border of every section a corresponding context menu will appear that offers you 
different possibilities for moving the corresponding section horizontally or vertically. 

 

The red arrows in the lower toolbar are additional buttons for moving sections horizontally. 

 

Detailed information about sections is available in "View -> Sections (view page 811)" and 
"Edit > Range > Split range (view page 522)". 
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Select multiple tracks – group track controls 
To select multiple tracks, choose the tracks by clicking the respective track 
numbers/track ranges while holding down the "Ctrl" key or the "Shift" key. The 
selected tracks are highlighted in the arranger, which indicates that they are grouped. 

 Alternatively, the select the desired tracks and then open the track context menu and 
select "Track properties > Group track controls". 

If the status of a button or controller is changed now, then it will become apparent that the 
corresponding control elements of the other tracks in the group will also change. This 
applies to faders, panorama, EQ, AUX, mono, phase, solo, mute, record, MIDI/audio 
swapping, track color, track locking, Revolver track settings, bouncing settings, and for the 
selection of types of automation (track/object), plus the audio inputs/audio outputs. For 
the audio in and outputs, incremental functionality may also be selected, which 
distributes the in and outputs available in your system according to the selected tracks.  

On the other hand, specific settings such as integrated plug-ins, the selected automation 
mode, or the comments field remain as individual settings for the respective track and are 
not transferred to the group. 

This group functionality also applies to the mixer. The multi-track selection function is also 
available in the mixer for previously added control groups (view page 167) if the same 
control elements are integrated. 

In order to clear the group, click any track above or below the selection. If you click 
and move a control element related to one of the tracks removed from the group, it 
becomes apparent that the complete group has been cleared. 

In order to remove a track from an existing multi-track selection, hold down the "Ctrl" 
key and click the track name. If you change a control element of another grouped 
track, it becomes apparent that the tracks are still grouped, even without the track that 
has been removed. 

Alternatively, you may open the context menu in the track box and select "Track 
properties > Ungroup track controls to clear a group. 
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The context menu featuring commands to group or ungroup track controls may also 
be accessed by right clicking in the track header area below the last track in the arranger. 

 

Note: Multi-channel selection in the mixer functions exactly like multi-track selection in the 
arranger, i.e. by clicking the track number/name while holding down the "Ctrl" key or 
"Shift". In order to clear a group of channels, click a channel before than the selection. 

 

Zooming 
Use the zoom functions to adjust the sections of a virtual project. The higher the zoom 
stage, the more precise display will be. 

Samplitude features the following zoom functions: 

 

Zoom with the position bar 
Click the magnifying glass to open the zoom feature. The glowing red buttons zoom 
vertically along the timeline while the blue magnifying glasses zoom vertically. In addition, 
there are 4 freely definable magnifying glasses; pressing a number and holding down 
"Shift" while clicking enables the zoom stage to be set individually. 

 

Use the wave symbols on the right to set the zoom stage for display of the waveform in the 
active section. 

 

Zoom with keyboard 
The key combination "Ctrl + Arrow right" zooms out of the project; "Ctrl + Arrow left" 
zooms in. Press "Ctrl + Arrow up" to zoom into the waveform display, while "Ctrl + Arrow 
down" zooms out of the waveform display. 
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Zoom with the scroll bar buttons 
In the lower right-hand corner of the VIP window, the "+" and "–" buttons may be used for 
more precise adjustment of the horizontal and vertical zoom levels. 

 

A common feature of the preset zoom functions is that they center the play cursor in the 
visible section, provided it's visible when the zoom command in the section is executed. 

 

Zooming with the mouse wheel 
The key combination "Ctrl" and the mouse wheel provides simultaneous horizontal and 
vertical zooming - even during playback.  

The key combination "Ctrl + Alt" and the mouse wheel provides simultaneous horizontal 
and vertical zooming.  

You can zoom in by rolling the mouse wheel upwards.  
You can zoom out by rolling the mouse wheel downwards. 

 

Zooming with the mouse - vertical zoom 
An elegant method of zooming is to left click on the time line, hold down the button, 
and drag the mouse vertically.  

By dragging the mouse up, you can zoom out of the project, and you can zoom in with 
the reverse action. Simultaneously, you can change the range borders or the play cursor 
position with horizontal mouse movements, depending on whether you position the mouse 
at the beginning of the action on the grid toolbar or on the marker bar. 

This way you can position the play cursor precisely in one go: set the desired playback 
position roughly by clicking somewhere in the marker bar. . Next, move the mouse 
downwards while holding down the mouse button to zoom into the project. Correct the 
mouse position by moving it horizontally, and finally zoom out of the project by moving the 
mouse upwards. 

Deactivate this function at any time via the system settings ("Y -> keyboard, menu & mouse 
-> Mouse -> Special key performs vertical zoom without shift key"). 
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Zoom Mode 
Selecting the magnifying glass icon in the mouse mode bar accesses Zoom Mode (view 
page 73). Use the right mouse button to zoom out of the project, and click with the left 
button to zoom into it. 

 

Zoom Tool (Shortcut: Z) 
You can temporarily switch to "Zoom" mode by pressing "Z" and then dragging out a lasso 
with the mouse. By holding down the "Z" key and left clicking, you can zoom into a project 
in stages; right clicking while holding down "Z" zooms out in stages. 

 

Zooming with the scrollbars 
The scrollbars may also be used to change the zoom stages. When the mouse pointer 
moves over the left and right border of the horizontal scrollbar, it will change into a double 
arrow. This may be used to move the scrollbar borders, which also changes the length of 
the section displayed in the window. The length will then be shown on the left of the 
horizontal scrollbar. 

Similarly, you can use the vertical scrollbars to zoom into the track display. 

 

Scrolling 
The visible section follows the play cursor in so-called Autoscroll Mode during playback. 

All commands for setting the play cursor via keyboard or via the menu "Play / Rec > Move 
play cursor" also move the section with the play cursor. When moving the play cursor with 
the arrow keys the section will be moved as soon as you leave the window (page mode), 
with the keyboard shortcut "Alt+Arrow" the section will always be moved in such a way 
that the play cursor remains in the middle of the VIP window. The "Home" and "End" keys 
move the play cursor as well as the visible section to the beginning or end of the project. 

Should it be the case that you wish to move the visible section without moving the play 
cursor, you have the following options: 

Grid/marker bar: Moving the mouse pointer in the grid/marker bar while holding down the 
"Alt" key enables you to move the visible section conveniently from left to right. This 
method is very useful for navigating quickly within the arranger together with the vertical 
zoom (view page 100). 

With the scroll bar: By moving the scroll bar the contents of the window can be moved 
either to the left or to the right. 

With the arrow buttons in the position bar: The red arrow buttons can be used to move 
the section independently. 

With the keyboard: You can set up Keyboard shortcuts for all commands of the menu 
"View -> Horizontal/Vertical" (view page 816). 
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Detailed information about creating keyboard shortcuts is available in the chapter "Preset 
shortcuts". 

 

Ranges 
Ranges are selected sections of the arrangement that may be selected for editing or 
access later on. When creating ranges, you are not bound to object borders, individual 
tracks, or any other limitations like markers. Ranges that you search for are displayed 
inverted. You can set the step size of the selection by switching on the "Snap/Grid" 
function in the "Project options (view page 33)". 

 

Working with ranges 
Be aware of the following specifics when working with ranges in Samplitude: 

 The range remains in "Loop" mode even if the play cursor is repositioned 
 In loop mode the entire project is looped, even if you haven't marked a range. 
 Playback can be started before or within the loop. 
 If you start playback behind a range, the loop button in the transport console will turn off. 
 In loop mode the entire project is looped, even if you haven't marked a range. 
 Range ends can be adjusted during playback as well. 
 The play range can be deleted by dragging to size 0. . 
 The current range can be deleted by double clicking the grid toolbar outside of the 

range. 

 

Note: In the general program settings (shortcut: "Y -> Program -> 
General"), if a check is removed from "Play cursor independent of 
range", the active range will be defined for the length of the recording or 
playback process. Samplitude then ceases playback or recording 
automatically at the end of the active range, provided the "Loop" 
function is active in the transport controls.  

 

Selecting a range 
To select a range, move the mouse pointer to the top half of an object and press the left 
mouse button. Move the mouse pointer within the object while holding down the mouse 
button. An inverted rectangle appears between the starting point and the current mouse 
position. Once you let go of the mouse button, the range will be selected. 
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The play cursor always automatically remains at the beginning of the range, even if you 
can't see it at this moment in time. To expand the range to other tracks, click on the top 
half of the selected object again and drag the mouse down vertically while keeping the 
mouse button held. Now click the section with the "Shift" key held down, and every object 
featuring a middle point within the selection rectangle will be selected. 

 

A range may also be selected by dragging the mouse across the timeline. This will then be 
indicated by a different color. Double clicking this range in the timeline selects a range in 
the selected track; double clicking again selects the range over all tracks, and double 
clicking once more restores the simple timeline selection.  

The timeline selection enables the play cursor to be positioned outside the range. The 
range will remain in loop mode. This way, playback may be started in front of or within a 
loop. In this case, the range edges may also be modified during playback. The playback 
range may be deleted by dragging to size 0. . Click the range borders in the timeline to 
position the play cursor at the playback borders. Double clicking the timeline outside of the 
range removes the playback range. 

 

Leaving a range 
To select a different range, click somewhere in the project other than the current range, 
and simply draw a new range. 

 

Reactivating a range 
Use the shortcut "Shift + backspace". By clicking on this command repeatedly you can 
restore the last five ranges. You can execute the same function by clicking on the left arrow 
button in the transport control. 
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Change range borders 
Timeline selection enables you to change the range edges by positioning the mouse over 
them. The mouse pointer turns into a double arrow. The range borders may now be 
changed by dragging horizontally. 

To change the edge of an existing track range (start, end, top edge, or bottom edge), left 
click inside the range of the existing area and hold down the mouse button. Next, leave 
the range in the direction of the edge you would like to change while holding down 
the mouse button. As soon as the edge of the existing range has been crossed, the range 
edge will follow the movements of the mouse pointer. Once the range's edge has been 
redefined, release the mouse button. The start of the range may be changed via the 
arrow keys, and the range's end may be changed by pressing "Shift + arrow". 

 

Horizontal movement of a range 
Left click within the existing range while holding down "Shift" and holding down the 
mouse button to move the range horizontally. 

 

Saving and opening ranges / Special range commands 
Selected ranges can be saved by going to "Edit" then selecting "Range" from the menu or 
by pressing "Alt" and one of the function keys "F2-F10" and opened again with "Ctrl + F2 
... F10". 

"Alt + F4" however, should not be used, since this is a Windows command that closes the 
current screen. Similarly "Alt+F9" should not be used either as it is used in Sequoia as a 
source destination edit command. On the other hand, you may redefine this keyboard 
shortcut whenever you like via "Menu File > Program preferences > Edit  Keyboard 
Shortcuts and Menu (view page 488)". 

You can also save and rename ranges without any restrictions using Alt+F11. 

These and further special functions for defining, changing, and using ranges can be found 
in the "File > Edit > Range" menu. Beneath this you'll find a range editor dialog for the 
exact numerical input of ranges and the Range Manager (view page 149) for quick and 
easy viewing of and jumping to ranges. 

 

More information on ranges can be found in the menu reference point under "Menu Edit > 
Range". 

 

Examples for working with ranges 
Example 1: You want to move multiple neighboring objects to a new position. Instead of 
selecting each object separately while holding down the "Ctrl" key, you can select a range 
that contains all objects. Select the desired objects via "Object > Select objects > Select 
objects under the play cursor/range". 
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Example 2: You wish to remove a section of a song from the VIP window completely. This 
may be, for example, a verse of a song that should be cut out in order to reduce the overall 
length of the track. Select a range and activate all tracks by double clicking twice to select 
the affected verse. Then select "Edit > Delete > Delete with time/ripple" to remove the 
verse. 

Example 3: A selected range can be played as a loop. Activate the "Loop" button in the 
transport console. In this case, the range edges may be modified by dragging the handles 
on the edges. This enables previewing prior to making a cut. 

 

Markers 

 

Markers can set position points in your project that are of special importance to your 
arrangement. On opening any set marker, the play cursor will be moved to the defined 
marker position. Markers are listed along the top line of the virtual project, the so-called 
marker list, and these may be set when stopped, during playback, or during recording. 

A virtual project in Samplitude can contain any number of markers. The first ten number 
markers can be saved using the key combination "Shift + number key" on the 
corresponding play cursor position and open them directly via the number keys again. 

If you want to rename a markermove the mouse pointer over its front edge.  

  

This turns the mouse pointer into a double arrow. Double click You can rename the marker 
in the dialog window that appears. 

In the menu point "Play / Rec > Marker > Marker with name" you may name additional 
markers freely. 

 

To delete a marker, select it by clicking its front edge, and then press the 
"Del" key on your keyboard. Markers can be moved by grabbing them and 
dragging them to where you want to go, the mouse pointer changes into a 
double arrow <->. 

By using the object modes "Connect objects until pause" and "Connect objects on a track" 
together, the markers in the top arranger track can also be moved when objects are 
moved. Moving objects in object mode "Group objects", simultaneously moves the marker, 
independent of the selected track. 

If you right click inside the marker list or press the "Marker" button to the left beside the 
marker bar, a context menu will appear that features the most important marker 
commands. 
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The marker manager may also be accessed via "View > Manager > Marker manager". This 
is where you manage and edit the markers you set. 

More information about this is available in the chapter "Manager -> Marker manager (view 
page 147)". 

To stretch a range between any two markers, first click on the first marker. Then click on 
the second marker while holding down the Shift key. This selects a new range. 

Use the function keys "F2" and "F3" to quickly jump back and forth between the marker 
positions or the keyboard shortcut "Alt + W/Alt + Q" or select  "Play / Rec > Move play 
cursors > Marker left/right" from the menu. 

Alongside the standard markers there are additional markers that can be used in 
Samplitude as well: 

 Markers in wave projects are saved in the audio file (*.wav) as so-called audio markers 
and are available in this form in other applications as well. Audio markers are linked to 
the audio material, and are visible on the upper side of´an audio object. The purpose of 
the audio marker is to mark positions within the audio material, this marking will therefore 
remain regardless of the positioning in the virtual project. Audio markers may also be 
made visible in the view options ("Shift + Tab") in the "Objects" area by marking "Audio 
markers" with a check mark. The audio markers displayed in the object of the virtual 
project are identical to the markers in the corresponding Wave project. If you want to 
place a new project marker in a Wave project, as is done automatically when recording a 
new take, the audio markers are visible at the same position in the audio material in all 
related objects. Note: All time information for the audio marker relates to time positions 
in the audio material, and not to positions in the virtual project. 

 Markers for CD burn functions: CD track markers are displayed in red, CD subindex 
markers are green, and CD pause markers are blue. 

 Tempo markers signify a tempo change at a specific position in the project. 
 Beat markers change the type of beat from the marker position, e. g. 4/4 beat to 3/4. 
 Beat position markers assign a specific musical position to a specific time position. 

This way, the bar frame/grid and MIDI events can be easily synchronized with existing 
audio material. 

 

For more information on Tempo and grid position markers, see "Play/Rec > Marker (view 
page 301) > Insert Tempo Change/Insert Grid Position Marker" (view page 305) in the 
menu under reference. 

 

Advanced ruler/time display 
Use the grid bar's context menu to activate a second grid bar in the arranger and set 
your own measurement unit (show 2nd grid bar). Both grid bar positions can be 
exchanged (swap grid). If you select "Independent time format" in the transport window, 
the upper grid will adapt to a chosen BPM grid, unlike the lower grid. This makes it 
possible to select an SMPTE format independent of the project frame rate, which provides 
an overview of two different SMPTE displays. 
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Scrubbing 

 

Scrubbing makes it easier for you to find a specific part of the music in the project simply 
by moving the mouse pointer. Playback occurs while moving the mouse forwards or 
backwards. 

By varying the playback speed, it's possible to quickly locate an approximate position and 
then find the exact position at a reduced speed. 

If you press the insert key ("Insert" or "0" on the number pad), Samplitude will switch to 
"Scrub Mode". Now move the play cursor with the mouse in order to hear the audio 
material beneath it. When you hold down the mouse button in "Scrub Mode", you can also 
hold down on the "Shift" or "Ctrl" keys to slow down the process slower to make it more 
precise. You can also use the mouse wheel for fine-tuned scrubbing. 

The mouse mode list also contains a separate scrubbing mouse mode. 

The following scrubbing modes can be selected via the playback options (keyboard 
shortcut: "P"): 

Shuttle: The relative distance between the play cursor (positions bar) and the mouse 
position is used to control the speed. This means: 

Scrub controller on the left edge = double speed backwards 
Scrub controller in the center = no movement 
Scrub controller on the right edge = double speed forwards 

Absolute: This mode allows you to use the absolute position of the mouse in the window 
to control the speed. 

Two speed: Two speeds are provided for scrubbing. The object plays back slower or 
faster depending on the distance between the scrub control fader and the mouse position, 
whereby slow scrubbing at a speed of 0.25, or 1/4 of the original speed, is preset, and fast 
scrubbing is set to 1.0, i.e. the original speed. Change the value for slow playback in the 
"Speed" field. 

One speed: The preset scrubbing speed is 1.0, i.e. original speed. The "Shift" key halves 
this value. The "Ctrl" key uses the speed set in the "Scrubbing speed" field. 

Scrubbing speed: This specifies the factor of the original speed applies to the scrubbing 
speed. The range of values stretches from 0.01 to 10.0, i.e. 1/100 of the original speed up 
to ten times the regular speed. 

The option "1 track" enables you to limit scrubbing to the active track only. 

Scrubbing in the transport control 
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Another way to scrub is to use the scrub control wheel in the transport controls. Right 
clicking on the scrub control wheel opens a dialog to set variable speed settings as 
described above.  

 

Scrubbing tip: Scrolling is "softer" in case of smaller hard disk HD buffers (250-1000 
samples). Test if your computer functions at this buffer size without any playback errors. 

 

Samplitude as a wave editor 
Samplitude executes most tasks completely in the virtual project without having to access 
the original audio material. 

In certain cases, e.g. if audio files are used in other applications, it can be advantageous to 
adapt the original material. In this case, not only the reference objects within a virtual 
project are edited, but also the wave files (.wav) on your hard disk. When saving the 
modified files, you can create a copy of the original file to easily access the original file at 
any time. On the other hand, the command "Object -> Edit a copy of wave content" 
enables you to open a copy of the wave project for editing purposes. 

When using Samplitude as a  wave editor, practically the exact same editing options are 
available as those during non-destructive editing. Real-time effects are not available, since 
these may only be used on virtual object layers in the VIP, and several mouse modes such 
as "Universal" mode, "Object" mode, "Curve" mode, "Cut" mode, and "Pitch Shift/Time 
Stretch" mode. 
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To open a wave project from within a virtual project, point at the lower half of the reference 
object and double click while holding down the "Ctrl" and "Shift" keys. Alternatively, you 
can also select "Object -> Edit wave project" from the menu. A wave project is opened 
in a separate window and displayed as a waveform. The function of the zoom, scroll, 
range, and marker features does not change for the new window. 

 

There are two methods for editing wave projects: "Destructive editing" mode and the virtual 
"Wave editing" mode. 

 

Destructive Editing 
Destructive audio edit mode is the standard mode when the command Edit Wave Project 
in the Object Menu is used to open wave projects that belong to a VIP object. 

Wave projects opened directly via "File -> Open -> HD wave project" are opened in the 
virtual wave editor by default. This can be adjusted in the program settings. ("Y" -> 
Program -> General -> Open wave projects in destructive editor mode"). 

Regardless of the mode you load your wave project in, you can toggle between 
destructive and virtual wave editing via "File -> Project Properties ->Destructive 
Wave Edit Mode". If the box is checked, the extension "destructive" will appear in the title 
list of your project. 

In destructive mode wave projects are written directly to the hard drive. Changes in the 
editing window immediately affect the audio wave file. To be able to undo actions in the 
opened file in this mode using "Ctrl + Z", you have to activate the undo function for wave 
projects in the program settings ("Y -> Program -> Undo"). 

Note: At any time, a selected range in a wave project may be transferred from a wave 
project in destructive mode into a VIP via "Copy" and "Paste". 
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Non-destructive wave editing 
Samplitude also features non-destructive (virtual) wave editing. The advantage of this 
editing mode is that it works directly in the audio material combined with the features of 
non-destructive virtual editing. Compared to destructive wave editing mode, the 
following differences are apparent: 

The features "Cut", "Copy", "Delete", and "Insert" are non-destructive. The positions where 
these operations have taken place are marked with dotted lines. These operations may be 
performed in real time, since it is no longer necessary to copy data to the hard drive for 
undo functions. All edits are performed when the wave project is saved, and then they are 
added to the project. 

 

"Wave editing" mode – volume and panorama curve 
Volume and panorama editing is also virtual in "Wave editing" mode. Activate "Volume 
Draw/Automation Draw" Mode. You can now draw level and panorama curves with the 
mouse, just like in the VIP. 

 

"Wave editing" mode – master section 
If you open the mixer window by pressing the "M" key, you will see a minimized mixer on 
the master channel. This makes all of the real-time effects familiar from the VIP master 
section available, even for non-destructive wave projects. This enables you to apply 
multiple effects simultaneously when editing waves non-destructively. During destructive 
editing, however, only one effect may be written to the wave file at a time. 

 

"Wave editing" mode – auto-crossfade 
The auto-crossfade option may be activated during any cut or insert operation in non-
destructive wave projects 

 

Working with Samplitude – tips & tricks 
Here are some hints on how to work more effectively with Samplitude: 

 

New wave project via drag & drop 
Click on a selected range from the range list of your wave project and drag this up 
from the editing window onto a free section of the program background to create a new 
wave project. This enables you to make copies of the entire wave project or just parts of it 
quickly. 
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Drawing waveforms with the pencil tool 

 

In "Wave editing (view page 108)" mode, use the pencil tool to draw or modify the 
waveform of a file. Waveform display shows the suitable zoom level, and the mouse pointer 
becomes a pencil. Changing the waveform in the wave window is useful if you want to edit 
very short impulse disturbances manually. 

 

Working in virtual projects 
 The keyboard shortcut "A" produces a range that covers everything. 
 To set a range between two markers, double click somewhere between the markers in 

the marker list. 
 The keyboard shortcut "Shift + mouse movement" may be used to move the range. 
 Drag the range border to increase the range size to the left or to the right, for 

example to adjust a loop. 
 Use the "Tab" key to switch between two display modes in virtual projects, and edit 

the modes via "Shift + Tab". 
 The function "Objects -> Set objects" enables objects to be locked against 

unintentional moving. 
 By pressing the right mouse button in various areas of the VIP, e.g. above an object, 

above the "Record" and "Play" buttons, or above the scroll bars, a context menu with 
useful functions appears. 

 Press the "Delete" key to delete selected markers and objects. If you drag out a range 
over objects, press the delete key to delete the contents of the range. 

 Press "T" to split an object at the position of the play cursor. If a range over an object 
is selected, cuts will be made at the edges of the range. If "Auto crossfade" mode is 
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active, a crossfade will be added to each cut procedure which may be optimized later 
with the crossfade editor. 

 "Shift + mouse-click" on the 4 zoom buttons S1 to S4 at the bottom of the position list 
may be used to save each separate zoom setting. 

 Double clicking an object in the VIP opens the object editor. 
 You can select multiple objects one after the other by clicking the lower half of the 

objects while holding down the "Shift" key. 
 When holding down "Shift", all objects located between the first and last activated 

object will be selected. 
 There are a number of functions for editing objects available via "Object -> Edit 

object/crossfade", which may be executed fastest by clicking on the corresponding 
keyboard shortcut. 

 The level and panorama curves may be linked to the objects below by pressing the 
"Connect curves and objects" button in the mouse mode bar. This way, objects and the 
curves that belong to them may be moved together.  

 Numerical values in dialog fields like the display of the playback position in the transport 
window may be changed by clicking the corresponding field and holding down the 
left mouse button while moving up or down. This turns the mouse pointer into a 
double arrow. 

 

Mixer 
 In the mixer, right click on the insert slots to open the corresponding effect dialogs. 
 Double clicking the knobs/faders moves them to the zero position. Double clicking 

again restores them to their original position. 
 Master normalization in the mixer contains a feature which allows you to quickly set the 

output level to 0 dB. If the limiter in the master section is active, the output level is also 
monitored to prevent level clipping. 

 The mixer function "Mix to file" is located on the bottom right of the mixer. When the 
"On" button is active, the master output of the mixer may be written to a wave file or 
HD wave project during playback. During playback, change any parameter you want 
in order to record any live sound adjustments you make. 

 

Recording/playback 
 The recording dialog may be accessed via "Shift + R". Start recording by pressing "A"; 

"S" ends recording. 
 Begin and stop playback instantly by pressing the space bar. On stop, the play cursor 

returns to the starting point. . If playback is stopped by pressing "0" on the number pad, 
the cursor remains at the last position. The exact position may also be moved with the 
mouse while holding down "0" (scrubbing). 
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Object-oriented audio editing 
Object-oriented editing describes a method which enables the various ways of editing any 
selected object, independently of other mixer and track automation settings. This results in 
a high level of flexibility, even on the object level. You can edit sound material considerably 
quicker, add various effects to individual objects, and assign object-specific AUX 
components. The original audio files remain unchanged. 

 

What is an object? 
The object is a unit in Samplitude's arranger window. The object is displayed as a 
waveform, which may be moved, copied, or cut in any way. 

Objects contain references to the basic audio material. You can also speak of referencing 
an audio file with an object. 

An object accesses available audio data and calculates parameter settings like volume, 
panorama, object length, sound changes, effects, and fades, all in real time. Pitch Shifting, 
Time Stretching, AUX send feeds, and plug-ins are also calculated. 

 

 



 

1 1 4  O B J E C T  E DI TO R   

Object Editor 
The centerpiece of object-oriented working is the object editor, which can function as a 
tool for a single object as well as multiple ones. 

Note: There is an object editor for MIDI objects as well. Detailed information can be found 
in the chapter "MIDI in Samplitude -> Working with the MIDI object editor (view page 244)" 

 

The object editor is divided in three sections "FX", "Fades", and "Time/Pitch". The object 
editor may be left open to edit objects - the view automatically adjusts to the selected 
object.  

To open the object editor, select an object and press "Ctrl + O" or double click on the 
object. The Object Editor opens in the Docking bay (view page 50). 

The Object Editor can also be opened for an unselected object by positioning the play 
cursor over the object you want to edit and pressing Ctrl + O. The track containing the 
object must be activated. 

To select all objects at a certain play cursor position, activate a track with no object at that 
position. Press "Ctrl + O" and all objects located at the cursor position will be selected, the 
object editor will open for the topmost object in the track list, which also features the 
lowest track number. 

 

Basic functions: Object editor 

 

The selection options for the three different dialog windows of the Object 
Editor are displayed to the left. 

FX: Here you can set the gain, AUX, plug-ins, EQ, panorama and 
automation. 

Fades: Here you can set the fade in, fade out, wave position and object 
position values. 

Time/Pitch: Here you can set Timestretch/Pitchshift algorithms and loops. 
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The section on the far right is the same for all three dialog windows: 

 

The object name is displayed in the upper text field and this may also be edited. 

In the square field to the side you can select the object color. 

Using the arrow keys you can "jump" up or down to the object of a neighboring track. 

Use the double arrow buttons to jump to the previous or next object. If multiple objects 
are selected, these buttons will not be active. 

You can save the various object editor settings in the 4 snapshots. This can be done 
by"Shift + left clicking" on the corresponding button. In case you haven't yet defined a 
snapshot for the respective button a simple left click is enough. Clicking on the respective 
number keys will switch between snapshots. This means that you can quickly compare the 
various object editor settings. Also by right clicking on the numbers keys 1 4 you can load, 
save and delete snapshots of the object editor's settings. 

If the "To all" option is active all selected objects are updated when the object editor is 
opened. All recently applied settings that have been made in a selected object, regardless 
of which of the three object editor window areas, are applied to all other selected objects.  

Note: 

In an object - Volume changes are transferred relatively, i. e. they are increased or 
decreased relative to  the volume of other selected objects. 

- The EQ settings are always completely transferred, in contrast to previous versions 
where only the edited bands were transferred.  

FX bypass: this deactivates all real-time object effects, EQ/panorama settings, AUX sends. 

Freeze: If you click on the Freeze function for an object, this will be calculated as a new 
wave file with all the associated effects. The new Freeze object takes the place of the 
original object. This way you can bypass the processor-heavy realtime processing of 
effects. 
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Play/stop: This button corresponds to the normal playback function (Shortcut: space bar). 

Phi: The Phi button causes a 180 degree phase rotation. By right clicking on the Phi button 
you can invert the left and right channels individually. 

Lock: The activated Lock button corresponds to the key button's switch in the object. The 
object is then protected against any inadvertent horizontal movement. Additional locks 
against vertical moving, volume adjustment, fades, length adjustments, ripples or deletion 
can be set in the  system settings  (Shortcut "Y") under "Program ->Object lock 
definitions" (view page 549). Locking can be temporarily cancelled by pressing the "alt" 
key. 

Solo: This button moves the play cursor, during playback, to the start of the selected 
object and plays that only. Track-dependent buses and AUX paths are also observed at 
playback. 

Mute: This button mutes the selected object. You can also mute the left and right channels 
individually too. 

Commentary: You can type comments relevant to the selected object in this field. 

 

Object effects 

 

In addition to the numerous effects available for individual tracks and the master area of the 
mixer, audio objects may also feature effects. All settings are retained when moving or 
copying objects. 

By crossfading between objects of different settings, you can also fade between the 
different effect settings. CPU-intensive effects may therefore be used more efficiently, 
since they are only processed as required (unlike a track effect set up as an AUX send 
effect). 

"Effects" or the context menu also makes it possible to access the object effects. 

Manipulation via the level and pan curves or the volume controllers is only calculated after 
object level effects. 

 

Gain and AUX sends 
Gain: Set the gain for the object here. 
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AUX Sends:  Any object can send to all available AUX busses. You will see, however, 
initially only to AUX1 AUX 4. You can adjust the corresponding slider by dragging in the 
respective AUX Send field.  

By right click on the blue button in the header the advanced AUX send dialog will open, 
which provides full access to all AUX send paths. 

By left clicking on the blue button in the track header you can bypass all AUX sends 
(Bypass function). 

 

Plug-ins and EQ 
The plug-in section provides you with quick access to installed effect plug-ins on the object 
level. 

Here, plug-ins and insert effects can be selected by clicking the arrow symbols of each 
plug-in slot. 

Just by clicking you can switch the sought plug-ins on or off. Right clicking opens the 
interface of the respective plug-in.  

The "FX" button opens the Effect routing selection dialog (view page 174) for advanced 
settings and modifications to the plug-in series. Here you can load even more plug-ins than 
are visible in the slots. To load additional internal effects, you should use the FX/Routing 
dialog. If you click on the arrow button next to the "FX" button, you can save and load the 
object effects settings. 

The "Offline-FX" button opens a selection dialog concerning using offline effects (view 
page 178). Select the effect in the corresponding effect dialog and confirm using the "OK" 
button. the effect will now be included in the object offline. It is also possible to edit either 
the left or right channels individually. 

To remove a plug-in or an effect, select "No effect" from the corresponding plug-in slot in 
the menu. 

Under "EQ"  you can set four frequency bands. The blue button in the header switches the 
equalizer on and off. By right clicking on the controller/blue button you can access the 
dialog window for the fully parametric 4-band equalizer. The selected EQ values can be 
cut, copied, inserted and deleted by right clicking on the corresponding fields. 

 

Pan 
Here you can edit the panorama as well as the stereo width of the active object. Right 
clicking on the controller opens the "Pan settings" dialog. Use L <-> R to toggle between 
the left and right channels. 

Pan:Use the fader on the left to specify the panorama in the stereo picture. 

Stereo:  Use the fader on the right to set the stereo width. 
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Balance + stereo enhancer:  The pan fader sets the stereo balance. The mid position 
corresponds to a level of 0dB on both channels. When panorama is moved to the left, the 
level of the right channel is reduced and vice versa.  

The stereo button sets the base width of the left attack = 0% = mono via mid = 100% = 
stereo to right attack = 200% = Enhan. (extreme base widening). 

-4.5 dB Panorama+Stereo enhancer: The panorama fader controls the panorama 
position so that when the levels of both channels are set to the middle, the channels are 
reduced by -4.5 dB. In the outer settings one of the channels is faded out, the other is 
raised from -4.5 dB to 0 dB via the control range. This compensates for any perceived 
drop in volume in the mid position. Use this mode to place mono objects in the stereo 
panorama. 

2-channel panorama: In this mode, the two faders turn into two panorama faders for both 
channels, just like a mixer with mono channels. 

2-channel volume:  This mode controls the level of the two object stereo tracks 
separately. 

Reset: This button resets the controller and Panorama mode.  

Note:  For three-times more powerful frequency-selective base width, use the multiband 
stereo enhancer as an effect insert in the plug-in section. 

 

Vol 
Vol: The volume is controlled using this fader. 

Double clicking on the fader sets it to 0 dB. 

Norm.: The Norm. button normalizes the maximum level of the object to 0 dB 

 

Automation 
You can change object automation settings here. 
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You can make the automation curves of the selected parameter visible in objects with the 
"View" option. 

In both of the lower fields you can select the desired automation parameters. 

Activate the Automation drawing mode button and draw the object automation curve in 
the corresponding object. 

 

Position/Fades 
Use this dialog to set object-related time positions (start, length, end) and fade parameter 
for the selected object. In the entry fields "Timestamp" and "Step size" the measurement 
units can be changed by simply clicking. The following units are available: samples, 
milliseconds, hours/mins/secs, SMPTE (24, 25, 29.97 non drop, 29,97 drop, 30), 
SMPTE/milliseconds, CD-MSF, feet and frames 16 mm (40fpf) and feet and frames 35 mm 
(16fpf), noise reduction (meter). 

 
 

Fade In/Fade Out 

 

Fade in and fade out may be edited via this dialog. 

Using the faders you can adjust the precise settings of the curve shape of the fade. 

If you wish to produce the original fade, click on the arrow button and select the "Reset" 
option.The same context menu also features linear presets of the curve shapes, "Exp" 
(exponential), "Log" (logarithmic), "Cos" (Cosine) and "Sine". Here you can load separately 
saved additional curve shapes. Double click the fader to switch the fade between "Linear" 
and the last setting. 
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In the context menu there are two additional options available for fade-ins: 

Enable crossfade (left): Use this option to extend the fade-in object to the left over the 
original object border, depending on the values set in "Fade length". The fade-out of the 
previous object is shortened accordingly; both fade-in objects will remain linked. 

Asymmetrical crossfade (left): This option adjusts the fade-in independent of the fade-
out to the left past the object border. 

Beneath this you'll find the three "Fade offset" as presets. 

"Fade offset (%)" defines the percentage of the fade that should extend beyond the 
original object edge. 

 0%: The fade is located completely within the object 
 50%: the fade is symmetrical to the object edges 
 100%: the fade is completely outside of the original object edge 

The object is stretched according to the percentage set in "Fade offset". The original object 
edge that now acts as the "axis" of the fade will now be depicted as a dotted line. 

If the fade offset is above 0%, make sure that there is enough audio material in the wave 
project so that an object may always be faded in or out. For example, if the object starts at 
the exact beginning of the wave display, you will no longer be able to crossfade as soon as 
the "Fade offset" rises above 0%. 

"Fade inside" (corresponds to 0% "Fade offset"), "Symmetric fade" (corresponds to 50% 
"Fade offset") and "Fade outside" (corresponds to 100% "Fade offset"). 

The "Get global crossfade" function may also be used. Here the crossfade values of the 
standard settings are acquired for automatic crossfades. Use "Set global crossfade" to 
set the current crossfade values as standard values for automatic crossfades. 

The resulting curve shape for fade-in and fade-out is shown together with the "Fade offset" 
in the graphic. 

 

Content 
Audio file: Here the referenced wave project can be exchanged directly in the Object 
Editor, copied and renamed. Open the dialog exchange dialog by clicking the folder system 
beside the name of the audio file. If the audio file is used by multiple objects, you can 
indicate whether it should be switched for the currently selected object or for all referenced 
objects. 

Takes: Select the take you want here. 

Wave position: The arrow buttons do not affect the position of the object or its length, 
they move the wave display in the object left or right. 

Timestamp: This value assigns a unique time to the respective object. 
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If you click on the "Gear" button the Broadcast Wave Manager will open (view page 471). 

With the option Reverse playbackan object will be played backwards. The audio files are 
not changed. 

Hint: Please note that there are some limitations when using additional effects on a 
backwards-playing object. This refers to wave editing or using timestretching effects, 
especially Elastic Audio. Furthermore, reverse playback requires more resources as track 
speed cannot be used here. 

 

Position 
The starting time of the object on the timeline, object length, and object end can be set 
here by entering a number or using the arrow buttons. 

Using the arrow buttons beside object start / position the object can be moved forward 
to the start of the project or towards the end of the project. 

The arrow buttons beside object length move the start of the object, they work just like 
the front lower object handle. 

The arrow buttons beside object end shorten or lengthen the object, they work just like 
the back lower handle. 

The step size shows the position/length adjustment made upon clicking on the arrow 
button. The unit of measurement to the right beside the input value can be changed in the 
context menu (right-mouse click to open). 

The lower part of the menu features corresponding presets for each selected 
measurement, e.g. for the unit of measurement "Bar/beats", the following step sizes are 
used: 1/64, 1/32, 1/16, 1/8, 1/4, 1/2, 1Beat, 2Beats, 1Bar, 2Bars, 4Bars. 

 

Timestretching/Pitchshifting 

 

Pitchshifting and timestretching can be executed simultaneously and independently of one 
another (but not in "Resampling" mode). 

Pitchshifting: Enter the pitchshift in semitones (mouse wheel + Ctrl) or percentage (mouse 
wheel + Shift) or as a factor of the output material. 
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Timestretching: Enter the speed correction either as a new object length/stretch length 
or as a factor of the output material, or even as the desired speed in BPM (beats per 
minute). 

The button "<< from loop or range" makes it possible to extract the BPM value from one 
selected range or the object length and enter it as the "Original BPM". Enter the number of 
quarter notes in the dialog that opens and then confirm with "OK". This is important if the 
object tempo is not entered correctly and another tempo needs to be compensated. 

The values are also able to be adjusted in stages using the knob. 

If you wish to change the original speed ("Original BPM"), you will see that the speed of the 
object you wish to correct adapts to that of the set stretch factor. The modes available are 
"Resample", "Standard", "Smoothed", "Beat marker stretching (smoothed)", "Beat 
marker slicing", "Beat marker stretching", "Monophonic voice", "Universal HQ" and 
"True Resynthesis". 

"Edit" opens a clear display of the already named parameters. If you move through the 
individual modes with the mouse, a detailed explanation will appear for each mode.  
 

Detailed information about these algorithms is provided in "Effects -> Time/pitch -> 
Resampling/Timestretching (view page 647)". 

 
"Reset" restores all pitchshifting and timestretching settings. 
Elastic Audio provides a high-quality tool for pitch customization. The "Elastic Audio" 
button opens the activated object in the Elastic Audio Editor. 

The Use Elastic Audio (Pitch Automation) , changes the pitch using Elastic Audio. 

 

Loop 
In Loop mode (view page 136) Loop Start, Loop Length and Loop End are active 
whereby the unit of measurement to the right beside the "Step size" input value can be 
changed with a mouse-click. The loop with the specified step size can be corrected using 
the arrow buttons: 

Loop start:The upper arrow buttons change the loop starting point without changing the 
loop length, that  is, the loop end is moved as well. 
Loop length: The middle arrow buttons change the starting point as well as the loop 
length, the loop end remains unchanged. 
Loop end: The lower arrow buttons move the loop end, the loop length changes. 

All settings can be seen in the selected object in the form of vertical dashes. Once an 
object has been selected the whole object turns into a loop. If, however, you selected a 
range, only this will turn into a loop. 
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Methods for Working with Objects 
Integrating wave files as objects in the VIP 
This is how to add a wave file to your virtual project as an object: 

 Click somewhere in the upper half of the desired track at the position that should display 
the beginning of the new object. The play cursor now moves to the position at which the 
object will be inserted. The track is selected. 

 In the "File" menu, select "Load/import" and then "Load audio file". Browse to the 
desired wave file in the dialog window that opens. If you now choose to open this, it will 
be appear as an object in your project window. 

If multiple audio files have been selected (by holding down the "Ctrl" key), you can specify 
under "Options" whether these should be aligned beside one another or on top of one 
another in multiple tracks and also in which order they should be inserted into the virtual 
project. 

Tip If you have not opened a virtual project (VIP), the command "Load audio file" will load 
your wave file in wave editing mode. You can select destructive wave edit mode from the 
menu, "File > Project properties" 

Detailed information about destructive editing is available in "Working in the project window 
-> Samplitude as a wave editor (view page 108)". 

 

Integrating sections from wave projects as objects 
To integrate a section of a wave project into a virtual project (VIP) as an object, open a 
wave project in an empty project window and drag the range up that should be integrated 
into the virtual project (VIP). Then open a virtual project (VIP). 

Click anywhere in the VIP in the upper half of the desired track at the position that should 
display the beginning of the new object. The play cursor now moves to the position where 
the object will be inserted. The track is selected. Click "Object -> New object" to insert 
the previously selected range. 

Alternately, press "Return" to display the VIP and wave projects one under the other. 

Click the selected range of the range list in your wave project. Now drag this section of the 
wave project up into the desired track of the VIP. The selected range is now available as a 
new object in the VIP. 

 

The difference between loading and importing audio files 
Unlike during loading, the selected audio file is converted to .wav format when imported 
and then copied to the hard disk. This is only necessary for file formats that cannot be 
opened directly using Samplitude, e.g. Windows Media Files and certain MPEG files. 



 

1 2 4  M E T H O D S  FOR  WO RKI N G WI T H O BJ EC T S   

Increase the performance of your computer by importing compressed formats like MP3 or 
OGG-Vorbis instead of simply loading them to bypass real-time decoding. 

 

Integrating CD tracks as objects into VIP 
You can also import tracks of an audio CD into your project. 

 Click anywhere in the upper half of the desired track at the position that should display 
the beginning of the CD track. The play cursor now moves to the position where the CD 
track will be inserted. The track is selected. 

 In "Menu CD/DVD" -> Load audio CD track(s)..." the CD track list will open. By 
clicking "Copy selected tracks...", you can import selected tracks into the system and 
load them into the project window. 

 

Selecting objects and clearing selection 
Each object may be selected with the mouse. To do this, click the lower half of the object 
with the left mouse button. The selected object will be recognizable by a different 
background color and the five handles that appear on its corners and in the center of the 
object. 

 

This selection may be cleared again by holding "Shift" and clicking the lower half of the 
object or by clicking beside the object. 
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Object handles 
When an object has been selected, five handles appear at the corners and at the center of 
the object. 

 

The length handles are at the bottom left and right corners. Use these to adjust the length 
and starting time of an object within the wave project. Use the object editor to change the 
length as well. 

The length of an object depends on the audio file that is accessing the object. The longer 
the audio file is, the longer the object can be. The referenced audio file restricts the length 
of the object: the object may not be longer than the audio file. 

The fade handles (top left and top right) are used to fade an object in or out, and different 
curve shapes are possible. Use the object editor to adjust the curve shape precisely. 

The volume handle is at the top center of the object. You can use this to adjust the 
volume. The volume level is displayed above the tool tips. 
The object name is visible next to the left length handle on the right hand side and the key 
symbol to its right may be used for locking objects (view page 130). 

 

Select multiple objects; clear selection of multiple objects; 
reverse selection 
Objects may be selected in various ways. The selection may be expanded, reduced, or 
reversed at any time. 

 Select multiple objects by holding down the "Ctrl" key at the same time. 
 Left click on a free area in the lower part of a track and hold down the mouse button. 

Now drag the mouse to open the object lasso. All objects in the lasso are selected 
when the mouse button is released. 

 If there is no free space available, access the object lasso via "Object > Select objects 
> Object lasso" (Keyboard shortcut: Ctrl + Alt + L). Now select individual objects by 
dragging the mouse. 

 Hold down the "Shift" key and click to select all of the objects between the first and last 
selected objects. 

 The complete object selection may be cleared by clicking anywhere in the lower part of a 
track. The complete selection will not be cleared if you click a currently selected object; 
clicking an object that is currently selected will remove that object from the complete 
selection.. 
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 The current object selection may be reversed (invert). To do this, select "Object > 
Select objects > Switch selection". 

 

Moving objects 
 A simple move: Left click an object in the lower half of the object and hold down the 

mouse button. The object will follow the mouse movement. Release the object at the 
desired position (drag & drop). You can move an object in another track. In order to 
move an object to the left or right, use this keyboard shortcut: "Ctrl + Alt +Shift + arrow 
left/right". 

 To move multiple objects at once: Select the desired objects as described above. 
Click and drag one of the selected objects using the mouse to move all selected objects 
together. 

 To preserve the time position while moving objects different tracks: Select the 
objects as described above. Press the "Shift" key and move the objects to the desired 
track. The keyboard shortcut for moving a track up or downwards is "Ctrl + Alt + Shift + 
arrow up/down".  

 To move objects upwards over the visible section: To move objects vertically 
upwards across the visible section, drag the objects across the section in the arranger. 
Move the mouse pointer across the top track in the section to the grid/marker bar; 
after a moment, the arrangement will scroll upwards so that the selected objects may be 
moved to the tracks above.  
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 To move selected objects downwards across the visible section in the arranger, 
hold the mouse pointer to the lower horizontal scroll bar; after a moment, the 
arrangement will scroll downwards so that the selected objects may be moved to the 
tracks below. 

 

nudging objects 
 "Object -> Move objects > Object step 1/2" features a number of commands for 

specifying individual keyboard shortcuts in the system options. 
 To change the step widths 1 and 2, access "Object -> Move objects -> Object/Fade 

Step Settings". 
 Alternately, select the objects you wish to move and open the Object Editor. In the 

Position/Fades window click on the right or left arrow in the Position/Length dialog. The 
objects now move at the set step width. 

 For step-by-step moving of an object you will also find the corresponding buttons on the 
range list. Go to "View" > Toolbars > Range bar" to make this visible. Buttons are also 
provided for moving the object's start or end, or the entire object. 

 

Changing the length and start time of an object 
You can move the object borders using the length handles. If the mouse is moved to the 
length handles at the beginning of an object, the mouse cursor will transform into a double 
arrow. By clicking and dragging, you can edit the starting time of the object. This also 
changes the object length. 

This function is also available in the object editor as well as in the corresponding buttons on 
the range bar. 

 

Duplicating, copying, and inserting objects 
Duplicating one or more objects is done by moving objects while holding down the "Ctrl" 
key. 

Copying and inserting objects is done in the familiar manner with the keyboard shortcuts 
"Ctrl + C" and "Ctrl + V". 

Inserting an object with ripple 
The keyboard shortcut "Ctrl + Alt + V" inserts a previously copied object at the play cursor 
position; the objects following this in the arranger will be moved back correspondingly 
("ripple").  
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Mute objects 
You can mute the activated objects using the "Ctrl + M" shortcut or with the mute button in 
the object editor. 

 

You also have the option to mute either the left or right channel. 

Note: If you've selected several objects and want to mute them collectively, make an 
object mute and use the "Apply to all" checkbox to apply this to the group.  

 

Change waveform view 
The waveform view may be adjusted in "View -> VIP display -> Define...". 

Detailed information about the display options is available via the menu reference under 
"View -> VIP display (view page 491)". 

Change the size of the waveform by holding the "Shift" key and rolling the mouse wheel. 

Zoom into a waveform at the position of the play cursor by pressing the "Ctrl" key and 
simultaneously scrolling with the mouse wheel. 

 

Edit fades in the object editor or by using the handles 
To quickly produce a fade, click and drag the fade handle of the selected object. The curve 
shape that was set in the object editor is used in this case. 

The object editor provides a selection of fade curves when the "Menu" button is pressed. 
Select the fade lengths in the field beside this. 
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Reverb in the object 
Reverb times fade away if the Reverb effect in the routing is situated after the 
"volume". For standard routing, only the post DirectX/VST plug-ins or internal delay effects 
apply. 
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For reverb times with RoomSim change the effects sequence so that "Volume" is 
placed before the "FX inserts". 

 

The reverb time depends on the option "Maximum reverb time for objects without 
fadeout (sec.)", which is located in the playback options (view page 578). 

To ensure that reverb does not continue past the fade out, but rather that it breaks off, 
arrange the object's parameter "Volume" in the FX/routing dialog after the effect (FX 
inserts or DirectX/VST plug-in (pre) or DirectX/VST plug-in (post)). 
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Locking objects 

  
Just click the key symbol on the lower border of each object to protect an object 
against accidental moving. This function corresponds with the "Lock" command in the 
object editor. 

 Clicking on the key symbol again unlocks the object. 

Multiple selected objects may be locked with a mouse click. 

The menu entry "Object -> Lock objects -> Lock objects" applies to single and multiple 
objects. 

If you wish to lock all objects of a track, click on the lock symbol in the track overview box 
or Track Editor. 

Locking against fades, changes to length, or deleting may be set via "Object -> Lock 
objects -> Lock definitions". 

Temporarily disable the lock function by holding down the "Alt" key while clicking objects. 

 

Editing an object destructively 
By editing an object destructively, to add complicated effects to the audio material, severe 
loads on the CPU may be reduced during playback in the virtual project (VIP). 

To edit an object destructively, right click the object to access its context menu and select 
"Wave Editing". The wave project will open. The wave may now be edited as desired. 
Samplitude now functions as a wave editor (view page 108). 

If an audio file that is contained in multiple VIP objects is edited in destructive mode via 
"Object -> Wave Editing", then all of the associated objects in the VIP will access this 
audio file. For example, if reverb is added to an audio file in destructive mode, all objects 
that reference this audio file will now feature reverb. 

On the other hand, to edit only certain objects destructively, select the command "Object -
> Edit a copy of wave content". Samplitude will produce a copy of the audio material and 
add this to the project folder. The selected objects will now refer to the copy that is 
created. Following this, destructive effects may be applied to the selected objects without 
influencing other objects.  

The button "Advanced options (view page 601)" in the corresponding effects dialog 
provides access to saving options for the copy.  
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The take manager (view page 150) provides an overview of the versions of destructively 
edited files and select them for the respective object. 

 

In order to reference audio files for other objects in the VIP retroactively, click the folder 
symbol in the object editor to the right of the audio file. One of the following dialogs will 
appear: 

 

 

Select whether the file should be swapped for the current object, for all selected objects, or 
for all objects that reference the file to be swapped.  

The option "Create copy" is activated by default for all destructive effects for safety. This 
creates a temporary copy of the unedited audio file. Activate this option in the offline effects 
dialog to be able to use the undo function in the VIP later - this allows you to undo 
destructive editing. 

Note: Temporary files for the "Undo" function are only created with destructive effects 
calculation if the "Undo" function for wave projects is also activated (keyboard shortcut: "Y" 
– Program -> Undo) and "Create copy" is activated in the corresponding effect dialog. 
Deactivate the option "Create copy" if you are sure that the original audio file will not be 
used for other objects. This also applies to objects in other VIPs. 
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Moving to a defined position 
The following options are provided for moving an object to a specific position: 

1. Right click on the object you want to move. In the context menu that opens, click 
"Objects/move crossfade/edit -> Move object...". A window opens to enter the 
value of the new starting position in samples, milliseconds, SMPTE time, or beats. 

2. Open the object editor to enter the desired position under "Object start". 
3. If you want an object to start at the position of the play cursor, right click on the 

object you want to move. In the context menu that opens select: "Object -> 
Edit/move crossfade/edit -> Object to play cursor position". 

 

 

Group/ungroup objects 
Select all objects for the group. 

Now select either the "Group" symbol in the toolbar or right click one of the selected 
objects and select "Object -> Create group" in the context menu. The selected objects 
now form a group. 

Click the "Ungroup" symbol in the program toolbar or right click one of the selected objects 
and select "Object -> Ungroup objects" from the context menu to clear the group. 

"Object -> Select objects -> Temporary exclude object from group" command 
removes an object from an existing group according to when it was last clicked. By clicking 
on an object again and repeatedly using the function, the removed object is moved back 
into the group. 

Shortcuts: Ctrl + Shift + U 
 Shift + Ungroup button 

"Object -> Select objects -> Temporary exclude all objects from groups" temporarily 
ungroups all objects from the group. In this case, the "Ungroup" button will blink. If the 
function is accessed again or if the blinking buttons are pressed again, then the groups will 
be restored and the button will stop blinking and return to inactive status. 

Shortcuts: Shortcut: "Shift + Alt + Ungroup" 

Saving ignores the temporary condition, but saves the original grouping. 

If "Group color" is activated in the display options, a different color will be assigned to 
each group. This helps to easily distinguish the groups from one another. You can also 
activate display of the group numbers in the VIP display. Individual objects may be 
removed from groups by pressing ungroup while holding the "Shift" key. 

Detailed information about the display options can be found in the menu reference under 
"View -> VIP display (view page 491)". 
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To learn more about grouping tracks (multi-track selection), see "Working in the project 
window -> Selecting/grouping multiple tracks (view page 98)". 

 

Linking objects 
This is how to link objects in a track: 

 
Click the button "Link all tracks" in the mouse mode bar. All of the sequential objects 
on the timeline will now be linked with the selected object. 

 
Click the button "Link one track" in the mouse mode bar. All of the sequential 
objects on the timeline will now be linked with the selected object. 

 
If you now click "Normal object" mode in the mouse mode bar, all objects will return 
to their original modes. 

Pressing the "K" key temporarily toggles the object mode. This activates the other selected 
mode for as long as the key remains pressed. 

 

Overlapping objects 
Only one object can be played per track (channel) at any given time. 

If an object is moved over a bordering object, it will cover the preceding object. The 
invisible part of the subsequent object can be made visible and audible again by moving 
the first object. To create a crossfade between two consecutive and partially overlapping 
objects, apply the "Crossfade editor" function in the "Edit" menu.  

If "Auto Crossfade" is active, a crossfade will be created automatically as soon as the 
overlapping object is faded in. 

 

Overlapping two objects via the keyboard shortcut "Ctrl + 
V" 
If you drag a shorter object completely into a longer one, then the shorter object will 
replace the longer object from the start of the shorter object.  
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If you hold the keyboard shortcut "Ctrl + V" before releasing, then the shorter object will 
also replace the longer object across the entire length of the shorter object, but the end of 
the longer object that extends past will remain.  

 

Now try it the other way around and drag a longer object over a shorter object; the shorter 
object will be replaced from the start position of the longer object if its start position lies 
behind that of the shorter object.  

 

 

If the start position of the object being moved lies before that of the target object, then the 
target object will remain complete. Only the part of the object to be moved that is present 
before the start position of the target object will be added to the target track. 

 

 

If you hold down the keyboard shortcut "Ctrl + V" before releasing, the object being moved 
replaces the target object across its entire length. 
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Gluing objects 
If you wish to combine two objects into one, select both objects and right click on one of 
them. In the context menu that opens, select "Glue objects". This creates a new file that is 
saved in the "FreezeData" folder in the project folder. 

If you uncheck "Freeze" in the object editor of the new object, it will be separated into its 
old components. 

Note: In order to keep mono objects from changing into stereo objects during gluing, 
activate the option "System options -> Effects -> Resampling/bouncing -> Keep mono 
if possible". 

 

Looping objects 
Looping repeatedly plays an object or object range. You can change the length of objects 
by dragging out the length handles. 

An object is normally played back between the object start and end. A loop object also 
starts from the beginning of the object, once the loop starting point has been reached only 
the set loop range will be repeated until the object end. 

The easiest option to loop is to open the object's context menu and choose the option 
"Create looped object" (shortcut: Ctrl + L). The entire object is treated as a loop. If you 
now drag the length handle at the back to the right, you will see a vertical dash at the 
previous object end. For this marking onwards the object will be played back again, it is 
looped and can be stretched out to the right. 

An object loop may be edited in far more detail by using the object editor (view page 122). 
In Loop Mode you can set and customize the loop start, loop length as well as the loop 
end within the object. Skilled looping omits time-consuming cutting. 

 

Trimming objects 
"Trimming" refers to trimming objects to a certain specific range. Make sure that the 
selected range does not exceed the object borders. 

Once a range is selected, right click the object and select "Trim objects" (shortcut: Ctrl + 
T). The selected object will now feature the selected length. 

You can also trim multiple activated objects in the same way, even if they don't have the 
same starting and end points. 
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Replacing an audio file below the object 

  

Open the object editor and switch to the view "Position/fades" or to 
"Max" view. 
Now click the folder symbol in the object editor to the right of the name 
of audio file. A new wave file may be selected in the following dialog. 

„ 

Moving audio material below the object 
By pressing the right Ctrl button and clicking the lower part of the object, you can move 
the audio material below an object by clicking it. Of course, excess material must be 
available within the defined object borders, i. e. the audio file must be longer than the 
object that it is connected to. 

 

 

If the right "Ctrl" key is pressed and then the length handles are dragged out on the left 
or right borders of the range, the adjacent object edge will be maintained while the other 
edge moves with the mouse. 

If you hold down the right Ctrl and Shift keys and then drag the left or right length handle 
on the object to the start or end position, the edge will remain while the adjacent edge 
moves in sync with the mouse movement. 
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Manager 
The managers combines frequently required management and control functions within one 
window, such as for markers, tracks and CD tracks. This includes a file browser for finding, 
previewing and loading media files. 

The manager may be opened inside or outside of the Docking bay (view page 50). The 
manager window is multi-monitor enabled and saves the last position when closing. 
Multiple managers in various different views can be opened simultaneously and 
independently of one another. 

Manager Shortcut 

 File Browser  Ctrl + Shift + B 
 Object manager Ctrl + Shift + O 
 Track Manager  Ctrl + Shift + S 
 Marker Manager  Ctrl + Shift + Alt + M 
 Range Manager  Ctrl + Shift + Alt + B 
 Take-Manager  Ctrl + Shift + Alt + T 
 VSTi-Manager Ctrl + Shift + I 
 Routing manager Ctrl + Shift + Alt + R 

To open the manager, click "Manager" in the toolbar or "Manager" in the "View" menu. The 
menu item "Open new manager" also allows you to open additional manager windows. 

Drag the bar above the manager tab upwards to enlarge the manager window. Double 
click the bar to uncouple the manager window. 

Note:  Shortcuts work with already opened managers and change to the view which was 
assigned to the shortcut. If several manager windows are open, the shortcut affects the 
first opened or currently active window. 

By right clicking on the individual columns of the respective Manager window further editing 
options will be available. 
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File browser 
Samplitude contains a file manager for previewing and loading files directly into projects. 
The browser may be used to create favorites folders and provides access to all recently 
opened folders. 

To display the file manager, click the "Manager" button in the toolbar, and then select the 
"Files" tab in the manager window. 

Menu: Tools -> Manager -> File manager 
Keyboard shortcut: Ctrl + Shift + B 

 
 

Navigation/favorites 
The file manager includes a directory tree that may be switched on/off; this behaves just 
like Windows Explorer. Directories and files are displayed with directory and file symbols in 
the form of a list. 

The following file information is displayed: 

 Name 
 Extension 
 Size 
 Date 
 Length 
 Resolution in bits 
 Stereo/mono 
 Sample rate 
 Timestamp 
 Description/title 
 Originator/artist 
 Path 
 BPM: Specified by the loop length 

Navigation is done via mouse or keyboard. A drive selection menu located in the toolbar 
lets you quickly switch between all data storage devices connected to the workstation. 

A display filter located in the toolbar limits the display to certain media types, e.g. .WAV, 
MIDI or project files, only. "All media files" is displayed by default. 
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Just like other manager windows, the "Search" option searches in the current window for 
directories or files. Enter a search item into the box and press the search button. Any 
located directories or files are highlighted. You can find and highlight several entries that 
meet the search criteria by entering one or several first letters. 

To the right in the file manager, the current directory may be added or deleted as a favorite 
to your favorites list. Click a favorite to open it. 

 

Underneath the favorites list, a selection menu is located featuring a list of paths used last. 
You can switch into the current project folder here. 

 

Preview audio files 
A selected audio file may be previewed with the playback symbol in the file manager. Any 
highlighted audio file is played immediately if the “Autoplay" box is checked. A complete list 
may be previewed simply by using the cursor keys. Clicking the play button again stops 
continuous playback. The fader symbol may be used to control the volume. 

 

Playback does not proceed via the mixer or internal effects, but rather via the global 
playback device selected in the playback parameters (keyboard shortcut: "P"). If no 
playback occurs, check to ensure that the routing settings for the device are correct. 

 
BPM sync: This option enables the selected loop to be previewed in the VIP's 
tempo. The original BPM is specified in this case by the length of the file. When 
playback is running, loops are positioned at the beginning of the beat by double 
clicking and then added into the arrangement as loop objects. 

 
Looped preview enables the selected file to be previewed in a loop. 

Note: To preview certain media data, e.g. in WMA format, these files must be converted to 
wave format. Conversion is carried out automatically in the background. 
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Load files from the file manager into projects 

  

Media files may be inserted into an opened project at the desired play cursor position via 
drag & drop or by double clicking. If the file browser list is in the foreground, press "Enter" 
for the same effect. Right clicking the desired file opens a context menu. This enables you 
to open, rename, and delete files and folders. This also provides access to the functions 
"Select all files", "Open via standard link", "Open in Windows Explorer", and "Copy path 
to clipboard". This enables you to display the respective file's properties. 

Insert file into new track: The keyboard shortcut "Alt + Enter" creates a new track for the 
file. The track that is created is named according to the file. 

Open file in wave project view: Drag an audio file from the list and drop it into an empty 
space or into the title bar of the program window. 

If several files are selected in the list, all files will be inserted at the current cursor position as 
new objects, and the loading options ("Options") will also be applied. This allows you to 
specify whether all files should be inserted into the current project one after the other, one 
underneath the other, alphabetically, or according to their timestamp positions. The load 
option settings are also valid for files loaded via the program's "Load" dialog. 
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File manager options 

 
Additional options may be accessed via the small gear icon: 

 
 

Loading options 

 

Use selection order of file dialog: If this option is activated, Samplitude remembers the 
sequence in which the files were selected and then sorts them accordingly. 

Load files in alphabetical order: If this option activated, Samplitude sorts the selected 
files alphabetically in the VIP. 

Use sync positions (timestamp) of waves: Broadcast wave files containing timestamps 
are positioned precisely at this position in the VIP. 

Load all files to selected track: The selected files are loaded successively in one of the 
selected tracks. 

Load files to different tracks: The files are now sorted in vertical order from the selected 
track to the next one. If necessary, an additional track is added. 

Group loaded objects: All loaded files are grouped. They can be ungrouped anytime. 

File management 
Copy audio files to project folder: Copies the file to the corresponding project folder. 
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Convert compressed files to wave format: Compressed audio formats such as MP3 
may also be loaded and played directly by Samplitude. This does, however, require 
increased CPU calculation. Activate this option to convert files like this into an 
uncompressed wave format. 

 

Extended file search 
Additional criteria are available for extended file searching, e.g. Date of last file change 
between, Date of file creation between, Files with audio length between, and Files 
with sample rate of, File name, Project comment, Description/title, Originator/artist: 

 

Note: Deleted files will always be removed to the recycling bin. "Shift + Del" deletes directly 
without placing the file into the recycling bin (after confirmation request). 
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Object manager 
The object manager lists all objects contained in the current project and makes it possible 
to edit selected object parameters. 

To display the object manager, click the "Manager" button in the toolbar, and then select 
the "Objects" tab in the manager window. 

Menu: Tools -> Manager -> Object manager 
Keyboard shortcut: Ctrl + Shift + O 

 

You can export object manager information as a text file. Click "Export text" in the toolbar 
to do this. The Windows text editor opens with an excerpt from the marker manager list. 
The following information will be saved:  

 Project name and project path 
 Track and object name 
 Start position in the project 
 Source file path 

You can find this file in the project folder (Projectname.txt). 

 

Object view and selection 
These objects are displayed via a tree structure according to tracks. Tracks are only listed if 
they also actually include objects. Further instances of the listed objects can be moved into 
the Arranger using drag & drop. 

 

 

You may optionally choose to display objects in the current tracks only (toolbar: 
"Options"). 

 

 
You can use the +/- keys on the toolbar to open and close the track object 
display for the complete window. 
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Click on the “+” symbol left of the track number to explode the view of a 
single track. 

 

 

Select objects: A square check box in front of the 
object name enables select of a single or multiple 
objects. This is also visible immediately in the 
project window. 

If an object that is part of a group is selected, the other objects of the selection will also be 
selected in the project window and object manager. Grouped objects are also recognizable 
via the number of the object group in the "Group" column. 

 

Objects that are currently playing are highlighted 
with color in the object manager. 

Searching for objects: Like in other manager windows, the object manager also provides 
a search option that allows you to search for objects in the current window. Enter a search 
item into the box and press “Return”. Found Objects are highlighted, but are not selected 
in the Project Window. 

 

Delete, rename and edit objects. 
You can delete Objects directly in the Object Manager by selecting one or several Objects 
simultaneously and pressing the “Del” key. Alternatively, you can delete an Object via its 
context menu. You can rename Objects by double-clicking on the Object names and 
entering a new name. Alternatively you can also use the context menu. 

To edit an object directly in the object manager, right click the object entry you want to edit 
and start the object editor using the context menu that appears. In the same context menu 
you can also duplicate objects. 

 

Edit object parameters 
You may edit the following parameters via the object manager: 

 Start position 
 Name 
 Length: 
 end cap 
 Volume 
 group 
 Lock 

To edit a parameter, double click the respective entry and enter a different value. Numeric 
values may be changed by dragging with the mouse, and "Ctrl" and "Shift" allow larger or 
smaller changes. "Tab" moves to the next editable value. "Play cursor up/down" navigates 
vertically within a column, provided this is a text column. 
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Track manager 
All tracks in the current project are displayed in the track manager, which allows direct 
access to the "Solo", "Mute", and "Record" functions, as well as hiding tracks in the project 
window and mixer. 

To view the track manager, click on the "Manager" button in the toolbar and then select the 
"Track manager" tab at the bottom of the manager window. 

Tools -> Manager -> Track manager 
Keyboard shortcut:  Ctrl + Shift + S 

 
 

Track view and selection 
The track manager contains all tracks of the current project. Double click the track number 
to select a track. The track will be displayed in the project window. If the track is outside of 
the visible display, the project window will scroll to this vertical position. 

Search for tracks: Like in other manager windows, the track manager also provides a 
search option that allows you to search for tracks in the current window. Enter a search 
item into the box and press "Enter". Located tracks are highlighted. 

 

Sort, rename, delete, and insert tracks 
To sort tracks in the track manager, just pick them up with the mouse and drag them 
vertically to the desired position. 

Delete tracks via the manager by selecting one or several of these tracks and pressing the 
"Del" key. Alternatively, you may also use the context menu to delete a track. 

Rename tracks by double clicking the track names and entering a new name. Alternatively, 
the context menu also provides an option for this. "Tab" moves to the next editable value. 
"Cursor up/down" navigates vertically within a column, provided these are text boxes. 

You may also insert new tracks directly in the track manager. Right click on a track entry 
and select "Insert track" from the context menu. You may also add track folders, submix 
buses, AUX buses, Surround buses, or attachments. The "Track settings" are also made 
available by right clicking. 
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Hiding and displaying tracks 
Besides the "Solo", "Mute", and "Record" features, you can also hide tracks. To remove a 
track from the project window or mixer, click the check the box in the "Arranger" or "Mixer" 
column. Hidden tracks are still available and are still played and edited while they are 
hidden. 

To display a hidden track, reactive the check box. 

 

Write text file 
Click the "Export text" button and Samplitude will create a text file with a listing of the 
tracks used in your project. The button beside this imports a list of track names from a text 
file. 

 

Marker manager 
The marker manager displays all markers contained in the current project (regardless of 
type), and makes it possible to jump directly from the list to them or to play them. 

To view the marker manager, click the "Manager" button in the toolbar, and then select the 
"Markers" tab in the "Manager" window. 

Menu: Tools -> Manager -> Marker manager 
Keyboard shortcut: Ctrl + Shift + Alt + M 

 

The following marker types may be displayed in the marker manager: 

 Markers with numbers or names 
 CD track markers 
 CD subindex markers 
 CD pause markers 
 Source markers 
 In/out point markers 
 Tempo markers 
 Beat markers 
 AQ marker (audio quantization marker/transient marker) 
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Marker manager information may be exported as a text file. Click on the "Export text" 
button in the toolbar. The Windows text editor opens with an excerpt from the marker 
manager list. The following information will be saved:  

 Project name 
 Marker position in project 
 Marker type 
 Marker name 
 ISRC (International Standard Recording Code) for CD markers 

You can find the file in the project file (Projectname.txt). 

 

Marker view and selection 
The marker manager displays all of the current project's markers. 

Marker filter: An optional marker filter limits the view to selected marker types. Select all of 
the marker types you want to display in the filter menu by placing check marks and then 
clicking the filter button. All non-selected marker types are hidden. 

Find markers: Like in other manager windows, the marker manager also provides a search 
option which allows you to search for markers in the current window. Enter a search item 
into the box and press "Enter". Located markers are highlighted. 

Set range between selected markers: Set a range between the selected markers via the 
context menu. 

 

Jumping to and playing from marker positions 
Double click a marker in the type column to position the play cursor there. 

Playing markers: Select a marker and click on the "Play marker" button in the toolbar. A 
range surrounding the selected marker is created and playback begins. 

 

Deleting markers, changing a marker's name, position, 
and type 
Delete objects directly in the object manager by selecting one or several objects 
simultaneously and pressing the "Del" key. Alternatively, you may also use the context 
menu to delete a track. 

Rename markers by double clicking the marker name and entering a new name, or use the 
context menu. Alternatively, the context menu also provides an option for this. Use the 
same method to change a marker position directly from the list. The "Tab" button switches 
to the next editable value. "Cursor up/down" navigates vertically within a column. 

Tip: You can change the type in the context menu for the respective marker any time, e.g. 
if you want to change a position marker into a CD track marker. 
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Range manager 
The range manager displays all areas contained in the current project and makes it 
possible to select them directly from the list. 

To view the range manager, click the "Manager" button in the toolbar and then select the 
"Ranges" tab at the bottom of the manager window. 

Menu: Tools -> Manager -> Range manager 
Shortcut: Ctrl + Shift + Alt + B 

 
 

Defining and searching for ranges 
Defining ranges: To save a range in the manager, define a range in the project window 
first. Next, click "Define new range" in the toolbar of the range manager. Ranges that are 
saved using the program's "Save range" feature ("Alt + F2", "Alt + F3", etc.) appear in the 
list with the indicators F2, F3, etc. 

Search for ranges: Like in other manager windows, the track manager also provides a 
search option that allows you to search for ranges in the current window. Enter a search 
item into the box and press "Enter". Located ranges are highlighted. 

 

Edit range parameters 
Edit the following parameters via the range manager: 

 Name 
 Start 
 Length 
 End 

To edit a parameter, double click the respective entry and enter a different value. Numeric 
values may be changed via drag & drop; "Ctrl + Shift" enables larger or smaller value 
changes. "Tab" moves to the next editable value. "Arrow up/down" navigates vertically 
within a text column, provided these are text fields. 
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Take manager 
Menu: Tools - > Manager -> Take manager 
Keyboard shortcut: Ctrl + Shift + Alt + T 

 

The take manager offers you a convenient option for selecting and organizing recording 
takes, loop recordings (view page 86), and destructive object edits (view page 131). 

When graphical comping with the take composer (view page 152), you can edit together a 
new take from available take sections.  

Note: A new take is also added after effects calculation and this is displayed immediately in 
the take manager if the option "Create copy" is selected in the destructive effects dialog. 

 

Take manager - basic working principle 
In addition to the audio and MIDI data, Samplitude also saves additional information like the 
time position and the track where the data was recorded in each recorded file. This data is 
stored as take information in the wave project and the MIDI object. For multi-track 
recordings, the takes also contain information like which other tracks were involved in the 
recording. 

This enables each recorded passage to be assigned to a section, marking it as a take of a 
certain recording. 

First, record as many takes of a certain passage as required. If a new take in an arranger 
track is recorded over an old one at the same position, no existing data will be overwritten. 
The new recordings will be attached to the end or saved to a new file. 

If an object from a recording is selected and the take manager is opened, takes from the 
same track and original position are searched for in the whole audio material of the project, 
and the results are shown as takes. 

Note: The take manager only accepts objects that were created by recording, but not 
those created by wave or CD import. 

 

Examples for using the take manager: 
 To select the best takes after some punch loop recording sequences 
 To find the best takes from several recording sequences using predefined bar positions 
 For a well-structured display of all available takes in a specific SMPTE period 
 To merge the best parts of existing takes of recorded vocals to a "perfect take" 
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The basis for working with the take manager is always a selected object, e.g. the most 
recently created object after a punch-in recording. The current object take is identifiable via 
the check mark in front of the name in the take list. All the takes matching the selected 
object are shown in the list. In the basic settings, this refers to all the takes from the same 
track and original position. 

 

Take manager - options 
Filter recording position: Only takes that overlap the same original time positions are 
shown, e.g. the selected object. 

Filter out takes that are too short: Only takes that are at least as long as the currently 
selected take are shown. 

Show all tracks: Takes of all tracks will be displayed. 

Manager font: Use the dialog to specify the font, format, and size for the take manager 

 

Select takes 
To select a take for the object, place a check mark before the desired take, or press 
"Enter" after you have selected the corresponding take in the take manager. 

Select a take directly in the arranger window by applying "Ctrl + right click" to the object. 

All of the takes shown in the take manager and the currently selected take are arranged 
one below the other in the take composer. Takes may be compared directly in the take 
composer, and a combination of the various takes may also be cut out. 

Rename take: Right click on the take to open the context menu and rename it, edit the 
recording position, or delete the take. Multiple selection is also possible. 

Edit recording position: This option enables you to make changes in the take manager's 
position field. 

Delete takes: Right click on the take to open the context menu to delete it. Multiple 
selection is also possible. Once you have deleted all of the takes except for one, you can 
decide if you would also like to delete the referenced file. Note that the deleted audio file 
will not be usable in other projects.  

Note: In case the audio file is no longer referenced via objects, but contains various takes, 
then not every take has to be deleted in order to fully remove it from the hard drive. 
Instead, use the "Remove unused samples (view page 465)" function from the Tools menu. 

Note: For a better overview, easy-to-use take-naming options are available in the recording 
window (view page 582) even during recording. 
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Take management for multi-track recordings 
For multi-track recordings, each recording creates associated classified takes on each 
track. All simultaneously recorded objects are grouped and also given the same take 
name.  

Switch takes on all tracks: This allows all takes of a multi-track recording to be 
exchanged in one step. 

Note: Since the take manager display refers to the last clicked object, the reference track 
may be switched at any time. 

 

Take Composer 
The take composer is an editing window that displays a selected track's individual object 
recording runs (takes) and the created Revolver Tracks (view page 62) below each other. 
Produced Revolver Tracks are located below the takes. 

Use the take composer to add the best parts of individual recordings of an object to create 
the perfect take, or edit the Revolver Tracks for the corresponding track. 

Open the take composer by clicking the corresponding button in the manager area. 

 

The take composer opens as an extra window below the arranger. 
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In the take composer use the space bar to initiate playback in sync with the arranger. 

In the manager's marker menu you can specify, if you want to display Revolvertracks, if the 
take composer should open in its own window or should be docked to the arranger, and if 
the take manager should run in sync with the arranger.  

 

To quickly execute comping (see below), switch to "Cut" mode or close the take 
composer. 

The current take selection of the respective track is displayed in the first track's take 
composer. During so-called "comping", you can edit the best passages of the individual 
takes together in this master track by using the editing operations described below. 

The individual recording takes are arranged in the take composer one above the next 
starting from track two.  

 

Monitoring with the arrangement 
The take will be played together with the starting arrangement when playback is started 
with the space bar. 

Monitoring without the arrangement 
In order to play the take without the starting arrangement, start playback with the Play 
button on the transport console or via "Ctrl + space bar". 
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A range will also be created that stretches from the cursor position across all selected 
objects. 

 

To listen to the individual receiving passages switch the corresponding track to "Solo" and 
start playing. The default solo modus is "Exclusive solo". 

In case multiple takes or tracks should be played back simultaneously in the take 
composer, click the corresponding track numbers and then press the shortcut "Alt + S"in 
the corresponding track header for the desired tracks. You can switch all selected tracks to 
"Solo" mode. 

Note:  If you have an object selected in a take, then the key combination "Ctrl + space 
bar" has the effect that you will only hear this object during playback – even if "Solo" is 
active on another track. 

 

Comping 
"Comping" refers to the process of combining several takes to create a single one. 

Comping in cut mode 
For this process, the take composer offers a specially modified scissors tool for quickly 
cutting/copying take sections into the first take composer track. 

Select the scissors tool by selecting "Cut" mouse mode. The mouse pointer becomes a 
scissors icon. 

 

Now click on the desired cut point in the respective take. The selected take is inserted from 
the current position up to the end of the first track in the take composer. Auto crossfade 
(view page 526) mode is activated as a default during the process. Cut the suitable 
sections from the respective take in this way along the timeline into the top track.  

If you only want to transfer specific ranges of a take into the comping track, drag out a 
limited range with the scissors tool by holding down the mouse button. When the mouse 
button is released, the section indicated in the respective take will be copied to the first 
track.  



 

M A N A G E R  1 5 5   

The keyboard combination "Shift + click" replaces an object in the comping track with the 
contents of the take composer track over which you are holding the scissors tool. 

 

To play a take from the cursor position in "Cut" mode, use the keyboard shortcut "Ctrl + 
mouse click".  

Comping in "Universal" mode or in "Range" mode 
Another comping option is to select the desired take range in a track.  

In "Universal" or "Range" mode, drag out a range in a take composer track. Use the 
keyboard shortcut "Shift + C" to transfer the selected object's section to the first track. 
Auto crossfade mode (view page 526) is also activated by default during this process. 

 

 If however you don't mark/select a take range, the shortcut "Shift + C" will insert the 
selected take from the current position up to the end of the first track in the take 
composer. 

This enables you to select the best parts of the available takes and add them to the top 
track in the take composer. These parts may be combined to create the perfect take. 

When the take composer project is closed, changes may be confirmed, which transfers the 
take manager's comping track into the original project. 
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VSTi manager 
The VSTi manager facilitates easy display, insertion, and deletion of MAGIX, VST, and 
ReWire instruments in the current project. Right clicking the selected instrument opens the 
plug-in dialog for the selected VSTi. If the plus sign beside the instruments display is 
clicked, the outputs to the assigned tracks will be shown. By right clicking "Output to 
track", a track may be selected which should only be fed the individual output of each. The 
assigned output then appears in the target track's plug-in slot. 

The general instrument outputs are routed in the VSTi manager via "Routing setup". 
Specify how the outputs should be routed in the dialog that appears. Either route all 
outputs to the current track or create new mono or stereo tracks for each output. Pressing 
the "Del" key removes a selected instrument completely from the project. If only individual 
output signals were selected, routing to a track is canceled by pressing the "Del" key. 

 

Detailed information about instrument routing settings and about managing single outputs 
is provided in the chapter "Software/VST instruments -> "Routing instruments (view page 
318)". 

 

Routing manager 
The routing manager provides a clear overview of the matrix of inputs and outputs and 
AUX connections of all tracks. 

 

You can assign several tracks to the same inputs and outputs by selecting the desired I/O 
for the first track and then assign the same I/O by pressing "Shift" + clicking on the last 
track. Routing may be arranged vertically or diagonally. 

In the output section, all tracks are displayed as potential submix busses behind the 
playback devices; a track may be quickly converted into a submix bus by clicking the 
corresponding matrix field. 
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Similarly, an AUX bus may be routed to an individual track. Right clicking allows you to 
define the AUX bus as a pre-fader send or as a sidechain send, or access the stereo editor 
for panorama specification for the respective AUX bus. 

 

Soundpool manager 
In the Soundpool Manager you can integrate you Soundpool loop content in a clear form. 

 

In the input field next to the magnifying glass enter a combination of letters which should be 
in the loop you're looking for. Clicking on the magnifying glass symbol starts a search for 
the corresponding loop name. 

You can access a selection menu by clicking on the cog symbol. Here you can: 

 Add styles: Search the folder system for the desires soundpool style 
 automatically play the selected loops 
 Hide instruments without available loops 
 reset the soundpool. The list of styles shown in the Soundpool will be deleted. 
 Clean Soundpool: With this function only the styles available on the hard drive will be 

displayed in the Soundpool. Soundpools on storage devices as well as styles deleted or 
moved from the hard drive will be removed from the Soundpool view. 

With the play arrow symbol you can start and stop the selected loop. 
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Mixer 
Mixer overview 
You can open the Samplitude mixer via "Window > Mixer". The mixer is very similar to a 
hardware mixing board. As a result of the digital environment, however, Samplitude's mixer 
is far more flexible than an analog mixer. 

All settings made in the mixer are processed and edited in real time. This includes track 
and master effects, panorama and level settings, device assignments for individual 
tracks/buses, and device assignments for the master section. 

 
 

Using the mixer 
Every VIP track has a corresponding mixer track. However, you can hide any VIP or mixer 
track in the track manager. 

 

Alternative mixer skins 
The system options (shortcut: "Y") in "Design -> Skins" feature alternative mixer skins. A 
further option for changing the Mixer skins is to click on the System menu in the Mixer 
window (the Samplitude symbol in the top left corner of the Mixer window). The "Hardware 
controller (view page 365)" function is also located here. 
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Mixer keyboard shortcuts 
 Cursor buttons: Use the cursor buttons on your keyboard to select the various mixer 

elements and select active elements (fader, knob or switch). 
 Page up/page down: Changes the value of the active mixer element. Hold the "Ctrl" 

button simultaneously to change the value in large increments, and hold down the "Shift" 
button for smaller increments. 

 Home: Resets the mixer element to its preset (passive) initial value. If you press "Home" 
again, the element is reset to the last value, providing a simple comparison between the 
changed and initial preset states. 

 End: Opens the assigned sub-window of an element, e.g. the EQ window for one of the 
EQ knobs. This function corresponds to right clicking a knob with the mouse. 

 Enter: Opens the numeric entry field for a control. Switches are turned using the "Enter" 
key and "Page up/Page down" keys. 

 Del: An activated plug-in slot may be reset via the "Del" key. 

 

Mixer operation with mouse and keyboard 
Left click:  Selects a control element. 

Right click: Accesses either a context menu for the corresponding control element or a 
dialog with additional settings. 

Ctrl + left click You can use this shortcut for multi selection. 

Shift + left click: You can select all similar control elements between the previously 
selected and the current control element (multi selection). 

Hint: After selecting several mixer elements, you can form these into one 
group (view page 167). Use the "Group selected controls" button to do 
this. 

Ctrl + Shift + left click" on knobs and faders: This keyboard shortcut switches the 
behavior of corresponding faders or knobs within a linked group (inverse selection).  

Some mouse movements create opposing movements of two grouped faders or move 
panorama faders of two tracks in the opposite direction. 

Ctrl & Left-click: A single control element can be temporarily positioned within a group by 
pressing the “Alt” key and operating the element. 

Double-click on numbers: Opens the entry box to allow manual entry of numeric values. 

Double clicking on control knobs: Resets the control element to its preset (initial) value. 
Double clicking again sets the value back to the altered value. 
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Left clicking on value displays: Clicking on the area below the faders or on the left button 
corners decreases the values. If the mouse is held down, the value is automatically 
reduced until the key is again released or the end of the scale has been reached. (Shortcut: 
Page down)  

 

Clicking on the area above the faders or on the right button corners increases the values. If 
the mouse button is held, the value is automatically increased until the key is again released 
or the end of the scale has been reached. (Shortcut: Page up) 

 

The level faders can be adjusted very precisely. If you click on these, whilst keeping the 
left mouse button pressed and moving the mouse pointer left or right from the fader you 
can fine tune the settings by moving the mouse on a vertical plane. The steps of the 
settings become smaller as the mouse pointer is moved further away from the selected 
fader. 

 

The step size of the fader movement also becomes smaller if you hold down the "Shift" key 
while moving a fader. 

Knobs can be set in two different ways. After clicking on a knob you can move the mouse 
around the knob or move the mouse up and down like with faders. This makes it possible 
to reduce the step size value by holding down the shift key. The way in which the knobs 
are controlled can be set in the "System Options" dialog (shortcut: "Y") under "Keyboard, 
menu & mouse -> Mouse". 

New AUX bus in mixer:  A newly added AUX bus is always displayed in the arranger at 
the bottom and in the mixer to the right with the highest channel. 

Drag & drop in mixer: You can rearrange individual channel strips in the track number box 
or name box via drag & drop. The mouse pointer turns into a hand. The overall settings of a 
channel can be transferred to another channel via dragging & dropping the "FX" button. 
The EQ settings can be transferred by dragging & dropping the "EQ" button. 

The plug-in slots offer drag & drop functionality to copy effects to a different track or 
between tracks and the master. The effects sequence for VST and DX plug-ins can be 
changed within the track via drag & drop.  
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Note:  If a certain effect is already available, a repeat drag and drop of the same effect onto 
the same track performs a reset of the effect to the values of used effect, and does not 
copy it; the original values will be overwritten. 

If all you want to do is move shift effects between the channels in the mixer instead of 
copying them, simply keep the Shift button pressed while dragging & dropping. 

 

Channels 
Each track in the VIP is fed through a specific mixer channel. The sound settings of the 
respective mixer channel are applied to the objects on the track. 

Each channel strip provides the following settings options. Each individual section can be 
opened and closed by clicking on the corresponding arrow symbol. 

In (Input): In this field you determine the recording mode for the incoming signal: 

 If you select "1+2 - Stereo in", the channel input will be switched to stereo and the 
signal will be picked up on two channels. 

 If you select "1 - Mono in", the channel input will be switched to mono and the signal 
will only be picked up on one channel. 

 If you select "Mono mix in", the channel input will be switched to mono and the signal 
will be picked up on two channels and then mixed down to one. 

 "Mono effect processing" enables you to switch the processing for the complete 
channel from input to panorama fader to mono. This results in all object effects and track 
effects being calculated before the panorama fader in mono. This function saved CPU 
resources, given that it is supported by every plug-in. Opening "Mono effect 
processing" switches the input to mono automatically. This function corresponds with 
the mono switch in the track editor. This option is not available for buses because they 
always calculate in stereo. 
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In: Specifies the audio input for recording. 

Gain: The mixer adjust the input amplification for the respective channel. 

AUX sends: This section allows you to activate and set up the AUX 
component for different AUX buses (view page 172). Open a menu by right 
clicking for advanced settings such as Pre fader send, "Sidechain send" or 
AUX pan editor". The upper "AUX" button above turns all AUX paths either 
active and inactive, which effectively makes it an AUX bypass switch. 

Inserts: Here you can add effects to the channel strip. Clicking on the arrow 
right of the accordant Insert Slot, opens the selection menu. The "Insert" 
button above activates all effects (FX inserts + plug-ins). A visual indicator (*) 
is displayed for plug-ins that were previously active and are active the next 
time "Insert" button is pressed. 

Equalizer: This section lets you change the sound of the track signal by 
means of a 4-band parametric equalizer. The knobs change the volume of 
the filter band. 

You can numerically edit the gain and frequency of the corresponding filters. 

Right-click on one of the dials for fine-tuning. Samplitude shows the EQ 
dialog in which you can specify exact settings. 

Panorama: Here you can set the direction of the signal in the stereo 
panorama. The settings of the knob have a different effect on mono and 
stereo tracks. When set to the center position, the track signal is held in the 
center of the panorama irrespective of the whether the track is mono or 
stereo. If the knob is moved away from the center position, the mono signal 
is moved to the left or right within the stereo field. For a stereo track, the 
alignment between the left and right channels within the track signal 
changes. 

Beside the panorama dial, you'll also find a switch to reverse the phase. 

Right click one of these two control elements opens the stereo panorama 
dialog (view page 220) to adjust additional settings like panning laws or the 
stereo width. 
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Detailed information about the stereo panorama dialog can be found in the chapter "Stereo 
panorama dialog (view page 220)". 

Link: This button connects the corresponding channel with the one to the right of it. All 
faders, panorama, input, AUX sends, as well as EQ settings and adjustments now affect 
both channels. Both panorama faders are linked through inverse selection. With this 
keyboard shortcut Ctrl + Shift + left click on knobs and faders: you can switch the 
behavior of corresponding panorama knobs within a linked group (inverse selection). 

Automation: This button gives you access to the channel's automation functions 

Detailed information about automation is available in the chapter "Automation (view page 
327)". 

Solo: The solo button mutes all channels with the exception of the selected channels. 
Right clicking enables the selection of the output device for the channel. 

Shortcut:  Alt + S 

Solo exclusive: This setting switches the active track to "Solo exclusive" mode, i. e. only 
the active track is audible. All other tracks are silenced in solo mode. 

Shortcut:  Shift+ Alt + S 

Detailed information on the global solo modes can be found in  "Global buttons -> Global 
solo modes" (view page 171). 

REC: This button activates the track. Right click to determine the recording mode for the 
incoming signal. (see "In (Input)"). 

Mute:  The mute button mutes the selected channel. Right clicking enables the selection of 
the output device for the channel. 

Shortcut:  Alt + M 

Mute/Inactive: Mutes and also deactivates the track. This increases performance as 
caching and FX processing of this channel are not necessary. 

Shortcut:  Ctrl + Alt + M 

Mute bus inputs:  Use this function to mute the bus inputs routed to this channel. 

Volume fader: Controls the track levels. The behavior of the volume fader in the MIDI track 
is preset on controller 7 (MIDI volume). Alternatively, you can also specify that "Volume 
fader" mode does not change for MIDI tracks or that the volume fader for MIDI tracks 
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should match the MIDI velocity scaling (view page 244). To do this, right click the track's 
volume fader.  

Note that a virtual synthesizer's audio output can usually be created, edited, and mixed on 
the same track as the MIDI data the instrument is receiving. In some cases, this results in 
duplicate use of the volume fader which, on the one hand, controls velocity or MIDI volume 
(CC7), and on the other, this controls the audio level. These are not identical parameters. 
For instance, you may include a MIDI instrument played with high velocity quietly in the mix 
and vice versa. For this reason, the volume fader may be assigned differently. 

Hint: You can also enter levels higher than 6 dB numerically. 

Monitoring: Click the loudspeaker symbol to activate the monitoring function. Audio 
material will be passed through the inputs of the sound card and forwarded to the outputs. 

If the "Hybrid Engine" is set up for monitoring, all mixer channel effects for the feeds can be 
used. This requires working ASIO drivers for the sound card. Samplitude can therefore be 
used as a live effect device for example. 

More details on Monitoring can be found in the chapter "System settings >"Monitoring 
settings" (view page 27). 

Track name: You can enter the name of the VIP track here. This name can be edited by 
double clicking. 

FX:  This key activates the effects routing dialog for the corresponding track, and can be 
used to configure and edit the effects chains. This specifies the sequence of the effects. 

More information about this is available in the chapter "Buses and routing -> Order of 
effects calculations and signal manipulation (view page 173)". 

Right clicking the "FX" button opens a context menu. Here you can open the effects 
routing dialog for the channel, as well as preset effects settings. Track effects settings can 
be copied, inserted, reset, saved, or loaded. Save your personal track effect settings in the 
program directory in "FX presets -> Track FX". Of course, new subfolders may also be 
created. 

Out:  Sets the channel's audio output. This may be either a submix bus in the mixer or a 
playback device. 
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Master section 
The master section can be found to the right beside the channel strips. 

 

Master plug-ins: This function can be used to set effects 
inserts, MAGIX plug-ins, VST or DirectX plug-ins for the master 
out signal. Right click on the control button to show the plug-in 
dialog. To switch the plug-in effects on or off quickly, click the 
control button. 

De-hisser: The "De-hisser" mastering effect helps reduce 
existing distortions like high-frequency hissing. Open the "De-
hisser" dialog by right clicking it. 

FFT EQ: A right mouse-click opens the FFT filter dialog. 

Vocoder: Here you'll find the Vocoder for the entire signal. A 
right mouse-click opens the dialog. 

Room simulator: The room simulator for the entire signal. A 
right mouse-click opens the dialog. 

Multi-band Dynmics: A right mouse-click opens the entire 
multi-band dynamics section. 

 

Advanced dynamics/limiter: Right click to open the compressor/limiter dialog for the 
master signal. 

Master Equalizer: This Equalizer affects the sum signal. 

Stereo enhancer (SE): The multiband stereo enhancer is used to modify the entire signal's 
stereo picture. Three bands are available for the bass, mids, and high frequencies. 

Mono: This button plays the entire signal in mono. Its purpose is to verify mono 
compatibility. 

Normalize (N): This is the master normalization. If this key is selected, the output level will 
be adjusted in such a way that the loudest signal sections reach 0 dB levels. The maximum 
level reached during the last playback will serve as the basis during this process and will be 
displayed on the peak meter. 
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Hint: Click the level display in stopped state, and the play cursor will jump to the position 
indicated by the level. 

Link: This key connects the left and right channels of the master signal. 

Faders: Both of these faders adjust the left or right master signal. Reset the faders to the 0 
dB position by double clicking them. 

FX: Opens the effects/routing dialog for editing and configuring any number of effects 
chains. This specifies the sequence of the effects.  

More information about this is available in the chapter "Buses and routing -> Order of 
effects calculations and signal manipulation (view page 173)". 

 

Mix to file while recording 
The Mix to file and On buttons may be used to mix down in real time and to change any 
of the mix's parameters during playback. At the end of the playback process, the mixdown 
created will be written to a wave file. 

1. Click the "Mix to file" button to open a dialog to specify the name and place where the 
created wave file should be saved. When the "On" button is active, the master output 
of the mixer can be written to a wave file during playback. 

2. Now start playback of the VIP 
3. On playback, any parameter may be changed in order to record any live adjustments 

that are made. 
4. At the end, stop the playback of the VIP. 

Important: Make sure that the "Mix to file – on" button is deactivated if the master signal 
should not be mixed into a new file. Otherwise, the system creates a wave file every time 
the file is played. 

The "Mix to file" function does not necessarily need to be used to record dynamic mixer 
movements during playback. Effects may be controlled via AUX busses, and volume and 
panorama curves may be automated. 

Note: The "Mixdown" button is available in some mixer skins, e.g. "Multi-track mixer" or 
"Recording mixer". This function also mixes down and saves the entire VIP, including all 
settings, to a single file. In contrast to "Mix to file", no parameter changes during playback 
are taken into consideration, but the track is merely "bounced". Detailed information may 
be found in the menu reference under "Menu tools -> Track bouncing (internal mixdown)". 

Device/master out: Enter the playback device for the stereo signal. Select "Master 
inactive" if the master playback device should not be used in the project (e.g. multiple I/O 
setups). 
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Note: If the settings for the master playback device are changed, all tracks routed to the 
master will also automatically change settings. If this automatic process is not helpful, 
select "Master inactive" before setting up a new device. 

 

Global buttons 
Some further buttons for adjusting the global settings of the Mixer window and Mixer 
handling can be found at the right side of the Mixer window. 

This includes clockwise from bottom left: 

 

Start track: If the arrangement has many tracks, only a 
section of the corresponding mixer channels are 
generally displayed in the mixer window. The visible 
section can be moved using the scroll bar at the 
bottom of the mixer. 

 

Hold the "Shift" key down and click on one of the "Start track" buttons to save the current 
view (a left click is sufficient the first time). 

The previously saved section may be recalled by clicking the "Start track" button again. 

Right click the "Start track" button to open a context menu to select between "Load 
snapshot", "Save snapshot", and "Delete snapshot". 

 

Solo/Monitor/PFL/AFL/Solo in Place: (view page 170) 

 

 

Show functions: Individual sections of the mixer window may be 
switched on and off to the right of the master volume fader. 

 

 
Group selected controls: These two buttons are used to group and 
ungroup elements of the mixer.  
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To group track controls, select the desired elements while holding down "Ctrl" and then 
activate "Group track controls". To ungroup, choose one of the elements in the group and 
then press "Ungroup controls". 

Note: If you have previously selected multiple tracks, this is also available to group selected 
controls in case the same control elements are involved. More about grouping tracks in 
Samplitude is available in "Working in the project window -> Selecting/grouping multiple 
tracks (view page 98)".  

Multi-channel selection:  Multi-channel selection in the mixer functions exactly like multi-
track selection in the arranger, i.e. by clicking the track number/name while holding down 
the "Ctrl" key or "Shift". In order to clear a group of channels, click a channel before or after 
the selection and activate a control element. 

 

Play/stop: Playback of the VIP can be started and 
stopped with this button. Right clicking opens the 
transport console. 

 

 

AutoRec: This display will light up if the level automation is 
written in Master. 

Bypass: Using this button you can switch off active effects in the project for comparison 
purposes. 

Solo/Mute: All solo/mute functions can be globally activated and deactivated using these 
buttons. 

 
Load mixer setup/save mixer setup: These buttons 
enable the current mixer settings to be saved as a preset 
(without snapshots) or previously saved mixer setups to be 
accessed. 
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Snapshots:The Snapshot Function is particularly useful to 
compare various Setups with each other. You can easily 
switch between setups. Naming snapshots is possible by 
double clicking the name field. Right clicking a snapshot 
opens a context menu to save, load, or delete snapshots 
or to switch snapshot banks. Using this process, up to 32 
mixer snapshots can be saved. 

Save mixer to file: Save mixer settings to a separate file via this menu item. 

Save mixer with snapshots: This option enables mixer settings to be saved including 
snapshots. When these mixer settings are loaded in the future, a dialog will ask whether 
the saved snapshots should also be included. If this is confirmed with "Yes", then you will 
overwrite any snapshots used up until this point. 

Load mixer from file/load mixer from file (including track names): Complete mixer 
settings may also be accessed with or without track names. 

Load last mixer: When loading a snapshot, the current mixer settings will be saved 
temporarily and these may be recalled via the command "Load last mixer". This makes an 
A-B comparison between the snapshot and the settings possible. 

 

Reset FX: This enables you to remove effects from the signal path for all 
channels. 

Reset peaks: This enables the LED peak meter to be reset (peak hold 
display). 

Reset EQ: Resets all equalizer settings. 

Reset AUX: Resets all AUX portions of the channel strips to their default values (= no AUX 
portion). 

Reset (stereo): Resets all mixer settings to the default settings for stereo tracks (when 
working with stereo wave projects). This reset function refers to the track panorama 
settings (view page 220). 

Reset (mono): Resets all mixer settings to default settings for mono tracks (when using 
mono or LR wave projects). This reset function refers to the track panorama settings (view 
page 220). 

 
Setup: The mixer setup dialog can be opened by clicking the "Mixer 
setup (view page 468)" button. 

?:  Click this button to open the help file, which includes detailed information about the 
mixer. 
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Solo/monitor volume fader 
A solo and a monitor level is available in the master section of the standard mixer. 

 

The solo fader controls the monitor volume in "Solo" mode, while the monitor fader 
influences the level on the monitor output. The audio monitoring point may also be set 
using the AFL/PFL switch. 

 PFL = Pre Fader Listen 
 AFL = After Fader Listen 

In general, the monitor bus behaves like "Main to Monitor", meaning that the content of the 
master may be heard at the same time on the monitor bus. As soon as solo is activated, 
only the solo state is played over the monitor bus. 

 

Solo in Place (default) 
This solo button method has been available in Samplitude since the beginning. "Solo in 
place" sets channels to solo in the mixer at their corresponding positions within the stereo 
picture of the mix. Simultaneously, all other channels are muted. "Solo" mode is normal 
during mixing to identify instrument tracks and edit them. 

Switch to "Solo in place" mode by deactivating the solo output bus and switching to "Solo 
bus inactive/Solo in place" in the device selection under the AFL/PFL button. 

 

Caution: When using the monitor fader in this mode, it's possible to influence the audible 
master level and thereby the level of external devices connected to the stereo master. You 
can set the monitoring volume in the mixer without using external volume controls. The 
audible result is different than the peak meter display in the mixer, which is the reason for 
the numerical level values in the mixer displaying in red. Additionally, the solo fader 
influences the volume of the solo tracks that are played via the master area. The internal 
level for bouncing and burning, however, remains unchanged. 

Another function of this mode in Samplitude is to toggle between "Pre-fader listen" and 
"After fader listen" in "Solo in place" mode by clicking the AFL/PFL switch. 
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Solo/monitor bus (in the "Hybrid Engine" only) 
Use this bus to monitor tracks individually by pressing the corresponding solo buttons 
without influencing the stereo sum signal. This also affects mastering or live mixing. 

The signal may be accessed at two different positions: 

PFL: PFL (pre-fader listen) accesses the signal before the faders and effects, but after the 
input gain. 

AFL: AFL (after-fader listen) includes all panorama changes/fader movements and 
influences the monitoring signal accordingly. 

To set up an AFL/PFL monitoring line, switch the button to AFL or PFL by clicking it, and 
then select an output in the slot under your sound card as a solo bus. 

 
 

Global solo modes 
You can use the solo bus selection to set the global presets for using solo. This may also 
be accessed by right clicking the solo buttons. 

 

Global: Solo is not explicitly listed as a mode. If no check is set for a solo mode, then 
global solo will be active and you will hear the solo channels without AUX return channels. 

Global: Solo safe: While in "Solo in place" mode, every channel switched to solo may be 
heard including the AUX return channels automatically. 

Global: Solo PFL (available only in hybrid mode) switches solo tracks to PFL mode. The 
signal is accessed before the fader and effects, but after the input gain. When deactivated, 
the solo tracks are accessed after the fader. 

Note: Economy tracks cannot be monitored with PFL. 

In Global: Solo exclusive mode, only one channel may at a time may be switched to solo 
by clicking the solo button. In this case, the solo state is deactivated for all other tracks. If 
you activate the "solo" button for another channel, only this will be switched to solo. Solo is 
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deactivated for the channel previously switched to solo. This enables you to quickly "walk 
through" individual channels. 

To listen to the AUX return channels on the channels switched to "solo", select "Global: 
Solo safe" mode as well.   

Note: While in "Global: Solo exclusive" mode, to still be able to listen a single channel in 
"Solo exclusive" mode, click the channel's "solo" button while holding down the "Shift" + 
"Alt" keys.  

If you have already set "Solo exclusive" as the global solo mode, the same key combination 
deactivates "Solo exclusive" mode in order to hear multiple channels "solo" at the same 
time. 

 

Buses and routing 
AUX buses 
An AUX bus combines all signals of the corresponding AUX sends from the individual 
channels. AUX buses are usually used for controlling real-time effects via the volume curve. 
For this purpose, part of the signal of the desired mixer channel is sent to the AUX bus 
("AUX send") where effects are added. The fader of the AUX bus represents "AUX return". 

Note: AUX tracks normally don't contain objects in the arranger view. They provide objects 
on other tracks with effects. 

 

Submix buses 
A submix bus combines several tracks. It controls the volume, panorama, and effect 
settings of all tracks that are "routed" to the submix bus. For example, all drum tracks (hi-
hat track, bass drum track, etc.) may be combined as one submix bus so that the entire 
drum kit may be controlled via the volume controller of the submix bus. 

 

Creating submix/aux buses 
 An AUX/a Submix Bus can be created in the Mixer at any time. 
 To create an AUX bus, click with the right mouse button on the number of the channel in 

the mixer. In the context menu, select "Insert tracks -> New AUX bus". Another option 
for adding an AUX bus is to access an unused slot in the AUX area of the track 
editors or the mixers. This creates a new AUX bus automatically. 

 If an AUX bus has already been created, you can the feed the signal of the previously 
created AUX section into the the newly created AUX bus. 

 To integrate a submix bus, click with the right mouse button on the number of the 
channel in the mixer. In the context menu, select "Insert tracks -> New submix bus". 
The submix channel is integrated behind the channel that is accessed. If the output of 
several previous channels is now routed through this bus, the volume of these signals 
may be controlled via the newly created bus.  

 Right clicking the number of a channel provides an option to select between the 
properties "AUX bus", "Submix bus", or even both for the respective channel strip. 
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 Submix or AUX busses are always meant for stereo busses. 
 Submix and AUX buses may be used for all channel effects, including volume, panorama 

automation, and AUX send. The outputs may be routed for any channel to output 
devices or other submix buses with higher channel numbers. 

 Automation of AUX and submix busses works the same as on all other channels. 

 

AUX Routing 

 

By right clicking on a mixer channel's AUX button the AUX routing dialog will open. Right 
clicking on the channel number will cause a dialog to appear above, if you select "Track 
effects > AUX sends" in the context menu You can enter the intensity of each AUX bus in 
numeric values or by moving the orange bar (the bar is not visible in Off mode). 

By default all AUX buses are routed "post" in Samplitude. Activate the corresponding "pre" 
box for pre-routing. Use the effects routing dialog (view page 174) to specify the precise 
position of the "pre" and "post" AUX buses within the effects chain. 

The "Pan" button applies a complete panorama section for every AUX send, which 
operates analogous to the stereo panorama dialog (view page 220) of a track. This enables 
the stereo width to be changed or the phase to be inverted for the AUX send, for example. 

New AUX bus: Creates a new AUX bus. 
Reset AUX Sends:  All AUX settings are reset. 

 

The sequence of effects calculations and signal 
manipulations 
The sequence of gain, panorama, and filter manipulations has no effect, at least when 
working with 32-bit float. In this case, it is not important whether you filter first and the 
change the gain, or vice versa. Most other effects are also independent on the input signal. 
This includes the Room Simulator, Stereo Enhancer, Delay, Resampling, and Time 
Stretching or Pitch Shifting. 

All dynamics functions and those that remove or reduce noise (De-hisser and noise 
reduction) are dependent on the input signal level and, in some cases, on the frequency 
response of the input signal. Once the optimal settings for a parameter have been found, 
other effects located in front of the effects should not be adjusted. For example, use the 
De-hisser and the multi-band dynamics section in the mix master only after all other 
changes have been applied to the individual objects and the mixer channels. 



 

1 7 4  M I X E R   

 

Effect routing/plug-ins dialog 
Open the effects routing/plug-ins dialog to specify the most important settings for real-time 
effects/plug-ins. This dialog is available at object level ("FX routing" in the object editor), 
channel/track level ("FX" button in the track editor), and at mixer level ("FX" button in the 
stereo channel strip). 

 

Effects Sequence/Plug-ins 
All available effects are displayed in the effects list in the respective context (track, object, 
or master). 

The sequence of the effects may be configured freely via the effects routing dialog. Open 
this dialog via the "FX" buttons in the track editor, track box, and mixer. 

 

You can set new sequences using the arrow keys. Order the FX inserts before or after the 
EQ or the dynamics. The free movement of the effects in the insert slots of the track editor 
or the mixer channel is limited by this order.  

Note: Effects inserts may only be moved as a group. 

Right click on an effect in the effect routing dialog to access the settings dialog directly. 
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You can add plug-ins via the "Plug-Ins" dialog: 

 
 

Plug-ins pre or post 
The plug-ins dialog enables you to introduce effects "Pre" or "Post". Highlight "pre" or 
"post" in the plug-in list before loading a plug-in. The plug-in is then inserted "pre" or "post" 
fader, respectively. Effects may be moved freely into the track editor or mixer channel's 
insert slots, but they are limited by the fixed position of the plug-ins in sequence (view page 
174), e.g. DirectX/VST plug-in (pre) and DirectX/VST plug-in (post). 

 

Effect routing/plug-ins dialog parameters 
Save/load/delete: Manage your individually customized settings here. 

Up/down buttons: Change the position of an effect or plug-in with the up/down arrows. 

On/off: Switches of the corresponding activated effect or the activated plug-in. Activating 
or deactivating the checkbox preceding the corresponding effect/plug-in has the same 
effect. 

Edit: Opens the dialog for the active effect/plug-in. Another way to open an effect/plug-in 
dialog is to right click the desired effect or plug-in's name. 

Detailed information about the plug-in dialog is available under "Software instruments/VST 
plug-ins/Rewire -> Plug-in panel - graphical display (view page 319)".  

Delete: You can also remove internal Samplitude effects (insert effects) and plug-ins 
instead of just deactivating them, if you want to save resources. 

Reset: Returns all settings to the Samplitude basic settings. 

Copy/paste: Use these buttons to quickly apply the settings to different tracks/objects. 

Play/stop: Starts and stops playback at the current cursor position. 
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Plug-in latency/force latency: Samplitude works with latency compensation for all plug-
ins. Plug-ins report their latency to Samplitude, and this value is transformed into a time 
shift in the audio material; time shifting  no longer occurs when plug-ins are used. If the 
values reported by a plug-in remain incorrect (time delays result from the use of a plug-in in 
spite of this), then you can force a specific latency value to compensate. 

Plug-in options -> Settings: Opens the VST/DirectX setup dialog in the plug-in options 
area. 

 

VST / DirectX / ReWire setup / Plug-in buffer 

 

VST plug-in path: Set the path to your VST plug-in effects and VST instruments here. If 
you click the folder icon, a context menu will appear. This allows you to use the VST folder 
already set for your system as the plug-ins path or select any other VST folder. The 
selected folder is then scanned by Samplitude for VSTs. Plug-ins are then checked for 
usability within Samplitude. This scan is only necessary once per folder, since available VST 
plug-ins are saved during this process. If multiple VST plug-in folders are present on your 
computer, then you may enter additional sources by scanning them with the option "(Re-) 
Scan selected VST folder" once more. If individual plug-ins are not integrated as 
expected, then try using the option "(Re-) Scan selected VST folder including failed 
plug-ins" to check them. Samplitude detects newly installed plug-ins automatically, but 
only in the specified folders.The corresponding data is saved in the file "VSTplug-ins.ini". 

Activate ReWire: If this option is selected, rewire-compatible client applications can be 
integrated into Samplitude as synthesizers. 

ReWire is generally used for sample-exact, real-time transmission from audio channels 
between two programs. Both programs can be connected with the same sound card. The 
transport functions of the applications (such as playback and forward/reverse) are 
connected via ReWire. If you are working with ASIO drivers, you can direct sounds from 
ReWire-compatible applications to different sound card outputs. 
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To integrate ReWire applications into Samplitude, find the ReWire-compatible instrument 
that you want to connect to Samplitude in the "MIDI out" slot of the track editor via "New 
instrument -> ReWire". The ReWire application's instrument outputs can be opened via the 
"Audio in" slot for each track. 

The tempo is always oriented according to the settings specified in Samplitude, i.e. 
Samplitude is the master. The tracks/channels connected to the ReWire-enabled software 
may be edited with the equalizer, effects, and other plug-ins, and then routed to the 
available buses. 

Note: Please make sure that the sample rates set for the applications connected via 
ReWire match one another so that playback may be guaranteed at the correct pitch. 

Additional information about ReWire is available in the chapter "Software instruments/VST 
plug-ins/ReWire -> ReWire client applications (view page 325)". 

Plug-in buffer 

The default presets usually cover most cases when working with plug-ins. Try out various 
presets if you are experiencing any problems with plug-ins or DSP cards. You can specify 
the buffer size directly that is sent to the plug-in for XD and VST plug-ins. The following 
special values apply in this case: 

0: The program specifies the buffer size 

-1: The ASIO buffer size is used 

The VST buffer size is equal to the standard VIP buffer size. To use the ASIO buffer 
size in the Hybrid Engine, enter the value "–2" or select the "Forced ASIO buffers 
(Hybrid)" preset. The "Forced VIP buffers (use UAD & Powercore in economy engine)" 
setting diminishes latency with UAD/Powercore plug-ins. 

DirectX preload buffer size: If you enter the value "-1" in this case, the entire buffer size 
will be used for DirectX start initialization. 

VST automation resolution 
The Hybrid Engine uses the ASIO buffer size. To achieve shorter automation times in the 
"Economy Engine" (which works with VIP buffers), enter a corresponding lower value here. 

The option "Write DirectX logfile" is for support purposes. This may normally remain 
inactive. You may also activate the option "Start all object-related plug-ins at play start". 
Some plug-ins cause delays when switched on; in this case, these plug-ins should be 
switched on before starting playback, since otherwise errors may occur when the 
corresponding objects are played. 

Disable all DirectX effects while scrubbing/jogging": DirectX plug-ins may cause errors 
when scrubbing or jogging. Use this option to disable communication with DirectX plug-ins. 
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Effects – organization and workflow 
In general there is a difference between effect types. The following effects are available in 
Samplitude: 

Realtime effects / Virtual effects / Non-destructive effects 

(accessible via track editor plug-ins, object editor plug-ins, the track header plug-in 
selection field, the "Effects" menu (in which case a check may not be placed next to 
"Process Effects Offline"), or via the "Insert" section in the mixer) 

These effects are calculated during playback or export. The effect settings may be 
changed at any time to optimize the sound. 

Real-time effects differ according to where they are applied: 

 Object effects that may be accessed via the object editor or the "Real-time effects" 
menu 

 Track effects/mixer channel effects (able to be accessed via the track editor, track 
header plug-in selection field, the track header plug-in button, or the insert section of the 
mixer)  

 AUX effects (accessible via the track editor, track header plug-in selection field, or the 
AUX track header plug-in button) 

 Surround effects (able to be accessed via the insert selection field of each Surround bus 
channel, the track editor, track header plug-in selection field, or the track header plug-in 
button) 

 Master effects (can be accessed via the master section of the mixer) 

Internal offline effects/destructive effects 

(able to be accessed via the "Effects" menu. A check must be placed next to "Process 
Effects Offline". 

These effects are calculated into the original wave file or a new wave file once. After this 
time, the settings can no longer be changed. 

In contrast to real-time effects, during playback, all resources are used during the playback 
of the effect. 

Here too, the effects can be differentiated according to their location of application: 

 Non-destructive audio editing: The effect for the selected area will be written into a 
temporary file. When saving the wave file, the original and the changed areas will be 
recombined again. 

 Destructive WAV editing: The effect for the selected area will be written directly into the 
original file. The "Undo" function is available for reversing operations. 

 Application in a VIP object: The effect will be calculated for the selected area of the 
object. Depending on the settings for application of destructive effects, calculation takes 
place directly in the original material, at the end of the original material, or in a new file. 
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Plug-in effects 

Besides internal effects, additional effects may also be applied as plug-ins. 

Samplitude supports plug-ins in the following formats: 

 MAGIX plug-ins: A selection of included plug-ins, including Analog Modelling Suite (only 
for Samplitude Pro X) Vintage Effects Suite, Am-munition, essentialFX (efx), Vandal, and 
VariVerb Pro. 

 VST effects (VST FX): This includes all external VST effects 
 DirectX effects 

These effects can be accessed as real-time effects via the track editor plug-ins, object 
editor plug-ins, track header plug-in selection field, track header plug-in button, or the 
mixer's "Insert" section. 

 

Save effects parameters (preset mechanism) 
The effect dialogs contain preset selection boxes. These presets are saved and recalled 
to/from the FX preset directory (a sub-directory of the main program directory) and appear 
in the selection box after they are stored. 

 

If the desired preset files are not stored in the FX preset folder, these may be accessed via 
the "Load" function. However, they will not appear in the selection box. Enter the path to 
the effects preset manually. 
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Saving new effects parameters 
In many new effect dialogs you now have direct access to the automation button and 
therefore to the automation menu. This is made possible by a newly created header in the 
respective dialogs. 

 

In the presets input field you can load, save or delete presets.  

Here the overview of the other control elements: 

 
Bypass: The algorithm is removed from the signal route. This enables the 
unedited signal to be easily compared to the result of the algorithm. 

 
By clicking on this button you can toggle between the selected automation 
write/read mode. By right clicking you can get to the Automation context 
menu. 

 
A/B comparison function. This control element is only displayed when it is 
supported by the respective effect. 

 Reset function. This control element is only displayed when it is supported by 
the respective effect. 

 
Play button. 

 Solo button. This control element is only displayed when it is supported by the 
respective effect. 

 Here you can call up extra help information. 

 

 

Track effect settings 
By right clicking on the track/channel number in the Track Editor, Header or Mixer a 
Context menu will open. In the "Track effects" category you can copy, reset, save or load 
current/discarded track effect settings. There are also a wide range of presets available, 
which offer you possible effect combinations and instruments for various applications. 

The track effect settings are .TRKfiles. 
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Effect routing 
The sequence of all real-time effects may be adjusted individually for each track. This 
enables individual sequences to be set for the effects. 

Detailed information about the FX routing dialog is provided in the chapter "Mixer - buses 
and routing -> Effects routing/plug-ins dialog (view page 174)". 

 

External hardware effect integration 
(for "Mixer FX monitoring/Hybrid Engine" only) 

To integrate external effect devices into your setup, you will require a multi-channel audio 
interface. Reserve a channel pair for every external effect device you wish to integrate. 

The integration of external effects or synthesizers can be made via the dialog "File > 
Program Properties > External effects". Here you can set up the inputs and outputs for 32 
external devices, create new Effect Send and Effect Return tracks as well as specify effect 
latencies so that they can be taken into account during latency compensation. 

 

The order of inputs and outputs is saved globally for the program. The setup of the external 
effect integration is dependent on the project. 

Note: Return tracks have to be recorded first in order to be available for track bouncing 
and CD burning. For this reason, external effects are integrated via the program's own 
tracks and are not available in the tracks themselves as plug-in inserts. 

You can open the "External effects" dialog via "Project options" or via the keyboard 
shortcut "I". 
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Routing the effect 
First, replace the description FX01, FX02, etc. in the name column with the name of the 
integrated effect. Clicking the next column opens a selection of the available output devices 
to feed your effect device as an effect send function. In the "Input device" column, select a 
free input device as a carrier for the effects return channel. Next, activate the external effect 
device by clicking the first column and connecting your effect device to the physical audio 
inputs and outputs that were set up previously. 

 

At all points in the program where input and output channels are set up, you may also 
integrate external effect devices, e.g. in the mixer, in the track editor or alternately, by right 
clicking on "Mute" or "Record". In this case, the names of external effects are displayed 
behind the device name. 
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Creating effects send and effects return tracks 
The lower part of the "External effects" dialog lets you create effect tracks for your external 
effect device. 

 

Effect as AUX 
Under "Add effect tracks", select the options "Add FX Send track" and "AUX bus", then 
tick the box beside "Add FX return track", and finally click the "Create tracks" button. 
You'll now see two newly created tracks or channels in the arranger and in the mixer that 
control the send or return signals of the external effect device. 

 

Next, set up the send level of every integrated effect device in the AUX slot for each mixer 
channel using the mouse, and position the effect signal in the mix using the fader of the 
effect return channel. 

 

Effect as insert 
If you want to add an insert effect, select "Add effects track", then the options "Add FX 
send track" and "Submix bus", then set a check next to "Add FX return track", and click 
"Add tracks". 

Two new created tracks will be created in the arranger and in the mixer to control the send 
and/or return signal of the external insert effect device. For the track to which an insert 
effect should be added, select the send (submix) track for the external effects device as the 
output device.  

 

Use the effect return channel fader to set the effect signal's return volume. 
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Note: Make sure input monitoring is switched on for the effect return track. Activate the 
loudspeaker button in the return track to do this. The loudspeaker symbol is highlighted 
and you will hear the effect return signal. 

The routing settings for each channel may also be adjusted in the track settings dialog. 
Right click on the track name to start. For the effect send channel, set the output for the 
sound card connected with the external effects input via "Playback". For the effect return 
channel, set the input of the sound card that is connected with the external effect output 
via "Record". For the channel intended to work with the external device, set the effect-send 
track via "Playback" [e.g. submix: PCM70 Send (track 16)]. 

Use the double arrow buttons beside the track name field in the track settings dialog to 
switch the track settings to those of the neighboring track. 

It is also possible to use an effect combined as AUX as well as a submix bus. To do so, 
both options have to be active when creating new tracks. FX sends may be changed later 
by accessing the track properties (right click on the track header for the FX send bus) and 
setting a check next to the corresponding setting, i.e. "AUX bus", "Submix bus", or "Pre-
master bus". 

 

Effect as pre-master bus 
If you select "Pre-master bus" when creating tracks, the new tracks will be added at the 
end of the project, and all project tracks will be routed to the input of the send track. The 
return track is automatically routed to the master. This enables the external effect to be 
used as a master effect. 

 

Setting latencies for external effects 
Almost every external device features latency that needs to be compensated to function 
synchronously with the tracks in the arrangement. 

Use the "Set latency of the effect" button to set the latency of an effect. A ping signal is 
transmitted to the "Send", and the time it takes to reach the "Return" channel is 
determined by this signal. The resulting value features a doubled ASIO buffer size and the 
latency of the external effect device. 

The option "Automatically identify output (send) device" emits ping signals to all 
available devices. The device that matches the effect is detected automatically. The input 
device for the effect must be set prior to this. 

 

Integrating external synthesizers 
Select the MIDI port as the output device (send) to control the synthesizer here. Specify the 
input of your sound card where the synthesizer is located as the input device (return). Press 
the "Set effect latency" button to set the latency of the external synthesizer to ASIO buffer 
size. 
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Effects and Plug-ins in an Overview 
Real-time effects at track, object, and master level 
Amplitude: Normalize, normalize (quick access), loudness adaptation, fade in/out, set zero 

Dynamics: Dynamics, advanced dynamics, multiband dynamics, sMax11, 
efx_Compressor, eFX_Gate, AM-munition (Samplitude Pro X Suite), AM-track (Samplitude 
Pro X Suite), AM-phibia (Samplitude Pro X Suite), AM-pulse (Samplitude Pro X Suite) 

Frequency/Filter:  Parametric EQ, EQ116, FFT filter/spectral analysis, brilliance enhancer 
(optional), Filtox, De-esser 

Delay/reverb: Delay, room simulator, efx_Reverb, efx_StereoDelay, Ecox, Variverb 

Time/Pitch: Resampling/Timestretching, Elastic Audio   

Distortion:  Distortion, Ampsimulation, Vandal, eFX_VocalStrip, eFX_TubeStage 

Restoration: De-clipper, de-clicker/de-crackler (optional), de-hisser, de-noiser, get noise 
sample, remove DC offset (offline), spectral cleaning (offline) 

Stereo/phase: Switch channels, multiband stereo enhancer, invert phase (both channels, 
left channel, right channel) 

Modulation/special: Convolution, vocoder, efx_ChorusFlanger, efx_Phaser, 
eFX_TremoloPan, Corvex, reverse 

Sample manipulation:  Change sample rate (offline), sample number/2 (offline), sample 
number *2 (offline), reverse, form loop (offline) 

plug-ins 

essentialFX: eFX_ChorusFlanger, eFX_Phaser, eFX_Reverb, eFX_StereoDelay, 
eFX_Compressor, eFX_Gate, eFX_DeEsser, eFX_VocalStrip, eFX_TubeStage, 
eFX_TremoloPan. 

MAGIX Plug-ins: AM-Munition (Samplitude Pro X Suite), AM-Track (Samplitude Pro X 
Suite), AM-Phibia (Samplitude Pro X Suite), AM-Pulse (Samplitude Pro X Suite), Corvex, 
Ecox, Filtox, VariVerb, Vandal 

Process Only Left Stereo Channel 

Process Only Right Stereo Channel 

Process Effects Offline: Tick the checkbox here to process effects offline 

At object level you can swap object channels, invert phases, Object EQ, Object Dynamics, 
Pitchshifting/Timestretching, Object backwards, Elastic Audio, and MAGIX plug-ins. 
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Cleaning/Restoration Suite (optional) 
With the optional "Cleaning/Restoration Suite" the following cleaning effects are available as 
real-time effects and as offline effects: 

 DeClicker/DeCrackler: The DeClicker removes crackling and clicking noises, which are 
typical on scratched records. 

 DeClipper: The De-clipper removes overmodulation 
 DeHisser: The DeHisser eliminates regular, "white" noise, typically produced by 

recordings, microphones, pre-amplifiers or transformers.  
 DeNoiser with Noise Print Wizard: The DeNoiser removes annoying background noise 

from audio material. 
 Brilliance Enhancer: The included Brilliance Enhancer compensates for the loss of 

higher frequencies, for example due to MP3 compression or in the case of old tape 
recordings. 

 Spectral Cleaning: This removes distortions (like coughing, whistling, or singular claps) 
from a recording without influencing the wanted signal. The graphical interpretation of 
the music can be seen in the Spectral Cleaning Editor via a spectrogram. 

Once you've bought the Cleaning/Restoration Suite effects DeClicker/DeCrackler, 
DeClipper, and DeNoiser and Spectral cleaning you can find them in the Effects menu 
under "Restoration". 

Once you've bought the Brilliance Enhancer you can find it in the Effects menu under 
"Frequency/Filter." 

You can find more information on the Cleaning/Restoration Suite in the PDF document 
"Cleaning/Restoration Suite" included with the program. 

 

DirectX and VST effects 
Microsoft's DirectX and VST-compatible plug-ins may also be used for processing effects 
in Samplitude. This allows almost any effects algorithm and VST instrument from third-party 
vendors to be used in addition to the effects included in Samplitude. 

 

VST Instruments 
Additionally in the Track Editor the MAGIX synths Revolta2, Robota and Vita are accessible 
for the first effect slot of each track, plus a list of the included VSTi instruments, object 
synths Atmos, BeatBox 2, DrumnBass and Livid including connected devices using 
ReWire. You can include your VST plug-in folder via "Menu File > Program preferences > 
Effects > VST/DirectX/ReWire (view page 483)" in Samplitude. 

Detailed information about plug-ins can be found in "Software/VST plug-ins/ ReWire (view 
page 312)". 
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MAGIX Plug-ins 
MAGIX plug-ins are effects that are accessible via the track editor plug-ins, object editor 
plug-ins, track header plug-ins selection menu, track header plug-in button, the insert 
section in the mixer, or via the "Effects" menu. These are further divided into the Analog 
Modelling Suite (AM-Phibia, AM-Pulse, AM-Track)(only Samplitude Pro X Suite), 
Vintage Effects Suite (CORVEX, ECOX, FILTOX), essentialFX (eFX_ChorusFlanger, 
eFX_Phaser, eFX_Reverb, eFX_StereoDelay, eFX_Compressor, eFX_Gate, 
eFX_DeEsser, eFX_VocalStrip, eFX_TubeStage, eFX_TremoloPan), VariVerb Pro, AM-
Munition (only Samplitude Pro X Suite) and Vandal. 
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Object synths 
Synth objects represent a special form of synthesizer. The instrument selected, i.e. the 
synth object, is a component of the object created. Objects created in this way are not 
based on previously created MIDI data. They may be edited easily and can therefore be 
conveniently used as an audio building block. 

Synth objects therefore form individual synth objects. Synth objects may be moved across 
tracks in Samplitude in any way without changing the synthesizer settings. The synth 
objects are Atmos, BeatBox 2, Loop Designer and LiViD.  

Synth objects are available as installation options. After installation, they are located in a 
separate folder, i.e. "Synths". 

Synth objects may be accessed via "Object -> New synth object" or via the first plug-in 
slot of the plug-ins section in the track editor for the respectively selected track. A 4-beat 
loop object is created at the current play cursor position. The instrument interface for the 
synth object that is created may be accessed by double clicking the object. 

  

The shortcut "Ctrl + space bar" plays the selected synth object in "Solo" mode. 
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Atmos 
Atmos is a synthesizer that can be used to easily create realistic nature sounds. From 
thunder and lightning to animal sounds and traffic noise, Atmos helps you design natural-
sounding atmospheric noises for your projects. 

 

 In the upper edge of the window, select "Scenario", the top category. Select a nature 
sounds category (e.g. "Thunder and Lightning") here. 

 In the middle of the window, a collection of control elements appears for designing the 
desired ambience. Each element has its own description (e.g. "Thunder") and two 
faders, i.e. "Volume" and "Intensity". The "Volume" controller adjusts the loudness of the 
element. The "Intensity" controller adjust the sound, behavior depending on the variable. 
For "Thunderstorm", for example, this sets the frequency of thunder and lightning; for 
"Rain", this sets the strength of the downpour. 

 The bottom right border features a master volume fader for setting the master volume of 
the synthesizer. The parameters "Random" and "Auto" are also available. "Random" 
produces randomly placed settings, and the "Auto" parameter switches on automation 
of the individual parameters. 
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BeatBox 2 
BeatBox 2 is a 16-voice pattern-based drum computer featuring hybrid sound synthesis 
and a step sequencer. The interface includes a multi-effects section (one effect per drum 
instrument), auto copy, and a convenient velocity editing function. 

A drum sound is created in BeatBox 2 using a sample, which is combined with a synthetic 
sound that can be created using up to three different synthesis models (hybrid sound 
synthesis). BeatBox 2 also enables detailed editing and automation of all sound 
parameters. 

BeatBox 2's interface uses two states. While closed, you can listen to the included sounds 
and patterns or those you've made in BeatBox 2 without using too much window space. 

 

Only the most important control elements are displayed when the program window is 
minimized: 

1. Volume controller: Controls the volume. 
2. Peak meter and preset name: The peak meter enables the output from BeatBox 2 

to be checked visually. Clicking the triangle beside the preset name opens the preset 
list. 

3. Previous/next preset 
4. Save preset: The preset includes the drum kit in use, the pattern, and any possible 

automations (see page 249). 
5. Play/stop: The playback controller in BeatBox 2 starts the BeatBox solo, i.e. without 

playing the arrangement.  
6. Edit button: The edit button opens BeatBox 2 for you to program your own beats 

and sounds. 
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Maximized BeatBox 2 plus window: 

1.  Drum kit: This section is where drum kits (collections of different drum instruments) 
and the individual drum instruments are loaded. 

2.  Selected drum instrument: The settings in the synthesis section (5) and 
velocity/automation (4) always affect the selected drum instrument. 

3.  Pattern editor: Programs the beat sequence. In the top part, different patterns 
(sequences) may be loaded and saved as well as different settings for the view and 
function of the pattern editor. The matrix is where the beat is programmed: one line 
corresponds to a drum instrument, and a column matches a specific time position 
within 1-4 beats. If a cell is clicked, then the respective drum instrument will be 
triggered at this position. 

4. Velocity/control: This section has two modes: velocity and automation. The 
"Velocity" setting displays the velocity levels for the selected instrument's beats as a 
column. The "Automation" setting allows automation to be set for sound parameters 
in the synthesis section (5). 

5.  Synthesis: The selected sound parameters and effects settings for the selected 
drum instrument may be edited here. 

 

The following section explains the sections of BeatBox 2 individually: 
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BeatBox - drum kit 

 

This section loads drum kits (collections of different drum instruments) and the individual 
drum instruments. You can also try out an already programmed pattern with different kits 
or exchange individual drum instruments. 

1. Select drum kit: Use the <> buttons to cycle through the different drum kits. A drum 
kit is a collection of percussion instruments with matching sounds, e.g. rock kit or 
electronic drums à la TR 808. By changing the drum kit, you can add an entirely 
different sound to the rhythm you have already created. 

2.  Save drum kit: Use this button to save the current collection of drum instruments as 
a kit. 

3.  Drum kit list: Click the arrow to the right of the name to open a complete list of 
available drum kits. 

4.  Select drum kit: The arrow buttons function the same way as with the drum kit. The 
sequence of drum instruments in the kit may be resorted via drag & drop. 

5.  Mute/solo: The "Solo" button switches a drum instrument solo, i.e. all other 
instruments which are not "solo" will be muted. The "mute" button mutes a drum 
instrument. 

 

New drum or effect sounds may by added to the current drum kit via drag & drop from 
Windows Explorer. Drag a wave file to a drum instrument to create a new drum sound 
based on this sample. BeatBox 2 copies the sample into the sample folder to make sure 
that the instrument or kit created can be used again later. Drag a complete folder featuring 
wave files to the drum kit to create a kit based on those samples. 

 

BeatBox - context menu 
Right clicking a drum instrument always a context menu: 

 Copy/paste: Copy an instrument from a track and paste it to another one. 
 Empty instrument: An empty instrument is added. No sound is played, it has no name, 

and is used to clean up an unused track. 
 Default instrument: Adds the standard instrument. This features the standard 

parameter for all synthesis shapes and serves as the starting point for your own sounds. 
 Reset automation: Several of BeatBox 2's own presets contain automations. These are 

dynamic sound parameters like filters or pitch changes. This command allows these to 
be completely removed from the selected instruments. 

 



 

E F F E C T S  A ND PL UG- I N S  I N  A N O VE R VI E W 1 9 3   

BeatBox - pattern editor buttons 

 

1. Pattern: Use the <> buttons to switch through the different patterns. The arrow to 
the right opens a list of all available patterns, and the save button stores the current 
pattern. 

2. Clear track/all: All events for the selected instrument (track) or all events for the 
pattern (all) are removed by clicking this button. 

3. Bar selection: The bar you wish to edit may be selected via the corresponding 
number button. Use the "Follow" button to select "Follow" mode, i.e. the step display 
follows the steps of the currently played beat. "All" displays all bars of the pattern. 

4. "1>2-4" auto copy: If more than one bar is set as the pattern length, "Auto copy" 
mode ensures that the drum notes set in the first bar are automatically placed into the 
next bars. This also makes it easy to create a continuous beat, even with a loop 
length of four bars. Notes set in the bars further back are not affected by the "Auto 
draw" function, e.g. making faint variations detectable only in the fourth bar. 

5. Bars: The maximum length of a drum pattern is four beats. This length may be 
selected via the small scroll bar. 

6. Shuffle: This controller changes the timing of BeatBox 2; if the controller is turned to 
the right, 1/8th notes in the rhythm will be played more and more as triplets. If that 
sounds too abstract, simply try it out, ideally with a pure 1/16 hi-hat figure; you'll soon 
see what the shuffle fader is capable of. 

7. Grid: Set the time resolution for BeatBox here. Choose from 1/8th notes (only for very 
simple rhythms), 1/16 (default), and 1/32 (for more refined constructions). 

 

 

BeatBox - pattern editor matrix 

 

This is the heart of BeatBox. A click on any position in the drum matrix creates or deletes 
drum notes (events). Clicking and dragging draws in a series of notes. Together with the 
velocity editing options (see velocity), it's easy to create drum rolls. 

If "Shift" is held while notes in the range are clicked, a rectangle will be drawn out which 
selects the notes contained within this rectangle (lasso selection). Selected notes may be 
copied by dragging them to a new position. If "Ctrl" is also held down, then existing notes 
will remain at the target position. Delete all selected notes by right clicking. 

Two special commands are available for selection: 
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Shift + double click: Select everything in the selected beat. 

Ctrl + shift + double click: Select everything 

A single mouse click cancels the selection. The selection is automatically canceled after 
copying. To keep the selection, hold down "Ctrl" while copying. 

Many functions in BeatBox 2 can be controlled with the keyboard; for example, a beat may 
be triggered with the "Enter" key live in a running pattern. Here's a complete list of the 
keyboard commands: 

General: 

 e -> Open/close the editor 

Pattern editor options: 

 a  -> "1>2-4" auto copy 
 f  -> Follow 
 1..4 -> Show beat 1..4 
 0  -> Show all beats 
 +/- -> Grid finer/rougher 

Selected drum instrument: 

 Arrow up/down -> previous/next 
 p   -> Preview 
 Enter  -> Live input 
 m   -> Mute on/off 
 s  -> Solo on/off 

 

BeatBox - velocity 
Use "Velocity" mode to edit the velocity/automation of the individual drum notes for the 
selected drum instrument. 

 

1. Reset: Sets all velocity levels to 100% 
2. Mode switcher: Switches the range between velocity control and automation (see 

page 249).  
3. Random: The random parameter adds random variations to the set velocities. This 

helps make your beats sound more natural. 
4. Amount: No function in velocity mode. 
5. Velocity level: Enables every set note for the selected instrument to be edited via the 

height of the column. Multiple columns may be edited at once; see "Editing velocity 
values and automations". 
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BeatBox - automation 
Every parameter for a drum sound, including effects, may be automated, i.e. so that it 
changes during a pattern. For example, make your snare drums more lively by adding 
higher voices to loud hits or by setting accents on individual hits with reverb effects. 

 

The synthesizer section below enables the selection of a 
parameter for automation via the small blue LEDs above a 
parameter controller. More about the parameter controllers is 
available in the "Synthesizers" section. 

 

1. Reset: Sets all automation values for the selected parameter to "0". 
2. Mode switcher: Switches the section between velocity control and automation (see 

page 249). This happens automatically when selecting parameters. 
3. Random: The random parameter adds random variations to the set automation. This 

helps make the beats sound more natural because each programmed hit will sound 
slightly different. The level of the random parameter is also influenced by the amount 
controller (see below), i.e. if the amount is at "0", then the randomness will have no 
effect. 

4. Amount: The amount parameter regulates the complete influence of the automation 
values and of the random factor on the selected parameter. An amount of "0" does 
not have any effect at all on the automation; maximum level has the greatest effect. 
The effect of the amount controller on the automation values is made visible by a 
slightly brighter line in the value columns. 

5. Automation values: The selected parameters may be drawn in as a column with the 
mouse. Automation values may also be drawn between the set notes; the sound of 
the drum instrument changes during playback. The automation values are added to 
the original parameter value. 

 

Editing velocities and automation values 

Hold down "Shift" and select any number of bars for velocity or automation with the 
mouse. Two special commands are available for selection: 

Shift + double click Select everything clicked on in the bar  

Shift + Ctrl + double click Select all 
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The "Copy" button copies the selection to the clipboard. If you select this or that track in 
another editor, you can paste the notes there now from the clipboard. If the target selection 
is larger than the contents of the clipboard, then it will be inserted again. This lets you 
quickly add a short section throughout the complete length of the pattern.  

The three handles allow the velocity or automation values to be edited together. 

 

The middle handle increases or lowers the values together. 

 

If the handles are moved horizontally, you can change the curve shape of the transition. 

A single click in the automation section cancels the selection again. 

 

If you move the handles horizontally you can change the curve shape of the transition. A 
single click in the automation section cancels the selection again.  

Note: A selection of velocity values matches the selection of corresponding notes in the 
matrix editor track. 
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BeatBox - synthesizers 
Use the lower section of BeatBox to set the sound for the selected drum instrument. 

Synthesis in BeatBox 2 consists of a combination of a simple drum sampler and a 
synthesizer. There are three different synthesis models possible for the synthesizer: "Phase 
distortion synth" (FM synthesis), "Filtered noise", and "Physical modeling". The mixed signal 
of both components is then processed by a multi-mode filter. An envelope curve 
("envelope generator") time-dependently controls modulations of in all components.  

 

1. Preview drum instrument 
2. Save drum instrument 
3. Select sample: Clicking the arrow selects samples from the categories like kick, 

snare, etc. 
4. Select synthesis mode: Switches between the three synthesis models. 
5. Mix: Mix ratio between drum sampler and synthesizer. 
6. Parameter controller: All six sound parameters for a drum sound may be set directly 

and automated via the parameter controllers. These parameters depend on the 
currently loaded drum sound. By clicking the name of a sound parameter, a menu 
opens for you to add parameter controllers to each drum sound's synthesis 
parameters. 

7. Automation: This selects the controller's parameter for the automation. 
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BeatBox - effects section 
Each of BeatBox 2's drum instruments includes an effects unit which is fed in after the 
actual sound synthesis and editing. Each of these effects units includes a series of high-
quality algorithms to add "audio polish" or to place the sound in a production-typical 
context.  

 

1. FX on/off 
2. Parameter controller: An effects module includes four adjustable parameters. The 

fourth parameter, "Mix", is always available and the remainder possess a function 
dependent upon the selected algorithm. 

3. Automation: This selects the controller's parameter for the automation. 
4. Effects algorithm: Click the arrow to select an effects algorithm. 
 

The available effects algorithms are described in the following: 

 Mono delay (tempo sync/millisec.) 

Simple, monophonic delay effect. 

Parameters 

-Time: Delay time controlled by musical measure (sync) or free  
-Feedback:  Repetitions  
-Damping: High damping of the repetition 

 Stereo delay (tempo sync / millisec.) 

Stereophonic repetition, separately adjustable per side 

Parameters 

-Left/right: Delay times, synced or free  
-Feedback: Compared to mono delay, no repetition takes place in the middle position of 
the feedback controller. When turned to the left, the type of delay is the so-called "ping-
pong" variety, i.e. the signal is sent alternately so that it jumps from one channel to the 
other. When turned to the right, the delay effect is "dual mono", in which case left and right 
sides function as two independent time-delay units. 

 Chorus 
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Produces a typical "floating/shimmering sound" by modulated detuning of a signal to 
"thicken up" its sound or spread it across the stereo field. Detuning is achieved via a short 
delay, the length of which can be varied by the modulation. This produces the so-called 
"Doppler" effect. 

Parameters 

-Time: Delay time in milliseconds. This may be understood as the "base" modulation that is 
stretched or compressed by the modulator. 
- Rate: Modulation speed 
- Depth: Modulation amplitude. Low values modulate only a little; higher values create a 
clear vibrato. 

 Flanger 

Algorithmically similar to chorus, but different in that the delay time is significantly lower and 
delay works with repetitions (feedback). A flanger sounds more "cutting" and up-front than 
a chorus. 

Parameters 

- Rate: Modulation speed 
- Feedback: Delay feedback 
- Depth: Modulation of amplitude 

 Phaser 

A modulation effect just like chorus & flanger, but in this case no detuning takes place. 
Filter components periodically alter the signal's "phase response" (principle of the "phase 
shifter"). Characteristic notches are produced in the frequency spectrum response to 
create so-called "comb filter effects". The phaser effect is suitable for pads and 
"psychedelic" sounds. 

Parameters 

- Rate: Modulation speed 
- Feedback: Feedback of filter steps 
- Depth: Modulation amplitude 

 Room reverb/hall reverb 

In the case of reverb, there are two realistic simulations of natural reverberation. Sounds 
receive "atmosphere" to appear lively and "authentic". Room reverb simulates a small 
space with high echo density. Hall reverb mimics the typical reverb of large concert halls. 

Since natural spaces never sound "static" (air molecules are constantly moving and the 
reflection process is quite complex), both algorithms include a modulation parameter which 
varies the delay time of individual echoes and thereby affects the liveliness of the reverb 
impression depending on strength. 
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Parameters 

- Decay: Reverberation length  
- Damp: Damping of highs to simulate absorption via air, wall materials, and objects  
- Mod: Modulation strength 

 Lo-fi 

This algorithm gives the sound a little bit of "grit", or a certain measure of signal destruction 
depending on its setting. An ideal partner for creative sound design. The simulation of early 
digital synthesizes or samplers is equally possible, since their AD/DA converters were 
anything but "true" in the character of their sound. The sample rate from the output of the 
lo-fi effect can be continuously reduced and a generous measure of "aliasing" distortion 
may be produced alongside the unavoidable loss of highs resulting from "down sampling". 
Bit resolution is clearly changeable, too. 

Parameters 

·Rate: Sample rate 
·Crush: Number of bits 
-Low-pass: Low-pass filter at the output to smooth out induced noise 

 Distortion 

This overdrive effect works similarly to common guitarist effect pedals. Everything is 
possible, from light, bluesy signal saturation to hard "metal shred boards". In this case, a 
dual-band EQ works on the in and output signals and to provide a rich palette of sounds. 

Parameters 

- Drive: Controls the internal level and the overdrive 
- Low: Bass portion 
- High: High portion 

 Analog filter 12/24 dB 

An additional filter may be applied across the entire drum sound. 

Parameters 

·Cutoff/resonance: Filter frequency and resonance 
·Type: Filter type  
-Drive: Filter saturation 

Vintage compressor 

A compressor with a special "analog" controlling behavior for more pumping bass drums. 
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Parameters 

-Input: Input level 
·Attack/release: Time constants for compression. 
·Ratio: Compression ratio 

Synthesis models 

The sound synthesis in BeatBox 2 consists of a simple sampler and a synthesizer which 
includes three different synthesis modules.  

Sampler 

The sampler plays short sound recordings ("samples") in different pitches. The sampler is 
used to create all kinds of drum sounds; the sounds are static and unnatural if the pitch is 
not altered. This is why the sampler is combined with one of the three synthesis models. 

 

Filtered noise 

White noise is filtered by two band-pass filters with separate frequencies and resonance. 
This algorithm is suitable for creating synthetic snares and high-hat sounds. 

Phase distortion synth 

Two oscillators with regulated phase distortion and thoroughly variable frequency modulate 
each other (FM/cross-modulation/ring-modulation). Depending on the setting, this 
algorithm may be used to create kick, tom, or metallic percussion sounds; higher values for 
frequency and modulation level produce noisier sounds for high hats or shaker sounds. 
Since the oscillator frequency can be set exactly according to the musical pitch, this model 
may be used to produce bass lines or melodies. 

Physical modeling 

This is a simple physical model of an "abstract" percussion instrument. A feedback network 
of delays is caused to oscillate by an impulse of filtered white noise (exciter). Depending on 
the setting of the exciter, the size of the model (surface), and the damping, a wide 
spectrum of natural sounding percussion instruments like cymbals, claves, gongs, or 
triangles can be created. 

 



 

2 0 2  E F F E C T S  A ND PL UG- I N S  I N  A N O VE R VI E W  

Loop Designer 
The Loop Designer unifies the notable style elements of the Drum'n'Bass genre in a single 
device: twisted beats and throbbing bass lines. Create authentic drum 'n' bass sounds 
without previous experience using this machine. 

 

The upper half of the synthesizer controls the rhythm section, and the lower half controls 
the bass section. Between this on the left edge, a symbol is provided to control both 
sections or shut them off. For example, the bass section may switched off so that only the 
breakbeat in the drum section is added to the arrangement. When mixing the arrangement, 
only the drum section is added to the mix file. 

The right edge includes a "Volume" controller that is used to control the volume of the two 
sections. The "Play" and "Stop" buttons play your drum & bass creations. 

In the "Velocity presets" submenu, help functions are available for programming the velocity 
sequence (see below for description). Homemade drum loops and bass samples may also 
be loaded there. 

 

Loop Designer - Rhythm Section 
This section makes it easy to create complex and authentic-sounding jungle breakbeats. 
Jungle breakbeats are produced in professional studios by taking a drum loop and splitting 
it into little "bites" and then putting them together into another sequence. The Loop 
Designer makes this laborious process a lot easier. 

The top sequence, i.e. the "steps" row, specifies the new sequence. The blue cells indicate 
the individual sections ("count times") the loop is divided into. 

Left clicking one of the blue cells allows one of six icons to be selected. Each symbol 
indicates other notes or another type of note playback. Each time a blue cell is clicked, the 
next symbol will be selected. 

A short description of the symbols: 
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1: Play drum loop from start 
2: Play drum loop from second note 
3: Play drum loop from third note 
4: Play drum loop from fourth note 
Reverse symbol: Play in reverse from this position 
Stop symbol: Stop playback 

Right click the step cells individually to delete them. The "Clear" button the right deletes all 
step cells; the drum loop is played back in its original condition. 

In the "Velocity" row, intensity values of 0 to 16 may be specified with the mouse (left 
button increases the value, right button reduces it). The manner in which these values 
influence the loop may be specified via the 3 buttons below the "Velocity" row. If "Volume" 
is selected, then the velocity value changes the volume in this cell (16= loud, 0 = quiet). If 
"Filter" is activated, the velocity value specifies the filter strength in this cell (16 = bright, 0 = 
dull). The "Off" button deactivates the velocity values. 

 

Loop Designer - Bass Section 
The bass section produces matching bass lines. Just like in the rhythm section, there are 
also two step rows here: 

 The first row, the "Notes" row, specifies the progress of the notes, i.e. the harmony. Left 
clicking on a cell opens a popup window for selecting a note. Right clicking deletes a 
cell. Clicking with the right mouse button on an empty cell produces a "Stop" symbol. 
This symbol behaves the same as in the rhythm section, i.e. playback of the bass line 
stops at this position. 

 The "Octave" row specifies the octave of the bass line. Octave 1 creates a deeper 
sound, and octave 3 creates a higher sound. Octave values may only be set, if a note is 
also present in the row above. Just like in the rhythm section, the "Clear", "Random 
notes", and a red selection field are available in the upper edge of the bass section. The 
red selection field may be used to select the bass sound. 

 Below the step rows there are two faders for altering the sound: 
 The "Vibrato" controller causes the pitch of the bass tone to "sway". If the fader is all the 

way to the right, the sound will fluctuate more, and if it is all the way to the right, then the 
pitch won't change at all. 

 The "Decay" fader specifies how long it should take until the sound has stopped. Set all 
the way to the right, the fader causes the sound to dissipate quickly (after approximately 
1/4 seconds); all the way to the left, and the sound will reverberate permanently. 
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LiViD - Little Virtual Drummer 
MAGIX LiViD is a great help for creating songs. Only a few details need to be entered for it 
to play a complete drum track with an intro, verses, refrains, fill-ins, etc., and it provides the 
exact structure for the entire song. Brilliant stereo drum samples, played by studio pros 
and adjustable via the "Humanize" effect, create a genuine drum feeling and the perfect 
sound. 

 

Select one of four styles (pop, rock, funk, latin), which are also divided into four substyles 
(TYPE), which are further broken down into six song parts per style/substyle (intro, verse, 
bridge, chorus, fill-in, outro). 

Scramble: Creates a random series of four single-beat patterns per style/substyle/song 
part. "Scramble" regenerates this sequence. 

Shuffle: Moves the second and fourth sixteenth of the beat smoothly backwards (100% = 
triplets). 

Humanize: Moves the position of all events randomly forwards/backwards/not at all. 
Attention! These movements are only very slight and may not be heard clearly! 

Snare: Changes the hit style of the snare between "normal", "side stick" (hit on the edge 
with stick on drum) and "rim shot" (hit on edge and drum simultaneously). Exception: The 
quietest velocity level of the snare  always stays normal ("ghost notes"). 

Hi-hat: Changes the hit style between "soft" (not opened) and "hard" (half opened). 
Exception: completely opened hi-hat (pop, type 1, verse). 

Ride: Changes the hit style of the ride cymbal between "ride" (on the edge) and "ride bell" 
(on the cymbal bell). 
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MAGIX synths 
Samplitude includes Robota, Vita, and Revolta 2, software synthesizers based on VST 
technology  

Robota: Eight voice drum computers for "mean" electronic beats. 

Vita: A sampler with incredibly realistic-sounding, "classic" instrumental sounds like 
different guitars (power chords, clean electric guitar, acoustic guitar, bass guitar), different 
pianos, percussion, strings, brass, woodwinds (each as an individual set & as an ensemble 
set), and much more. 

Revolta 2: An analog, varied, and powerful-sounding 12-voice synthesizer featuring a 
sound matrix, noise generator, and nine effect types. Use this synthesizer to create any 
electronic music you can imagine. 

The following differences define the synth objects: 

 MAGIX synths are always loaded to a certain track 
 All MIDI objects on this track control this instrument 
 All editing options in the MIDI editor are available 
 MIDI recordings are possible via the MIDI keyboard 
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Robota Pro 
Robota is a single octave drum computer VST instrument that is based on virtual-analog 
synthesis. You can access it via the first plug-in slot of any track by selecting "MAGIX 
Synth > Robota". 

Samples are not usually used as drum sounds, but rather the sounds are created in real-
time with a specialized drum synthesizer. Typical analog sounds of classic drum computers 
like Roland TR-808, TR-909 or those of more modern manufacturers like Korg Electribe or 
the Jomox X-Base may be created using Robota. The tool is controlled via a step 
sequencer with programming or via MIDI. 

 

The Robota drum map can be found in the Samplitude program folder under "MXSynth -> 
Robota -> ROBOTA.map" 

 

Robota - technical data 
 8-track sequencer 
 64 steps (4 x 16 or 2 x 32) 
 "Notes" mode (velocity information per step) 
 Snapshot mode (instrument setting can be saved for each step, variable "snapshot 

recall" time) 
 Groove presets ("swing" & "velocity" information) 
 "Follow" & "auto copy" mode for simplified editing 
 8 "instruments" (1 per sequencer track). Available for each instrument: 
 Oscillator section (sine/triangle/saw tooth/ .WAV) + noise generator 
 Modulation (FM/ring) 
 Lo-fi section 
 Filter section (multimode filter (12/24dB), comb filter, filter envelope) 
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 Tube simulation 
 Compressor 
 Volume + pan 
 Output routing for stereo output pair 1 4 
 Sorting of 8 instruments as "drum kits" 
 "Setup" files as overall machine status (pattern + instrument setting + further settings) 
 "Config view" with enhanced settings (MIDI trigger, controller matrix, performance 

parameter, etc.). 

 

Robota - sound synthesis 
The eight voices of Robota are setup identically. The synthesis of Robota is quite 
complicated, since every voice has to generate a large variety of drum sounds, ranging 
from hissing hi-hats to heavy bass sounds. 

The Robota drum synthesizer consists of an oscillator with a selectable wave form (sine, 
triangular or saw tooth) or a sample. You can also add a noise generator or use this as a 
pitch modulator (in which case the "noise" controller determines the speed of the 
modulation). 

The oscillator features a pitch envelope and attack/decay controls. It also features 
frequency and ring modulation. The modulation depth may be controlled by means of an 
envelope parameter (FM/rng dcy). This is followed by a "Lo-fi" section consisting of 
distortion (rectify, diode rectification), bit rate reduction (crush) and sample reduction 
(downsample). The duration of the lo-fi effects may also be adjusted via an envelope (lo-fi 
dcy). This is followed by a multimode filter (high-cut/band-pass/low-cut) filter featuring a 
cut-off steepness of either 12 or 24 dB. A comb filter may also be added. You can also 
modulate the filter frequency via an envelope. A compressor circuit adds "impact" and 
"power" to the sound ("compressor": intensity; "response": attack and decay) and a tube-
amp stage lets you enhance this before it proceeds to the output. 

 

Click "M" to set the instrument to mute; "S" for solo. 

You may preview the instrument by pressing the loudspeaker button. Alternatively, use a 
MIDI keyboard to edit sounds, to trigger the individual voices with “note-on” commands, 
and to change the individual synthesis parameters via MIDI control change (also explained 
in “Config view”). Ensure that the “MIDI trigger” button is activated for triggering via MIDI. 
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(to edit in "Stop" mode, ensure that you have activated input monitoring in Samplitude). 

Robota provides 8 audio outputs as 4 stereo pairs. It makes sense to use more than one 
stereo pair to edit patterns with many tracks and individual sounds separately in 
Samplitude's mixer. When editing an instrument, choose the output to send to (horizontal 
slider below the display). 

All instruments are routed to the output pair 1 by default. Make sure that the changes are 
not saved with the instrument but always as a "Setup". 

 

Robota - master section 
"Volume" controls the master volume of the Robota. "Tube" adds a controllable tube 
distortion to give the sound more power and make it sound rougher. The peak meter 
controls the output level; if this appears in the red area, reduce the master volume. 

 

Robota - sequencer 
Classic flashlight programming is used to control the drum patterns, as is the case with 
practically all classic drum computers and groove boxes. The step sequencer consists of 
16 individual step buttons with LEDs which correspond to the sections of a bar (16 or 32 
beat, whereby only half a bar is displayed). A flashing button corresponds to the drum 
sound at this point in the bar. Left clicking switches on the step, and an additional left click 
deletes the step again. 

The maximum length of a drum pattern is four beats. The length may be selected via the 
small scroll bar above the button list. 

Use the appropriate “Edit” button to select the beat you want to edit. Use the "Follow" 
button to select "Follow" mode, i.e. the step display follows the steps of the currently 
played beat. 

If more than one bar is set as the pattern length, "Auto copy" mode ensures that the drum 
notes set in the first bar are automatically placed into the next bars. This makes it easy to 
create a continuous beat, even with a loop length of four bars. Notes set in the bars further 
back are not affected by the "Auto copy" function, e.g. which makes it easy to add a light 
variation in the 4th bar. 

Programming a new drum pattern: 
1. Use the slider to select the pattern length. 
2. Select "Event" mode. 
3. If you are editing during playback, switch off “Follow”. Choose the track you want to edit 
by using the “Edit” button. 
4. Use buttons 1-8 to select the instrument you want to edit. 
5. The “Clear” button deletes all tracks in the current bar of the selected instrument. 
6. Switch on the appropriate step buttons. Use the “Velocity” slider to define the velocity of 
a beat. 
7. Repeat the process for the other instruments. 

 

Robota - snapshots 
It is also possible to automate the sound parameters of a drum sound with so-called 
“Snapshots”. This enables the sound parameters of an instrument to be saved on the step 
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buttons of the sequencer. Doing this, you may model an individual event within the sound 
and, for multi-beat sequences, program very lively and “crazy” processes. This enables you 
to program melodies by changing the tuning of the affected steps (make sure that the 
oscillators are working in “Chromatic mode” via config view. 

Automating a drum instrument using snapshots: 

1. Set the editing mode to "Snap". 

 If you are editing during playback, switch off “Follow”. Choose the track you want to edit 
by pressing the “Edit” button. The snapshot automation should be deactivated 
beforehand (press “On” button). The settings you have just made would otherwise be 
replaced by a snapshot already recorded at the current position. 

 Select an instrument and change the sound according to your preferences. You can 
check the sound of an instrument once playback is stopped by clicking the loudspeaker 
button or by triggering the sound by MIDI (requires activated monitoring in Samplitude). 

2. Save the sound as a snapshot to one of the step buttons. 
3. You may now change the sound of the drum instrument and save the settings to one of 
the other step buttons. 

Note: Parameter changes do not happen abruptly, but are faded internally instead to 
prevent crackling. Use the "Time" slider to specify how fast the parameters should be 
faded to the new sound. This allows you to create interesting "morphing" effects. The 
settings of this controller are saved with the pattern (or setup file). 

4. You can jump between the individual snapshots by using the cursor keys if you want to 
correct individual scenes (input monitoring in Samplitude must be activated). 
5. Now click "On" to activate snap automation. 

 

Robota - groove control 
The secret to "groovy" beats is to play the individual beats delayed or earlier according to 
certain patterns. For example, shuffle is used for house beats, in which case the even 
1/16s are delayed. 

Robota features groove velocity and groove swing presets. Groove velocity presets feature 
a certain offset for every step of a beat by which the original velocity is increased or 
reduced; groove swing presets feature a time delay for every step, in order to delay or 
bring forward the step. The result is a considerably more lively-sounding drum sequence. 
The strength of each effect can be selected with the % controller. 

Groove presets can be selected from the lists in config view. 

 

Robota - setups, drum kits, presets, and patterns 
Loading/saving 

Instruments, drum kits, patterns, and setups may be selected via the "up/down" keys 
located next to the display. Alternatively, you may click the display to open a list with 
available presets. To save a preset, click the "Save" button (disk symbol). The current 
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preset name will be selected. However, you may also enter a new file name and delete 
unused presets from the folder view. 

(Note that Robota always uses the predefined directories, even if you switch to somewhere 
else. You cannot save files in a different location.) 

Robota organizes sounds and beats according to the following hierarchy: 

 An individual drum sound is saved to an “instrument”. 
 The 8 instruments may be saved together as a “drum kit”. The individual instrument 

parameters, however, are not saved, but rather the 8 references to the file names. 
Therefore, if you manually delete an instrument from your hard disk or change one of 
these sounds later and save it again, this will affect the drum kits that this instrument 
uses. “Drum kits” are therefore suitable for organizing frequently used sounds. If you 
have prepared your own drum sounds by changing existing presets and would like to 
save these as a drum kit, save the instruments as new presets and then the new drum 
kit. 

 All note information and snapshots are saved in a pattern. 
 The combination of everything (instruments + pattern + further settings) produces a 

“setup”. In this case, it's not important which instruments belong to which drum kits and 
whether you have made individual changes to the parameters. A setup always saves the 
current master status, including all sound parameters, notes, snapshots, and groove 
settings.  

 In general, all edit processes may be saved as a “setup”. This would “freeze” everything 
safely to continue from this position at any time. We recommend the following instead: 

 Create a personal “instruments” library. 
 Group regularly used instruments as a “drum kit”. 
 Create a sufficient basis of “basic patterns”. 

This lays the groundwork for future projects. You may now use “setups” specifically by 
using these primarily the basis for songs. The advantage is that in addition to triggering 
individual events by MIDI notes, you may also changeover the patterns and drum kits. 
(Please also read the section about config view). 

You can switch individual setups in Samplitude in the preset list (below the instrument 
selection) or via MIDI program change (1-128). 

If you save a project in Samplitude, the last selected setup is opened. Please make sure 
that you save the state in the setup before closing the VIP. 

(When using program changes, note that the storage locations may move when inserting 
new setups). Setups do not have fixed program locations, but are sorted according to the 
alphabet.) 
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Robota - config view 
Use the wrench symbol in the top right of Robota to access the back of the device. 

 

Change the following settings here: 

 “MIDI play” section: 
 Set the MIDI receive channel to trigger the 8 voices externally 
 Specify the “trigger keys” for the individual instruments 
 MIDI controller matrix: The left list features a selection of „MIDI Control Change (CC)“ 

numbers for operating the controllers of the currently selected instrument externally. By 
default, this list contains the default CC numbers of the M-Audio Oxygen 8 keyboard. 
The right list displays the available parameters of the engine for every source. You may 
customize the controller matrix and even route one source to several targets. 

 

Robota - PATTERN/DRUM KIT PLAY section 
 Select the "Play" channel. This does not necessarily have to correspond to the "MIDI 

play" channel, depending on how the MIDI working environment has been arranged. 
 Select the “trigger key” and the corresponding pattern or drum kit. This lets you “play” 

patterns or kits on the keyboard. 
 “Change“: Select the time when the change is to take place (immediately, with the next 

beat, or always on bar 1). 

 

Robota - GROOVE PRESET section 
 “Swing”: If necessary, choose a swing preset from the list. The level of the presets may 

be adjusted in the sequencer section via the % controller. 
 “Velocity”: Select a preset to modulate the volume of your pattern. 
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Robota - MACHINE GLOBALS section 
 Accuracy vs. CPU: “Normal” is selected by default; a compromise of an appropriate 

timing and medium CPU load. “High” is even a bit “tighter”, particularly in the event of 
intensive use of the filter modulation and the pitch envelope. You should only use “low” if 
the processing time is exhausted due to other instruments or effects, since the timing 
and the envelopes are less prioritized. 

 “Oscillators”: “Retrigger” resets the phase of the oscillators for every phase so that wave 
shape and modulation sound identical for every step. When set to “free”, all oscillators 
are constantly active, and depending on the application, this may sound more lively and 
“analog”. 

 “Tuning mode”: By default, the “tune” controller locks into place on “tonal” values 
(“chromatic”), so that you can also program melodies, arpeggios, or bass loops using 
suitable sounds. “Free” tuning is also possible. 

 "Knob mode": Select whether you would like to move the sliders vertically, horizontally, 
or prefer circular movements. The latter is the most precise option for fine changes while 
"hor./vert." is recommended for rough changes. 

 

Robota - CONFIG MEMORY section 
 “Save with current setup”: If this button is activated, all changes made in config view will 

be saved when the next setup is saved, and are restored when this is opened again. 
 “Save as default”: This saves the current configuration as “default”. This is useful for 

restoring the same conditions in the VIP. 
 "Restore default": Use the "Restore" function to overwrite a “Config” setting created 

using a loaded setup with your “standard”. 
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Vita 

Vita is provided as an installation option. 

The MAGIX Vita synthesizer specializes in realistic playback of "real" instruments by utilizing 
sampling technology. Short samples of real instruments in different pitches, playing 
techniques, and volumes are used, combined, and played again at the correct pitch. 

The VITA synthesizer is controlled via the MIDI objects. 

 

Vita - the interface 

 

1. Layer selection/peak meter: The Vita sounds, also known as layers, may be selected 
here using the arrows. Right clicking on the display opens the layer menu. 

2. Main parameter: Set the volume, panorama position, pitch characteristics ("transpose"), 
and the fundamental frequency ("master tune") here. 
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3. AMP: This is the volume envelope. This influences the temporal progression of a track's 
volume. A(ttack) stands for the volume increase at the start, D(ecay) for the length of time 
the decrease in volume takes on a section set with S(ustain) at the maximum volume. 
R(elease) is the length of time it takes for the sound to ring out. 

 

4. FILTER: Switch on a filter to influence the sound here. FILTER TYPE selects the filter 
type. "Cut-off" regulates the filter frequency; "Resonance" controls the strength of the 
amplification of the filter frequency. "Velocity" specifies how strongly the velocity should 
influence the filter frequency, while volume can be balanced using the "Gain" controller. The 
filter envelope (ADSR slider) influences the filter frequency depending on the time. 

5. DELAY: Switches on an echo effect; "Time" controls the delay time, "Level" controls the 
strength of the echo sound. 

6. REVERB: Switches on a reverb effect, "Time" controls the delay time, and "Level" 
controls the strength of the echo sound. 

7. VALUE DISPLAY: The value display shows the exact value of the parameter that has 
been modified. 

8. DYNAMIC RANGE: Usually, the relationship between the created volume and MIDI 
velocity is proportional. Since some MIDI keyboards produce a velocity that is too hard for 
loud sounds or vice versa, this behavior may be compensated with "MIDI input curve". 
"Dynamic" and "dynamic curve" influence the dynamics of the sound, i.e. the relationship 
between the quietest and loudest sounds. 

9. Voices: Control the number of voices played simultaneously here. If notes are no longer 
played during fast passages, increase the amount of voices here (performance will not be 
as good). 

10. Keyboard: A preview of the Vita sounds. This only works during playback or recording. 
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Revolta 2 
Revolta 2 is polyphonic and may be played with up to 12 voices. It includes a series of 
additional features, like an additional noise generator, a step sequencer, and an extra 
flexible modulation matrix. Its effects section of 9 different effects and presets, designed by 
a famous designer, make it a full-fledged synthesizer for all kinds of lead, sequence, and 
pad sounds. 

REVOLTA 2 has a whole array of presets. The sounds have been created by professional 
sound engineers and demonstrate the huge potential of this instrument right from the start. 
But first of all, we encourage you to try out the various control functions and to experiment 
as much as you like. The sky's the limit to your creativity. 

 

Revolta 2 - the interface 
The Revolta 2 interface may be displayed in two sizes. In "Rack" mode, only the elements 
necessary for preset loading are visible: 

 

Clicking the "Edit" button opens the entire user interface. 

 

 1. Main parameter: The volume, panorama position, pitch characteristics ("transpose") 
and the play modes (POLY, MONO, LEGATO) may be set here. GLIDE controls the 
portamento time. 

2. Oscillator section: Two oscillators are available with a smoothly adjustable curve form 
and a noise generator. Both oscillators may be tuned to each other and used to modulate 
frequencies. 
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3. AMP: This is the volume envelope. This influences the temporal progression of a track's 
volume. A(ttack) stands for the volume increase at the start, D(ecay) for the length of time 
the decrease in volume takes on a section set with S(ustain) at the maximum volume. 
R(elease) is the length of time it takes for the sound to ring out. VEL specifies how much 
the envelope curve depends on the velocity. 

4. FILTER: Switch on a filter to influence the sound here. FILTER TYPE selects the filter 
type. "Cut-off" regulates the filter frequency; "Resonance" controls the level of amplification 
of the filter frequency. VEL" indicates how much the velocity influences the filter frequency, 
"KEY" changes the filter frequency depending on the note pitch ("Keytracking"). The filter 
envelope (ADSR slider) influences the filter frequency depending on the time. "Env mod" 
controls the strength of the filter envelope curve, and "drive" may be used to overmodulate 
the filter. 

5. FX1/FX2: Mix in 2 different effects out of a total of 9 available effects. 

6. LFO1/LFO2/STEPSEQUENCER: Two LFOs and the step sequencer may be used to 
modulate single parameters of Revolta 2. 

7. Options and modulations matrix: The two buttons open Revolta's options page for 
general and preset-specific settings and modulation matrix. In the modulation matrix, 
modulation sources are connected with modulation targets. Simple modulations like the 
oscillator, where the pitch will be modulated via an LFO (vibrato), may be set quicker 
directly on the interface. Much more complex modulations are possible in the matrix, 
because the matrix offers more modulation sources (e.g. MIDI controller, oscillators) and 
the modulation source may influence more targets.  

8. VALUE DISPLAY: The value display shows the exact value of the parameter that has 
been modified. You may also use this to find out the load of the twelve voices. 

9. Preset section: Select different Revolta presets here. Every sound may be previewed, 
and an A-B comparison between two sounds is also possible (e.g. an edited and the 
original sound). 
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Plug-ins at track, object, and master level 
MAGIX Plug-ins > Analog Modelling Suite: AM-Munition, AM-Phibia, AM-Pulse, AM-
Track (Samplitude Pro X Suite). 

 

AM-munition is an extremely versatile, dynamic tool for editing groups or signal sums, 
especially in the domain of mastering. It has separate units like compression, filtering, side-
chain, limiter and clipper. All modules and parameters are optimized to perform their 
fundamental functions without any compromises: effective enrichment of the program 
material without causing bothersome artifacts, a high maximum volume, and an "analog" 
behavior with an individual sound signature. 

AM-phibia is a tube amplifier/channel strip. It combines an optical compressor with a pre 
and post filter unit. By selecting the filter presets the suitable setting can be chosen 
depending on the input signal. When interacting with the compressor section, am-phibia 
may be used as a vocals pre-amp, tube guitar amp, or simply for creating a warm sound. 

AM-pulse is a "transient modeler", a creative tool for editing envelope and sustain 
processes on percussive or dynamic signals. 

AM-track is a combination of an analog compressor and a tape simulator in a single 
device. This is used primarily for so-called "tracking", i.e. editing individual channel strips or 
subgroup signals. 
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MAGIX plug-ins -> Vintage Effects Suite: CORVEX, ECOX, FILTOX 

 

This suite enhances the repertoire of Samplitude with a chorus/flanger, delay, and filter 
plug-in. CORVEX, ECOX, and FILTOX are each based on the same basic handling 
principle: as required, a modulator (LFO) controls almost all of the controllers accessible via 
the "frontplate". 

MAGIX plug-ins -> VariVerb Pro 

 

VariVerb Pro is a classic reverb unit which performs classic and modern algorithm-based 
reverb generation without accessing impulse responses. The effect includes several rooms, 
halls, hall plates and non-linear algorithms that can be edited in two different modes in 
many ways. 

Note: You can open the MAGIX plug-ins via the plug-in section of the mixer, track editor, 
track, or at the object level via "Effects". Detailed information about MAGIX plug-ins can be 
found in the help file "Menu effects -> MAGIX plug-ins (view page 698)". 
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VST/DirectX/ReWire: All DirectX plug-ins installed on your system are written into the 
Windows registry and are available via the effects slot or the menu item "Effects -> Object 
DirectX/VST plug-ins". At track or master level, you can access plug-ins by clicking on the 
"FX" button. 

VST FX: This is a list of all VST effect plug-ins included in the VST plug-ins folder. The path 
for VST plug-ins can be determined via "File > Program preferences > System/Audio (view 
page 176)", shortcut "Y". 

 

Vandal 
(Vandal in Samplitude Pro X Suite / Vandal SE in Samplitude Pro X) 

The main concept of the Vandal guitar amp (view page 745) consists of virtual switching 
that models three different preamps and two power amps. This can be achieved by 
switching the mode functionality on an easy, single front view. 

 

essentialFX 
The essentialFX Plug-in Suite (view page 685) offers high-quality audio tools for all-around 
tasks. Each plug-in has a number of important qualities for producing quick and accurate 
results: 

 Low-resource DSP functions in spite of great quality algorithms 
 Low space requirements for interfaces 
 Easy operation thanks to reduction of function elements featuring only the most 

important parameters 
 Consistent operation of all interfaces 
 Simple, straightforward preset management via the tried-and-true file/folder basis; 

simple upgrades for users 
 Color coding: Each plug-in has a color code in the top part of the window for quick 

identification; modulation effects = blue, dynamic plug-ins = orange  

The following essentialFX are available: eFX_ChorusFlanger, eFX_Phaser, eFX_Reverb, 
eFX_StereoDelay, eFX_Compressor, eFX_Gate, eFX_DeEsser, eFX_VocalStrip, 
eFX_TubeStage, eFX_TremoloPan. 
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Remix Agent 
The Remix agent is a powerful tool for determining the BPMs (beats per minute) and the 
time position of quarter note beats of any song. 

 
 

Detailed descriptions of the Remix Agent can be found in the menu reference in "Menu > 
Object >Remix Agent". 
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Stereo Editor 
Right clicking in the panorama controller in the arranger, mixer, and track editor allows you 
to change panning from the left to right channels for every track in the stereo editor as 
well as further settings related to the phase of the track. 

 

Note: The settings made here are not effective if the track is routed to a Surround bus or 
Surround master, or if the option "2-channel Surround mode" is activated. In both cases, 
the Surround editor is used for panning. 

For mono tracks, conversion from mono to stereo takes place in the signal flow exactly 
according to the panorama controls. At this point, effects or plug-ins may be inserted in 
stereo. The routing positions may be changed in the Effects routing dialog (view page 536). 

 

Stereo dialog options 
Panorama: Set level distribution between left and right here. 

Stereo width: Adjusts the stereo bandwidth for each track. 

If set to the center, no changes occur. If you move the controller to the right, you will only 
hear the mono portion. 

Right click to set the enhancer function for the corresponding track. The middle and side 
signals will be separated and their volumes edited separately. 

Note: Because mono signals have no side signals, this only changes the middle signal with 
the stereo width control. If set fully to the right, the mono source material will no longer be 
audible. 

Detailed information is available in "Effects -> Stereo/phase -> Multiband stereo enhancer" 
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Copy L-R 

Change the channel assignment of the tracks here. If you activate "Copy L -> R", only the 
left channel will be audible on both sides; "Copy R -> L" has the same effect for the right 
channel. Activate both options so that the left and right channels are swapped. 

Center channel damping (panning law): In order to balance volume fluctuations while 
panning (particularly for automation), it is common to additionally dampen the track volume 
at the center position, while no additional damping occurs if the pan controller is moved to 
the left or right limit. The value should be selected according to the audio material. Here are 
some common values:   

0 dB: This setting is recommended for stereo material. No damping occurs at the center 
position, i.e. if panned to the right, the right channel volume remains the same, if panned to 
the left the left channel remains unchanged. The audio material is not changed if set to the 
center position. The volume may be perceived slightly louder if the signal is mono. 

-6 dB: This setting may be used to automate mono tracks. In the middle, the volume of the 
right and left channels will be halved. 

Common setting for automating stereo signals are -3dB or -4.5 dB.  

The panning law settings can be applied to all tracks by activating "All tracks". 

Phase: Inverts the phases of the individual channels. However, the switch in the mixer or 
track editor always switches both channels. 

2-channel Surround mode: 

Detailed information about this option is available in the chapter "Surround sound -> 2-
channel Surround mode (view page 234)". 

The individual parameters are processed in the following order: 

Copy L-R -> Stereo width -> Phase invert -> Panning/panning law 
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MS-Processing 
"MS" stands for "Middle/Side" and describes the process by which the channels are 
separated not into left and right, but into middle ("M") and side ("S"). 

MS recordings 
With MS microphone setups files will be received after recording with separate middle and 
side parts, rather than a left and right channel. With the stereo panorama dialog's presets 
provided you can edit MS recordings (here we assume that these are available as a stereo 
file with M left and S right).  

MS processing of mono original material 
To extract the correct stereo picture from an MS file, duplicate the output material and save 
it as a new track. For the first track, select the "Left channel only" preset. This results in 
the M signal being played in mono only. On the second track, use the preset Side signal 
(Stereo) (from M/S source) to only play the side signal in stereo, i.e, left +side and right -
side. Both tracks can be mixed together each at 0 dB 

MS processing of stereo original material 
Another requirement is the independent editing of mids and side parts even if the output 
material is available in stereo format. To do this duplicate the output material and save it as 
a new track. 

"Mono (get mid signal from stereo source)" extracts the mid part from the output 
material as the first track, while "Side signal (Stereo) (from stereo source)" extracts the 
side part in stereo as the second track. Here you can subsequently mix both tracks each 
with 0dB. 

Advanced MS processingIn Samplitude there are additional options for processing stereo 
signals in mono tracks.  

Mono (get mid signal from stereo source): In this case, only the mid component of the 
stereo signal is used in the mono track.   
Left channel only: In this case, use only the left component of the stereo signal used in 
the mono track. 
Right channel only: Use only the right component of the stereo signal used in the mono 
track. 
Side signal (mono) from stereo source: Use only the mono side component of the stereo 
signal used in the mono track. This way, you can apply all subsequent object and track 
effects to the side part as mono parts. 
Side signal (mono) from stereo source: Use only the mono side component of the stereo 
signal used in the mono track. This way, you can apply all subsequent object and track 
effects to the side part as mono parts.  
Convert side signal (mono) to stereo: Converts the mono side component to stereo. 

 

 



 

2 2 4  S U R R O U N D  S O U N D   

Surround Sound 
Samplitude offers several possibilities for mixing audio material in various multi-channel 
formats. 

One of the pre-requirements is the use of a mixer configured with a Surround Master 
corresponding to the target format. So-called target formats are   5.0 ITU, 5.1 ITU, or 7.1 
SDDS (for example). 

In "Project Surround Setup" (File > Project Properties > Mixer Setup > Surround Master > 
Setup) you can route the channels of the Surround Master to any playback devices you 
like. The audio material of the tracks in an arrangement may be distributed across the 
existing Surround buses by right clicking the "Pan" button in the track. 

Objects can also be routed directly to the Surround Master and distributed in the Surround 
Panorama irrespective of the track they are assigned to. 

The Surround Panorama module provides four different modes for sorting the signal into 
the Surround panorama. Various surround effects are provided in the Mixer for mixing in 
multi-channel format. 

Samplitude also offers 2-channel surround, which can be used for stereo projects and is 
based on "Dolby Surround ProLogic". A regular stereo audio card and Dolby Surround 
ProLogic compatible receiver/amplifier are sufficient for working with 2-channel surround. 

 

Adding a new project with a Surround mixer 
Create a Surround project via "File -> New Virtual Project 
(VIP)" 
Select "Mixer setup -> Surround" via "Setup for new project (VIP)". Select the desired 
format under "Surround setup" (e.g. 5.1 ITU). 
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Besides the audio track's channels, the mixer in the new VIP now also contains the 
Surround master in the selected format (e.g. 5.1 ITU L, R, C, LFE, Ls, Rs). All mixer 
channels for the corresponding project tracks are automatically routed to the Surround 
master. The mixer's stereo master will be hidden initially, but it may be displayed by clicking 
the "Master" button in the mixer.  The individual mixer channels may be routed to either the 
Surround master or the stereo master. 

 

Converting an existing stereo VIP into a VIP with mixer in 
surround format 
In the mixer of an existing VIP click on the mixer "Preset" selection button at the bottom 
right corner under the "Setup" and select "Surround". The "Project Surround setup" opens 
to select the preferred Surround format (for example 5.1 ITU). 

 
 

Project Surround setup 
Setting the physical output of the surround buses 
The "Project Surround setup" dialog opens by clicking the audio device button in the 
Surround master on the mixer or on the "Setup…" button in the "Surround panorama 
module" or by selecting the "Setup" button in the master section of the "Project mixer 
setup" dialog. 

The Surround format for the mix is set in the "Project Surround setup" window. You can 
access various presets (e.g. 5.1, ITU, DD, DTC...) or edit and save your own formats. The 
filter settings for the LFE channel are also set here. 
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Presets 
Previously added Surround formats may be accessed and new formats may be saved 
here. A preset features the Surround buses, their name as an abbreviation, the sequence, 
and the position coordinates of the speaker. When loading a preset, the playback device 
settings will feature the default values set for the preset. 

 

Get default 
Pressing the buttons loads the default configuration of the playback devices belonging to 
the currently active preset. 

 

Set default 
The current assignment of the Surround buses to the playback devices is saved as a 
configuration of the currently active preset by pressing this button. This configuration will be 
loaded whenever the preset is accessed. 

 

Audio device settings via load/save 
Activating this option saves the current playback device configuration during playback, 
independent of the default configuration in the setup. 

 

Channel configuration 
Name: This determines the name of the individual Surround buses. The abbreviation used 
in the "abbreviation" column is generated from this description. The first letters or 
subsequent upper case letters of the words are used for the abbreviation. 

Left = L 
Left Surround = Ls 
LFE = LFE 

This abbreviation is used in the Surround panorama module and for labeling the 
corresponding mixer channels. During Surround trackbouncing, the abbreviation is 
automatically added to file name of the wave files being created. 

Example: The file name "Mastermix" is selected when bouncing a 5.1 Surround mix in 6 
mono files. The following wave files will be generated: "Mastermix_L.wav", 
"Mastermix_R.wav", "Mastermix_LFE.wav".  

Median/frontal: These columns describe the position of the respective speaker in relation 
to the median and frontal levels. 

Position X/position Y: This describes the precise position of the speaker in a system of 
coordinates. This may be edited by entering the value manually. The settings refer 
exclusively to the speaker positioning in "Sound field" mode. 

Audio device: Assignment of a physical output on an existing sound card for the 
respective Surround bus. A default device setting may be saved for each Surround preset; 
see "Get/set default". 
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Lock channel position 
If this is selected, the position of the loudspeakers cannot be changed using the mouse in 
the Surround panning module. This function is always initially activated and should only be 
switched off in special cases (e.g. variable speaker positioning). 

 

Up arrow/down arrow buttons 
If a line has been selected in the configuration table (corresponds to a Surround channel), 
this line may be moved up or down within the table. 

The order of the Surround channels in this table determines the order for display of the 
mixer, Surround panorama module (e.g. peak meter), and the Surround effects windows. 

 

LFE settings 
You can activate a filter for the LFE channel in "Project Surround setup". Select between a 
4-band filter (default setting) and an FFT filter. These filters can be edited by clicking on 
"Edit". 

Cut-off frequency: Determines the cut-off frequency for the low-pass filter. 

Dampening: The dampening of the filter above the cut-off frequency is set to 12 
dB/octave for the 4-band filter. 

Edit: Opens a window to edit the filter settings. 

 

Surround panning 
Now that the basic settings have been made, proceed to the actual mixing. There are two 
methods for mixing audio material displayed in the VIP window into the Surround master: 

 

Track-based Surround panning 
Each audio track in the arranger may be assigned to a position in the Surround panorama 
module via the Surround panorama module of the corresponding channel strip of the 
mixer. All objects on this track are thereby positioned in Surround panorama at this point. 

 

Object-based Surround panning 
Each object may be routed directly to the Surround master or another Surround submix 
bus via the object editor. The object editor for the current object is opened by double 
clicking it, and in "Pan/mute/invert", the "Output..." button is set to "Sur master". The 
corresponding Surround panorama module opens for this to set the desired positioning. 
Later corrections to the panorama setting may be made at any time via the "Object editor -
> Pan/mute/invert -> Surround send -> Edit". 

"Stereo" in the "Output" selection indicates routing of the object to the VIP track and the 
corresponding mixer channel, i.e. track-based Surround panning (basic setting). "Surround 
master" indicates direct routing of the object to the Surround bus, i.e. object-based 
Surround panning. 
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Object-based surround panning is identified in the VIP object display by the "Sur" extension 
to the object name. 

Note: Object-orientated Surround panning will not route the audio signal through the 
channel strip of the corresponding mixer track. All settings made here (AUX send, EQ, etc.) 
have no effect on this object. 

For most applications, an object should be mixed to the Surround bus either via track-
based or object-orientated Surround panning. However, by pressing the "Ctrl" key while 
selecting the output, you can select "Stereo" and "Sur bus" together. 

 

Surround panorama module 
The panning of a track or object within the Surround bus is set and edited via the Surround 
panorama module. 

There are several options for opening the Surround panorama module for track-based 
Surround panning: 

 right click the Surround pan display for the corresponding mixer channel strip or 
 right click the pan button or fader for the corresponding track in the VIP or 
 right click the track information to open the track menu to choose "Pan/Surround 

editor..." or 
 Select the required track in the VIP and choose "Pan/Surround editor..." from the 

"Track" menu. 

The Surround format and the track currently being edited are displayed in the title bar. 
Example: "Surround panorama module: 5_1 ITU - track 4"  

To open the Surround panorama module for object based Surround panning, double click 
the corresponding object: 

Open "Object editor -> Pan/mute/invert -> Surround send -> Edit". 

The Surround mode for the object currently being edited is displayed in the title bar of the 
Surround panorama module. 

 

Display elements 
A two-channel input meter is located on the left of the stereo track area in Samplitude. 
Both scales display the mono signal of the mono input signals. 

The level meters of the Surround master's channels are on the right side. Only the levels of 
the material currently being edited in the Surround panorama module are displayed. 

The loudspeaker channels of the Surround setup are displayed as blue dots in the main 
panorama window. Their position within the Surround panorama field depends on the 
selected mode. Muted channels are marked with a gray dot. A red dot marks the sound 
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source that is to be positioned within the Surround panorama. Depending on the "Pan L/R" 
settings, these may also be displayed as two dots. 

 

A two-channel input meter is located on the left of the stereo track area in Samplitude. 
Both scales display the mono signal of the mono input signals. 

The level meters of the Surround master's channels are on the right side. Only the levels of 
the material currently being edited in the Surround panorama module are displayed. 

The loudspeaker channels of the Surround setup are displayed as blue dots in the main 
panorama window. Their position within the Surround panorama field depends on the 
selected mode. Muted channels are marked with a gray dot. A red dot marks the sound 
source that is to be positioned within the Surround panorama. Depending on the "Pan L/R" 
settings, these may also be displayed as two dots. 

Activating the options below the main panorama dialog display the following information: 

Name: The loudspeakers are described using the abbreviations specified in the "Project 
Surround setup" window. 

Volume: Level information is displayed for each loudspeaker. This displays the value of the 
signal share that is passed on to this bus by the sound source. In stereo modes, the sum 
of the levels of both sources is always displayed. Holding the "Shift" key and clicking on a 
source can briefly display the value of a single source only. 

Sound field: The meaning of this display depends on the module used by the Surround 
panorama module. 

Channel: Mutes or changes the level of the bus outputs of the Surround panorama module 
to the Surround buses. Deactivates bus outputs/speakers are displayed as gray dots in the 
panorama field. 

LFE: Level share of the signal that is reproduced via the LFE channel. 

LFE only: The source is routed only to the LFE channel. 

Center: This parameter controls the portion at the center for assignment of the sound 
source to the front channels. In certain areas (e.g. film sound), it is normal to reserve center 
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channel dialogs and mix music and sound in the center. A signal placed directly in the 
center is played back in 5.1 format only in the center if center = 100%; at 0%, this is only a 
phantom sound source that is output by the channels L and R. This parameter is often 
referred to as "divergence". 

Pan L/R: Mono and stereo sources may be positioned via the Surround panorama 
module. The "Pan L/R" function determines how the mono and stereo signals are be 
positioned. A distinction must be made between the types of signal. For more information, 
please read the chapter entitled "Stereo and mono signal processing in Surround projects". 

 

Panorama modes in the Surround panorama module 
Panning in the surround panorama module can be carried out in different modes. This 
makes editing of different panning processes easier. Stationary sources of sound can be 
positioned in the surround panorama, and you can also design the most diverse 
movements of sound sources. 

Note: The different panorama modes work according to different background principles. 
Changing to a different mode can therefore partly change the acoustic location of the 
sound source. Exception: The precise level ratios are adopted when changing to matrix 
mode. 

The size of the “Surround panorama module” is scalable. Under certain circumstances 
some settings can be made more precisely if the screen display is set to a higher 
resolution. 

In all modes (exception: "Matrix" mode) the source of sound (red dot) is moved to the 
required position in the panorama. The x and y positions can also be changed by entering 
the value into the corresponding number box, vertically dragging the mouse pointer over 
the active number field or by using the mouse wheel. 

The movements of the sound source can be coordinated and restricted holding down the 
following keys and moving the mouse pointer: 

X + Mouse movement: Only position changes that are parallel to the x-axis are possible. 

Result: L -> R movement 

Y + Mouse movement or Z + Mouse movement: Only y-axis movements are possible. 

Result: Front -> Rear movement 

C + Mouse movement: The distance of the sound source to position 0 (x=0, y=0) remains 
the same. The result is a circuit. 

Result: circular movement 
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A + Mouse movement: The sound source can only be moved with constant angle. A line 
running from the initial position of the sound source through point 0 of the system of 
coordinates determines the movements. 

Result: Diagonal movement with consistent angles. 

 

Sound field mode 
In "Sound field" mode, the input signal is displayed as a concentric sound field. Each red 
line corresponds with a 3dB drop in the sound field level. The loudspeakers are positioned 
so that the distance from a single speaker to a neighboring speaker remains constant. This 
positioning permits a uniform distribution of the sound source across all channels. Level 
ratios develop between the channels that cannot be achieved in other modes. 

 

Example of use: Very accurate localization, particularly for movements 

Con: Level conflicts, e.g. movements in a constant direction ("Angle" mode is more suitable 
for this) 

Width: Influences the sound field width of the loudspeakers 

Sound field characteristic (pan setup): This adjusts the character of the sound field. 
"Invers. logar." produces a quick drop of the sound field and short fades between 
loudspeakers. "Logarithmic" provides a slow reduction of the sound field and longer 
transitions between speakers. 
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Panning law mode 

 

 This mode operates with a display of the Surround panorama as known from many 
digital mixers. 

 The positions of the loudspeakers are displayed at the outer borders of the usable 
panorama. By clicking the "Sound field" option, you can visually display the graphical 
levels displayed across the Surround buses. The level distribution between two adjacent 
loudspeakers is performed according to the -3dB law, which causes both speakers to 
emit a sound source of -3dB at the exact center location. 

Example of use: Simple static 2-dimensional panning, rough localization. 

Con: No precise localization, not suitable for dynamic panning (automation). 

Pan law: The value of -3dB is changed with this setting. 
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Angle mode 
A sound field is displayed which extends from from the center of the circle. The sound 
source is located on the central axis of this sound field. The loudspeakers are aligned in a 
circle. The level shares of a sound source that are routed to one channel are determined by 
the angle ratio between the sound source and the loudspeaker, as well as the aperture 
angle of the sound field. If the angle of the sound source and the channel correspond with 
each other (i.e. the middle axis of the sound field is pointing directly at the speaker: angle 
difference = 0), the level of this channel will be the highest. If the angle difference increases, 
the level of this channel continuously decreases. 

Example of use: Good localization of direction of movements (e.g. airplane passing, etc.) 

Con: Not suitable for distance panning. 

 

Width: Determines the size of the sound field aperture angle. 

Sound field character (pan setup): You can adjust the character of the sound field. 
"Inverse logarithmic" creates a larger aperture angle and shorter transitions between the 
speakers. "Logarithmic" produces a smaller aperature angle and longer transitions between 
the speakers. 

Maximum sum output level constant (pan setup): If this function is active, the total level 
of all channel outputs of the Surround panorama module will not exceed this value. If this 
setting is activated in "Angle" mode, level drops in the sound field connected with larger 
aperture angles will be avoided. 
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Matrix mode 
The level of the input signal sent to the individual surround buses may be entered directly in 
"Matrix" mode. Entering the values manually by double clicking the numeric field. 

Dragging the mouse over the level bars while holding the left mouse button also changes 
the value. Fine tuning is possible by additionally holding the "Shift" key down. 

Example of use: Analytical tasks like routing after track bouncing or simultaneous 
distribution of a signal over several Surround channels. Distribution over 3-dimensional 
alignments, e.g. 2+2+2 setup. 

Con: No automation possible. 

 

Unlike other modes, the "Pan L/R" settings in "Matrix" mode mean: 

Pan L/R mono: The levels of the left and right input signals are applied equally. 

Pan L/R stereo: Controls the levels of the left and right input signals individually. 

The remaining "Pan L/R" settings do not apply. No reflection sources will result. 
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2-channel Surround mode 
Two-channel Surround is a method for adding additional room features to a normal stereo 
signal. No additional audio channels are required. The result is also a stereo format 
including additional Surround information ("encoded"). 

Using a Dolby ProLogic-compatible amplifier system (also referred to as Dolby Surround), 
additional Surround information may be decoded and played back via 4-5 speakers. In 
addition to the stereo speakers, there are then one or two additional (rear) Surround 
speakers and an additional center speaker. 

Dolby Surround ProLogic only supports one rear channel. If two rear speakers are present, 
the same signal will be played back on both speakers. 

The signal remains fully downward compatible with stereo playback; it may be played on 
any system not featuring Dolby Surround. 

From a technical viewpoint, the output signal is a regular stereo signal. No additional output 
devices are required and, consequently, nor are Surround buses/Surround masters. 

Samplitude is able to work simultaneously with 2-channel Surround tracks and 
stereo/mono tracks. The left and right signals of conventional tracks are played back in the 
Surround mix via the L and R speakers, the center channel is fed the mono signal (R+L). 
For each track, the 2-channel Surround may be activated via the track info dialog or as a 
parameter in the track settings. 

The Surround panning module may be opened by right clicking the pan controller in the 
mixer window or by right clicking the "Pan" button in the VIP. You may also click the 
Surround control box in the mixer window (only visible if "Surround" mode is active). 

Now select the position of the sound source within the Surround space by placing the red 
circle at the desired position with the mouse. In "2-channel Surround" mode, the 
automation functions available in the other Surround panorama modes are also available. 
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Pan setup 
The "Pan setup" window allows you to make further changes to the Surround panorama 
module. Open this window by clicking "Pan setup" in the Surround panorama module or by 
right clicking the sound source. 

 

Sound field offset (dB): The set offset is included for sound sources that are directly 
positioned and routed to a single Surround channel/speaker. For example, signals traveling 
from directly routed positions to panning between individual channels may be 
compensated if they are too strong. 

Sound field characteristic (only available in the Surround panorama module in "Sound 
field" or "Angle" mode): This parameter is described in the section covering "Sound field" 
and "Angle" modes. 

Maximum sum output level constant (pan setup): If this function is selected, the 
maximum level of all channel outputs of the Surround panorama will not exceed the set 
value. This function is especially useful in case of automation and if sources are intended to 
move throughout the room. Unintentional fluctuations of the max level may therefore be 
compensated as positions change. 

Link all tracks: Changes in the following settings within the Surround panorama module 
are always transferred to all tracks of the VIP: sound field offset, level drop characteristics, 
output volume sum constant, center, pan-law/width, LFE level and settings, channel 
settings such as level changes or mute. 

Copy settings to all tracks: The settings made in this Sound panorama module (sound 
field offset, level drop characteristics, output volume sum constant, center, pan-law/width, 
LFE level and settings, channel settings such as level changes or mute) are copied to all 
other tracks once. 
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Surround presets 
Frequently used settings may also be saved as presets in the Surround panorama module. 
The pan L/R mode and settings are also saved besides the position of the sound source. 

Use "Load preset" to load previously saved presets. 

 

Stereo and mono signal processing in surround projects 
Mono (pan L/R settings): The following applies to stereo signals: a mono sum will be 
created using the left and right signals. This is positioned as a single mono sound source in 
the panorama. 

The following applies to mono signals: this signal is positioned as a single mono sound 
source in the panorama. 

X-sym (setting pan L/R): The following applies to stereo signals: the left and right 
channels are symmetrically aligned to the x-axis. For example, this allows you to pan a 
stereo signal to front L/Ls. 

The following applies to mono signals: a second (mono) mirrored sound source of this 
signal is positioned in addition to the original mono source. 

The x-axis is the mirror axis. 

Y-sym: The following applies to stereo signals: the left and right channels are symmetrically 
aligned to the y-axis. For example, this allows you to pan a stereo signal to front L/R. 

The following applies to mono signals: a second (mono) mirrored sound source of this 
signal is positioned in addition to the original mono source. The y-axis is the mirror axis. 

XY-sym: The following applies to stereo signals: the left and right channels are 
symmetrically aligned to the x and y axes. For example, this enables you to pan a stereo 
signal to front L/Surround R. 

The following applies to mono signals: a second (mono) mirrored sound source of this 
signal is positioned in addition to the original mono source. This mirrors the original source 
along the x and y axes. 

Parallel: The following applies to stereo signals: the left and right channels are kept in 
constant distance from each other and are moved in parallel. The distance between the 
two sound sources may be changed by holding down "Ctrl". 

The following applies to mono signals: the original and mirrored sound sources are kept at 
a constant distance from each other and are moved in parallel. The distance between the 
two sound sources may be changed by holding "Ctrl". 

Stereo thru: For stereo signals, depending on the position of the sound source, the same 
level ratios are reproduced on different channels. However, only the left signal is used for all 
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left channels, and only the right signal for all right channels, and the mono share for the 
center and LFE channels. 

The following applies to mono signals: no special function, identical with "Mono" mode. 

The sum of the levels of both sources is always displayed under each loudspeaker in any 
mirror mode (if display options are active). Holding the "Shift" key and clicking a source 
briefly displays the value of the individual sources. 

 

Alternating between stereo and Surround formats 
Each channel strip of the mixer may be routed either to the Surround master or to the 
stereo master. Simultaneous routing is not possible. However, you can use mixer 
snapshots to mix stereo and Surround more or less at the same time.  

For example, first set a Surround mix. This may be saved in the mixer as a snapshot. All 
panorama settings, filters, etc. are saved. 

The "Stereo" preset is then selected in the mixer. All mixer channels are thereby routed to 
the stereo master. If the stereo master fades out in the mixer, it is faded back in after 
clicking the "Master" button again. All required settings for the stereo mixer may now be 
set again. This is then also saved as a snapshot. 

You may now alternate between the stereo and Surround mixes by switching between the 
two snapshots. 

Both mixtures may be saved with the "Trackbouncing" function as a new wave files (*.wav). 
Trackbouncing is done separately for each mix, and the respective mixer snapshot (stereo 
or Surround) must be accessed for this. 

 

Automating the Surround panorama module 
Panning movements on tracks set to Surround panning may be automated. To do this, first 
activate the automation in the Surround panorama module. 

 

Pressing the pan button for the corresponding track in the VIP window can also do this. If 
the sound source is now moved during playback, this movement is recorded and displayed 
as a curve in the VIP. This curve may now be edited in the VIP using "Panorama mouse" 
mode. 
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Drawing Surround automation curves 
To use this automation mode, you must first select the range in the VIP where you would 
like to add the change. Draw mode is now activated in the Surround panorama module. 
You may now draw any movement for the sound source in the Surround panorama. This 
sequence is then applied in the previously selected time span when playing back the VIP 
the next time. This curve may be edited after in the VIP by using the mouse in "Curve edit" 
mode. 

 

Effects in Surround projects 
Difference between stereo and Surround effects 
The following Surround effects are available for Surround buses: 

 Dynamics 
 Multiband dynamics 
 Advanced dynamics 
 Room simulator 
 FFT filter 
 De-hisser 
 Vocoder 

Effects may only process up to 6 channels in parallel instead of only two (stereo) when 
working with Surround. 

You may define the number of channels by grouping. 

 

Accessing Surround effects 
Surround effects may be used in Surround buses (including the Surround master) and in 
Surround AUX buses. 

 

Grouping mechanism for Surround FX, Surround control 
group 
Grouping and ungrouping: Hold the "Ctrl" key while clicking the channels  in the output's 
mixer for the channels routed to "Sur mast" that you want grouped together or removed 
from a group.  

Add effects to Surround bus (Surround FX): If Surround channels have been grouped, 
all of the channels in the group will be processed using a single instance of the effect, i.e. 
the parameters affect all channels in the group equally. 

Surround control group The Surround channel buttons are located in the Surround 
control group that appears with the Surround-capable effects below the effects dialog. 

Grouping effects: 

 The parameters entered in the effects window affect all channels of the active group (as 
they would affect two stereo channels in "Stereo" mode). 



 

2 4 0  S U R R O U N D  S O U N D   

 If presets are loaded into the presets window, the parameters affect all Surround 
channels of the group activated in the window but not the Surround channels of other 
groups. 

 For dynamic effects (including the multiband dynamics module), the control signals are 
generated using all channels of the group (just as they would be generated from the two 
stereo channels in "Stereo" mode). 

 

Editing Surround sound automation 
Automation recording in the Surround sound dialog 
When recording an automation, the source signal may be moved to any position in a room. 
Samplitude records this movement during playback or recording and creates automated 
events on the corresponding curve in the VIP track. 

To change the start position of a reverb source, start the recording process of the 
automation by clicking and holding the desired position of the reverb source in the 
Surround panorama module right after playback starts. The source signal position will be 
automatically registered and the resulting movements will be recorded by Samplitude. 
Samplitude indicates that recording is in progress with a red "Record" indicator in the 
window. 

 

Draw mode in the Surround panning dialog 
In order to prepare to drawing and move Surround sound as the source signal, a range in 
the VIP track where the automation will take place must be selected first. "Draw" mode 
must also be activated in the Surround panning window. Now you can move the source 
signal to a new position in the panning window. Samplitude creates automation events 
automatically to generate this movement for the automation curve. 

 

Drawing automation curves in the VIP track 
Samplitude allows you to draw new Surround sound automation curves in a VIP track or 
alter existing alter existing ones. Ensure that the "Pan" of the respective VIP track is 
activated. The "Automation on" feature may also be selected in the Surround panning 
window. "Panorama draw" mode must then be selected in the tools menu. Use this to 
draw new curve events in the VIP track. Position the mouse pointer close to an existing 
curve and click the left mouse button. While the key is held down, record new events for 
this curve. 

 

Surround bouncing 
Surround track bouncing allows you to automatically record complex sound mixes to a 
new wave file. The outputs of the individual surround buses are used as a recording signal. 
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The dialog "Trackbouncing (internal mixdown)" opens via "Tools". 

 

Surround Bouncing provides selection between creating a wave file or an MP3 files.  

An interleaved file may also be created:  

 

RIFF64 (also known as RF64) is a format for combining individual channels into a Surround 
sound production (e.g. for 5.1) as an interleaved file. 

The remaining settings may be selected during regular trackbouncing (view page 456). The 
abbreviations for individual Surround buses set in the "Surround audio devices" will be 
added at the end of the selected names of files to be recorded.  

Example: The file name "Mastermix" is selected when bouncing a 5.1 Surround mix in 6 
mono files. The following wave files are generated: "Mastermix_L.wav", 
"Mastermix_R.wav", "Mastermix_LFE.wav". The following combinations are output as 
stereo files: "Mastermix_LR.wav"; "Mastermix_LsRs.wav"; "Mastermix_CLFE.wav", and 
"Mastermix_CLFE.wav". 
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MIDI in Samplitude 
MIDI setup 
All global MIDI settings are provided in the system dialog (shortcut: "Y") under "System 
options -> MIDI". 

Please read "System settings -> MIDI settings" (view page 31) for more. 

 

Import, record, edit 
Recording MIDI tracks 

For MIDI recording and MIDI recording modes, please read "Samplitude Quickstart -> MIDI 
recording (view page 88)". 

 

Importing MIDI data 
Existing MIDI files may be imported into a Samplitude VIP project as objects. 

Menu:    File -> Import -> Load MIDI file… 
Shortcut:  Shift + M 
Mouse:    Drag & drop from file browser or Windows Explorer 

Set the playback cursor to the position at which the MIDI file should be inserted. 

When importing MIDI files, note that only type 0 and 1 standard MIDI files (SMF) are 
compatible with the import function. This corresponds with tracks featuring format 0 and 
multiple tracks featuring format 1. Each file should feature the file extension .MID in 
order to be detected as a valid import format. 
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The following dialog is displayed automatically: 

 

Standard MIDI files often also contain tempo information. Samplitude displays this 
information in BPM (beats per minute) in a separate section of the dialog. At this stage of 
importing, select whether to adjust the virtual project tempo to the tempo of the 
imported MIDI file or not. Place a check next to "Use MIDI-BPM in VIP" to do so. 

If the option "All MIDI channels in one VIP track" is selected, Samplitude inserts the MIDI 
object into the currently selected track in the virtual project. The MIDI object that is 
created contains all the tracks of the MIDI file. 

To provide a separate track in the virtual project for each MIDI channel of a standard MIDI 
file (format 1), select the option "All MIDI channels in a new VIP track". 

Samplitude also offers the option "Create new track" for multi-track import of MIDI files. 
If this function is not selected, existing tracks will be used for importing. 
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Editing MIDI objects 
Editing MIDI objects in Samplitude follows the same principle as editing audio objects: MIDI 
objects can be copied, split and trimmed, have fade handles for fading in or out, and a 
volume handle that scales the MIDI velocity. 

Freeze MIDI object ("Object > Freeze objects (view page 563)") causes each selected 
object to be rendered as a new wave file. The original MIDI objects are replaced in the 
arranger by audio objects. 

Note:Make sure to check that the your MIDI receiver's audio return signal (VST of ReWire 
instrument) is routed to the MIDI track. 

 Freezing is advantageous if a very system-intensive real-time plug-in is activated. The 
original object always remains preserved and may be re-edited using the "Edit object 
freeze" function or put back into the arranger via "Unfreeze objects". 

MIDI objects can also be edited using the MIDI object editor as well as in the different MIDI 
editors such as the Matrix editor, the drum editor, the controller editor, the event list and 
the note editor. 

 

MIDI object editor 
Object:    Object editor 
Shortcut:  Ctrl + O 
Mouse:    Shift + double click 

MIDI object parameters may be easily edited using the MIDI object editor, which is 
structured similarly to the audio object editor. Among other options, you can set sound, 
length, volume, and program swapping for each MIDI object. 

A Samplitude MIDI object can contain events in up to 16 channels. For example, it's 
possible to control a multi-output VST instrument using a single object on several MIDI 
channels. Notes in the corresponding MIDI editor can be edited simultaneously or only in 
one selected channel within this object. 

 

If there is only one channel in the MIDI object, settings will only be available for this MIDI 
channel. 

You can also use the MIDI object editor to quantize MIDI files into MIDI objects.  
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Note: These settings influence the MIDI object in real time and not destructively, making 
the changes invisible in the MIDI matrix or drum editor. 

Important functions and settings in the MIDI object editor: 

Velocity: The velocity fader works comparably to the volume fader in the wave object 
editor. 

Normally, every MIDI note contains a velocity value which determines how "hard" the note 
will be played back. Changing the velocity value in the object editor scales the volume of 
the notes in the MIDI object to their physical maximum or minimal value (0 or 127), 
calculating it together with the actual velocity note value. Changing the fader is identical to 
changing the top-center handle of the MIDI object in the VIP track. 

MIDI real time effects: Here you'll find the settings for a MIDI channel: 

MIDI OUT channel: Here you can redirect the MIDI files of a channel to another channel. 

Program: : The values preset here will always be sent if the object is played back again. 
Use these settings if various objects in a MIDI track should use different programs of a 
sound generator. 

Bank High/Low: This sets the MIDI Bank Change bytes. 

Transp.: This button transports all MIDI notes of the corresponding channel. 

Quantization:  While the quantization conducted in the MIDI editor has an immediate effect 
on the start position of the notes, a virtual quick quantization takes place. Absolute refers 
to the absolute resolution of the VIP project, while Relative refers to the relative resolution 
of the object itself. 

Options: 

Mute MIDI Controller:  Switches the MIDI controller off. 

Mute SysEx: Prevents control via the SysEx files. 

Position: Here you can specify the object start / position, object length, object end and  
step size. The setting is equivalent to moving the object in the VIP track or changing the 
length using the lower length handles right and left in the object. 

Loop:  If you tick the checkbox here, then you will set the MIDI object to "Loop" mode. 
Now drag the bottom left object handle to the left and you will see that the events of the 
MIDI object are arranged in a row, according to the new length of the MIDI object.  

The object name is displayed in the upper text field and this may also be edited. 

In the square field to the side you can select the object color. 
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Using the arrow keys you can "jump" up or down to the object of a neighboring track. 

Use the double arrow buttons to jump to the previous or next object. If multiple objects 
are selected, these buttons will not be active. 

If the "To all" option is active all selected objects are updated when the object editor is 
opened. All recently applied settings that have been made in a selected object, will be 
applied to all other selected objects.  

Note: 

In an object - velocity changes are transferred relatively, i. e. they are increased or 
decreased relative to the velocity of other selected objects. 

Bypass FX: Here you can deactivate all effects 

Freeze: If you click on the Freeze function for an object, this will be calculated as a new 
wave file with all the associated effects. The new Freeze object takes the place of the 
original object. 

Play/stop: This button corresponds to the normal playback function (Shortcut: space bar). 

Lock: The activated Lock button corresponds to the key button's switch in the object. The 
object is then protected against any inadvertent horizontal movement. Additional locks 
against vertical moving, volume adjustment, fades, length adjustments, ripples or deletion 
can be set in the  system settings  (Shortcut "Y") under "Program ->Object lock 
definitions" (view page 549). Locking can be temporarily cancelled by pressing the "alt" 
key. 

Solo: This button moves the play cursor, during playback, to the start of the selected 
object and plays that only. Track-dependent buses and AUX paths are also observed at 
playback. 

Mute: This button mutes the selected object. You can also mute the left and right channels 
individually too. 

Commentary: You can type comments relevant to the selected object in this field. 
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MIDI Editors 
Open MIDI Editor 
The MIDI Editor is opened by double-clicking on a MIDI object in the project. You can also 
start the MIDI Editor for all selected MIDI objects by selecting "Object > MIDI Editor ..." in 
the menu or by clicking on the "MIDI Editor" button.  

In case you open the MIDI Editor in the Docking bay (view page 50) there is the option use 
the toolbar by right clicking in a free range. 

 

Once opened it displays the MIDI files starting from the currently active position over the 
length of the object or within the selected range. 

The MIDI editor always shows the current MIDI object and the current arranger track from 
which this object originates. In the field to the right you should see the MIDI out or the plug-
in activated for this track. 

 

If no MIDI Object is selected, a window appears which lets you create an Object at the 
playback position. You can then choose between a menu of pre-defined MIDI templates 
from within the Samplitude “Templates” sub-folder. 
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Now you can draw in events into the MIDI editor (view page 250) or record notes via your 
MIDI keyboard. 

 

 Detailed information about MIDI recording is provided in the chapter "Samplitude 
Quickstart -> MIDI recording (view page 88)". 

 

Working with the MIDI Editor 
MIDI data can be edited in the MIDI Editor in five sub areas: 

piano roll editor 

 

drum editor 

 

Controller Editor (for example, velocity, MIDI volume…) 

 

Event list 

 

Note editor 

 

Various tools are available for editing, e. g. the pencil or eraser tools. Exact values for each 
MIDI event can also be set in the edit fields via the event window. 

 

Fundamentally, changes such as moving or deleting notes, always refer to all selected MIDI 
events (red) with just a few exceptions. Changes to the selection in a range always apply to 
every other range as well. You can, for example, select a group of notes in the Matrix Editor 
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and then change the velocity of these note groups which modifies all selected notes 
simultaneously in the Controller Editor. 

 

MIDI editor: Select events, delete events 
(Matrix-Editor, Drum-Editor, Controller-Editor, Event list, Note editor) 

 Select event: Left click on the event or pull a frame with the left mouse button over the 
event  

 Add/Remove event to/from selection: "Ctrl" + left click on event or "Ctrl" + pull the frame 
over the new event  

 Change/Set current event within multiple selection: Left-click on selected event  
 Set current event, deselect all other events: Double-click on event 
 Selection of events within an area: Left click on the first event, then left click with held-

down Shift key on the last event. Or: Drag a frame over the desired event(s).  
 Selection of all notes of a pitch: Double-click on the assigned key on the keyboard 

display.  
 Select all notes behind click position: Shift + Alt + Double click 
 Select all notes: Ctrl + A  
 Freehand note drawing and lengthening (back and front): Alt 
 Select previous/next note: Left/Right arrow keys 
 Delete events: Right mouse click 

 

MIDI editor: Copy/duplicate events 
You can copy selected events using "Ctrl + C" and then paste them at any play cursor 
position using "Ctrl + V".  

Copying and pasting MIDI data is available not only within the MIDI editor, but also 
between different MIDI objects. Copied MIDI data is always inserted at the current position 
of the play cursor. 

Duplicate: Press "Ctrl + D" to copy selected notes and add these to the next snap point 
behind the selection. Activate the quantization grid ("MIDI menu -> Quantization grid 
active") to do this. 

 

MIDI-Editor: Move events 
To move events, move the mouse over the event. The mouse pointer turns into move icon. 
Now you can move the event. If you have snap turned on, the events move horizontally 
according to the snap quantization values.  

To temporarily remove a event from the snap quantization, hold the "Alt" key when moving. 

If you only want to move an event horizontally, avoid accidental vertical movements by 
simultaneously holding the key "H". The move symbol will turn into a horizontal double 
arrow. 

If you only want to move an event vertically, avoid accidental horizontal movements by 
simultaneously holding the "Shift" key. The move symbol will turn into a vertical double 
arrow. 
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MIDI Editor: Zoom use the scroll wheel 
Just like in the project window, you can set the vertical and horizontal picture detail as well 
as the zoom factor in the MIDI editor using the scroll wheel: 

Scroll wheel: Horizontal scrolling 
Shift + Scroll wheel: Vertical zoom 
Shift + Ctrl + Scroll wheel: Vertical scrolling 
Ctrl + Scroll wheel: Horizontal zoom 

You can change the scroll wheel settings at any time by going to "File > Program 
Preferences > "Edit Keyboard Shortcuts and Menu (view page 488)". 

 

Synchronized image view in Arranger and MIDI editor: 
If you change the horizontal display using the scroll bars, holding the Shift key changes the 
corresponding Arranger window. 

 

MIDI editor: mouse mode/toolbar 
There are many different editing tools available for event creation and editing within the 
MIDI editor. For every tool (except the eraser), editing events functions in the same way as 
described above. The tools behave differently only when clicking in free areas. Access the 
mouse modes/tools via the MIDI editor's "Mouse modes " menu and via the following 
buttons: 

Selection (Shortcut: 1) 

 

Lasso: Hold down the mouse button to draw a selection window. 

Click in an empty space to remove an existing selection. 

Draw notes (Shortcut: 2) 

 

Draw an event by clicking the selected MIDI editor and dragging to the right with the 
mouse. The event snaps according to the current snap-quantization values. If the "Alt" key 
is held down, then the event may be drawn freely (without the snap function). 

Draw drums (Shortcut: 3) 

 

A sequence of notes may be drawn with this tool. The length of the notes and the note 
intervals are determined by the current quantization settings. Moving the mouse back (to 
the left) while holding down the mouse button removes previously drawn notes. 
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Draw pattern (Shortcut: 4) 

 

Select the MIDI events to use for the pattern first, then save this pattern via the keyboard 
shortcut "Ctrl + P". Next, draw in a sequence of previously selected patterns with the 
"Draw pattern" tool. Moving the mouse back (to the left) while holding down the mouse 
button removes previously drawn notes. 

Change velocity (Shortcut: 5) 

 

When this tool active, drag the mouse vertically, and the velocity values of the selected 
events will be increased or decreased relatively to each other. Holding down "Shift" 
changes all velocity values absolutely, i. e. every changed event has the same velocity 
value after editing. To recognize velocity of events by their levels, switch on "Velocity" for a 
controller slot button in the Controller Editor Range. 

Eraser/Delete (Shortcut: 6) 

 

This deletes the MIDI notes by left clicking. If multiple notes are selected beforehand, then 
all notes will be deleted. The eraser tool can also be used on specific MIDI notes to delete 
them. The eraser is also available to for all other tools (except the magnifying glass) by right 
clicking.    

Magnifying glass (Shortcut: 7) 

 

Zoom in with the left mouse button to the length display horizontally; use the right mouse 
button to zoom back out. 

The combination of left mouse button + dragging zooms in on the range. The zoom 
mode may be temporarily accessed again by holding the "Z" key at any time. After 
releasing the key, the mouse mode is active once more. 

Glue notes (Shortcut: 8) 

 

If a MIDI note is clicked on using this tool, then the note will join with the next MIDI note of 
the same pitch. 

Separate draw notes (Shortcut: 9) 
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This tool separates a note on the matrix into two notes. The separated note snaps to the 
next snap point.  

Mute (Shotcut: M) 

 

This mode mutes individual notes or selected groups of notes by clicking/activating them 
again. This function is also available as a command in the MIDI editor menu, "MIDI 
functions" (Shortcut: "Ctrl + M"). 

Tips: 

 "Shift to pencil": The "Shift" key is now the hotkey for "Draw notes" mode. This does not 
apply to the magnifying glass mouse mode, since "Shift" activates the vertical zoom in 
this case. 

 The keyboard shortcuts to switch the mouse mode/tool can be freely defined via the 
MIDI editor menu "Shortcuts -> Edit shortcuts".  

 "Delete" mode may be activated anytime by clicking/dragging with the right mouse 
button. For instance, use the pencil to insert new notes by left clicking, or remove 
already inserted notes by right clicking (without having to change tools). 

 No matter what the present mode is, "Draw" mode may be switched on temporarily by 
holding down the "Shift" key. 

 Notes created in "Draw" mode contain the MIDI channel and velocity specified by the 
editing fields below the toolbar. 

  Select the preceding/following notes with the left/right arrow keys. Change the pitch of 
the selected notes gradually with the up/down arrow keys. 
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MIDI editor: Editing fields 
Editing selected events (editing fields): The properties of every event in the piano roll, 
drum editor, controller, and listen editor can also be edited with the editing fields under the 
editing tools. The following buttons are available for each note: 

 Channel 
 Pitch (byte 1) 
 Velocity (byte 2) 
 Starting time in bars:beats:ticks 
 Length in bars:beats:ticks 

The display of the ticks has a resolution of 384 PPQ. 384 ticks correspond to a quarter 
note.  

Hold the left mouse button in the desired field and drag upwards or downwards to increase 
or decrease the value. The value steps are greater if you press "Ctrl". 

This value may also be edited numerically with the keyboard. Double click in the editing 
field you wish to change and enter the value via the keyboard. 

A few special properties result when multi-selecting events: 

For the "Pitch" and "Level" parameters, you can change the values relatively by dragging 
with the mouse, or by entering the values numerically and then confirming with "Enter". You 
can make absolute changes for all selected events by simultaneously holding "Shift" while 
dragging with the mouse in the editing field, or by finishing the entry process with "Shift + 
Enter". 

For the "Time" and "Length" parameters, you can change the values relatively by double 
clicking the desired value field and then confirming with the mouse wheel.   

Note: MIDI channel changes are always permanent for multiple selections. 

 

MIDI functions 
The commands in the MIDI functions menu always refers to all selected notes. If no notes 
have been selected, all functions are applied to all notes. 

Legato:  Notes may be prolonged and played back in bundles. 

Shortcut:   Ctrl + L 

Note Quantize (standard): This command conducts standard quantization of the lengths 
of the MIDI notes of all selected MIDI objects according to the MIDI quantize settings. 

Shortcut:   Ctrl + Q 

Extended Quantize: 
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Start Q: This command quantizes the start positions of the MIDI notes for all selected MIDI 
objects according to the MIDI quantize settings. The grid view corresponds to the start 
quantization value. 

Start and Length Q: This command applies quantization to the start and length of the 
MIDI notes of all selected MIDI objects according to the MIDI quantize settings. 

Soft Q (quantize approximation): This command includes the current Soft Q level value in 
the quantization options. 

Q length/quantize MIDI length:  This command applies quantization to the lengths of the 
MIDI notes of all selected MIDI objects according to the MIDI quantize settings. 

Quantize Note Ends to Grid: This command quantizes the ends of the MIDI notes of all 
selected MIDI objects according to the MIDI quantize settings. 

Reset Quantization: Use this command to reverse all completed quantization steps. 

Hint:  "Reset quantization" is still possible after saving and loading a VIP. During 
quantization, the distance to the next grid position saved together with the note and 
recalculated after "Reset quantization" is selected. This way the original groove or phase of 
a note can be restored even after displacement or copying. 

Quantization settings: Make detailed changes to the quantization settings in this dialog 
(see below). 

Quantize/Thin out controller: Controller values may be quantized or reduced with this 
function. 

Humanize: This command considers the current Humanize value in the quantization 
options. 

Mute notes (mute): Mutes and unmutes notes. 

Remove note overlaps (polyphonic): Notes may be shortened to avoid any overlaps. 
Chords (simultaneously played notes) are recognized and left uncorrected, i. e. chords are 
not split up. 

Remove double notes (monophonic overlaps): Notes may be shortened to avoid any 
overlaps. This function forces monophonic voice leading. 

Transform sustain (CC64) to note lengths: You can transform sustain values of events 
into notes lengths and display them in the MIDI editor. 

Transpose: Here you can transpose the pitch of selected events into half steps. 

MIDI Timestretching: With this function you can make various changes to selected 
events, e.g  



 

M I D I  E DI TO R S 2 5 5   

 double the tempo 
 halve the tempo 
 scale to range length. 
 manual stretch. This allows you to enter individual values in the Stretch Factor field. 

If, when using this command you don't select any notes it is the same as selecting all 
notes. 

Retrograde (Reverse): With this function you can reverse the playback sequence. The 
events move by a further quantization step each time they are reversed again.  

This command affects all events inside the specified range i.e. all selected events. If you 
have not selected anything, all events will be affected. 

Melody Inversion: This function mirrors the selected events in terms of the pitch of the 
current note. 

If you don't define any particular notes, the mirroring will affect the mid pitch of all notes. 
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Velocity dynamics 
The MIDI velocity dynamics can be accessed as an offline effect via "MIDI editor  MIDI 
Functions > Velocity dynamics", or as a real-time track effect in the track editor.  

"Velocity dynamics" is a MIDI effect that edits the MIDI velocity dynamic of the selected 
MIDI notes. It can be used in real time as a track effect during playback and for MIDI-Thru 
(button in the MIDI section of the Track editor), and also offline via the corresponding 
menus. 

Velocity dynamics makes it possible to adjust the MIDI velocity to the dynamics of the 
connected synthesizer, i.e. to adjust MIDI synths or VSTis, thereby compressing or 
expanding the velocity strength of the selected events.  

Each input velocity value is assigned to a specific output velocity via the characteristic. The 
characteristic curve may be set linear like a compressor/expander, but other 
characteristics patterns are also available to produce exponential and sinus/cosine 
curves. 

 

The Preset field contains a series of presets for different compressor or expander 
applications; these may be used to form the basis of individual adjustments. 

Ratio (0.10 - 10.0): This parameter describes the level of compression/expansion as the 
MIDI input signal reaches the threshold. 

Threshold (0 - 127): Threshold specifies the level at which MIDI events are adjusted via 
velocity dynamics. 

Inverse: Velocity values above the thresholds aren't processed, but rather only those 
values below the threshold. 
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Gain (-128 – +128): The gain controller sets the amplification factor for events after they 
have been processed by other parameters 

Auto: If this option is activated, the gain parameter will be adjusted automatically to reach a 
consistently full overdrive (Velocity 127). 

Limit maximum and Limit minimum are used to limit the top and bottom velocity ranges 
by entering a minimal or maximum velocity value. 

Offline mode 

Offline mode makes the Set value button available. If this is pressed, then the selected 
MIDI events may be set to the velocity value entered in the field next to it.  

Change velocity with the random function 
With the Random Variation button you can assign several of the same velocity values to 
subsequently fluctuate around mean velocity values, e.g. in order to make a programmed 
sequence sound as if it were played live. In the field next to the button, enter the maximum 
deviation value allowed. The velocity values will be altered randomly within the range 
specified.  

If randomized variation should be displayed in relative %, then this option must be 
checked accordingly. If the Randomize button is clicked now, the selected MIDI velocity 
values will change accordingly. At a lower dynamic in the original material, variation will be 
softer than positions with higher dynamics.  

Only for notes in limit zone: A check placed here modifies notes with a velocity within the 
limit minimum and limit maximum. This enables all notes with a velocity of 100 to be set to 
77 or only notes above velocity 100 to work with random variation. 

Note:  By setting the limit minimum and limit maximum to the same value, a fixed value 
may be set for the velocity for real-time use. 
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Quantize 
Irregularities when recording patterns maybe evened out with quantization. Samplitude 
features audio quantization as well as MIDI quantization.  

Details about audio quantization are provided in the menu reference "Object > Quantize > 
Audio Quantization wizard (view page 550)". 

Recorded MIDI events may be set to the exact note start and note length values using MIDI 
quantization. Quantization may also be varied with additional parameters like "Soft Q", 
"Swing", or "Humanize", which adjust quantized MIDI notes to the musical properties of 
each song. 

The quantization functions are featured in the MIDI Editor via the "MIDI functions". 

The settings for MIDI start and length quantization can be found in the "Menu Object > 
Quantize > MIDI Quantize settings" or in the "Grid quantization value" and "Length 
quantization" fields of the MIDI editor's toolbar. If in the length quantization values input 
field you enter the value # the value will be linked to the respective snap quantization value. 

 

The setting Musical measure means that, signatures based on quarter notes serve as a 
quarter snap unit, and time signatures based on eighth notes serve as a eighth snap unit. 
The snap therefore follows the time signature and observes any time signature changes. 

The grid view in the MIDI Editor corresponds to start quantization value. If you also hold 
down the "Alt" key, the grid will be disabled temporarily. 
 
Clicking the "Quantize" button at the top right in the MIDI editor quantizes the start 
positions of all selected MIDI objects according to the MIDI quantize settings (view page 
259). If no notes are selected, then all notes will be quantized.  

 

Shortcut: Ctrl + Q 

Right clicking this button opens the dialog for the global grid/quantize options (view page 
259). 

The command "Extended The command "Extended MIDI quantize (start and length 
Q)" applies quantization to the start and length of the MIDI notes of all selected MIDI 
objects according to the MIDI quantization options.quantize (start and length Q)" 
applies quantization to the start and length of the MIDI notes of all selected MIDI objects 
according to the MIDI quantization options. 

"Soft Q (approximate quantization)" includes the current soft Q values in the quantization 
options. 
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Quantize Note Ends to Grid This option may be used to extend the ends of the selected 
notes to the next snap point according to the set values. 

Reset quantization: This function resets all quantization processes. 

 

Quantization - window view 
In this case, the quantization snap grid (Q snap) is displayed graphically, and the Q range 
appears gray. Only notes or slices within the Q range will be changed.  

 

The beat names in the quantization grid depend on the beat signature that is set. The blue 
lines depict the effective Q snap as well the velocity level (bar height) for groove templates. 

Note: The beat signature in the quantization dialog is independent of the tempo map.  

 

Quantization settings 
For precise specification of the global grid and quantization options, a separate dialog is 
available to you in the menu under "Object > Quantize > MIDI Quantize settings": 

 

This dialog can also be accessed in the MIDI editor via "MIDI functions -> extended 
Quantize > Quantize settings" or by right clicking on the "Quantize" button. This dialog 
displays the main view depending on the settings in the quantization area and the 
respective quantization snap points.  
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Settings applied here also affect the behavior of the "Input Q (view page 58)" button in the 
track editor. 

In this case, MIDI quantize settings changed in the VIP are applied as a preset for new 
VIPs. 

 

Quantization presets 
Here you can select from a number of presets: 

 5-tuplet:  Quantization occurs in fifths 
 Magnetic quantize: The "Q window" value is set to "50", i. e. only 50% of quantization 

will be considered. Only events that are within a range of 25% of the grid width left and 
right of the grid point will be quantized. 

 Swing: The swing parameter is set to "75", i. e. in contrast to the binary rhythm, which 
features a "swing" value of "50", inclined/un-highlighted counting times will be set to 
delay. This results in a swing feeling 

 Triplets: Quantization occurs in triplets 
 16th offbeat: The quantization grid's timing is moved back a 16th note 
 8th offbeat: The quantization grid's timing is moved back an 8th note 
 "New groove" and "More life for hi-hat" provide groove templates 

Of course you can create and save your own settings as presets. 

 

Q grid/Q length 
Both fields for "Q snap" and "Q length" match the fields in the MIDI editor's toolbar. The 
settings for grid and length quantization are also located here. The value "#" in the length 
parameter couples the length quantization value to the respective snap quantization value 
that has been set.  

 

Tuplets (8th, 5th, 7th) 
The Q grid also provides n-tuplet quantization values (for thirds, fifths, and sevenths). For 
example, if 7 is entered, the grid will be adjusted for septuplets. The count will be divided 
into 7 subsections for quantization. A thirds snap is indicated by a "T" behind the number. 

 

Groove template 
You can set a rhythmic pattern on all selected MIDI events or Audio objects with Groove 
Templates. Groove Templates adjust the selected range of a recording to a specific 
musical grid. So you can bring static MIDI patterns to life, quantize them according with 
available audio drum loops or create special metrics like dotted grid values. It is also 
possible to make a rhythmic pattern for the MIDI pen. As well as the position the velocity 
and note length can be also be changed with the Groove Template (only for MIDI).  

A Groove Template enables a freely-definable grid. As a rule it is from one to four beats 
long and repeats itself in a loop. The length of the Groove Templates is in principle, 
however, freely-definable. You can also create a grid based on a track's bass drum, to 
draw a perfectly in-time bass using the MIDI pen. Length and start of the Groove 
Templates are continually set to all the beats. 
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You can select the grid from the Groove Template selection box, which puts binary, triplet 
and dotted note values at your disposal. 

 

If a you have selected a groove template, the "Snap/Quantization value" field of the MIDI 
editor will indicate "Grv". 

The MIDI editor may be used to create new groove templates yourself by selecting the 
MIDI events as the template and then accessing "Edit -> Create groove template from 
selection". 

This quantizes the Groove Template to entire bar borders. So if you want to create a 
Groove Template that is 2 eighths long, choose a 2/8 time signature. 

Additional to each note start position both the note length and velocity are saved in the 
Groove Template. In the file selection box you can give your Groove Template a name. 
Subsequently the Groove Template is immediately active and appears in the grid 
quantization list. 

Groove velocity (appears only for groove templates): The groove velocity indicates in % 
how much the velocity information affects the groove template. 

Groove note length (appears only for groove templates): The groove note length 
indicates in % how much the note length information affects the groove template. 

Note: If a groove template is selected, then the parameters "Swing" and "Offset" will be 
deactivated and grayed out. 

For audio objects, you can create groove templates by specifying the transients (AQ 
markers) for the audio object intended to serve as the template via "Object > Quantize > 
Extended audio quantize" and then accessing the "Create Groove Template from 
Transients" function. You can also reduce the range in which you want to create Groove 
Templates through another active range. Then only the AQ marker within the highlighted 
object range will be taken into account. 

If you rename the new Groove Template and put it in the "fx-preset/Grooves" program 
folder, it will be available in the future in the Groove Template selection box. 

 

Show Grid/Time Signature 
Displays the desired beat signature and number of beats. The display window will change 
accordingly. 

 

Q Threshold 
The parameter "Q threshold" may be used to slightly vary quantization by excluding notes 
from quantization that are very close to the next quantization value. 
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Q Window 
"Q window" refers to the interval to the left and right of a grid point; events will be 
quantized within this range. No quantization will take place beyond this, and for this reason, 
the events outside of this window will remain at their position. The quantization area is 
dependent on the values of the parameters "Q snap" and "Q threshold". 

Example: Grid: 4  max. Window: 4 

 100: The Q range covers the entire area between the grid points on the quantization 
grid. All events will be quantized 

 50: The Q range covers half of the quantization interval. Events with gaps of ¼ of the 
grid width left and right of the grid point (1/16 note values in this example) are quantized 

 0: no Q range -> quantization off 

 

Select notes within the Q range 
This button activates a display of the selected events that will be quantized for the currently 
set Q window size of the quantization range (Q range). The affected events are displayed 
with a red outline.  

Click in an empty area in the MIDI editor to deselect.  

The smaller the window size for the quantization area is, the fewer events will be included in 
quantization. The Q range and the graphical velocity display function help, e.g. to assign a 
lower velocity to all offbeat notes. 

 

Swing 
Set swinging, ternary playing with this value. This enables you to enter the division for an 
uneven/unaccented grid points. 

 50: "50-50/1:1" split. The unaccented eighths are exactly half way between the even 
eighth notes ("even", binary playing method) 

 67: "67-33/2:1" tuplets. The beat is split up into three counts, whereby the note is 
assigned 2 beats (67%) and the off beat note one count (33%) 

 75: "75-25/3:1" split. For example, a pointed eighth and a sixteenth is created from two 
eighth notes 

 

Offset 
The value range in this parameter stretches from -100 to +100. By changing the offset 
values, you move the whole quantization grid. Select a negative value for the offset, and the 
quantization grid will be moved by the corresponding value to the left, or forward in time. 
On the other hand, if you select a positive offset value, you will set the quantization grid by 
the corresponding value to the right, or backwards in time. 

A value of -100 corresponds to a shift of half a grid length to the left; +100 corresponds to 
a shift of a half a grid length to the right. 

 

Humanize 
The "Humanize" parameter creates another variation option, i.e. notes are able to be 
assigned according to the randomization principle up to a specific interval to positions 
around the exact quantization value. The setting occurs in % of a 16th note. The value 
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specified therefore determines the possible interval between the quantized notes and the 
exact quantization value. 

 

Soft Q 
This value sets the strength or "Soft Q" value of the quantization. 

 "100" moves the event precisely to the quantize grid point, 
 "50" shifts the event to the middle between the current position and the quantization grid 

point,  
 "0" means no movement, i.e. quantization off 

"Soft Q (quantize approximation)" (in the arranger menu "Object > Quantize > Extended") 
considers the current "Soft Q" value in the quantization options in contrast to "Note" and 
"Start" quantization.  

In contrast, quantization commands "Quantize notes (start and length)" and "Start 
quantization" always proceed with 100% strength. This corresponds with a Soft Q setting 
of 100.  

Note: Use the keyboard shortcut for the approximation of soft quantization and hard 
quantization. In this manner, you can always select between approximation soft 
quantization and harder quantization without having to switch quantization options every 
time. 

 

Standard Quantization 
Here you can choose what type of quantization is used as standard after pressing the 
"Quantize" button. You have the choice between: 

Start Q - Start quantization 
Start and Length Q - start and length quantization 
Length Q - length quantization 
Soft Q - start quantize approximation 

The "Apply standard Q" applies quantization according to the selection. 

Note: If you give the "Soft Q" parameter a value other than 100, please take care that you 
also change the setting to the soft quantization mode. If the corresponding quantization 
settings should be considered, you need to set the "Soft Q start" command as the 
standard quantization. In contrast, quantization commands "Q start" and "Q start + length" 
always proceed with 100% strength (Soft Q). 
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Undo quantization/reset 
With the help of the round arrow buttons, you can undo/redo the last quantization made. 
In this case, the counter-clockwise round arrow provides the "Undo quantization" function, 
while the clockwise arrow serves as the "Redo quantization" function. 

Reset quantization: This function resets all quantization processes. 

The "Standard settings" button provides the option of resetting the preset values: 

Q threshold: 0 
Q window: 100 
Swing: 50 
Offset: 0 
Humanize: 10 
Soft Q: 25 

 

Step recording via keyboard or controller keyboard 
In the MIDI editor, so-called "Step recording" may also be executed via the computer 
keyboard or a MIDI fingerboard. Activate the corresponding button first. 

 

A marker shows the scope of the current octave for the following entries. Now you can 
enter MIDI notes step-by-step via your keyboard. Note length and step length may be 
specified via the length quantization values. The most important keyboard shortcut for 
entering MIDI notes using step recording: 

Tab : One step forwards (set pause) 
Shift + Tab : One step backwards 
Ctrl + arrow up/arrow down : Octave entry up/down 
CDEFGAH : Note entry in current octave 
Shift : Enter chords 

Different notes may be entered without the play cursor jumping if you hold down the "Shift" 
key. This enables chords to be played. 

Of course, notes may also be entered in "Step recording" mode via the controller's 
keyboard. 
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Cell Edit Mode 

 

This mode may be opened/closed manually by clicking the "Cell" button beside the 
horizontal scroll bar. "Cell edit" mode provides an alternative view of the MIDI events: 

 Notes are displayed as cells. In this case, the actual note lengths for the individual events 
are no longer considered. You may specify a unified display width of all events a lot more 
by setting the snap quantization and length quantization values in the MIDI editor's 
toolbar. 

 The intensity of color of the individual notes increases with velocity strength – for larger 
velocity values, the event is displayed in dark blue, and events with little velocity are 
highlighted light blue.  

 "Cell edit" mode provides a better overview for display of MIDI percussion instruments 
(see drum editor (view page 269)), since these often appear as short, explosive events. 
Display is limited to the most important information, note starting points, and velocity. 

 

Velocity Mode 

 If you click the "Vel" button next to the "Cell" button, the view switches to "Velocity" 
mode.  

In this case, the velocity strength is no longer displayed like before (with different color 
intensity of events). "Velocity" mode keeps the events the same color. The respective 
velocity may be recognized by the height of the event. The event's velocity may be 
changed by dragging the mouse to the upper edge of the respective event. In all mouse 
modes (except for "Delete"), the velocity can be changed by directly clicking without having 
to switch to the controller editor.  

Note: "Edit Shortcuts" in the MIDI editor menu enables the parameter "Event velocity" to 
be changed in the MIDI editor via a shortcut assigned by you. The functions "Velocity up" 
and "Velocity down" are available. 
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Matrix Editor (Piano Roll Editor) 

 

For all MIDI objects that show no entry in the "Drum Map" field, you can open the Matrix 
Editor with a double click. The button is selected in the MIDI editor if the Matrix Editor is 
active. 

 

The Matrix Editor is easy to recognize via the piano icon on the left side of the editor. The 
MIDI events displayed are arranged according to their respective pitch. 

 

Note display 
Notes which are not selected within the editor are displayed in blue. The intensity of the 
colour represents the velocity. The velocity increases while getting darker/stronger in color. 

Selected notes are displayed in red. Here too, a more intense color symbolizes increased 
velocity 

Current event: Selected events appear in bright red with a red border. The properties of 
the currently selected events are displayed in the edit fields above the Matrix Editor If an 
event is selected with the mouse, it turns into the current event. 

 

Velocity colors: Unselected note (blue), selected notes (red) and current events (red with 
border) in the Matrix Editor 
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You can also determine the colors of tracks or MIDI channels via the "Options" menu in the 
MIDI editor. If no previous track colors have been set, random colors will be assigned for 
track color display in the MIDI Editor. 

 

Track color display for MIDI events 

In the MIDI channel color display MIDI events are displayed in different colors, based on the 
MIDI channel settings.  

 

MIDI channel color display 

Display of filtered events: To get a better overview of the events of a MIDI object, you can 
filter specific events for the display. 

Example: The MIDI object features notes in the MIDI channels 1, 2, and 5. By selecting 
both MIDI channels in the MIDI editor menu "Options -> MIDI channel filter", you may 
make all notes in channels 2 and 5 available to editing tools. All unselected notes in 
channel 1 will be filtered and will be displayed in gray/pale in the Matrix Editor and in the 
Event list. 

Events in the filtered channels may be hidden completely using the "Hide filtered MIDI 
data" in the "Options" menu. 

The Event list (view page 277) provides additional display filters that only function within the 
list.  

Display of muted events: MIDI object settings (view page 244) (shortcut: "Ctrl + O") may 
be used to mute notes and filter other MIDI events. Muted events appear paler in the Matrix 
Editor and Event list. 

Events above and below the current picture section: Two small red rectangles above 
and below the vertical scroll bar to the right-hand side of the MIDI editor screen show in 
red if there are notes outside the screen's display. 
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Matrix Editor: Special selection options 
In order to directly select all notes of a certain pitch, double-click on a free section with this 
pitch in the Matrix Editor or in the keyboard. Hold down the "Alt" key to select notes with 
this pitch from this click position only. 

Using the "Shift + double click" key combination on a free area, you can create a new 
event and simultaneously select all notes of this pitch. 

Note: If you additionally press "Ctrl" during any of these selection methods, the new 
selection is added to the current one (i. e. the previous selection is not canceled). 

 

Matrix Editor: Edit events 
If you move the mouse over an event the pointer will change depending on which event bar 
area the mouse is in. The following options are available: 

 Change event start time: drag the event's front edge. The note end remains intact. 
 Change event length: drag the event's back edge. The note start remains intact. 
 Set fixed event length: for multi-selection, hold "Shift" and drag the currently referenced 

event longer or shorter. This function makes all event equal length. 
 Scale event length relative: for multi-selection, hold "Ctrl" and drag the currently 

referenced event longer or shorter. The lengths of the other selected events change. 
 Move events horizontally: move the mouse over an event whilst holding the "H" key. The 

mouse pointer will turn into a horizontal double arrow. Move the selected events 
horizontally in the timeline. The step size is defined by the set grid value. 

 Move events vertically: move the mouse over an event whilst holding the "H" key. The 
mouse pointer will turn into a vertical double arrow. Move the selected events vertically in 
pitch. 

 You can temporarily remove the snap and freely drag the event by holding "Alt". 

Relative snap for moving operations ("Options -> Relative movement in grid"): If this 
option is active, the interval between events to the next snap position remains for event 
moving. This makes preferred implementation of instrument groups easier to rearrange. 
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Drum Editor 
After opening the MIDI editor (double click on the MIDI object), switch to the corresponding 
field  

 

in the Drum Editor. Instead of the piano keys, a list of drum instruments is displayed. 

 

Note:If a drum map is active in the arranger track (recognizable by the word "map" in the 
MIDI area of the track editor (view page 58)), the drum editor is loaded automatically when 
the drum editor is loaded. 

Drum editor track box: In the individual track boxes of the drum editor, you can 
individually adjust MIDI channel (K), grid (#), quantization length (L), display width in cell 
mode (< >), and the velocity scaling in percent (V) for each drum instrument. 

 

Display width in cell mode: You can determine the display width of the notes of the 
current snap in percent with this value. The setting has no effect on playback. At "100" the 
displayed note completely fills the cell. 
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Velocity scaling: The velocity value of each note is multiplied by the V value/100 and 
adjusted to the MIDI velocity between 1 and 127. Scaling is audible, but is not visualized 
further. 

When the drum editor opens cell edit mode (view page 264) activates by default. Here, 
moreover you can turn Velocity Mode (view page 265) on. 

 

Mouse modes 
The following modes are available for editing events, just like in the piano roll: 

Selection mode (shortcut: 1): Use this mode to select drum events, move, or change the 
length of one or several events simultaneously. 

Draw tool (shortcut: 2): This mode enables you to draw in drum events manually. If the 
grid is active, the events will be quantized immediately. 

Drum tool (3): This mode also includes a draw function. However, the quantization length 
is also included while the events are drawn. 

Pattern tool (4): This mode allows you to draw entire drum patterns (or melody patterns). If 
you want to create a new pattern, you have to select it first in "Selection" mode and press 
"Ctrl + N" simultaneously (or go to menu "Edit" in the "MIDI/drum editor -> Create pattern 
from selection"). If you have created a pattern, you can start drawing at any position. The 
lowest note in the pattern is then the pitch you are drawing. 

Velocity tool (5): This mode allows you to mark events and change the velocity values of 
all selected events in relation to each other. Absolute values are entered when you hold the 
"Shift" key, i.e. all changed events receive the same velocity value. 

Eraser (6): This tool deletes events with a single mouse click. 

Zoom mode/magnifying glass (7): Draw a rectangle. The tool will zoom into the 
rectangle. The left mouse button is used to zoom in, the right one is used to zoom out. 

 

Velocity 
 If this button is active, the bar height is used when displaying the velocity 

value of the note. 
In all mouse modes (except for "Delete"), the velocity may be changed by clicking directly 
on a note without have to switch to the controller editor. 
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Drum Maps 
A drum map assigns certain qualities to the different drum instruments of a MIDI drum kit. 
Besides key assignment for pitch, the export note, the MIDI channel, and the quantization 
are defined.  

The "General MIDI" map is used by default to distribute drum kits. 

You can set the drum map in the drum editor by selecting the "map" field in the desired 
drum map. You can also open the drum map under in the track editor under "MIDI". 

 

It may be the case that your synthesizer, VSTi, or the drum computer do not refer to the 
GM map, but to a different mapping setup. If this is the case, you will hear a different sound 
than you expect when playing the drum events (e.g. a tom drum instead of a bass drum). It 
is recommended to create a correct drum map for the current playback device. In this 
case, select the command "Create new drum map) and assign the individual instruments to 
the corresponding pitch or key assignments of your MIDI keyboard. The quantization 
options and MIDI channel options may be defined individually. The newly created drum 
map must be saved, and will then appear in the selection menu. 

Note: A drum map is already available for the MAGIX Synth ROBOTA PRO. If you embed 
ROBOTA into your setup, please select "ROBOTA PRO" as your drum map. 
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Drum Map Editor 
This editor enables you to route each played note to a different one and give them their 
own individual names. It's also possible to assign each individual instrument its own 
quantization and a new (MIDI) output channel. 

 

Pitch: This parameter indicates the incoming MIDI note. The value cannot be changed, so 
the pitch always corresponds to the input note. 

Instrument: Name each corresponding percussion instrument here. 

Grid: Specify a grid for the start point of the drum events individually for each instrument. 
Leave the value set to "Global", and the globally set quantization value in the toolbar will be 
adopted.  

Length: Specify a grid for each instrument for the length display of drum events. Leave the 
value set to "Global", and the globally set quantization value in the toolbar will be adopted.  

Output note: Specify the note value each drum instrument or the incoming MIDI note in 
the "pitch" field" will be "mapped". 

Channel: Specify a defined MIDI channel for each instrument. The value set here disables 
the channel setting in the MIDI track. 

Note: In addition, you can set detailed quantization settings for each instrument in the 
drum map editor using the "Quantization options" button. 

 

Quantization in the Drum Editor 
You may also assign individual quantization values to drum instruments. To make the 
necessary settings, select the arrow next to the track name of the instrument you want to 
edit and open the quantization options. 
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Controller Editor 
The controller editor is located below the matrix or the drum editor; this may be hidden or 
shown via the keyboard shortcut "Alt + V".  

 

ein- und ausgeblendet werden. If you position the mouse below the horizontal scroll bars, 
the mouse cursor will turn into a vertical double arrow. Pull it up to enlarge display of the 
controller editor.  

The controller editor is used to display and edit up to 4 different MIDI controller curves 
simultaneously. 

 

Note: To display more than one Controller button, hold the mouse just below the scroll bar 
and drag the double arrow that appears upwards whilst holding the left mouse button. If 
you now click on one of the Controller buttons, the corresponding Controller line will be 
refreshed. 

If you click an the arrow for a controller slot, the following controller types are available for 
selection: 

 

 Velocity 
 Pitch bend (bend the note pitch, just like with the pitch bend wheel of a keyboard) 
 Aftertouch (pressure on the key after the first strike to control additional parameters, 

specified via the MIDI playback device) 
 Program change (selection of program changes for assigning preset sounds to the 

corresponding MIDI device) 
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 with a continuous controller numbered 0-127 The controller selection features the 
controller types available to the respective object; a star behind the name of the 
controller type indicates that a controller curve already exists for this controller type. 

 The velocity values are displayed directly in the controller editor as vertical bars under the 
corresponding notes. The height of each bar represents the corresponding note velocity 
strength. As velocity increased, the color intensity of the bars also increases. Selected 
events appear red in the controller editor. 

 

The values of all other controllers will appear in the controller editor as ramps. In this case, 
the height of the ramps and their color intensity also represent the last defined value of an 
event. The length of the ramps reaches to the next varying event. Selected event ramps are 
also represented in red. 

 
 



 

M I D I  E DI TO R S 2 7 5   

Selecting and drawing events 
Combi tool: 

 

Keyboard shortcut:  Ctrl + 1 

The mouse cursor button provides you with a combi tool. Use it to select, change values, 
and draw freehand and uniform lines.  

Click a position on the controller editor and start drawing horizontally, and two red vertical 
lines will appear. The first indicates the starting point of the selection and the second 
displays the end point. All events located within the limits are now selected and displayed 
in red. 

Individual events may also be selected by clicking the respective bar.  

To delete selected events in the controller editor, press the "Del" key or the back space 
key.  

Other editing options with the combi tool: 

Click on the bar end: The controller value may now be adjusted by dragging vertically. 
Hold the "Shift" key down while dragging, and all of the selected events will be set to the 
same value. 

Alt + drag (with the pencil): This activates freehand drawing, and the mouse cursor 
becomes the pencil. Detailed envelopes, ramps, and grades may be created by dragging in 
the respective controller range. 

Shift + drag (with the cross hairs): This activates line drawing and the mouse pointer 
becomes a cross hairs. Create envelopes, ramps and grades, or set all of the events to the 
same value by dragging horizontally. 

Draw freehand: 

 

Shortcut key: Ctrl + 2 

This activates freehand drawing; the mouse pointer becomes a pencil. Detailed envelopes, 
ramps, and grades may be created by dragging in the respective controller range. Correct 
curves during drawing by dragging backwards. Any existing (multi) selection is ignored. 
Create crescendi or decrescendi using velocity curves, for example. 

Single clicking creates a new ramp which reaches up to the next controller event.   
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Shift + click & dragging with the cross hairs to draw a line. 

Hint: When editing the velocity, no new notes are generated; existing velocity values are 
only modified by dragging and clicking the events. 

Drawing lines: 

 

Shortcut key: Ctrl + 3 

This activates line drawing; the mouse pointer becomes a cross hairs. Create envelopes, 
ramps, and grades by dragging horizontally. 

Single clicking creates a new ramp which reaches up to the next controller event.  

Hint: When editing the velocity, no new notes are generated; existing velocity values are 
only modified by dragging and clicking the events. 
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Tips 

Copying controller events: 

You may copy selected events using "Ctrl + C" and then paste them at any play cursor 
position in the corresponding controller editor using "Ctrl + V". 

Timeshifting several selected controller events:  

First, select all events you would like to move. To select different controller types together, 
hold down "Ctrl" at the same time. Now you can move the selection in the time field by 
entering a value or by vertically dragging the double arrow. 

Use the display filter function for velocity values: 

In multi-voiced areas, the velocity bars are located above each other, making it difficult to 
select the respective note bars. To edit only notes of a certain pitch, e.g. all C1 notes in the 
controller editor, click the corresponding key on the keyboard. The key and the 
background of the selected pitch are highlighted. Only notes of this pitch are displayed in 
the controller editor. Repeated clicking of the same key removes the selection. 

You can also select several pitches for the velocity visualization filter by clicking on the 
desired buttons while holding down "Ctrl" or "Shift" for the keyboard area. 

Another option to selectively edit velocity bars located on top of each other is to edit the 
currently selected note using the mouse. Click on an event inside the piano roll or the 
controller editor. Finally, navigate to the desired note with the "Cursor left/cursor right" 
buttons and change the controller value by clicking the top third of the red area and 
dragging the double arrow that appears. 

Quantize controller events 

MIDI controller events may be quantized and thinned out; select the "MIDI functions" menu 
and the "Quantize/thin out controller" command to do this. Quantization occurs according 
to the quantization settings. 

Detailed information about quantization is provided in "MIDI editors -> Quantization". 
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Event list 
Open event list: The MIDI editor has an integrated display of all events in list format. This 
List Editor can be opened with the button above the keyboard or by using the “Alt + L” 
keyboard shortcut. 

 

When the event list is opened and activated for editing, it has a narrow red border. This is 
to make clear that certain functions, e.g. select next/previous event (arrow keys) or the 
“Select all” (Ctrl + A) command, refer only to the List. 

Working with the list editor:  The list editor does not only display note events, but also 
percussion instruments (in drum editor mode), MIDI controllers, and SysEx messages. 
These controllers and messages may be hidden and even filtered by checking the 
appropriate "mute" box. 

 

Double clicking on a SysEx entry in the list opens a simple editor for viewing and editing the 
SysEx information. 

A note on and a note off event (or note on with velocity 0) belong to a note. These are 
always selected and edited in pairs. You can show and hide note off events by ticking the 
corresponding checkbox beneath the Editor. 

You can create new events in event list directly at the play cursor position using the "Insert" 
button. 

 

The values of the previously selected notes are still in effect for the edit fields channel, 
byte1 (Pitch), byte2 (velocity), time and length. 

 

If you would like to edit only certain events specifically, the event list offers various display 
filters. These are small check boxes above the event list columns. If you click a box, it will 
change to blue and the respective display filter is active.  
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The display filter provides information for the editing fields MIDI event, MIDI channel, pitch 
and velocity.  

Example: Select a note and click a display filter of the pitch column to only display events 
of this pitch. All other events will be faded out: 

 

Display filters can be combined with one another. For example, all control change events of 
type 10 (pan) to MIDI channel 1 may be filtered for display. Then, you can select all 
matches will "Select All" (Ctrl + A) and edit together in the editing field or delete with the 
"Del" key: 

 

Advanced filter functions in the list editor 

You can access the following filter functions by right clicking on the display filter buttons: 

=  equal 
!=  unequal 
> bigger or equal 
< smaller or equal 

The filter functions listed above relate to the selected event kinds like "Note On" or "Ctrl 
Ch". For example, this function filters out all notes with a velocity of 40 or lower: 
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Multi object editing (MO-Editing) 
 You can also load several MIDI objects simultaneously in the MIDI editor. All MIDI objects 
selected in the arranger are added to the MIDI editor by clicking the "MIDI editor" button in 
the Docker (view page 50). 

 

In an already-opened MIDI Editor you can include additional MIDI objects for Multi Object 
editing by clicking in the Arranger while holding down the Shift key. 

The MIDI editor (and in multi object editing) always shows the current MIDI object and the 
current arranger track from which this object originates. In the field to the right you should 
see the activated VST plug-in for this track. 

 

New MIDI events will always be inserted into the current object (i.e. the currently displayed 
object). In Score mode the current note line is observed.  

If you click on the arrow next to the object/ track display, you will see all MIDI objects/MIDI 
tracks in MO Editing mode listed beneath one another. Here the current object or current 
track has a tick. 

When selecting notes or MIDI events or when clicking using the pen tool the associated 
object becomes the active object. The current Note line will be automatically converted in 
the Note editor. 

You can also copy and insert MIDI notes between multiple objects. 

The Current object area can be highlighted using the button behind the object selection 
field. Areas lying outside the current object will be grayed-out and the notes of other 
objects will be paler, but still selectable. 
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A display filter for the current track may be activated while in MO editing mode. Data 
from other tracks are then grayed out. If the option "Hide filtered MIDI data" in the 
"Options" menu is activated, then MIDI events that are not current will be made invisible. 

 

Note: If the note editor is activated at the same time, only the velocity values of the current 
staff will be displayed in the controller editor. 

In representing notes, the note system of the current track will be highlighted using blue 
note lines. 
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Score Editor 
The score editor displays the MIDI data of a MIDI object as notes in real time and also 
offers all MIDI editing options in the note display. If you move or extend MIDI data, these 
changes are immediately reflected in the score. If you insert a new note in the score editor, 
a corresponding "MIDI note on" event is created immediately. 

Each track may contain a maximum of 48 staves. During multi-object editing across 
multiple tracks, the scores from the systems of each track are compiled together. The 
staves of a track may be used as an instrument or instrument group within a score. The 
entire score may be revealed via the multi-object editing feature and by showing all MIDI 
tracks in the score editor simultaneously. A vocal excerpt can be obtained by showing the 
track of the desired instrument only or an instrument group in the score editor. 

 

Open Score Editor 
The score editor is integrated into the MIDI editor window. If the MIDI editor is opened, you 
can activate the linear score view by pressing the "Score editor (linear)" button. 

 
Score editor (linear) button 

 

 

Score Editor Modes 
Samplitude offers two alternatives for viewing the score: linear display and page mode.  

The linear note display may be combined with the matrix display. This offers ideal MIDI 
editing options, since the detail in depth of the matrix editor and overview may be 
supplemented by several score systems. You can select the score in the score sheet and 
perform fine adjustments in the piano roll. Selection and zooms in all editor views (linear 
score, piano roll, event list, velocity editor) are always synchronized. 

 

Note editor modes - Linear view 

 
Score editor (linear) 

In the linear view, not only the Score editor, but also the matrix and velocity display are 
available. For detailed editing of the MIDI data in the score, select the linear view. All 
parameters such as pitch, note length, and velocity are displayed. 
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Please note: Only the notes of the currently active system are displayed in the velocity 
editor if notes and velocity are parallel. The red bar mark indicates the currently active 
system. 

 

The linear height of the range of the note view may also be modified. To do so move the 
line between Score and Matrix editor with the mouse. 

The horizontal section can be set above the scroll bar, parallel to the matrix view of the 
MIDI notes. 

In "Linear" mode, details may no longer be displayed correctly if you zoom out horizontally, 
since the note symbols overlap. It may be necessary to reduce the notation symbol size 
with the "-" button on the right side. Despite these details being displayed incorrectly, 
zooming out can still provide you with a good overview, particularly for large scores. 
Samplitude can adjust the notation symbol sizes automatically at the selected section. To 
do this, please select "Automatic zoom" in the "Score" menu. 

 

Score editor modes - page view 
The side mode displays the notes just like on a musical score, which also serves as a print 
preview. This enables you to arrange or delete notes or voices. The design of the score 
sheet can be used for editing longer passages. The stave break allows you to display 
considerably more bars than with the linear display. 

 

Score editor - Page view 

Scrolling in full view mode: Use the vertical scroll bar to scroll from page to page. 
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Page mode as print preview: You should first change the page format (in the Score 
Properties dialog) to the paper format of your printer before setting up the page for printing 
as the display depends on the page format. You will then see your score exactly as it will 
be printed. 

 
 

Score sheet 
The automatic conversion of MIDI data into score material is usually sufficient for editing 
MIDI data; in this case, efficiency is required instead of a perfect, ready-to-print display. 
However, it may still be necessary to adjust some of the display options for the musical 
material during editing. These display options are provided in the "MIDI score properties" 
dialog, which you can open by clicking the corresponding button. 

 
Score settings: Open the score settings dialog for notation system and 
page properties 

Presets are also located here. These are preprogrammed standard settings for certain 
instruments or instrumentation such as strings, piano, or orchestra. Selecting a preset 
changes the score display and its legibility: 

 

Before 

 

After the selection of the "Piano" preset 

Further explanations of the notation system (view page 291) are provided below. 
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Editing MIDI data in the score sheet 
Select notes 
As usual, you can select notes by clicking them. A group of notes (a chord) may be 
selected by dragging a frame over the notes with the mouse button. Select multiple single 
notes by pressing the "Ctrl" key. 

 

Note parameters 
Parameter pitch, velocity, and length can be changed for one or several selected notes. If 
one or several notes are selected, the data for the current note will appear in the info bar 
above the score view. Changing a parameter may have a comparable effect on all selected 
notes, just like in the matrix editor. 

Note: In "Page" mode, notes may not be drawn with the pencil or moved or copied with 
the mouse. Use the corresponding menu commands and keyboard shortcuts. This 
limitation does not apply in linear display mode. 

 

Move and transpose 
To move notes, first select them, and then drag them to the desired position. The infobox 
can help you keep track of the pitch or position. The step size when moving is determined 
by the selected quantization raster in the MIDI editor. 

 

Copy 
Select the desired notes and copy them by holding down the "Ctrl" key and dragging the 
mouse. Alternatively, you can also use the copy function in the "Edit" menu. 

 

Insert new notes 
You can also insert new notes in the score editor with the pen. Click the desired position 
with the pen, hold down the mouse key and correct the position and pitch as required. If 
you let go of the mouse key, Samplitude will add a new note featuring the same length as 
the selected length quantization value.  

You may only insert new notes into the active stave. For instance, to insert a note in the 
lower part of a piano system, click the lower staff in the system on the left first. Only notes 
that correspond to the current pitch are inserted. Non-scaled notes or chromatic 
intermediate steps are skipped. If you enter conventional music material with the mouse, 
diatonic insert mode increases the chances of hitting the correct note. If a new prefix is 
going to be added to the note, you can move the note chromatically with the arrow keys. 
This way, an inserted F in C Major may be transformed into an F# by pressing the "Page 
up" key.  

 

Delete notes 
Delete notes by 

 selecting them and pressing the "Del" key or 
 clicking the eraser tool or 
 by clicking them with the right mouse button 
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The menu command "Score -> Selected notes: hide/show in score" enables the selected 
notes to be removed from the score, without influencing MIDI playback. Notes hidden in 
the scale are indicated in the matrix by a diagonal line. This function is practical for making 
trills easier to manipulated, or in order to to remove "control notes" from the score when 
switching between playing styles. 

 

Insert notation symbols 
Clef symbols may be inserted at the current cursor position by pressing the corresponding 
clef symbol button in the active system.  

 

Delete notation symbol 
Manually added notation symbols such as clefs and signatures may not be selected, since 
these are meta information for the notation display and no MIDI events have been assigned 
to them. Nevertheless, these may be deleted by clicking them with the eraser (or the right 
mouse button). 

 

Adjusting and optimizing the score 
Samplitude automatically generates a notation display from the MIDI events contained in 
the MIDI object. This is always correct with regard to pitch and position. However, this 
does not mean that the notation can be optimally read, since displaying note lengths also 
plays an important role in this context. In this case, the notation allows flexible 
interpretation, so the user usually has to intervene. This is a negative example of a poorly 
readable translation of a piano passage in notation:  

 

Automatic notation with unsuitable display settings... 

This representation may be correct; however, it is illegible and somewhat confusing. Why is 
that? The MIDI events contain very precise information about the start of a note and its 
length and pitch, which has to be taken into account during playback. It may influence the 
groove of a song if the notes are always slightly shorter than sixteenth notes. If this were to 
be displayed correctly in the notation, the score would be unreadable as in the example 
above. The MIDI events also do not contain information on whether the gap between two 
notes is a real pause, its harmonic correlations (pitch), and the characteristics of the 
dynamic sequences.  
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This is why automatic processing of notation always differs from what would be ideal. 
Samplitude includes a number of automatically and manually controllable functions for 
making it easier to read the notation.The reworked version of the above score excerpt 
illustration shows how big the difference can be: 

 

…and editing is finished. 

 

Note allocation in multiple systems 
The term "System" refers to an individual line in a staff as well as all staves of a score. In 
cases where it is important to be able to differentiate a score and a note line from one 
another, we use the term "System" for the score and "Staff" for a single system. 

Mostly, what is meant by "system" is the result of the context. For example, a two-handed 
piano piece makes reference to the "upper" and "lower" systems. 

Samplitude provides multiple systems, e.g. for piano notation or entire scores that are 
comprised of up to 48 individual systems per track.  

To assign notes manually to a system, click the "Assign to upper system" button 

, 

to move the selected notes one line higher on a staff, and correspondingly on "Assign to 
lower system" 

, 

to move the selected notes a line lower. This results in the note being connected to the line 
(independently of the MIDI channel or pitch). This manually set allocation can be undone by 
clicking on  

 Assign notes automatically 

 

to ungroup them. 

Note: You can only move notes within the staff of the corresponding track during "Multi-
object editing". 
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When transcribing a MIDI piano recording, splitting the notes into a two-line piano system 
using the split point is recommended. This indicates that notes above the split point pitch 
belong in the upper system and that the other notes belong below it. The positions where 
individual notes are placed incorrectly can be easily corrected by assigning the notes 
manually by clicking the desired system. 

Automatic assignment of notes to a specific staff is flexible. Either the MIDI channel of the 
note event, the pitch, or even a combination of the two can make up the criteria. This 
permits simpler and faster distribution of MIDI notes in the staff.  

Example: For some standard MIDI files, the notes of a lower system of a particular piano 
piece may have a different MIDI channel than that of the notes of the upper system. 
Assume the notes for the right hand are on channel 1 and the notes for the left hand are on 
channel 2. In this case, set up two staves for the system in the note system settings. The 
easiest way to do this is with the "Piano" preset. For the first staff, set the MIDI channel 
allocation to "Ch. 1" in the "Channel" selection box and "Ch. 2" for the second staff (see 
MIDI score settings dialog (view page 290)). 

The rules for allocation are as follows: 

If the "Automatic system allocation" option (preset) is set for the note, the note lines will be 
played until the MIDI channel corresponds with it and the pitch is over or equal to the split 
point.  

Note: Some notes may not show at all; that's because they haven't been assigned to a 
system yet. 
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Multi-voice notation 
Up to two independent voices may be annotated for each staff. The voices differ in the 
direction of the note stems: the first voice is always with the stem pointing upwards, the 
second with the stem pointing downwards. Pauses are displayed individually for each 
voice. 

Multi-voice notation can simplify the score considerably and enable multiple instruments or 
parts to be displayed in one staff together. 

 

Mono-voice display 

 

Multi-voice display 

You can set the voice by selecting the notes and clicking: 

 

"1. Assign voice (stem direction up)" 

and 

 

"2. Assign voice (stem direction down)"  

. This sets the stem direction of the notes and therefore the voice assignment itself. 

The set voice assignment can be ungrouped again by selecting  

 automatic voice assignment 

to ungroup them. 

Tip: You'll find the corresponding commands in the MIDI "Score" menu;  keyboard 
shortcuts may also be assigned to these. 
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For automatic voice allocation, the note's MIDI channel has to be analyzed. 

To do this, set up a MIDI channel for the second voice in the "Note system properties" 
dialog. This can be set individually for each staff. All notes of a system featuring a MIDI 
channel that has not been assigned to a second voice are added to the first voice. 

Voice allocation via the MIDI channel can be practical for displaying standard MIDI files with 
multi-voice piano pieces, e.g. if the right hand voices are set to the first and second MIDI 
channels and the left hand voices are set to MIDI channels three and four. Apply the 
following settings: 

 

Note: If there is no MIDI channel selected for voice allocation, only one voice will be 
annotated (if manual voice allocation does not occur). 
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MIDI score settings 

 The score settings dialog opens the notation system and 
page format properties. 

Apply the note system and page format settings here. None of the settings have any 
influence on the MIDI data itself, but rather only on the display of the score. 

 

Note: The affected note system settings are always applied to all MIDI objects situated on 
the current track. The page format settings apply to the entire VIP project. 

 

Note system settings 
All templates for the system, the display parameters, and options are available on this 
dialog page. Specify the key, clef, and much more here.  

Samplitude provides up to 48 staves on one track for MIDI data. Key, clef, display 
transposition (for transposing instruments like saxophone, etc.), and display quantization 
may be individually set for each staff. 

An instrument's prefix ("Name") may also be set, plus the MIDI channel for automatic 
system/voice assignment.  

Similarly, the split point provides automatic system allocation. Notes above the split point 
are added to the upper system, while those under the split point are added to the system 
beneath it (as long as the MIDI channel matches).  

The active staff is recognizable via the index marked in red. The list of 16 staves can be 
scrolled vertically using the arrow buttons (up/down). The active staff's display options are 
displayed in the lower range. 
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Optionally, all changes to settings, display options, key, and display quantization are always 
transferred equally to all staves. 

During multi-object editing across multiple tracks, the scores from the systems of each 
individual track are compiled together. A partial system of a track can be composed of 
multiple staves (e.g. 2 lines for a "grand staff" in piano notation). The system lines within a 
track will be grouped with struck-through beat lines.  

The staves of a track may be used as an instrument or instrument group within a score. For 
this reason, consider early on how you would like to distribute multi-voiced pieces to 
multiple MIDI tracks to obtain a sensible score display. The entire score may be obtained 
by using the multi-object editing feature and showing all MIDI tracks in the score editor 
simultaneously. A vocal extract may be produced by showing the track of the desired 
instrument only or an instrument group in the score editor. 

 

Display quantization 
Using the display quantization ("Quant." column), you can set the rhythmic resolution of the 
note display independent of the actual quantization. This enables you to display a freely 
imported and unquantized track in sixteenth notes. 

 Set "Quant." to the lowest value in the sequence of the note value. For a sequence that 
contains sixteenth notes as the lowest value, select the setting "16th", not "64th" notes. A 
quantization display that is too fine may make the display illegible.  

The display quantization does not have any influence on note playback, but rather adapts 
the note display to a raster. The actual recording (the MIDI files) is not changed, unlike the 
quantization function in the MIDI editor. 
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Interpretation options 

 

None of the options have any influence on the MIDI files or playback. An adjustment only 
occurs with regard to the note display. 

simplify note lengths (interpretation) 

Displays pauses and slurred notes in such a way that the score is as legible as possible 
without influencing playback. 

 

Display without active interpretation options. Display quantization is set to one sixteenth. 

 

Display with option "simplify note lengths (interpretation)". 

hide note overlaps 

With this option you can get rid of overlapping of sequential notes which, for example, 
arises as a result of playing legato: 
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Original 

 

Display with "hide note overlaps" option 

automatic staccato articulations 

A staccato symbol is added to a note whose value is considerably longer than the 
displayed MIDI note. 

 

Display with additional option "automatic staccato articulations" 

recognize triplets 

Activate this option if triplets are present in the MIDI object.  

Note: The display quantization value always has to be one step finer than the smallest 
discernible triplet value. For example, to recognize one eighth triplets, display quantization 
has to be set to at least one sixteenth (or to 1/64 for 1/32 triplets). 

strict measure beat/pulse division 

This option ensures that there are no note or pause values longer than a beat subgroup 
(pulse). Longer notes are displayed as multiple slurred notes as the case may be. This can 
simplify the legibility of the score. 

larger beam groups  

Beam groups are partially compiled across beat subgroups. This can also simplify the 
legibility of the score. 

recognize grace notes  

Note values which are much shorter than the display quantization value are annotated as 
grace notes as long as a base note is present. 
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Original 

 

Display with "Automatically recognize grace notes" option 

force polyphonic notation 

The display of the notation always appears multi-voiced. 

 

Notation symbol 
Clef 

 

There are four clefs available in Samplitude: violin, bass, tenor, and alto clef. Samplitude 
differentiates between base clef and clef change. The base clef may be set up for every 
system in "Score settings" (and applies to all MIDI objects on the current track). A clef that 
you enter via the toolbar will be interpreted as a key change. Key changes are possible any 
number of times in a song and also within beats. 

To add a clef, activate the staff where the key should be inserted by clicking the staff 
signature to the left. 

Position the play cursor at the desired insert location and click the clef you want in the 
toolbar. The clef will be entered musically rather than graphically. 

Example: For a key change at position 10:01:000 (the beginning of bar ten), the clef 
symbol will be displayed at the end of bar nine just as it corresponds with the notation 
rules. 

Key changes may also be deleted by clicking the clef symbol with the eraser (or the right 
mouse button). 

 

Beat signature 
The metric and beat signature symbols are created automatically from the tempo markers 
of the VIP project. 

Time signature changes are possible at full beat borders. Create a beat counter marker 
with the new signature (e. g. 6/8) at the desired position via "Edit > Tempo -> Tempo/Beat 
marker (view page 301)". If there are no beat count measure changes, setting the time 
signature of the piece (e. g. 3/4) in the transport control is sufficient. 
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Prefix 

 Enharmonic change 

Samplitude sets the sharps and flats according to the clef selected. It is often the case, 
however, that enharmonic changes can considerably optimize the legibility of certain 
passages. In this case, you can work manually. To change one or more selected notes 
enharmonically, click the corresponding button. The function transforms flats into sharps 
and vice versa. 

 

Page format settings 
Page format settings may be accessed via "Score -> Score settings" in the MIDI menu. 
Click the "Page format settings" button.  

You may select the paper format independent of the printer settings so that it always has 
the same note layout, regardless of where you are working and independent of the printers 
installed in Windows. 

 

Samplitude automatically creates the layout of the score for optimal division of staves and 
systems on the page. You only need to specify the page size, orientation, and page 
borders. 

Scale score size (%): Scales the size of the note symbols for the printout. However, the 
score display influences the position where a line or page break occurs. 

 Set a value smaller than 100% to fit more beats/systems onto one piece of paper. 
 Set higher values than 100% to keep larger note symbols on the printout. 
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You can also make entries for tempo notation, composer, and an extra text field. Similarly, 
you can choose which layout elements should appear on the page (check boxes for beat 
numbers, page numbers, and texts). 

 

Print notes 
Activate the print process in the "Score -> Print score" menu or via the "Print" button. The 
print dialog window will appear which has been adjusted to your printer or printer drivers. 
Depending on the printer, there are various options like the selection of pages you wish to 
print and the number of copies. Make sure to set up the same paper format for the printer 
as for the page mode, otherwise the printout may be scaled and the page ratio changed. 

The following items won't be printed; they are only visible on the monitor: 

 The lines which highlight the page borders on the monitor 
 Mouse pointer 
 The color display of the currently selected notes and playback areas. 

Note: When printing a file (e.g. as a PDF file with a special printer driver), note that you 
have to activate the option "Save fonts in document" in the printer driver so that the 
notation symbols will be displayed correctly in the document. 

 

Score editor – tips 
In complex arrangements, we recommend using two separate versions of a song for 
sequencing and for note print previews. This way, MIDI events for the note display may be 
changed in any way without influencing the playback. You may have to increase or 
decrease the length of a note in order to display the correct note value or the correct 
pause.  

It may also be advantageous to remove trills, grace notes, and other ornaments in order to 
be able to print the score in a more simplified form. This manipulations, however, do affect 
playback. Compromises are not necessary when working with separate versions for 
sequencing and note print preview. 

 

Score music XML export 
The score may also be exported as a MusicXML file and then edited further in notation 
applications. Finale, Sibelius, Forte, plus many other MusicXML files can import music XML 
files. Converters are also available for transforming MusicXMLs into other formats. You can 
find out more at www.musicxml.org. 
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During the MusicXML export, all properties of the score (except for the page layout), like 
staves, notes and pauses, bar groups, keys, polyphonic voices, lead signs, enharmonic 
change, etc. are transferred. However, page layout, line breaks, and the distance between 
systems are not transferred. These may also be a component of MusicXML, but since 
these parameters in Samplitude may only be partially edited, they will be removed from 
MusicXML export. 

 

Not every staff editing application processes all MusicXML elements correctly, so it may 
become necessary to manually correct struck-through bar lines later, or to regroup 
brackets for "parts". 

If you create your composition in Samplitude, set score settings here in order to be able to 
edit and navigate more easily through the score view. You may then continue editing the 
score in order to optimize the layout and notation. 

Converting to MusicXML format has the advantage (unlike standard MIDI file format) that 
many manual settings and optimizations of the score (e.g. number of scores, key, voice 
allocation, pitch, etc.) remain the same. 

 

MIDI editor shortcut keys 
Apart from few exceptions such as "Space" for stop and playback, the keyboard shortcuts 
can be defined freely. Open the keyboard shortcut menu and mouse editor via the 
"Shortcuts -> Define shortcuts" in the MIDI menu. For some basic functions such as 
scrolling and zooming, all keyboard shortcuts from the VIP are used. You can define 
explicit shortcuts for all commands that are available in the MIDI editor menu. 

Note: The mouse wheel settings from the arranger are also assumed, as is the switch for 
temporary zoom mode (special) which is preset as "Z". 
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Play/stop Spacebar 
Close MIDI editor (discard changes) Esc 
 
File 

Import MIDI Ctrl + I  
Export MIDI Ctrl + E 
 
Edit 

Undo Ctrl + Z 
Redo Ctrl + Y 
Cut Ctrl + X 
Copy Ctrl + C  
Insert Ctrl + V 
Duplicate Ctrl + D 
Select all Ctrl + A 
Create pattern from selection Ctrl + P 
Delete selected MIDI data Back, delete 
Delete all MIDI data Ctrl + Back, Ctrl + 

Del 
Select next event Right arrow 
Select previous event Left arrow 
 
MIDI functions 

Legato Ctrl + L 
Quantize notes Ctrl + Q 
 
Options 

Scroll mode F 
Show event list Alt + L 
Show velocity/controller editor Alt + V 
Play clicked notes Alt + P 
Quantization grid active Ctrl + G 
Show quantization grid Alt + G 
Quantization options Alt + Q 
MIDI object editor Ctrl + O 
Audition panic-end played edit notes Ctrl + F 
 
Mouse mode 

Selection 1 
Draw 2 
Drum (draw) 3 
Pattern (draw) 4 
Velocity change 5 
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Delete mode 6 
Magnifying glass 7 
Combine notes mode 8 
Split notes mode 9 
Mute notes mode M 
Select next event Right arrow 
Select previous event Left arrow 
Event pitch up Up arrow 
Event pitch down Arrow down 
Select next grid quantization value Alt + Arrow down 
Select previous grid quantization value Alt + Arrow up 
Select next length quantization value Alt + Arrow right 
Select previous length quantization value Alt + Arrow left 
Move play cursor forward Page down 
Move play cursor forward (fast) Ctrl + Page down 
Move play cursor back Page up 
Move play cursor back (fast) Ctrl + Page up 
Velocity controller combi-tool Ctrl + 1 
Draw velocity/controller freehand Ctrl + 2 
Draw velocity/controller lines Ctrl + 3 
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Tempo Editing 
Tempo and Time signature changes in the tempo map... 
Tempo and Time signature changes are an important means of expression of your 
music. You can make these changes in Samplitude by using extensive options. 

A precise beat grid is essential for precise editing. Samplitude offers you a convenient 
option for adjusting the beat grid to existing material (audio/video/MIDI). 

Changes in tempo can be made using the marker or graphically using aTempo track. A 
tempo track contains the project's tempo map as an automation curve.In principle 
each automation point of the curve corresponds to a tempo marker.  

The tempo map displays all the tempo markers and determines the musical positioning 
for each time position. Put simply, the tempo map defines the beat grid. 

You can adjust the beat grid to certain time positions by using grid position markers 
(e. g. existing audio or MIDI events). To do so, just drag a grid line of the beat grid to the 
desired time position.  

It is even possible to tap the beat or entire bar positions. In this case, use the "Grid Fit 
Mode" of the tempo map. 

Besides the tempo map dialog (view page 308), the transport console also serves as 
optical control of the tempo map and tempo track The transport console displays the 
current values for tempo (BPM) and beat type at the current play cursor position. 

In the Tempo-Map dialog (view page 308) you can specify which objects or markers in 
your position should be adjusted when tempo changes are made. 
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BPM marker, Tempo curve (>) and beat change (3/8) - under the tempo track. 

 

Tempo markers 
Tempo markers appear either as BPM markers or as Grid position markers according to 
the Tempo-map mode. Time signature marker (e. g. 3/4) are by contrast, independent 
from the Tempo Map mode. 

In total there are three types of tempo marker: 

 Time signature marker (blue) 
 BPM marker (red) 
 Grid marker positions (green) 

A time signature marker represent a time signature changes (e. g. from 4/4 to 6/8). 

You can also change the time signature when creating BPM markers and grid markers. Set 
the Tempo marker directly using the menu or indirectly by manipulating the tempo in the 
tempo track with the mouse. 

Another way of accessing and editing the Tempo marker is by using the Marker Manager 
(view page 147). 
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Tempo Map Modes: BPM Mode / Grid Fit Mode 
In the Tempo Map dialog (view page 308) you can choose between two modes:BPM 
mode and Snap adjustment mode. The selection can be accessed from the menu: 

Play/Rec > Marker > Insert Tempo change 

Play/Rec > Marker > Insert grid marker change 

 In Snap mode you work exclusively with grid position markers and Time signature 
changes. 

 In BPM mode you work exclusively with BPM markers and Time signature changes.  

 

Modes can be changed at any point. The Tempo markers remain the same, but change 
their type. The effective Tempo map and beat grid remain unchanged. You can toggle 
between BPM markers and grid position markers at any time. 

Example 1: Initially in the beat adjustment mode the beat grid is adjusted to a MIDI 
recording which contains lots of tempo changes. Subsequently certain musical tempo 
changes such as Rubato and Ritardando can be inserted for individual sections in BPM 
mode. (The tempo track can only be edited in BPM mode, in snap mode it serves solely as 
a display). 

 

Example 2: The time signature of available grid position markers should be changed at the 
start of the piece, subsequently however the beat grid positions should be placed more 
precisely. As changing the time signature moves the beat borders and with it the grid 
position markers, change the markers to BPM markers because this will unaffected by time 
signature changes. This is how you swap to BPM mode. Now change the time signature 
and the go back to the beat adjustment mode in order to adopt the beat grid changes. 
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Tempo Change: BPM Marker 
A new project first has a single "Master" tempo which can be defined in the transport 
console or in the project settings (shortcut: "I"). 

This Master tempo affects either the entire project or the start of the project up to the first 
BPM marker.  

Exception: If the tempo should be interpolated to the first tempo marker, the master 
tempo is only effective directly at the project start, to then go linearly to the tempo of the 
next BPM marker. 

You can make any tempo changes directly in the project window at any time or for any 
musical position (even between beats) using the BPM marker or corresponding tempo 
curve point. 

The tempo markers are snapped to the next snap point when the grid is active. By 
dragging the tempo markers and holding down "Alt", you temporarily deactivate the grid 
function. 

Note: Samplitude does not automatically adjust audio objects via tempo markers in case of 
tempo change. In order to change the length of audio objects to the defined tempo 
changes, use the pitchshift/timestretch mode and drag them to the end of the rear object 
edge of the audio object until this matches the original beat marking. 
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Time Signature Marker 
Beat counter markers change the time signature from the marker position onwards, e. g. 
4/4 beat to 3/4. 

Therefore you can only insert time signature marker at bar borders and only position them 
at full beat borders. 

 

Grid Position Marker 
Grid position markers assign a specific musical position to a specific time position. If you 
move a grid position marker, you'll see how the beat grid is immediately adjusted. In the 
tempo track you can apply the effects of the beat grid changes to the tempo. 

A grid position marker defines the tempo indirectly, causing the tempo before the marker to 
be adjusted in such a way as to reach the desired musical position exactly at the marker 
position. 

 

Grid Tapping 
You can set grid position markers in the tempo map grid adjustment mode during 
playback. To do so, assign the menu command "Insert Grid Position Marker" a 
keyboard shortcut of your choice, e. g. "P". Press "P" in time with the rhythm during 
playback and tap the beat grid or tempo map.  

The following will happen: when you press the key, the nearest bar position of the selected 
beat grid will move to the current playback position and it will be marked with a grid 
position marker. 

Tips:  

To detect the tempo, work in the bar grid, in entire bar borders first. In a second step in, 
you can detect slight tempo variations in the bar grid. 

The BPM mode exceptionally allows you to set a temporary bar position marker while 
dragging with the mouse and the "Alt" key held down in timestretch mouse mode (or when 
loading older VIP projects). 

The new command Menu Edit > Tempo > Create click track creates an audio track, 
which contains all metronome click as objects. 
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Tempo Track 
The Tempo map is also available as an Automation curve "tempo" and can be graphically 
edited. 

  

Note: Only one track can be used as a tempo track. The track that serves as a tempo 
track is freely selectable.  

Changes to tempo markers or in the tempo track are automatically transferred. 

The Tempo automation behaves differently to typical automation curves. Automation points 
are coupled with evenly increasing/decreasing tempo changes and the pencil of the 
automation drawing mode doesn't create any new automation points as you drag, only 
when you click. 

Note: In the tempo track the beat grid is constantly active (independent of the system 
option "Program > General > Snap also applies to curve automation points"). As usual the 
snap can be temporarily disabled using the "Alt" key. 



 

T E M P O  E DI T I N G  3 0 7   

 

Edit in the Tempo Track (only BPM Mode) 
Insert tempo changes 

 Double click on the tempo curve in Universal mouse mode: 
 In the Curve edit mode: click (and drag) on tempo curve. 
 Click in the Automation draw mode:. 
 Ctrl key: creates a Ritardando or Accelerando. A special BPM marker with tempo 

curves will be created before the tempo marker position ("Pre-BPM"), and, after the 
tempo marker a previous/new tempo will be used. The pre BPM value can be set with 
Ctrl + dragging. 

 Shift: Creates a new tempo marker with tempo curve at the previous tempo marker. 

Change existing curve points 

 BPM. value and positions can be changed by clicking and dragging curve points. For 
tempo levels: there are always two curve point for one tempo marker, one for position 
and tempo respectively.  

 Alt keys: Temporarily disable snap. Toggle tempo changes and tempo curves as 
necessary. 

 Shift keys: Only change and set BPM values (horizontal lock). 
 Ctrl + Shift + Click: Switches between tempo curve and tempo step. 
 Right click: open "Tempo and time signature" dialog (view page 310), to change values 

numerically. 

 

Tempo Scaling / Change Global Tempo... 
With this menu command all BPM values of the selected tempo curve points can be scaled 
with one adjustable factor. 
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Tempo Map Dialog 
Set the playback cursor to the position at which the tempo or Time signature changes 
should occur. Now open the Tempo window from the Marker Menu (right-click on time bar) 
or from the edit tempo menu. 

 

Click on the "New marker" button in the dialog. A marker is inserted at the current position. 
You can now use the marker option to set the properties of this marker. For a new tempo 
marker, enter the required tempo in BPM or the new beat for the time signature marker. 

Please note that the settings are only valid for the markers currently selected in the marker 
list. For example, you cannot set marker properties such as type or tempo after a new one 
has been created. 

A time signature marker is always placed at the start of a new bar. If the play cursor is at a 
different position, the marker position is automatically moved to the beginning of the next 
bar. 

Edit marker/Tempo map window 
If a tempo marker is changed or a grid position marker is moved, this influences the 
following markers and audio/ MIDI projects in the VIP. 

There are two main possibilities: The time position either remains constant, or the musical 
position remains and the time position is adjusted (Tempo/Time Signature window). 

The time position in the VIP is the absolute position, the musical position is flexible and is 
displayed by the grid.  
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Maintaining the musical grid position means that objects or markers are adapted to the 
newly created grid, its absolute time position in the project therefore changes. If the time 
position is retained the musical position changes accordingly. 

When manipulating the tempo markers, the behavior of markers, audio, and MIDI objects is 
controlled separately. By default, the grid position of MIDI objects and tempo markers 
remains intact, and the time position of markers and objects remains the constant. The 
time position is always observed if you hold the "Alt" key when moving the mouse. 

 

 

In this example the first tempo marker in the second image has been changed. The MIDI 
object and the second tempo marker were moved correspondingly so that the musical 
positions (03:01:00) were maintained. 

If you want to keep the time position of objects, select the "On all appointed tracks" 
option 

Additional options: 
Each tempo and grid position marker can be ignored using the “Bypass” option. This 
occurs automatically for grid position markers if illogical bar positions are created while 
moving, e. g. if grid position markers are exchanged (bar 20 before bar 19) or are moved in 
such a way that these bar positions that originate from a previous tempo marker cannot be 
met by tempo interpolation. 

Ignore All Tempo Markers, use Project Tempo 
With this option you can ignore any previously created tempo markers in your project, so 
that only the project tempo observed. 
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Tempo and Time Signature Dialog 

 

This dialog appears when you double click on a previously available tempo marker/curve 
point or if a new tempo marker should be set using a menu command. You can enter the 
desired tempo in BPM here (not for grid position markers) and, if needed insert a time 
signature change. Also you can choose here whether the tempo should be interpolated to 
the previous tempo marker (Ritardando or Accelerando). 

 

Manipulating the Tempo Marker in Timestretch Mouse Mode 
The timestretch Mouse Mode simplifies working with tempo markers. Select 
"Pitchshift/Timestretch" mode from the toolbar. 

Create BPM markers by directly clicking the desired playback position and holding 
down "Shift", and you can adapt this tempo by moving the mouse vertically while holding 
down "Shift". You can adapt this tempo by moving the mouse vertically while holding down 
the Shift key. 

You can create grid position markers in "Timestretch" mouse mode by clicking the 
desired playback position and holding down "Alt". 

You can create bar position markers with "Alt" + mouse click, and you can move them 
using "Alt" + horizontal mouse movement, e. g. to manipulate the bar grid and adapt it 
to existing audio events. 

 

Tips, examples of use 
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Tempo markers can be placed when composing in the MIDI Editor. Subsequent MIDI 
Objects and tempo markers retain their musical position (advanced setting). 

The grid can be adjusted to available audio events, e.g. assigning beat numbers to certain 
time positions. You can either use the "Set new grid position marker" menu command to 
create a marker at a position within the project and assign the corresponding bar position, 
or use "Alt" + mouse click on the respective beat grid position and, while holding down the 
mouse button, immediately move it to the required time position (e.g. to the beginning of an 
object). 

If the project includes MIDI data, this is automatically adjusted (preset). The newly created 
tempo grid is used in the MIDI Editor for subsequent editing. 

When working with MIDI files and complex tempo changes, you can switch off the tempo 
map before starting to record the new MIDI data ("Ignore all tempo markers, use project 
tempo"). After the recording has finished you will be able to switch on the tempo map once 
again, which makes the newly recorded MIDI data adjust itself automatically. 
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Software-Instrumente/VST-Plug-Ins/ReWire 
Samplitude provides the option to integrate software instruments according to VSTi 
standards or via ReWire into a VIP, and these may be controlled via the internal MIDI 
functions and editors. 

 Software instruments may be accessed as audio track inputs and as mixer channels. In 
this way, the audio signals of a VST instrument may be edited further with all options 
featured by the mixer, including EQ, effects, and routing.  

VST instruments offer sample-precise timing of MIDI events. The maximum number of 
plug-ins is only limited to processor performance. You can increase the number of applied 
VSTs almost without limit by using the integrated freeze function 

 

Installing VST plug-ins 
Install VST plug-ins according to the manufacturer's instructions. VST instruments and VST 
effects are not entered into the Windows registry, but must be saved in a certain directory. 

Samplitude searches for installed VST instruments in the "VST plug-ins" program subfolder. 
VST instruments may be installed either in this folder or another path may be specified. If a 
VST plug-ins folder is already installed on the system, then please use the existing folder. 
The existing path must be specified in the system settings (shortcut: "Y" key) via "Effects > 
VST/DirectX/ReWire" (multiple paths may be specified). Simply enter one path after the 
other; each path will be scanned. Samplitude will automatically find new plug-ins that have 
been installed if they are present in the specified folders. If you add VST plug-in subfolders 
into the main VST folder (e.g. "Equalizer", "Filters", "Modulation", etc.), then these will be 
displayed as submenus when VST plug-ins are loaded. 

 

The first time the program is launched, a search for existing instruments and plug-ins is 
executed (when the track settings are opened). In this case, not only are all the plug-ins 
imported, but they are also checked for their usability within the program. This search is 
only required once; the next time it is opened, the track settings will be opened 
immediately. 

Tip: If you have problems with your current configuration, then you may reset all paths and 
installed instruments or plug-ins. To do this, delete the "VSTPlug-Ins.ini" file in the 
Samplitude folder. All paths will have to be newly entered. Plug-ins which were removed 
from the program prior to this will still be shown again.  
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Load software instruments 
You can also assign a software instrument to each track; the instrument is selected as a 
MIDI playback device. Selected instruments or their individual outputs are shown directly in 
the first VSTi plug-in/insert slot of the track header and track editor and can also be muted 
(left click) and opened (right click) from there.  

Load an instrument by selecting a "New instrument" in the project window as a track 
output. This can happen at various positions: 

 In the MIDI section of the track editor: "Out" slot -> new instrument 
This is the standard method for loading and routing a software instrument. 

 

 In the audio section of the track editor: "In" slot -> instrument outputs 
 In the playback device context menu, (right click "Mute -> MIDI -> New instrument) 
 Plug-ins slot -> VSTi in the track editor 

 

Software instruments may also be created in the mixer: 

 Insert effect slot of the mixer -> VSTi 
This option is located in the top insert slot of the individual mixer channels. 

Alternatively, you can also install and manage software instruments in the VSTi rack. To do 
so, open the VSTi manager. 

Note: You can load plug-ins In the master section of the mixer, just like in the mixer tracks. 
Click on the arrow to the right beside one of the plug-in slots and select the desired plug-in 
from the menu. 
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Apply plug-ins at wave level 
The menu item "Effects -> Plug-ins" lets you calculate the plug-in effects directly into the 
audio material. During virtual wave editing, the plug-ins will be loaded into the mixer's 
master area. 

Detailed information about destructive editing is available in the chapter "Working in the 
project window -> Samplitude as a wave editor (view page 108)". 

 

Load plug-ins at object level 
Effects plug-ins may be applied at object level or via "Effects -> Plug-ins". 

Effects menu: Note the check is not set for "Apply effects online". Select an audio object 
in the arrangement by clicking it. Next, open the "Effects" menu and select the entry "Plug-
ins". In the dialog, you can load the desired plug-ins for the selected object one after the 
other via the "Add plug-in" button. Right clicking on the loaded plug-in opens its interface. 

Object editor: Double click an object and select the "Object effects" view in the object 
editor. Under "Plug-ins", click the arrow to the right next to the plug-in slots. The plug-ins in 
the menu are available. 

 

Load plug-ins at track level 
At track level, you can load plug-ins in the mixer as well as in the track editor. 

Track editor 

 Select the track where you wish to load the effect.  
 Open up "Plug-ins" if it is not yet visible.  
 Now click on the little arrow next to the plug-in slot. 
 Select any plug-in from the menu. 

Mixer 

 Open the mixer by pressing "M" or via the mixer button.  
 Click the small arrow next to the insert slot for the desired track. 
 Now select a plug-in from the corresponding submenu. 

 

Load plug-ins at master level 
You can load plug-ins in the mixer's master section just like in the mixer tracks. Click the 
arrow to the right beside one of the plug-in slots and select the desired plug-in from the 
menu. 

 

Loading routing settings with software instruments 
An instrument may also be assigned to each track as a MIDI output device. 
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Audio output channels may also be routed from software instruments to any VIP track. 
MIDI (send) and audio (return) signals from a software instrument may be present together 
on one track (but this is not absolutely necessary). Samplitude is fully flexible in terms of 
individual routing configurations. 

When installing a software instrument, the "Routing for multi-channel instruments" 
dialog opens. This is also available via the VSTi manager under "Routing settings". 

 

Note: Press "Extended options" to specify that this dialog is always displayed when 
inserting a new software instrument into a track or when adding a track for individual 
output in the VSTi manager. 

Simple mono or stereo software instruments may be installed completely in the current 
track. In this case, the track sends MIDI to the instrument and receives the audio signal 
from the instrument. Select the "Simple: Audio and MIDI together on the same track" 
configuration. Now all audio signals will be routed to the track that contains the instrument. 
Multiple outputs will be mixed together before the mixer effects. You may specify that only 
the first stereo output is routed to the current track via the advanced options. You may 
specify that only the first stereo output is routed to the current track via the advanced 
options. 

Multi-timbral: Route the audio to a new track separated from the MIDI track 

Several MIDI tracks are typically used for so-called "multi-timbral synthesizers", which may 
play several sounds on different MIDI channels simultaneously, in which case each device 
controls a specific sound program (part) on a specified MIDI channel. You can specify in 
the extended options that only the first stereo output is routed to the current track. 
The audio return track may also be hidden in the arranger. This setting is useful if 
individual outputs of an instrument are controlled by a single MIDI file, which therefore do 
not contain objects or information in the arranger window. 

Multi-channel: Create new tracks for instrument outputs 
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Choose this option to automatically create new tracks for all VSTi audio outputs. The newly 
created tracks are named accordingly. The mono/stereo configuration is assumed from 
Samplitude (default). 

Note: Individual outputs may also be routed to separate tracks. To display hidden tracks in 
the arranger window again, use the track manager. 

Advanced options: 

Stereo/mono (standard): Information delivered from the plug-in is used for routing. 

All as mono: This option forces individual outputs to be treated as mono outputs. 

All as stereo: This option forces individual outputs to be treated as stereo outputs. 

Audio/MIDI combined (tracks also send MIDI): Activate this check box to automatically 
route the MIDI output for each individual track to this instrument. 

Don't show the audio return tracks in the arranger: All newly created output tracks for 
this instrument are hidden in the arranger but still appear in the mixer window. This setting 
should be used if an instrument's individual outputs are controlled by a single MIDI file, and 
therefore do not contain objects or information in the arranger window. 

Note: A virtual synthesizer's audio output may normally be created, edited, and mixed in 
the same track as the MIDI data the instrument is receiving. In some cases, this results in 
duplicate use of the volume fader which, on the one hand, controls velocity or MIDI volume 
(CC7), and on the other, this controls the audio level. These are not identical parameters. 
For instance, you may include a MIDI instrument played with high velocity quietly in the mix 
and vice versa. Therefore, the volume fader may be assigned differently. To do this, right 
click the track's volume fader. 
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VST MIDI out + Audio out recording 
(for "Mixer FX monitoring/Hybrid Engine" only) 

You may record VSTi audio outputs for VSTi return tracks by activating recording in these 
tracks. 

"MIDI out" may be activated for every track VST plug-in or VSTi in the plug-in panel menu. 
This sends and records MIDI data from the VSTi in another track. 

 

By activating the option "VST MIDI out recording" for a track (right click the record 
button), you can record all received VSTi MIDI out data in the corresponding track. Select 
the instrument output of the VSTi to be received. 

 

If MIDI thru (view page 88) is activated, this signal may also be routed to another VSTi/VST-
FX or external MIDI device. By right clicking the "Moni." button in the transport control, 
activate the "Automatic MIDI monitoring (thru) at recording start" function. 

After recording, apply the track freeze function to visualize the waveform of the recorded 
track. If you remove the check mark again in front of the VSTi output with a right click on 
the record button in the track box, the routing connection to the sending VST instrument 
will be removed. 
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Routing VST instruments using the VSTi manager 
There are many flexible methods for signal routing of instruments. 

As described in the previous paragraph, an instrument may be fed from several MIDI 
tracks, and the outputs of an instrument may also be sent to several tracks. 

 

Routing instrument outputs 
Instrument outputs may be easily routed by using the VSTi manager. Simply open the VST 
instrument to view the individual outputs, and then right click the "Output routing" 
column. 

 

Now search for the track to be fed the corresponding individual output. The assigned 
output now appears in the target track's plug-in slot. 

Alternatively, you may also route directly to the track box of the arranger: 

To play the output of an already loaded (or instantiated) instrument on a specific track, 
right click the record button for the track, go to "Instrument outputs", and select the 
instrument output available in the project by placing a check mark. Several instrument 
outputs may be used simultaneously in one track. The outputs of several different 
instruments may even be combined into one track. 

Deactivating the instrument outputs works the same way. Remove the instrument output 
by removing the check in front of the corresponding output in the "Instrument outputs" 
submenu. 

Note that the routing options of the mix engine may also be used. A track containing the 
audio return of any instrument may be routed to any bus, AUX bus, or master. 

 

Routing MIDI instrument inputs 
Nearly all software instruments require MIDI data to be audible. To route the MIDI input to a 
specific track that contains the MIDI data, click the VSTi button in the track editor for the 
corresponding track, and then select the instrument in the "Out" slot that you want to 
activate. Previously loaded instruments are also featured in this list. 

To open a completely new instance of an instrument which works independently of already 
existing instruments within the project, select its name from the "New instrument" 
submenu. Multiple instances of the same VST plug-in are indicated by the number (index) 
in front of the name of the software instrument. 
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Solo playback of VSTi instrument outputs 
To preview solo instrument outputs, switch the track that is receiving the signal from the 
instrument to solo. Even if the MIDI objects, which in effect are responsible for the sound, 
are not present in the track, you will still hear the selected track solo. Samplitude 
automatically recognizes the MIDI track that is sending the signal to the output and allows 
the instrument continue to receive MIDI data from the assigned tracks. 

 

Instruments with multi-channel outputs 
The number of available individual outputs generally depends on the instrument, and this 
may be adjusted via the instrument's settings. Outputs may be available in stereo or mono. 

Here are two examples of typical handling of individual outputs: 

Addressing an instrument on a MIDI channel and 
distributing the sounds across several tracks 
This approach is ideal for drum samplers to address an entire drum set and simultaneously 
mix and edit the drum sounds individually. 

Addressing an instrument on several MIDI channels 
Several MIDI tracks are typically used for so-called "multi-timbral synthesizers", which may 
play several sounds on different MIDI channels simultaneously, in which case each device 
controls a specific sound program (part) on a specified MIDI channel. The advantage of this 
is that these instruments only require one instance of the plug-in for several sounds. Multi-
timbral software instruments often have separate audio outputs. Don't forget to route the 
individual parts to the desired outputs within the VST instrument (panel). 

 

Plug-in panel - graphical interface 
The plug-in dialog (panel), the graphic interface, opens when an instrument is loaded and 
can be opened again later by right clicking on the plug-in slot which displays the 
instrument's name. For instrument plug-ins, you can also open the panel via "Track -> 
VST instrument editor". 
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The graphical interface opens by default. The ReWire client application will open when 
ReWire instruments are selected.  

"Programs" features the presets for the corresponding plug-in. 

Besides "Programs", you will also find "Sidechain input (view page 324)" for those plug-ins 
that feature the "Sidechain" function. 

 

Plug-in parameter dialog 
If the selected plug-in does not have its own interface, the parameter dialog will open. This 
display mode is limited to just a few control elements and can only be opened via the menu 
of the instrument window. In this dialog, eight freely selectable instrument parameters are 
clearly and numerically displayed. Bar control elements may also be used to adjust the 
parameter values. 

 

Once the automation of the selected parameters is activated, the automation curve will be 
displayed in the project track for editing. You can automate parameters during playback via 
the corresponding bar faders. 

The parameter selection is saved for each plug-in so that the next time you use the same 
plug-in, the same parameters are used. This provides the advantage that every frequently 
used parameter of the corresponding instrument is available immediately after it has been 
opened. 
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Plug-in menu functions 
Bypass: Deactivates the instrument and mutes it. Note that some instruments use up 
processing power if "Bypass" is switched on. Remove the instrument if you no longer need 
it. 

Monitoring: This option must be switched on to be able to hear the instrument when it is 
being played (live or recorded). If you want to have have monitoring active when the track's 
REC button is on, select the "Tape monitoring" option in the "System/global audio" options 
dialog. 

MIDI out may be activated for every track VST plug-in or VSTi in the "MIDI out" plug-in 
panel menu. This sends and records MIDI data from the VSTi in another track. 

By activating the option "VST MIDI OUT recording" on a track (right click on the record 
button), you can record all received VSTi MIDI OUT data in the corresponding track. If 
"MIDI thru" is activated, this signal can also be routed to another VSTi/VST-FX or external 
MIDI device. 

Permanent options: These additional settings are valid for all instances of each plug-in.  

Note: We recommend only changing the "Permanent options" in case of compatibility 
problems. After making changes, reload the project. 

Limit to only 1 CPU: All instances of VSTi will be calculated only on one CPU. This 
enables you to avoid a multi-CPU conflict between various instances of the same plug-in. 

If you activate this option for an effect plug-in, all track or object effects on tracks using this 
plug-in will be calculated via a single CPU. As soon as you activate this option for an 
effects plug-in, the entire track and all effects will be calculated via only a single CPU. 

Note: When using UAD cards, this option is activated by default. 

Force calculation by silence input: When processing single tracks as economy tracks via 
the playback engine (view page 28), Samplitude normally doesn't process track signals if 
an audio signal is not present. This reduces the CPU load.  

This plug-in option ensures that the complete track where the plug-in is embedded is 
calculated smoothly, even if there is no audio signal. This is especially useful for delay plug-
ins in economy tracks or when bouncing economy tracks. This option is also 
recommended for all plug-ins that produce audio independently of their input. 

Note: Continuous calculation takes place in the Hybrid Engine, even of empty or silent 
tracks. This function may be deselected in the global performance options by checking the 
option "Deactivation of empty or silent tracks for ASIO".  
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No automatic copying: This option prevents automatic copying of plug-ins when you split 
or copy objects. 

Load/Save patches/banks: Save an instrument's settings and sounds. The standard 
formats for this are: *.fxp for patches or *.fxb for whole banks. Several instruments possess 
their own patch/bank format. Settings are then loaded and saved directly via the 
instrument's interface. 

Set parameters randomly: Use this function to set all parameters of an instrument to a 
random value. For synthesizers, this option can cause surprising results, and it provides 
interesting results for sound design thanks to random generation of new sounds. Note, 
however, that parameters may only be set when they are accessible via the interface. With 
some very complex virtual synthesizers, e.g. modular systems, some parameters may not 
be modifiable using this option. Note that due to the random placement of various 
parameters, very extreme sounds may be generated. This may cause no sound to be 
produced at all or extremely loud volumes and frequency ranges. For this reason, keep an 
eye on the preview volume while experimenting with this function. 

Automate next parameter: The next parameter which you change during playback will be 
recorded via automation. You may also do this by holding "Ctrl + Alt" while clicking and 
changing the parameters with the mouse. 

Learn hardware controller: Activate this function to learn your hardware controller. 

1.  Grab and move the plug-in element that you want to learn  
2.  Move the element on the hardware controller you selected 
 

Note: 

The hardware controller element must have been learned in the hardware controller setup 
beforehand and may not be empty. 

Learned elements permanently modify the internal mode in the hardware controller setup. 
Assignment is also available later for other projects. 

Assignment may be cleared again via the "Restore modes" button beside the internal mode 
in the hardware controller setup 

Detailed information about adding hardware controllers is provided under "Hardware 
controller -> Learn controller for plug-in/mixer elements (view page 372)" 
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Play and monitor instruments live 
Monitoring 
Use the following settings for live monitoring: 

 ASIO driver ("File > Program Preferences > System/Audio > Audio system > Driver 
system") 

 Activate global record monitoring in the transport control ("Moni" button) 
 Activate the track monitoring button (loudspeaker symbol) 
 Software monitoring or Mixer monitoring ("Menu, File > Program preferences > 

System/Audio > System options > Audio system > Monitoring Setup") 

Tip: You can also select this monitoring mode by right clicking "Record monitoring" on the 
transport control. 

Latency: Please note that a system-dependent delay between pressing the key and 
hearing the sound occurs when you play virtual software instruments. This so-called 
latency time is mainly determined by the buffer size set for the ASIO drivers. To play in an 
acceptable manner, we recommend a buffer size of max. 1024 samples. This corresponds 
to 23ms at 44.1kHz. For many users, however, a latency of 3 ms, i. e. 128 samples, is 
optimum. Please note that the CPU load also increases at a lower buffer size. The "live" 
delay only occurs when an instrument is played; playback latency of an already recorded 
MIDI track via an virtual instrument is automatically compensated by Samplitude. 

As software instruments are fully integrated into the audio engine of the program, the 
signals can be routed, mixed and equipped with plug-ins any way you like. There are 
restrictions when recording VST instruments, according to the selected monitoring 
settings. 

Note: For monitoring effects during input, "Track FX monitoring" mode or "Mixer FX 
monitoring/Hybrid Engine" must be activated. 

 

Recording and playing back an instrument 
An instrument is recorded in much the same way as a normal MIDI track. Make sure that 
the MIDI recording is active in the desired track and then press the record button in the 
transport control. The recording begins immediately. 

When playing back already recorded MIDI tracks, track monitoring should be switched 
off. 

To be able to record MIDI data sent by a VST instrument in another track, activate the 
"MIDI out" function in the plug-in panel menu for the respective track VST plug-in or VSTi. 
This sends MIDI data from the VSTi. 

By activating the option "VST MIDI out recording" for a track (right click the record 
button), you can record all received VSTi MIDI out data in the corresponding track. Right 
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click on "REC" in the track editor and set a check next to the corresponding context menu 
item.  

You may record VSTi audio output for VSTi return tracks by activating recording in these 
tracks. 

If "MIDI thru" is activated, this signal can also be routed to another VSTi/VST-FX or external 
MIDI device. 

 

VST instrument preset selection 
If an instrument has presets, these are displayed in the "Program slot" ("Prg") with their 
internal name (if "MIDI" mode is activated). 

 

This dropdown menu can be used to easily "step through" the presets of your instrument. 
These presets may also be selected using the instrument window's "Program" menu. 

If your MIDI input device can send "Program change" commands, you can also directly 
select programs of this instrument. The program slot is automatically updated in the track 
to provide an overview of the program at all times. 

 

Sidechain Input 
At the track and master level of a correspondingly equipped VST/MAGIX plug-in (e. g. am-
munition), as well as in advanced dynamics, you can activate the sidechain and specify one 
or more of the previous tracks as the sidechain input(s). In the tracks or mixer channels 
sought out as side chain signals the track name of the fed track appears in the AUX 
section just above the send level.Internally, a side chain bus (AUX bus) is created.  

Right clicking on the AUX send button selects this as "Side chain send".  

The "Side Chain Solo" function bypasses the corresponding effect and only the input of 
the side chain is played. When closing the plug-in dialog, the "Side chain solo" function is 
reset. 

The command "Sidechain filter" opens a parametric equalizer that may be used to edit 
the sidechain signal. 

Detailed information on the sidechain function can be found in "Effects -> Dynamics -> 
Advanced dynamics -> Dynamic parameters (view page 611)". 
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Freezing VST instruments 
To freeze an instrument, mark the instrument in the VSTi manager, and select the 
"Freeze" option under "Functions". After a short processing time, all MIDI and audio 
objects from the audio return track are replaced by a single 32-bit stereo audio object. 

A frozen instrument will no longer be controlled by the track's MIDI files and can even be 
deactivated, provided that it is not used by other MIDI tracks.  

Select "Unfreeze" in the VSTi manager to change the original MIDI data at a later point. The 
instrument returns to the state in which it was "frozen". 

The "Freeze" function also works with single outputs. You can also freeze these tracks if 
they do not contain MIDI information and do not hold objects. The MIDI data that has been 
routed to the track or to the individual output of the instrument automatically creates an 
audio file that is played instead of the original instrument.  

In order to avoid double playback of the data, manually deactivate the instrument's single 
output in the frozen track. 

Note: To edit freeze data, you cannot use the "Track freeze edit" function only, since there 
is no MIDI data available on this track to be edited. Therefore, "unfreeze" the track and edit 
the send track's MIDI data. You can then refreeze the track. 

 

"Inactive" state for VST instruments and VST effects 
Plug-ins may be completely deactivated to free memory space. When reactivating the 
plug-ins the last state is restored in its entirety. 

If you set VST plug-ins to "Inactive" by pressing "Shift + Alt + Click" in the plug-in slot of 
the corresponding track, these plug-ins are completely removed from RAM. This way, no 
more resources are used in conjunction with the hardware systems like "PowerCore" or 
"UAD". 

 

The instrument on this track will be deactivated and removed from the disk. The "frozen" 
state of the instrument will be indicated using ** symbols on either side of its name. 
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ReWire Client Application 
ReWire-compatible client applications (e.g. Propellerheads Reason) can be integrated into 
Samplitude as synthesizers. 

Activate ReWire functionality in the system options settings ("Y") under "Effects -> 
VST/DirectX/ReWire". Afterwards, installed ReWire applications may be loaded as 
instruments into a MIDI out slot in Samplitude. All ReWire client applications appear as 
individual sections in the selection menu of the track's plug-in slot and are loaded as 
software instruments (VSTi). The client application should always first be started after 
launching Samplitude and closed again before Samplitude is ended. Some client 
applications may be opened automatically by right clicking on their name in the MIDI out 
slot. 

 The ReWire application may be controlled via MIDI, just like a software instrument. You 
can set up the ReWire client's individual output signals according to the multi-channel 
software instruments on multiple tracks. The client application runs, starts, and stops 
synchronously to Samplitude's time position. 

The "classic" MIDI channel for MIDI notes and events is not important, it is replaced by the 
ReWire MIDI bus system. For each track, a MIDI object is able to control a ReWire MIDI 
BUS. This means that all of a MIDI object's events apply to the track for this ReWire bus, 
independent of the channel number the events originally had. Multi-timbral MIDI objects 
(like those created in the MIDI file import) cannot be played correctly with ReWire. However, 
you may access the ReWire client across multiple tracks on various ReWire MIDI buses. 

 ReWire supports up to 4,096 MIDI buses. A ReWire client only registers the MIDI buses 
that are actually available with the host (Samplitude). You can therefore select the bus 
within the track in Samplitude's MIDI channel menu (e.g. the receiving instrument for 
Reason). 

Several ReWire clients may be opened directly via the host. If you start your client 
application manually, this automatically detects the presence of a host application and 
opens in a special client mode. 

Detailed information is available in the section "Mixer -> Effects routing/Plug-ins dialog -> 
VST/DirectX/ReWire setup plug-in buffer (view page 176)". 
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Automation 
Samplitude provides lots of comprehensive automation possibilities at master, track and 
object level. You can enter automation movements on track and master level in realtime or 
draw them manually in the automation track. The created automation data are visible as 
controller movements in the channel or as a curve in the automation track. An unlimited 
number of automation curves are available on each track. The volume automation curve is 
set to +0 dB in the middle of the track. Upper track edge corresponds to +6 dB. 

Select "Automation" from the menu or in the Track Editor by clicking on the appropriate 
button, to determine whether track or object automation should be displayed.  

 

Equally you can select an automation parameter, in the "Automation" menu, or by right 
clicking on the Automation buttons in the Track Editor, which you can control with the 
automation slider in the Track Editor.  

 

Alternatively, you can draw in the curve of the selected parameter using the pen in 
Automation Draw mode. 

 

The following dynamics automation settings are available at track level: volume, panorama, 
surround, AUX sends, EQs, and plug-in control elements and MIDI controllers. 

At object level, you can automate the volume, AUX sends, and VST plug-ins. 

At master level, you can automate the volume, EQs, VST plug-ins, and MIDI controllers. 
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Track automation - Basic procedures 
Step 1: Select the track recording mode for creating automation curves for the individual 
tracks/channels. You can select either "Touch", "Latch", "Overwrite", and "Trim" mode 
for recording. "Overwrite" mode only applies to the last-activated automation curve, and 
"Trim" mode is intended for volume automation. 

2. To automate a plug-in control element, select "Automate next parameter" in the plug-
in menu, and click the desired function button in the plug-in dialog.  

 

The arranger now displays an automation curve for this parameter. 

You can also select the plug-in's parameter to be controlled by right clicking the 
automation display in the Track Editor. 



 

A U T O M A T I O N  3 2 9   

3. To start recording automation, press "Play". Whatever changes you made to the 
selected control element, will be recorded in real time during playback. 

 

You can overwrite, edit and copy the automation data at any time. You can draw fine steps 
in the curve if you hold down "Shift".  

Note: If you want to move curve points which were already created and selected vertically 
only, create a lock against horizontal movement by holding down "Shift". You can now 
move the curve points vertically in 0.01 dB stages. You can deactivate the fine grid by 
simultaneously holding down "Alt" in order to make rough changes. 
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Automation modes 

 

The automation modes define how automation data should be saved or displayed. Set the 
automation mode for each channel/track. By right clicking the automation button in the 
mixer channel, different automation modes may be selected. Clicking this button toggles 
between the last activated mode and "Read" mode. 

 

Off mode 
All automation functions are deactivated in "Off" mode, all previously written automation 
sequences are ignored. 

 
 

Read mode 
All recorded automation parameters are played in "Read" mode. The automation button is 
usually set to this state. 

 

Touch mode 
In "Touch" mode, automation data is only recorded as long as you touch the selected 
control element with the mouse or touch it from your external controller. Automation 
recording is stopped when you release the corresponding key. Once released, the control 
element will move back to the previously recorded position. You can set the fader return 
time in the "MIDI controller automation" dialog in "Settings -> Time constant for user 
entry". The "MIDI controller automation" dialog can be accessed by right clicking the 
automation button in the track editor. 
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Latch mode 
In "Latch" mode, automation files are written starting only from the first touch of the control 
element or the external controller. As soon as the corresponding button is released, the 
automation is written to the last value until playback ends or another mode is switched on. 

 

Overwrite mode 
In "Overwrite" mode, automation data is recorded right away, as soon as playback begins, 
independent of whether the fader is moved or not. Automation is written until playback 
ends or another mode is switched on. This way, you can quickly overwrite a previously 
recorded automation curve. 

This mode is available only for the currently active, selected curve. 

 

Trim mode during playback 
"Trim" mode produces a relative change of values during simultaneous playback for 
existing volume automation.  

Note: For other automation parameters, "Trim" mode during real-time drawing, just like 
"Touch" mode (view page 330). 

In Trim mode you can move pre-existing automation data. The channel's volume fader will 
firstly be set -6dB, regardless of the value of the current automation data. The fader display 
that shows the value relative to the changes (fader value box) will show the output value as 
-0.0 dB.  
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When trimming a range, new automation points will be set at the range's edges. If you 
move the fader for a relative volume adjustment during playback, the relative adjustments 
will be displayed. You can see the current difference to the previously recorded value in the 
fader value box as well as in the tool tip which appears. 

 

If the option "Use snap for automation curve points" (System options -> Program -> 
General) is selected, automation points may be set while moving set values on the grid. 

This mode is useful if you want to maintain the existing automation movements, or increase 
or decrease the overall level.  

In "Trim" mode, automation data is only recorded as long as you touch the selected control 
element with the mouse or touch it from your external controller. As soon as you release 
the button, the automation recording stops. Once released, the control element will move 
back to the previously recorded position.  

You can set the fader return time in the "MIDI controller automation" dialog in "Settings -
> Time constant for user entry". The "MIDI controller automation" dialog can be 
accessed by right clicking the automation button in the track editor. 
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Trim mode with stopped playback 
You can also make relative changes to all volume automation points within a certain area 
when playback has been stopped. 

Select a range for the respective volume events in the track and drag the channel fader in 
"Trim" mode up or down. You can see the level adjustment difference value in the Tooltip 
or Fader box. 

 

Note: You can of course activate any number of automation points for all other Automation 
curves (e. g. EQ, Panorama etc), by clicking whilst holding the Shift key, then change the 
values of the selected Automation points, again by holding Shift. 

 

Apply to all tracks 
The option "Transfer to all tracks" applies the currently selected automation mode to all 
tracks/channels. 

 

Automate existing curves only 
Select the option "Automate existing curves only" to apply the automation data to 
existing automation curves only. This enables you to experiment with parameters that have 
not been recorded yet, without having to write automation for these parameters directly. 
This option should be removed once the new parameters are ready to be committed. 
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Object automation 
At object level, you can automate the volume, AUX sends, and VST plug-in parameters. 

To conduct the object-based automation, first select an object. Next, select "Show object 
automation" from the automation context menu and select an automation parameter in 
the lower section of the context menu. You can select object volume, object AUX sends, or 
any VST plug-ins embedded in the object for automation. 

 

Switch to automation draw mode 

 

and draw the object-based parameter changes directly into the object with the pen tool. 
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Master automation 
Volume, EQs, VST plug-ins, and MIDI controllers may be automated on the master level. 

The master section of the mixer also provides automation buttons for volume automation of 
the stereo sum. 

To make the master track visible in the arranger as well, right click the automation button in 
the master channel. Select the option "Display master track in arranger". The arranger 
will now feature a track outlined in blue and the name "Master". This track can also be 
automated in the arranger. 

The master track may also be made visible via the track manager in the arranger window: 

Open the track manager via the "Manager" button, and place a check next to 
"Arrangement" for the "Master" track name. 

 
 

Automation – context menu 
A number of options are available to open the automation context menu: 

 Access the "Automation" menu item 
 Right click the "Automation" button in the track editor 
 Right click the automation controller in the track editor 
 Right click the "Vol" button in the track box 

The following functions are now available: 

The first entry indicates which parameter has been automated, e.g. "Volume" or "Pan". 
Checking the corresponding entry activates the corresponding automation curve. If an 
element hasn't been automated, then "No effect (track)" appears. 
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Curve generator 
The curve generator will create a volume curve for you that is beat based and pulses 
according to eighth, quarter, half or full notes. You can enter a minimum and maximum 
value or define delay values as an option for the beat-based envelope curve calculation. 

The option "Create..." in the automation context menu opens a selection dialog to define 
the shape of the automation curve more accurately. 

 

Beat-based: This option causes the form of the automation curve to follow the beat in the 
arrangement.  

There are 4 basic patterns available for beat-based automation curves: 2 saw-tooth 
shapes, rectangle, and triangle. These shapes run depending on the beat and control the 
intensity of the activated effect. The left side of the dialog enables the automation curve to 
be set to activate once per eighth, quarter, half, or whole note. 

Options: This opens an additional dialog to control the style and intensity of the influence 
of the beat on the automation curve (see below). 

Scan envelope curve: Allows the volume process to be displayed as an automation curve 
as an alternative to a beat-based automation curve. 

 

First normalize: This function normalizes the level of the audio object before the object is 
scanned to create an automation curve. 
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Create curve points in range only: If this option is selected, curve points will be 
generated only in the area previously defined in the arranger. 

 

Curve generator - options for envelope calculation (beat-based) 
Limitation: Determine the minimum and maximum value of the envelope. Via Delay 
Minimum/Maximum the basic forms can be altered further.  

 

Shift moves the entire curve. This lets you create interesting off-beat effects. 

 

Editing curves 
Edit curve – Create 
Opens the Curve generator (view page 335). 

 

Edit curve – invert 
This command inverts the activated automation curves. 

 

Edit selected curves – thin out 
While recording, the automation events are placed in very short intervals. The command 
"Thin out" reduces the number of curve points. The course of the automation is then 
displayed and reproduced even more accurately. 

 

Edit curve – inactive 
Use this command to deactivate the selected automation curve. The curve remains intact, 
but will be displayed as a dotted line and will no longer affect the corresponding parameter. 

 

Edit curve – curve color 
This command displays a color palette for you to specify the color of the active curve. 

 

Edit curve – copy, paste, delete 
The activate automation curve may also be copied, pasted into other tracks, or deleted. 

If the option "Use snap for automation curve points" (System options -> Program -> 
General) is selected, automation points may be set while moving set values on the grid. 
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Delete all curves 
This command erases all automation curves on each track automation or each object 
automation. 

 

Track automation mode 
Specify the track automation mode here. Detailed information about the automation modes 
is available in the chapter "Automation -> Automation modes (view page 329)". 

 

MIDI controllers 
This launches the MIDI controller automation (view page 338) dialog. 

 

Display automation curves options 
Do not display automation 
With this option, you can deactivate the display of the automation curves for all tracks. 

 

Display track automation (default setting) 
If you select this display option, only the track automation will be displayed. 

 

Display object automation 
If you select this display option, only the object automation will be displayed for all tracks. 

 

Display selected curves only 
Views only the selected curves for the corresponding track. This helps keep an overview if 
several automation curves have been created. 

 

Show unselected curves (not selectable) 
The unselected automation curves are also shaded, but may now be activated with the 
mouse. 

 

Show unselected tracks (selectable) 
The unselected curves are also shaded, but may now be activated with the mouse in 
universal mode/curve editing mode/automations drawing mode. 

The last section of the context menu lists the ranges that automation parameters are 
available for when automating the corresponding track or the corresponding object. 

 

Curve generator 
This menu item opens the curve generator. 
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MIDI controller automation 
Automation/controller 
For each track, you may also draw MIDI controller curves automatically and send them to a 
VST plug-in or MIDI synthesizer over the track's MIDI output device. You can assign a MIDI 
channel to each MIDI controller curve.  

Open the MIDI controller dialog for the corresponding track by opening the context menu 
(right click on the automation display in track editor), and then selecting the "MIDI controller 
automation". 

Shortcut:  Ctrl + Alt + A 

"MIDI controller name" or "Contr. no." selection menus for all available MIDI controllers for 
the selected track. These MIDI controller slots may be set up individually for each track.  

A MIDI controller may be assigned to a free slot in the name field according to the general 
MIDI name specifications (e.g. volume, panorama, or LSB bank charge) or according to its 
number (0-127) in the number list box.  

If you select "MIDI controller (according to general MIDI nomenclature)", you will see the list 
of controllers according to the GM standard in the "MIDI controller name" field selection 
menu. 

For the external C-console program, a pre-defined name list is also available for selection. 

 MIDI controllers (sorted by numbers) 
 MIDI controller (according to general MIDI designation) 
 MIDI controllers for C-console 
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 Active: Switches the controller curve on/off 
 Controller no.: MIDI controller selection 
 Channel: MIDI channel to which the MIDI controller sends values 
 Color: Color selection for each automation curve 

By selecting the option "Record/update MIDI controller curves to this track during 
playback", an automatic recording of selected MIDI controllers curves for this track takes 
place.  

To fill an already occupied automations slot, simply enter another controller name or 
another controller number.  

Delete an automations curve by selecting the topmost (empty) entry in the "MIDI controller 
name" field. 

Settings 
Detailed information on automation curve settings and MIDI controller can be found under 
"Automations/MIDI controller settings (view page 343)". 
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VST plug-in/VST parameters dialog 
All of the parameters that may be automated may also be selected and activated in the 
VST plug-in's parameters dialog. 

This allows automation to be recorded directly via the selected parameter controllers during 
playback. 

You can open the parameter dialog in the plug-in's menu via "Plug-in -> Parameter". 

Detailed information about the VSTi parameter dialog is provided in the chapter 
"Software/VST instruments -> Plug-in parameter dialog (view page 320)". 

 

Recording automation in "Read" mode 
The easiest way to write automation in "Read" mode during playback is via the "Ctrl + 
Alt + switch/controller" shortcut, while working directly in the plug-in/instrument/mixer 
interface. This way allows an automated recording to be made at any time. As long this key 
combination is held down, you may also automate the selected parameters in "Read" 
mode. 

If a mixer/VST control element is clicked with the same key combination "Ctrl + Alt" while 
stopped, a corresponding inactive curve will be created automatically for editing in "Draw" 
mode. 

 

"Draw" mode 
Select "Draw automation curves" mode to draw automation curves for a parameter or a 
MIDI controller. 

 

Drawing track automation 
First, select a control element in the track editor/mixer or VST plug-in using the key 
combination "Ctrl + Alt". 

Draw the automation curve for the selected parameters straight into the selected track 
using the pencil tool.  

To create an automation curve using the pencil tool, draw the corresponding automation 
curve by dragging with the mouse cursor on any position within the track. 
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Drawing object automation 
 Switch to "Object automation" mode in the track editor 
 Right clicking the automation area in the track editor opens a context menu; the lower 

section displays all available object automations. Select the desired automation 
parameter (e.g. AUX Send 3). A dotted, inactive automation curve appears in the object 
(hint: newly created, inactive "AUX send" curves are located on the lower edge of the 
object). 

 Next, draw the automation for the selected parameter in the selected object by holding 
down the mouse button. 

VST parameters are shown in % while drawing; volume and "AUX send" parameters are 
displayed in dB. 

More information about "Automation draw" mode is provided in "Screen elements -> 
Toolbars -> Mouse mode bar -> Automation draw mode (view page 71)" 

 

Edit automation curves 
Besides the normal mouse (create or delete curve point), a special "Curve edit" mode or 
"Object/curve" mode 

 

or "Object/curve" mode 

 

is provided. 

In Curve edit mode, you may directly draw, move, and delete curves with a double click. 
The mouse cursor switches between a hand or moving tool. If the mouse is not directly 
above the curve, you may select an area of automation points using the calculation tool. 

In Object/curve mode, you may also create new points on the curve, move, and delete 
curves with a double click. If you move away from the curve using your mouse, you will 
automatically switch to "Object" mode to move objects and edit the start & end position, 
the fade-in & fade-out phases, and the object volume. 

Detailed information about curve modes can be found in "Screen elements -> Toolbars -> 
Mouse mode bar" 
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Move automation curve with audio/MIDI data 
To move the audio material to a new position on the timeline along with the automation 
curve, the automation curve will have to be connected to the object. This is possible via 
"Link curves to objects" mouse mode. Click this button in the mouse mode toolbar to get 
started. 

 
Objects may now be moved or copied together with your curve points. 

Note: If you only want to move or copy curve points, follow the instructions above and 
simply delete the objects once they have been moved/copied. The curves remain intact. 

To copy the curve points, simply use "Curve edit" mode and drag out a section by moving 
the mouse from right to left over a curve while holding down the mouse button, copy the 
curve points via "Ctrl + C", and then insert them into a different track at the current play 
cursor position via "Ctrl + V". 

 

Automation/MIDI controller settings 
In the "Automation curve" dialog ("Ctrl + Alt + A"), you will find an additional subdialog 
"Settings" for configuring all automation settings. There is a range of "Global settings" that 
affects all tracks equally. 

MIDI resolution: Time constant (in milliseconds) for sending current controller data. When 
starting playback, the controller data is transmitted after this time has elapsed if its value 
changes (within the frame of 7 bit MIDI resolution). During playback, the MIDI controller 
data is retrieved and sent to the respective MIDI device. 

Time for entries by users: As soon as a controller curve is updated (i.e. new controller 
data for this curve is received) previous data (of this curve) is no longer transmitted. If no 
further data is transmitted, Samplitude transfers the original data after this time expires. 

Note: This sets the fader return time for the write automation modes. 

Visual refresh time: The frequency of redrawing can be adjusted using the "VIP refresh 
time" input box. 
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VST automation resolution (samples): Time constant (in milliseconds) for sending current 
controller values: when starting playback, the controller data is transferred after this time 
has lapsed if its value changes (within the frame of 7 bit MIDI resolution). During playback, 
the VST controller values are exported at this rate and sent to the corresponding VST plug-
in. During playback, the VST controller values are retrieved within this time gap and are 
sent to the respective VST plug-in. 

Send MIDI curve data: Activates or deactivates global transmission of MIDI controller 
data. 

Show received data automatically: The curves in the project window can be updated 
automatically. The refresh rate can be adjusted via the "VIP refresh time" window. 

Automatic track allocation of the new MIDI controller 

Set to what extent new MIDI controllers should be automatically allocated to tracks here. 

The following options are available: 

 None 
 Only tracks with "Recording/update MIDI controller" activated 
 All tracks with the same input device 
 Current track + MIDI channel (C-console mono tracks) 
 Current track + MIDI channel (C-console stereo tracks) 

Detailed information about the first tab of the dialog ("Automation/controller") is provided in 
the section "MIDI controller automation (view page 338)" above. 
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Synchronization 
Synchronization is very important to an audio system, since it is necessary to align 
playback and recording speeds of different system components. Synchronization enables 
studio equipment such as tape machines, drum computers, video recorders, or 
sequencers to be linked with different formats like MIDI clock, MIDI timecode, or SMPTE 
timecode so that all of the devices run at precisely the same time. 

Samplitude can be configured to as the master or slave within a synchronization system. 
As a master program, it generates the necessary timing information required for other 
system components; as slave. Samplitude receives the timecode data to follow during 
playback or recording. 

Clock on digital systems 

In case digital signal flows are processed, e.g. via ADAT, SPDIF, or MADI, it is important to 
define a clock reference within the overall system. The clock signal is transferred via 
Blackburst, World Clock, or the digital input, and it may be received by the receiving or 
playback computer. External devices such as converters or mixers may also provide a 
clock reference. For these systems, there can be only one master but several slaves. 

Note: Don't confuse (Word) clock with timecode. The clock signal is only a digital pulse for 
comparison of the timing between the connected devices and to keep the bit rate 
constant. This enables transmission errors to be prevented. Professional digital audio 
devices normally feature a word clock input and are able to generate and receive a clock 
signal. 

Time-related synchronization of projects 

For more complicated configurations, it is usually necessary to connect various audio and 
video systems via absolute time references. This enables them to operate according to the 
behavior of the master, and the timecode information (transport and progress) is 
implemented correspondingly. 

 

Synchronization formats 
The synchronization format features slave device information about the start position, start 
and stop signals and, in extended formats, the precise timing information, which are 
continuously transmitted. 

Samplitude understands and transmits the synchronization formats MIDI clock, MIDI 
timecode (MTC), and SMPTE (Society of Motion Picture and Television Engineers). 
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MIDI Clock 
The MIDI clock acts as a MIDI transmission clock consisting of system messages (F8H), 
and its time reference is not based on hours, minutes, and seconds, but rather on "ticks". 
One "tick" is the 24th part of a quarter note (24 ppqn [pulses per quarter note]) – MIDI 
clock signals are therefore transmitted 24 times per quarter note. Since the MIDI clock is 
based on the tempo as a reference, the number of ticks output depends on the tempo of 
the generating device. The MIDI clock also does not transport any information concerning 
where in the song the listener is located at any particular time. 

Depending on the options the external MIDI devices provide for synchronization, start 
(FAH), stop (FCH), and continue (FBH) signals are also transmitted. These parameters 
ensure that the connected devices start via MIDI, stop at any point in the song, and that 
they may be restarted at the stop position. 

Depending on the device specification, the MIDI clock signal may also transmit the song 
position pointer (SPP). This acts as a beat counter that provides the number of MIDI 
beats that have been played back since the start. SPP is also sent all 6 ticks as system 
exclusive data, which corresponds with a 1/16 note rhythm.  

The song position pointer makes it possible to link the connected devices with a precision 
of 1/16 notes at any position in the song. 

Note: Look at the specifications of your external MIDI devices to learn which 
synchronization parameters are supported. Samplitude is able to process MIDI clock 
(F8H), start (FAH), stop (FCH), continue (FBH), and song position pointer (SPP). 

MIDI clock synchronization is especially useful for synchronizing devices with ticks as a 
time reference with Samplitude, e.g. external samplers or drum computer or if you want to 
link LFOs or arpeggiators of multiple external synthesizers. 

SMPTE Timecode 
SMPTE Timecode is a conventional synchronization standard for linking different audio and 
imaging devices via absolute time reference. Every SMPTE message sends exactly how 
much time has passed since the beginning of the projects. 

The SMPTE Timecode refers to the units hours:minutes:seconds:frames. The concept of 
"frames" originates from the film and video industry, which the SMPTE code was originally 
developed for. The different frame rates specify the resolution in the individual images per 
second, which is common in the film and video industry. 

MIDI Time Code (MTC) 
MIDI Time Code (MTC) is an eight-digit format like SMPTE timecode that integrates an 
absolute timecode (hours, minutes, seconds, and frames) as a synchronization reference. 
MTC is transferred with other MIDI data via the MIDI interface and transmitted as system 
messages or as universal system exclusive messages.  

MIDI Time Code is especially useful for synchronization of multiple sequencers or DAWs.   
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Note: To synchronize devices that output SMPTE Timecode with MTC, the SMPTE Code 
is converted into MIDI Time Code first via an SMPTE to MTC Converter. 

MIDI Machine Control (MMC) 
This is a signal for controlling external controllers that support the MMC format. Samplitude 
may also be remotely controlled via MMC commands from an external controller or mixer. 

You can find out more about this is available under MIDI Machine Control (MMC) (view 
page 351). 

APP (ASIO Positioning Protocol) 
The ASIO Positioning Protocol enables transmission of sample-exact time information from 
a third device that is connected via a digital interface with the sound card. As a component 
of the ASIO driver architecture, digital signal connections (SPDIF, ADAT) or special sound 
card interfaces (LTC, Video Burst In) may also be used to transmit the ASIO Positioning 
Protocol. This enables synchronization with SMPTE or MTC-equivalent timecode, without 
requiring an additional MIDI connection. Samplitude is therefore able to follow the input 
signal of an external source exactly.  

Note: Inform yourself regarding about whether your audio device and the ASIO driver 
support the APP protocol. 
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Synchronization setup dialog 
The settings options for synchronization are available via the synchronization setup dialog. 

Menu: File > Program preferences > Synchronization setup 
Shortcut: Shift + G 

 

This window is for customizing the synchronization according to your requirements. The 
available formats are MIDI clock, MTC, APP, and SMPTE. 

 

MIDI Clock 
MIDI Clock Input 
MC input active: Activate the input for the incoming MIDI clock signal by clicking this 
check box.  

Device: Select the device that should create the MIDI clock signal for synchronization. 

BPM: Define the tempo that the MIDI clock should receive. 

MIDI Clock Output 
MC output active: This check box activates the output for the MIDI clock signal generated 
by Samplitude.  

Device: Select the device that should receive the MIDI clock signal for synchronization. 

BPM: Define the tempo that the MIDI clock should receive. 

VIP BPM: This check box defines the project speed set in Samplitude for the 
synchronization project. 
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MTC (MIDI Timecode) 
MTC Input 
MTC input active: This check box activates the input for the incoming MIDI Timecode 
signal.  

Device: Select the device that should create the MIDI timecode signal for synchronization. 

MTC output 
MTC output active: This check box activates the output for the MIDI timecode signal 
generated by Samplitude.  

Device: Select the device that the MIDI timecode signal should be sent to for 
synchronization. 

 

ASIO positioning protocol (APP) input 
APP Input 
APP input active: This check box activates the input for the incoming APP input signal.  

Preroll time: In order to hinder problems during starting, you can set the preroll time at up 
to 1500 milliseconds. 

APP output 
APP output active:  This check box activates the output for the APP signal generated by 
Samplitude. Please make sure that the APP output from the ASIO hardware is supported. 

 

Information concerning the generation of SMPTE timecodes within Samplitude is presented 
in the menu item "Effects -> SMPTE generator (view page 775)". 

 

No automatic record stop in MTC input mode 
If Samplitude is receiving MTC from an external device and the corresponding track is 
ready to record, Samplitude will begin recording as soon as the external signal is recorded. 
If sending of external synchronization signals stops, Samplitude will end recording and 
enter into playback mode automatically. If timecode is received again, Samplitude will begin 
playback. In any case, if you want Samplitude to record again when receiving MTC, then 
activate this option. 

 

MTC Output also in stop-status 
If you select this option, Samplitude continuously sends the current time position as MTC – 
even in case playback has stopped. 
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Chase lock sync - adapt speed by resampling 
Samplitude supports real chase lock synchronization, i. e. audio playback can be 
controlled by an incoming timecode signal. In this case not only the starting point of audio 
playback is controlled externally, but sync also controls playback speed if "Chase Lock" is 
activated. Samplitude is therefore capable of following analog tape devices or VCRs that 
always feature some slip over longer periods. 

If fluctuations in speed occur, Samplitude can make adjustments in slave mode that ensure 
exact temporal synchronization. This function is called "chase lock". Use chase lock in 
case a device involved in the synchronization cannot be clocked centrally via Blackburst, 
Wordclock, or the digital input and Samplitude is the "slave". This is the case if the 
timecode is located on a track featuring a multitrack machine. 

Active:  Activate chase lock synchronization by clicking this check box.  

Sync Velocity: By entering the Sync Velocity you can influence the speed of the tempo 
adjustment. The greater the sync velocity value, the faster Samplitude will follow master 
device tempo changes; however, this also means that the pitch fluctuation in the audio 
material is greater. The preset value for the sync velocity is 100; experiment with values 
larger than 100 in case the synchronization does not run exactly.  

Note:  Please note that Samplitude will apply resampling to the recording in real time 
according to the timecode fluctuations in case chase lock is active. This causes increased 
CPU load and may result in unwanted changes to the audio material, if this is played later 
with other timecode references.  

If the systems are coupled via a central digital audio clock, then chase lock should not be 
activated. 

When using the hardware pitching feature, chase lock synchronization uses direct access 
to the sample rate of the sound card in 1 Hz steps. This achieves particularly precise 
synchronization without additional CPU load. However, this feature has to be supported 
specially by the sound card. 

Use sample-accurate position:  If this option is active, Samplitude uses the time position 
of the sound card as the clock reference (timer) and not its own internal timer. This ensures 
sample-exact synchronization between the recorded audio material and the sync signal. 
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SMPTE settings 
SMPTE-Offset: Specify an offset to be deducted from the incoming SMPTE time before 
the time is used for synchronization. An offset of 01:00:00:00 (1 hour) therefore allows you 
to synchronize a tape with an SMPTE code that starts at 1 hour. The SMPTE offset 
behaves relative to the project start time (view page 33). 

FX:  This factor allows you to equalize possible irregularities with regard to positioning in 
long samples. Perfect synchronization at the beginning of the sample is nevertheless a 
prerequisite. 

Preroll frames: Enter the number of frames that Samplitude should ignore before 
synchronization begins. This takes into account the fact that analog devices normally 
require a certain amount of time before they reach the correct speed. Samplitude will now 
synchronize at a valid time, since this startup time is able to be skipped according to the 
set preroll frames. 

Type: Select a suitable frame rate, e. g. 24 for video/movies, 25 for PAL video and audio 
synchronization, 29.97 for NTSC video, and 30 for HDTV. 

 

Synchronization - Samplitude as master 
Samplitude supports MIDI Clock, MIDI Timecode, and APP Timecode output as a master. 

Sync output is directly linked to audio playback so that no delays occur between 
Samplitude and external devices, even with long tracks. 

Note regarding linking Samplitude as the master: 

 In this case, use a virtual MIDI router for linking the programs internally.  
 Wherever possible, favor the MIDI Timecode synchronization with MIDI Clock, since this 

does not need to include tempo changes. 
 If Samplitude is running as the master, then set the FX factor to 1.0. 
 For optimal synchronization stability, deactivate the virtual memory (if possible). 
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MIDI Machine Control (MMC) 
MMC modes 
In the project options, you will find a dialog for remote control via MIDI machine control. 
Samplitude supports synchronization of external devices via MMC. The following modes 
are available: 

Receive MMC: If you have set up Samplitude to work as a slave, activate this option. 
Samplitude follows JOG shuttle operations, cursor position, track mute, track solo, track 
input monitoring, track record ready, play, stop, fast forward, rewind, and record 
commands from external devices. 

Send MMC: Samplitude operates as master. When you use commands like cursor 
position, track mute, track solo, track input monitoring, track record ready, play, stop, fast 
forward, rewind, and record, the external device follows. If you also activate the "Receive 
MMC commands" option, Samplitude receives the current playback position of the device 
and displays it as an additional blue cursor on the timeline. 

 

While playing a range in Samplitude, the MMC device stops once the end of the range is 
reached. 

 

Transport window only controls external device 
If you activate this option, the transport control no longer controls playback and record 
directly within the program, but rather the external MMC device. Play, stop, fast forward, 
fast rewind, and rewind no longer have a direct effect on playback in Samplitude. The 
"Record" button starts recording in Samplitude in synchronization with the playback of the 
MMC device. 

Use spacebar to control external devices: If this option is activated, the MMC device's 
start and stop commands are controlled with the spacebar. 

More options 
Input MIDI device: Set the MMC device which Samplitude receives. 

Output MIDI device: Set the MMC device which Samplitude sends to. 
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MMC input ID: Enter the Samplitude MMC input ID here. 

MMC output ID: Enter the input ID of the MMC device to control remotely. 

List of implemented MMC commands 

Supported receive commands 

Full frame  
Locate 44 
Play 02 
Deferred play 03 
Stop 01 
Record pause 08 
Pause 09 
Record 06 
Rewind 05 
FFWD 04 
Shuttle 47 
VARIABLE PLAY 45 
READ location 42 01 
READ record status 42 4D 
READ track record ready 42 4F 
READ track record status 42 4E 
WRITE track record ready 40 4F 
READ motion control tally 42 48 
READ track mute 42 62 
READ track input monitoring 42 53 
WRITE track mute 40 62 
WRITE track input monitoring 40 53 
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MAGIX MMC extension 

F0  7F  <device_id>  06  6F  <…>  F7 

Set marker 6F 01 New auto numbered marker 
Navigate play cursor to 
marker left/right 

6F 02 n n = 00  to left marker 
n = 01  to right marker 

Set all tracks RecRdy on/off 6F 03 n n = 00  off 
n = 01  on 

Set monitoring mode 6F 04 n n = 00  manual monitoring 
n = 01  tape monitoring 

Set input monitoring on/off 6F 05 n n = 00  off 
n = 01  on 

Set sync mode on/off 6F 06 n n = 00  off 
n = 01  on 

Set loop mode on/off 6F 07 n n = 00  off 
n = 01  on 

Set punch mode on/off 6F 08 n n = 00  off 
n = 01  on 

 

Send commands 

Full frame   

Locate 44  
Stop 01 Transport control remote mode 
Play 02 Transport control remote mode 
Rewind 05 Transport control remote mode 
VARIABLE PLAY 45 Transport control remote mode 
 

 

Synchronization applications 
Application 1. Synchronization using an external hardware sequencer. Samplitude is 
the master. 

To synchronize Samplitude with an external hardware sequencer (drum computer, groove 
box, etc.), first select the type of synchronization. As these external devices usually use the 
song's tempo or rhythm-dependent information, they are often synchronized using MIDI 
clock. In this case, impulses are passed on from the master to the slave. These control 
impulses are transmitted for each quarter note. Their number per quarter is always 
identical. The tempo information is always clear, since the impulses do not occur in 
absolute time units but are rhythm-dependent. This secures the tempo synchronization of 
the two units that are to be aligned. Of course the same tempo (more or less) should be set 
to both units from the beginning. The MIDI song position pointer is another important MIDI 
clock synchronization tool which provides information on how may control impulses have 
already been transmitted. You can therefore start at any position of the sequencer. The 
same position of both synchronization units is thereby guaranteed. 
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Important: The value of the MIDI song position pointer is limited to 1024 bars (4/4 beat). 
After this, no further synchronization via MIDI clock is possible; connected slave devices 
simply stop. In this case, connected slave devices remain still. 

1. Make sure that your external hardware sequencer supports synchronization via MIDI 
clock as slave. 

2. Connect MIDI OUT of the master (MIDI OUT on the MIDI interface of the computer 
running Samplitude) to the MIDI IN of the external hardware sequencer.  

3. Set the hardware sequencer to "Slave" mode. If you apply this setting, refer to the 
instruction manual for the respective device. 

You will now notice that the transport control and tempo setting of the hardware sequencer 
are deactivated. It will now receive data from the master, i.e. from Samplitude. 

4. Open the synchronization window in Samplitude and activate the "MIDI clock output -> 
MC output active" option.  

5. Select the MIDI port that connected to the slave device.  

Select the tempo you would like the external hardware sequencer to run at. This does 
not necessarily have to be the tempo of your Samplitude VIP project (VIP BPM), but in 
most cases it is sensible, since the bars in the Samplitude arranger window will correspond 
with the bars of the hardware sequencer.  

6. If you press play in Samplitude, the external device runs in sync with the tempo of your 
VIP project. 

Note: Please also observe that the "Transport window only controls external devices" 
option must be deactivated if the device that is to be controlled cannot process MIDI 
machine control data (MMC), since the transport keys neither control Samplitude nor the 
external sequencer. 

Application 2: MIDI Clock synchronization using an external device. Samplitude is 
the slave. 

In principle, it makes sense to choose a master within a group of devices with the most 
stable timing. In most cases, this would be Samplitude. Of course you can also set 
Samplitude as slave, for example, if the main parts of a production are prepared using an 
external hardware MIDI sequencer and Samplitude is only used as an additional audio 
device, or if the sequencer only permits MIDI Clock synchronization as a master.  

The following should be observed: unlike a MIDI-only device, Samplitude can contain audio 
files which might need adjusting. This is only possible with the "Chase lock sync (time 
alignment by resampling) -> Active" function. If the timing of the master is inaccurate, 
audible pitch fluctuations may occur. 
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Note: This function should only be used if a common word clock is not available  If a 
common word clock is available, synchronization variations will be created. 

1. To synchronize via MIDI clock as slave, connect the MIDI OUT of the external 
device to the MIDI IN of the MIDI port selected in the synchronization setup.  

2. Now select "MC Input active" in "Synchronization/MIDI clock input" and enter the 
tempo of the external sequencer. 

Samplitude is now operating as a slave. Unlike many other hardware sequencers, 
Samplitude does not deactivate the transport keys but “listens” to the incoming master 
commands.  

3. Make sure that the external device is switched to "master synchronization" (many 
devices also call this "Internal sync mode" with "Sync Out" activated).  

4. If you start the external device now, the VIP project in Samplitude starts, too. 

If "Chase lock sync" is active, the fluctuations Samplitude has to compensate are 
displayed in the bottom right arranger window.  

If your external sequencer is set to a different tempo than from Samplitude, this will attempt 
to adjust to the incoming tempo by changing the playback tempo relative to the initial BPM 
after starting the sequencer. However, this can take up to several bars and results in clearly 
audible pitch fluctuations. Make sure from the start that both synchronization units are set 
to the same tempo. 

Application 3: MIDI time code (MTC) synchronization using a second software 
sequencer. Samplitude is master . 

Samplitude can be synchronized with another software sequencer or hard disk recording 
system. MIDI time code synchronization is particularly useful for this. 

The advantage of the synchronization method is that it is independent of a song's BPM 
entries. Rhythm and beat-dependent changes of tempo are therefore no longer a problem 
within a project, since communication now takes place via time values. Division into hours 
is possible according to the SMPTE code: minutes: seconds: frames (format: 00:00:00:00). 
Frames are the smallest SMPTE units. These originate from movie technology and state the 
number of images per second (e.g. 24 frames for film, PAL: 25 frames for video). 

Note: If Samplitude should be synchronized with audio data and not film, then the frame 
rate can be set however you like. It's important that both of the systems to be 
synchronized feature the same sample rate. 

Preparing for synchronization: 

The second software sequencer can be running on the same or on a different machine as 
from Samplitude. If two sequencers are running parallel on one computer, make sure that 
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the audio drivers being used permit simultaneous use of multiple sound card 
outputs. Alternatively, you can also use two different audio interfaces. 

During synchronization via the MIDI interface, note that a MIDI port that is opened by 
the software cannot be used by other applications. To overcome this limitation, two MIDI 
interfaces that have been connected may be used. It's more elegant to use a freeware 
help program like "Hubis Loopback", "Marblesound Maple", or "MIDI Yoke". These 
programs install virtual, open MIDI ports on a PC that may be "connected" freely with the 
corresponding applications. 

MIDI time code (MTC) synchronization using a second software sequencer. 
Samplitude is master: 

1. Start both programs first. 

2. Now connect the MIDI output of the MIDI port used by Samplitude with the MIDI 
input of the system to be synchronized, or patch this virtually using an auxiliary program. 

3. Select the corresponding MIDI port in Samplitude's "MTC output" window and 
activate the MTC output.  

4. On the slave system select the corresponding “slave” or “receive MTC” option. 
This setting is independent of the second program being used. Now, activate the used 
MIDI in-Port.  

5. Ensure that the same frame rate is set for both systems.  

6. Now start playback in Samplitude. The slave system will follow and be in sync with the 
master. 

Important:  Always make sure that the sync start position of the slave system is identical 
with the start position of Samplitude. If SMPTE sync start cannot be set for the other 
sequencer, you can also enter the starting time of the other system in Samplitude in 
"Synchronization -> SMPTE settings -> Offset". 

Application 4: MIDI time code (MTC) synchronization using a second software 
sequencer. Samplitude is slave. 

This method is generally the same as in point 3. However, the master/slave setting has 
to be reversed, i.e. MIDI OUT from the other sequencer to Samplitude's MIDI IN. 
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Media link/video setup 
The integrated video engine allows video objects to be added to the first track. Various 
video files like AVI, DV, MOV, MPEG, MXV may also be loaded. WMV or image files such 
as BMP or JPEG may be loaded into the arranger window via drag & drop or via "File -> 
Load/import -> Load video file". 

 

Please ensure that the video files included in a project are identical in terms of dimension, 
aspect ratio, and frame rate. If possible, use only videos that work only with keyframes and 
without interframes (DiVX or MPEG are not very suitable). 

The video soundtrack is loaded into the project, MPEG-2 sound is then converted into 
WAV format. 

Move or cut video objects just like all other objects, but no fades will be used. It is possible 
to edit a video using source/destination cut commands. 

When working with many single bitmap files, it is good to keep in mind that these will be 
loaded completely into RAM and not successively read from the hard disk. 

Right clicking the video object enables you to 

 open the video setup dialog window 
 show/hide the video window 
 replace the video file 
 move/shift the video object by entering values 

 

Video options 
Show video time stamp: This option opens the time stamp display in the video monitor. 
You can choose for it to be displayed at the top, center, or at the bottom. 

Video object drawing: The option "Show video thumbnails" displays thumbnails in the 
video track in different resolutions. Improve system performance by deselecting the box to 
shut off the video object display completely. The video file will continue to be played in the 
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video monitor. VIP draw mode 2 ("Tab" key) may be used to display only the object start 
and end frames. 

Extract audio from video: This button extracts and converts audio files from an AVI file 
into a wave file for insertion into the current project. 

Replace audio in video: This option can be opened using the "Export video sound" 
function to replace the existing audio track in an AVI video. 

Playback offset: Set a positive or negative playback offset in this field. 

Aspect ratio: Select an aspect ratio of either 4:3 or 16:9. 

Large video cache: This option allows you to allocate more cache for the video clipboard. 

Double frame rate for interlaced: This enables you to double the image repeat frequency 
when interlacing so that videos can be viewed without any flickering. 

Video overlay (hardware video output): "Video overlay" indicates that the graphics card 
calculates the video display and the video picture is positioned on top of the actual 
windows screen (overlay). 

 



 

3 6 0  H A R D W A R E  CO N T RO LL ER   

Hardware Controller 
Hardware controller - Introduction 
Samplitude lets you easily control the software using external hardware controllers. 
Templates (.cps files) for advanced controllers come supplied. The number of supported 
devices is increased continually and they are adapted to the new devices that appear on 
the market. 

A MIDI interface is required to use a hardware controller. Please ensure that the program's 
MIDI functions are not deactivated, (Menu, "File > Program Preferences > System options 
> MIDI > Deactivate all MIDI functions") since they are necessary for addressing the MIDI 
controllers. 

The hardware controller setup contains four registers. 

 Controller settings:  Selects your controllers and assigns MIDI ports. 
 Adjust controller: Learns or changes functions. 
 Options: Carry out additional individual settings. 
 Scale faders: Adjusts faders to the scales on the controller. 

 

Hardware controller settings 
Access the "Hardware Controller Setup" dialog by pressing "Y" on your keyboard. The 
"System Options" dialog will open; click the "Hardware Controller" subcategory. 

 

1. Click the "Add New" button in the controller settings. Select your controller or a 
compatible device from the list. Pressing "Remove" or "Del" on your keyboard will 
remove the selected controller. Save your individual configuration by clicking "Save 
as". 

2. Drag & drop to modify the order of controllers and their internal assignment. A 
controller that appears beside another one corresponds to an expansion module. 
Click the check box above the controller to activate/deactivate a controller 
temporarily. 

3. Select the MIDI In and MIDI Out ports that your controller is connected to on the 
right. 

4. Close the dialog. The controller is now operational. 
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Using multiple controllers, extenders, and multi-bank controllers 

A maximum of four controllers may be positioned in the controller selection list. For 
example, if you select a Mackie Control and want to add an extension to it, then just add a 
Mackie control again. This will be added automatically directly below the first one. In this 
case, the second controller is treated as the extension. Specify the correct MIDI ports for 
this controller, too. 

If the order of both devices is not correct, simply swap their positions via drag & drop or 
change the MIDI ports. 

If you wish to have both controllers working parallel and independently, drag them using 
the mouse so that one is directly beneath the other in the list. 

Activate EuCon: Activate this check box if you are working with a EuCon controller. The 
connection may be updated at any time via the corresponding button. 

Track count: Specifies the number of tracks in a bank available to the controller. This is 
usually eight tracks. Mackie Control and HUI protocols can only communicate with eight 
channels per bank. However, there are also controllers that have a native mode that is able 
to learn several channels (64 max.). This value is 1 for single track controllers. 

Output  

Deactivate: If your controller does not have any motorized faders, you can use this option 
to deactivate transmission of controller data. 

Normal Send: Program data (e.g. mixer fader changes) are sent to the controller. MIDI 
controller data is received and processed. 

Send Echo: Program data (e.g. mixer fader changes) are sent to the controller. MIDI 
controller data is received and processed and sent back to the controller. This is required 
by the controller to update features such as LED displays and buttons. If your controller 
has difficulties with this (e.g. Logic Control), activate "Normal Send". 

Send Echo (without fader touch): Program data (e.g. mixer fader changes) are sent to 
the controller. MIDI controller data is received and processed and sent back to the 
controller. In this case however, the fader values are not returned when the faders are 
moved (activated fader touch),  but rather only the last value after the fader is released is 
sent (in order to prevent increased data volumes). If your controller experiences difficulties 
with this feature (e.g. Logic Control), then activate "Normal Send". 
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Hardware controller – "Internal" mode 
The internal modes are used to adapt to different hardware controllers which operate using 
different concepts. Depending on the mode, the controller display is controlled differently 
and Samplitude interprets the controller information differently. The effect is that a particular 
physical control element controls different parameters in Samplitude, depending on the 
internal operating mode.  

The function "Learn hardware controller" in the mixer menu or in the menu for any 
VST plug-ins (view page 372) enables these data structures to be manipulated. In this 
case, the active operating mode may be changed so that it is able to function differently 
than its preset. The changed data structures are saved accordingly and are immediately 
available the next time the program is launched. This ensures that you are able to continue 
working with the most recent settings. 

To restore the original configuration, press the button "Restore modes". 

Note:  If you are using a hardware controller that is not listed in the hardware control setup, 
then select one from the list that is most similar in concept and design. 

Following internal modes (Mapping modes) are available: 

Mackie Multitrack 
Track 

Press first time: Track mode 

Press second time: Active control mode 

 Each activated mixer element (recognizable by the red marking) is controlled by the first 
fader 

PAN 

 Pan mode (like track mode, except for the display) 

EQ 

Press first time: EQ Phat Channel Bandwise mode 

 Gain, frequency, and quality accessible via the knobs 
 Use the bank switch keys to access the other bands 

Note: The bank switch functions have to be learned, which is usually the case 

Press second time: EQ Phat Channel Typewise mode 
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 Gain, frequency, and quality accessible via the knobs (differently grouped than in 
Bandwise mode) 

 Using the bank switch keys, each of the other EQ functions can be accessed 

AUX 

Press first time: AUX track mode 

 AUX 1 to 6 of the active track using the knobs 

Press second time: AUX slot mode 

 Set AUX for each track 
 Select number of AUX tracks to be controlled using the Bank Switch keys 

Plug-in 

 The VST plug-in slots are listed for the active track (flip through via bank switch keys) 
 Selection of the VST plug-in to be adjusted by pressing the corresponding knob 
 Thereafter the parameters for the selected plug-ins are shown 
 Changing the parameter using the knob 
 Page through the parameters 

Frontier AlphaTrack 
Track 

Press first time: Panorama mode 

 Panorama control 
 Navigate to markers 
 Move selected track 

Press second time: Active control mode 

 Changes the value of the selected element in the mixer with the fader. 

AUX 

 Select other track 
 Select other slot 
 Change AUX send of the selected track/selected slot 

EQ 

Controlling the input volume, frequency, and quality bands of the selected EQs. The 
individual bands are selected with "Mixer track up/down". 

Plug-in 
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 Select track 
 Select plug-in slot in the track with "Mixer track up/down" key 

Now you can control 3 parameters of the corresponding plug-ins with the vpots. The 
display page is toggled with the keys "Mixer track   up/down". 

Frontier Tranzport 
Functions: For transport only 

 

JLCooper (MCS) 
Track 

Press first time: Track mode 

Press second time: Active control mode 

 Each activated mixer element (recognizable by the red marking) is controlled by the first 
fader 

AUX 

Controls all AUX sends in the selected channel. 

EQ 

Controls the EQ of the selected track via the knobs. 

Presonus fader port 
Active control 

The currently active mixer element (recognizable by red highlighting) is controlled by the 
first fader. 

Mackie HUI 
Track 

Track mode 

Active control 

The currently active mixer element (recognizable by red highlighting) is controlled by the 
first fader. 

EQ (Phat Channel EQ mode) 

Controls the EQ for the selected track via the knob controllers. 

AUX (Phat Channel AUX mode) 
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Controls all AUX sends in the selected channel. 

AUX [slots] (1 - 8) (Track AUX mode) 

Controls AUX sends for the different tracks in the selected slot. 

 

Customizing controllers 
Most devices available on the market understand protocols such as Mackie Control or HUI. 
If your device is not included in the list (view page 373), simply select the nearest 
compatible device. 

Note: Before adapting an existing template to your controller, save it under a new name via 
"Save as..." 

If you can't find your device in the list or want to change the default settings, you should 
proceed as follows: 

1. Open the "Customize controller" tab. The following dialog appears: 

 

2. Use Mackie Control if the controller is able to emulate this mode. In this case, 7-bit 
messages are transmitted. This is also visible in the MIDI input monitor. Pressing a button 
displays a new line; another line is displayed upon release. HUI receives 14-bit messages, 
i.e. two lines respectively. 

3. In the mixer, which should be open at the same time, you can now select the element 
you wish to program on your controller. The saved function is displayed in the section  
"Program function", e. g. "Fader master" for the fader in the Samplitude mixer. 
Alternatively, you may also open the context menu via "Program function". This contains a 
list of all remotely controllable functions in Samplitude. The uppermost commands are 
purely mixer functions and are suited solely for the controller connection. The lowermost 
commands are illustrations of the complete Samplitude menu structure. You can use this 
to assign each command from a menu to a controller key. Please note that when working 
with menu commands, the key LEDs of the controllers remain inactive. 
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Here are a few special learnable program functions:  

 Mixer: Global track arming/mute/solo 
 Mixer: Global FX mute button 
 Mixer: Monitoring volume 
 Mixer: Monitoring AFL/PFL button 
 Mixer: Flip mode (exchange faders and vpots) 
 Mixer -> Navigation: Learn AUX modes button for AUX1... AUXx 
 Modifier: SHIFT lock (e. g. for JL-Cooper MCS-3800) 

1. Select a program function via the context menu or by moving a mixer element. 

2. Now move the fader or press the corresponding key on your controller. The MIDI data 
for this element is displayed in the section "Latest MIDI data".  

3. Press "Learn" and the new data will be assigned to the function in Samplitude. 

Note: Hardware controllers with touch-sensitive faders send a message whenever they are 
moved and released (FaderTouch). "Learning" must be activated before moving and 
releasing a fader. 

If you want to learn a key/fader for multiple tracks, e. g. mute, select the corresponding 
function in "Program functions" (e. g. "Mixer -> Tracks -> Track mute"). Now activate 
"Track -> Auto increase" and start programming the first track. After pressing "Learn", 
the value of the track is automatically increased by "1". Simply move/activate the next 
element on the controller and press "Learn" again. 

Use the "Delete" button to remove assignment of a function. 

If a controller moves in the wrong direction after programming it, repeat the programming 
sequence and activate the "Invert vpots direction" option. 

Last MIDI files: These fields display the last used MIDI files.  

“Send MIDI message This function can be used to: send another MIDI message to the 
controller for LED control.  

MIDI messages that are sent by a hardware controller's control element are normally the 
same messages used by the application to control the control element remotely. This may 
be the position of a fader or a key's LED light, for example. There are also controllers that 
expect different MIDI messages. These may be entered separately in the fields. 

Control sends 14-bit message: Activate this button if the control element to be learned 
sends two MIDI messages. HUI protocol does this, for example. There may be different 
control elements on a single controller, in which case several send 7-bit messages while 
others send 14-bit messages. 

Endless: Activate this option if the control element to be learned sends relative movement 
(e. g. dials to the right or left) - in contrast to absolute positions. 
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If a controller moves in the wrong direction after programming it, repeat the programming 
sequence and activate the "Invert vpots direction" option. 

Alternative controller dynamic: If a dial makes overly large 'jumps' when moved quickly 
you can edit that here. 

Don't send feedback: Regardless of the output mode, you can specify the controller 
settings for each controller, e.g. if feedback should be prevented from returning to the 
controller. 

Status key: Controllers normally send a MIDI "IN" message when a key is pressed and 
then a MIDI "OUT" message when the key is released. Some controllers send alternating 
"IN" or "OUT" messages by pressing and releasing respectively. To be able to use keys in 
this fashion, activate this message during MIDI learning. 

MIDI monitor: The MIDI monitor can be opened using the button of the same name. It 
displays all MIDI files, which are sent by the Hardware Controller Module to Samplitude. As 
sources of sent MIDI files, Samplitude's MIDI Editor as well as activated plug-ins come into 
consideration. 

 

If you press the "Shift" key when clicking a button at the same time, the MIDI monitor will 
remain open once you close the hardware controller settings. 

If you click a button while holding down the "Ctrl" key, then you will be able to move the 
MIDI monitor as an independent window freely on your monitor. 

Of course, both modifiers ("Shift" + "Ctrl") may also be held down together to connect there 
functions. 

Modifier: Assigns modifier keys for the computer keys (Shift, Alt/Option, Ctrl/Control) to 
execute special functions. Pressing the assigned modifiers will execute these special 
functions.  

The "Shift", "Option", and "Control" modifiers are available for hardware controllers. To be 
able to use these modifiers, they will need to be learned first as program functions on the 
hardware controller keys. To learn a function with modifiers to a key,  you need to set the 
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desired combination of modifiers in the modifier field. Of course, not all functions may be 
used with modifiers. 

Other learned functions:  Learned functions are displayed clearly in a list. Click on an 
entry in the display window and the setting will be transferred to the dialog element. 
Individual changes may now be written over older entries by pressing "Learn". 

 

Controller elements 
The hardware controller elements featured in Samplitude provide additional options: 

 Update locator at initialization 
 Track monitoring is no longer coupled to record ready, but is rather individually learnable 
 Optimize peak meter processing 
 ActiveControl mode available for plug-in controls/VSTi 
 On-the-fly mixer mapping also for buttons 
 Hardware controller follows the mixer while scrolling in the mixer with "Ctrl" held down 
 Controls and automation for plug-in parameters via vpots or faders 
 Automation with endless controllers (with and without modifiers for Pan, AUX, and EQ) 
 Automation button in "HUI" mode glow red when automation is being written or green 

when automation is being read (controller-dependent) 
 VPot controls with depressed "Shift" for gradual controller changes 
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Hardware controller options 
Depending on the controller in question, received MIDI messages will be interpreted 
differently. In the "Options" tab, adjust and individualize settings for different controllers and 
operating methods. 

 

Protocol: The protocol specifies a series of internal interpreting parameters. You may 
select Mackie Control, HUI, JLCooper, and Tascam. 

Display mode: Many controllers feature LCD displays which differ in size and number of 
lines, and which also need to be controlled differently. For controllers without a display, you 
can deactivate the display control. You may select Mackie Control, HUI, and JLCooper. 

Locator mode: Several controllers possess a special display for the current time position 
(locator). Locator mode may be set in the following display types: Off, Mackie Control, HUI, 
and JLCooper. 

Peak meter mode: Some controllers possess a special peak meter display. "Peak meter" 
mode sets the way that the display is controlled. You may select Off, Mackie Control, HUI, 
JLCooper, and Tascam. 

Bank switch track number: A project in Samplitude can include more tracks than are 
available to the controller. In this case, the controller only displays a section of the available 
tracks. To change this section, change the channels or the bank. While switching channels 
changes the section exactly to the track, a bank switch can jump several tracks. 
Depending on the number of tracks on the controller and your preferred working style, you 
may set different step intervals per bank.  

MIDI ping to controller: Most controllers expect a periodic incoming MIDI message (ping) 
to ensure that there is communication with the application. Different messages may also 
change a controller's operating modes. Enter the message to be sent to the controller. 

MIDI ping from controller: As a response to ping messages, controllers usually send a 
ping message. So that no confusion results, you may enter these explicitly so that they may 
be ignored by the application.    
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Display interval (ms): Display control occurs in certain time intervals and not continuously. 
This limits the amount of display information. A small interval accelerates the display on the 
controller, but enlarges the amount of MIDI data that needs to be transferred.  

Locator interval (ms): Locator display control also takes place in intervals. If the time 
position within an interval changes, only the current value is sent to the controller after it 
expires. Reduce this interval and the locator display will react more directly. 

AnySolo LED: Some controllers possess an LED which indicates that at least one track in 
the project has an active "solo" function. Since no button belongs to this LED and it is not 
learnable, you may set the corresponding MIDI message here. 

Manual hardware ID: To activate "Mackie Control" display mode, an additional parameter 
is necessary: the hardware ID. This may be automatically queried with new firmware 
versions or entered manually. 

Query hardware ID: Activate or deactivate the automatic hardware ID query. Deactivate 
this function if you aren't using the "Mackie Control" display mode. This helps to avoid 
incorrect interpretation of the query message.  

Ignore SysX input data: SysX data sent from the controller won't be processed by the 
application. 

Don't send SysEx: Samplitude sends different messages via SysEx. What is sent exactly 
depends on the selected display mode, locator mode, etc. If problems occur with SysEx 
messages while using a controller, then you can use this to stop sending these messages 
to the hardware controller. 

Fader touch activates track: This option activates the track that belongs to the fader 
when a touch-sensitive fader is used. 

No fader update after release for motorized faders: When you move touch-sensitive 
faders, the fader messages to the controller are normally ignored by the controller. 
However, after release, the controller requires a positioning message. If this isn't sent, the 
fader will reset to its last position before being moved. Some controllers don't require this 
new position message. They jump to the new position from the old message to the new 
one first. To avoid this, deactivate sending of new positions. 

The following options concern the synchronization between controller range, mixer 
range, and the active track. The controller range describes the section of available tracks 
in a project which can be controlled by the controller. The mixer range is the section of 
available tracks in the project that can be controlled by Samplitude's mixer. 

Controller range follows active track: If this option is active, then the controller range is 
adjusted if the active track is changed so that the active track lies within the controller 
range. 

Controller area follows controller range: If this option is active, a track within the 
controller range is activated when the controller range is changed. The track next to the 
previously activated track is also activated. 
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Mixer range follows controller range: If this option is active, changes to the controller 
range at the start of the mixer will be adjusted to the start of the controller range. 

Mixer range follows controller range when active track is changed: This option is only 
sensible when "Controller range follows active track" is active. If a track outside of the 
controller range is active, then the controller range will be adjusted to it. These changes to 
the controller range readjust the mixer range. 

Note: If you scroll through the mixer and simultaneously hold "Shift", the beginning of the 
controller range will be adjusted to the start of the mixer range.   

Show track numbers instead of track names: If this option is active, track numbers will 
be shown instead of track names in the controller display. 

Control assignment display: Some controllers possess an additional display field for 
showing the current operational mode (track, EQ, AUX, etc.). If a controller does not such a 
display field, then deactivate control the display field so that control commands don't 
incorrectly influence other controller elements. This option updates Samplitude's 
automation modes optimally. 

Control fader LEDs: Some controllers possess LED displays that are assigned to the 
dials. These can be used for visual display of the current parameter controlled by the dial. 
For controllers without LED displays, you can deactivate the display control. 

Process messages with dialogs open: Normally, when hardware controller dialogs are 
open, MIDI messages are no longer processed to avoid unwanted changes. In some 
situations, adjusting or programming a controller requires that controller messages are able 
to be responded to. In this case, you can activate incoming messages while dialogs are 
open. It's a good idea to deactivate this option again once the controller is adjusted. 

 

Hardware controller - fader scaling 
Fader scaling offers you the option to adjust the position of the fader in the program to the 
pressed scale of the controller. Of course, fader control also functions without this 
adjustment. Control via a hardware controller can occur within a range of +6 dB to -100 
dB. Normally, the fader position is right at the top for +6 dB and all the way down at -100 
dB. 

 

To set up new scaling, take the following steps: 
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1. Delete all previous entries. Click on the entry in the list and then press "Delete scale 
entry". 

2. Enter the value "6" into the "Scale entries on controller" and move the fader all the way 
up (to the scale value +6 dB). Next, click "Set scale entry" to set the new entry.  

3. Move the fader all the way down and enter the value "-100" into the "Scale entries on 
controller". Click "Set scale entry" again. 

4. Insert additional scale positions (e.g. -10,-20, -40, etc.) in the same way. 

To test if the scale matches, close the dialog with okay and compare the controller's fader 
positions with fader positions in the program mixer. Additional scale values may also be 
added later. To change a value, delete the previously learned value first. 

 

Learn controller for plug-in/mixer elements 
The respective active mode may be adjusted for individual settings. The mixer's system 
menu features the entry "Learn hardware controller" for this. Right click the icon in the 
title bar in the mixer to open this function. 

 

Click the command "Learn hardware controller", activate a mixer element with the 
mouse, and then move the desired control element on the controller. The control element 
will now control the assigned mixer element. This assignment only changes the mode 
active at this time. This makes is possible to use controller elements that have been learned 
in the hardware controller dialog.  
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The plug-ins menus also include the entry "Learn hardware controller". The plug-in 
parameters may also be learned for a controller in the same way. 

 

The changes made remain available until  either "Restore modes" is clicked in the 
hardware controller dialog or until a change is made in the hardware controller dialog 
settings. 

Here are the instructions for learning a controller: 

1. Click the desired plug-in/mixer element or move it 
2. Move the selected element on the hardware controller 

Pay attention to the following: 

 The hardware controller element must have been learned in the hardware controller 
setup beforehand and may not be empty. 

 Learned elements permanently modify the internal mode. Assignment is also available 
later for other projects. 

 Assignment may be cleared again via the "Restore modes" button beside the internal 
mode. 
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Hardware controller presets 
The following list features the most important presets for hardware controllers and 
integrating/configuring devices. 

 

Artist Mix 

 

1. Close your controller (according to manufacturer's instructions) and install the required 
driver software. 

2. Go to system options/Hardware controller and select "activate EUCON". 

3. Close the dialog. Your controller is now ready to use. 
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Controller configuration  

Track area: 

Control element Function Shift function 
SEL 1 ~ 8   

ON 1 ~ 8   

DIAL 1~8 Panorama  
SOLO 1 ~ 8 Track solo  
ON 1 ~ 8 Track is on (inverted mute)  
RTZ  Cursor at project start   

PREV  Previous marker 

NEXT  Next marker  

REW  Fast rewind 

FF  Fast forward 

Stop  Stop 

PLAY  Playback 

REC  Recording 

FADER 1 ~ 8 Track volume  
AUTO 
REC N 

Track record Track automation 
 

ASSIGN 
SEL Y 

Track selection Track arrange using 
EuControl 
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Navigation: 

Control element Function Shift function 
TOP 
BACK 

Return from a subpage Return to upper most 
page 

< PAGE Parameter page to the left 
e.g. in channel editing mode, AUX or 
Inserts 

 

PAGE > Parameter page to the right 
e.g. in channel editing mode, AUX or 
Inserts 

 

FLIP 
CHAN 

Channel editing mode (Phat-
Channel) 

Flip mode: 
KNOBS and FADERS 
swap functions 

INPUT 
INSERTS 

Plug-in mode  

DYN 
EQ 

EQ mode  

GROUP 
AUX 

AUX mode  

MIX 
PAN 

Pan mode  

SHIFT Shift key  
   

MIXER 
< NUDGE 

Controller track 1 to the left Mixer 

CLOSE 
NUDGE > 

Controller track 1 to the right Close application 

HOME 
< BANK 

Controller track 8 to the left View goes to track 1 

END 
BANK > 

Controller track 8 to the right View goes to last track 

WORKSTATION 
APPLICATION 

Switch the current Windows 
application 

Workstation switch 

 

Observations: 

The modes INPUT, DYN, GROUP and MIX are not available in the software. 
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Artist Control 

 

1. Close your controller (according to manufacturer's instructions) and install the required 
driver software. 

2. In case the files Sam.xml or Sequoia.xml don't exist in the driver software 
programs\Euphonics\EuCon\SQRL copy and paste it here from the folder program 
directory/Customize.  

3. Go to system options/Hardware controller and select "activate EUCON". 

4. Close the dialog. Your controller is now ready to use. 

Controller configuration  

Track area: 

Control element Function Shift function 
SOLO 1 ~ 4 Track solo  
ON 1 ~ 4 Track is on (inverted mute)  
FADER 1 ~ 4 Track volume  
AUTO 
REC N 

Track record Track automation 
 

ASSIGN 
SEL Y 

Track selection Track arrange using EuControl 

HOME 
SOFT KEYS  

SOFT KEYS upwards SOFT KEYS to first page 

END 
SOFT KEYS 

SOFT KEYS downwards SOFT KEYS to last page 
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Display range:  

Control element Function Shift function 
DIAL 1~8 Function independent of view  
SOFT KEYS 1 ~ 12 Function independent of view  
 

Navigation: 

Control element Function Shift function 
MONITOR 
CONTROL ROOM 

 Monitor volume Solo-Bus volume 

TOP 
BACK 

Return from a subpage Return to upper most page 

WORKSTATION 
APPLICATION 

Switch the current Windows 
application 

Workstation switch 

< PAGE Parameter page to the left 
e.g. in channel editing mode, AUX or 
Inserts 

 

PAGE > Parameter page to the right 
e.g. in channel editing mode, AUX or 
Inserts 

 

MIXER 
< NUDGE 

Controller track 1 to the left Mixer 

CLOSE 
NUDGE > 

Controller track 1 to the right Close application 

HOME 
< BANK 

Controller track 8 to the left View goes to track 1 

END 
BANK > 

Controller track 8 to the right View goes to last track 

REC Recording  
PLAY Playback  
Stop Stop  
FF Fast forward  
REW Fast rewind  
SHUTTLE 
JOG 

Positioning 
 

Scrubbing 

VERTICAL ZOOM 
HORIZONTAL ZOOM 

  

SHIFT Shift key  
 

Observations: 

The modes INPUT, DYN, GROUP and MIX are not available in the software. 
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Artist Transport 
1. Close your controller (according to manufacturer's instructions) and install the required 
driver software. 

2. In case the files Sam.xml or Sequoia.xml don't exist in the driver software 
programs\Euphonics\EuCon\SQRL copy and paste it here from the folder program 
directory/Customize. 

3. Go to system options/Hardware controller and select "activate EUCON". 

4. Close the dialog. Your controller is now ready to use.  

Controller configuration  

Copy Sam.xml or Sequoia.xml 

Control element Function Shift function 
SOFT KEY 1 Jog  
SOFT KEY 2 Scrub  
SOFT KEY 3 Loop mode  
SOFT KEY 4 Metronome  
SOFT KEY 5 Sync  
SOFT KEY 6 Position input 

Apply using ENTER 
Abort using * 

 

Numeric key (0 ~ 9) Number input  
-   

+   

. Decimal place  
* ESC/Cancel  
Enter Enter  
TRANSPORT KEY 1 Cursor at project start   
TRANSPORT KEY 2 Fast rewind  
TRANSPORT KEY 3 Fast forward  
TRANSPORT KEY 4 Stop  
TRANSPORT KEY 5 Playback  
TRANSPORT KEY 6 Record  
TRANSPORT KEY 7 Loop mode  
WORKSTATION 
APPLICATION 

Switch the current Windows 
application 

Workstation switch 

SHIFT Shift key  
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Frontier AlphaTrack 
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1. AlphaTrack is supported in "Native" mode. Right clicking the AlphaTrack symbol in the 
toolbar switches the device to AlphaTrack Native. 

 

 

2. Go to Samplitude/Sequoia's system settings/hardware controller and select 
AlphaTrack using the New button. 

3. Next, set the right side of the MIDI port to AlphaTrack.  
4. Close the dialog. The controller is now operational. 

Controller configuration 

Control element Function SHIFT-  
Label 

SHIFT - Function 

FADER Track volume   

ANY SOLO (LED) Indicates, that at least one 
track in the arrangement is 
switched to SOLO 

  

AUTO WRITE 
(LED) 

   

AUTO READ 
(LED) 

   

REC Record track  Monitor track 

SOLO Solo track  Global solo 

MUTE Mute track  Global mute 

SHIFT Shift   

PAN Press first time: Pan mode 
Press second time: Active 
Control mode 
(see table 2) 

  

SEND AUX mode  
(see table 2) 

  

EQ EQ mode 
(see table 2) 

  

Plug-in Plug-in mode 
(see table 2) 

  

AUTO Track automation  Copy automation 
mode to all tracks 

F1 Touch automation F5 Read automation 
F2 Latch automation F6 Automation off 
F3 Overwrite automation F7 Restore 
F4 Trim automation F8  Undo 
< TRACK Previous track IN Punch start marker 
> TRACK Next track OUT Punch end marker 
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LOOP Loop mode PUNCH Punch marker mode 
FLIP Mixer WINDOW Delete punch marker 
<< Fast rewind RTZ Cursor at project start  
>> Fast forward END Cursor at project end 
STOP Stop Esc Cancel 
PLAY Play Enter Enter 
RECORD Record Mode  

TOUCHPAD Positioning   

Foot switch Record   

 

Special modes 

Mode Control element Rotate Press 

Pan mode DIAL 1 Track selection  

 DIAL 2 To the marker Set marker 

 DIAL 3 PAN Reset pan 

ACTIVE 
CONTROL 
MODE 

FADER 
(controls the active element in the 
mixer, track editor, or plug-in that 
must be selected with the mouse 
beforehand) 

 
 

 

 DIAL 1 PAN  

 DIAL 2 PAN  

 DIAL 3 PAN  

 
AUX mode 

 
DIAL 1 

 
Track selection 

 

 DIAL 2 AUX level  

 DIAL 3 AUX selection  

 
EQ mode 

 
DIAL 1 

 
Level 

 
 

 DIAL 2 Frequency  

 DIAL 3 quality  

 < TRACK Previous 
EQ band 

 

 > TRACK Next 
EQ band 

 

Plug-in mode 
Plug-in slot 
selection 

DIAL 1 Track selection  

 DIAL 2   

 DIAL 3 Slot selection  

 < TRACK Select plug-in  
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 > TRACK Select plug-in  

Plug-in parameter DIAL 1 Change 
parameters 

 

 DIAL 2 Change 
parameters 

 

 DIAL 3 Change 
parameters 

 

 < TRACK Previous 
parameters 

 

 > TRACK Next parameters  
 

Frontier TranzPort 
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1. TranzPort is supported in "Native" mode. By right clicking the TranzPort symbol in the 
toolbar, you will switch the device to TranzPort Native. 

 

 

2. Go to Samplitude/Sequoia's system settings/hardware controller and select the 
Frontier TranzPort (Native) entry from the list via the New button. 

3. Next, set the right side of the MIDI port to TranzPort. 
4. Close the dialog. The controller is now operational. 

Controller configuration 

Control element Function SHIFT - Function 

< TRACK Previous track  
> TRACK Next track  
REC Record track Monitor track 
MUTE Mute track Global mute 

SOLO Solo track Global solo 
ANY SOLO (LED) Indicates, that at least one track in the 

arrangement is switched to SOLO 
 

UNDO Undo Restore 
IN Punch start marker  
OUT Punch end marker  
PUNCH Punch marker mode Delete punch marker 
LOOP Loop mode  
SHIFT Shift  
PREV MARKER Previous marker Metronome 
ADD MARKER Insert marker  
NEXT MARKR Next marker Scrub mode 
<< Fast rewind Cursor at project start  
>> Fast forward Cursor at project end 
STOP Stop Cancel 
PLAY Play Enter 
RECORD Record  
DATA WHEEL Positioning Track volume 
DATA WHEEL + 
STOP 

Selected range  

Foot switch Record  
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JLCooper MCS-3800 

 

1. Go to Samplitude/Sequoia's system settings/hardware controller and select the 
"JLCooper MCS-3800 (Native)" entry from the list using the "New" button.  

2. Now set up the MIDI ports with the corresponding in and outputs of your MIDI interface 
on the right side.  

3. Close the dialog. The controller is now operational. 

Controller configuration  

Track range 
Control element Function Modifier Modifier function 

SELECT 1~8  Select track   

AUX 1~8 Record track SHIFT Track monitoring 1~8 
(ASIO only) 

SOLO 1~8 Solo track   

MUTE 1~8 Mute track SHIFT Track automation 
FADER 1~8 
(with fadertouch) 

Track volume   
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Navigation 
Control element Function 

Cursor left Mixer track 1 to the left 
Cursor right Mixer track 1 to the right 
Cursor up Mixer track 8 to the right 
Cursor down Mixer track 8 to the left 

 

Area to view 
Control element Function 

PAGE 1 Track mode (see special modes) 
PAGE 2 AUX mode (see special modes) 
PAGE 3 EQ mode (see special modes) 
PAGE 4 Active control mode (see special modes) 
PAGE 5  
PAGE 6  
PAGE 7  
PAGE 8  
BANK 1 Mixer 
BANK 2 Transport console 
BANK 3 Time display 
BANK 4 Video window 
DIAL 1~5 Change parameters 

 

Functions window 
Control element Function 
F1 Punch marker mode 
F2 Loop 
F3 Metronome 
F4 Synchronization 
F5  
F6  
F7  
F8  
SHIFT Shift 
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Mode range 
Control element Function Modifier Modifier function 

M1 Read automation Shift Automation off 
M2 Touch automation   

M3 Latch automation   

M4 Overwrite automation   

M5 Trim automation   

 

Shuttle range 
Control element Function Modifier Modifier function 

Shuttle wheel Positioning W1 Scrubbing 
Rotation ring    

W1 Scrub mode   

W2 Punch start marker   

W3 Punch end marker   

W4 Delete punch marker   

W5    

W6    

W7    

 

Locator range 
Control element Function 

LOCATOR 
numbers 
(0 ~ 9) 

Entry position: 
Apply using ENTER or PLAY 
Abort using STOP 

Enter Apply position 
CLEAR / CANCEL Erase single digits 
+/-  
LAST  
SET LOCATE  
MODE LOCATE  

 

Transport range 
Control element Function 

REWIND Fast rewind 
FAST FORWARD Fast forward 
STOP Stop 
PLAY Play 
RECORD Record 
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Special modes 

Mode Control element Function 

Track mode DIAL 1  
 DIAL 2  

 DIAL 3  

 DIAL 4 Track pan 

 DIAL 5 To the marker 

AUX mode DIAL 1 AUX level 
 DIAL 2 AUX level 

 DIAL 3 AUX level 

 DIAL 4 AUX level 

 DIAL 5 Selection AUX range 

EQ mode DIAL 1 Level EQ band 1 
 DIAL 2 Frequency EQ band 

 DIAL 3 Quality EQ band 

 DIAL 4  

 DIAL 5 Band selection 

Active control 
mode 

FADER TRACK 1 
(controls the active element in the mixer, 
track editor, or plug-in that must be 
selected with the mouse beforehand) 

 

 

Notes 

In "Shift" mode, the LED buttons will not refresh for the commands learned in "Shift" mode. 

LEDs for Bank3 (time information) and Bank 4 (video window) are inactive. 

Plug-in controls are inactive. 
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Logic Control 
1. Go to Samplitude/Sequoia's system settings/hardware controller and select Logic 

Control from the list via the New button. 
2. Now set up the MIDI ports with the corresponding in and outputs of the MIDI interface 

on the right side. 
3. Close the dialog. The controller is now operational. 

Controller configuration  

TRACKS 
Control element Function Modifier Modifier function 

DIAL 1~8 Pan; Eq; Aux  
(see special modes) 

  

REC/RDY 1~8 Activate track SHIFT Monitor track 
SOLO 1~8 Solo track   

MUTE 1~8 Mute track   

SELECT 1~8 Select track   

FADER 1~8 
(with fadertouch) 

Track volume   

MASTER FADER Master volume   

 

ASSIGNMENT 
Control element Function 

1 Press first time: Track mode 
Press second time: Active Control mode 
(see special modes) 

2 Press first time: AUX mode 
Press second time: AUX mode (phat channel) 
(see special modes) 

PAN/SURROUND Pan mode 
(see special modes) 

Plug-in Plug-in mode 
(see special modes) 

EQ EQ mode 
(see special modes) 

INSTRUMENT  
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FADER BANKS 
Control element Function 

< BANK Mixer track 8 to the left 
BANK > Mixer track 8 to the right 
< CHANNEL Mixer track 1 to the left 
CHANNEL > Mixer track 1 to the right 
FLIP Flip mode: Invert functions of dials and faders 
GLOBAL VIEW Mixer 

 

DISPLAY 
Control element Function 

NAME/VALUE  
SMTP/BEATS Timecode switch 
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FUNCTION BUTTONS 
Control element Function Modifier Modifier function 

F1 Set / jump to 
marker 1 

SHIFT 
CNTRL 

Move marker 1 
Delete marker 1 

F2 Set / jump to 
marker 2 

SHIFT 
CNTRL 

Move marker 2 
Delete marker 2 

F3 Set / jump to 
marker 3 

SHIFT 
CNTRL 

Move marker 3 
Delete marker 3 

F4 Set / jump to 
marker 4 

SHIFT 
CNTRL 

Move marker 4 
Delete marker 4 

F5 Set / jump to 
marker 5 

SHIFT 
CNTRL 

Move marker 5 
Delete marker 5 

F6 Set / jump to 
marker 6 

SHIFT 
CNTRL 

Move marker 6 
Delete marker 6 

F7 Set / jump to 
marker 7 

SHIFT 
CNTRL 

Move marker 7 
Delete marker 7 

F8 Set / jump to 
marker 8 

SHIFT 
CNTRL 

Move marker 8 
Delete marker 8 

 
GLOBAL VIEW 
Control element Function 

MIDI TRACKS  
INPUTS  
AUDIO TRACKS  
AUDIO 
INSTRUMENT 

 

AUX  
BUSSES Select previous object 
OUTPUTS Select next object 
USER Crossfade Editor 

 

MODIFIERS 
Control element Function 

SHIFT Control  
OPTION Option 
CONTROL  
# / ALT Shift 
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AUTOMATION 
Control element Function Modifier Modifier function 

READ/OFF Read automation SHIFT Automation off 
WRITE Overwrite automation   

TRIM Trim automation   

TOUCH Touch automation   

LATCH Latch automation   

GROUP Copy automation mode to all 
tracks 

  

 

UTILITIES 
Control element Function Modifier Modifier function 

SAVE Save   

UNDO Undo SHIFT Repeat 
CANCEL Cancel   

Enter Enter   
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TRANSPORT 
Control element Function Modifier Modifier function 

MARKER Marker mode 
(see table 2) 

  

NUDGE Object mode 
(see table 2) 

  

CYCLE Loop mode   

DROP Punch marker mode   

REPLACE Synchronization   

CLICK Metronome   

SOLO Activate LCD meter by 
holding "F1", "F2", "F3", or 
"F4" 

  

REWIND Fast rewind SHIFT Cursor at project start  
FAST FWD Fast forward SHIFT Cursor at project end 
STOP Stop   

PLAY Play   

RECORD Record   

Cursor left Range to left ZOOM Horizontal project zoom (-
) 

Cursor right Clip to right ZOOM Horizontal project zoom 
(+) 

Cursor up Next highest track ZOOM Vertical project zoom (+) 
Cursor down Next lowest track ZOOM Vertical project zoom (-) 
ZOOM Zoom mode   

SCRUB Scrub mode   

Shuttle wheel Positioning SCRUB Scrubbing 

 

Special modes 

Mode Control element Rotate Press 

Track mode DIAL PAN Reset 
ACTIVE 
CONTROL 
MODE 

FADER 
(controls the active 
element in the mixer, 
track editor, or plug-in 
that must be selected 
with the mouse 
beforehand) 

  

Pan mode DIAL PAN Reset 
EQ mode DIAL 1 Level EQ band 1  
 DIAL 2 Level EQ band 2  

 DIAL 3 Level EQ band 3  
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 DIAL 4 Level EQ band 4  

 DIAL 5 Frequency EQ band 1  

 DIAL 6 Frequency EQ band 2  

 DIAL 7 Frequency EQ band 3  

 DIAL 8 Frequency EQ band 4  

AUX mode 
AUX 1~8 
selectable using 
BANK 

DIAL 1~8 AUX level  

AUX mode (phat 
channel) 
depending on 
selected track 

 
 
 
DIAL 1 

 
 
 
AUX 1 level 

 

 DIAL 2 AUX 2 level  

 DIAL 3 AUX 3 level  

 DIAL 4 AUX 4 level  

 DIAL 5 AUX 5 level  

 DIAL 6 AUX 6 level  

 DIAL 7   

 DIAL 8   

Plug-in mode DIAL 1~8  Select plug-in 

Plug-in parameter DIAL 1~8 Change parameters  
 < BANK Previous parameters  

 BANK > Next parameters  

Marker mode REWIND  Previous marker 

 FAST FWD  Next marker 

Object mode REWIND  Previous object 

 FAST FWD  Next object 

 

Note: 

Crossfade editor (only Sequoia): Controller operation is inactive. 

 

Logic Control XT 
1. Go to Samplitude/Sequoia's system settings/hardware controller and select Logic 

Control XT from the list via the New button. 
2. Position Logic Control XT under Logic Control 
 

 

 If you have set up Logic Control XT to the left of Logic Control, the entries in the list 
will appear as follows 



 

H A R D W A R E  CO N T RO LL ER  3 9 5   

 

 

3. Now set up the MIDI ports with the corresponding in and outputs of the MIDI interface 
on the right side. 

4. Close the dialog. The controller is now operational. 

The functions correspond with the Logic Control. 

Note: The number of tracks to be jumped when a bank is switched may be altered via the 
program's hardware controller setup options. These settings are available via Logic 
Control. 

 

Mackie Control 
1. Go to Samplitude/Sequoia's system settings/hardware controller and select "Mackie 

Control" from the list via the "New" button.  
2. Now set up the MIDI ports with the corresponding in and outputs of the MIDI interface 

on the right side. 
3. Close the dialog. The controller is now operational. 

Controller configuration  

TRACKS 
Control element Function Modifier Modifier function 

DIAL 1~8 Pan; Eq; Aux  
(see special modes) 

  

REC/RDY 1~8 Activate track SHIFT Monitor track 
SOLO 1~8 Solo track   

MUTE 1~8 Mute track   

SELECT 1~8 Select track   

FADER 1~8 
(with fadertouch) 

Track volume   

MASTER FADER Master volume   
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ASSIGNMENT 
Control element Function 

1 Press first time: Track mode 
Press second time: Active Control mode 
(see special modes) 

2 Press first time: AUX mode 
Press second time: AUX mode (phat channel) 
(see special modes) 

PAN Pan mode 
(see special modes) 

Plug-ins Plug-in mode 
(see special modes) 

EQ EQ mode 
(see special modes) 

DYN  

 

FADER BANKS 
Control element Function 

< BANK Mixer track 8 to the left 
BANK > Mixer track 8 to the right 
< CHANNEL Mixer track 1 to the left 
CHANNEL > Mixer track 1 to the right 
FLIP Flip mode: Invert functions of dials and faders 
EDIT Mixer 

 

DISPLAY 
Control element Function 

NAME/VALUE  
SMTP/BEATS Timecode switch 
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FUNCTION BUTTONS 
Control element Function Modifier Modifier function 

F1 Set / jump to marker 1 SHIFT 
CNTRL 

Move marker 1 
Delete marker 1 

F2 Set / jump to marker 2 SHIFT 
CNTRL 

Move marker 2 
Delete marker 2 

F3 Set / jump to marker 3 SHIFT 
CNTRL 

Move marker 3 
Delete marker 3 

F4 Set / jump to marker 4 SHIFT 
CNTRL 

Move marker 4 
Delete marker 4 

F5 Set / jump to marker 5 SHIFT 
CNTRL 

Move marker 5 
Delete marker 5 

F6 Set / jump to marker 6 SHIFT 
CNTRL 

Move marker 6 
Delete marker 6 

F7 Set / jump to marker 7 SHIFT 
CNTRL 

Move marker 7 
Delete marker 7 

F8 Set / jump to marker 8 SHIFT 
CNTRL 

Move marker 8 
Delete marker 8 

F9~F13    

F14 Select previous object   

F15 Select next object   

F16 Crossfade Editor   

 
MODIFIERS 
Control element Function 

CNTRL Control  
OPT Option 
SNAPSHOT  
SHIFT Shift 

 

AUTOMATION 
Control element Function Modifier Modifier function 

READ/OFF Read automation SHIFT Automation off 
WRITE Overwrite automation SHIFT Copy automation mode to all 

tracks 
UNDO Undo SHIFT Repeat 
SAVE Latch automation   

TOUCH Touch automation   

REDO Trim automation   
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FUNCTIONS 
Control element Function 

FDR GRP Cancel 
CLR SOLO Enter 
MRKR  
MIXR Save 

 

TRANSPORT 
Control element Function Modifier Modifier function 

< FRM Marker mode 
(see table 2) 

  

FRM > Object mode 
(see table 2) 

  

END Loop mode   

PI Punch marker mode   

PO Synchronization   

LOOP Metronome   

HOME Activate LCD meter by holding 
"F1", "F2", "F3", or "F4" 

  

REWIND Fast rewind SHIFT Cursor at project start  
FAST FWD Fast forward SHIFT Cursor at project end 
STOP Stop   

PLAY Play   

RECORD Record   

Cursor left Range to left ZOOM Horizontal project zoom 
(-) 

Cursor right Clip to right ZOOM Horizontal project zoom 
(+) 

Cursor up Next highest track ZOOM Vertical project zoom 
(+) 

Cursor down Next lowest track ZOOM Vertical project zoom (-) 
ZOOM Zoom mode   

SCRUB Scrub mode   

Shuttle wheel Positioning SCRUB Scrubbing 
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Special modes 

Mode Control element Rotate Press 

Track mode DIAL PAN Reset 
ACTIVE 
CONTROL 
MODE 

FADER 
(controls the active 
element in the mixer, 
track editor, or plug-in 
that must be selected 
with the mouse 
beforehand) 

  

Pan mode DIAL PAN Reset 
EQ mode DIAL 1 Level EQ band 1  
 DIAL 2 Level EQ band 2  

 DIAL 3 Level EQ band 3  

 DIAL 4 Level EQ band 4  

 DIAL 5 Frequency EQ band 1  

 DIAL 6 Frequency EQ band 2  

 DIAL 7 Frequency EQ band 3  

 DIAL 8 Frequency EQ band 4  

AUX mode 
AUX 1~8 
selectable using 
BANK 

DIAL 1~8 AUX level  

AUX mode (phat 
channel) 
depending on 
selected track 

 
 
 
DIAL 1 

 
 
 
AUX 1 level 

 

 DIAL 2 AUX 2 level  

 DIAL 3 AUX 3 level  

 DIAL 4 AUX 4 level  

 DIAL 5 AUX 5 level  

 DIAL 6 AUX 6 level  

 DIAL 7   

 DIAL 8   

Plug-in mode DIAL 1~8  Select plug-in 

Plug-in parameter DIAL 1~8 Change parameters  
 < BANK Previous parameters  

 BANK > Next parameters  

Marker mode REWIND  Previous marker 

 FAST FWD  Next marker 



 

4 0 0  H A R D W A R E  CO N T RO LL ER   

Object mode REWIND  Previous object 

 FAST FWD  Next object 

 

Note: 

All statements refer to MCU firmware 2.1.2 

Crossfade editor (only Sequoia): Controller operation is inactive. 

 

Mackie Control XT 
1. Go to Samplitude/Sequoia's system settings/hardware controller and select Mackie 

Control XT from the list via the New button. 
2. Position Mackie Control XT under Mackie Control 
 

 

 If you have set up Mackie Control XT to the left of Mackie Control, the entries in the 
list will appear as follows 

 

 

3. Now set up the MIDI ports with the corresponding in and outputs of the MIDI interface 
on the right side. 

4. Close the dialog. The controller is now operational. 

Functional assignment can be referenced in the chapter "Mackie Control". 

Note: The number of tracks to be jumped when a bank switch is pressed may be changed 
in the program's hardware controller setup options. These settings are available in Mackie 
Control. 
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PreSonus FaderPort 

 

1. Go to Samplitude/Sequoia's system settings/hardware controller and select the 
"PreSonus FaderPort (Native)" entry from the list using the "New" button.  

2. Next, set the MIDI ports on the right side to USB audio device.  

3. Close the dialog. Your controller is now ready to use. 
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Controller configuration  

Control 
element 

Function SHIFT 
labeling 

Value control 
element 

SHIFT - 
Function 

 

Return 
value for 
LED 

 

FADER Track volume     

PAN Track pan     

MUTE Mute track  Global mute A01200 A01501 

SOLO Solo track  Global solo A01100 A01601 

REC Record track  Monitor track 
(ASIO only) 

A01000 A01701  

< Previous track / 
Bank 

  A01300 A01401 

BANK "<" and ">" switch 
bank 

  A01400 A01301 

> Next track / Bank   A01500 A01201 

OUTPUT ACTIVE CONTROL 
mode 
(see special 
modes) 

  A01600 A01101 

READ Read automation   A00A00 A00D01 

WRITE Overwrite 
automation 

 Latch automation A00900 A00E01 

TOUCH Touch automation  Trim automation A00800 A00F01 

OFF Automation off  Copy automation 
mode to all tracks 

A01700 A01001 

MIX Mixer   A00B00 A00C01 

PROJ    A00C00 A00B01 

TRNS Transport console   A00D00 A00A01 

UNDO Undo REDO Restore A00E00 A00901 
SHIFT Shift   A00200 A00501 

PUNCH Punch marker 
mode 

PREV Previous marker A00100 A00601 

USER Metronome NEXT Next marker A00000 A00701 
LOOP Loop mode MARK Insert marker A00f00 A00801 
REWIND Fast rewind START Cursor at project 

start  
A00300 A00401 

FAST 
FORWAR
D 

Fast forward END Cursor at project 
end 

A00400 A00301 

STOP Stop   A00500 A00201 

PLAY Play   A00600 A00101 
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RECORD Record   A00700 A00001 

FOOT 
SWITCH 

Record     

 
Special modes 

Mode Control element 

ACTIVE 
CONTROL 
MODE 

FADER (controls the active element in the mixer, track editor, or plug-in 
that needs to be selected with the mouse beforehand) 

 

Notes: 

The foot switch is available for controller firmware 1.2 and up. 

To learn control elements for the FaderPort, enter the response values to the controller for 
learning so that the button LEDs also function. Copy the value of the last column from table 
1 of the corresponding control element into the "Send MIDI files" field. Here is an example 
of the correct arrangement for the MUTE keys. 
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Tascam US-2400 

 

1. The Tascam US-2400 is supported in "Native" mode. Use the most current firmware. 
Start the device via the power button and hold down SEL (above the master fader) and 
CHAN. The device is now in "Native" mode. 

2. Go to Samplitude/Sequoia's system settings/hardware controller and select the 
"Tascam US-2400 (Native)" entry from the list using the "New" button.  

3. Next, set the MIDI ports on the right side to USB audio device.  

4. Close the dialog. The controller is now operational. 
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Controller configuration  

Track range 
Control element Function Shift function 

DIAL 1~24 Pan, EQ, AUX 
(see table 2) 

 

SEL 1~24 Select track Track automation 
SOLO 1~24 Solo track Record track 
MUTE 1~24 Mute track Monitor track 

(ASIO only) 
FADER 1~24 
(with fadertouch) 

Track volume  

SEL (master)  Copy automation mode to all tracks 

CLR SOLO Global solo Global record 
FLIP Global mute Flip mode: Invert functions of dials and 

faders 

MASTER FADER Master volume  
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Navigation 
Control element Function Shift function 

CHAN EQ mode 
(see special modes) 

 

PAN Pan mode 
(see special modes) 

 

AUX 1 DIAL 1~24 to AUX 1 Read automation 
AUX 2 DIAL 1~24 to 

AUX 2 
Touch automation 

AUX 3 DIAL 1~24 to 
AUX 3 

Latch automation 

AUX 4 DIAL 1~24 to 
AUX 4 

Overwrite automation 

AUX 5 DIAL 1~24 to 
AUX 5 

Trim automation 

AUX 6 DIAL 1~24 to 
AUX 6 

Automation off 

METER Activate level meter in dial display  
F-KEY Active control mode 

(see special modes) 
 

NULL   

Shuttle wheel Positioning  
Shuttle wheel + 
STOP 

Select range  

SCRUB Scrub mode  
BANK Mixer track 24 to the left Mixer track 1 to the left 
BANK+ Mixer track 24 to the right Mixer track 1 to the right 
IN Loop mode  
OUT Metronome  
SHIFT Shift  
REW Fast rewind Cursor at project start  
FFW Fast forward Cursor at project end 
STOP Stop Cancel 
PLAY Play Enter 
REC Record  
Foot switch Record  

 

Special modes 

Mode Control element Function 

Pan mode DIAL 1~24 Panorama 

EQ mode 
(1 press) 

DIAL 1 Level EQ band 1 

 DIAL 2 Frequency EQ band 1 
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 DIAL 3 Quality EQ band 1 

 DIAL 4  

 DIAL 5 Level EQ band 2 

 DIAL 6 Frequency EQ band 2 

 DIAL 7 Quality EQ band 2 

 DIAL 8  

 DIAL 9 Level EQ band 3 

 DIAL 10 Frequency EQ band 3 

 DIAL 11 Quality EQ band 3 

 DIAL 12  

 DIAL 13 Level EQ band 4 

 DIAL 14 Frequency EQ band 4 

 DIAL 15 Quality EQ band 4 

 DIAL 16  

EQ mode 
(2 press) 

DIAL 1 Level EQ band 1 

 DIAL 2 Level EQ band 2 

 DIAL 3 Level EQ band 3 

 DIAL 4 Level EQ band 4 

 DIAL 5 Frequency EQ band 1 

 DIAL 6 Frequency EQ band 2 

 DIAL 7 Frequency EQ band 3 

 DIAL 8 Frequency EQ band 4 

 DIAL 9 Quality EQ band 1 

 DIAL 10 Quality EQ band 2 

 DIAL 11 Quality EQ band 3 

 DIAL 12 Quality EQ band 4 

ACTIVE 
CONTROL mode 

FADER TRACK 1 
(controls the active element in the mixer, 
track editor, or plug-in that must be 
selected with the mouse beforehand) 

 

 

Note: 

The number of tracks to be jumped when a bank switch is pressed may be changed via 
the program's hardware controller setup options. 

When using the TASCAM US-2400 as an exclusive recording panel, it's recommended that 
you relearn the SEL buttons as RecordReady. 
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Tascam FW-1884 

 

1. Go to Samplitude/Sequoia's system settings/hardware controller and select the 
"Tascam FW-1884 (Mackie)" entry from the list using the "New" button.  

2. Next, set the MIDI ports on the right side to "FW 1884 Control".  

3. Close the dialog. The controller is now operational.  

Controller configuration: 

Encoder 

Control element Function Shift function 

FLIP Flip mode: KNOBS and 
FADERS swap functions 

 

PAN Pan mode  
AUX 1~6 AUX select Record track 
AUX 7, 8   

 

Shortcuts, control panel 

Control element Function Modifier Modifier function 



 

H A R D W A R E  CO N T RO LL ER  4 0 9   

SAVE/F1 Lock project   

REVERT/F2 Global mute SHIFT Global recording 

ALLSAFE/F3    

CLR SOLO/F4 Global solo   

MARKER/F5 metronom   

LOOP/F5 "Loop" mode   

CUT Split object  SHIFT Separate object with 
alternative crossfade 

DEL Delete CTRL Delete with time/ripple 

COPY Copy CTRL Duplicating and moving 

PASTE Insert   

ALT/CMD    

UNDO undo SHIFT Repeat 

SHIFT Shift   

CTRL Ctrl   

 

Track range 

Control element Function Modifier Modifier function 

ENCODERS 1-8 Send pan/aux   

SEL 1-8 Select track CTRL Monitor track 
SOLO 1-8 track solo   

MUTE 1-8 Mute track   

FADER 1-8 Track volume   

FADER MASTER Master volume SHIFT Trim automation 
REC Arm track with SEL 

1-8 
  

 

Navigation 

Control element Function Modifier Modifier function 
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F7 Automation OFF   

F8 Transfer 
automation mode 
to all tracks 

  

F9 Trim automation   

F10 Mixer   

READ Read automation   

WRIT Overwrite 
automation 

  

TCH Touch automation   

LATCH Latch automation   

SIITL Scrub mode SHIFT Zoom mode 
WHEEL Jog/Scrub   

CURSOR UP Previous track SHIFT Zoom project vert.(+) 
CURSOR DOWN Next track SHIFT Zoom project vert.(-) 
CURSOR LEFT Timeline 

positioning 
SHIFT Zoom project horiz.(-) 

CURSOR RIGHT Timeline 
positioning 

SHIFT Zoom project horiz.(+) 

BANK LEFT Previous bank SHIFT Mixer channel 1 left 
BANK RIGHT Next bank SHIFT Mixer channel 1 right 
NUDGE LEFT Move object left   

NUDGE RIGHT Move object right   

LOCATE LEFT Previous marker SHIFT Previous object 
LOCATE RIGHT Next marker SHIFT Next object 
SET Create marker 

(auto #) 
SHIFT Delete marker 

IN Set punch in 
marker 

SHIFT Delete punch marker 

OUT Set punch-out 
marker 

  

REW Fast rewind SHIFT Cursor to project start 
(Return to Zero) 

FFW Fast forward SHIFT Cursor to project end 
(Go to End) 

Stop Stop SHIFT Cancel 
PLAY Playback (second 

press: stop at 
position) 

SHIFT Enter 

REC Recording CTRL Punch mode on/off 

 

Notes 

The following elements do not send MIDI values and may not be learned: 

 PFL, HIGH, HI-MID, LOW-MID, LOW, GAIN, FREQ, Q, COMPUTER, MIDI CTRL, MON, 
CLOCK, ROUTE 
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 All elements with CTRL configuration may be learned in the control panel without 
providing a modifier, sine the CTRL configuration already takes place in the controller 
and sends separate IDs. 

 All elements with a CTRL configuration may also be set up with SHIFT-CTRL. In the 
control panel, set the modifier to "Shift" (since the CTRL configuration takes place in the 
controller already), next press CTRL + the element and learn. 

 AUX elements LED doesn't light up correctly 
 FLIP LED doesn't light up correctly 
 The SoftLCD application that was installed with the FW-1884 drivers may be used to 

display track names and other Mackie Control-typical information 
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Preset keyboard shortcuts 
On the other hand, you may redefine this keyboard shortcut whenever you like via "Menu 
File > Program preferences > Edit  Keyboard Shortcuts and Menu (view page 488)". 
Change, remove, create keyboard shortcuts. Clicking the "All" dialog opens an overview of 
all of the shortcuts defined there. Shortcuts in brackets (<>) cannot be changed. 

Note: Pressing the key combination "Alt + Shift" may cause Windows to switch keyboard 
languages. In order to avoid this, the keyboard shortcut for switching the input scheme can 
be deactivated. In the Windows control panel, open the "Country and language" options. 
Navigate to the "Languages" tab and then to the "Details" button to access the settings for 
the standard input scheme. Press "Keyboard" to access the advanced keyboard settings. 
Open the dialog "Change keyboard combination" and place a check mark next to "Change 
input scheme" and "Remove keyboard layout" to hinder the input scheme from changing in 
the future. 

 

File menu 
New Virtual Project (VIP)... E 

 

Open 
Virtual project (*.vip)... O 
Load MIDI (*.MID) file Shift + M 
Open HD Wave Project (*.hdp) Shift + L 
Load audio file W 
Save project Ctrl + S 
Save project as... Shift + S 
Import audio… Ctrl + I 
Export WAV Ctrl + E 

 

Project Properties > 
Mixer setup... Ctrl + Shift + M 
Playback parameters P 
Project status Shift + I 
Track information... Alt + I 
Synchronization active G 
Synchronization setup... Shift + G 
Draw setup Shift + Tab 
System options Y 
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Edit menu 
Undo Ctrl + Z 
Redo Ctrl + Y 
Cut into clip Ctrl + Shift + X 
Delete Del 
Copy C / Ctrl + C / Ctrl + Insert 
Insert clip V / Shift + Insert 
Delete with time/ripple Ctrl + Del 
Clear Alt + Del 
Cut with time/ripple Ctrl + Alt + X 
Copy + clear Ctrl + Alt + C 
Copy as… Shift + C 
Copy to clip store Ctrl + Shift + C 
Overwrite with clip Ctrl + Shift + X 

Paste from ClipStore Ctrl + Shift + V 
Insert from clips with time/ripple  Ctrl + Alt + V 
Overwrite with clip  Alt + V / Insert 

 

 

Range 
Range all A 
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Manipulate range 
Move range start to left Alt + Numeric Pad '/' 
Move range start to right Alt + Numeric Pad '*' 
Move range end to left Shift + Left arrow / Alt + Numeric Pad - 
Move range end to right Shift + Right arrow  / Alt + Numeric Pad 

'+'  
Fold range to left Ctrl + Shift + Left arrow 
Flip Range right Ctrl + Shift + Right arrow 
 Beginning of Range -> 0 Ctrl + Page up 
 Beginning of Range <- 0 Shift + Page up 
End of Range -> 0 Ctrl + Page down 
End of Range <- 0 Shift + Page down 
Range start to left marker Shift + F2 
Range end to right marker Shift + F3 
Split range B 
Note range Alt + f2 - F10 (exception: Alt + F4 and F9) 
Other areas... Alt + F11 
Get range Ctrl + F2 - F10 
Get range length Ctrl + Shift + F2 - F10 
Saver marker Shift + 0-9 
Marker with name... ? 
Markers with auto number  Shift+# 
Place marker at recording position Alt + ? 
Get markers 1 - 9, 0 
Recall last range Shift + Back 
Field 1 Alt + Numeric Pad 1 
Field 2 Alt + Numeric pad 2 
Field 3 Alt + Numeric pad 3 
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Track menu 
Track properties 
Mute Alt + M 
Mute / Inactive Ctrl + Alt + M 
Solo Alt + S 
Solo exclusive Shift + Alt + S 
Record Ready Alt + R 
Monitoring  Ctrl + Alt + Shift + F 
Lock Alt + L 
Volume curve active Alt + K 
Pan curve active Alt + P 
Edit Volume Ctrl + Shift + K 
Track EQ Ctrl + Shift + F 
Track information... Alt + I 
MIDI Controllers/VST Autom. Ctrl + Alt + A 
Track Freeze Alt + Shift + F 
Unfreeze Track Alt + Shift + U 
Activate next track Alt + Arrow down 
Activate previous track Alt + Up arrow 
Edit Pan Ctrl + Shift + P 

 

Object menu 
Cutting objects 
Duplicate and move Ctrl + D 
Separate with alternative crossfade Shift + T 
Splitting objects T 
Trim objects Ctrl + T 
Heal objects Ctrl + Alt + T 
Gluing objects Ctrl + Alt + G 
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Move/edit objects/crossfade 
Object step size 1 

(Left) object to left Ctrl + 1 
Right object to left Alt + 1 
(Left) object to right Ctrl + 2 
Right object to right Alt + 2 
Move object(s) left Ctrl + Alt + 1 
Move object(s) right Ctrl + Alt + 2 
Object start to left Ctrl + 3 
Object start to right Ctrl + 4 
Object end to left Alt + 3 
Object end to right Alt + 4 
Move crossfade left Ctrl + Alt + 3 
Move crossfade right Ctrl + Alt + 4 
Object start offset to left Ctrl + 5 
Object start offset to right Ctrl + 6 
Object end offset to left Alt + 5 
Object end offset to right Alt + 6 
Increase left volume Ctrl + 8 

Reduce left volume Ctrl + 7 
Increase right volume Alt + 8 
Reduce right volume Alt + 7 
Increase volume Ctrl + Alt + 8 
Reduce volume Ctrl + Alt + 7 
(Left) object content to left Ctrl + 9 
(Left) object content to right Ctrl + 0 
Right object content to left Alt + 9 
Right object content to right Alt + 0 
Object(s) content to the left Ctrl + Alt + 9 
Move object(s) content right Ctrl + Alt + 0 

Object step size 2 

(Left) object to left Ctrl + Shift + 1 
Right object to left Alt + Shift + 1 
(Left) object to right Ctrl + Shift + 2 
Right object to right Alt + Shift + 2 
Move object(s) left Ctrl + Alt + Shift + 1 
Move object(s) right Ctrl + Alt + Shift + 2 
Object start to left Ctrl + Shift + 3 
Object start to right Ctrl + Shift + 4 
Object end to left Alt + Shift + 3 
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Object end to right Alt + Shift + 4 
Move crossfade left Ctrl + Alt + Shift + 3 

Move crossfade right Ctrl + Alt + Shift + 4 

Object start offset to left Ctrl + Shift + 5 
Object start offset to right Ctrl + Shift + 6 
Object end offset to left Alt + Shift + 5 
Object end offset to right Alt + Shift + 6 
Increase left volume Ctrl + Shift + 8 
Reduce left volume Ctrl + Shift + 7 
Increase right volume Alt + Shift + 8 
Reduce right volume Alt + Shift + 7 
Increase volume Ctrl + Alt + Shift + 8 
Reduce volume Ctrl + Alt + Shift + 7 
(Left) object content to left Ctrl + Shift + 9 
(Left) object content to right Ctrl + Shift + 0 
Right object content to left Alt + Shift + 9 
Right object content to right Alt + Shift + 0 
Object(s) content to the left Ctrl + Alt + Shift + 9 
Move object(s) content right Ctrl + Alt + Shift + 0 
Object to play cursor position Ctrl + Alt + P 
Object to original time position Ctrl + Alt + O 
Arranging objects Ctrl + Alt + Shift + A 
Mute objects Ctrl + M 
Creating looped objects Ctrl + L 

 

Select objects 
Selecting all objects Ctrl + A 
Unselect all objects Ctrl + Shift + A 
Select next object > / Ctrl + Alt +W 
Select previous object < / Ctrl + Alt + Q 
Object lasso Ctrl + Alt + L 
Create group Ctrl + G 
Ungroup Ctrl + U 
Object name Ctrl + N 
Object editor Ctrl + O 
Object manager Ctrl + Shift + O 
Take manager Ctrl + Alt + Shift + T 
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Play 
Play / Play loop Space 
Play with preload Shift + Space bar 
Play with Preload Shift + P 
Only play selected objects Ctrl + Space 

 

Play cut 
Play to cut start F5 
Play from cut start F6 
Play to cut end F7 
Play from cut end F8 
Play over cut F4 
Play upper audio material Alt + Shift + Space 

Play lower audio material Ctrl + Alt + Spacebar 

Stop and jump to current position Num , 
Playback parameters P 

 

Playback mode 
Auto scroll Scroll 
Soft autoscroll Shift + Scroll 
Scrubbing active Alt + Shift + Cursor down 

Scrub left Alt + Shift + Cursor left 

Scrub right Alt + Shift + Cursor right 

Record R 
Record options… Shift + R 
Input monitoring Alt + Shift + M 

 

Move play cursor 
To beginning Home 
To end End 
Left move in page mode Cursor left 
Left move in scroll mode Alt + Cursor left 
Right move in page mode Cursor right 
Right move in scroll mode Alt + Cursor right 

Object border left Ctrl + Q 
Object edge right Ctrl + W 
Marker left F2/Alt + Q 
Marker right F3/Alt + W 
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Real time effects 
Elastic Audio  Ctrl + Shift + E 
 

CD/DVD menu 
Set track Ctrl + Alt + I 
Remove all indices Ctrl + Alt + Shift + I 
CD track options Ctrl + Alt + Shift + D 

 

View menu 
Managers 
File Browser Ctrl + Shift + B 
Object manager Ctrl + Shift + O 
Track Manager Ctrl + Shift + S 
Marker manager Ctrl + Alt + Shift + M 
Range manager Ctrl + Alt + Shift + B 
Source list manager Ctrl + Alt + Shift + S 
Marker list input Ctrl + Shift + L 
Take Manager Ctrl + Alt + Shift + T 

 

 

Clips 
A clip Shift + B 
Three clips B 
Activate next clip Page down 
Activate previous clip Page up 
Show grid ´ 
Snap active Ctrl + ´ 
Snap / Grid Setup... Ctrl + Shift + ´, I 
Define VIP display... Shift + Tab 
Toggle between mode 1 / 2 Tab 

 

Save position and zoom level 
1 Ctrl + NumPad 1 
2 Ctrl + NumPad 2 
3 Ctrl + NumPad 3 

 

Save zoom level 
1 Ctrl + NumPad 4 
2 Ctrl + NumPad 5 
3 Ctrl + NumPad 6 
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Get position and zoom level 
1 Number block "1" 
2 Number block "2" 
3 Number block "3" 

 

Get  zoom level 
1 Number block "4" 
2 Number block "5" 
3 Number block "6" 

 

Horizontal 
Half section left Ctrl + Alt + Cursor left 
Half section right Ctrl + Alt + Cursor right 
Clip to play cursor/last stop position Ctrl + Alt + , 
Zoom in Cursor up, Ctrl+ Cursor right 
Reduce range Cursor down, Ctrl+ Cursor left 
Show all Ctrl + Alt + Cursor up 
Zoom to range Ctrl + Alt + Cursor down 

 

Vertical 
Half section up Shift + Cursor up 
Half section down Shift + Cursor down 

Zoom into waveform Ctrl + Cursor up 
Zoom out of waveform Ctrl + Cursor down 

 

Window 
Tile horizontal Return (Enter) 
Restore Shift + Return 
Mixer M 
Time display Ctrl + Shift + Z 
Visualization Ctrl + Alt + Shift + V 
Transport console Ctrl + Shift + T 
Close all windows Ctrl + H 
 
 

Help menu 
Help F1  
Context help Shift + F1 
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Mouse 
Center click Start/stop play 
Wheel Horizontal scrolling 

Shift + wheel  Fine tune active 
buttons/faders/wave zooming 

+ Ctrl Horizontal zooming 

+ Alt Vertical zooming 

+ Ctrl + Alt Horizontal and vertical zooming 

+ Ctrl + Shift Vertical scrolling in VIP (tracks) 
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Signal Flow 
Record 
During recording the record signal is routed through the ASIO buffer (ASIO only) and then 
recorded on the hard drive. Recording in Samplitude is designed in such a manner that it is 
actually not a real-time process. The input buffers coming from the sound card are 
collected in the buffer and passed on to the file system as larger blocks to be saved on the 
hard disk. Latencies are not important and the procedure is quite safe. 

 

Playback 
During playback, all files are read from the hard drive, and they pass through the track 
speed buffer and finally the effect sections. This not only ensures the allocation of effects, 
but also setting of the volume and panorama as well as buses and outputs. The signals are 
processed in packages at the size of the VIP buffer and are finally reproduced by the sound 
card via the ASIO buffer (ASIO only). 
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Signal flow with monitoring 
For all other models, three signal flows occur simultaneously: playback of the recorded 
tracks, recording of tracks to be recorded, and monitoring of the signals of the input. 

Samplitude is designed to function like the sync head of an analog tape machine. Temporal 
offset of the individual signal currents is compensated automatically; the playback of the 
signal is drawn out by the latency of the effects and the buffer. This guarantees that the 
playback signal is not delayed vis-a-vis the recording and input signals. 
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Hardware monitoring 
Audio monitoring via the sound card in use or via external mixing hardware. With MME 
drivers, this is the only monitoring type possible. 
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Software monitoring 
Audio monitoring that includes the set recording track levels does not support effects. This 
monitoring option is only available when using ASIO drivers. 

Whether track effects in the recording track are audible or not during software monitoring 
depends on whether the "Hybrid Engine" is activated/deactivated. 

 For more information about the Hybrid Engine, please also read the section "System 
options -> Monitoring settings (view page 27)". 

ASIO software monitoring is essential when working with VST instruments. We recommend 
activating the "Hybrid Engine" for the lowest possible delay times. 

 

 



 

4 2 6  G L O S S A R Y   

Glossary 
 

A 
Active section 
If you wish to use zoom commands with the position buttons or the menu commands 
(position bar) on a section, it's necessary to specify the section beforehand for which the 
corresponding positioning is required. This happens by clicking on the right or lower scroll 
bars of the section. 

Detailed information about this is available under: 
"View -> Sections (view page 811)" 
Edit menu "Range" > Split Range (view page 522)" 

 

Audio markers 
Markers in wave projects are saved in the audio file (*.wav) as audio markers and are 
available in this form in other applications as well. Audio markers are coupled directly with 
the audio material and visible along the upper edge of an audio object. The purpose of 
audio markers is to mark positions within the audio material so that the selections remain 
independent of their placement within the virtual project. 

Audio markers may also be made visible in the display options ("Shift + Tab") in the 
"Objects" area by marking "Audio markers" with a check. 

The markers displayed in a virtual project's object are identical to the markers in the 
associated wave project. If you set new project markers in a wave project (this happens 
automatically while recording a take), then all audio markers in all associated objects of the 
virtual project will be visible at the same position in the audio material. 

Note: All time information for the audio marker relates to time positions in the audio 
material, and not to positions in the virtual project. 

 

Automation 
Automation can be used to change the envelope of certain parameters in Samplitude such 
as panorama, volume, surround and AUX parameters, MIDI controllers, and VST 
parameters. Changes can be displayed with the help of an automation curve. 

There is a separate mouse mode available for editing automation curves. 

 

AUX bus 
An AUX bus is a track featuring all the abilities of a normal track, i.e.  it can include track 
effects, and panorama and level can be automated. It has one input and one output. The 
most important difference is that the audio signal is diverted to the bus of any track with a 
lower track number than the AUX bus. This is done via the AUX send faders in the mixer. 

AUX buses are typically used for effects like reverb or echo, which may be equally required 
for various tracks, but in different amounts. Objects may  also be routed to AUX buses. 
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C 
Clip 
Clip for audio files (Wave projects) 
The clip is a buffer where samples from wave projects can be copied into or from which 
you can paste samples into wave projects. The content of the clip can also be mixed with 
the data of a wave project. The clip always assumes the properties of the project where the 
data originated (bitmap resolution, sample rate, and mono, LR or stereo mode). The clip is 
presented on the screen by a window with Clip in the title. 

The clip window is normally hidden; however, you can make it visible with the command 
"View > > Window > Iconize all Wave projects". Otherwise, the clip is a project like any 
other, i. e. you can play it, edit it, and save it with another name. 

 

VirtClip for virtual projects 
While the clip is responsible for wave projects, the data from virtual projects (i.e. objects in 
the virtual project) is buffered in the VirtClip (virtual clip). The clip window is normally hidden; 
however, you can make it visible with the command "View > > Window > Iconize all Wave 
projects". 

VirtClips are used as a location to store objects that were cut or copied out of a VIP 
window. Technically speaking the VirtClip is a special VIP window. It can therefore be 
edited like a virtual project. The content of the VirtClip can also be dragged onto any VIP 
window. 

The size and track numbers of the VirtClip correspond with the range copied or cut from 
the original VIP window. If this is only a single object, the VirtClip will only consist of one 
track with a single object. However, if a range spanning over five tracks is cut out or 
copied, the VirtClip also contains five tracks with several objects. 

You can easily exchange audio material between two windows with the help of the VirtClip. 

Context menu 
Nearly all parts of a VIP and the mixer include a context menu that is opened via the right 
mouse button. It is called a context menu because different menus appear that are always 
adapted to the current context, i.e. depending on the VIP or mixer area that is clicked. 

 

Crossfade 
Crossfading two objects on one track within the Virtual Project (VIP). A standard crossfade 
can be created automatically when cutting to avoid clicking ("Auto crossfade" mode). 
Crossfades can also be edited in Samplitude in detail with the crossfade editor. 

 

D 
Destructive editing 
In this mode, wave projects are edited directly on the hard drive. This means that changes 
to the audio material which occur acoustically and visually in the project window are also 
included in the audio file. The file does not have to be saved after editing, since editing of 
the audio data can be performed directly on the hard drive. Of course, undo steps are also 
available, but these are only available for as long as the file is open. After that the changes 
are permanent! 
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Note: Destructive editing can be used in virtual projects if offline effects are applied to 
selected objects or when working with wave editing in "Destructive" mode. 

 

F 
Fade 
An audio transition. These may be fade-ins (volume increase) or fade-outs (volume 
decrease). You can also fade between objects in the VIP (crossfade). 

 

G 
Grid/marker bar 
The grid/marker bar is located above the first visible track. This is divided into two halves. 

Marker bar/upper half: Markers may be placed in this section. 
Left mouse click: Sets the play cursor. 

Right mouse click: Accesses the context menu with entries for setting/getting the marker, 
etc. 

Grid bar/lower half: The grid bar displays the project time in relation to the selected 
measurement unit. You can also select ranges if this option is not directly available in the 
tracks via the selected mouse mode (e.g. "Object/curve" mode). 

Left mouse click: Sets the play cursor. 

Left mouse click and drag: Opens a new range. 

Right mouse click: Context menu including grid and raster entries. 

 

H 
Handles 
Handles are the five little rectangles that appear on the outline of a selected object. 

The length handles are on the bottom left and right corners of the object. These may be 
used to adjust the length of the object. 

Fade handles: Located on the top right and top left. These can be used to softly fade an 
object in or out. 

Volume handles: These are located in the center. Use these handles to adjust the track 
volume. 

 

Hybrid Engine and economy tracks 
Very small audio buffers ("Low latency" mode) increase the CPU strain of the playback 
engine. For optimal use of the PC resources, we recommend using the mixer tracks in 
"Low latency" mode only. This includes: 

 Monitor tracks 
 Tracks with VSTis 
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Tracks that play hard disk content (MIDI or audio files) may be taken out of "Low latency" 
mode in the Hybrid Engine by assigning the "Economy" property to them. These tracks will 
then use the play engine's buffer (VIP buffer size). 

 

L 
Latency 
Audio latency and response latency are important when working with audio applications. 

Audio latency is the delay of audio data when being processed through an audio function 
unit (effect plug-ins, DAW audio engines, digital mixers, hardware effect devices, DA/DA 
converters, etc.). The entire audio latency is made up of the sum of the latency of the 
sound card (ASIO latency) and the latency of the effects used in monitoring tracks and the 
master. When monitoring, this latency is disruptive even at 5 ms. 

Response latency is the delay between activation of a sound producing or sound modifying 
control element and the audible change or generation of the sound. The response latency 
is made up of the sum or the output latency of the sound card, the latency of used effects, 
the latency of the play engine, and possibly the latency of the MIDI input/graphical user 
interface latency of the PC operating system.  

When using MIDI-controlled synthesizers (VSTi's), the response latency is similarly critical, 
much like audio latency, in monitoring (disruptive after 5 ms). 

When playing files with the play engine, response latencies created by effects and the play 
engine itself are much less problematic (disruptive after approx. 250 ms). 

The internal effects show the latency caused by the effect in the lower control element bar. 
The latency of the sound card in conjunction with the driver being used is displayed in 
"System/audio options ("Y"). The overall latency of all effects is shown in the status bar 
once playback begins. 

 

Latency comparison 
When using effects which cause latency, you must make sure that there is no time delay 
with parallel tracks, objects, or AUX channels. Depending on the location where effects 
which cause latency are integrated, various latency comparison methods may be applied. 
When using latency-causing effects in live input tracks (monitoring), all other tracks must be 
compensated.  

When using effects which cause latency in tracks that are playing content on the hard disk, 
latency may be balanced using a read offset. The other tracks do not have to be delayed in 
this case. 

When using internal effects in the object and in the master under MME, a real-time latency 
balance method (intelligent audio stream preview management) is applied. 

The advantages of this process: 

 When linking the latency-filled effects or increasing latencies by modifying the latency-
relevant parameters, passages containing silence will not be created.  
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 When unlinking the latency-filled effects or the reduction of latencies by modifying the 
latency-relevant parameters, errors/skipping will not occur. 

 Synchronization always remains the same (real-time latency balance – playback not 
necessary) 

 Time changing parameters (timestretching or resampling) may also be used without 
causing any synchronization problems. 

A delay of other audio streams is not necessary. 

 

Level fader 
Volume control 

 

Lock 
This button sets a lock on individual objects or all objects of a track. 

If the lock button is active, then individual objects or all objects on a track may be locked in 
the track header. 

Other parameters of locked objects depend on the "Lock definitions" option in the "Object" 
menu. 

 

M 
Markers 
Markers act as reminders for position points. They are visible as named orange bars along 
a special line at the top edge of a project. Markers may be placed during playback as well 
as during recording. 

 

Menu 
Menus are located in the Samplitude main window, directly below the title bar. Each of 
these menu entries may be assigned a keyboard shortcut. 

They may also appear in other program parts or dialogs. 

 

MIDI object 
MIDI objects in Samplitude are edited like wave objects. 

Object-oriented editing for audio allows a VIP object to be used for playback instructions of 
audio files. MIDI objects are structured according to this concept: they refer to a recorded 
or imported MIDI file and may be copied, split, and trimmed. They have fade handles as 
well as a middle volume handle. 

MIDI objects may also be edited with real-time effects in the object editor. Samplitude 
displays a different type of object editor specially adapted to MIDI objects for this purpose. 

 

Monitoring 
The signal being recorded is played back simultaneously via the output devices. Different 
modes are available depending on the driver model used and the monitoring mode. 
Monitoring has nothing to do with playback of the recorded signal. Only the signal at the 
input is involved. 
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Mouse mode 
Mouse modes add specially adapted functions to the mouse. 

 

O 
Object editor 
The object editor enables you to edit the properties of any audio object exactly. For 
example, the length of the object may be entered numerically or the fade characteristics 
may be determined here. 

Real-time effects, EQ, and dynamics editing may be applied to the object without having to 
access track effects in the mixer. The selected processing does not depend on any 
following changes to the object position. 

 

Object-oriented 
Object-oriented work describes a method that makes it possible to apply various changes 
to the audio material connected with the object virtually, i.e. without affecting the actual 
audio material (data on the hard drive). Samplitude features an independent audio engine 
behind every object, which enables virtual editing of all DSP functions on the object level. 

 

Objects 
In virtual projects, the audio data is represented by rectangles (referred to as "objects") on 
multiple tracks. An object is a representation of the sample or a segment marked within the 
sample. 

In addition, each object has certain attributes which may be modified using Samplitude's 
object editor. The rectangle features several handles which may be used to modify the 
object's start time, length, and volume attributes. 

Objects that overlap in one VIP track may be faded into one another. For exact crossfade 
settings, try the crossfade editor. 

The lock symbol positioned on the lower edge of each object may be used to protect a 
single object against accidental modification. The attributes to be protected can be 
selected in "Lock definitions". 

 

P 
Play cursor 
The play cursor or the position line is the vertical line that moves during playback to display 
the current position in the audio material. 

The starting position of the play cursor is moved by clicking in the project. The mouse must 
be in "Universal" or "Range" mode. If a range is opened, it will be cleared by this action. 

 

R 
Range 
A range can be stretched or selected in projects using the mouse. As soon as a range is 
selected, pressing the spacebar will play it back. A range is defined by its start and end 
(horizontal) as well as by its upper and lower edges (vertical). 
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The range specifies sections where certain operations are executed (e.g. cutting, inserting, 
normalizing, fade in/out, move up, calculate effects, and delete). 

The range is also used to define loops that are included during project playback. 

 

Routing 
Re-route or allocate internally 

 

S 
Scroll bars 
The scroll bars are displayed on the lower and right edges of the arranger window. These 
bars may be used to navigate the project or to enlarge or reduce the window section.  

 

Scrub 
Scrubbing refers to "searching" through the audio material at different speeds to locate a 
certain position "acoustically".  

In this case, Samplitude behaves like the editing function of a tape player. The motor is 
switched off, but the tape remains at the sound head. Turning the tape reels by hand can 
slowly move the tape past the sound head to make it easier to find specific positions on the 
tape. 

By varying the playback speed, it's possible to quickly approach a position, but also to 
arrive at the exact position at a reduced speed. 

 

Section 
"Section" refers to the visible part of a project in the project window. Which section of the 
project this is depends on the position of the section and the zoom. 

 

There are many commands for moving (scrolling) the visible clip and adjusting its size 
(zooming). These commands may be opened via the "View" menu, via the position bar, and 
via the shortcut keys. 
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Up to three different sections can be displayed in a project at any one time. This way, the 
entire project can be displayed in one section, while a smaller part where you are working 
is shown in a different section. 

 

Setup button in the VIP 
The 8 buttons at the lower left edge of a virtual project may store 4 setups (S1....S4, incl. 
zoom level, display position, and display mode) and 4 zoom levels (Z1...Z4). 

To save, click the button while holding the "Shift" key. This allows you to quickly jump 
between certain positions and zoom levels without manually zooming in and out. 

Right clicking a button opens a context menu containing options for loading. 

 

Status display 
The status bar is located at the bottom part of the Samplitude window. For longer actions 
or calculations a bar is displayed whose width shows the current state of operation. 

 

Action instructions and explanations also appear. 

The status bar can also be hidden via the "View > Toolbars > Status bar" menu item. 

 

Submix bus 
A  submix bus is a track featuring all the abilities of a normal track, i.e.  it can include track 
effects, and panorama and level can be automated. It has one input and one output. The 
important difference is that you can route the output signal of every track with a lower track 
number than the submix bus to this bus (instead of routing to the master or an output 
device). 

AUX buses are typically used for effects such as reverb or echo, which may be equally 
required for various tracks, but in different amounts. In Samplitude, objects may be routed 
to AUX buses as well. 

 

Surround AUX bus 
AUX buses are usually used to apply send effects. A Surround AUX bus has the same 
function, but with the option to integrate Surround effects. It may be sent from a normal 
track (see stereo and mono signal processing in Surround projects) or from a Surround 
bus. The AUX bus itself may also feed a Surround bus (if the track number is higher). 

 

Surround sound in Samplitude 
Surround master 
From a technical viewpoint, the Surround master is a Surround bus of a Surround project 
that has the additional property of assigning the audio devices, but cannot feed a Surround 
bus itself. 

 



 

4 3 4  G L O S S A R Y   

Surround bus 
A Surround bus is required if Surround effects are to be applied. Tracks that include 
Surround effects therefore have to be routed to a Surround bus where the appropriate 
parameters may be set. 

All tracks routed to a Surround bus have the Surround panorama module instead of the 
normal panorama fader for setting the output level of the track. As soon as a Surround bus 
is available, the output signal of each individual object may also be routed to this bus and 
positioned in the Surround panorama independent of the track panorama settings. 

From a technical viewpoint, the Surround master is also a Surround bus in a Surround 
project, since Surround channels may also be assigned to the audio devices and it cannot 
be routed further to a Surround bus. 

 
System settings 
Settings that are not project-specific are described as system settings. These include 
settings that apply to the entire project. 

 

T 
Tempo markers 
A tempo marker indicates a tempo change at a certain project position. 

 

Time input field 
All fields that represent a time position can act as an input field by double clicking with the 
mouse. The time units may be changed by clicking on the right section of the field. 

 

Title bar 
The title bar is located at the top of the window. It contains the name of the application and 
the project. 

 

To reposition the window, simply click the title bar and move it as desired. You can also 
move around dialog boxes by moving the title bar. 

 

Toolbar 
Toolbars contain the tools that apply certain commands by clicking. These are located 
above and below the project window. 

 

Tooltips 
Tooltips provide additional information about the function of a certain control element. Hold 
the mouse pointer over an element for a few seconds, and more information will be 
displayed. Text featuring the name or a short description of the element will appear. 
Keyboard shortcuts and operating instructions are often also included. 

 

Track 
The audio track. Tracks can contain audio and MIDI objects. Automation curves are also 
represented in the track. 
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Track header 
The track header is the front section of a VIP track. This contains various functions 
including mixer elements, buttons for loading plug-ins, and other track parameters. 

 

Track header with activated mute 

 
 

V 
VIP - virtual projects 
Virtual projects (VIP) are the top level of audio editing in Samplitude. In virtual projects, 
objects may arranged to create complex arrangements. All editing steps carried out in the 
arranger window are applied non-destructively. This allows you to select the proper cut 
position, cut length, volume level, effect setting, etc. without losing the original audio 
material or altering it. 

The actual audio data is represented by objects on the various tracks. An object is a 
representation of the sample or a segment marked within the range. In other words, the 
object refers to the audio data. 

A virtual project has two display modes. Use the "Tab" key to toggle between the two 
modes. The shortcut "Shift + Tab" may be used to open the editor for defining display 
properties. 
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VirtClip 
see "Clip (view page 426)" 

 

Visualization 
The visualization feature displays the audio material visually in different ways. 

 

W 
Wave editing 
Non-destructive wave editing lets you take advantage of combining direct and virtual 
editing of audio material (wave projects), just like with VIP projects. 

 

Wave projects 

 

A wave project contains audio data. Objects in the VIP refer to this audio data. 

If you use Samplitude as recording/mastering DAW you usually don't have to edit wave 
projects as all editing options can be performed quicker and safer in the virtual project. For 
using Samplitude as a wave editor, refer to "Working in the project window -> Samplitude 
as a wave editor (view page 108)". 

The windows of the wave projects used by VIP objects are usually hidden. These may be 
accessed via "Edit wave projects" in the "Object" menu or by pressing "Shift" and double 
clicking an object used by wave project. 

All loaded wave projects may be made visible as icons via the command "View > Window 
> Iconise All Wave Projects". To hide them again, go to "View > Window > Hide All Wave 
Projects". 

The name of the wave project, sample length, and the resulting memory requirement may 
be entered in the title bar of the wave window. To activate a wave project you have to click 
into the corresponding window. Samplitude can manage an infinite number of wave 
projects on the screen. 

 

Work area 
Work areas are for adapting the program to certain work styles, i.e. they may be changed, 
renamed, and created. The work area is opened via the "Workspace bar". Work areas are 
available as wave editing or virtual projects. 
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Z 
Zoom 
Use the zoom functions to display a larger or smaller part of the virtual project in the 
window. At higher zoom levels, the display is more detailed. Automation curves can be 
edited more easily when a higher zoom level is selected. 

To view larger projects at their full length, you have to zoom out of the VIP window, making 
the display less detailed, but displaying more content.  

Features a series of functions for working with various zoom levels Samplitude. 
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Menu reference 
Extensive information on the individual menu points of Samplitude can be found in the 
following sections. 

The menus in Samplitude may also be individually customized, i. e. menu items may be 
hidden or shown.  If menu items are described in the following sections that are not 
present in your menus, then they are probably only hidden. To display them again, activate 
them in the menu settings via "File -> Program settings > Edit keyboard shortcuts and 
menus (view page 488)". 
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File Menu 
This allows you to apply comprehensive settings for creating, managing, loading, and 
saving projects. 

 

New Virtual Project (VIP) 

 

Shortcut:  E 

A new Virtual Project is created in the arranger with the specified number of tracks: 

Name: Enter the name for the new project. 

File path: Select the folder for saving the project. 

Create new project subdirectory: A subdirectory featuring the name of the project is 
automatically created in the directory selected in "File path". 

Project template: Choose between previously selected project templates in this list field.  
These presets contain project settings such as track number, device assignments, etc. 
Create project templates with "File -> Save project as template (view page 449)" 

Mixer setup: Select a preset mixer setup here. Mixer setups define the number and kind of 
tracks/buses as well as the routing of inputs/outputs and effects. 

To create a Surround project, define the Surround setup first. The list field located below, 
i.e. "Surround setup", is activated for selecting a number of Surround formats. 

Project options: All settings adjustments made here are valid for every newly-created 
virtual project. They will be saved in a separate VIP(Templates\Template.VIP). The 
Template. VIP file may also be edited directly to define additional settings for all projects: 
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 Record arming setting of the first track 
 Some mixer setup settings 
 Playback mode 
 Effect sequence on the tracks and mixer 
 Grid offsets 

Please also read "System settings -> Project options -> General (view page 33)" for more 
details about project options. 

Track number: The start track count of the virtual project is defined here. Use "Track -> 
Insert new tracks... (view page 531)" to add tracks at any time. 

Sample rate: Defines the sample rate of the virtual project. 

Preset project length: The initial project length may be set as a preset here. This setting 
will be automatically adjusted during loading or recording and changes during zoom 
operations. 

Note: VIP projects may only be up to 168 hours in length.  

There are no more length restrictions on WAV files with NTSF. Recordings are written to a 
large RIFF64 file. If under 2 GB, it will be compatible with normal wave files. FAT 32 
continues to split these into W01, W02, etc.. 

 

Open Project 
You may open various file types here and load them into Samplitude. To load audio files, 
use the command "Load/import -> Load audio file". 

 

Virtual Project (*.VIP) 
Use this menu command to load a multi-track project as an arrangement. 

Shortcut:  O 

 

RAM Wave (*.RAP) 
RAM Wave Projects contain audio data in an audio format unique to Samplitude that is 
loaded into the RAM memory. Additional information for display of the audio data, marker 
positions, etc. is contained by this data. 

 

HD Wave (*.HDP) 
HD Wave Projects contain audio files that are loaded directly from the hard disk. Additional 
information for display of the audio data, marker positions, etc. is contained in them. The 
files use WAV audio format. 

Shortcut:  Shift + L 
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Note: If a VIP is active, the loaded wave projects are loaded immediately into the VIP as 
objects. The range of the active track displays the position. "CD arrangement" mode is the 
exception. In this case, the objects are displayed below one another independent of the 
range. The distance between the objects corresponds to the pause time (CD/DVD menu -> 
Set start pause time (view page 792)). 

 

Import AAF/OMF 

 

TheAAF import transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Object pan 
 Object volume automation 
 Object pan automation 
 Track names 
 Track Volume 
 Track Pan 
 Track Volume Automation 
 Track Pan Automation 
 VIP markers 
 Timecode offset 
 Timecode format (24, 25, 30 fps) 
 Processing timestamps in audio files 
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TheOMF import transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Track names 

Note: When importing AAF/OMF files video files will also be imported. These can only be 
played when the program 'understands' the format and when the corresponding codecs 
are available on the system. 

Find the AAF/OMF file you want to import using the import dialog. In a further dialog you 
can choose the track panorama when importing, so that the uneven track numbers in the 
panorama are placed on the left and the even on the right. 

 
 

Object (*.OBJ) 
An object contain playback instructions for the underlying wave project. The object 
contains information about the time position as well as the editing steps involved. Objects 
are used in virtual projects. 

 

Edit List (*.EDL) 
The EDL helps exchange projects with other sequencer programs. A virtual project that 
resembles the EDL is created. The list is a text file that contains information about the wave 
files used, video files, object borders, object volumes, markers, and volume & panorama 
automation. 
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Edit list (*.aaf, *.omf) – optional 

 

TheAAF import transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Object pan 
 Object volume automation 
 Object pan automation 
 Track names 
 Track Volume 
 Track Pan 
 Track Volume Automation 
 Track Pan Automation 
 VIP markers 
 Timecode offset 
 Timecode format (24, 25, 30 fps) 
 Processing timestamps in audio files 

TheOMF import transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Track names 
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Note: When importing AAF/OMF files video files will also be imported. These can only be 
played when the program 'understands' the format and when the corresponding codecs 
are available on the system. 

Find the AAF/OMF file you want to import using the import dialog. In a further dialog you 
can choose the track panorama when importing, so that the uneven track numbers in the 
panorama are placed on the left and the even on the right. 

 
 

Table of Content (*.TOC) 
With the table of contents (toc) of an audio CD the information about the contents of a CD 
is saved.   

 

Session (*.SAM) 
This command loads a Samplitude session. This opens all projects and arranges the 
windows as they were distributed on the screen when the session was saved. 

 

Load/Import 
Load Audio File 
This opens a dialog for loading audio files.  

The following formats are supported and read directly by Samplitude: 

Wave files (.wav), MP3/MPEG files (.mp3, .mpg, .mus), QuickTime files (.aif), MS Audio files 
(.asf, .wma), Ogg Vorbis (.ogg), FLAC (.flac), MIDI files (.mid), video files (.avi), and playlists 
(.m3u, .cue). 

Note: Open all other formats with the import audio function "Import audio" to convert these 
to wave files for local storage on the hard drive. 

Several files may also be loaded simultaneously. To do this, expand the selection via "Ctrl + 
click" (just like with Windows Explorer), or select a range of files via "Shift + click". 

If a virtual project is opened, new objects that refer to loaded audio files are created 
simultaneously. If an area has been selected in the VIP, the files are positioned at the 
beginning of the range or with a separating pause of 2 sec. after the last object. The length 
of the pause may be adjusted in the "CD/DVD" menu via "Set pause index". 

Each audio file may be previewed before it is loaded. 
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Attention: The monitoring function uses the Windows Multimedia MME standard output 
device. Many audio cards shut down the Windows MME system when ASIO drivers are 
used, which means problems may occur during monitoring. For this reason, the preview 
function is deactivated by default when ASIO drivers are used. 

The "Load audio file" option activates the preview function again at any time. 

The button at the bottom right of the dialog opens the options for loading audio files (view 
page 445). 

 

Options for loading audio files 

 

Use selection order of file dialog: If this option is activated, Samplitude remembers the 
sequence in which the files were selected and then sorts them accordingly. 

Load files in alphabetical order: With this option activated, Samplitude sorts the selected 
files alphabetically in the VIP. 

Use sync positions: Broadcast wave files containing timestamps are positioned precisely 
at this position in the VIP. 

Load all files to selected track: The selected files are loaded successively in one of the 
selected tracks. 

Load files to different tracks: The files are now sorted in vertical order from the selected 
track to the next one. If necessary, an additional track is added. 

Group loaded objects: All loaded files are grouped. They can be ungrouped anytime. 

Other (only present for "Load audio file") 
File preview with Windows Media Player Control: Files may be previewed via the 
Windows Media Player. 

File management 
Copy audio files to project folder: Files are copied into the corresponding project folder 
automatically. 
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Convert compressed files to wave format: Compressed audio formats such as MP3 
may also be loaded and played directly by Samplitude. This requires increased CPU 
calculation. Activate this option to convert files like this into an uncompressed wave format. 

 

Import Audio 

This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File -> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

This lets you import all supported file formats explicitly as Wave Projects.  

This is only necessary for importing file formats which can't be loaded by Samplitude using 
"Load audio file". 

In contrast to the "Load audio file" function, when importing audio files wave formats are 
converted and copied to the hard drive. You can also use the command if you want to 
work in a copy of the file within the project. 

Shortcut:  Ctrl + I 

Hint: You can increase the performance of your computer if you import compressed 
formats such as MP3 or WMA instead of loading them. It helps to avoid real time 
decompression 

Use the "Import raw data (dump)" to try importing damaged files that sound like white 
noise on playback. The header is usually damaged or missing. In this case you can enter "0 
bytes" as the header length in the following dialog. 

 
 

Import as Dump 
Imports a wave or MP3 project as raw audio data (PCM) in RAW format (Little Endian for 
PC, Big Endian for Amiga, Mac, Atari). 
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Load MIDI File 
This function loads a MIDI file. Detailed information about this topic is provided in "MIDI in 
Samplitude -> MIDI - record, import, edit -> Importing MIDI files (view page 242)". 

Keyboard shortcut:   Shift + M 

 

Load Video File 
This dialog helps load a video into the current project. After selecting a video, preview it or 
inspect its properties. If a check is placed next to "auto play", the selected video file will 
play automatically in the preview window. 

 

Before loading the video, you will be asked if you want to load the video's audio track into 
the project. This is positioned in the track underneath the video track. If the sample rate of 
the audio file deviates from the VIP's sample rate, then the sample rate may be adjusted. 
The following options are available for adjusting the sample rate: 

 Convert file: Samplitude creates a converted audio file in the VIP's sample rate. The file 
name will now also indicate the new sample rate.  

 Object resampling: If this option is active, Samplitude will resample the object. The 
quality of object resampling may be set under "System option -> Effects -> 
Resampling/bouncing (view page 483)". 

 Adjust VIP sample rate (existing objects are played back at incorrect speed) 
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 No change (file plays back at incorrect speed) 

 

Detailed information about displaying video objects is available in "Video setup (view page 
358)". 

 

Import Audio CD Track(s) 
This command imports the audio contents from a DVD into Samplitude (view page 777). 

 

Import Audio DVD 
This command imports the audio contents of a DVD into Samplitude (view page 780). 

Note: Importing the audio track(s) from a video DVD is not possible! 

 

Save Project 
The current disc project is saved with the name displayed in the project window. If you 
have not yet specified a name for your project, Samplitude will ask you to do so. 

Shortcut:  Ctrl + S 

 

Save Project as... 
A standard dialog will open, where you can specify the path and name of the project to be 
saved. If you would like to save wave projects and virtual projects under a new name and 
in a different location, the original file will remain untouched. Then you can continue 
working in the new project (automatic). 

Shortcut:  Shift + S 

 



 

F I L E  M E N U  4 4 9   

Save Project Copy... 
A dialog open to create a copy of the project, which may be saved under a different name. 
In this case, the date and time are added automatically to the project name. Of course, you 
can name the copy any way you like. Once saved you will be able to continue working on 
your original project. 

 

Save Project as Template... 
This option saves the current project as a project template. The template will save all 
project-based settings like grid form, track number, etc., but not the used objects or wave 
files. Templates may be loaded when creating new multi-track projects ("File -> New Virtual 
Project). 

 

Save project as EDL... 
The active virtual project will be saved as a list in the EDL text format. This edit list is a text 
file containing information about used wave files, video files, object borders, object 
volumes, markers, volumes & panorama curves. 

This option effectively lets you save Samplitude projects into an exchange format that 
allows a project to be incorporated into a different sequencer or video editing program. 
EDLs may be converted together with the audio files into other formats using a conversion 
program like EDL ConvertPro. 

 

Save Object... 
This function allows you to save a single object. This file contains all the data of the object 
editor like fades, effects, object names, etc.), but not the actual audio data. The wave 
project referenced by the object also has to be available if you want to reload the object.  

 

Save Session... 
A Samplitude session is a meta project that includes the file paths and window positions of 
all loaded projects upon saving. This is useful for starting to work again at the same 
position where you ended, without having to load various projects. 

If you save a session with the name "startup.sam" and place it into the directory with the 
program folder, Samplitude will load that session automatically the next time you start the 
program. 

 

Export Audio 
This menu point allows you to export projects in various formats. 

The export dialogs for each format are almost identical. 

1. Selection of path and file name. 
2. Format settings: This dialog features selection and settings options for the 

corresponding export format. 
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3. Export settings: Specify which area of the project should be exported here. Multiple 
files may be exported, provided their starting points have been specified with the 
placement of track markers or other markers. This way, an almost automatic export 
of individual files from within an arrangement is possible.  

Note: The audio data from HD wave projects may be further processed or imported 
directly as wave files from HD wave projects. The use of the "Export" function is only 
necessary when the data is to be copied. 

 

WAV 
Here you can export Wave files. 

Format settings: A dialog window featuring a list of all compression codecs appears here. 
Select the codec and compression rate you require. If you click the "Dithering" button, the 
dithering options dialog will open. Detailed information about this is available in "File > 
Program Preferences > Dithering Options (view page 498)". 

 

MP3... 
Exports the project as MPEG Layer 3 with the included encoder. By clicking on the format 
settings, a new window opens where encoder options can be defined. Set output format, 
encoder quality, padding mode, stereo coding, content options, VBR (variable bit rate) 
options, and MP3 ID editor labeling. 

 

MP3 with external encoder 

This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File -> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

Here you can choose an external Encoder, which your project will export as MPEG Layer 
3. Here, the format parameters, the audio stream as well as the new file name for the 
exported MP3 are transferred. 

 

MPEG... 
Exports the project as an MPEG file. These formats may also be set in the advanced 
settings dialog, which is opened via the button "Format settings". The options "stereo", 
"joint stereo", and "mono" are featured. 

 

Windows Media... 
Exports the project in Window Media Format. 

This format is an optimized audio/video format for the Internet from Microsoft™. This 
format also enables streaming playback of audio files over the Internet. Select a profile for 
the Windows Media file in the "format settings" dialog. Enter the track and artist names, 
copyright details, and descriptions. 
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Real Audio... 
Exports the project in Real Audio format (.RA). 

Real Audio is an audio format designed especially for Internet applications. This is 
especially useful for streaming audio. In format the settings, specify the bit rate of the 
transmission speed (modem, ISDN, etc.). Similarly, details on the content and copyright 
information may also be added. 

Content settings: Select presets for the type of audio or video material (only 
voice/background music, music, stereo music) here. 

Clip information: Enter author, video name, etc., which appear in the Real Player during 
playback here. 

Multi-rate file (Real Server): Streaming audio requires a server application that must be 
installed on the server and from which the audio for playback ("streamed") in real time. If 
you don't have this application, it will have to be downloaded. "Real Server" is a server 
application that enables streaming audio in Real Audio format. 

If the "Multi-rate file" option is activated, a multi-rate file can be created that includes 
several files in various bandwidths. Multi-rate files allow the selection of multiple target 
groups. 

 

AAC... 
Exports the project to an AAC file. You can also set the encoder settings in the advanced 
dialog, which is opened via the "Format settings" button. You can also set the quality and 
transport format (MPEG 4 or ADTS) here. AAC export uses the file extension *.m4a. 

 

FLAC... 
The FLAC format allows you to compress 16-bit or 24-bit files during export. The 
properties of the FLAC encoder may be accessed via the "Format settings" button. Set the 
compression degree, bit resolution, format, sample rate, and dithering here. 

 

OGG Vorbis... 
Exports the project in OGG Vorbis format. 

The "Format settings" button opens an additional dialog to select the desired bit rate. The 
scale of compression ranges from 46 kBit/s to 500 kBit/s (for MP3 from 32 kBit/s to 320 
kBit/s). In the stereo options, choose between "Stereo" and "Mono" and also select the 
"Variable bit rate" mode. 

 

AIFF... 
The project will be exported in AIFF format. In the advanced dialog, select the bit 
resolution, stereo format, sample rate, and quality level of sample rate adjustments. 
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AIFF File with QuickTime... 
Exports the project in AIFF format. In this case, QuickTime is used as the encoder. This 
format also enables streaming playback of audio and video files over the Internet. 

Like with Real Media exports, the corresponding video size, frame rate, and codec settings 
may be adjusted for "AIFF with QuickTime" export as well. This function requires the 
installation of QuickTime on your computer. 

The following export options are available: Format (linear PCM, A-Law 2:1, IMA 4:1, MACE 
3:1, MACE 6:1, QDesign Music 2, Quallcomm PureVoice™, µ-Law 2:1), channels (mono, 
stereo, quadrophonic, 5.0, 5.1 ), sample rate, sampling rate conversion quality as well as 
linear PCM settings in 8, 16, 24, 32 and 64-bit file format. 

 

Mono / Stereo Convert 
Stereo Wave -> 2 Mono 
This function saves both the left and right channels of a stereo wave file (file.wav) separately 
as a mono file (file_left.wav, file_right.wav). 

"Stereo to 2 Mono" may also be applied to objects in the VIP. Stereo objects to be split are 
replaced by two mono objects that are arranged one below the other and which feature 
panorama settings at the object level to the left or right. 

 

2 Mono -> Stereo Wave 
This combines two mono wave projects to one stereo wave project. 

After executing this command, a dialog opens displaying all loaded mono files. You can 
load additional files with "Load file". From the opened wave projects, select the right and 
left files with the "^" keys. With "<->" keys you can switch channels. After clicking "Link 
files", specify the name of the new file to be created in the project folder. 

Please note that only mono wave projects of the same word width and sample rate can be 
linked. The length of both projects are adapted to one another, the longer mono file sets 
the total length. 

 

LR Wave -> 2 Mono 
LR wave projects may be split into two independent mono projects using this function. 

 

LR Wave -> 1 Mono 
The active LR wave project is set to mono mode. In this case, the two channels are mixed 
together by adding the corresponding samples each at 100% and then splitting the sum in 
two in order to avoid overmodulation. This corresponds to sinking the level by 6 dB. 

 

2 Mono -> LR Wave 
This creates an LR wave project with two channels from two mono wave projects, in which 
case one mono wave project in panorama view is positioned to the left, and the other one 
to the right. Select both mono files with consecutive mouse clicks. In the following dialog 
you can decide to "Link". "Convert to stereo" creates a stereo wave file. 

 



 

F I L E  M E N U  4 5 3   

1 Mono -> LR Wave 
In this case, LR wave project with two identical channels is created from a mono wave 
project. The original sample is duplicated here. 

 

Save in format 
Use this function to save wave projects in various formats. 

This can be useful when, for example, RAM projects are to be converted into HD Wave 
Projects or LR Wave Projects (two mono samples linked to one another) are to be 
converted into Stereo Wave Projects. 

In "Area settings", select whether only the selected area or the entire wave project 
should be saved in the new format. 

Under "General options", select whether the maximum amplitude should be displayed or 
not and if the master effects should also be copied when the file is saved. 

The Dithering Options (view page 498) can also be adjusted here. 

In the "Format" section you can determine in what format the file should be saved 
(Wave,MP3, AIFF, Ogg Vorbis orFLAC). 

In the case of Wave, AIFF and FLAC projects you also have the options "Stereo", "left & 
right", "only left channel", "only right channel", "mono mixdown" and "Mono" and the 
selection/quality of the sample rate options open to you. 

By clicking on the format settings for MP3 format  a new window opens, where encoder 
options can be defined. Here you can set the Output format, Encoder quality, Padding-
mode, Content options, VBR (variable bit rate)options and tagging using the MP3 ID 
Editor. 

In the dialog for AIFF you can specify the bit resolution, stereo format, sample rate, and 
quality level of sample rate adjustments. 

 

Change Bit Resolution 
Select the desired word width/bit resolution of wave projects here. 

 

Working with the 32 Bit Float Format 
If you convert fixed comma wave projects into the floating comma format, the signal will 
remain a 16 or 24-bit signal and the quality will not be improved. This will only yield a result 
if you are applying destructive changes to the audio material as precise calculation is 
practically impossible after editing. 

You use overmodulation resistance and level-independent dynamics. The quantization hiss 
will not increase, even if you set very low levels. 

The downside is that twice the amount of hard disk space is required and only half the 
tracks are now playable simultaneously (depending on the CPU). 
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If you convert from 32-bit float to 16 or 24 bits, dithering occurs to reduce subjective 
quality loss. 

 

Working with 8 Bit Wave Projects 
A smaller word width may be useful when editing audio for multimedia applications, since 
these applications may use a resolution of 8 bits to save storage space. 

The downside of such a low bit resolution is that as the quality of the so-called SNR (signal-
to-noise ration) drops, and the quantization noise increases. This quantization noise is not 
consistent, but is modulated by the signal and may be unpleasant. 

The word width of the project is always indicated in the title bar of wave projects. To 
perform manifold destructive editing on an 8-bit project, you should convert it into 16 or 
32-bit float before editing. The created calculation precision will then occur in the 16-bit 
range, this being considerably smaller. After editing, convert the sample back to 8 bits. 

 

Export as Dump 

This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

Export a Wave or MP3 Project as raw audio data (PCM) in RAW format (Little Endian for 
PC, Big Endian for Amiga, Mac, Atari). 

 

32-bit float as 16-bit / 20-bit / 24-bit 

This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

Exports the (32-bit float) project as a wave file with 16 / 20 / 24-bit. This takes into account 
the Dithering options (view page 498). 

 



 

F I L E  M E N U  4 5 5   

Export to "MAGIX Video Pro X"... 
The following trackbouncing dialog opens for exporting to the external MAGIX program 
"Video Pro X". 

 

Select whether only the video objects should be transferred, whether an Audio downmix 
(stereo/Surround bounce) should be made, or if the Audio objects should be 
transferred individually. If the "Continue" button is pressed, a save dialog will appear. 

 

Export Video Sound... 
After successfully editing the video sound in Samplitude, you can write the sound back into 
the video file. You may replace the original sound of the video or create a new video file. 

Set the source file under "Video source". 

Replace audio in the original AVI file: This option carries out trackbouncing on the 
current VIP. This creates a temporary wave file which can then be integrated into the 
selected AVI file. It's necessary that the AVI contains an audio track of the same format 
(sample rate and bit resolution). 

Save a new AVI file to: This option applies trackbouncing to the current VIP. This creates 
a temporary wave file which may be copied with the selected AVI file into a new AVI file. 
This process contains the original AVI file. 

Note: If the lengths of the audio and video files differ from one another, a warning dialog 
opens. After the export, the longer component is cut off; an attempt to automatically 
synchronize the data is not carried out. If you receive this warning, try to resample the 
soundtrack to the correct length. 
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Export MIDI File... 

 

The particular file format may also be specified when exporting a MIDI file. One track 
corresponds to format 0, multiple tracks to format 1. In addition, the tempo map may 
also be exported, in which case the support point count per beat for tempo runs can be 
selected freely. 

The standard MIDI file (SMF) export always takes place in the current VIP-PPQ resolution. 
The markers are also exported. 

 

List Export 
A current marker list, object list, or track list for your project may be written into text file 
and stored in the project folder. 

 

Trackbouncing 
This command can be applied to compile a project, a sought range or selected objects, 
and tracks of a virtual multi-track project (VIP) into one audio file and save them under one 
name. Here, all realtime editing (cuts, crossfades, all mixer settings including mixer effects 
and DirectX plug-ins, volume and panorama curves, realtime effects in the Object Editor, 
etc.) can be integrated into the new project. 
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If you bounce into the 32-bit float format, overmodulation cannot occur. 

 

Normalize your project before bouncing using the master normalization function in the 
Mixer ("N" key) in order to get an precisely modulated file. You can always save the 
affected settings as presets. 

 

Trackbouncing settings: Source 
Routing: 

In this field you determine the outputs to be written to the file. 

Master: The mixer's master output is written as a file. This is the standard for all exporting 
processes. 

All outputs (Ignore device routing): All tracks that have not been muted are calculated 
together, independent of the routing involved. Suitable for bouncing at object level. 

Surround master (view page 240): This bounces the surround mix. 

Surround + Stereo Master: The surround mix is bounced together with the stereo mix. 

All outputs (Use device routing): All tracks that have not been muted are calculated 
together to the individual outputs according to their routing. 

Horizontal: 

Selected range only: In this case, trackbouncing is only applied to the length of the 
selected range in the arranger. This function does not work track-selectively, i.e. all tracks 
of the selected range, except for muted tracks, are used in bouncing. 
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From the project start to the last object: In this case, the bounce process includes all 
objects from the project start to the end of the last object, plus the time it takes for the 
sound to dissipate. 

Complete project: If this option is selected, the entire virtual project is bounced. 

Vertical/Special: 

All audible tracks: All tracks that have not been muted are calculated into a new file. 

Selected tracks only: All of the selected tracks are bounced together. 

All audible tracks individually (Multi-track bounce): All tracks that have not been muted 
are individually calculated into a new file. 

Bounce all selected objects individually: All selected objects are bounced individually. In 
this case, all object effects are used. This enables a large number of single objects to be 
exported quickly to separate files (e.g. for creating sample archives). 

Glue selected objects together: All selected objects on a track are processed and written 
into a new file including object effects. 

Note: The two previously mentioned options correspond to the "Object freeze" function / 
the "Glue objects" function in the "Object" menu. The difference that the file names may be 
specified individually and that an "Unfreeze" function is not available. 

Samples before object start and after object end: This function allows additional 
samples to be included in the file to be calculated.  

Note: If the selected track is a submix bus, all tracks that are routed to this bus are also 
bounced. This also works recursively, i.e. if these tracks are busses. This permits fast 
mixing of individual groups. 

 

Track Bouncing Settings: Generate 
Create new wave file: The selected range or the virtual project (VIP) creates a new wave 
file. 

Open new wave project: The selected range/virtual project (VIP) is converted into an wave 
project. 

Create new object in VIP: The bounced objects are inserted as new objects in a new 
track in the existing VIP. 

Replace objects in VIP: The objects used in trackbouncing are removed and the result is 
inserted into the selected track. 
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Create new VIP: A new virtual project (VIP) will open. The bounced audio material is 
inserted into the first track of the created project. 

 

Trackbouncing settings: Format 
The target format may be set flexibly. Wave and AIFF files in 8/16/24/32-bit mono/stereo 
at variable sample rates and four different quality levels are supported, as are MP3, Ogg 
Vorbis, and FLAC files at variable sample and bit rates. The desired codec may also be 
selected by clicking "Format settings..." 

The following diagram displays the signal flow for the target format's setting. 

 

 The format setting "Stereo" creates a file that contains the stereo information as an 
"Interleaved file". 

 The format setting "Left & right" may be used to create two files, i.e. "Filename_L" and 
"Filename_R", which provide separate information about the left and right channels. 

 The format setting "Left channel only" monitors and outputs the left channel only. 
 The format setting "Right channel only" monitors and outputs the right channel only. 
 The format setting "Mono mixdown" calculates the left and right channels together 

according to the formula "(L+R)/2" and then outputs these. 
 The format setting "Mono" is especially useful for hard left or right tracks, since it 

bounces these at the same level. Mono is formed according to the formula "L+R". If 
panorama is set in the middle in the format settings, the trackbouncing process will 
automatically result in a level reduction of 6 dB per channel (panning law -6 dB). This 
will ensure that even centered mono signals are not bounced at a too high level, but at 
the original level. 

If you set Surround Bouncing (view page 240) in "Source -> Routing", then the formats 
"Mono", "Stereo", and "Interleaved file (RIFF 64)" will be available for selection. 

Note: All files created as a result of trackbouncing are opened in Samplitude. 

You cannot bounce to the same project twice in succession. You have to close it first. If 
you bounce often and do not require any special mastering options, you can work more 
effectively by using the "File -> Export" (view page 449) command instead of the 
trackbouncing dialog. 
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All formats that cannot be directly opened by Samplitude cannot be created in the 
trackbouncing window. For bouncing into Real or WMA formats, use the "File -> Export 
(view page 449)" command. 

 

Trackbouncing criteria: Options 
Exclude master effects from bouncing: Master effects are not included during bouncing. 

Exclude track effects of the target track: Track effects of the target track are not 
included if they are not identical with a source track. 

These options are important in combination with the "Create" functions "New separate 
object in current VIP" and "Replace objects in current VIP". Note: these are set 
automatically so that the track effects are not applied twice. 

Calculate maximum amplitude: Display the maximum volume in dB after bouncing in 
order to correctly set equipment for additional editing or to correct the master level. Once 
bouncing has been completed, the corresponding information window will be displayed. 

Dithering: Every trackbouncing process may feature its own dithering process, 
independent of the global settings. This enables dithering to be bypassed or to apply the 
standard dithering (dithering featuring triangular noise).  

 

Use this dialog to apply dithering according to the system options or to access the 
dithering options in the system settings. The button value in brackets (e. g. Triang. or 
POW-r 1) indicates the currently set dithering algorithm. 

Detailed information on this can be found in the menu reference under "File" -> "Program 
Preferences" -> "Dithering Options (view page 498)". 

 

Range Bouncing (Internal Mixdown) 
Use this function to convert the objects within a selected range to a new wave file. The 
objects are then replaced in the arranger. This is useful if you want to combine multiple 
objects into a single object for easy editing later. 

To create performance room you can render real-time object effects using the range 
trackbouncing feature. 

If the rate of your objects is higher than 16-bits, a dialog box will ask you whether the new 
file will be created as a 32-bit float or 16-bit file: 
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32-bit (float): The resulting file features a 32-bit (float) rate. This setting is practical if 24-bit 
objects or float objects are used in the bouncing and their high rates should be retained. 

16-bit (integer): The resulting file is 16-bit rate. This setting is practical when the recording 
needs to be burned to CD and when there are no 24-bit objects in use. If 24-bit objects are 
being used during bouncing, these may be reduced to 16-bit using dithering options. 

 

MIDI bouncing 
In another prompt you can choose whether you want to mix the entire project with all MIDI 
objects or just the selected MIDI objects within the current area into one single MIDI object. 
In this case, the MIDI track and object effects like timestretching, track MIDI transpose, 
program change, etc. are bounced into the resulting MIDI object. 

 

Note: Don't confuse MIDI bouncing with the "MIDI object freeze (Object -> Object freeze) 
(view page 563)" function, which replaces the MIDI objects with audio objects in the 
software instrument's audio return signal. 
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Export project as AAF/OMF 

 

TheAAF Export transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Object pan 
 Object volume automation 
 Object pan automation 
 Track names 
 Track Volume 
 Track Pan 
 Track Volume Automation 
 Track Pan Automation 
 VIP markers 
 Timecode offset 
 Timecode format (24, 25, 30 fps) 
 Processing timestamps in audio files 

OMF Export transfers the following content: 

 Object position/wave offset - sample exact 
 Object fade in/out - linear only 
 Object crossfade - linear only 
 Object volume 
 Track names 

Note: During AAF/OMF export, media files will always be converted to WAV files. You can't 
export video files. Corresponding objects will not be transferred; the video track therefore 
remains empty. 
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Destination path 

Enter here where you would like to export the AAF/OMF file. 

Media files 

 Embed in AAF/OMF file: If you select this option when exporting then the whole project 
will be saved as a single file, which contains both media content and metadata. 

 Copy into target folder: If you select this option, media files will be placed next to the 
AAF/OMF into the target folder. 

 Don't copy. AAF/OMF refers to original paths: If you select this option, no media files 
will be exported – the AAF/OMF file will only refer to the original media file paths.  

Note: Select the "Embed in AAF/OMF file" or "Copy to destination folder" if you want to 
have the entire project together with the corresponding Audio/Video files as AAF/OMF files 
in another studio. 

Format 

Select whether you want to export the file in AAF format or in OMF format. 

Compatibility 

Without automation curves (Pro Tools-compatible): If you select this option, AAF/OMF 
export will take place in a Pro Tools-compatible fashion. Track volume and panorama as 
well as automation curves will not be transferred. 

Convert stereo objects into left/right tracks automatically - Pro Tools compatible: 
Stereo objects are not supported by Pro Tools. Convert the corresponding objects into Pro 
Tools-compatible objects prior to AAF/OMF export as required. 

Note: Timestamps saved with ProTools in Frames for improved compatibility. 

 

Rename Project... 
The current project may be renamed using this dialog. For HD wave projects, all the files 
involved will be correspondingly renamed. 
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Clean up 
Collect project files 
This dialog displays all files located outside of your project folder. All files marked in the 
"Edit" column can be compiled in the project folder. You can ether copy or move the files 
outside of the project folder into it or create a new subfolder. Samplitude displays the 
amount of space required and how much is currently available.  

 

After processing, it's a good idea to save the project! 

 

Delete Virtual Project (VIP) 
Use this menu command to easily delete wave projects from the hard disk. The integrated 
wave files may be individually blocked from deletion by removing check marks under 
"Delete" next to each file. The remaining files belonging to a virtual project will be deleted. 

Warning: Once the dialog has been confirmed, the data will be deleted without a repeat 
query. 

 

Save Complete VIP in... 
The complete virtual project and all associated wave files will be saved in the specified 
folder. This function is useful for making backups on a different drive, etc. 

Keep project subdirectories: If you have already created subfolders in your project 
directory, e.g. to sort samples, then these will also be copied into the new directory. 
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Copy unfreeze data: Copies all unfreeze data in the VIP into the new directory. 

Copy Revolver track data: Copies all Revolver track data included in the VIP. 

Copy ClipStore data (Sequoia only): Copies all of the ClipStore data used in the VIP. 

Copy video data: Copies associated video files. 

Copy effect used files: Copy the files used by effects into the new directory, e.g. Room 
Simulator or the vocoder. 

Copy only samples used in VIP: Only the sections of wave projects that are actually used 
by objects in the VIP are copied. 

This function is practical for saving disk space; however, the objects in the newly saved 
project may be only shortened, and not extended. This is because all  of the audio data 
outside the object edges is not copied with it, and therefore, cannot this cannot be used. 

A security area in may be defined in samples for this purpose. The number of samples will 
be left as additional space in front and at the end of the corresponding object limits to 
leave a reserve, in case the object may be altered with a fade in/out. A value of 22,050 
samples is preset (this corresponds to 500 ms at a rate of a 44.1 kHz). 

 

Burn Project Backup on CD/DVD 
Use this menu command to burn an entire project backup onto multiple CDs or DVDs. 
Samplitude's burner program, MXCDR, will open for this. 

 

Delete Wave Project(s)... 
Use this menu command to easily delete wave projects from the hard disk. All files 
belonging to the HD wave project (the wave file containing the audio files, files with the 
graphics data, and the HDP file with the project information) will be deleted together. 

Note: An HD wave project may only be deleted once it's closed. As long as parts of the 
project are still active as objects in the VIP, deletion is impossible. Once the dialog has 
been confirmed, you will be able to delete the data. 

 

Delete Unused Samples 
This function lets you edit all wave projects belonging to the current virtual project in such a 
way that all ranges that aren't used are deleted. It basically deals with the part of the audio 
data to which the objects in the arranger do not refer and don't get played at any point. 
The objects in the virtual project are customized automatically so that nothing changes in 
the arranger view. 

This function deletes physical data and does not feature an "Undo" option. You should 
therefore apply this command carefully. 
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If multiple virtual projects refer to the same wave files, all of these projects should be open 
as well. This is the only way to monitor and prevent data loss. 

Using the "Remove unused samples" function saves storage space, but corrections to the 
objects' lengths are limited, since all audio data outside the object borders are removed. 
For this reason, specify backup reserves with "Save additional samples for each object". 
This number of samples is left in front and behind the object borders in the audio material. 
The default value is 22,050 samples, which corresponds to 500 ms at a 44,100 kHz 
sample rate. 

The dialog lists all of the wave projects used in the virtual project. You can see the total 
memory space used by the wave projects in the "Size" column here, and beside this the 
free space in the "Unused" column. In the "Edit" column, you'll find a check box for each 
file that may be used to add files to the process. Only those files that contain unused 
sections of audio data are selected. To keep these, remove the check. 

Note: The list may also contain files not actually referenced by the VIP, but referenced by 
the VIP's undo chain. These files are 100% unused samples and will be deleted completely 
when checked. 

For example, if you have discarded an entire recording session, you can delete the unused 
files as well. However, if you had opened audio material from other sessions or your private 
sample library and didn't use them any more after that, you should uncheck these files so 
that they don't get deleted. 

We recommend deleting the "Undo" chain and closing all unused wave projects before 
using the function. 

Tip: If the relevant audio files are required later on for additional production work, the 
following procedure is recommended for archiving the finished production: 

Save your entire project in a new folder ("File -> Save complete VIP in...").  In the save 
dialog, select the command "Copy only samples used in VIP". Now only those audio 
files/samples that are actually required by your archiving project will be found in the few 
folder. You can now save the content of this folder to a backup medium (e.g. CD-ROM or 
DVD). 

 

Delete Freeze Data 
Use this function to delete unused data that was created when freezing but is no longer 
needed after "unfreezing". 

 

Close Project 
This menu point closes the active project. 
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Project Properties 
Snap and Grid Setup 
In the general project options dialog you can choose the kind of grid and its activation. 

Shortcut: I 

Virtual projects have an object grid, area grid, beat grid, and frame grid. In the object grid, 
the objects may only be moved to the start, end or the hotspot (view page 562) ("Object -> 
Set hotspot/delete hotspot (view page 562)"). The reference point is normally the front 
edge of the object that is to be moved. As soon as a hotspot has been defined for the 
object, this is what will be used. If several objects are selected, alignment takes place at 
the forward edge of the hotspot of the object that was selected last, and is currently 
located under the mouse cursor. The intervals between the selected projects stay 
constant. 

 

Grid:  Checking the tick box turns snap on globally. 

Object grid:  This option activates the object grid. This lets objects snap exactly to the 
edges of other objects. 

Snap to range: Activates the range grid with the option to use the current range as the 
basis for snapping. 

Grid/bars: Activates a grid with bars as the basis. The objects snap to the the next beat 
grid. 

Grid/bars (Relative):  Activates a grid with bars as the basis. This means that the relative 
distances between the objects adhere to the beat grid when you move them about. 

Grid/frames:  Activates the frame-based grid. 

Snap offset to project start: Here the snap offset can be set relative to the beginning of 
the project. "Use current position for offset" specifies the current position as the grid's zero 
position. 
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Use snap offset also for grid:  The snap offset is used as a reference size for the grid. 

 

Mixer setup 
This item enables project and mixer settings to be configured, saved, and loaded. 

 

Shortcut:   Ctrl + Shift + M 

 

Project and Mixer Configuration 
Set the number of tracks, AUX buses, and submix buses. You can also define effects and 
signal routing for the tracks and the master section. 

The window of the first track is always open for effects routing of individual tracks/buses. 
To adjust the settings for all tracks, click "All tracks" in the effects routing dialog. 

Besides the routing button, two additional options are available: 

 Use adv. dynamics in master for dyn./limiter: In the master section of the mixer, the 
resource-saving "normal" dynamics may be used as a dyn./limiter or for high-quality 
advanced dynamics. 

 Automatic latency compensation: Activate this option for automatic latency 
compensation of DirectX and VST plug-ins. This is active by default. 

 

Master Routing 
 Keep current setting: The current setup in the project will not change. 
 Stereo master: Normal mixing occurs via Samplitude's stereo master. If the sound card 

provides several devices, select one in the mixer (in the "out" bar below the volume 
faders) or in the play parameters (shortcut: "P"). 

 Surround master: If this setting is active, master channels are provided for 5.1 Surround 
mastering. 

Detailed information about the Surround setup is available in "Surround sound -> Surround 
project setup (view page 225)". 
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Keep Current Number (Tracks, AUX and Submix Buses) 
Check this box to prevent the current settings from being overwritten when loading a mixer 
preset. The current status of this checkbox is also saved along with a preset. If you quickly 
want to add a few tracks, (e.g. 4 AUX buses and 4 submix buses), you only have to load 
the "4 Busses 4 AUXes" preset. 

When loading a preset, the respective tracks and buses will be added where the box is not 
checked. In other words, place a check for settings that shouldn't be included in the preset 
before saving. 

 

Device Setup (Track Assignment, Routing) 
Select the in and output device assignment for several tracks simultaneously in this area. 

I/O Devices: Define the routing for playback, recording, or both. 

Track number (0 for all): Start with track 0 as active track: This option permits a change 
to I/O routing for a certain number of tracks. If you set the track number to 4, starting at 
track 8, the selected routing setup is applied to tracks 8 - 11. 

Note: To be able to switch these commands to active, you must first replace the "Do not 
change the setup currently used in the project" option in the neighboring "Routing" field 
with another option from the selection menu. 

 

Routing 
Keep current setup: No routing assignment takes place if a preset is loaded. 

Route all tracks to stereo master: All tracks (incl. AUX and submix buses) are routed to 
the master. L/R panning sets the panorama  settings for the tracks to alternate between 
left and right. Use this option if stereo sources are recorded as mono pairs. 

Assign all tracks to different mono/stereo devices: All tracks are assigned to the 
different output devices. In the system options window (shortcut: "Y") you can define which 
devices are available in Samplitude and which are not. When routing to mono devices, the 
tracks are also placed right/left in panorama alternatively. 

Initialize tracks on Surround channels: The corresponding tracks are created here after 
the Surround setup  has been selected . 

Use saved setup in preset: The settings saved in the preset are used. 

 

External effects 
Detailed information on this topic can be found in "Effects -> Breakdown and functionality -
> External hardware effect integration". 
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Media link 
The media link in "Options -> Project properties" allows you to link video and MIDI files with 
your Samplitude project to play them simultaneously. 

 

More detailed information about the media link is available in "Synchronization -> Media link 
(view page 358)". 

 

Playback Options 
More information is available in "Playback -> Playback parameters (view page 578)". 

Shortcut:  P 

 

Project Auto Save… 
The Autosave dialog is available via the project options.  

 

This dialog provides options for creating backups of projects. The button View backup 
project opens the selected backup in the arranger.  

The button Restore backup status restores the project to the status of the backup. If the 
current project was changed previously and not saved, then the last status may be saved 
with the extension _OLD.vip. 
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Autosave Mode 
Autosave mode may be activated with the corresponding check box. Select from the 
following options: 

Save to original: Overwrites the original file in specific intervals with the current status. If 
the option Save in subfolder is selected, the previous status, i.e. the pre-previous status 
will also be updated in the Backup subfolder. 

Add backup file (*bak.VIP): Adds a backup file and updates this at specific intervals. If the 
option "Save in subfolder is selected, the backup file will be updated in the Backup 
subfolder each time it is saved. 

Max. 10 backup files (*bak0.VIP until *bak9.VIP): Specify save intervals for up to 10 
backup files and number them. If the option "Save in subfolder is selected", the backup 
files will be updated in the Backup subfolder each time they are saved. After 10 backup 
processes, the final backup file will receive the extension *bak9.VIP, the oldest backup file 
will be deleted, and the others will move downwards in the sequence. 

 

Project Information… 
Enter information about the project here. 

There is also a text field for comments. These may be set to show each time the project is 
opened. 

 
 

Project Status… 
This indicates all project status information like the name, path, number of ranges, markers 
and objects, wave files used in the current project, or the date of creation. You can also 
create a text file which includes all of this information. 

 

Broadcast Wave Manager… 
The broadcast wave manager extension makes it possible to store information about the 
audio file, i.e. metadata, in a chunk of the BWF file. This metadata may be proprietary, 
however we recommend observing the guidelines set out by EBU and SMPTE. 
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Wave Project 
This displays a list of the data included in the project. Select the respective file using the 
mouse to display the individual information. The corresponding BWF information will be 
displayed in the right half of the window. 

The main application of the BW manager, however, is defining the meta data included in 
the broadcast wave extension of the recorded audio material. 

This metadata is then available to all users of the audio file in the future. Some applications 
can read or extract this meta data for further purposes, such as the administration of the 
audio data in the databases. 

 
 

Broadcast Wave Manager - List of Individual Fields 
All values that refer to the project are saved and applied to new audio data. 

File Description: This is a freely usable text field. Enter a maximum of 256 ASCII 
characters. 

Originator: This field contains details on the origin of the file, e.g. the description of the 
producer. Maximum of 32 characters. 

Originator Reference: This field is specified by the originator. This can be an internal 
reference number, for example. In the EBU range, a recommendation according to EBU 
R99-1999 specifies how this field should be constructed. To assign the entry of this 
property, activate the "USID" option. Next, format the entry according to EBU guidelines. 
Maximum of 32 characters. 

Date: The date of the file's creation is displayed; this may be edited if audio material was 
saved for the first time as a file, even though the recording is somewhat older and the date 
needs to be valid as a reference. If the entry is edited in the BW manager, then a value 
independent of the file properties results. 

Time: The time at which the file was created initially is shown here. Like the date, this is 
automatically created from the file properties, but may also be edited in the same way as 
mentioned above. 
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Timestamp: The timestamp saved in the BW (broadcast wave) extension is displayed here. 
This is the timecode for recording the file, which is identical with the timecode of the first 
recording if the recording was synchronous. For other applications, this timestamp 
provides information about the time on the day of recording. The timestamp may be edited 
or applied from the object position. You can assign the timestamp from the object 
positions to all wave files.  

Unique material Identifier (UMID): Handling of the UMID is regulated by SMPTE. An 
corresponding document is available from SMPTE. The code number is SMPTE 300M-
2000. We recommend these reading the guidelines and agreements regarding the use of 
the UMID before using this feature, which may be applied accorind to your needs. Use of 
UMID is not absolutely necessary for a valid BWF. 

Coding History: Besides information about the file format (A: encoding, e.g. PCM, F: 
sample rate, W: bit width, these values are only used with non-transparently encoded 
material like MPEG or MP3, M: number of channels), each entry of this field contains a T 
value. This is a comma-free text string for entering serial numbers of recording tape 
machines, codecs, dither types, AD converters, or special signal editing applied to the file 
(like denoising). 

An entry is made when a file is recorded in Samplitude. If this file is processed again (e.g. 
the bit width has been reduced or via MPEG encoding), then an additional entry is added. 

Use of this coding history is regulated by EBU recommendation R98-1999. 

 

Broadcast Wave Manager - Advanced Options 
Save BWF graphic data in wave files: If this option is activated, Samplitude creates a so-
called "peak chunk" that saves graphic information as a meta data in the file. Samplitude 
usually saves graphic data in separate files (.ho files). 

Read BWF graphic data and use data in Samplitude: If this option is activated, the peak 
chunk included in a BW file is used instead of a .ho file. 

 

CD Arrange Mode 
If this is activated, Samplitude arranges recently added objects to insert a Red Book 
Standard-compatible pause between the objects. 

Detailed information about "CD arrange" mode is provided in "CD arrange mode (view 
page 792)". 

 

Destructive Wave Edit Mode 
This menu item activates or deactivates the destructive editing mode in the wave project 
window. If this point is deactivated, then Samplitude is put in "Virtual wave editing" mode. 

Detailed information about destructive editing is available in the chapter "Working in the 
project window -> Samplitude as a wave editor (view page 108)". 
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Program Preferences 
System options 
Specify all of the important settings for Samplitude in this dialog. 

These include: 

 System options: Audio setup, audio devices, MIDI, hardware controllers, metronome, 
record, play, performance, advanced buffer settings 

 Program preferences (program): General, undo, object locking 
 Keyboard, menu & mouse: Keyboard/menu, MIDI editor, special keys, mouse, mouse 

wheel. 
 Design: Skins, display options, colors 
 Effects: Dithering, resampling/bouncing, VST/DirectX/ReWire, destructive effect 

calculation 
 Option administration: Reset program settings to default values 
 Project options: Switches the tree structure of the project options 

Explanations and references regarding system settings are located directly in the "System 
options" dialog. 

 

Audio Setup 
Driver System 

Please also read "System settings -> Audio setup (view page 25)" for more information. 

 

Buffer Settings 

Please also read "System settings -> Audio setup (view page 25)" for more information. 

 

Device Address/Driver Communication 

Please also read "System settings -> Audio setup (view page 25)" for more information. 

 

Monitoring Settings 
There are different ways of monitoring. These settings are used as presets for new 
projects. 

For more information about monitoring, please see "System settings -> Monitoring settings 
(view page 27)" for more details. 

 

Audio Device 

More information about this is available in "System options ->  Audio devices (view page 
31)". 
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MIDI 
For more details about MIDI settings, see "System settings -> MIDI settings (view page 
31)". 

 

Hardware Controller 
Detailed information about this is available in "Hardware controller". 

 

Metronome options 

Detailed information about this is available in "File -> Program Preferences -> Metronome 
Options (view page 84)". 

 

Record 
This dialog enables the selection of various dialog configurations and cursor behavior when 
recording. 

Format: Choose from 16 bit, 24 bit or 32 bit (float). 

Enter the Recording offset in samples to ensure consistent movement of your audio 
recordings with regard to the existing audio material in the arrangement. 

 

The following options are then available: 

 Pre-activate all tracks for track punch recording 
If this option is activated, all set record devices will open when the playlist is opened, so 
that you can start a recording on all tracks using the track record button. 

 Save each take in a new file 
This option saves each take of a recording as a new file. Loop recordings, however, are 
collected as a take and then saved into the same file. 
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 Read CD/DAT marker 
DAT devices and several professional CD players output digital marker information via an 
SPDIF output e.g. CD track markers or DAT markers). This recording option reads this 
marker information from the SPDIF input of the sound card and applies it to the VIP, 
provided that the selected audio device supports this. 

Pre-recording (ASIO only): If recording is activated from the stop state or during 
playback, this function inserts audio material that you have added at the beginning of the 
recording to the beginning of the current recording. Prerecording lengths of 2, 5, 10, 30, 
60, and 120 seconds may be set.  

If a recorded object is dragged to the left, then the audio material recorded before actual 
recording start is visible according to the set pre-recording time. 

Post recording: Post-recording may also be activated in the recording options in order to 
record up to 2 seconds of audio material in the background after the actual recording is 
ended. If the end of the object to the right after recording is dragged out, the portion of 
extra material recorded will be displayed. The preset for post-recording equals 0.5 
seconds.  

Advanced options 

Show small record window during direct recording: Displays a small non-modal 
recording window with the most important recording controls while recording. 

Show small record window during recording/punch in recording: Displays a small non-
modal recording window with the most important recording controls during punch 
recording. 

Show confirmation window after recording: If this option is checked, a dialog will appear 
after the recording process to choose whether to keep or discard the recording. 

Note: Select the option "Display confirmation window after pressing the record button..." , 
and the recording will always be saved directly after it has completed. On the one hand, 
this offers the best protection against data loss as a result of inadvertent deletion is 
guaranteed, and on the other hand, obviously unnecessary takes are saved to the hard 
drive and take up space until they are manually deleted. 

Update object during recording: This option increases the recorded object constantly 
along with continuous recording. 

Autoscroll recording position: If this option is activated, the window will scroll along with 
the recording cursor. 

Set cursor to record end - start next recording at this position: If this option is active, 
the play cursor is moved on recording; playback/recording then starts from this position. 
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Recording button in recording options can stop recording: Specify that the "Record" 
button in the Recording options (shortcut: Shift + R) is able to start or stop the recording 
process. 

Record button ends playback after standard recording: If this option is activated, then 
the running recording and playback may be ended by pressing the "Record" button in the 
transport console. 

 

Playback 

More information about playback settings is available in "Playback -> Playback parameters 
(view page 578)". 

 

Performance 

 

The options featured under "Performance" are provided to set up your system's 
performance optimally. Among other things, "ASIO silence economy" is available for 
switching off empty or silent tracks with ASIO. 

Multi-CPU support: Samplitude supports use of multi-CPU/multi-core/HT workstations 
that distribute the load of various tasks across several processors. If you select the driver 
system "MME" or "WDM", the audio thread editing will run mainly on the first CPU. Disk I/O 
operations, graphics, and video integration are processed by additional CPUs. 

"ASIO" activates this driver system and dual CPU support; the mixer tracks and their 
effects are distributed between the initial CPUs. Objects (including their effects), integrated 
video material, and the graphics engine are distributed between additional available CPUs. 
The program is currently optimized for work with up to eight cores; working with 3 cores is 
preset. 
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If you own a system with multiple CPUs, you will be able to get higher performance from 
your system for processing audio, provided that you activate this option. However, using 
multi-CPU support can lead to incompatibilities with plug-ins that are specified for a set 
track processing series. 

ASIO priority boost: Among all threads of the application, special priority is granted to the 
ASIO thread. This option is a preset and does not need to be modified. This increases the 
reliability of your audio recordings as well as that of the playback. 

Note: We recommend deactivating this option for LYNX and TASCAM devices. 

Deactivate muted tracks for ASIO: Use this option to reduce the CPU strain on your 
system. When muted, however, there may be some delays. 

Deactivate FX on empty or silent tracks for ASIO: Use this option to reduce the CPU 
strain on your system even more. This function can, however, cause fluctuating CPU 
efficiency. 

Switch off Hybrid Engine for bouncing/export: This option calculates all effects during 
the bouncing/exporting process using the faster "Economy Engine". This may cause 
irregularities when some plug-ins attempt to compensate for latency. 

Note: If every option is activated, maximum system performance will be achieved. If each 
option is deactivated, maximum compatibility will be achieved. 

 

Advanced buffer settings 

Detailed information about this is available in "File -> Program Preferences -> Advanced 
Buffer Settings (view page 500)". 
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Program 
General 

 

Open VIP and record window on program start: If this option is active, Samplitude will 
automatically open an empty virtual project (VIP) and the "Recording parameters" dialog 
when the program is started. 

Open wave projects in destructive editing mode: If this option is active, wave projects 
will be opened in destructive editing mode. 

Lock VIP size against zoom out: If you zoom the virtual project out beyond the section 
size, this option will automatically stop it from being extended. 

Play cursor independent of range: This option allows the play cursor to be set 
independently in "Loop" mode and playback to be started outside of the selected loop 
range. 

Performance display: This option activates the DSP performance display in the lower left 
corner. If the display shows values of 100% or more, then the processor is overloaded. In 
that case, take the following steps: 

 Reduce the number of real-time effects in the mixer or in the object editor. 
 Reduce the number of tracks by muting tracks that are not needed. 
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 Increase the VIP buffer size (keyboard shortcut: Y) up to 16,000 or 32,000 samples. 

Note the message displayed in the status bar in case overload occurs during real-time 
previewing of complex effects like the Denoiser or FFT analyze filter. 

Hide wave projects loaded into virtual projects: Hides windows in wave projects that 
are loaded directly into the VIP. 

Show project tool tips: If this option is active, additional information is displayed when the 
mouse pointer hovers over an interactive element. 

Show extended project tool tips: If this option is activated, the extended tool tips are 
displayed if the mouse pointer is held over an inactive element.  

Keep FX dialogs on top: This option keeps all effects dialog windows "always on top" of 
all other windows. 

Use snap for automation curve points: Select this option to set automation curve points 
while moving set values on the grid. 

Reset all "Don't show this message again" boxes: Press this button to reactivate all tips 
dialogs that have been deactivated. 

Path Settings 
New virtual projects: All new virtual projects as well as recorded and imported wave 
projects will be saved under this path. 

Project files: All other wave files which are to be saved on the hard drive and that cannot 
be allocated to a specific project are saved under the specified path. 

FTP download: All files downloaded via the integrated FTP client will be saved under the 
specified path. 

Temporary files: This preset path is directed to the standard temporary files folder. Make 
sure that this folder is on a hard drive or partition with sufficient free storage space. 

 

Undo 

Detailed information about this is available in "File > Program Preferences > Undo 
Definitions (view page 497)". 

 

Locking objects 

Detailed information about this is available in "File -> Program preferences -> Lock 
Definitions". 
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Keyboard, Menu & Mouse 

Detailed information can be found via "Menu File -> Program Preferences -> Edit Keyboard 
Shortcuts and Menu (view page 488)". 

 

Designs 
Skins 
In this dialog, select different skins for the project, the mixer, and the transport console. 
Use the various skins to adjust the color and graphical display of the Samplitude interface. 

 

There are specific skins adapted for working with certain methods like the "Multi-track 
mixer", "Dual Row Recorder" or "Recording Mixer" which can help keep the overview in 
certain working situations. 

 

Various skins may be selected by clicking on the icon to the top left in the title bar of the 
Mixer (view page 158) or in the Menu bar of the Arranger (view page 47). 

 

System options > Design > View options 

Detailed information on display options can be found via "File > Program Preferences > 
Definition... (view page 491)". 
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Colors 
All colors used in the program can be set here. You can also load and save these colors as 
presets.  

 

Use automatic sample colors for record: A separate random color is chosen for each 
recorded object per track.  

Redo 
Restore last state: The last status of the color settings prior to opening the dialog was 
opened is restored. 

Reset...: Reset the color settings to those of the previous or original color state. 

Previous state: The previous color settings will be restored. 

Original state: Resets all colors to their default setting. 

Reset object colors: This option resets all object colors. This may also be necessary when 
importing a project from a different PC with different color settings, or if the objects have 
colors that deviate from the standard object colors as a result of automatic assignment 
during recording.  

Reset track colors: Resets the track colors. 
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Reset object colors to track colors: Sets the object foreground colors of the waveforms 
to the track colors.  

Object background to track colors: Sets the object background colors to the track 
colors. 

Semi transparency view: Some effect dialogs and editors feature transparent displays. 
These may be deactivated here to increase performance. 

 

Effects 
Dithering 

You can find out more about this by reading "Dithering options..." (view page 498). 

 

Resampling/Bouncing 
Specify the settings for record resampling (normal, high, very high), playback resampling 
(normal, high), and object resampling for new objects (normal, high) as well as the 
resampling quality during bouncing (high, very high, ultra high 1, ultra high 2). 

You can also select the following freeze options here: 

 Keep mono, if possible 
 Use additional samples for object freeze 
 Object freeze without object volume 

16-bit, 24-bit, 32-bit formats are available 

 

VST/DirectX/ReWire 

Detailed information is available in the section "Mixer -> Effects routing/plug-ins dialog -> 
VST/DirectX/ReWire setup plug-in buffer (view page 176)". 

 

Destructive Effect Calculation… 
Choose in the advanced destructive effects calculation options (view page 601) if you want 
to add the effect to the original file when editing destructively, write it into the effect file, or 
create a new effect file for each calculation. 

 
Options administration 
The Samplitude folder includes so-called "Ini" files and preset files, which contain program 
settings.  
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The following dialog enables the listed settings to be saved and loaded conveniently. This 
makes it possible to save the complete program settings onto a mobile storage device for 
use on other Samplitude workstations. 

 

The program settings are saved as "Settings Container Files (*.INZ)".  

Save: Press the "Save" button to save the current project and program settings in a 
"Settings Container". All of the program settings will be saved, including those that are not 
checked. The state of the individual check marks during saving only represents a pre-
selection for loading. The saved file will now appear as a preset at the top of the list.  

Samplitude settings are provided for the following dialogs: 

 General settings (view page 479) 
 Settings displays and window positions (view page 491) 
 Audio/MIDI Options 
 Toolbars 
 User administration (affects all users and user settings) (Sequoia only) 
 Standard project settings (view page 33) 
 Standard Crossfade-templates (Sequoia only) 
 Project templates (view page 449) 
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Load: Select a program setting for Samplitude from the list above or import the settings via 
the folder button.  

 

Specify via the tree structure which "Ini" files or "Preset Files" for the selected container file 
should be used. Now press "Load and restart" to activate the settings. Samplitude will 
restart and a backup of the last settings will be created. 

The program subfolder "Customize" also features a series of "INI patches" that do not 
contain complete files, but rather only activate or deactivate individual settings. These may 
also be loaded just like a "Settings Container" via the folder button. After selection is 
confirmed, a separate dialog window featuring explanations about the respective "INI 
patch" will appear. 
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Project options 
General: 
Please also read "System settings -> Project Options -> General (view page 33)" for more 
information. 
Auto save: 
Detailed information about this is provided in "File -> Project Properties -> Project Auto 
Save (view page 470)...". 
Mixer setup: 
Detailed information is provided in "File -> Project Properties -> Mixer Setup (view page 
468)...". 
External effects: 
Detailed information on this topic can be found in "Effects -> Breakdown and functionality -
> External hardware effect integration". 
Video setup: 
Detailed information is provided in "File -> Project Properties -> Media Link...". 
Synchronization: 
Detailed information is provided in "Synchronization (view page 345)" 
MIDI Machine Control (MMC): 
Detailed information is provided in "Synchronization (view page 345)" 
Project information: 
Detailed information is provided in "File -> Project Properties -> Project Information (view 
page 471)...". 
Project status: 
Further information is provided in "File -> Project Properties -> Project Status (view page 
471)...". 
Broadcast wave: 
Detailed information is provided in "File -> Project Properties -> Broadcast Wave Manager 
(view page 471)...". 

 

Varispeed and Scrub Settings 
This dialog enables tempo changes for virtual project playback to be made. Right click the 
scrub control button in the transport controls. 

Sample rate: The preset project sample rate is displayed here. To change this value, a 
request window will appear to adapt all audio objects to the new sample rate as needed. 
This adjustment may also be made by moving or resampling the audio material. MIDI 
objects may also be adapted to the new sample rate. These may also be moved, but the 
musical position will remain the same. 

Autoscroll/scrubbing: See "Playback parameters (view page 578)". 

Stop at position: This stops the play cursor at the current position when the "Stop" button 
is pressed and doesn't jump back to the original position. 

Device: Specifies the driver of the sound card for playback. 

Active: Checking this box activates Varipitch/Varispeed. 
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Varipitch/Varispeed mode 
Vertical slider: This controller defines the playback from -200% to +200%, in which case 
negative values cause the project to play in reverse. 

Pitch: Double clicking this field enables the speed factor to be input directly, e.g. 0.5 for 
half speed, 2.0 for double speed. 

Halftones: This field specifies pitch changes according to semitones; a value of -12  
causes the project to play an octave lower at half speed, and a value of +12 plays back the 
project one octave higher at double speed. 

Internal rate: This specifies the sample rate for Varispeed calculation. At a sample rate of 
44,100 kHz, a value of 22,050 plays the project an octave lower at half the speed. 

BPM orig: Displays the original speed in BPM. 

BPM out: Enter the target speed in BPM. Samplitude calculates the varispeed pitch factor 
from the quotient from the target to the original tempo. 

 

MIDI Options... 

More details about MIDI settings are provided in "System settings -> MIDI settings (view 
page 31)". 

 

Synchronization Active 
This command activates synchronization. 

Shortcut:  G 

 

Synchronization Setup... 
Shortcut:  Shift + G 

Read "Synchronization (view page 345)" for more information about synchronization 
settings. 

 

MMC Setup... 

Read "Synchronization (view page 345)" for more information about synchronization 
settings. 
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Shortcuts and Menu Settings 

 

This dialog allows you to specify keyboard shortcuts for every menu function in Samplitude. 
It's possible to set the commands you use most often to a special key combination in order 
to open them quickly. 

You can also hide menus that you don't really use. 

When you close Samplitude, the shortcut settings are saved in the Windows folder file 
"Sam_d.ini" so that they are available automatically the next time the program is opened. 

The display of the entire menu tree of Samplitude is the key function of the dialog. 

Here, you can select which menu point you want to create a new shortcut or if the menu 
point should appear in the main menu of Samplitude.  

Displaying and searching for menu items 

The menu is displayed in tree form, and submenus may be opened by clicking on the "+" 
symbol. You can also search for a specific menu point by entering any desired search term 
into the upper input field and then clicking on the magnifier next to it. 

Show/hide menu item: Select a menu item which you would like to hide. "Hide menu 
point" removes the menu item from the menu. It will be shown in grey in the dialog's tree 
diagram. Please note that the menu point will no longer be selectable via previously defined 
keyboard commands. "Show menu item" activates the hidden menu item again. "Reset" 
returns everything to the original condition with all commands visible again. 

Load/save/reset: These buttons load, save, and reset the menu definitions, respectively. 

Create keyboard shortcuts: Click on the desired menu point and then on the entry field 
underneath the "Shortcut..." bar. Then, press the desired buttons for the keyboard 
combination. Drücken Sie nun die gewünschten Tasten für das Tastaturkürzel. 
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Combinations of any key with "Shift", "Alt", or "Ctrl" may also be used. You can now assign 
the new shortcut with the button at the far right. Please do not use the space bar, "ESC", 
or "Ins" key (0 in the number block), since these keys are permanently assigned in 
Samplitude and cannot be changed. 

Assign: This button activates the entered key combination as a new keyboard shortcut. 

Find keyboard shortcuts: Click the input box underneath the "Shortcut..." bar. Next, 
press the keyboard combination buttons for the search. Click on telescope symbol on the 
side to view the menu command assigned to the keyboard shortcut. 

 

Delete: Deletes the selected shortcut. 

Export lists: With this button you can call up and print a complete list of current shortcuts 
as a text file, excel lists or shortcut dialogs. 

MIDI editor/Special buttons/Mouse wheel/Mouse 
"MIDI editor" finds or assigns new keyboard shortcuts for editing MIDI events. 

"Shortcuts" redefines the keys for temporarily changing mouse and object modes. Use 
these functions to quickly switch from "Universal" mouse mode to a different mouse mode 
and to temporarily activate "Link objects" mode or to temporarily switch to "Write 
automation" mode, for example. 

 Temporary switch for "Link one track (view page 78)": Activates the function "Link one 
track" as long as the assigned keyboard shortcut/key combination is held down. 

 Temporary switch for "Link all tracks (view page 78)": Activates the function "Link all 
tracks" as long as the assigned keyboard shortcut/key combination is held down. 

 Temporary switch for object contents: Enables object contents to be moved (view page 
137) with the mouse as long as the assigned shortcut combination/key combination is 
held down. 

 Temporary switch for Snap mode (view page 66): Activates the "Snap" mode as long as 
the assigned keyboard shortcut/key combination is held down. 

 Temporary switch for Object (view page 69) mode: Activates "Object" mode from 
"Range" mode as long as the assigned key is held down. 

 Temporary switch for Curve (view page 70) mode: Activates "Draw automation" mode 
from Universal/range mode as long as the assigned keyboard shortcut/key combination 
is held down. 

 Temporary switch 1 for "Scrub (view page 579)" mode: Activates "Preview" mode as 
long as the assigned keyboard shortcut/key combination is held down. 

 Temporary switch 2 for "Scrub (view page 579)" mode: Activates "Preview" mode as 
long as the assigned keyboard shortcut/key combination is held down. 
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 Temporary switch for "Zoom mode (view page 101): Activates zoom mode as long as 
the assigned keyboard shortcut/key combination is held down. 

 Switch for "Scrub mode (view page 107): Switches to "Scrub" mode indefinitely until the 
next time play stops. 

 Temporary switch for "Cut mode (view page 70): Activates cut mode as long as the 
assigned keyboard shortcut/key combination is held down. 

 Multi-tap sequence key: Pressing this key multiple times provides special functions. 
 Temporary switch for "Automation write" mode: Activates "Automation write" mode as 

long as the assigned keyboard shortcut/key combination is held down. 

More information about the different mouse and object modes is available in "Screen 
elements -> Program interface - overview". 

"Mouse" defines some special options for the keyboard and the mouse to achieve 
compatibility with older versions. These are: 

 Disable range zoom for double mouse clicks 
 Zoom lasso allows vertical zoom without "Shift" 
 Disable mouse zoom on grid  
 Old shift click behavior in mixer: This allows you to change the keyboard shortcut for 

"Switch to exclusive" for solo, mute, and record. Click "Solo/Mute/Record" and the 
selected shortcut "Shift + Alt" or "Shift" switches the individual channels temporarily to 
"Exclusive" mode. 

 Treat knobs like faders: If this option is active, knobs can be pulled up and down like 
faders by dragging with the mouse. 

 2nd click required to move object: This option requires a second click to moving 
objects. The first click selects objects and prevents unintentional moving. 

 Move thresh: When an object is selected by clicking it, it could be moved 
unintentionally. If "Move threshold" is activated, Samplitude will wait a set time until 
performing the operation. 

"Mouse wheel" allows definition of the mouse wheel for zooming and scrolling in the virtual 
project. Define which modifier ("Alt", "Ctrl", "Shift") triggers which action in combination with 
the mouse wheel. 

Note: Pressing the key combination "Alt + Shift" may cause Windows to switch keyboard 
languages. In order to avoid this, the keyboard shortcut for switching the input scheme can 
be deactivated. In the Windows control panel, open the "Country and language" option. 
Navigate to the "Languages" tab and then to the "Details" button to access the settings for 
the standard input scheme. Press "Keyboard" to access the advanced keyboard settings. 
Open the dialog "Change keyboard combination" and place a check mark next to "Change 
input scheme" and "Remove keyboard layout" to hinder the input scheme from changing in 
the future. 

 

Edit Toolbars 
Samplitude lets you customize toolbars however you like. The corresponding editing dialog 
may be opened by double clicking any toolbar. 
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 Select an available button and press "Insert" to add the selected button to the toolbar. 
 Select an available button and press "Del" to remove the selected button from the 

current toolbar. 

 

Reset Toolbars 
Resets the toolbars to default settings. Select whether individual toolbars should be reset 
or if all of them should be reset via "Reset all toolbars". If the file "Samplitude_TB.ini" is 
deleted from the Samplitude folder, then the default settings will be reset. 

 

Font Selection… 
Select a font for text display in Samplitude. 

 

Font for Time Display… 
 Select a font for the time display here. The time display is opened via the "Window" menu. 

 

Font for Manager… 
Choose a font for the managers. 

 

Metronome Options… 
Detailed information about metronome settings is provided in the chapter "Samplitude 
quick start -> Workshop: recording -> Metronome settings (view page 84)". 

 

Draw Setup 
Definition... 
This dialog can be used to change between the two viewing options "Drawing mode 1" 
and "Drawing mode 2". Wave form display, object, VIP, and wave form color categories 
can be edited. 

Shortcut: Shift + TAB 

 

Mode 1/Mode 2/Switch Modes 
Select a view mode here, or switchback and forth between the two viewing modes. 

Shortcut: Tab 

 

Waveform Display 
Draw wave form: Turn the wave form display on and off here. When deactivated, you can 
see volume and panorama curves more clearly. 

Note: In "Drawing mode 2", the standard default setting for the wave form display is 
switched off. This may be changed at any time. 

Scale with fades/curves: In this default display mode, the wave form overview is scaled 
according to the settings for the fade in/out or volume curves. This makes the decay of the 
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sound during a fade out or for volume curve changes more visible. This mode also offers 
good visibility when crossfading audio material. 

  

Halved waveform: Switches the graphical representation of the samples to half the 
waveform display size. 

 

Separate stereo: If this option is active, stereo tracks are displayed separately one above 
the other. 

 

Draw envelope: If this option is active, an outline is drawn around the envelope of the 
waveform. 
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Gray out muted objects/tracks: Muted objects and tracks will be shown gray. 

 

The second column is especially useful for a more clear crossfade display. 

Standard: The waveform of the second object is drawn over the waveform of the first 
object: 

 

Envelope only: When this radio button is selected, only the waveform outline (envelope) is 
drawn. Both objects are well visible in crossfades: 

 

Transparent: If this button is selected, the colors of both crossfade waveforms are 
overlapped. The waveforms appear against a dark background. We recommend 
combining this and the "Waveform colors -> Red/blue alternation" to optimize the display 
of crossfade areas: 

 

Interleaved: When this option is selected, a sample of the left object and a sample of the 
right object will be drawn. You may then visually assess the fade area, a task made 
especially easy if the adjacent objects have different colors: 
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VIP 
Various VIP components (buttons/sliders, peak meters, show border, arrangement text, 
compressed waveform, and CPU peak meter) can be activated/deactivated here. 

Buttons/slider displays the track header with all mixer controls, i.e. the channel faders, 
solo buttons, etc. If you always have the track editor open, then you won't have to use 
these functionally identical control elements at this location. However, if the track header is 
left open, then only the track header's peak meter will be able to be hidden. 

If you hide the borders, the edge of the selected track will disappear. 

Arrangement text identifies the tracks for the two editing ranges in "Universal" mouse 
mode. If you place a check mark here, you will see "Play cursor and range manipulation 
area" in the top half of the track and "Object manipulation area" appears beneath this. 

Compressed wave display: This display option causes the waveform to be distorted 
according to the zoom level. The transition from silence (less than –90 dB) to signals with 
lower levels (e.g. noise) is also shown more clearly. 

CPU peak meter: If this option is activated, the peak meter in the track header displays 
the CPU load per track. The upper peak meter displays the load on the Economy Engine 
for the left channel, while the peak meter below this displays the load on the Low Latency 
Engine for the right channel. In this case, a display value of 0dB equals a load of 100%.  

Note: The dB displayed by the track header peak meter depends on the skin (view page 
481) selected for Samplitude. 

 

Objects 

 

Draw background: This activates the background color view of the selected objects. 
Every object may be assigned its own color (see "Object .> Object color/name (view page 
563)" or in the object editor under "Color"). 
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Use track color: The track color will be applied used as the background color. 

Large Object Handle: The object handles are displayed larger. 

Object properties: This option enables object settings like EQ, dynamics, panorama, 
effects or plug-ins to be displayed with abbreviations in the object. 

Object block symbol:  If a checkmark is set, a key will appear on the bottom of an object, 
which can be used to lock and unlock objects (view page 549). 

Highlight crossfades: With this setting, the crossfades between the objects are displayed 
in contrasting colors. 

Draw while moving: The user interface is updated while moving the mouse. This option 
can be deactivated for computers with low processing capabilities. 

Handle for fade overlap: Use this handle to set the offset ratio for crossfades without 
having to open the Crossfade Editor or Object Editor. 

Additional information about object representation: 

 

Object Name: Shows the object name. 

File name: The file names will be displayed. 

Group number: Objects can be grouped in VIPs. The groups are numbered. When 
displaying these group numbers a quick overview appears showing which objects belong 
to which groups. 

Original position: This shows the original recording position at the beginning of the object 
in the set time code format. This way, a comparison of values in the object with the 
position on the timeline or on the time code of the picture helps clear up possible 
deviations in the synchronization. 

Audio Markers: Use this option to display markers in objects that are present in the wave 
projects that are based on them. 

Transients AQ: Use this option to display the transients in objects that were created 
beforehand with audio quantization. 
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Waveform color 

 

Default color setup: The waveform contains the default color set in the color setup. 

Details about the color setup can be found in the menu reference under "File > 
System/Audio -> Design -> Colors (view page 482)". 

Red/blue alternation: This display mode colors the objects beside the waveform 
alternately red and blue so that crossfades in the "Transparent" and "Interlaced" draw 
modes are optimally visible. This way, crossfades may be optimally viewed in the 
"Transparent" and "Stacked" drawing modes. 

Comparisonics colors: This display mode uses a patented algorithm from 
Comparisonics™ for coloring the display of the sound material. Depending on the pitch 
and other parameters, a special color tone for each segment of audio material can be 
calculated and displayed. Deep sounds get blue color tones; high sounds get 
green/yellow/red colors. Tonal material appears clear, noisy material features gray tones. 
This makes it easy to recognize different pitches optically, for example a saxophone solo 
versus unwanted noise. 

The segment size for color calculation can be entered in "Comparisonics audio segment 
size". Sizes 50 ms or longer are recommended so that there is enough material for color 
determination available within the segment. 

On the basis of the Comparisonics colors, a completely new audio search function is 
available via "Range -> Comparisonics audio search (view page 571)"; with these help 
ranges, identical or similar audio material in the project may be found quickly and easily. 
More information on Comparisonics algorithms can be found at www.comparisonics.com. 

Group colors: Object groups receive a randomly created individual group color when 
being made. This way, various groups can be displayed and differentiated very clearly from 
one another. 

Track colors: The tracks will appear in colors selected under track options. The track 
options can be opened by right-clicking on a track name. 
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Spectral display: Here you can select various spectral colors palettes. The graphical data 
that has been created will be saved in an extra *.hs file. 

 

The graphical interpretation of the music is displayed in the Spectral display using a 
spectrogram. This displays the frequency proportions in a time curve. The volume of 
frequencies is visualized via a color code or via its brightness. 

 

Color Settings 

Details about the color setup can be found in the menu reference under "File > Program 
Preferences > System/Audio > Definition > Color Setup... (view page 482)". 

 

Undo Definitions... 
Use this editor to switch the undo function on and off for virtual projects, wave projects, 
and plug-in settings. The amount of undo steps may also be entered. A value of 20 means 
that the last 20 changes to a project may be undone. 

If you check the corresponding box, temporary undo files be created as HD wave projects 
for RAM wave projects. 
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Dithering Options... 
How does dithering work? 
An audio signal is quantized at a higher or lower resolution with every A/D conversion. 
During quantization, the signal receives an echelon form via limiting of the possible 
amplitude values. An 8-bit signal, for example, possesses only 256 amplitude values. This 
echelon formation causes distortion and thereby deforms the signal, especially impairing 
the sound of the lower levels. 

Dithering can be understood as "mixing in" of low-level noise which seriously reduces the 
human ear's detection of sound defects. 

 

When to dither? 
Samplitude always dithers a signal in integer format when it is saved or exported. 

This is the case for the following situations: 

 During 16-bit playback. All device addressing takes place in fixed comma resolution. 
 When burning audio CDs in real time using an internal precision setting of 32-bit float. 
 When using track-bouncing for virtual projects into 16-bit wave files, provided the 

internal precision is set to 32-bit float. 
 When converting any 32/24-bit wave project into a 16-bit wave project. 

Note: Samplitude does not execute dithering during recording. 

The individual settings for dithering can be set during each trackbouncing process. Detailed 
information is provided in "Tools -> Trackbouncing (internal mixdown) -> Trackbouncing 
settings: options". 
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Dithering Options 

 

No dithering, math. rounding of sample value: This mode converts the signals of 32-bit 
float via precise mathematical rounding without dithering. The rounding involved makes 
sure that surplus commas are not simply removed, and it also prevents signal distortions. 

Dithering with linear spread noise: This converts audio data at 32-bit float via dithering 
with noise featuring amplitude values that occur at regular intervals. The noise level may be 
set via the "Dithering depth in bits" option. 

Dithering with triangular spread noise (standard dithering): In this mode, audio data at 
32-bit float is converted via dithering with noise featuring amplitude values split into 
triangular intervals. This means that values are more regular in the medium range and less 
often at the maximum or minimum values. This type of dithering usually creates better 
results than linear dithering. The noise is not modulated through the signal, resulting in a 
fading signal being enveloped by one constant noise signal.  

Dithering depth in bits: This sets the level of the noise used in dithering. Input is in bits. 
Use this option to specify how many bits of the resulting 16-bits should be affected by 
dithering. In most cases, values between 0.5 and 2 will produce good results. Increase the 
value until distortion effects are no longer audible. Provided you cannot perceive any 
distortion effects, values below 0.5 are usually sufficient. If you would like to add more 
severe noise to your signal, try entering values between 8 and 12. 

 

POW-r dithering/Smart Dithering 
POW-r #1 (dithering): This function uses a special dithering curve to minimize quantization 
noise. 



 

5 0 0  F I L E  M E N U   

POW-r #2 (noise shaping): This function uses additional noise shaping across a wide 
frequency range to extend the dynamic range by 5-10 dB. 

POW-r #3 (noise shaping): This function uses additional, optimized noise shaping to 
extend the dynamic range by up to 20 dB between 2 kHz and 4 kHz. The human ear is 
most sensitive to this frequency range.  

Noise shaping minimizes side effects caused by bit reduction by spectrally displacing the 
quantization noise above 10 kHz, which is the range the human ear is least sensitive to. 

Which dithering mode sounds the best depends mainly on the audio signal. 

Use POW-r dithering only for master outputs when playing back, use standard 
dithering for other outputs: If this option is selected, then only the master outputs will be 
dithered with the POW-r dithering algorithm. The individual outputs will use standard 
dithering, i.e. dithering with triangular spread noise. 

Smart dithering for export/CD burning (switch off dithering dependent on audio 
material) 

For wave files: This option is set as the default. Dithering will only occur on 16-bit exports 
and when burning CDs if the bit-depth is 16-bit. If the original material is 16-bit, dithering 
only occurs when there are modifications to the bit depth. Dithering is not calculated during 
silence. 

For virtual projects: This option is switched off by default. In this case, dithering only 
occurs if the bit depth does not equal 16-bit. 

Threshold for switching off dithering (autoblack): Specify a threshold value below which 
any dithering noise that is created should be muted. The range of values in this case is 
between -100 dB and -210 dB. 

 

Advanced Buffer Settings… 
In this dialog you can optimize buffer settings for your virtual project, for hard disk caching 
and for plug-in manipulation. If no drop-outs or scratches are heard during playback, you 
don't have to make any changes. 

Program buffer/ hard disk performance 
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For special cases, you can set and save your own buffer settings. In addition, special 
presets are available, e.g. for scrubbing and ASIO applications. 

 

Program Buffer (in stereo samples) 
VIP Object Buffer: Since error-free playback is usually more important than fast reaction 
times, this value should be increased when playing multiple tracks. This is the only setting 
relevant for playback and editing in virtual projects. 

HD/Scrub Buffer: This buffer is put useful during direct playback of HD wave projects. You 
can try out smaller values here to achieve faster reaction times. 

Test Buffer: This buffer is only used for previewing the effects from the effects menu in real 
time. 

Buffer Number: Specify how many of the buffers described above should be used here. 
More buffers increase reliability, but also increase the memory requirements. Reaction 
times become longer. You can check the current buffer usage levels in the status bar to 
the bottom right. We recommend using between 4 and 6 buffers. 

Hard Disk Performance/TrackSpeed 
With the help of the TrackSpeed technology, you can increase the number of hard disk 
drives simultaneously playable in Samplitude. TrackSpeed uses your PC's RAM to 
intelligently and effectively preload the necessary audio data. 

By using TrackSpeed, the internal audio engine of Samplitude can even work using 
multiple tracks with small audio buffers (e.g. 8000 samples or less), without reducing 
performance. This makes short reaction times between user activities possible, for example 
with the mixer and various object handles. 

There are several settings, and TrackSpeed can be customized to your individual needs. 
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Activate TrackSpeed: Set a check mark here to activate TrackSpeed. 

Load File Cache in Stopped State 
If this option is activated, the file cache will be preloaded each time the play cursor is 
repositioned. You can recognize this by the "preloaded cache" notification that appears in 
the bottom right status bar. The next play start happens automatically because the 
necessary audio files are already present in RAM.  

Read Ahead: Enter how many seconds of the VIP can be preloaded in this field. 

Preload at Play Start: This value determines how much of the cache will be loaded at play 
start (in percent). Large values delay start, but increase play stability when track count is 
high. 

The dialog also displays the following project information: 

 Tracks used 
 Total memory requirement 
 Data transfer rate 
 Reading block size 

 

Resampling Quality Options… 
Use these options to set the following resampling/freeze calculations. 

Resampling options 

 Record resampling (chase lock sync, conversion to 44.1 kHz during recording) 
 Playback resampling (scrubbing, chase lock sync, playback at altered sampling rate) 
 Object resampling for new objects (load objects with sample rate different from project) 
 Resampling during bouncing (prior to burning CD) 

Freeze options 

 Keep mono, if possible 
 Use additional samples for object freeze 
 Object freeze without object volume 
 Format (16-bit, 24-bit, 32-bit) 
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Locking options 

 

Select which functions should be disabled by locking objects or tracks here. You can 
select the following options: 

Locking objects 
Disable moving: Prevents objects from being moved horizontally. This avoids unintentional 
offsets between individual tracks for multi-track recordings. 

Disable vertical movement: Prevents objects from being moved vertically. 

Disable volume changes: This deactivates the object's volume handles. 

Disable fade-in/out: Deactivates the fade handles of the objects. 

Disable length changes: Deactivates the length handles of the objects. 

Disable deleting:  This option prevents the deletion of locked objects. 

Disable ripple for locked objects: Locked objects are not affected by functions like "Edit 
-> More -> Delete with time/ripple" or "Edit -> More -> Cut with time/ripple". 

Locking objects/tracks 

Note: Tracks are locked in the track box by activating the lock symbol. 

Disable crossfade editing: This deactivates the crossfade function for set tracks. The 
crossfade can no longer be changed. 

 

Set Preroll Time… 
This option sets the pre-roll time for the cut simulation functions. The cut simulation 
function is started via the corresponding buttons in the punch/playback bar. The pre-roll 
time specifies how long is played until the selected range is reached. 
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Destructive Effect Calculation… 
Choose in the advanced destructive effects calculation options (view page 601) if you want 
to add the effect to the original file when editing destructively, write it into the effect file, or 
create a new effect file for each calculation. 

 

More 
Disconnect Internet 
This menu item allows you to terminate an existing Internet connection directly from within 
Samplitude. 

 

Append Project 
With this function, a project can be appended to another one. The objects or wave files of 
a selected project will be immediately copied to the end of an existing object. 

To execute this command, first click the project you would like to attach the material to. 
Next, select the "Append project" command, followed by a mouse click the project to add 
to. Finally, confirm via the appearing dialog by clicking on the "Add" button. 

 

Add a VIP to a VIP 
Virtual projects may be inserted into other virtual projects and added to the end of already 
existing virtual projects. 

All objects of the appended VIP remain separated and are inserted at the end of the 
existing project from the first track downwards.  

Note: The mixer settings for the inserted project will not be applied with this command. 

 

Add Wave Project to a Wave Project 
"Append Project" allows you to copy a wave project to the end of an already existing wave 
project. 

 

Exit 
The program Samplitude is being shut down. All projects changes will be lost if "Save" is 
not selected. 

 

Recent File 
In the last section of this menu the 10 projects opened last will be displayed.   
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Edit Menu 
This menu features functions that are applicable only to wave projects ("Edit -> More -> 
Copy to"), and others are only for virtual projects ("Cut silence"). 

Edit functions like "Extract" require range to be selected; other functions like "Copy" are 
available only for active objects. The start and end points of the selected range determine 
the start and end points of a cut, and the vertical position indicates the tracks that are 
affected by the edit. 

Activate the auto crossfade function and all the newly created fade edges will automatically 
be made soft or disappear. 

 

Mouse mode 
The following options allow you to select from a variety of mouse modes like in the Mouse 
mode bar (view page 69). 

In addition to the various mouse modes, numerical values in the dialog windows can be 
changed by clicking on the input field or by moving up and down while holding down the 
left mouse button. This turns the play cursor into a vertical double-ended arrow. 

 

"Universal" mode 
This is the preset mouse mode for Samplitude. All necessary functions can be reached 
with the left mouse button. Right-clicking always opens a context menu. 

Detailed information about "Universal" mode is available in "Screen elements -> Mouse 
mode bar -> Universal mode (view page 69)". 

Left mouse button: 

Upper half of track 

Drag: Open and move ranges. 
Click: Place start position of play cursor. 
 
Lower half of track 
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Click:  Selects objects. 
Click + Shift:  Selects multiple objects (including all objects between two clicked objects). 
Click + Ctrl: Select multiple objects. 
Drag + Shift:  Moves an object (or a group of objects) onto a different track; the horizontal 
position remains the same. 
Drag + Ctrl: Duplicate one or more objects. 
Drag + Shift + Ctrl: Duplicates one or more objects on a track; the position is maintained. 
Double click on object: Double click opens the object editor 
Lasso function: Clicking next to an object while dragging to the right activates the object 
lasso to select multiple objects. 
Clicking next to an object, while left-dragging activates the object lasso for selecting 
multiple volume or panorama events. 

Object handles 

Middle handle (top): Changes the object volume. The exact value in dB can be seen in 
the tooltips. 
Side handles (top): Set a fade-in or fade-out for the object. The fade curves can be edited 
in the object editor. 
Lower handle: Sets the start and end position of the object. 

Volume and panorama curves: 

Double-clicking on a curve: Creates a new curve event, while double-clicking again 
deletes an existing event. 

Click on a point: Selects a point. 

Click on an event + Ctrl: Allows selection of multiple events. 

Click on an event + Shift: Multiple selection of start and end events, including all curve 
events in between. 

Drag a selected point: Moves the selected point. 

Drag an event + Ctrl: Moves multiple selected points. 

To delete multiple events, select them and choose "Edit -> Delete curve handle" or simply 
press the "Del" key on your keyboard. 

Right mouse button: Context menu 
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Range mode 
In this mode, only ranges and the play cursor can be manipulated. 

Detailed information about "Range" mode is available in "Screen elements -> Mouse mode 
bar -> Range mode (view page 69)". 

Left mouse button:  

Drag: Stretches and moves ranges with the "Shift" key. 
Clicking beside range: Sets the start position of the play cursor. 
Held down "." period key: Switches temporarily to "Object" mode to move objects. 

Held "-" dash key: Switches temporarily to "Curve" mode to move and edit volume and 
panorama curves. 

Right mouse button: Context menu 

 

Curve mode 
This mode allows Panorama and volume Curves to be drawn, edited and deleted with the 
left mouse button. 

Read more on this in the "Screen elements -> Symbol bars > Mouse mode bars (view 
page 70)" section of the manual. 

Left mouse button: 

Drag to left or right: Dragging the lasso selects multiple volume or panorama automation 
curve events. 
Click once on a curve event: Creates a new event; a double click deletes it again. 
Click on a point: Selects a point. 
Click on an event + Ctrl: Allows selection of multiple events. 
Click on an event + Shift: Multiple selection of start and end events, including all curve 
events in between. 
Drag a selected point: Moves the point. 
Drag a selected point + Ctrl: Moves multiple selected points. 
To delete multiple events, select them and choose "Automation -> Delete curve points", or 
simply press "Del" on your keyboard. 

Right mouse button: Context menu 
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Object mode 
In this mode, objects may be moved and curves may be edited with the left mouse button. 

Detailed information about curve modes is provided in "Screen elements -> Mouse mode 
bar -> Object mode (view page 70)" 

Left mouse button: 

Click:Selects objects. 
Click + Shift: Selects two objects, including all objects in between the two objects. 
Click + Ctrl: Select multiple objects. 
Drag objects: Moves objects in the set grid steps. 
Drag + Shift: Moves an object (or a group of objects) onto a different track; the horizontal 
position remains the same. 
Drag + Ctrl: Duplicate one or more objects. 
Drag + Shift + Ctrl: Duplicates one or more objects on a track; the position is maintained. 
Double click on object: Double click opens the object editor 
Lasso function: Clicking next to an object while dragging to the right or left across multiple 
objects activates the lasso. 
 
Object handles 

Middle handle (top): Changes the object volume. The exact value in dB can be seen in 
the tooltips. 
Side handles (top): Set fade-in or fade-outs for the object here. The fade curves can be 
edited in the object editor. 
Lower handle: Sets the start and end position of the object. 

Right mouse button: Context menu 
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"Object and curve" mode 
In this mode, you can move objects and edit curves using the left mouse button. 

Left mouse button: 

Click:Selects objects. 
Click + Shift: Selects two objects, including all objects in between the two objects. 
Click + Ctrl: Select multiple objects. 
Drag objects: Moves objects in the set grid steps. 
Drag + Shift: Moves an object (or a group of objects) onto a different track; the horizontal 
position remains the same. 
Drag + Ctrl: Duplicate one or more objects. 
Drag + Shift + Ctrl: Duplicates one or more objects on a track; the position is maintained. 
Double click on an object: Opens the object editor. 
Lasso function: Clicking next to an object while dragging the lasso to the right across 
multiple objects selects the objects within the loop. Clicking next to an object while 
dragging the lasso to the left selects multiple volume or panorama curve events. 
 
Object handles 

Middle handle (top object edge): Changes the object volume. The exact value in dB can 
be seen in the tooltips. 
Side handles (top object edge): Set a fade-in or fade-out for the object here. The fade 
curves can be edited in the object editor. 
Lower handle: Sets the start and end position of the object. 
 
Click on a curve: Creates a curve event; a double click deletes it again. 
Click on a point: Selects a point. 
Click on an event + Ctrl: Allows selection of multiple events. 
Drag a selected point: Moves the selected point. 
Drag an event + Ctrl: Moves multiple selected points.  

To delete multiple events, select them and choose "Automation -> Delete curve points" or 
simply press the "Del" key on your keyboard. 

Right mouse button: Context menu 
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Left / Right mode 
Use this function to switch to the Left / Right mode. The right mouse button then controls 
object functions, the left one controls manipulations of the range. 

Left mouse button: 

Double click on volume and panorama automation curves: Creates a new curve event; 
another double click on the same curve event deletes the event. 

Right mouse button: 

Click:  Selects objects. 
Click + Shift: Select multiple objects. 
Drag objects: Moves objects 
Drag + Shift: Moves objects onto a different track; the horizontal position remains the 
same. 
Drag + Ctrl: Duplicate one or more selected objects. 
Drag + Shift + Ctrl: Duplicates one or more selected objects on a track; the horizontal 
position is maintained. 
Click on a point: Selects a point. 

Click on an point + Shift: Allows selection of multiple points. 

Drag selected points: Moves several events. 
 

 

Wave (HDP/RAP) Mouse Mode 
Range 
Use the left mouse button to set the play cursor and select ranges. 

 

Draw Wave 
Draw the sample material at a high zoom level, which can be helpful if you want to remove 
clicks and clipping. 

 

Volume Draw Mode 
In this mode, you can directly manipulate the volume using the mouse. 

 

Scrub Mode 
This mouse mode enables you to preview and control the playback speed. The project is 
played forwards or backwards, depending on the scrub direction. 

 

Zoom Mode 
Click with the left mouse button to zoom into the wave display; zoom out with the right 
mouse button. 

 

Cut mode 
Left click:  Click on an object to separate it at the corresponding position. 
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Right mouse button: Context menu 

 

Pitchshift/Timestretch mode 
The object handles below and in the centre can be used for directly setting the playback 
speed and pitch. 

The timestretch Mouse Mode simplifies working with tempo markers. 

Create BPM markers (Tempo changes) and by directly clicking the desired playback 
position and holding down Shift. You can adapt the tempo by moving the mouse 
vertically while holding down "Shift". 

You can create Grid position markers in "Timestretch" mouse mode by clicking the 
desired playback position and holding down "Alt". Also you can shift the snap by moving 
the mouse horizontally. 

You can create Grid position markers with "Alt" + horizontal mouse movement without 
adjusting time positions, e. g. to manipulate the bar grid and to adjust it to available 
audio or MIDI objects. 

Left mouse button:  
This mode is only different from "Universal" mode because of the handle function (the five 
boxes on the selected objects): 
Middle handles: Object pitch may be changed within a range of +/- 6 semitones. The 
process used may be selected in the object editor. 
Side handles: Set a fade-in or fade-out for the object. The fade curves can be edited in 
the object editor. 
Lower right handle: This handle controls the length changes made to an object via 
timestretching. The same time section (starting length of an object in the wave project) may 
be extended or shortened via timestretching. Select the stretching mode used in the object 
editor. 

Right mouse button: Context menu 

 

Volume draw mode 
This mode allows Volume Curves to be drawn with the left mouse button. You must first 
activate the volume curve on the corresponding track with the "Vol" button to the left in the 
track header. Then, click on the curve to create curve points. These can then be dragged 
to the desired position. 

Left mouse button: Freehand drawing function for volume curve. 

Right mouse button: Context menu 

 

Automation draw mode 
This mode allows automation curves to be drawn by using the left mouse button. Activate 
the automated parameters of the embedded plug-in beforehand with the shortcut "Ctrl + 
Alt + move the corresponding plug-in's handling element". Next, click with the right 
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mouse button on the "Track automation" field in the track editor, and place a check mark 
for the desired parameters. Now in the track you can draw in the curve of the selected 
parameter using the pen in Automation Draw mode. 

The selected parameter's curve can be seen in the track in the foreground; all other curves 
are optionally displayed as thin lines via the context menu.  

Tip:  You can also move any plug-in parameter at any time via the small horizontal faders in 
the track editor's automation box while using "Automation drawing" mode (e.g. touch, 
latch, overwrite, or trim). Latch, Overwrite oder Trim) aktiviert haben. 

Left mouse button:  Freehand draw function for automation curves. 

Right mouse button: Context menu 

 

Spectral mode 
With the "Spectral mode (view page 72)" you can remove noise from a track object, 
without the wanted signal being audibly influenced. Editing can be done directly in the 
Arranger window. 

After calling up "Spectral mode" highlight the unwanted noise by drawing a rectangle 
around it using the mouse. With help from the handle you can adjust the selected area. 
After making the correction, you can see the results in the Wave/Spectral display in the 
Arranger window. 

Left mouse button: Marks the selection box 

Right mouse button: Context menu 

 

Scrub mode 
This mouse mode enables you to preview and control the playback speed. The project is 
played forwards or backwards, depending on the scrub direction. 

Left mouse button:  Clicking the project activates monitoring with control of the 
playback speed. 

Right mouse button: Context menu 

 

Zoom mode 
Left mouse button: zoom in 

Right mouse button: zoom out 

 

Color mode 
Left mouse button: Changes the background color of the object 
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Right mouse button: Changes the object's wave form color  

 

Object Mode 

Detailed information about object modes is available in "Screen elements -> Toolbars - 
overview -> Object modes (view page 77)". 

 

Undo 
Samplitude offers a secure way of tracking your changes in Virtual and Wave Projects, 
which makes it easier to undo work steps. Up to 100 changes can be kept in the memory 
using the undo function in "Menu > File > Program Preferences  > Undo Definitions (view 
page 497)". 

When editing audio material with destructive effects ("Offline Effects menu"), the Undo 
option only works when the option "Create copy" is activated in each dialog. 

Shortcut:  Ctrl + Z 

 

Restore 
"Redo" (undoes) the most recent Undo command. 

Shortcut:  Ctrl + Y 

 

Undo History 
A list featuring the most recent executed commands appears.  

 

In this dialog, you can return to an earlier work stage. This list can be removed in the "Edit -
> Delete undo levels (view page 513)". 

 

Delete Undo History 
Deletes the undo levels of a project. 

 

Copy 
Copy 
The current range is copied into the clipboard. Please note that any previous clipboard 
content will be deleted. 

Shortcut:  C, Ctrl + C or Ctrl + Ins 
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Copy as… (Wave-Project) 
This function copies the selected range from a wave project  into a new file. 

Shortcut:  Shift + C 

 

Copy + Clear 
Copies the current range to the clipboard (clip), removes it from the project, and replaces it 
with silence. 

Shortcut:  Ctrl + Alt + C 

 

Cut 
Cut 
Virtual projects (VIP) 
In the case of virtual projects, the selected area will be copied into the virtual clip (VirtClip) 
and removed from the active project. The VirtClip (view page 427), like the virtual projects, 
does not contain the actual audio files, just the links to them. The VirtClip contains the 
same count of tracks as the selected area. 

Shortcut:  X 

 

Wave projects 
The data of the selected range is copied into the clip (view page 437) and removed from 
the current project. Data behind that range takes its place. The Wave project is reduced in 
size by the length of the removed segment. 

If you cut a piece out of a mono wave project, the clip will be a mono wave project, and if 
you cut out a piece from a stereo wave project, the clip will also be a stereo wave project. 
Similarly, the bit resolution and the sample rate from the project are applied. The old 
content of the clip is overwritten. 

After the function has been carried out, the play cursor will be at the cut edge of the 
removed segment. You can now place the clip back into the wave project with the 
command "Paste from clip". 

 

Cut with Time/Ripple 
This command deletes the marked range and copies it into a clip. The material behind the 
removed range will be moved forward by the length of the range (ripple, shuffle). 

Shortcut:  Ctrl + Alt + X 

 

Split 
Split Objects 
Use this option to split all selected objects at the cursor position and separate them into 
individual objects. 
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If the range is selected, the cut will be made at each border. Ensure that the object that is 
to be edited is contained within the active range. If necessary, all objects may be activated 
by double clicking on the range selected in the range bar. In this case, it is not necessary to 
select the objects beforehand.  

Shortcut:  T 

 

Split objects at Marker Positions 
The object is split into pieces at the marker positions that lie within the object borders. The 
newly created objects will be named after the previous markers. 

 

Split Objects at Track Marker Positions 
The object is split into pieces at the marker positions that lie within the object borders. The 
newly created objects will be named after the previous track markers. 

 

Split Objects at Audio Marker Positions 
The object is split into pieces at the audio marker positions that lie within the object 
borders. The newly created objects will be named after the previous audio markers. 

 

Heal/Unsplit Objects 
This command recombines two objects that have been split without any audio calculation. 
To do this, the objects in the VIP must be positioned exactly beside each another, and the 
audio material must be connected. The objects must therefore be different but sequential 
pieces of audio material from the same wave project. If this not the case, the command will 
not function properly. 

Before executing the command, select both of the objects that were split previously. All of 
the second object's properties, like fades and effects, will be discarded. The resulting 
combined object will feature the properties of the first object. 

 

Insert 
Paste/Insert Clip 
The data contained in the clip (view page 426) or VirtClip is inserted at the current position 
of the play cursor (position line) or at the beginning of the current range. 

In the "Link objects" modes, objects behind the insert point are moved to the end. In all 
other modes, the inserted material replaces the existing objects. 

A new area will automatically be defined for the inserted files.   

Shortcut:  V, Ctrl + V, Shift + Insert 
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Paste with Time/Ripple 
This menu option inserts the clip at the position of the cursor or at the start of the range. 
The audio material after the cursor position will be moved down by the length of the range 
(ripple, shuffle). 

Shortcut:  Ctrl + Alt + V 

 

Overwrite with Clip 
The current range will be overwritten with the contents of the clip. The length of the clip will 
not be reduced. The data previously located at  this position will be overwritten. 

In virtual projects, the selected range determines the start position and track for the clip 
contents. 

Shortcut:  Alt + V or Insert 

 

Mix with Clip 
The content of the range is mixed with the content of the clip. This command is available 
only in the destructive wave edit mode. Please note that with this function both 
components are entered into the mix at 100%, being added together. This can cause 
overmodulation. You may have to adjust the amplitude of the project by normalizing prior to 
this. 

 

Crossfade with Clip 
The content of the range is crossfaded with the content of the clip. This command is only 
available in the destructive wave edit mode. In this case, the position of the play cursor 
specifies the end of the clip to be faded with the wave project. The length of the clip sets 
the length of the crossfade. 

 

Delete 
Virtual projects (VIP) 
With this command you can delete selected objects from the virtual project. For selected 
ranges, objects as well as track automation curve points above them will be deleted. 

In connection to the button "Link objects on 1 track" in the button bar, the objects lying 
behind the deleted area of the corresponding track are pulled up, shortening the total 
length of the track. In other object modes, the range is replaced by silence. 

Use "Object -> Cut objects -> Delete objects (view page 546)" to remove the objects from 
the range. 

You can delete any individual automation curve handle by selecting it in the project window 
using the mouse and going to "Edit -> Delete curve points". 

Shortcut:  Del 
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Wave projects 
The files of the selected area will be deleted and the segment of the wave project located 
after the area will be pulled into its place. 

Caution: If you are using offline Audio edit mode and have deactivated the "Undo" function 
("Options -> Program preferences -> Undo Definitions (view page 497)"), the files cannot 
be restored. 

 

Delete with Time/Ripple 
This command deletes the marked range. Material later than the end of the range will be 
prolonged by the length of the range. 

Shortcut:  Ctrl + Del 

 

Extract 
Press "Extract" to trim your project by deleting the areas outside of the selected segment. 

 

Virtual projects (VIP) 
The extraction function results in all objects outside of the selected segment in a virtual 
project being deleted. All tracks stay unchanged, even if no object is found in the selected 
segment. This function is not track-specific.  

Individual objects can be cropped using "Object -> Trim Objects (view page 548)". 

 

Wave Projects 
In "Wave editing" mode, only those wave project segments below the selected area 
remain. The files before and behind the range are deleted. 

 

Silence 
Insert Silence 
This command inserts silence to all tracks at the position of the current play or at the start 
position of the selected range. The objects will be split at this position and the files after it 
will be added after the silence. 

If a range is selected, its length will be adapted as default. The selected range is not 
adjusted after the operation. It's possible to change the value in the input field. The project 
is extended by the length of the inserted object. 

 

Strip Silence 
This command cuts the objects apart at the position of the silence. Before applying the 
command, add a threshold value in the dialog for the silence and used signal. The cut 
objects are marked to make it easier to delete them using the "Del" button. 

Threshold for silence detection (dB): If the signal falls below this value, the object will be 
cut at the corresponding position. 
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Threshold value for used signal (dB): If the signal rises above this value, the object will be 
cut at the corresponding position. 

The "Minimum length of silence" parameter sets the length which silent passages should 
be applied so that they can be selected and deleted. This enables you to remove very short 
passages of silences from the cut. 

With the "Crossfades" option, you can create automatic crossfades between at the cut 
positions of the objects. 

 

Clear 
The data of the selected area will be deleted. The files found after the selected area will not 
be moved, leaving silence in the tracks selected. The length of the track stays unchanged. 

Shortcut:  Alt + Del 

 

Tempo 
Tempo Map Dialog... 

Detailed information about the "Tempo Map" dialog is available in chapter "Tempo Editing 
(view page 300)". 

 

Tempo Map BPM Mode 

Detailed information about the "Tempo Map BPM Mode" is available in chapter "Tempo 
Editing > Tempo Map Modes: BPM Mode / Grid Fit Mode (view page 302)". 

 

Tempo Map Grid Fit Mode 

Detailed information about the "Tempo Map Grid Fit Mode" is available in chapter "Tempo 
Editing > Grid Tapping" (view page 305). 

 

Insert Tempo Change 

Here you open up the "Tempo and Time Signature Dialog (view page 310)" in order to 
insert tempo change. 

 

Insert Time Signature Change 

Here you open up the "Tempo and Time Signature Dialog (view page 310)" in order to 
insert time signature change. 
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Insert Grid Position Marker 

Detailed information about the "Grid Position Marker" is available in chapter "Tempo Editing 
> Grid Position Marker". (view page 305) 

 

Tempo Scaling 
With this menu command all BPM values of the selected tempo curve points can be scaled 
with one adjustable factor. 

 

Ignore All Tempo Markers / Use Project Tempo 
With this option you can ignore any previously created tempo markers in your project, so 
that only the project tempo observed. 

 

Metronome Active 
This command activates/deactivates the metronome. This function can also be activated 
via the "Click" button in the transport controls. 

 

Metronome options 

Detailed information about this is available in "File -> Program Preferences -> Metronome 
Options (view page 84)". 

 

Create click track 
The new command Menu Edit > Tempo > Create click track creates an audio track, 
which contains all metronome click as objects. 

 

Range 
Range All 
This expands the range to include the entire project. Double clicking the timeline or 
pressing "A" selects the range in the selected track; double clicking again or pressing "A" 
again selects the range over all tracks, and double clicking or "A" once again restores the 
simple timeline selection. 

Shortcut:  A 

 

Manipulate Range 
Move Range Start Left 
This function moves the beginning of the range in the current arranger window one grid unit 
to the left.  The length of the movement depends on the set grid value. This may be 
adjusted via "Project options -> General" (shortcut: "I", "Ctrl + Shift + #"). 

Shortcut: "Alt + ÷" (number block), right arrow 
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Move Range Start Right 
This function moves the beginning of the range in the current arranger window by one grid 
unit to the right.  The length of the movement depends on the set grid value. This may  be 
adjusted via "Project options -> General" (Shortcut: "I", "Ctrl + Shift + #"). 

Shortcut: "Alt + *" (number block), right arrow 

 

Move Range End Left 
This function moves the end of the range in the current arranger window one grid unit to 
the left.  The length of the movement depends on the set grid value. This may be adjusted 
via "Project options -> General" (shortcut: "I", "Ctrl + Shift + #"). 

Shortcut: "Alt + -" (number block), "Shift + right arrow" 

 

Move Range End Right 
This function moves the end of the range in the current arranger window one grid unit to 
the right.  The length of the movement depends on the set grid value. This may be adjusted 
via "Project options -> General" (Shortcut: "I", "Ctrl + Shift + #"). 

Shortcut: Alt + +" (number block); Shift + right arrow 

 

Range to Beginning 
Choose this option to extend the currently marked range to the beginning of the project 
(Wave Project or VIP). 

 

Range to End 
Choose this option to extend the currently marked range to the end of the project (Wave 
Project or VIP). 

 

Flip Range Left 
Choose this option to flip the currently marked range to the left (this swaps the start of the 
marked range to the end of the marked range.) 

Shortcut:  Ctrl + Shift + left arrow 

 

Flip Range Right 
Choose this option to flip the currently marked Range to the right. (What used to be the 
end of the marked Range is now the beginning of the marked Range.) 

Shortcut:  Ctrl + Shift + right arrow 

 

Find zero crossings 
Beginning of Range -> 0 
Choose this option to move the beginning of the currently selected range to the next zero 
amplitude crossing. "Zero" is the next sample value featuring a ZERO value or that 
indicates the boundary between a positive and a negative sample value (or vice versa). This 
function is especially useful when searching for loop points. Remember to zoom into the 
waveform display far enough so that you'll be able to see the actual changes in the 
arranger window. 
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Shortcut:  Ctrl + Page up 

 

Beginning of Range <- 0 
Choose this option to move the beginning of the currently marked range left to the previous 
zero amplitude crossing. 

Shortcut:  Shift + Page up 

 

End of Range -> 0 
Choose this option to move the end of the currently selected range to the next zero 
amplitude crossing. 

Shortcut:  Ctrl + Page down 

 

End of Range <- 0 
Choose this option to move the end of the range left to the previous zero amplitude 
crossing. 

Shortcut:  Shift + Page down 

 

0 -> Range <- 0 
Choose this option to move the beginning of the range right to the next zero amplitude 
crossing, and to move the end of the range left to the previous left zero amplitude crossing. 

 

Range start to left marker 
Choose this option to extend the Range to the next marker on the left. 

Shortcut:   Shift + F2 

Note: This command also takes set object audio markers into account as soon as they 
have been selected via menu "File > System preferences > System/audio -> Design -> 
View options". 

 

Range Start to Left Object Border 
The start of the range is set to the next object edge on the left. 

 

Range end to right marker 
The end of the range is set to the next marker to the right. 

Shortcut:   Shift + F3 

Note: This command also takes set object audio markers into account as soon as they 
have been selected via menu "File > System preferences > System/audio -> Design -> 
View options". 

 

Range End to Right Object Border 
The end of the range is set to the next object edge on the right. 



 

5 2 2  E D I T  M E N U   

 

Range Over All Selected Objects 
Choose this option to extend the range over all selected objects. 

 

Remove Range 
This command removes the current range from the grid and marker bar. This function is 
also available by right clicking in the grid and marker bar. 

 

Range Not Over Tracks 
This command selects the selected range from the grid and marker bar only, and not in the 
tracks. Switch between the "Range not over tracks", "Range over current track", and 
"Range over all tracks" functions by double clicking in the selected range in the grid and 
marker bar. 

 

Range Over Current Track 
This command selects the selected range from the grid and marker bar as well as in the 
selected track. 

 

Range Over All Tracks 
This command selects the selected range from the grid and marker bar as well as in all 
selected tracks. 

 

Range Length 
Set the range starting from the play cursor to lengths of 1, 2, 4, 8 or 16 beats here. 

 

Split Range 
Use this function to split the arranger window into three sections. In this case, the upper 
section displays the entire project in an overview, while the left lower section displays the 
start of the range and the right lower section displays the end of the range (enlarged 
sections).  

The range borders may be set precisely in the lower sections, provided the grid setting 
"Grid/frames" is set in the "Project options" beforehand (shortcut: "I"). 

Shortcut:  B 
Back to range: "Shift + B" 

 

Split Range for Video 
This function is especially useful when working with AVI videos. The upper section displays 
the entire project, the lower left section displays the range start, and the lower right section 
indicates the range end. For the lower sections, a zoom depth of 1 frame is preset to make 
image-precise cutting and editing possible. 

To undo the split, restore the original range by pressing "Shift + B". 

 

Store Range 
Samplitude enables ranges to be stored by selecting the corresponding range number. 
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All current ranges in a project may be viewed via "Tools -> Manager -> Range manager". 

Shortcut:  Alt + F2 ... F10 

"Alt + F4" however, should not be used, since this is a Windows command that closes the 
current screen. Similarly, "Alt + F9" should not be used either, since this is used for the 4-
point cut command in Sequoia.  

The "Other..." dialog may be used to define additional ranges featuring freely assigned 
names. 

Shortcut:  Alt + F11 

 

Get Range 
Open previously saved ranges via this command. Getting a range is also possible during 
playback. This enables you toggle between various ranges in order to compare them 
acoustically. 

Shortcut:  Ctrl + F2 ... F10 

Ranges may be named and accessed via "Tools -> Manager -> Range manager". 

 

Get Range Length 
Use this function to set the current range to the length of the corresponding saved range. 

Shortcut:  Ctrl + Shift + F2 ... F10 

 

Range Manager… 
The "Range manager" displays all saved ranges of the current project. 

Detailed information about the "Range manager" is available in the chapter "Manager -> 
Range manager (view page 149)". 

Shortcut:  Ctrl + Alt + Shift + B 

 

Recall Last Range 
Use this function to recall the last selected range. Repeated application accesses ranges 
up to five levels back. 

Shortcut:  Shift + Backspace 

 

Crossfade 
Crossfade editor 
Samplitude features a professional crossfade editor. 
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The crossfade editor is opened by clicking the toolbar button or via menu "Edit -> 
Crossfade editor". You can also use the keyboard shortcut "Ctrl + F". 

Use the crossfade editor to conveniently and efficiently edit all aspects of a crossfade. All 
changes are non-destructive and can be undone. 

 

Crossfading with the crossfade editor 
In the VIP, select the objects which you wish to fade into and open the crossfade editor. 

 

The following editing options are available for selection: 

Crossfade length: The length of the crossfade may be set in different sized steps. Clicking 
the "+" / "-" buttons increases/decreases the length in small steps, the "++" / "--" buttons 
in larger steps. Use the "-?+" button to customize these step effects as needed. The 
crossfade length can also be defined by a selected range in the VIP by clicking on the "Get 
range length" button in the "Range" menu. This range has to be selected before opening 
the crossfade editor. 

Fade in/fade out: There are plenty of different curve types available for selection for the 
crossfade: 

 Linear (0) 
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 Exponential 
 Logarithmic 
 Cosine 
 Sine/cosine 

The faders may still be used to change the curves in the corresponding available range. 
Linear curves require less computer power than non-linear. 

Note: The settings for fading in/out in the crossfade editor are applied to the selected 
object if it does not overlap any other object. 

Global settings: Set 

The current settings are defined as by default. This is useful in case an object has been 
split with the "T" key and you want to create a crossfade between the two objects. When 
opening the crossfade editor, the specified settings are set as default. 

Global settings: Get 

Use this button to get the presets of the crossfade editor. 

Get range length: The range length of the range selected in the VIP is set as the crossfade 
length. 

Fade offset: Specify how much of the fade should be outside of the object border. 
Usually, the entire fade is located within the borders of the object, that is, the fade starting 
point is at the start of the object (0%) as is normal with fade ins/outs of individual objects. If 
the fade becomes part of a crossfade, it may be necessary to modify it. For example, if the 
second object starts with a drum beat, it would be better to execute the crossfade 
beforehand in order to keep the "attack" of the drum beat.  

The value may be changed from 0% (fade within the object borders) to 50% (fades 
symmetrical to the object borders) to 100% (fade outside the object borders) – the object is 
then stretched by the percentage of the fade length. The "actual" beginning of the object is 
displayed as a dashed line. 

With a fade offset of over 0%, make sure that the corresponding audio material is available 
in the wave project, otherwise it may be the case that an object with a modified fade offset 
cannot be faded in or out. For example, if the object starts at the exact beginning of the 
wave project, you will no longer be able to crossfade if the fade offset rises above 0%. 

Crossfade off: The "Crossfade off" button deactivates the crossfade of the selected 
object. The fade out time of the first object is set to 0.  

Play/stop: This button starts playback in the selected range or at the cursor position. 

Move crossfade position: The end of the first object and the end of the second object are 
moved equally. The ++/--/+/- buttons are used to set the crossfade length. 
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Enable asymmetrical crossfades: The fade offset settings of both objects are no longer 
connected to one another and can therefore be set independently of one another. 

 

Auto Crossfade Active 
With this option, all newly recorded or cut material in a VIP (or material that is dragged from 
a wave project into a VIP track) has an automatic fade-in applied to the start and end. 

Every object may be assigned a standard fade-in, and this may be edited via the object 
editor fade menu via "Get/set global crossfade".  

 

If two objects overlap in this mode, a real-time crossfade will occur at the intersection. The 
fade settings can be modified using a double click on each object in the object editor. 

If required, you may manually edit each intersection with the crossfade editor or handles. 

 

Batch Processing... 
Use batch-processing to automate long work processes. This makes it possible to define 
an editing sequence, which will be applied to all selected files. 

Every task will be entered into the task list. Define multiple batch tasks, which will then be 
executed one after the other. 

Possible editing options: 
 Normalization 
 Linear fading (in and out) 
 Real-time effects 
 Time Stretching/Pitch Shifting 
 De-clipping 
 Remove DC offset 
 Target format settings: Word width (8/16/24/32 float), sample rate, stereo/mono 

settings, file format conversion, compression process,  
 memory settings. 

For example, you can normalize a whole list full of 24-bit wave files to 96%, apply 5 ms 
fades at the beginning and the end of each file, compress them with the multi-band 
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compressor, change them all to 16-bit mono, resample them on 22 kHz, and then save 
them all as MP3 files. 

 

Tasks 
The task list is on the right edge of the batch processing window. New jobs are created by 
activating the “Add job” button. If you select a job (with a mouse click), the four settings 
tabs are displayed (source files, effects, target format, target files). "Remove job" removes 
the selected job. “Perform jobs” starts the batch processing. 

As long you don't close down Samplitude, all the tasks remain saved until execution, even 
if you close the batch processing window in the meantime. 

 

Source Files 

 

Create the list of the files for editing with the "Add file" button. Multiple selection is 
possible. Select "Add directory" to add all of the audio files within a directory (including all 
subfolders). All file formats that Samplitude can import may be loaded. "Save list" creates 
a playlist in *.m3u format for selection later. The option "Detect L&R files" makes it 
possible to edit left and right files as stereo. "Remove” deletes all selected list entries. 
"Remove all" deletes the complete list. 
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Effects 

 

1. Normalize: Enter a target maximum amplitude value in % or dB. For example, a value of 
75% corresponds to -2.5. Alternatively, you may also enter volume changes in dB. Detailed 
information about normalization is available in "Effects -> Amplitude -> Normalize (view 
page 603)". 

2. Master effects: To avoid redundancy in the  batch processing dialog, effects settings 
have been integrated with the mixer preset files. 

The Samplitude mixer enables all of the mixer settings to be exported as a mixer preset. 
Click the "Save mixer settings" button in the mixer. This is located under the snapshot 
storage slots. 

When you load the *.mix file into the batch-processing function via "Load preset", all effect 
settings for the master channel will be calculated into the file batch. "Edit preset" opens a 
special FX routing dialog that provides access to all of the effect parameters. 

Detailed information about the FX routing dialog is provided in the chapter "Mixer - buses 
and routing -> Effects routing/plug-ins dialog (view page 174)". 

Additional effects: Besides the master effects of the mixer presets, non-real-time effects 
such as "Resampling/Time Stretching", "Remove DC offset", and "Remove modulation" 
may also be applied. The "Settings" button opens the corresponding effects dialog. 

3. Fades at the start and end of projects Linear fades may be added to the start and 
end of files. The fade lengths may be set freely.  
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Target format 

 

All settings in this dialog can be saved as presets. You can freely choose the bit resolution 
(8/16/24/32 bit float), the sample rate, stereo/mono/left/right as well as the save format 
with the corresponding format settings. 

You can find out more about sample rates in the "File > Effects > Sample manipulation > 
Adjust sample Rate (view page 682)". 

You can find out more about file formats in the "Menu > File > Export  (view page 449)". 

 

Destination Files 

 

There are various ways to save edited files: 
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Replace source files: The original file is replaced with the edited one. If the file is used in a 
VIP, the VIP will be closed first. 
Save files with new name to the source directory: The edited file is copied back into the 
source directory and the file name will be expanded with an additional "file name prefix" 
and "file name suffix". 
Save file in the following directory: The edited file will be saved in the selected directory; 
the file name will be extended to include the "file name prefix" and "file name suffix". 
Remove file name suffix with numbers: This option removes numbers added by 
Samplitude's batch processing function (e. g. "_48kHz" or "_T001"). 
Delete jobs from list after processing: If you select this option, a job that has been 
processed will be removed from the list. 
"Delete source files after processing" may also be applied. 
Create subdirectories: This option saves all files in the same subdirectory structure 
including the source path. Subdirectories are created as required. 

 

More 
Range Editor… 
This window specifies the currently marked range's start and end positions and length in 
various measurement units. 

 

Adjustments to the parameters have the following effect: 

Change start of range -> Range end remains constant 
Change range length -> Range start remains constant 
Change range end -> Range start remains constant 

 

Edit time display 
Here you can set and the number fields for the range position (Alt + Num pad 1), range 
length (Alt + Num pad 2), and range end. (Alt + Num pad 3). 

Shortcut:  Alt + Num pad 1 … 5 
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Track Menu 
Insert New Tracks 
Add One Track 
Use this function to add a new track to the last track in the project. 

 

Add Several Tracks 
To add multiple tracks, select the command "Add several tracks". A dialog window 
appears to select the desired number of new tracks. 

The maximum track count in Samplitude is limited to 999 stereo tracks. Each of these 
tracks can also act as a AUX bus and/or as a submix bus. 

 

Insert Track(s) 
This command adds one empty track at the end of a selected track. 

 

Insert Several Tracks… 
To add multiple tracks, select the command "Insert several tracks". A dialog window 
appears to select the desired number of new tracks.  

 

New MIDI Track 
This command adds a MIDI track to the end of a selected track. 

 

New Folder Track 
This command adds a folder track in front of the selected track. If a range across several 
tracks is selected, each of these tracks will be added to the new folder track. 

Detailed information about folder tracks is available in "Screen elements -> Program 
interface - overview -> Folder tracks (view page 61)". 

 

New Submix Bus 
Add a submix bus as a track here. The new bus will be added below the selected track. 

 

New AUX Bus 
Add an AUX bus (view page 426) as a track here. The new bus will be added below the 
selected track. 

 

New Surround Bus 
You can mix down your project in Surround sound retroactively. Use this command to 
create a Surround bus that will be placed below the selected track. All tracks routed to one 
Surround bus receive a Surround panorama module instead of the normal panorama slider 
to control the Surround position of the output signal. 
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As soon as you have creates a Surround bus, you can route the exiting signal of an object 
to this Surround bus and set the Surround panorama independently from the track 
panorama settings. 

The Surround master is created simultaneously when a Surround bus is created; the 
individual channels are routed to the different output devices. 

 

New Surround AUX Bus 
Use this command to create a new Surround AUX Bus. 

A Surround AUX bus allows integration of Surround effects. This may be fed by a normal 
track or by a lower lying Surround bus. The AUX bus itself can again feed a Surround bus 
with a higher track number. 

 

Copy tracks 
Use this function to copy tracks that are selected to the track header (view page 98), i.e. in 
the clipboard. 

If you want to copy several sequential tracks, drag out a selection over all of the tracks that 
should be copied. The selection does not need to be adjusted to the track contents. 

 

Next, load the selected tracks into the clipboard via "Copy tracks", and then insert them as 
additional tracks above the last selected track with the command "Insert tracks". This 
results in all track settings, save the AUX send paths, being adopted. 
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Paste Track(s) 
This function inserts all tracks copied into the clipboard (VirtClip (view page 427)) above the 
selected track. 

 

Deletes Track(s) 
This function deletes all selected tracks. 

 

Track type 
Here you can specify whether the track should be an audio track or a MIDI track. 
Moreover the track can be defined as a submix and/or AUX bus. 

So you can define the track as Economy Track. (view page 28) 

 

Input 
Stereo in: The channel input is switched to stereo and the signal will be picked up on two 
channels. 

Mono in: The channel input is switched to mono and the signal will only be picked up on 
one channel. 

Mono mix in: The track input is switched to mono, the signal is recorded like a stereo 
recording (dual channels), and then mixed into a single channel. 

MIDI track record: If you click this menu entry the MIDI section of the track editor will 
open, allowing you to record MIDI files. 

 

Group track controls 
With this function you can group control functions like faders, record or mute buttons from 
different tracks. If you want to group track controls, select the desired elements while 
holding down the "Ctrl" key and then activate "Group track controls". Control groups will 
be automatically called up when one of the elements of this group is activated. 

Example: When muting a submix bus, no AUX channels from the original tracks will be 
sent. An additional control group can be created in order to simultaneously control the 
faders of several tracks. By clicking and simultaneously using the Shift + Ctrl keyboard 
shortcut individual faders can be moved in the opposite direction. By clicking together with 
the shortcut "Shift + Ctrl", individual faders may even be moved in opposite directions. 

Note: Please note that only one control element may be present per control group. 
Overlapping control groups can't exist. 
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Ungroup track control group 
You can use this function to ungroup. To do so, click on an element in the control element 
and select "Ungroup track control". 

 

Hide Track 
This command hides the selected track from being displayed in the track view. It will, 
however, remain visible in the mixer and will continue to play there. 

The menu item "Show all tracks" shows this and all other hidden tracks. 

An overview of all tracks including their status of visibility is included in the track manager. 
("Tools -> Manager -> Track manager" shortcut: Ctrl + Shift + S"). Hidden tracks may be 
recognized in the track manager by the lack of a tick beside "Arrangement". In the column 
beside it to the right, you can hide the track in the mixer window as well. 

Detailed information about the track manager is provided in "The Manager -> Track 
manager" section. 

 

Unhide All Tracks 
Use this command to show all hidden tracks in the arranger once again. 

 

Track size 
Maximize Track 
The activated track is maximized, i.e. it is displayed in a large view. 

 

Minimize None 
All minimized (and maximized tracks) are displayed in the same size. 

 

Display Subtracks 
This command opens the subtracks for a folder track. 

 

Freeze Track 
With "Track freeze", you can have the selected file rendered into a wave file which replaces 
every object on the chosen track. The object and track effects are also added, reducing 
the CPU load resulting from CPU intensive effects and plug-in calculations. 

The advantage of "Track freeze" is that the frozen track is saved in a separate VIP and can 
be edited or recalled at any time. This allows you to work effectively, highly flexibly, and in a 
way that reduces strain on the computer's resources. 
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Detailed information about freezing plug-ins is provided in "Software instruments/VST plug-
ins -> Freezing plug-ins (Freeze)". 

 

Track Freeze for AUX Buses/Submix Buses 
Submix and Aux bus tracks may also be frozen. This way, you can get a complete group of 
tracks to release the required CPU load including all effects, fades, crossfades, and 
automation settings in one step. 

 

Submix Bus 
 Tracks routed onto the submix bus are not changed. They remain the same. 
 The submix bus input is muted 
 The file created while freezing is inserted into the submix track as an audio object. 
 Changes made to the tracks after freezing which are routed to the submix bus have no 

effect on the playback of the frozen submix bus. 

 

AUX Bus 
 AUX send settings in tracks are taken into account when freezing 
 Tracks routed onto the frozen AUX bus are not changed but remain unchanged instead 
 The AUX bus input is muted 
 The AUX send fader of the affected tracks is colored blue. 
 An asterisk is added in front of the name of the AUX send fader in the mixer. 
 The file created while freezing is inserted into the AUX track as an audio object 
 After freezing, any changes made to the tracks that transmit to the AUX bus are not 

updated in the file that was created during the freezing process. 
 

Edit Track Freeze 
This command opens the temporary trackbouncing VIP in which the frozen track is saved. 

You can make any changes you like here (just like in any other project), from object cuts via 
effect calculations in the track and object to adding other wave projects. 

 

Frozen Submix/AUX Bus 
If you have changed something on tracks that route to a frozen submix bus, you should 
"unfreeze" the bus using the "Track unfreeze" command and then refreeze it immediately 
afterwards with "Track freeze" in order to keep it up-to-date. 

 

Unfreeze Track 
This menu item removes the wave file created during "Track freeze" and brings back the 
track that was saved in the temporary trackbouncing VIP. 

Changes made in the temporary freeze project are also applied to the track. 

Note: If you add additional tracks which were created when freezing a track to the project, 
"Track unfreeze" will no longer be usable. 
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Track Effect Settings 
Track Routing Dialog 
You can apply all important settings for real-time effects In the track routing dialog. 

 
 

Track Routing Dialog - Routing 
All available effects are listed in the effects list in the respective context (track, object, or 
master). By right clicking, you can directly access the settings dialog of the respective 
effect. The check boxes for volume, pan and gain knobs as well as AUX gain knobs are 
grayed-out, because they are represented in the list only for the purpose of ordering the 
effects. 

The order of the effects in the mixer tracks and the mixer master may be configured freely; 
however, in the object, this order is restricted. You can change the position of an effect 
with the up/down buttons in the "Effects sequence" section. "Reset" changes the order 
back to the previous sequence. 

There are two entries for "AUX send" (pre and post) in the mixer tracks. A right-click opens 
the AUX routing dialog. Depending on whether the AUX send controller is switched to pre 
or post, the corresponding entry in the signal chain will be used to junction off the AUX 
signal to the AUX bus. DirectX and VST plug-ins may also be routed pre and post in a 
similarly flexible manner. 

 

Track Routing Dialog - Dialog Buttons 
Save/Load/Delete: Manage your individually customized settings here. 

All Tracks: The respective settings are applied to all tracks. 
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Reset: Returns all settings to the Samplitude basic settings. 

Copy/Paste: Use these buttons to quickly apply the settings to different tracks/objects. 

Edit: Opens the dialog for the active effect/plug-in. This can also be achieved by right 
clicking the desired list entry. 

On/Off: Switches the respective activated effect "on" or "off". Activating or deactivating the 
check box preceding the corresponding effect/plug-in has the same effect. 

Remove: You can also remove internal Samplitude effects (FX inserts) instead of just 
deactivating them if you want to save resources. "Unloaded" effects are displayed with a 
minus sign in the box on the left side. 

Play/Stop: Plays and stops playback at the current cursor position. 

 

Copy Track Effect Settings 
This command allows you to copy the complete effects settings of the active track into the 
clipboard. This includes the order and parameter adjustments of all internal effects 
including those of DirectX and VST plug-ins. 

 

Insert Track Effect Settings 
This command allows you to insert the complete effects settings from the clipboard in a 
track. This includes the order and parameter adjustments of all internal effects including 
those of DirectX and VST plug-ins. 

 

Reset Track Effect Settings 
This command resets all track effects settings to default values, i.e. no effects are applied. 

 

Save Track Effect Settings... 
Here you can save custom track effect setting as .TRK files. 

 

Load Track Effect Settings 
 Here you can load previously saved/preset track effect settings in the selected track. 

 

AUX Sends 
Use this dialog to create new AUX sends or determine the panorama out of existing AUX 
buses. You can also switch the AUX track to pre-fader or post-fader or deactivate it. 
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Description of the "AUX Sends" dialog 
You can enter the send level of each AUX bus numerically or pull the orange bar in the gray 
field from left to right. 

By default, all AUX buses are routed "post" in Samplitude. To switch them to "pre", activate 
the corresponding box. 

New AUX Bus: Clicking this button creates a new AUX bus. 

Reset AUX Sends: All AUX sends settings are reset. 

 

Mono Effect Processing 
Effects for this track will be calculated in mono. 

 

VST MIDI out recording: 
By activating the option "VST MIDI Out recording" on a track you can record all received 
VSTi MIDI Out data in the corresponding track.  

 

Track Options... 

 
 

Audio 
Change settings for recording and playback of audio tracks here. These settings also 
include settings for audio created by VST instruments. 

Record: Select the sound card device to record this track here. 

All Tracks: Applies the same recording device selected for this track to all tracks. 
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Track/Dev+: Sets the recording device for this tracks to the next, e.g. if inputs 1 + 2 of the 
sound card are set, it will be switched to 3 + 4. The button with the "+" sign to the right 
sets the recording and playback devices to the next ones simultaneously. 

Playback: Select your sound card device to record this track. You can also select a bus 
track. 

All Tracks: Applies the same record device chosen for this track to all tracks. 

Track/Dev+: Sets the playback device to the next, e.g. if set earlier to outputs 1 + 2 of 
your sound card, this will be switched to 3 + 4. The button with the "+" sign to the right 
sets the recording and playback devices to the next ones simultaneously. 

Track Type: This indicates if the track is a aux/submix bus. One track may also be both. 
"Economy (view page 28)" as well as "2-channel Surround" modes may also be activated 
for this track. 

Timeshift/Delay: Use this field to set an offset for an entire track. Positive values cause the 
playback from this track and the play cursor display to be delayed by the amount entered. 
Negative values cause playback to occur earlier. All other tracks and the play cursor will be 
delayed in relation to the entered value. To the right of the input field, you can select the 
unit for the time delay. 

Colour: Select a color for the corresponding track and its objects. 

Effects/Routing: This button opens the effects routing dialog for the corresponding track. 

Track Name: Use this field to change the name of the current track. 

 

Recording 
The section "recording" contains settings for recording from audio and MIDI. 

File: Indicate the name of the file to be recorded here. 

Assign file name automatically 
Click "All tracks" on the right of the file name box and then select the desired command 
from the popup that opens: 

 File name_track number: Transfers the file name of the track to all other tracks and adds 
the corresponding track numbers to them, for example, funky_01.wav, funky_02.wav, 
etc. 

 Project name_track number: Transfers the project name to all tracks and adds the 
corresponding track number to them, for example, demo_01.wav, demo_02.wav. 

 Track name: Sets the track name of each track as file names for the audio recording, for 
example, Drums.wav, Bass.wav, etc.  

 Track number_track name: Sets the track number and the track name of each track as 
file names for the audio recording, for example, 01_Drums.wav, 02_Bass.wav, etc. 
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 Project name_track name: Transfers the project name to all tracks and adds the 
corresponding track name to them, for example, demo_Drums.wav, demo_Bass.wav, 
etc. 

 Get track name from first object name: This option gives the track name the same name 
as the first object in that track. 

 Get track name from first object file: This option gives the track name the same name as 
the first file in that track. 

REC: Specify whether or not you want to record MIDI or audio here. 

Audio options 
You may also choose between recording in mono or stereo on the selected track. A 
mono mix of both device channels is also possible. 

The option "Recording only in RAM" allows recording to be done directly in the system 
RAM. 

 

MIDI 
The "MIDI" section provides access to the various MIDI options. 

Recording Device (MIDI): Use this menu to choose a MIDI entry device. 

All Tracks: Applies the same recording device selected for this track to all tracks. 

VST Instrument Editor: This button opens the graphical interface for the connected VST 
instruments. 

Playback Device (MIDI): Use this menu to select the MIDI playback device. The VST 
instruments may also be selected as playback devices. 

All Tracks: Sets the same recording and playback device as selected for this track for all 
tracks. 

Record Controller Curves During Playback: This option enables controller curves to be 
recorded during playback. 

The following are available as additional playback parameters: in-channel, out-channel, 
transpose, program change, bank high, bank low. You can also activate MIDI Thru for the 
affected track. This activates the loudspeaker symbol for this track. 

Automation/Controller: This button opens a dialog to change the settings of the MIDI 
controller. 

Detailed information about controller automation is provided in "Automation -> MIDI 
controller automation (view page 338)". 

Track Name: Use this field to change the name of the current track. 
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Revolver Tracks 
New empty revolver track: This command creates a new revolver track. 

Before track objects are rearranged, select the option "New Revolver Track (copy)". The 
track objects will be copied as a new Revolver Track and a star appears before the track 
name. The original objects may now be edited or repositioned to produce a different 
version of the track. 

Delete Revolver Track: This command deletes a Revolver Track. 

Previous Revolver Track: This command displays the previous Revolver Track 

Next Revolver Track: This command displays the next Revolver Track 

 

More 
Cut tracks 
This function cuts out all tracks that are selected in the track header (view page 98). The 
corresponding tracks are stored in the clipboard in the meantime. 

 

Track effects 
These options allow (as with the Mixer channels) the application of real-time effects to the 
selected track in Samplitude.  

More information about effects is available in "Effects - division and working methods (view 
page 178)". 

 

 AUX sends: Opens the AUX send routing dialog window 
 Dynamics: Dynamics, Advanced dynamics, Multiband dynamics, sMax11, 

efx_Compressor, eFX_Gate, AM-Munition, AM-Track, AM-Phibia, AM-Pulse 
 Frequency/filters: Parametric EQ, EQ116, FFT filter, brilliance enhancer, Filtox, 

eFX_DeEsser 
 Delay/reverb: Delay, room simulator, efx_Reverb, efx_StereoDelay, Ecox, Variverb 
 Distortion:  Distortion, Ampsimulation, Vandal, eFX_VocalStrip,  
 Restoration: DeClipper, DeClicker/DeCrackler, DeHisser, DeNoiser 
 Stereo/phase: Pan/Surround editor, Multiband Stereo Enhancer, track phase inversion 
 Modulation/special: Vocoder, efx_ChorusFlanger, efx_Phaser, eFX_TremoloPan, Corvex 
 MIDI: Velocity Dynamics 
 Plug-ins: opens the VST plug-in dialog. Here you can select MAGIX plug-ins, VST effect 

plug-ins as well as DirectX plug-ins from 3rd parties from the "Add Plug-ins" dialog, you 
can also call up the "VST/Direct X/Rewire Setup". 

 essentialFX: eFX_ChorusFlanger, eFX_Phaser, eFX_Reverb, eFX_StereoDelay, 
eFX_Compressor, eFX_Gate, eFX_DeEsser, eFX_VocalStrip, eFX_TubeStage, 
eFX_TremoloPan 

 MAGIX plug-ins: AM-Munition, AM-Track, AM-Phibia, AM-Pulse, Corvex, Ecox, Filtox, 
VariVerb, Vandal 

 



 

5 4 2  T R A C K  M E N U   

Track properties 
This submenu enables access to all track properties. 

Mute: Mutes the active track. 

Shortcut:  Alt + M 

Mute inactive: Mutes and also deactivates the track. This increases performance as the 
caching and FX processing of this track are not necessary) 

Shortcut:   Ctrl + Alt + M 

Solo: Switches the active track to "Solo" mode. 

Shortcut:  Alt + S 

Solo exclusive: This setting switches the active track to exclusive solo mode, i. e. only this 
active track is audible. All other tracks are silenced in solo mode. 

Shortcut:  Shift+ Alt + S 

Record: Arms the track for recording. 

Shortcut:  Alt + R 

Monitoring: Switches manual monitoring for the corresponding track on/off.  

Shortcut: Ctrl + Alt + Shift + F 

Lock: Locks the active track. 

Shortcut:  Alt + L 

Edit volume/Panorama: Enter a numerical value for volume in dB or for the panorama 
curve. 

Shortcut:  Ctrl + Shift + K; Ctrl + Shift + P 

Track phase inversion: Rotates the phase of the selected track. 

Shortcut:  H 

Mute bus inputs: Sets the input of the selected submix bus or AUX bus to inactive, i. e. 
the signals routed to the bus are not routed through to the signal path of the bus. 

Global mute: Enable/disable all mute states of the tracks. 

Global solo: Enable/disable all solo states of the tracks. 
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Global: solo safe: All tracks will be switched to "Solo safe" mode. In this mode the 
corresponding track, if switched to solo, will be monitored together with its AUX returns. 

Global: solo PFL: All tracks will be switched to "Solo PFL" mode. In this mode the 
corresponding track, if switched to solo, will be tapped at a position before the fader and 
heard as a pre-fader signal. 

Global: solo exclusive: All tracks will be switched to "Solo exclusive" mode. In this mode, 
the corresponding track will play exclusively if switched to solo. Solo tracks already 
switched to solo mode will be switched back. 

 

Pan/Surround Editor (Stereo-Panorama-Dialog) 
This command opens the Surround/Panorama dialog which provides lots of useful 
panorama presets. If you are working in the normal Stereo Master Mode, you have the 
option of activating 2-channel surround. 

The "Mono" button in the track editor sets the track to mono editing from input to the 
panorama controller. Particularly all track effects preceding the Pan controller operate in 
mono, which considerably saves CPU resources. The routing position of the Pan controller, 
however, can be freely adjusted in the FX routing dialog. In this case, the submix and AUX 
return buses always remain stereo. 

If stereo objects are located in mono tracks, the mono share (L+R) is played. 

If you use AUX sends, you can also use the panorama fader of the AUX send routing dialog 
for panning the mono signal. 

In Samplitude there is also a Surround Master Mode which can be set up via the "File" 
menu -> "Project Properties" -> "Mixer Setup". If this mode is active, every track is set to 
Surround Mode. 

 

VST Instrument Editor 
Software instruments as well as MAGIX synths (e.g. Robota Pro) may be integrated 
seamlessly into a virtual project and controlled via internal MIDI functions and editors. The 
instruments are integrated into all effects and routing options. If you have a track open in a 
virtual instrument, you can open the user interface of the VSTi here.  

Note: If activating this menu item does produce results, this means that a VST instrument 
has not been loaded into the corresponding track. 

Detailed information about plug-ins can be found in "Software/VST instruments (view page 
312)". 
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Activate Previous/Next Track 
Use this command to activate the next (lower) or previous (upper) track in the VIP from the 
view of the currently activated track. With the cursor keys you can conveniently scroll up or 
down. 

Shortcut: 

Activate next track Alt + cursor down 

Activate previous track Alt + cursor up 
 

 

Track visualization 
The visualization from the menu window can be set as a master or track display. 

Detailed information on the individual visualization displays can be found in the chapter 
"View > Visualization" (view page 798). 
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Object Menu 
Unlike with the "Edit" menu all commands from this menu refer to selected objects in the 
virtual project. 

 

Object Editor... 
Use the object editor (view page 114) for object-oriented editing. This enables you to 
quickly and easily edit each selected object independent of any additional track settings. 

Shortcut:  Ctrl + O 

 

MIDI Editor... 
This menu item opens the MIDI editor. The content of the MIDI object selected in the VIP 
may be displayed and edited here. You may choose from the matrix editor, drum editor, 
score editor, event list, and velocity/controller editor. 

If a MIDI object is not selected, you will be asked if you wish to create one. If you confirm 
this with "OK", a MIDI object in the current track is created at the cursor position/start of 
the range. 

Detailed information about this is provided in "MIDI in Samplitude -> MIDI editors (view 
page 247)". 

 

Edit audio file 
Here the wave project belonging to an object opens and is displayed in the wave window. 
The range corresponds precisely to the part of the audio data which the object accesses. 

Detailed information about offline audio editing and real time is available in "Working in the 
project window -> Samplitude as a wave editor (view page 108)". 

 

New MIDI Object 
This creates a new MIDI object in the selected track. A pop-up menu opens when the 
function is selected to choose from multiple templates. 

Presets include MIDI drums and MIDI phrases (filter sweep, 6 octave sequence, etc.) or 
an empty template. 

These are also available in the "Templates" folder in the program directory. The pop-up 
menu may also be expanded with other templates simply by copying the desired MIDI files 
into the "Templates" folder or exporting them directly from Samplitude as a template. 
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New MIDI object in the range 
This function creates a new MIDI object in the current track within the selected range. 

 

New Synth Object 
A 4-beat loop object is created at the current play cursor position. The instrument interface 
for the synth object that is created may be accessed by double clicking the object. The 
synth objects are Atmos, BeatBox 2, DrumnBass, and LiViD. 

 

Edit 
Cut Objects 
Use this command to delete selected objects from the current project and insert them into 
the VirtClip. The content previously in the VirtClip will be overwritten. 

 

Copy Objects 
This command copies the selected objects into the VirtClip. The previous content in the 
VirtClip will be lost. 

 

Insert Objects 
Use this command to add objects from the VirtClip into the project, starting from the 
current position of the play cursor. Note that this may cause objects to overlap. 

 

Delete Objects 
This deletes the selected objects from the current project. The content of the VirtClip will 
remain. 

Shortcut:  Ctrl + Del 

 

Duplicate Objects 
All of the selected objects are copied and positioned behind the original object dependent 
on the set grid. 

 

Duplicate Objects Multiple 
Use this function to duplicate selected objects sequentially. In the dialog window that 
opens, enter the number of copies, the corresponding distance, and the entire length. 

The following parameters are available: 

Number of Objects: Specify the number of duplicates here. 
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Group Created Objects: Decide here whether the duplicated objects should be assigned 
to a group. 

 

Time Difference: Set the distance between each object's starting point here. The default 
length is set to that of the object you wish to duplicate. This setting connects the objects 
seamlessly with one another so that a loop is created. 

Duration: As an alternative to the time difference, the entire length of all copies may be set 
here. This is calculated from the product of the time difference and the number of copies. 

 

Creating looped objects 
Use this command to define a loop inside an object. Use the previously selected range 
above the object to set the loop start and end points. By dragging the length handle at the 
bottom right of the object you can make the loop exceed the previous object end point.  

If you only selected an object, but not the range above it, the entire object will be looped by 
dragging to the right. 

Loop objects are suited, for example, to quick creation of full drum tracks from a drum 
loop. 

Loop points may also be set easily via the object editor. 

Shortcut:   Ctrl + L 

 

Split Objects 
Use this option to split all selected objects at the cursor position and separate them into 
individual objects. 

If the range is selected, the cut will be made at each border. Ensure that the object that is 
to be edited is contained within the active range. If necessary, all objects may be activated 
by double clicking on the range selected in the range bar. In this case, it is not necessary to 
select the objects beforehand.  

Shortcut:  T 

 



 

5 4 8  O B J E C T  M E N U   

Split objects at Marker Positions 
The object is split into pieces at the marker positions that lie within the object borders. The 
newly created objects will be named after the previous markers. 

 

Split Objects at Track Marker Positions 
The object is split into pieces at the marker positions that lie within the object borders. The 
newly created objects will be named after the previous track markers. 

 

Split Objects at Audio Marker Positions 
The object is split into pieces at the audio marker positions that lie within the object 
borders. The newly created objects will be named after the previous audio markers. 

 

Heal/Unsplit Objects 
This command recombines two objects that have been split without any audio calculation. 
To do this, the objects in the VIP must be positioned exactly beside each another, and the 
audio material must be connected. The objects must therefore be different but sequential 
pieces of audio material from the same wave project. If this not the case, the command will 
not function properly. 

Before executing the command, select both of the objects that were split previously. All of 
the second object's properties, like fades and effects, will be discarded. The resulting 
combined object will feature the properties of the first object. 

 

Trim Objects 
This function moves the object borders of a selected object to the edges of the current 
range. To do this, the range must be contained completely within the object's borders. 

Shortcut:  Ctrl + T 

 

Trim MIDI Objects 
This function removes the MIDI data of an object that is not located within the current 
object's borders ("virtual MIDI data"). For example, this type of object virtual MIDI data 
results from dragging the left object border of a MIDI object after a MIDI recording inward 
(to the right). This function can be very useful if you wish to edit multiple MIDI objects at the 
same time in the MIDI editor, since overlapping virtual MIDI ranges can be very difficult to 
keep track of. 

 

Glue Objects 
A new object is created using those selected. Trackbouncing is used in this case. If you 
have selected just one object, this will be glued together with the object to the right. This 
function corresponds with the "Glue" symbol in toolbar. 

Shortcut:  Ctrl + Alt + G 
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After gluing, original cut may be subsequently edited the using the "Freeze object -> Edit 
object freeze" function. When selecting this function, a single-track VIP that contains the 
original objects will open as well. These may then be edited individually. 

Use the "Freeze object -> Unfreeze object" function at any time to restore the original state 
of the object. 

 

Mute Objects 
This mutes the selected object. 

Shortcut:  Ctrl + M 

 

Lock Objects 
This protects objects from being unintentionally moved. When this function is active, the 
key symbol in the lower portion of the object turns red. If the key symbol is grayed out 
because of the display settings, the objects will be displayed crossed out instead. 

Note: Please take note of the "Locking options". These specify which functions may be 
locked for set objects. 

An object may also be locked by clicking the key symbol in the lower portion of the object. 

 

Unlock Objects 
This unlocks an object. All selected objects will be unlocked. 

An object may also be unlocked by clicking the key symbol in the lower portion of the 
object. 

 

Lock Definitions… 

Detailed information about this is available in "File -> Program Preferences -> Lock 
Definitions...". 

 

Edit Copy of the Wave Project 
Use this command to create a copy of the wave project featuring the object first. This copy 
may then be edited using the "Wave editing" function.  

 

Edit Root VIP 
Audio objects that were compiled using an internal mixdown of a virtual project to a wave 
project and then inserted into a new project contain information about the VIP that was 
used to generate them (bounced). The "Edit root VIP" function allows you to reopen this 
VIP for editing. 

Sample: A CD is compiled from any number of songs that were created in Samplitude and 
were converted to individual wave files using the trackbouncing function (view page 456) 
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and are now visible in the arranger window of the new project. It's possible that you may 
want to change something else in the song retroactively. "Edit root VIP" opens the original 
project to make the desired changes. Once the modified project is saved, it will be re-
bounced and updated in the project that is used to compile the CD. 

 

Demix MIDI Objects by MIDI Channels 
This function will create a new track for each channel of the selected MIDI object. The 
objects will then contain only the MIDI files of the specific MIDI channel. 

 

Quantization 
Audio Quantization Wizard 

The quantization wizard also lets you apply the 
functions described above for transients and beat 
marker editing. These commands reflect the 
typical work process when adjusting a multi-track 
drum recording to the VIP grid and are applied to 
object selection. The "One click button" 
automatically executes the "Determine 
transients", "Consolidate transients", "Cut at 
transients", "Quantize object positions (AQ)", 
and "Remove gaps between objects" 
commands sequentially. 

During determination of transients, you can set 
the sensitivity of the detection with the 
"Sensitivity" controller. The higher the value, the 
more beat markers are created. 

Use the "Analyze again" and "Clear" buttons to 
recalculate or delete an already created audio 
material analysis.   

If you would like to connect the slices you have 
created to crossfades, then enter the length of 
the fade into the respective field "Overlap 
(crossfade) length". 

Individual gaps between objects may be closed either by Object Time Stretching or by 
using the audio material from the slices to the right beside the gap.  

 

Define transients 
Audio quantizing objects is particularly well suited for modifying multi track drum 
recordings. 
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"F3" and "F2" allow you to jump to the next or previous transients in the audio signal. By 
quantizing the VIP object position and dividing objects at beat markers/transient positions 
you have the option to perform highly flexible dynamic drum quantizations. 

All following commands refer to selected objects and can also be accessed using the 
Audio quantization wizard. 

"Specify transients" marks the peaks of the selected objects as "AQ" with special beat 
markers. A beat marker is an audio object marker, which is written into the audio file. To 
make these markers visible, turn on "Objects -> Transients (AQ)" ("Shift + Tab"). All other 
audio markers may be displayed via "Objects -> Audio markers".  

Detailed information about audio markers can be found under "Menu Play/Rec > Markers > 
Audio marker Manager (view page 589)". 

 

Consolidate Transients 
Transients within a certain range (e.g. 20 ms) are moved to the first transient position with 
this command. The effect is that "Split at transients" doesn't create too many splices, 
especially if you have several tracks with slightly different transient positions for the same 
drum hit, i.e. due to microphone distance related signal latency. The time window may be 
specified with the audio quantization wizard. 

 

Create Groove 
"Create groove" button in the audio quantization wizard creates a groove template based 
on the AQ markers (transients) according to the selected audio objects in the selected 
range. 

 

Create MIDI trigger from transients 
This function creates a new MIDI track below the track which contains the selected and 
analyzed objects. The transients found there will be displayed as MIDI events with 
corresponding velocity. 
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If you integrate a VST instrument in a newly created MIDI trigger track now you can double 
up or replace your existing audio track with additional sounds. 

 

Create Groove Template from Transients 
This function stores the transients created for the objects as a groove template in the 
program folder "FX preset -> Grooves". 

Select groove templates in the audio quantization wizard under "Quantization settings -> 
Grid". The length and start of groove template is always set to full beats. 

 

Split at Transients 
All selected objects are split over multiple tracks at the beat markers (AQ). This quantizes 
each drum hit individually. 

Example: To split all drum tracks according to the bass drum and snare tracks, carry out 
transient recognition for the objects in those tracks. Next, select all drum tracks and apply 
the "Cut at transients" command. Now all objects will be split at any bass drum and snare 
hit. 

 

Quantize object position (hard) 
The menu command "Hard quantize audio object position" equals a soft Q value of 
"100" or "Quantize object positions (AQ) (view page 552)" in the Quantization wizard. 

 

Quantization setting - Soft Q 
This value sets the strength or "Soft Q" value of the quantization. 

 "100" moves the event precisely to the quantize grid point, 
 "50" shifts the event to the middle between the current position and the quantization grid 

point,  
 "0" means no movement, i.e. quantization off 

The menu command "Hard quantize audio object position" equals a soft Q value of 
"100" or "Quantize object positions (AQ)" in the Quantization wizard. 

 

Offset 
The value range in this parameter stretches from -100 to +100. By changing the offset 
values, you move the whole quantization grid. Select a negative value for the offset, and the 
quantization grid will be moved by the corresponding value to the left, or forward in time. 
On the other hand, if you select a positive offset value, you will set the quantization grid by 
the corresponding value to the right, or backwards in time. 

A value of -100 corresponds to a shift of half a grid length to the left; +100 corresponds to 
a shift of a half a grid length to the right. 

 

Quantize object position (AQ) 
Now all the selected objects will be adjusted to the corresponding quantization settings 
that you previously set in the Audio quantization wizard. During this process the "Soft AQ 
parameter" will not be observed.  
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When quantizing the object is hard quantized, i. e. it will be shifted to the next snap point.  

If you are not satisfied with the results, you can "Reset Audio Object Quantization" settings, 
which will set the objects back to their original position  

 

Soft AQ 
"Soft AQ" executes soft quantization according to the "Soft Q" parameter settings. 

 

Remove Object Gaps 
After object quantization has been applied, gaps between the objects can occur, which 
may lead to audible dropouts in overhead signals. The command "Remove gaps between 
objects" provides options for closing these gaps. The function "Use next object slice 
audio material" may be used to move the object start position of the object to the right of 
the gap to the left until the gap is closed, or the gaps between the objects may be filled by 
Time Stretching the objects next to the gaps. Each method can be selected in the audio 
quantization wizard. The overlap (crossfade) length setting of the first option, i.e. "Apply 
next audio object slice's audio material", is applied.  

 

Undo/Redo/Reset Quantization 
Use the round arrow buttons to undo/redo the last quantization applied. In this case, the 
counter-clockwise round arrow serves as the "Undo quantization" function, while the 
clockwise arrow serves as the "Redo quantization" function. 

Reset quantization: This function resets all quantization processes of the object positions. 

 

Reset Audio Object Quantization 
The "Reset object quantization" resets the selected objects to the original position and also 
undoes the quantization. 

 

Quantize Settings - Preset 
Different presets are available for selection: 

 5-tuplet: Quantization occurs in fifths 
 Magnetic quantize: The "window" value is set to "50", i.e. only 50% of quantization will 

be included. Only those events will be quantized that are located within a range of 25% 
of the snap range to the left and right of the grid point. 

 Soft quantize: The "Level" parameter is set to "50", i.e. quantization occurs at a half 
interval between the current position and the next grid point. 

 Swing: The swing parameter is set to "75", i.e. in contrast to the binary rhythm, which 
features a "swing" value of "50", uneven/un-highlighted counting times will be set to 
delay. This highlights the "swing" feeling. 

 Triplets: Quantization occurs in triplets 
 16th offbeat: The quantization grid's timing is moved back a 16th note 
 8th offbeat: The quantization grid's timing is moved back a 8th note 
 "New groove" and "More life for hi-hat" provide groove templates 

Of course, you can also set your own values and save them as a preset. 
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Quantize Settings - Default 
The "Standard settings" button provides the option of resetting the preset values: 

Q threshold: 0 
Q window: 100 
Swing: 50 
Soft Q: 25 
Offset: 0 

 

Quantize Settings - Grid 
Use the "Grid" parameter to set the selection step length and thereby the values for 
quantization. A value of "1" provides a snap value of a single note, "2" is a half note, "4" is a 
quarter note, etc. There is also a series of decimal values, n-tuplets, and a selection of 
special groove templates. 

Detailed information about groove templates is available in "MIDI editors -> Quantize -> 
Quantize settings - Groove template (view page 260)" 

 

Q Threshold 
The parameter "Q threshold" may be used to slightly vary quantization by excluding notes 
from quantization that are very close to the next quantization value. 

 

Q Window 
"Q window" refers to the interval to the left and right of a grid point; events will be 
quantized within this range. No quantization will take place beyond this, and for this reason, 
the events outside of this window will remain at their position. The quantization area is 
dependent on the values of the parameters "Q snap" and "Q threshold". 

Example: Grid: 4  max. Window: 4 

 100: The Q range covers the entire area between the grid points on the quantization 
grid. All events will be quantized 

 50: The Q range covers half of the quantization interval. Events with gaps of ¼ of the 
grid width left and right of the grid point (1/16 note values in this example) are quantized 

 0: no Q range -> quantization off 

 

Swing 
Set swinging, ternary playing with this value. This enables you to enter the division for an 
uneven/unaccented grid points. 

 50: "50-50/1:1" split. The unaccented eighths are exactly half way between the even 
eighth notes ("even", binary playing method) 

 67: "67-33/2:1" tuplets. The beat is split up into three counts, whereby the note is 
assigned 2 beats (67%) and the off beat note one count (33%) 

 75: "75-25/3:1" split. For example, a pointed eighth and a sixteenth is created from two 
eighth notes 
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Show Grid/Time Signature 
Displays the desired beat signature and number of beats. The display window will change 
accordingly. 

 

Audio Quantization – Tutorial 
1. The first step is to enable display of audio markers/transients in the display options ("Y 
-> Design -> Display options -> Options -> Audio markers/transients"). 

2. Load a VIP with a multi-track drum recording where the drummer has played to the 
click, so that the VIP raster matches the drumming tempo. 

3. Select a range for audio quantization. We recommend around 8 - 16 beats to guarantee 
fast calculation. Analysis of transients for a complete song can take a little longer. Next, 
separate the objects into the selected range size. 

4. Select all drum objects, open the audio quantization dialog, and move the "Sensitivity" 
slider. Beat markers should appear within the object at the transient positions. Adjust the 
sensitivity so all main hits are detected. Use the "F2" and "F3" keys to jump to the previous 
or next marker. 

5. To cut objects for all tracks at the beginning of transients, specify the beat markers with 
the "Consolidate transients" command. Samplitude adjusts the beat markers of all tracks 
within a period defined in the "Time window" parameter to the beat marker position farthest 
to the left. 

6. To separate all quantization objects, access the "Split at transients" command. 

7. Use "Quantize object positions" to adjust the individual positions of the partial objects. 
You also have the option of changing the quantization settings. 

8. Audio gaps might appear between some slices due to quantization. These can be filled 
with the option "Remove gaps between objects".  

If you are not satisfied with the quantization result, you can "Reset quantization" to set the 
split objects back to their original position and try other quantization settings. 

When you have finished editing, you can Glue slice objects together (shortcut: Ctrl + Alt + 
G) on each track to save CPU performance. 

 

MIDI Note Quantize (Standard) 
This command quantizes the ends of the MIDI notes of all selected MIDI objects according 
to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

MIDI Humanize Q 
This command applies the current Humanize value in the quantization options. 
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Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

MIDI Quantize Settings... 
Use this command to open the dialog for quantizing MIDI events. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

Extended MIDI Quantize 
Start Q 
This command quantizes the start positions of the MIDI notes for all selected MIDI objects 
according to the MIDI quantization settings. The grid view corresponds to the set start 
quantization value. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

Start and Length Q 
This command applies quantization to the start and length of the MIDI notes of all selected 
MIDI objects according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

Length Q 
This command applies quantization to the lengths of the MIDI notes of all selected MIDI 
objects according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

Soft Q (approximate quantization) 
This command applies the current Soft Q (level) value in the quantization options. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

Quantize Note Ends to Grid 
This command quantizes the ends of the MIDI notes of all selected MIDI objects according 
to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> Quantization". 
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Reset MIDI Quantization 
Use this command to restore the original offset of start and length values of MIDI notes for 
all selected MIDI objects. This enables you to undo quantization at any time (even after the 
VIP has been saved). 

Detailed information about quantization is available in "MIDI editors -> Quantization". 

 

MIDI Input Q (global) 
Use this option to quantize the MIDI recording destructively. The original position may be 
restored via the menu item "Object -> Quantize -> Reset Quantization". 

 

Object effects 
The following effects may also be accessed at the object level. 

Dynamics: Dynamics, advanced dynamics, multiband dynamics, sMax11, 
efx_Compressor, eFX_Gate, am-munition, am-track, am-phibia, am-pulse 

Frequency/Filter: Parametric EQ, EQ 116, FFT-Filter/Spectral analysis, Brilliance Enhancer 
(optional), Filtox, eFX_DeEsser. 

Delay/Reverb: Delay, RoomSimulator, eFX_Reverb, eFX_StereoDelay, Ecox, VariVerb. 

Time/Pitch: Resampling/Timestretching, Elastic Audio. 

Distortion: Distortion, Vandal, eFX_VocalStrip, eFX_TubeStage. 

Restoration: DeClipper (optional), DeClicker/DeCrackler (optional), DeHisser, DeNoiser 
(optional). 

Stereo/phase: Object channels, Switch channels, multiband stereo enhancer, invert phase 
(both channels, left channel, right channel) 

Modulation/special: Vocoder, efx_ChorusFlanger, efx_Phaser, eFX_TremoloPan, Corvex, 
object reverse 

Plug-ins: opens the VST plug-in dialog. Here you can select MAGIX plug-ins, VST effect 
plug-ins as well as DirectX plug-ins from 3rd parties from the "Add Plug-ins" dialog, you 
can also call up the "VST/Direct X/Rewire Setup". 

essentialFX: eFX_ChorusFlanger, eFX_Phaser, eFX_Reverb, eFX_StereoDelay, 
eFX_Compressor, eFX_Gate, eFX_DeEsser, eFX_VocalStrip, eFX_TubeStage, 
eFX_TremoloPan. 

MAGIX Plug-ins: AM-Track, AM-Phibia, AM-Pulse, AM-Munition, Corvex, Ecox, Filtox, 
VariVerb, Vandal. 
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Selecting Objects 
Select All Objects Under Cursor 
Selects all objects found under the play cursor or selected track ranges. 

 

Select All Objects 
Selects all objects in the arranger window. 

Shortcut:  Ctrl + A 

 

Select Objects in Active Track 
All objects in the active track will be selected. This function may also be applied by double 
clicking a free area in the active track. 

 

Object Lasso 
To select several objects, click on an empty area in the lower portion of the track and then 
drag the mouse over the objects you wish to select. Sometimes there is not enough space 
between the objects. In this case, adjust the mouse behavior with the object lasso. 

Once activated, click on an object and pull up a selection frame without moving the object 
you clicked on (which would be the case in "Universal" mode). After selecting, the mouse 
reverts to regular behavior. To use the lasso selection method several times in sequence, 
the object lasso must be reactivated each time. 

Shortcut:  Ctrl + Alt + L 

 

Select Previous Object 
Use this command to select the previous object on the same track. 

Shortcut:  Ctrl + Alt + Q, < 

 

Select Next Object 
Use this command to select the next object on the same track. 

Shortcut:  Ctrl + Alt + W, > 

 

Select Previous Object 
Use this command to add the previous object on the same track to the current selection. 

Shortcut:  Ctrl + Alt + Shift + Q 

 

Select Next Object 
Use this command to add the next object on the same track to the current selection. 

Shortcut:  Ctrl + Alt + Shift + W 
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Switch Selection 
All deselected objects are selected and all selected objects are deselected. 

 

Deselect Objects 
Deselects all objects. 

Shortcut:  Ctrl + Shift + A 

 

Groups 
Group Objects 
This function assigns all selected objects to a group. As soon as one object is selected, all 
objects in the group are automatically selected so that you can work on them collectively. 

Shortcut:  Ctrl + G 

 

Ungroup Objects 
Use this function to ungroup a selection of objects. This turns all selected objects into 
independent objects again. 

Shortcut:  Ctrl + U 

 

Temporarily Exclude Object from Group 
This command removes most recently clicked object from an existing group. By clicking an 
object again and repeating the function, the removed object is moved back into the group. 

Shortcut:  Ctrl + Shift + U  

  or  Shift + Ungroup button 

 

Temporarily Exclude All Objects from Groups 
This command temporarily removes all objects from their groups. In this case, the 
"Ungroup" button will blink. If the function is accessed again or if the blinking buttons are 
pressed again, the groups will be restored and the button will stop blinking and return to 
inactive status. 

Shortcut: Shift + Alt + Ungroup button 

The shortcut "Ctrl + Alt + Ungroup" resets the grouping history. 

Additional information about grouping objects is available in the chapter "Working with 
objects -> Group/ungroup objects (view page 133)" 
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Moving objects 
Move objects 
This opens the dialog window to enter the starting position of an object in number of 
samples, milliseconds, SMPTE, or beat units. 

 

Arrange Objects 
Use this function to edit the numerical interval between the selected object and the object 
in front of it on the same track. With multi object selection the entire distance between all 
objects on a track can be set. 

 

Object/Fade step size 
Select an object for simple object editing.  

If you have selected two objects for editing, it is possible to edit it them separately as well 
as together. 

Each of the commands below is available in two step sizes. The step sizes can be set in 
the dialog that follows. 

 

Use the "Ctrl" key to select the left object for editing and the "Alt" key to select the 
right object. Doing this the commands below are automatically carried out with Step size 
1. To edit with a step size of two, hold down the Shift key as well. Moreover press a key 
on the num pad 0-9, and activate the respective function. 
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Left object to the left Ctrl + 1 
Right object to the left Alt + 1 
Left object to the right Ctrl + 2 
Right object to the right Alt + 2 
Move object(s) left Ctrl + Alt + 1 
Move object(s) right Ctrl + Alt + 2 
Object(s) track downwards Ctrl + Alt + Shift + Page down 
Object(s) track upwards Ctrl + Alt + Shift + Page up 
Object start to the left Ctrl + 3 
Object start to the right Ctrl + 4 
Object end to the left Alt + 3 
Object end to the right Alt + 4 
Move crossfade left Ctrl + Alt + 3 
Move crossfade right Ctrl + Alt + 4 
Start offset to the left Ctrl + 5 
Start offset to the right Ctrl + 6 
End offset to the left Alt + 5 
End offset to the right Alt + 6 
Increase left volume Ctrl + 8 
Reduce left volume Ctrl + 7 
Increase right volume Alt + 8 
Reduce right volume Alt + 7 
Increase volume Ctrl + Alt + 8 
Reduce volume Ctrl + Alt + 7 
Left object content to the left Ctrl + 9 
Left object content to the right Ctrl + 0 
Right object content to the left Alt + 9 
Right object content to the right Alt + 0 
Object(s) content to the left Ctrl + Alt + 9 
Move Object(s) content right Ctrl + Alt + 0 

Additional key for step size 2 Shift key 

 

Please note the useful "Object content to the left/right" functions. Here, object length 
and object position are kept, the assigned audio material from the corresponding wave 
project is moved into it. 

 

Object Hotspot to Play Cursor Position 
Use this command to move the hotspot of the selected object to the play cursor position. 
Once you have activated a range, you can use this function to set the hotspot of the 
selected object to the start of the range. If you selected multiple objects, all other objects 
are sorted relative to the new position of the first object. 

Shortcut:  Ctrl + Alt + P 
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Object Begin to Play Cursor Position 
Use this command to move the starting point of the selected object to the play cursor 
position. Once you have activated a range, you can use this function to set the starting 
point of the selected object to the start of the range. If you selected multiple objects, all 
other objects are sorted relative to the new position of the first object. 

 

Object End to Play Cursor Position 
Use this command to move the end of the selected object to the play cursor position. 
Once you have activated a range, you can use this function to set the end of the selected 
object to the start of the range. If you selected multiple objects, all other objects are sorted 
relative to the new position of the first object. 

 

Object to Original Time Position 
With this command you can move the selected objects to their original track positions. 

Shortcut:  Ctrl + Alt + O 

 

Set Original Time Position 
This command opens a dialog which lets you write a new original position into the 
broadcast WAV header. The current object position is used as the new position, which 
may then be changed manually. 

 

Object step size 1 
See "Object/Fade step size". 

 

Object step size 2 
See "Object/Fade step size". 

 

Hotspot 
Setting a Hotspot 
With this function makes it possible to give an object another special snap point hotspot 
instead of its object front edge.  

The hotspot is not placed at the current play cursor position inside a selected object. 

Shortcut:  Shift + H 

A vertical line represents this in the object. From now on this object snaps to its hotspot at 
the corresponding snap markings.  

You can make the selected object jump from its hotspot position to any changed position 
of the play cursor by using the function "Object hotspot to play cursor position (Shortcut 
Ctrl + Alt+ P)" (view page 561). 
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Delete Hotspot 
This command deletes the hotspots for the selected object. 

 

Takes 
Take Manager... 

Detailed information about the take manager is available in the chapter "Managers > Take 
manager (view page 150)". 

Shortcut:  Ctrl + Alt + Shift + T 

 

Take Composer 
This menu item opens the take composer. 

Detailed information about the take composer can be found in the chapter "Manager -> 
Take Composer (view page 152)". 

 

Object Color/Name 
Object Name... 
This command opens a dialog to assign names to all of the selected objects. 

Shortcut:  Ctrl + N 

 

Object Background Color… 
The selected background color from the color dialog is applied to all selected objects. 

 

Object Foreground Color… 
The selected foreground color from the color dialog is applied to all selected objects. 

Note: If you have selected "Red/Blue alternation" or "Comparisonics colors" for the 
waveform color in the display options ("View -> VIP display mode -> Definition (view page 
491)"), there will be no change to the display of the object foreground color. The change to 
the waveform color will only be active when you restore the "Default color settings". 

 

Freeze Objects 
This function renders each selected object as a new wave file. The original object is 
replaced in the arranger. Freezing increases performance in case a very system-intensive 
real-time plug-in is active. The original object is maintained at all times and may be re-
edited using the "Edit object freeze" function or put back into the arranger via "Unfreeze 
objects". 
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"Freeze MIDI object" replaces the MIDI objects in the audio return signal of a software 
instrument featuring audio objects. The audio return signal must be routed to the MIDI 
track to do this. 

If more than one object is selected, the function will be applied to each individual object. 
The frozen objects are grouped. Fade-in, fade-out, and object volume are not calculated, 
since these properties are applied to the object properties of every new resulting object. 

 

Edit Object Freeze 
This command opens the Freeze VIP where the frozen object is saved. This VIP contains 
tracks with the original object. 

Changes made in the temporary freeze project are applied to the object as well if 
requested. 

Note: The length of the freeze VIP cannot be changed. This is because the length is set by 
the object to which the "object freeze" or "glue objects" function was applied. 

 

Unfreeze Object 
This menu item removes the wave file created during "Object freeze" and brings back the 
original object including the settings that were saved in the temporary trackbouncing VIP. 

Note: Do not create additional new tracks in the freeze VIP, since using the "Unfreeze 
object" function will no longer be possible. 

 

Remix Agent – Tempo and Beat Recognition 
The Remix Agent is a powerful tool for analyzing the tempo and beat of your music. First, 
automatic tempo and beat recognition  is carried out for manual editing later. You can then 
split the object into remix objects, adjust the arrangement tempo and object tempo to one 
another, and write the tempo and beat information into the audio file. 

 

Remix Agent – Applications 
 Provides beat-precise splitting of songs so that you can rearrange the remix objects any 

way you like in the multi-track project. 
 Adjusting the tempo of the arrangement to the tempo of the newly integrated song/CD 

track. 
 Integration and adjustment of newly integrated song parts to the tempo of the 

arrangement 

 

Remix Agent – Requirements 
Tempo and beat recognition is applied on audio material with a length between 15 
seconds and ten minutes. This should be rhythmic music. 
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Launch Remix Agent 
Start the Remix Agent from the "Tools" menu or from the context menu by right clicking the 
object. 

Note: To use the Remix Agent in the wave editor, make sure that there is no tick beside 
"Destructive wave edit mode" ("File -> Project properties"). 

 

Remix Agent – Working Method 
The Remix Agent works in fours steps: 

Step 1: Checking the start marker 
Step 2: Tempo recognition 
Step 3: Specifying beat starts 
Step 4: Application of BPM and beat recognition 

 

Step 1: Checking the start marker 
Place the play cursor at the position where detection should start in the remix object by 
clicking the timeline. If the object contains a longer intro without any beats or quiet 
synthesizer sounds in their place, the start marker should be placed after the intro. 

The start marker should always be placed just before the beat or even better, just in front 
of the starting beat of a bar.  

Alternatively, you can set the play cursor start position before opening the Remix Agent in 
the arranger of the virtual project or in the wave editor for the position where detection 
should start. 
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Step 2: Check the automatic tempo and bar recognition 
After opening the Remix Agent by pressing the "Continue" button, it will begin to analyze 
the audio material and try to determine the tempo. The object is then played with the result 
sounding like a metronome click and numbered green beat lines appear in the waveform 
display. 

Note: If the tempo or bar information of the object to be analyzed is already available, these 
are displayed as dots at the respective positions above the display of the waveform. 

Below the waveform display, a display is provided on the left-hand side for the detected 
beat. In the middle, you'll find a small transport controller to simplify navigation. The fader 
acts as a position controller. To set the metronome volume, additional fader and mute 
buttons are provided on the right-hand side. 

Correction of beat positions and tempo 
Automatic tempo recognition doesn't always work from the start. If you don't hear the 
metronome clicking in time with the music, click the "No" button in the upper section of the 
dialog in order to access the manual tempo input dialog. 

 

To correct the metronome speed and any time shifting that may occur between the 
metronome clicks, use the tempo correction as well as the "Tap tempo" button: 

Tempo correction: The Remix Agent provides various speed settings; the speed the 
detected by Remix Agent as the most probable is preset. If the determined speed isn't 
correct, select a different, more suitable one from the list. The next time the object is 
played, it should be synchronous with the metronome clicking. 

On/off beat correction: Sometimes the tempo is right, but the beats have been displaced. 
"On/off beat correction" provides a number of alternatives for moving the beats according 
to the complexity of the rhythm. Try out the different settings until you hear the metronome 
clicks in time with the beats. 

Tap tempo: Alternatively, click rhythmically on the "Tap tempo" button or press the "T" 
key. Additional blue lines are displayed in the wave display. After at least four taps, the 
Remix Agent attempts to select the correct tempo from the list in "Tempo correction". The 
display next to the "Tap tempo" button displays the current status. Keep tapping until the 
red display showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Stray markers are 
automatically removed in so that the set tempo remains fundamentally intact.  
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You can move the markers with the mouse. If you hold the "Ctrl" button simultaneously, 
subsequent markers are also moved. 

If the metronome clicks now correspond with the music, continue to the next step. 

Step 3: Determining the start of a bar 
Now set the beat type. 4/4 beat is set as default. You can correct it here if need be. The 
beat at the beginning of the beat should always be synchronized with the high, stressed 
metronome click or the red line in the waveform display. 

 

This can be corrected in one step: If the start of the bar is audible, click "Tap one" once 
with the mouse or press the"T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 

Use the "0" key to manually tap the position of the beginnings of the bars during playback. 
This is an efficient option for correcting the bars of longer sections. 

Continue to the last step once the starts of the bars are now correct. 

Step 4: Application of BPM and beat recognition 
This allows you to specify what should be done with the analyzed audio material. The 
following option is available: 

 Create remix objects from the analyzed audio material 
 Adapt the project tempo to the tempo of the audio material or vice versa 
 Save only the tempo and beat information in the audio file for possible editing later on. 
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Create remix objects 

 

Use this option to split the song into individual objects by beat, which can then be used 
later on in the virtual project. 

Note: The "Create remix objects" option can only be processed if the Remix Agent has 
been opened from within the virtual project. 

 

Create remix objects – audio quantization 
If you have selected this option, the new objects will be fit directly into the beat grid of the 
arrangement. 

Especially with live songs, there are slight tempo variations, making it possible that various 
beat lengths appear. Object Time Stretching is automatically activated and applied to 
correct the difference in length so that the objects still fit into the rigid beat grid of the 
arrangement. 

The "Use resampling for small corrections" option makes sure that the higher quality 
"resampling" algorithm is used on smaller corrections rather than the "Time Stretching" 
algorithm. 

Note: If you change the tempo of your multi-track project later and adjust the audio objects 
in the VIP to the new tempo, there will be clearly audible pitch changes in the remix 
objects. 

 

Remix objects in "Loop" mode 
If you select this option, the new objects will be set to "Loop" mode. This way, newly 
created remix objects can be stretched out as much as you like using the right object 
mouse handle. 

 

Create remix objects – set arrangement tempo to the object tempo 
Here, the arrangement of the virtual project takes on the found BPM value. To use the split 
song as the basis for a new composition in the remixes, use this option. 

Use crossfades: Remix objects may be faded into one another with this function. The 
parameters of the transitions can be set in the crossfade editor. 

Group: This function groups the remix objects. 
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Save tempo and beat information in audio file: If you select this option, the tempo and 
beat information are written to the audio file. 

Background color: Click this button to set the background color of the remix objects you 
want to create. 

 

Adapt tempo 
This option provides you with the opportunity to adapt either the tempo of the analyzed 
audio material to your project or the project speed to the speed of the analyzed audio 
material. 

Note: The "Tempo alignment" option can only be processed if the Remix Agent has been 
opened from within the virtual project. 

 

Apply arrangement tempo to object tempo 
This adapts the object length to that of the existing arrangement. 

 

You can choose from three different methods: 

Use Time Stretching: The pitch of the song remains constant in timestretching, but the 
sound quality may suffer. 

Use Resampling: Resampling changes the pitch (similar to changing the speed of a 
record player), but retains most of the sound quality of the song. 

Note: If you change the tempo of your multi-track project later and adjust the audio objects 
in the VIP to the new tempo, there will be clearly audible pitch changes in the remix 
objects. 

Use audio quantization: During audio quantization, the tempo adjustments are calculated 
into the audio file so that it seems as if remix objects were created and then immediately 
compiled into a new audio file. If recognition is unreliable, the result may feature extreme 
tempo variations. In this case, it is particularly important to set the start marker at such a 
position (before opening the Remix Agent) so that the tempo may be detected reliably. The 
advantage of audio quantization is that smaller tempo variations may be balanced in the 
music. The starts of the bars in the music correspond with the bar starts in the 
arrangement: they do not slowly drift apart. 
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Save tempo & bar info into the audio file: If this option is active, the tempo and bar 
information are saved in the audio file. The objects in the virtual project won't be changed. 

 

Set arrangement tempo to object tempo 
Just like "Create remix objects", the arrangement of the virtual project assumes the BPM 
value determined in the Remix Agent. If you would like to use the split song as the basis for 
a new composition in the remixes, then select this option. 

Change global settings: The BPM value of the arrangement in the VIP is set to the 
detected value. 

Adapt tempo map: Sets a tempo marker in the virtual project's arrangement for each bar 
from the position of the play cursor to the end position of the remix objects. 

 

 Use quarter notes: If this option is active, four markers are set (quarter notes) instead of 
one (whole notes). 

 Use beat position instead of tempo marker: Beat position markers are set instead of 
tempo markers. 

First example: Synchronizing a MIDI arrangement 

1. Place the song object you want to synchronize the MIDI arrangement and the MIDI 
object to on top of one another on the same track in the virtual project. Open the 
remix agent for the song object. Specify the beat and quarter positions using the 
remix agent in step 1-3. 

2. In step 4, select "Adjust tempo", then "Apply arrangement to object tempo" and 
"Adjust tempo map". This specifies that you want to create a tempo map. 

3. Now select "Use quarter beats" and "Bar position instead of tempo marker". The 
tempo map receives a synchronization point at each quarter and not only at the 
beginning of each beat. If you click the "Apply" button and open the MIDI editor for 
the MIDI object, the beats will match one another and all notes will be shown and 
played in sync to the song. Even the metronome click will be in time with the song. 

 
Second example: Mixing two song objects 
1. First, adapt the project tempo of the virtual project to that of the first song object that 

you want to fade from. Select the options "Apply object tempo to arrangement 
tempo" and "Change global settings". 

2. Next, adjust the speed of the second song object to that of the project by applying 
the "Set object tempo to arrangement tempo" option. 

3. Since the project speed now matches the song speeds of both songs, you can easily 
fade between the two songs. 
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Save tempo and bar info 
If this option is active, the tempo, and bar information are saved in the audio file. The 
objects in the virtual project won't be changed. 

Generate beat markers in the current range: Use this option to place markers at the 
beginning of the beats of a song. This corresponds to the positions of the strokes 
displayed in red in the waveform display. 

Generate quarter markers in the current range: Select this option to place markers at 
the beginning of the positions of the quarter beats starts. This corresponds to the positions 
of all the strokes in the waveform display. 

 

audioid 
Detailed information on audioid can be found in "Menu CD/DVD > audioid... (view page 
795)". 

 

Comparisonics Audio Search… 
This function uses the patented Comparisonics algorithm. This allows you to find the same 
or similar sounding ranges in an audio file very quickly. 

To do this, double click on the object you wish to use while holding down the "Shift" key, 
and this will then open it as an HD wave project. Now select the range to examine and 
copy it into the clipboard (shortcut: "C"). 

Now start the audio comparison function. 

The dialog that appears enables the sensitivity threshold for the recognition algorithm to be 
changed. During the adjustment process, markers appear in the project specified as 
"Match markers" at positions where the algorithm detects similar audio passages. 

After closing the search dialog, you may jump to the ranges that were detected by clicking 
the left border of the corresponding "match" marker, even during playback. 

 

Time Stretch/Pitch Shift Patcher... 
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Time Stretch/Pitch Shift Patcher - Overview 
Use this tool to patch wave files for use in Samplitude. In this case, additional information 
and settings may be written into the wave project. These enable the processing of Time 
Stretching and Pitch Shifting Algorithms at optimum quality. Without the patcher, you 
would have to search and set the settings and additional information for each wave file you 
wish to edit. 

The following may be patched individually: 

 Algorithms for Time Stretching/Pitch Shifting 
 Time factor/pitch 
 Time factor processing (new length/new BPM) 

 

Time Stretch/Pitch Shift Patcher – Patching 
Patches only work if you have opened the wave project in destructive "Wave editing" mode 
and if it is not open in a VIP simultaneously.  

Choose the algorithm you wish to use in the dialog. You may also specify the tempo of the 
wave file using the "Time factor" controller. 

You may now test the selected algorithm in conjunction with the "Play/stop" and "Play 
original" buttons. By clicking the "Patch" button, Samplitude writes the information 
permanently to the wave file. 

 

Algorithms for Time Stretching/Pitch Shifting 
Samplitude features the "Beat marker stretching (smoothed)", "Smoothed", "Beat marker 
slicing", "Beat marker stretching" as well as "Monophonic voice" algorithms as well as the 
"Standard" algorithm for real-time Time Stretching. 

Detailed information about this is available in "Offline effects -> Resampling/Time 
Stretching/Pitch Shifting (view page 647)". Use the patcher to save the most suitable time 
stretch algorithm for your needs in the wave project so that the chosen algorithm is used 
automatically on your wave projects when using Time Stretching/Pitch Shifting. 

 

Beat Markers 
Beat markers synchronize the audio material so that the groove remains perfectly intact. 
When using the beat marker-based algorithms, the beat markers are also saved in the 
wave project. 

Note: Unlike with the Time Stretching dialog in the "Effects" menu, the patcher is non-
modal, meaning that you can move the beat markers in the wave project and 
simultaneously control the result of the Time Stretching. 

 

BPM Value 
The desired BPM value (beats per minute) can be patched here. This is useful for when the 
Time Stretching factor must be determined later to adjust the wave project to the tempo of 
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an existing arrangement. If the "New BPM" field in the dialog is grayed out, you can change 
the value using the "Time factor" controller. 

 

More 
Duplicate Objects (in Place) 
Use this function to duplicate all selected objects. The duplicated objects lie congruently 
over the original objects. The duplicated objects may be moved to the desired position by 
dragging the mouse in "Object/curve" or "Universal" mode. 

Duplication is also possible via drag & drop while holding down "Ctrl". 

This enables objects to be duplicated quickly without having to access the VirtClip. 

 

Extract 
Use this command to delete all unselected objects. 

Note the difference between this and the "Extract" function in the "Edit" menu (view page 
517), which only applies to the selected area. 

 

New Object 
This function creates a new object. The last activated object is inserted at the position of 
the playback cursor in the selected track. 

 

Object Manager... 
The object manager displays all of the objects used in the arranger window in chronological 
order. 

If you select objects by ticking the box in the "Track" column, they will be selected in the 
arranger as well. This makes the selection of objects a speedy process. 

Detailed information about the object manager is available in the chapter "Managers -> 
Object manager (view page 143)". 

Shortcut:  Ctrl + Shift + O 
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Playback Menu 
Play Once 
This plays the wave project or the selected range once. This function corresponds to the 
"Play" button in the transport control (view page 52) as well as the "Play once" button in the 
toolbar (view page 66). 

Shortcut:  Spacebar 

 

Play Loop 
This plays the wave project or the selected range in a loop. This function corresponds to 
the "Play" button in the transport control (view page 52) as well as the "Play loop" button in 
the toolbar (view page 66). 

Shortcut:  Spacebar 

 

Play in Range/Loop 
The current range is played from the start of the project as a loop. This mode is especially 
useful for testing loops in the instrument sample and corresponds to the "Play in 
range/loop" button in the toolbar (view page 66). 

Shortcut:  Shift + P 

 

Play with Preload 
Playback is prepared with all buffers loaded. Use this function prior to starting precise 
synchronization manually. 

Shortcut:  Shift + Spacebar 

 

Play Only Selected Objects 
Use this command to play the selected objects only. All unselected objects will be muted 
temporarily. If the play cursor is not already located at the first selected object's time 
position, it will be moved there.  

Shortcut:  Ctrl + Spacebar 

 

Play Cut 
Play to cut start (in point) 
A defined time segment is played until the start of the selected range. The duration of this 
segment can be set under "Options -> Program preferences -> Set pre-roll time (view page 
503)". 

Shortcut:  F5 
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From play to cut start (in point) 
A defined time segment from the start of the selected range is played. The duration of this 
segment may be set under "Options -> Program preferences -> Set pre-roll time (view 
page 503)". 

Shortcut:  F6 

 

Play to cut end (out point) 
A defined time time segment is played until the end of the selected range. The duration of 
this segment may be set under "Options -> Program preferences -> Set pre-roll time (view 
page 503)". 

Shortcut:  F7 

 

Play from cut end (out point) 
A defined time segment from the end of the selected range is played. The duration of this 
segment may be set under "Options -> Program preferences -> Set pre-roll time (view 
page 503)". 

Shortcut:  F8 

 

Play over cut/crossfade 
This allows you to simulate the cut, in which case a defined segment is played until the 
beginning of the selected range. The selected range is then skipped and a defined 
segment is played from the end of the selected range. The duration of this segment may 
be set under "Options -> Program preferences -> Set pre-roll time (view page 503)". 

Shortcut:  F4 

 

Play into Cut 
Playback begins allowing for the lead-in time before the selected range starts and ends 
allowing for the lead-out time at the end of the selected range. 

 

Restart Play 
Use this command to move the play cursor to the original position during playback or back 
to the range start and then start playing from this position once again. 

 

Stop 
Choose this option to stop playback. The play cursor will jump to the start position. 
Whether or not the original position is the previous starting position or current stop position 
may be set in the playback parameters (shortcut: "P"). 

Shortcut:  Spacebar 
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Stop and Go to Current Position 
This option cancels playback; the play cursor will remain at the current position. 

Shortcut: Number block "0" or "," 

 

Playback Mode 
Loop Mode 
This mode plays the selected ranges in a loop. This corresponds to switching on the 
"Loop" button in the transport control. 

 

Change Play Direction 
This command changes the playback direction, even during playback. 

 

Cue Mode 
Cue mode is a special live playback mode often used for playable material like original 
sounds in radio broadcasts and theater. The objects contained in the original sound track 
(= cues) may be played back in sequence while they are recorded in another parallel track. 

 

You can control Cue mode in two ways: 

1. Control using object edges 

Starting playback with the space bar highlights the next range and then plays it in Cue 
mode. Playback stops automatically at the object's end. Upon resuming playback the 
following object starts etc. Related objects are treated as an object. 

Of course, multi-track projects may be played in cue mode. The object on the first track will 
be used for the Start/Stop range markings. 

2. Control via track markers 

With the help of the CD track markers you can use and control cue mode for complex 
arrangements independent of the object edges of the first track. To do so, switch on "CD 
arrangement" mode in the "CD/DVD" menu. Now position CD track markers at the desired 
positions in the timeline. 
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Once play is activated, playback will begin from the next CD track marker and end at the 
next one after that, which in turn is the starting put for the next playback range. 

Note:  For smooth Cue mode use deactivate the Loop mode. 

In cue mode, the recording mode in the transport control changes to Record without 
playback (band control) (view page 581). The original sound track is highlighted with a 
special background color.  

If recording is done in cue mode, automatic scrolling in the arranger window will remain 
switched off.  

The play cursor may be repositioned at any time within the currently played original sound.  

"System options -> Playback (view page 477)" may be accessed to ensure that the first 
track in cue mode is switched to"Solo". Pre-roll (ms) may be used to specify in 
milliseconds how long the delay between execution of the record command and the actual 
start of the recording should be. 

 

Scrubbing Active 
 Scrubbing Active Keyboard shortcut: "Alt + Shift + Page down" 
 Jog (Absolute) 
 Two Speed 
 Shuttle (Relative) 
 Scrub Left   Keyboard shortcut: "Alt + Shift + Arrow left" 
 Scrub Right  Keyboard shortcut: "Alt + Shift + Arrow right" 

Detailed information about scrubbing is provided in "Playback -> Playback options -> 
Scrubbing (view page 579)" 

Playback at speed 1 - 4: Select from four different playback speeds. Playback begins 
immediately after the corresponding object is clicked. 

 Play with Speed 1: Playback begins at the cursor position at 1/4 of the original speed. 
 Play with Speed 2: Playback begins at the cursor position at half speed. 
 Play with Speed 3: Playback begins at the cursor position at original speed. 
 Play with Speed 4: Playback begins at the cursor position at double speed. 
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Playback parameters 
Choose this option to open the play parameter window. 

 

Shortcut:  P 

Check the "Stop at current position" option if you wish the play cursor to remain at the 
same position after stopping playback. If this option is not active, the play cursor will jump 
to the original position or back to the start of the range when playback is stopped. 

The "Check space key for playback stop also in background" option also allows the 
space bar to be used for "Play" and "Stop" in Samplitude while using a different software 
application. 

An additional function can be used in case of overload, i.e. "Escape key stops playback 
and record". 

The pre-roll time is a necessary parameter for editing in Samplitude. Pre-roll time is used 
to define (to the second) the desired section before the start of the selected range. 

The maximum reverb time for objects without fade-out can be set up to 60 seconds here.  

Note: Please note that the length of reverb time can lead to performance problems. 

Cue ensures that the first track in cue mode is switched to "Solo". Pre-roll (ms) may 
be used to specify in milliseconds how long the delay between execution of the record 
command and the actual start of the recording should be. 
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Detailed information about cue mode is available via  the menu item "Play / Rec -> 
Playback mode -> Cue mode (view page 576)". 

With Autoscroll the graphical display runs the entire time before the play cursor reaches 
the visible section. This provides a constant overview.  Switch to autoscroll mode by 
checking "Active". "Active for zoom < 1 s"  causes autoscrolling to begin at very high 
zoom levels of less a second 

Choose between "Page" and "Soft" autoscroll modes. With page scrolling, the section 
changes before the play cursor moves outside the section, while with soft scrolling, the 
play cursor always remains in the middles of your chosen section and the arrangement 
moves along beneath it. At smaller buffer sizes (view page 25) (e.g. < 4096 samples), 
scrolling will be softer. 

Note:  The autoscroll process can overload the processor in some cases, in which case 
dropouts will occur in playback. Deactivate "Autoscroll" mode if this happens. 

 

Scrubbing 
If you press "0" on the number pad or the key combination "Alt + Shift + Page down" and 
hold these keys down, Samplitude switches to "Scrub Mode". 

This provides special control via the mouse over the selected track's playback speed. 

The keyboard shortcut for scrubbing to the left is "Alt + Shift + Left arrow" 
The keyboard shortcut for scrubbing to the right is "Alt + Shift + Right arrow" 

There are four different scrubbing modes to choose from: 

Shuttle: The relative distance between the play cursor and the mouse position is used to 
control the speed. The play cursor follows the movement of the mouse. The further you 
move the mouse from the play cursor, the faster playback will be. This means: 

Scrub control faders at the left edge = double speed backwards, 
Scrub control fader in the middle = no movement, 
Scrub control faders at the right edge = double speed forwards. 

Absolute: Use the absolute position of the mouse in the window to control the speed. 

Two speed: Two speeds are provided for scrubbing. The object plays back slower or 
faster depending on the distance between the scrub control fader and the mouse position, 
in which case slow scrubbing at a speed of 0.25, or 1/4 of the original speed is preset, and 
fast scrubbing is set to 1.0, i.e. the original speed. Change the value for slow playback in 
the "Speed" field. 

One speed: The preset scrubbing speed is 1.0, i.e. original speed. The "Shift" key reduces 
this value by half. The "Ctrl" key uses the speed set in the "Scrubbing speed" field. 
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Scrubbing speed: This specifies the factor of the original speed applies to the scrubbing 
speed. The range of values stretches from 0.01 to 10.0, i.e. 1/100 of the original speed up 
to ten times the regular speed. 

Scrubbing only on active track (1 track): If this check box is active, Samplitude will only 
scrub the active track. 

Global play device: Specifies the sound card driver for playback. 

 

Record 
If you select this menu point, recording is started immediately for the live, active track. You 
can record both the audio as well as the MIDI into each active track here. 

Detailed information on recording can be found in the chapter "Samplitude Quickstart -> 
Workshop: recording (view page 80)". 

Shortcut:  R 

 

Record Mode/Punch In 
Standard Mode (Playback while Recording) 
This option corresponds to the option in the recording options with the same name. This 
mode allows tracks to be recorded in addition to existing audio tracks while playback is 
running.  

Switch on the new recording tracks and activate monitoring.  

 

These tracks are now active in "Input" mode, i.e. the input sound desired for recording will 
be audible for these tracks. Recording begins at the play cursor position.  

If you have selected a range behind the play cursor on the grid and marker bar and have 
activated "Loop" mode, then recording will only begin at the loop start. Click the recording 
button at the play cursor position and the track will signal that it is ready to record (the 
recording button will blink during playback). Recording will only be activated once the start 
of the range is reached, and the selected range will be recorded in "Loop" mode. 
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Record without Playback 
If you begin recording in "Record without playback" mode, then recording will start at the 
play cursor position when the record button is pressed. Initially, only the track's input signal 
will be audible at the point where you are currently working in "Record" mode. The play 
cursor will not run in the timeline. 

If playback is now started from the position of the play cursor, all playback tracks will be 
audible from this position. Recording continues independently until the "Record" button is 
pressed again. The recording that was just created will now be visible as a new object in 
the arranger. 

 

Punch Marker Mode 
This button activates Punch Marker Mode. "Punch-in/out" is a recording process which 
can be started and ended while playback is running. 

There are two principal approaches for punch recordings: 

 Punch "on-the-fly": In this mode, the recording may be started (punch-in) and stopped 
again (punch-out) at any time during playback. Multiple punch processes may be made 
during a single pass in order to improve various positions in one recording. Start 
playback with the spacebar. Next, clicking the "Record" button in the transport console 
"punches in" and "punches out" again. 

Note: If you check "Prepare all tracks for track punch record" in the "System options -> 
Record (view page 475)" menu, you will also be able to punch your recording by pressing 
the "R" buttons for the individual audio tracks (see below). 

 Punch with markers: To execute the punch procedure with markers, activate the 
buttons "In" (sets the punch-in marker) and "Out" (sets the punch-out marker) at the 
desired positions. Start the process with the "Record" button on the transport console 
or the "R" key of the corresponding track. The actual recording occurs within the punch 
range. While this is happening, the "Record" button will flash when the play cursor is in 
front of the "In" marker. The button remains red during the punch recording. 

 Multiple punch recordings in one pass: It's possible to make multiple punch 
recordings in one pass with the help of punch markers. To do so, add extra punch 
markers by positioning the play cursor at the desired point and, while keeping the "Alt" 
key held, press the "In/Out" buttons in the transport control. 

Note: When working with punch processes, it is useful to have "Auto crossfade" mode 
active. "Auto crossfade" will create smooth transitions automatically between takes so that 
no pops or crackles result. 

 Punch recordings may also be executed as loops. Select a range across the planned 
punch range, press the "Loop" button and activate the recording. This will be looped 
until the process is canceled with the spacebar. Punch-in and punch-out markers are 
set automatically. A punch recording is at the punch position per pass. To find the best 
take from these looped runs, use the "Take manager (view page 150)". 
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 If the recording option "Pre-activate all tracks for track-punch recording" is active 
("System options -> Recording"), then audio tracks that were not active when recording 
was started may be added to a recording, or tracks may be removed from the 
recording. Click the "Record" button for the desired track. Punching an individual track 
requires that the track has been assigned to a sound card input that has not already 
been used for recording. This is indicated by a red circle around the record button in the 
track header. 

Note: Tracks that have been displaced in "Punch marker" mode via individual track 
punching will not be influenced by punch markers. 

 

Record Pause 
Recording is set to pause. 

 

Record Options 
This menu option opens the Record window. All recording settings can be changed here. 

 

Shortcut:  Shift + R 

Format:  Set the corresponding recording file format (Wave, MP3, MPG, WMA, Real 
Audio, AIFF, Ogg Vorbis, and FLAC). In the infobox below, you'll find information about 
each of the formats available. This way you can see if the format is editable in Samplitude 
as well as the compression it uses. 

Bit rate: Select the desired bit rate here for your recording. 

Recording mode: Choose between stereo, mono, and mono mix. 

 If you select "Stereo", the channel input will be switched to stereo, and the signal will be 
picked up on two channels. 
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 If you select "Mono", the channel input will be switched to mono, and the signal will be 
picked up only on one channel. 

 If you select "Mono (Mix)", the channel input will be switched to mono, and the signal 
will be picked up on two channels, and then mixed together. 

Preload: The recording is prepared and all buffers will be loaded. Thereafter, the message 
"Data loaded. Waiting to start..." appears. As soon as you press "OK", the recording starts 
without any delay. 

Sample rate: This option allows you to select the sample rate of the recording. Take note 
that your audio card must support the selected sample rate. 

Resampling to 44.1: If you have set a sample rate of 44,100 Hz and then activate this 
option, Samplitude will apply resampling at 44.1 kHz. The quality of resampling may be set 
via  "System options -> Effects -> Resampling/Bouncing. (view page 483)". 

Recording start: Set the recording start time in this field. The recording is then controlled 
automatically by the internal system clock to a specific time. 

Recording length: Specify the recording length in this field. Using "Recording start" and 
"Recording length" you have the option of executing timed recordings even when away. 
"Recording" is armed as soon as Record has been activated and starts at the set time for 
the set length. If no length has been selected, recording continues until the hard disk is full 
and then stops automatically. 

Record device: Here you can select the sound card driver that should be used for 
recording. If there is no entry here, or a wrong one, then the card is not installed in 
Windows correctly. Use the "Info" button to find out the recording properties of the 
recording device. 

File path: Specify the path to the files where the data should be recorded. The yellow 
folder button opens a query for selecting the path and file name. 

 

Further recording Options 
Monitoring Mode: 

Please also read the chapter "System options -> Global audio options -> Monitoring 
settings (view page 27)" for more details. 

Monitor: Use this button to activate the LED control displays. Please note that the 
recording device must be selected prior to beginning this. While recording, the LED control 
displays move slower, but they nevertheless show each maximum level. 

Play while recording: Activate synchronous recording and playing here if this supported 
by your sound card.  
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Note: If you want to record and play over multiple sound cards, small differences may 
result during playback of longer passages. This is as a result of sample rates of cards 
which are not 100% synchronous. Ideally you should use the same card for recording as 
you do for playback if possible. If your card creates a delay between the start of recording 
and the start of playback, you can balance it out in the "Record Offset" field. To do so play 
a sample with a noticeable impulse and record it using a loop from the sound card's output 
to the sound card's input. Then zoom into the Arranger to such a depth that you can 
precisely pinpoint the offset value. 

Create VIP object: Specify whether or not all recordings should be integrated 
automatically into a virtual project via this mode. The created objects are named with the 
specified object names. 

Update object during recording: This object updates the graphical display of the object 
while recording. 

Read CD/DAT marker: DAT devices and several professional CD players output digital 
marker information via an SPDIF output e. g. CD track markers or DAT markers). With this 
recording option all marker information is read from the soundcard's SPDIF input, provided 
the selected audio device supports it. 

Pre-recording (ASIO only): This recording option inserts audio material added at the 
beginning of the recording to the beginning of the current recording.  

More information about pre-recording is available via the menu item "Program preferences 
> System/Audio > Record (view page 475)". 

Recording offset (samples): If recordings exhibit a constant, undesired shift in relation to 
the existing audio material in the arrangement, set an offset here which can be used for 
positioning all recordings. 

Advanced options: Detailed information about advanced options is available viaFile > 
Program preferences > System/Audio > Record (view page 475)". 

Recording information: This area provides information about the last recording that was 
made, i.e. Recording time (length of the recording), Remaining time (remaining recording 
time), and Drive space (remaining storage space on the hard disk being used).  

Visualizer: Opens or closes the visualization window. 

Reset Pk.: Reset the visualization's peak hold display. 

Record: Click this button to start the actual recording.  

Note: During active external synchronization as the "Slave", recording does not start 
immediately, but rather when the master starts. 
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Stop: Ends a running recording process. 

Recording pause: Use this button to interrupt the recording process. The play cursor 
continues to run. Pressing "Recording pause" again restarts the recording from wherever 
you want it to continue. 

Take +: Each object or take number (Take 1, Take 2...) is given a marker so that it can be 
found again quickly. 

The take manager (view page 150) is ideal for managing the individual takes. 

Marker 1: While recording, the option is available to select a marker at the current position 
of the play cursor, e. g. to correct an erroneous passage later on.  

Close: Use this button to exit the recording options window. 

 

Monitoring 

Please also read the chapter "System options -> Global audio options -> Monitoring 
settings (view page 27)" for more details. 

 

Move Play Cursor 
to Beginning 
This option positions the play cursor at the beginning of the project. 

Shortcut:  Home 

 

to End 
This option positions the play cursor at the end of the project. 

Shortcut:  End 

 

to Range Start 
Sets the start position of the play cursor at the beginning of the currently selected range. 

 

to Range End 
Positions the start position of the play cursor at the end of the currently selected range. 

 

to Start of Section 
This option positions the play cursor at the beginning of the visible section. 

 

Left/Right Move in Page/Scroll Mode 
Use these commands to move the play cursor to the right or left. 
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In "Page" mode, the play cursor moves across the screen to the end of the visible section; 
at that point, the window view shifts to the start of the following section. 

In "Scroll" mode, the play cursor jumps to the middle of the section and remains there as 
the project moves through it. 

Shortcuts: 
Movement in "Page" mode:  Right arrow/left arrow  
Movement in "Scroll" mode:  Alt + left/right arrow 

Note: Once a range open is open, use the "left/right arrow" keys to control the beginning 
of the range. 

 

Object Border Left 
The play cursor jumps to the left to the next object edge in the selected track. 

Shortcut:  Ctrl + Q 

 

Object Border Right 
The play cursor jumps forward to the right to the next object edge in the selected track. 

Shortcut:  Ctrl + W 

 

Marker Left 
The play cursor jumps to the left to the next marker in the arranger window. 

Shortcut:  Alt + Q 

 

Marker Right 
The play cursor jumps forward to the right to the next marker in the arranger window. 

Shortcut:  Alt + W 

 

Recall Last Stop Position 
If the option "Stop at current position" has not been selected in "System options -> 
Playback", then the play cursor may be positioned at the last stop position with this 
command nevertheless. 

Shortcut:  Ctrl + Alt + , 

 

Repeat Last Position(s) 
This command jumps the play cursor to a maximum of 5 previous stop positions. 

Shortcut:  Backspace 
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Markers 
You will find a number of functions for managing markers. The function keys and numbers 
can be used to easily save, name, and reopen marker positions. 

Detailed information on working on ranges and markers can be found in the "Functions in 
the project window" chapter. 

 

Save marker 
With the option "Marker with name..." you can specify further markers to which you can 
assign a name of your choice. 

In the "Marker with names and numbering..." dialog " you can freely number and name 
additional markers. The "-1 sec" button drags the marker one second forward in the 
marker list. 

The command "Markers with automatic numbering" automatically creates markers with 
sequential numbers. 

Shortcut:   Shift + # 

The function "Marker on record position" causes a marker to be created at the current 
recording position during each recording. 

Shortcut:   Alt + ? 

Defined markers are visible at the top border of the project window and can be moved with 
the mouse. The mouse pointer changes to a double-arrow (<->). 

Set markers 1 - 10: You can set markers at the play cursor's current position by selecting 
a number between one and ten from the menu. 

Shortcut:   Shift + 1...0 

Jump to markers 1 - 10: You can set marker positions at the play cursor's current 
position by selecting a number between one and ten from the menu. 

Shortcut:   1...0 

 

Marker on Range Borders 
Use this function to set a start and end marker at the borders of a selected range. 

 

Set Markers on Silence 
This function automatically sets markers at positions of selected low-volume or silent audio 
objects. Open the dialog to specify a threshold and a minimum time for detection. 
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Min. time (ms): Set the minimum time threshold that must be exceeded in order to set a 
marker. 

Threshold (dB): Specify the threshold in decibels here. 

Note: When working in destructive wave editing mode, the height of the range in the wave 
project is set to the level of the threshold to make it easier to see.  

Start number: Enter the marker number that is counted upwards to "Marker after silence" 
here. 

Prefix: Enter additional characters/letters which will precede the "Markers after silence" 
here. This makes it possible to easily differentiate them from markers that may already 
exist. 

Add time (ms): Enter the time range in order to move the "Markers after silence" forward 
here. The selected object is moved forward by exactly the amount of the time range and 
filled with silence. 

Delete all markers with prefix: Deletes all markers that have prefixes. 

Delete all markers: Deletes all markers in the project 

Delete VIP objects: This option cuts the object at the set value and may then be deleted. 

 

Rename Marker 
If a marker is selected in the marker list (by clicking it), then this function may be used to 
rename it. 

 

Delete Marker 
This deletes the marker at the current position when selected from the marker list by 
clicking its front edge. 

 

Delete All markers 
This function deletes all markers in the active project. The audio markers, however, remain 
in the wave objects. 

 

Delete Markers in Range 
Deletes all markers of the selected range. 
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Set New Audio Marker 
This command sets an audio marker at the current play cursor position of a selected audio 
object. If a marker was previously set at this position, then its name will be applied as an 
audio marker. 

 

Copy Audio Marker to VIP Marker 
This copies all available audio markers of the selected object to the marker bar in the 
arranger window. Application of the VIP markers only occurs within the object boundaries. 

 

Copy VIP Marker to Audio Marker 
This copies existing markers from the marker list inside the object borders to the 
corresponding position of the audio object in the wave project. 

 

Audio marker manager 
Audio markers are linked to the audio material, and are visible on the upper side of´an 
audio object. The purpose of the audio marker is to mark positions within the audio 
material, this marking will therefore remain regardless of the positioning in the virtual 
project. 

Make Audio markers visible by marking the "Audio markers" checkbox in the view 
options ("Shift + Tab") in the "Objects" section. 

The audio markers displayed in the object of the virtual project are identical to the markers 
in the corresponding Wave project. If you want to place a new project marker in a Wave 
project, as is done automatically when recording a new take, the audio markers are visible 
at the same position in the audio material in all related objects. 

The following markers are able to be created and edited via the audio marker 
manager: 

 By right clicking under the upper edge of an audio object in the virtual project a menu 
will appear, in which all audio markers are listed. You can go straight to them by clicking. 
In the same menu you can place new Audio markers at the play cursor's position or 
open the Audio marker manager. 
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 The position of the Audio marker selected in the Audio marker manager can be changed 
in the editing field. If you click there a double ended arrow will appear at the selected 
point, with this you can change the corresponding value. The value content can be 
chosen in the field to the right. 

 

Note: All time information for the audio marker relates to time positions in the audio 
material, and not to positions in the virtual project. 

 

Set Start Marker 
This function sets the punch start marker (punch-in) to the beginning of a selected range. 

 

Set End Marker 
This command sets the punch end marker (punch-out) at the end of a selected range. 

 

Delete Punch Markers 
This command deletes the punch-in marker and the punch-out marker from the marker 
bar. 

 

Additional Punch Start Marker 
Adds another punch in marker. 

 

Additional Punch End Marker 
Adds another punh-out marker. 
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Delete Additional Punch Markers 
This command deletes additional punch markers from the VIP. 

 

Set new Tempo marker 

Detailed information on placing Tempo markers can be found in the chapter Edit > Tempo 
> Tempo Map Dialog". (view page 301) 

 

Set New Time Signature marker 

Detailed information on placing time signature markers can be found in the chapter Edit > 
Tempo > Tempo Map Dialog". (view page 301) 

 

Set new grid marker positions 

Detailed information on grid position markers can be found in the chapter Edit > Tempo > 
Tempo Map Dialog". (view page 301) 

 

Ignore all Tempo Markers, Use Project Tempo 
This option enables all previously created tempo markers in your project to be ignored so 
that only the project tempo is authoritative. 

 

Marker manager 
The marker manager lists all of the markers contained in the current project and makes it 
possible to jump directly from the list to them or to play them. 

To view the marker manager, click the "Manager" button in the toolbar and select the 
"Markers" tab. 

Shortcut: Ctrl + Shift + Alt + M 

Detailed information about this is can be found in the chapter "Manager -> Marker 
Manager". 
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Auto JamSession 
You can now jam quickly and creatively with your virtual band thanks to Auto Jam 
Session's practical loop automation function. Record your instrument on separate tracks 
and develop the song structure systematically. 

The recorded tracks are then put straight into an endless loop after the recording. 

 

Auto JamSession - access 
Open an Auto Jam Session via "Playback -> Auto JamSession..." or via the "Record" 
mode box in the transport window. 

Shortcut:  Shift + J 

 
 

Auto JamSession – modes 
There are numerous ways to record a song: 

 If you want to play loops yourself, leave the "accompaniment" field empty. The loop that 
was recorded first is used as set the tempo of the song in BPM (beats per minute). The 
buttons 1-8 function as mute or solo buttons depending on their set modes. 

 If you would like to jam to another prerecorded session, select one of the included 
accompaniments. The tempo of the song will be determined from the template. There 
are two types of templates: 
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Template in instrument mode (mute): The accompaniments consist of multiple 
instruments that can be muted using buttons 1-8 (or the corresponding number keys on 
the keyboard). 
Variations mode (solo): These accompaniments contain multiple variations of the same 
instrument that you can switch back and forth during playback via buttons 1-8. 

Reset: This function allows you to switch between various "Reset" functions. You may 
either: 

 set the "Mute/solo" buttons back to original state or  
 stop the last recorded loop at the play cursor position or 
 stop all imported loops at the play cursor position or  
 stop all loops at the play cursor position or  
 delete the entire project. 

 

Auto JamSession - operation 
After launching, you'll see the simple view of the Auto JamSession. On the right-hand side, 
you'll find useful hints on how to use the feature. 

"Action" button: The "Action" button on the lower left is an important control element, and 
it may also be activated via the spacebar. Repeated clicking triggers the various functions 
in series to produce your own jam session. 

1st click: Playback begins. Recording does not start. 
2nd click: The first recording starts. Record your first beat(s). As a symbol that recording is 
running, the "Action" symbol turns red. 
3. Click: Interrupts the recording while playback continues. The portion played is inserted 
into the arrangement as a looped object. 
4th click: In the next track, the recording starts. You can also hear the previously recorded 
loop. 
5th click: The recording is interrupted, playback of the first and the newly recorded loop 
continues. 
etc. 

This allows any number of additional voices to be played. 

Double clicking the "Action" button stops the most recently recorded loop and cuts it at 
the current play cursor position. Triple clicking cuts all played loops at the current 
position. 

Clicking the "Stop" button ends the playback/recording immediately. 

 

Auto JamSession - loop effects 
You can change your arrangement with these real-time effects. The loop effects influence 
either every track or just the last track recorded (see below). 

From a technical standpoint, these loop effects belong in the object effects category. If the 
loop effects are activated, separate objects will be created from the loops. 
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Half speed: Press this button to halve the playback speed. 
Double speed: Press this button to double the playback speed. 

For example, "Half speed" allows you to play nearly impossible guitar solos. Switch the 
existing backing arrangement to "Half speed", record your guitar solo, and then click 
"Double speed" again. Your accompaniment plays in original speed again and your solo 
now sounds twice as fast and an octave higher. 

Reverse: This effect plays the whole arrangement backwards. Opening it again resets it. 

 

Auto JamSession - advanced dialog 
Clicking the ">>" button opens the enhanced Auto JamSession dialog. 

 

Tempo 

Select the tempo from the list or enter one of your choice here. 

"–" indicates that the speed adapts to the first recorded loop or to that of the 
accompaniment (if chosen). 

Quantization 

The quantization ensures that recorded loops fit into the arrangement that is created. 

There are multiple options for quantization: 

Length of the next whole loop: The new loop is recorded with the same length or a 
whole-numbered multiple (2x, 3x, 4x...) of the original loop length. The loops always remain 
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synchronous, but do not need to have the same starting point. This is the preset 
quantization mode. 

Start + length of the next whole loop: Recording only starts after the next loop border. 
The length is quantized like in "Length of the next whole loop". The starting points of the 
loops are all at the same positions. 

Length to previous whole loop: The loop end is shortened to the last exceeded loop 
border. This is useful in case the "Action" button (spacebar) is only managed to be clicked 
shortly after the next loop passage during playing. 

Start + length to next bar: The starting point of the recording and the loop length are 
adapted to the bar. This is useful if you have recorded the first loop over multiple bars. 

Start + length to the next beat: The starting point of the recording and the loop length 
adapt to quarter beats. This is useful if very short loops are played. 

Both of these last two options are useful if the "Tempo" has been set or is given by the 
accompaniment. 

Freestyle: Quantization is deactivated in this case. No more loop starts or loop lengths are 
adapted when recording. 

Quantize mute/solo/effects: This option also quantizes the control of solo, mute, and 
other effects (double speed, half speed, reverse). 

Only use loop effects on the last track: The loop effects are always used on the last 
track. 

 

Auto JamSession - record device 
You can select the desired sound card or sound card input via this dropdown menu. 

Visualizer: This button switches the visualization on or off. 

Monitor: This button activates/deactivates monitoring. This means that the incoming signal 
is displayed in the visualization and played by the sound card output. 

Tuner: This button opens an additional visualization in the "tuner" mode for tuning 
instruments (e.g. a guitar). 

 

Auto JamSession - recording information 
Recording time: The recording time indicates how long you've been recording. 

Remaining time: This indicates how much longer the hard disk may recorded to. If you 
have multiple hard disks or hard disk partitions, the recording capacity of each of these are 
also shown. 
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Retrospective Recording (MIDI Pre-Recording) 
Samplitude creates a MIDI object in the recording-ready MIDI track that may be adjusted in 
terms of buffer length via "System options -> MIDI".  

 

Retrospective recording intermittently saves MIDI events and audio signals in an adjustable 
memory buffer in RAM. This takes place while running, even if a recording is not being 
made via the record button. This enables creative moments to be captured and then 
integrated into the project as a file/object. In this case, it doesn't matter whether the project 
is playing or not. 

The MIDI object may be added at the cursor position or synchronous to the last playback. 
A prerecording of 2 seconds is also saved during MIDI recording as an extra take. By 
changing the takes in the take manager, e.g. from "MIDI Take3" to "MIDI Take3 PreRec", 
you can drag the object to the left to restore the rhythm played prior to the actual 
recording. The object borders will be adjusted to exchange the take. 

Note: If you would like to add an audio recording from the buffer into the project 
retroactively, drag the newly created object to the left after recording (according to the set 
pre-recording time in the recording dialog of the system options). 

 

MIDI Record Mode 
The MIDI recording modes specify how newly recorded MIDI data is inserted into the virtual 
project if there are already MIDI objects at the recording position. 

 

Normal 
In this recording mode, a new MIDI object is created over the existing object for each 
recording. All objects are maintained. This way, you can record multiple takes of a passage 
and then compare them to the object with "Alt + right click". 

 

Overdub 
In this mode, the data for each new MIDI recording is mixed with already existing takes. 
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Replace 
In this mode, MIDI files of the existing object will be replaced with newly imported ones. If 
you record over several objects, these are combined into a single new object. 

 

MIDI Panic – All Notes Off 
This command sends a note off command to all MIDI devices that are activated in the MIDI 
options for all 128 notes on all 16 channels. The sustain (Controller 64) is also shut off, and 
the pitch wheel and modulation are reset to 0. All VSTis used in the project will also receive 
the all notes off command. 

If MIDI tracks or objects exist in the project, the same function is also accessible by clicking 
the stop button in the transport console or toolbar when the project is stopped. 
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Automation Menu 
No effect (Track) 
If you select this display option the track automations are deactivated. 

 

Edit selected curve 
Create 
The curve generator (view page 335) creates a beat-based volume curve and pulses 
according to eighth, quarter, half, or full notes. You can enter a minimum and maximum 
value or define delay values as an option for the beat-based envelope curve calculation. 

As an alternative, you can also let the curve generator write an envelope curve scan. 

 

Invert 
This command inverts the activated automation curves. 

 

Thin Out 
This function "thins out" the activated automation curve by reducing the number of 
automation events. During recording, the automation events are placed in very short 
intervals. The "Thin out" command reduces the number of curve points. The course of the 
automation is then displayed and reproduced more accurately. 

 

Inactive 
Use this command to deactivate the selected automation curve. 

 

Curve Color... 
This command displays a color palette to specify the color of the active curve. 

 

Copy, Paste, Delete 
The active automation curve may also be copied, pasted into other tracks, and deleted. 

 

Delete All Curves 
This command deletes all automation curves in the corresponding track. 

 

(Track) Automation Mode 
Specify the track automation mode here. "Copy to All Tacks" applies the currently 
selected automation mode to all tracks/channels. Select "Write Only Existing Curves" to 
apply the automation data to existing automation curves only. 

Detailed information about the automation modes is available in the chapter "Automation -> 
Automation modes (view page 329)". 
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MIDI Controller Automation 
This opens the "MIDI controller/automation curve settings" dialog. 

Detailed information about MIDI controllers is available in the chapter "MIDI controller 
automation (view page 338)". 

Shortcut:  Ctrl + Alt + A 

 

Hide Automation 
Use this option to deactivate the display of automation curves for all tracks. 

 

Show Track Automation 
Select this display option to display only the track automation. 

 

Show Object Automation 
If you select this display option, only the object automation will be displayed for all tracks. 

 

Show Only Selected Curve 
Views only the selected curves for the corresponding track. This helps to maintain a clear 
overview if several automation curves have been created. 

 

Show all curves (not selectable) 
The deselected automation curves are grayed-out. They cannot be activated with the 
mouse. 

 

Show all curves (selectable) 
The deselected curves are also shaded, but may now be activated with the mouse. 

 

Select previous curve 
With this you can select the last edited curve. 

 

Select next curve 
With this you can call up the next curve from the selection list. 
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Effects Menu 
This menu entry provides fast access to the relevant real-time effects at object level. 
Correspondingly, menu entries for all object effects are provided here. 

Note: All effects opened using this menu are calculated destructively, provided the option 
"Apply effects offline" is active. The option to work with a copy is available in order to 
preserve the original audio material. The "Create copy" option is already selected in the 
corresponding dialog. 

 

Notes concerning offline effects editing 
 When editing objects via the context menu item "Edit wave project", offline effects 

always have an effect on all of the objects that reference the same audio material. If this 
is not desired, access the command "Edit a Copy of the Wave Content" prior to 
destructive editing via the selected object's context menu. Samplitude will create a copy 
of the audio material and add this to the project folder. The corresponding object now 
refers to the copy that has been created. Following this, offline effects may be applied to 
the selected object without influencing other objects. 

 Activate the option "Create copy" in the offline effects dialog to use the undo function in 
the VIP later (this allows you to undo destructive editing). 

 The following functions are available exclusively for wave projects: "Sample Manipulation 
-> Sample Amount *2, /2", "Show/Hide", "To Zero" and "Build Physical Loop". 

Note on the "Undo" function: Please tick "Undo active" via the "Options menu -> 
Program Preferences -> Undo definitions (view page 497)" for virtual projects and for wave 
projects in order to activate the undo function. 

 Please note that most functions only work within the selected range in the wave window. 
To use the functions on the entire wave project, the entire wave project must be 
selected (Shortcut: "A"; menu item: "Edit > Range > Range all"). 

 On the other hand, selected objects in VIP projects are changed independently of the 
selected range across the entire range (the only exception here is the "Get noise sample" 
function. (Eine Ausnahme bildet hier nur die Funktion „Noise Sample holen“). If you do 
not wish to change the whole object, spit it at the range edges using the "T" key and 
activate "Auto-crossfade" mode to avoid crackling transitions. 

Play/Stop:  This button starts/ends the preview function for each offline effect. Previewing 
editing does not occur in real-time, the result, however, will match the end result. 

OK: The edit is applied to the selected range of the sample or the selected object. 

Cancel: Click this button to close the dialog window without applying any editing. 

Help: Displays the Help feature. 
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Advanced options for offline effect calculation 
These settings may be opened in the corresponding effects dialog by clicking the 
"Advanced options" button. Alternatively, this dialog may be accessed via "Options -> 
Program preferences -> Destructive effect calculation...". 

 

In this dialog, choose to write a copy with offline effects from the many options. 

 

Destructive Effect Calculation in Wave Projects 
If this is not desired, access the command "Edit copy of wave project" prior to 
destructive editing via the selected object's context menu. Samplitude will create a copy of 
the audio material and add this to the project folder. The selected object now refers to the 
copy that has been created. Following this, destructive effects may be applied to the 
selected objects without influencing other objects. 

The dropdown menu of the dialog provides selection between three styles of saving when 
executing offline effects. Saving is required in order to be able to undo offline effects. A 
check must be placed beside "Create copy" in the effect dialogs for this to be available. 

Note: Deselect this function if you're sure that the undo function will not be required. A lot 
of time and hard disk capacity can be saved if a copy of the wave is not created. 

 Append effect to original file: The object with the calculated effect is added to the 
original file. However, this has some disadvantages: When working in an integer wave 
file, the effect is also saved at this resolution, which is not always desirable when 
working with 32-bit resolution. The length of the wave file is also changed, which may 
cause problems when working with looped objects or in various VIPs. 

 Write effect to an FX file (._FX.wav): The result of the effect calculation is written to a 
separate file with the extension "_FX.wav" so that the original wave project remains 
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untouched. This also makes it possible to execute the effect calculation in the 32-bit 
float format, to save it, and thereby keeping the full quality of the effect. The file is not 
overwritten with every new effect calculation, but rather the new effect is simply added to 
the effect file. 

 Generate a new FX file for each effect: All offline effects are saved in separate files 
with sequential numbers. Alternatively, these files may be given detailed names featuring 
effect descriptions and the date. 

The effects file may also be saved in the format of the output file, in a 24-bit format, or in a 
32-bit float format. 

 

Offline effects calculation in wave projects 
When opening a offline effect in wave projects, the result of the effect calculation is always 
added to the opened wave project. The options of the offline effect calculation on VIP 
objects described above are not taken into account. 

Temporary files for the "Undo" function are only created with offline  effect calculation if the 
"Undo" function for wave projects is also activated (Shortcut: "Y" – Program -> Undo) and 
"Create copy" is ticked in the corresponding effect dialog. 

If an effect is applied to a specific range in the wave project, a crossfade may be inserted 
between the effect and the original at the beginning and end of this range. Enter the length 
of the crossfade in milliseconds. 

Moreover, you can calculate a number of additional samples before object start and 
after object end. 

Preview Time (seconds): Preview time is the duration calculated for listening to effects in 
the preview function. 

Maximum length of editing range for spectral cleaning (seconds): Enter how long 
(maximum) the audio material should be edited during spectral cleaning.  

 

Amplitude: Normalize, normalize (quick access), loudness adaptation 

Dynamik: Dynamics, Advanced Dynamics, Multiband Dynamics, sMax11, AM-Munition 
(Samplitude Pro X Suite), AM-Track (Samplitude Pro X Suite / SE Version for Samplitude 
Pro X), AM-Phibia (Samplitude Pro X Suite), AM-Pulse (Samplitude Pro X Suite) 

Frequency/Filter:  Parametric EQ, EQ116, FFT filter/spectral analysis, brilliance enhancer 
(optional), Filtox 

Delay/Reverb:  Delay, room simulator, Ecox, Variverb 

Time/Pitch: Resampling/Timestretching, Elastic Audio  

Distortion: Distortion, Amp simulation, Vandal (Samplitude Pro X Suite / SE Version for 
Samplitude Pro X) 
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Restoration: De-clipper, de-clicker/de-crackler (optional), de-hisser, de-noiser, get noise 
sample, remove DC offset (offline), spectral cleaning (offline) 

Stereo/phase: Switch channels, multiband stereo enhancer, invert phase (both channels, 
left channel, right channel) 

Modulation/Special:  Convolution, vocoder, Corvex, reverse 

Sample manipulation:  Change sample rate (offline), sample number/2 (offline), sample 
number *2 (offline), reverse, form loop (offline) 

MAGIX Plug-ins: AM-Munition (Samplitude Pro X Suite) AM-Track (Samplitude Pro X 
Suite/SE Version for Samplitude Pro X), AM-Phibia (Samplitude Pro X Suite), AM-Pulse 
(Samplitude Pro X Suite), Corvex, Ecox, Filtox, VariVerb, Vandal (Samplitude Pro X Suite/SE 
Version for Samplitude Pro X) 

essentialFX:  eFX_ChorusFlanger, eFX_Phaser, eFX_Reverb, eFX_StereoDelay, 
eFX_Compressor, eFX_Gate, eFX_DeEsser, eFX_VocalStrip, eFX_TubeStage, 
eFX_TremoloPan. 

Process Only Left Stereo Channel 

Process Only Right Stereo Channel 

Process Effects Offline: Tick the checkbox here to process effects offline 

At object level you can swap object channels, invert phases, Object EQ, Object Dynamics, 
Pitchshifting/Timestretching, Object backwards, Elastic Audio, and MAGIX plug-ins. 

 

Amplitude 
Normalize 
Use this function to change the amplitude of the sample data. It will be amplified in such a 
way that the highest amplitude that appears in the range is set to 100% (or another value 
between 1% and 400%) of the value range. In this case, the maximum is first detected and 
calculated with the selected percentage value. All values are then weighted by the new 
factor. 

Use this function to fully modulate samples or overmodulate targeted audio segments. 
Note that the noise level also rises during normalizing. 

This function is especially useful when converting from high to lower bit rates. This 
guarantees that the otherwise low dynamic range is used to its full extent at lower rates. 
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Shortcut:  Shift + N 

 

Note: If you experience very slight clipping during recording and then proceed to normalize 
the material, you won't achieve the same quality as when you produce an overmodulated 
recording! For example, if you only modulate half of the material, then your recording will 
have a quality of 15-bit samples – normalizing to 100% will not change anything. 

Normalize to: Set the value which the audio material should be normalized to by entering it 
into the input field, moving the fader, or selecting one of the presets (50, 95, 100, or 
200%). The value will be shown in % and dB (100% = 0 dB = max.). Values above 0 dB will 
cause digital clipping. 

Level maximum: This indicates the highest resulting volume for the selected range or 
object in the corresponding setting. 

Level change: Displays the level change in dB according to the selected normalize level 
and the detected level maximum. 

 

Working Mode 
Virtual: This function performs real-time normalizing on the selected objects. In this case, 
the sample data is not changed, but rather the object volume is adjusted so that the 
loudest part of the object reaches the selected normalization level. This virtual normalization 
is non-destructive, unlike destructive normalization, which changes the audio material 
irrevocably. The object to may be restored to its original volume setting by selecting 
"Reset", which is located below the volume fader in the object editor. 

Destructive: The audio material is physically altered. A tick is set beside "Create copy" in 
the dialog. 

 

Multiple Object Selection 
When multiple objects are selected, there a number of different techniques to normalize 
them. 

Independent normalization: Each object is normalized according to its own maximum 
level. 
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Uniform normalization: The maximum level is detected from all objects and each object is 
normalized according to that value. This is active by default. 

 

Quick Access 
Set parameters: Use this button to make the settings of the normalization function 
accessible via quick access. 

Get parameters: Use this button to get the current quick access parameters in the dialog. 

 

Normalize (Quick Access) 
This function enables the specified settings in the "Normalize" dialog under "Quick access -
> Set parameters" to be used immediately. 

Shortcut:  N 

 

Loudness Adaption 
This command executes an automatic RMS normalization. The loudness of each individual 
title is analyzed and the level of the titles is adapted to create uniform volume sensitivity. 
The preset target value is -15 dBfs. The target value may also be adjusted individually. The 
closer the value is to 0 dBfs, the louder the signal will be.  

 

This adjustment determines the percentage of control between the titles and the target 
volume value. 

 

Fade In/Out… 
Use this function to show or hide selected ranges of samples in a wave project. The 
amplitude will change according to the progression from the start value at the beginning of 
the range to the end value and the end of the range. 

A simple fade-in process may be activated in the dialog via the parameters "Fade start in % 
= 0", "Fade end in % = 100". A simple fade-out may be executed by setting "Fade start in 
% = 100", "Fade end in % = 0". 

You can have the transition display in three different curve envelopes: exponential, linear, or 
logarithmic. 

Note that in virtual projects, powerful real-time fade and crossfade options are available 
that usually make the use of destructive fade routines unnecessary. 
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Set Zero 
The level in the selected range is set to zero. This allows unwanted parts within a sample to 
be removed. 

 

Dynamics Effects 
What Compressors are Available in Samplitude? 
There are four different modules for dynamic editing available in Samplitude: 

1. essentialFX Compressor (view page 690): A simple, efficient tool for reducing 
dynamics with soft characteristics and adaptive control processing. The "essentialFX 
Compressor" is a very musical compressor. 

2. Dynamics (view page 607): A quick and easy-to-use dynamics module. Its main 
functions (setup) may be set to compressor, expander, gate, or limiter. More specific 
parameters may  also be changed; "dynamics" always uses an efficient algorithm, which  
also reduces required CPU resources. 

3. Advanced Dynamics (view page 608): This module is a very comprehensive tool. It's a 
combination of a classic dynamics module (compressor/expander/gate) and an 
approximating limiter. The result is an undistorted, optimally modulated signal with defined 
volume. Setting the parameter is done either via direct input or by graphically changing the 
characteristic. Level detection may be derived via either "Peak", "RMS", or "Fast" mode. 

4. Multiband Dynamics (view page 612): This module offers extensive dynamics editing 
options. The advantage of dynamics manipulation across multiple frequency bands 
versus a standard process is that the danger of pumping and other side-effects sinks 
drastically. For instance, the function is able to prevent bass peaks from reducing the entire 
signal. Multiband technology also lets you specifically edit individual frequency ranges. 

5. Samplitude's AM-Track, AM-Pulse, AM-Phibia, and AM-Munition also provide 
specific dynamics editing functions that simulate analog effects processors. Read more 
about this in the extensive chapter "MAGIX Plug-ins (view page 698)". 

6. sMax11 (view page 618): This module enables the loudness of the audio signal to be 
increased by specifying input amplification (gain in). Essentially, this involves a hard or 
brickwall limiter with input amplification. 

 

Which compressor should be used and when? 
When to use a certain dynamics module depends on how specific the change needs to be. 
The "Dynamics" and the "essential FX Compressor" modules work well on mixer channels 
to quickly and efficiently influence the dynamics. 

The sound of an object should normally be changed very specifically. In this case, the 
dynamics of an instrument may be varied between the verse and the chorus, depending on 
the playback method. This is a desired relation that may be preserved or even forced using 
precise compressor settings. We recommend using "Advanced dynamics" to change the 
dynamic behavior of the source material as optimally as possible.  
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Experiment with "AM-Track", "AM-Pulse", "AM-Phibia", and "AM-Munition" to add 
characteristic pre-amps or tube sounds to your pieces. 

The mixer's master module features "Multiband dynamics" to give the entire mix its final 
balance. Since increasing the volume using a multiband compressor may produce clipping, 
it's necessary to have a limiter, which then approximates all clipping samples at the limiter 
threshold. 

We recommend using "Multiband dynamics" for each object/CD track when mastering 
CDs. This enables you to react to the differences of CD tracks with different multiband 
dynamics settings. 

"sMax" is intended as a loudness maximizer/limited that adds increased loudness to your 
audio signal. 

 

Dynamics (Compressor/Expander/Gate/Limiter) 

 

Use this editor to adjust a sample's dynamics. Each function may be previewed in real 
time. 

The graphics display shows the corresponding resulting dynamics curve for an improved 
overview. 

The following functions are available: 
Compressor: The dynamics of a piece are limited, loud sequences are dampened, quiet 
sequences become louder. Compression is often used to add power to audio material or 
to increase the loudness. The level of compression is adjusted by the "Ratio" controller; the 
activation threshold is determined by "Threshold". You can also influence the "Attack" and 
"Release". 

Limiter: Only the loudest passages are limited (above the threshold). Quiet passages 
remain unchanged. Limiters are used to reduce the level peaks without reducing the 
master dynamics. After the limiter process, the master level can be increased using 
normalization without having to worry about overmodulation. The "Limiter" preset sets a 
threshold of -0.2 dB when using the limiter as a peak limiter in the master area of the mixer. 



 

6 0 8  E F F E C T S  M E N U   

Limiter 100%: Performs the same editing as the limiter; however, the level is immediately 
raised to 0 dB, which corresponds with a subsequent normalization.  

Expander: The dynamics of a piece are increased, loud sequences remain quiet, quiet 
sequences become even quieter. Dynamics expansion is often used for recording speech 
featuring a high noise level. The expansion causes the level of the speech to be raised 
while the noise is suppressed. Please note that there is also a powerful De-noising 
algorithm provided. 

Gate: Very quiet passages (below the threshold level) are dampened or set to zero. This 
way, you can effectively suppress noise during the pauses between takes. Even at high 
compression (ratio > 5), the gate function is still useful to avoid strong increases in the 
quietest of passages and background noise. 

 

Dynamics - Parameters 
Ratio: This parameter controls the compression ratio. A value of 5.0, for example, 
corresponds to a volume reduction that's five times the threshold, while a value of 1.0 
means that compression is not applied. 

Threshold: This sets the threshold; the effect will be applied above and below this level. 

Attack: This sets the time frame from crossing the threshold to the maximum extent of the 
effect. 

Release: This sets the time frame between the point below the threshold and the complete 
reduction of the effect. 

Gate level: This parameter specifies which levels should be set to 0. 
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Advanced Dynamics 

 
 

Advanced dynamics – general controls and presets 
Load, save, delete presets: Save, load, or delete settings here. The default file ends with 
*.dy2. In addition, all dynamics presets (*.dyn) can be loaded. The parameters are 
converted to those available in the "Advanced dynamics" module. If saved again, the 
preset will be saved with the *.dy2 extension to make sure the settings are stored. 

Dynamic scope: When the selected object/sample is played, the in and out level of the 
signal appears as a white, scattered line. 

Reduction display: The level reduction of the played audio material is displayed to the 
right of the graphic display. 

In/out displays: These meters show the input and output displays in dB. 

Reset: Reset the reduction, in and out displays. 

Mode: These setups are typical applications of "Advanced dynamics". They provide default 
settings that make the graphical editing of the reference line easier. In this case, the 
number of editable parameters are limited by the choice of the setup so that with pure 
limiter application, for example, the other curve points will not change. 

OK: Accepts the parameters. 

Cancel: Rejects the parameters. 

 

Advanced dynamics – editing the reference line (graphically) 
To graphically edit the static transmission reference line, left click one of the bases of the 
curve on the reference line and move it while holding down the mouse button. Moving the 
bases at a point often also influences the parameters of other points. 
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To position the point directly in the reference line field, right click. A dialog appears to read 
and enter the input and output values. 

If you switch on the "Hard" parameter in the limiter, a blue field entitled "Limited zone" will 
appear for threshold values below 0 dB. This field shows that the level of the signal never 
extends into this limited zone. 

In order to hide a handle, move the applicable threshold slider to 0 dB. In order to make it 
visible again, the threshold must be below the limiter threshold. 

 

Advanced dynamics – editing the reference line (parametrically) 
Gate 
Level [in dB] determines the minimum level at the input. All signals below this level will 
have an output signal level of 0 dB. 

Limiter 
Level [in dB] determines the maximum level at the output. Note the "Hard" setting. 

Hard: When this parameter is active, the output signal limits exactly to the set threshold 
value. This means that no value shall be higher than the set limiter level.  Of course, the 
signal is not simply cut off at this limit; the  applied algorithm brings the signal as close as 
possible to the limit without changing the sound much. If the "Hard" setting is not active, 
the algorithm only controls according to the set transfer reference line and behaves like an 
analog limiter. 

Soft: This parameter specifies the curve of the reference line in values from 0 to 20, in 
which case 0 indicates no curve. Curving is useful if the continuous change between 
uncompressed and compressed signals becomes apparent, i.e. the signal level alternates 
around the inflection point. With "Soft", a smooth transition is achieved. 

 

Advanced dynamics – envelope 
The time constants affect the sound characteristic significantly. In this way, specific time 
constants may lead to distortion or "pumping" effects. 

Attack: This sets the time frame between the crossing of the threshold and the maximum 
extent of the effect in milliseconds. 

Release: This sets the time frame between reduction of the threshold and the complete 
withdrawal of the effect in milliseconds. 

Compressor 1/2 threshold: This sets the input threshold in dB; above this level, the 
respective component will be activated. 

Compressor 1/2 ratio: This parameter controls the compression ratio. The "Linear" button 
resets the ratio to 1:1. 

Gain: Use this fader to set the whole static reference line in dB. 

All changes to these parameters directly influence the static transfer characteristic line. 
Please note that the parameters influence one another. 
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Advanced Dynamics - Dynamic parameter 
The "Reaction" function works much in the same way as the Compressor does to the 
source material. 

PEAK: This mode uses the signal's peaks as a basis for calculation. The dynamics module 
reacts to level peaks quickly and efficiently. 

RMS (Root Mean Square):  This mode is involves the signal's average volume, which 
corresponds with the dynamic behavior of analog dynamics modules. It sounds relatively 
round and balanced, less focused. The time constant for signal detection of the control 
signal only refers to the setting of the "Attack" fader. Both time constants are analyzed for 
signal equalization when manipulating signal dynamics. 

Fast: Use this option if the object dynamics should only be modified a little. The maximum 
level at the output is never higher than the limiter. 

Preview:  If this option is not checked, the dynamics section will not provide a preview. 
Thereby allowing artifacts (pumping) and over modulations to be set. On the other hand, 
without a preview, this option will not automatically "level" steep attack phases in the 
waveform, which may result in sharper-sounding audio material. To emulate the sound of 
analog dynamic modules is is recommendable to work without preview. The length of the 
preview may be entered in the "Samples" field. 

Side chain...:If "Advanced dynamics" is used as a track or master effect and the track is 
not a Surround master, the "side chain" button will appear. Enabling this option is used to 
request an external signal to calculate the internal control signal. 

 

Clicking the "side chain" button opens the side chain menu.  

Side chain in: Activates and deactivates the side chain function.  

Sidechain sole:With this option you can listen to the sidechain signal. The compressor will 
be switched to "Bypass", and only the input of the side chain will be played. When closing 
the plug-in dialog, the "Side chain solo" function is automatically reset. "Sidechain solo" is 
also ideal for acoustic control when applying the sidechain filter. 

In the lower half of the menu all tracks are listed, of which you can set one or more as 
sidechain inputs. In the AUX section of tracks that used as sidechain signals or mixer 
channels a new AUX send fader will be assigned for the target track.Internally, a side 
chain bus (AUX bus) is created. To differentiate from the "normal" AUX buses, a ">" is 
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added. "Pre-fader" is set to catch the side chain signal. This means that the sidechain 
remains independent of the fader position of the sending channel. 

Right clicking on the AUX send button selects this as "Side chain send". Thereby you can 
use further track as the source for the sidechain signal at a later date. 

Sidechain filter: The sidechain filter can be filtered by a parametric equalizer (view page 
621). 

 

Advanced dynamics – dynamic scope 
Dynamic scope appears when you play the selected object/sample in an open dialog. You 
can then see a scattered white line, a "snow cloud"  with individual points that represent 
the input and output values. This way, the change to the samples achieved via advanced 
dynamics may be visualized constantly.  

The dynamic scope's functions may be easily explained via the following example: 

Select "ZERO" and press "Play;, now the effect won't change the signal. The scope shows 
all samples on the red line, which indicates that all output values equal the input values. 
Slide the gain fader upwards to see that the "snow cloud" follows the reference line. If very 
high time constants are selected, then this takes place relatively slowly. 

Selecting a relatively short attack time (10 ms), a long release time (400 ms) and a severely 
arched reference line can also move the effect towards "pumping". The "restlessness" of 
this dynamic scope mirrors the "pumping" graphically. 

 

Advanced dynamics – tips and tricks 
 Select one of the provided presets as a general setting. You can now adapt the 

reference line to the source material with the help of the dynamic scope and very 
precisely separate the signal components. 

 If the scattered line of the dynamic scope moves very jerkily, this is probably because of 
the settings of the time constants. Set these according to the sound preferences and 
then save the personalized presets. 

 In order to couple an "analog" limiter with the hard limiter algorithm, define the Limiter 
level at the maximum desired sample level. Once set, an "analog" limiter may be set by 
using an extreme ratio setting (compressor 10.00 or expander 0.10). 
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Multiband Dynamics 
The "Multiband dynamics" section lets you edit the dynamics with up to four 
independent frequency bands. The entire signal is split into individual frequency bands in 
this case. The dynamics are then edited separately for each band. 

The combination of the individual bands is 100% phase-neutral, and thanks to the FIR 
Complement Filter, technique no discoloration of the frequency response occurs. In other 
words: If there is no dynamic editing in the individual bands, i.e. the signal is only split into 
the bands and then reassembled, the audio material will be perfectly compiled to the state 
it was before. The advantage of dynamics manipulation across multiple frequency bands 
versus a standard process is that the danger of pumping and other side-effects sinks 
drastically. For instance, the function is able to prevent bass peaks from reducing the entire 
signal. Multiband technology also lets you specifically edit individual frequency ranges. 

 
 

Multiband dynamics – overview 
In the "Frequency separation/Gain enhancement/Reduction" dialog, you'll find the 
parameters for the filter bank. The graphic shows you the frequency response curves of the 
individual curves. The left axis labeling shows the damping in -dB, while the upper axis 
labeling shows the frequencies in kHz. The individual curves are displayed in color. 

The illustration to the right displays the dynamics reference line. It illustrates the ratio from 
the input level (upper axis in dB) to the output level (left axis in dB). 

The dynamics reference line is always displayed for the band that was selected for 
adjusting the dynamics. 

The dynamics section of the individual bands is equipped with the following parameters: 
"Gain", "Ratio", "Threshold", "Attack", "Release, "Gate Level" as well as the modes 
"Compr. Max", "Compressor", "Limiter", Limiter 100", "Expander", and "Gate". 

 

Multiband dynamics – general controls 
Saving, loading & delete presets: This is where all parameters are saved loaded or 
deleted. The default file extension is *.mdy. 
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Reference line 
Band: Select a band for dynamic editing here. The reference line of each selected band is 
displayed in white, while the other bands are displayed as lines in their corresponding 
colors. 

Copy to all bands: After pressing this button the parameters of the selected band, i.e. the 
parameter values that appear on the screen, are applied to all bands. If you also have "Link 
bands" selected, the values for all bands remain coupled to one another. 

Setup 
Bands: Select the number of bands between 1 and 4. On setting 1, there is no separation 
into various frequency bands. In this case the algorithm works like the standard dynamic 
section. The more bands there are, the more processing power the algorithm requires. 

Band separation: See below 

Link bands: If this option is active, the changes to the dynamic parameters affect all 
bands. It's usually unnecessary to set up the dynamic parameters for each band 
individually. Especially with general settings, it's often necessary to adjust the parameters 
together. 

Advanced mode: If this option is selected, the same internal processing routines are set 
as in the "Advanced dynamics" module.  

Note: If you have activated "Link bands", this does not mean that all parameters in all 
bands will have the same values. Only those parameters are the same which were 
changed after "Link bands" was selected. If all bands should feature the same settings, 
click "Copy to all bands". 

Preview: If this option is checked, the dynamics section will perform a preview. When 
unchecked, artifacts like "pumping" or distortion may occur. On the other hand, without a 
preview, this option will not automatically "level" steep attack phases in the waveform, 
which may result in sharper-sounding audio material. This setting affects all bands. 

Bypass dyn. (bypass dynamics): 
The dynamic editing of individual bands is removed from the signal route. This option is 
used to compare the results of editing with the unchanged original. 

The difference from the "Bypass all" switch is that when "Bypass dyn." is in solo mode, 
individual bands may be compared separately, with or without dynamic editing as the filter 
bank is still activated. 

Bypass all: 
In this case as well, the entire multiband dynamic section is removed from the signal route. 
Since the entire filter bank is "bridged", "Solo" mode may no longer be used. The gain 
fader for the sum is also no longer active. 

Help: Displays the "Help" feature. 
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OK: The algorithm is applied to the selected range of the sample or the selected object. 
The parameters of the dialog window are applied when used in the master section of the 
mixer. 

Cancel: Click on this button to close the dialog window without calculating the effect. 
When used in the master section of the mixer, the parameters of the dialog window are not 
applied. 

 

Multiband dynamics – setups and parameters 
Parameters for the dynamic sections 
Ratio (factor): This parameter controls the level of the corresponding effect; 1.0 means 
that there is no effect. Clicking the button beside it resets the ratio to 1.00. 

Threshold (-dB): This is the input threshold value above and below which the 
corresponding effect is applied. 

Attack (ms): This sets the time frame from crossing the threshold to the maximum extent 
of the effect. 

Release (ms): This sets the time frame between the point below the threshold and the 
complete reduction of the effect. 

Gate level (-dB): This parameter specifies the value after which the level should be set to 
0. 

Output parameters: 
Gain Band (dB): This adjusts the level at the output of the dynamics stage individually for 
each band. Note that the influence of this controller cannot be fully displayed. If you set the 
controller higher, clipping may occur; in this case, the reference line continues upwards out 
of the display border. 

Solo mode: In "Solo" mode, frequency bands may be monitored one at a time. This 
function particularly simplifies the setting of filter parameters. For instance, you can locate a 
critical frequency range of a mix before editing the dynamics. 

Mode 
Compr. max: The dynamics of a frequency range are limited, loud sequences are 
dampened, quiet sequences are retained. These settings are often used to add power to 
audio material or to increase the loudness. Among other things, this type of dynamics 
editing effect is referred to as the "Maximizer" or "Loudness enhancer". Use the "Ratio" 
input field to set the degree of compression via the "Threshold". You can also influence the 
"Attack" and "Release" via the corresponding input fields. 

Compressor: The influence of the dynamics corresponds with the behavior of a "classic" 
compressor: The dynamics of a frequency range are limited, loud sequences are 
dampened, quiet sequences are retained. This setting is used especially for sound design 
via compression without raising the total volume. The level of compression is adjusted by 
the "Ratio" controller; the activation threshold is determined by "Threshold". "Attack" and 
"Release" may also be influenced. A "Gain" controller has also been added to the controller 
to compensate for volume reduction. 
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Expander: The dynamics of a frequency band are increased, loud sequences remain quiet, 
quiet sequences become even quieter. Dynamics expansion is often used for recording 
speech featuring a high noise level. The expansion causes the level of the speech to be 
raised while the noise is suppressed. Note that a powerful De-noising algorithm is also 
provided for noise suppression. 

Gate: This function dampens or sets very quiet passages below the threshold level to zero. 
This way, you can effectively suppress noise during the pauses between takes. Even at 
high compression (ratio > 5), the gate function is still useful to avoid strong increases in the 
quietest of passages and background noise. If different threshold values are entered in 
different bands, with a bit of skill, drum loops may be "chopped up". 

Limiter: Only the loudest passages are limited (above the threshold). Quiet passages 
remain unchanged. Limiters are used to reduce the level peaks without reducing the 
master dynamics. 

Limiter 100%: Performs the same editing as the limiter; however, the level is immediately 
raised to 0 dB, which corresponds with a subsequent normalization.  

Note: To use the limiter as protection against overmodulation, you should take into 
account that the limiter may only reliably prevent overmodulation in a single band. If the 
bands are mixed together, the sum may again result in an excess of the threshold level set 
for the bands. 

Out (all) 
Set the volume level for the entire algorithm here. This parameter cannot be set individually 
for each band. The graphic does not reflect this setting. Use the "Volume" fader to balance 
the volume difference via the dynamics process. 

Limiter on/edit (only in the master area of the mixer and in the object editor): 
This turns off/edits the peak limiter. It prevents overmodulation of the volume increases 
when using the multiband dynamics section. 

Separation frequencies 
Use the sliders at the bottom of the graphic to adjust the separation frequencies for each of 
the filter bands. The number of separation frequencies depends on the number of selected 
bands ("Bands" parameter). The border frequencies for the deepest and the highest bands 
(high-cut and low-cut) are displayed. The border frequencies are those at which filter 
damping amounts to -3 dB. For mid bands (band pass 1 and band pass 2), the mid 
frequencies and bandwidths are displayed. The bandwidth is, in this case, the distance 
between both separation frequencies. This corresponds to the intersection of the 
neighboring frequency curves. 

Band separation (in the setup area) 
A higher setting for "Band separation" ("Normal", "High") has a similar influence on the 
various properties of the filter, whereby the "precision" also increases: 

1.  The edge steepness of the filter curves increases and the transition range between 
two bands decreases. 
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2.  Dampening in the stop band increases (setting low: approx. 25 - 35 dB, normal: 
approx. 35 - 45 dB, high approx. 55 - 75 dB). 

3.  The ripple of the frequency range of the bands decreases. However, this is not a 
problem as the ripple of the individual filter bands compensate each other when put 
together thanks to the complementary filter technology. In any case, the output signal 
does not contain ripples. 

4.  The latency caused by the effect increases. 
 

 

Multiband dynamics – filter bank for experts 
Those who know a little about the program will be curious why the setting/display of values 
doesn't appear as it does in the parametric equalizer. The answer: in this case, a different 
digital filter type is used whose frequency response cannot be fully written using these 
parameters. While analog filters and "normal" digital filters always contain a logarithmic level 
drop (the drop can, for example, which is set to -12 dB per octave), the filters used in this 
case have a linear frequency-response curve, i.e. the level drop in dB increases in size the 
further the distance from the separation frequency. This method also has the advantage of 
100% phase accuracy, among other things. The display of the mid frequencies is derived 
from the "traditional" filter parameters and this way simplifies "acclimatization". 

Tips & tricks: strategies to manage the flood of parameters 
A multiband dynamics processor (naturally) contains many parameters. 

If you need to alter the dynamics of all bands, rather than one individual band, the following 
approach may be useful: 

Step 1: Global presets for all bands 
1. Select the mode that corresponds the most with your needs. If you wish to increase the 
volume of the audio material, select "Compr. max.". If you wish to improve sound 
characteristics, increase the transparency, improve the clarity of speech, freshen up older 
recordings or create more powerful bass without increasing the volume, use the 
"Compressor". The selection of this mode only applies to the selected band. 
Click "Copy to all bands". Selecting this mode ensures that all bands feature the applied 
setting. 
2. Activate "Link bands". Any changes you perform in the current band are automatically 
mirrored on the other bands.  
3. Change the parameters of all bands until the audio sounds right. 

Step 2: Fine-tuning of individual bands 
1. Turn off "Link bands". 
2. Activate "Solo" mode for a band. Individual bands may now be isolated, making the task 
of optimizing settings for each band easier. The optimum settings for the higher frequency 
bands have lower values because the waveforms are shorter here. 
3. If you can't find satisfactory settings for some of the bands, try to change the split 
frequency setting for the selected band. A narrow band setting may help prevent 
"pumping" artifacts in the sound. 

To edit a specific and critical frequency range only, a different approach may be 
taken: 
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1. Turn off "Link bands". 
2. Activate "Solo" mode for the band that contains the critical frequency range. 
3. Change the separation frequencies for the band so that they can effectively filter out the 
critical area. Now the dynamic editing can begin. First, select a suitable mode. 
4. "Limiter" mode or "Compressor" mode are suitable for the dynamic limiting of critical 
frequencies, i.e. for sibilant sounds. 
5. Use the "Bypass dyn." checkbox to compare the processed and unprocessed bands. 
6. Now turn off the "Play solo" option and compare the original and edited signals using 
"Bypass all". 

A third option is to first compare the supplied presets and then use the presets as a 
starting point for searching for optimum settings. 

In most cases, even loading a relevant preset will produce good results. But if you really 
want the very best sound or volume increase result, you'll often have to apply these 
settings manually. 

Comparing at constant volume levels 
Use this method to compare the sound differences without allowing the dynamics 
processing to alter the volume levels. Use the "Out (all)" option to adjust the volume until 
the audio signal level matches that of the bypassed level, i.e. when the "Bypass all" option 
is used. If the multiband compressor is used in the "Master" area of the mixer, the peak 
meter of the mixer may also be used as support. 

 

sMax11 

 

The sMax11 maximizer increases the loudness of the audio signal.  

This is done by entering the input amplitude (gain-in). The signal will be amplified by this 
level. The sMax11 simultaneously ensures that the signal doesn't exceed the output level 
(gain-out) that has been set. This requires regulation of the response time set via the 
mode and release time. Essentially, this involves a hard or brickwall limiter with input 
amplification. 
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A typical approach might look like this: First, switch on the link option. Now increase 
the input amplitude until the audio changes become unacceptable. Reduce the level again 
slightly. Distortions may be minimized by increasing the release time. In any case, the 
compression effect and the increase in loudness will therefore be lower. Maybe switch on 
the bypass. The link option keeps the loudness constant, allowing changes to be 
compared better. Once the optimal setting has been located, switch off the link option, and 
set the output gain back to 0 dB. 

 

sMax11 - general controls and presets 
The options Save, Load, and Delete are not provided directly in the dialog for this effect. 
These are integrated into the preset list, at the bottom. Click these list entries to load, save, 
or delete presets. The default file extension is *.max. 

Play/stop: This button starts/stops the real-time preview function. Use it to check the 
corresponding filter setting. 

Latency display: This value provides information about current distortion of the effect in 
samples that should be included for latency compensation. The latency of this effect is 
influenced by the set effects mode (among other things). 

OK: Applies the preset parameters. 

Cancel: Rejects the parameter settings. 

? (Help): Opens the help file for this effects dialog. 

 

sMax11 - graphical displays 
Mod. display: This meter indicates the modification of the signal in dB. The portion of the 
input amplitude is not included. Only the level with the non-linear changes (required for 
catching level peaks) will be displayed. 

In/out displays: These meters display the input and output displays in dB. 

Reset (meter): This button resets the meter displays. 

 

sMax11 - special control elements 
Gain-in: This value specifies how much the signal should be increased (maximum). 

Reset (gain-In): Resets the "Gain-in" parameter. 

Gain-out: This value sets the maximum output level. 

Reset (Gain-out): Resets the "Gain-out" parameter. 

Link: This option connects both gain values. 
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Note: If the link option is active, then "Gain-in" may be increased, e.g. without increasing 
the output volume. This makes it easier to detect distortions resulting from a high "Gain-in" 
value. 

Release: Set the time frame for the complete dissipation of the effect on the signal in 
seconds. 

Mode: The setting of the mode influences the effect's control behavior: 

 Balanced: Lowest level of distortion with transparent sound, robust to use. 
 Fast: Accesses slightly faster than "Balanced". This mode corresponds with the 

behavior of the hard limiter in the advanced dynamics unit. 
 Aggressive: Very short attack time, suitable for especially sharp transients for this 

reason 
 Hard clipper: Controls are shut off in this mode. Level peaks are simply cut off, which 

may lead to serious distortion. This mode may be useful if transients of an individual hit 
still need to be highlighted. 

Use of different modes is dependent on the case of application. For example, "Balanced" 
mode should be used for speech. For signals with dominant percussive sections, the 
sharpness of the hits may be maintained by using "Aggressive". The right setting will cover 
distortions that occur or make them very minimally audible. 

 

efx_Compressor 
The (essential) eFX Compressor (view page 690) is a simple, efficient tool for reducing 
dynamics with soft characteristics and adaptive control processing. It is a very musical 
compressor. 

 

AM-Munition, AM-Track, AM-Phibia, AM-Pulse 
(Samplitude MX Suite) 

More information is available in "MAGIX plug-ins (view page 698)". 
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Frequency/Filters 
Parametric EQ 
This dialog features a parametric 4-band equalizer. 

 

The parametric equalizer allows you to activate filters for four freely selectable frequency 
bands to adapt the sound of a sample/object more individually. Broadband elevations in 
high and bass values as well as narrowband corrections to the frequency response can be 
carried out here. 

Volume: Use this controller to adjust the master volume by up to +/-20 dB should the level 
rise or sink too much while filtering. 

Gain: These controllers allow you to raise or lower the filter +/- 20dB. Setting the controller 
to 0 deactivates the filter and thereby uses no CPU power. 

Freq. (Frequency): The frequency controllers set the cut-off frequency of the individual 
filters between 10 Hz and 24 kHz. You can freely choose the frequency enables multiple 
filters to be set to the same frequency giving a greater effect. 

Q (bandwidth): Set the bandwidth of the individual filters between 0.10 (very wide 
bandwidth) and 10 (extremely narrow bandwidth). 

Note: Depending on the parameter you select (gain, frequency, or Q factor), the fader to 
the left of the input fields controls the corresponding parameters. Gain and frequency 
values can also be changed directly in the display by dragging with the mouse. 

Type:  Set the filter type here. Filters types available include Peak, Shelving, High pass (= 
low cut), and Low pass (= high cut). 
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Note:  

The shelving filter starts signal manipulation at the cutoff frequency in order to apply the 
effect until the end of the audible range. This includes high and low-pass filters. 

A high-pass filter cuts the signal sharply after the defined cutoff frequency. 

A low-pass filter cuts the signal sharply above the defined cutoff frequency. 

The peak filter stretches the around the defined cutoff frequency. This includes "normal" 
parametric EQ, bandpass filters, and notch filters. 

Play/Stop: This button starts/stops the realtime preview function. This lets you check the 
acoustics of the respective filter settings. 

Setup A, B, C:  Switch between three different filter setups using the mouse to quickly 
execute an acoustic comparison of two different settings, even during previewing. Save the 
individual EQ setups with a mouse click on the corresponding button (A, B, or C) while 
holding down "Shift". 

 

EQ116 

 

The EQ116 provides filters for six freely selectable frequency bands to adapt the sound of a 
sample/object more individually. Broadband elevations in high and bass values as well as 
narrowband corrections to the frequency response may be applied here. 

 

EQ116 - general control elements, presets and setups 
Load, save, delete presets: Save, load, or delete settings here. The default file extension 
is *.aeq. 
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Setup A, B, C: Switch between three different filter setups using the mouse to quickly 
compare two different settings, even during previewing. 

Reset: Sets the effect to its original initialization state. 

Bypass: The algorithm is removed from the signal route. This allows the unedited signal to 
be compared to the result of the algorithm. 

Play/stop: This button starts/stops the real-time preview function. Use it to check the 
corresponding filter setting. 

Latency display: This value provides information about current distortion of the effect in 
samples that should be included for latency compensation. The latency of this effect is 
influenced by the set effects mode (among other things). 

OK: Accepts the parameters. 

Cancel: Rejects the parameters. 

Help: Opens the "Help" file for this effects dialog. 

 

EQ116 - Graphic displays 
Filter graphic:  This graphic provides a view of a number frequency-related details: 

 Amplitude response: The resulting amplitude envelope from the individual band 
settings 

 Group runtime/Phase response: One of these envelopes may be shown optionally. 
Toggle between these in the scale options dialog. The group delay describes the 
frequency-dependent time delay in passing the signal whilst the phase response shows 
the dependence of the phase of the frequency. 

 Original: This curve displays the original frequency response. 
 Edited: This curve shows the frequency response after processing by the effect. 
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The display of the filter graphic may be adjusted by accessing the "Scale options" and by 
using the vertical and horizontal scroll bars. 

 

Hide real-time curves: This option hides the "Original" and "Edited" real-time curves. 

Real-time offset:  Adjust the offset value in dB for the real-time curves for optimal display. 
Click in the display window after every change to the values to make the adjustment visible.  

In/Out displays: These meters show the input and output displays in dB. 

Reset (meter): Reset the in and out displays. 

 

EQ116 - Editing the reference line 
Filter graphic:  The band filter parameters gain and frequency may be changed within the 
graphic by clicking and moving the level points. The bandwidth can be changed by turning 
the mouse wheel near to a level point 

Volume:  Use this controller to adjust the master volume  if the level rises or sinks too 
much while filtering. 

Tape on/off:  In the header for each tape group, there is an on/off switch for turning the 
corresponding tape on or off. The associated level point will disappear from the filter 
graphic accordingly. In der Filtergrafik verschwindet dann auch der zugehörige Stützpunkt 

Gain: These controllers allow you to raise or lower the filter. Setting the controller to 0 
deactivates the filter and doesn't use CPU power. 
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Freq. (frequency): The frequency controllers set the cut-off frequency of the individual 
filters between 10 Hz and 24 kHz. You can freely choose the frequency enables multiple 
filters to be set to the same frequency giving a greater effect. 

Q (bandwidth):  Set the bandwidth of the individual filters between 0.10 (very wide 
bandwidth) and 10 (extremely narrow bandwidth). 

Type: Set the filter type here. These include normal (= peak), low shelving, high 
shelving, high pass, and low pass   

Slew rate (gradient): This influences the internal process of a filter band and thereby the 
slew rate of the high or low pass in the lockout zone. The settings are not equally available 
to all filter types. For a high pass and low pass, a slew rate may be selected between 6 
dB/octave, 12 dB/octave, 24 dB/octave, or 36 dB/octave. For low shelving and high 
shelving, there is a choice available between 6 dB/octave and 12 dB/octave. The filter 
type "Normal" is fixed at 12 dB/octave. 

Note:  Depending on the parameter you select (gain, frequency, or Q factor), the fader to 
the left of the input fields controls the corresponding parameters. 

 

EQ116 - internal operating modes 
Mode: Set the internal operating mode for the EQ116 here. 

The following modes are supported: 

 Normal: The advanced equalizer operates in a manner that corresponds with the 
parametric 4-band equalizer, and therefore represents a compatibility mode. 

 Oversampling: This effect works internally compared to the first mode and a higher rate 
at which the filter formation takes place. In particular, the upper frequency range 
achieves a better amplitude frequency response. 

 Linear phase: This filter formation occurs such that no phase shifts occur. Processing of 
this filter takes place according to a process that is fundamentally different than other 
modes. 
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FFT Filter/Sound Cloner 

 

The FFT filter (for real time use in the object editor, in the track or master section) allows 
you to precisely filter linear signals. The FFT filter for real-time application is a "minor" option 
with a huge number of possible settings, analyses, and functional modes for destructive 
editing of audio material. 

Note:All effects opened using this menu are calculated destructively, provided that, 
additionally, the option "Process Effects Offline" is active. You do, however, have the 
option to work with a copy to be able to keep the original audio material. The "Create 
copy" option is already selected in the corresponding dialog.  

Edit the red filter curves by drawing with the pencil tools in the graphical display. If you let 
the object play along, you will immediately hear how the sound of the edited object. 

The graphical view shows 3 curves that are integrated in a coordinates system. This 
includes the vertical axis, which shows the volume in dB, and the horizontal axis, which 
shows the frequency in Hertz (the pitch). 

The yellow curve represents the original frequency response, and the blue one 
represents the corrected frequency band that accompanies the original frequency 
response after the red filter curve is applied. 

The following tools are available via the object FFT filter: 

 

Pen for free-hand drawing:  This tool allows you to draw any curve you need. Hold the 
"Shift" key down to draw straight lines. 

Pen for quantization drawing: Use this tool to draw stepped filter curves; the quantization 
steps depend upon the set resolution. Hold the "Shift" key down to draw straight lines. 
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Bend tool for curving lines: Click with this tool above or below the curve to bend the 
curve/frequency area. The further away from the line you click with the bend tool, the 
sharper the curve will be. This effect may be enhanced by clicking by holding down "Ctrl". 

Navigation tool:  Use the navigation tool to move the visible selection vertically and 
horizontally while zoomed in. 

Zoom tool:  Click with the left mouse button to zoom into the display; zoom out with the 
right mouse button. By left clicking and dragging you can stretch a range which will then be 
displayed as a zoom range. 

Besides the FFT filter tools, the following buttons are also available: 

 

Snapshot:  If this feature is activated, the filter's current in and output spectrum will be 
preserved in the graphical interface. 

Save:  This command saves the filter curve as a text file. 

Load:  This command loads a filter curve from a text file. 

Copy: This command copies the filter curve to the clipboard (Shortcut: Ctrl + C). 

Insert: Use this command to insert the filter curve from the clipboard into the FFT filter 
selected for the object; this replaces the current filter curve in the graphical interface. 

Reset:  This button resets all curves for the FFT filter. 

Scaling options:  Set the graphical display of the curve value here.  
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Frequency axes property: The frequency can be output as a linear curve or as a 
logarithmic curve. If the logarithmic display is selected, then the display's x-axis can be 
output either according to frequency or according to pitch.   

Value display: Here you can stretch the filter curve on the y-axis, either 5:1, 10:1 or 20:1. 
For the dB values choose either the linear or the logarithmic display. The range of values 
may be defined freely. Simply enter the desired minimum and maximum values into the 
corresponding fields. 

Curve display: Display the curve roughly as a stepped bar or as a soft curve. 

Level: This controller pinches or stretches the filter curve. Set the level of adjustment for 
the transmitted frequency response between 1 and 200%.  

Vol.: This controller adjusts the total volume of the filter curve in dB, and thereby the "Out" 
value of the level display. 

Sound Cloner functions 
With the Sound Cloner feature you can determine the sound characteristic of a selected 
object and transfer it to another one. For instance, if individual songs of a music collection 
are different to others, the sound cloner feature can adapt them to other pieces. This could 
be treated with the characteristic sound of the late 60s, for example.  

First of all, determine the spectral image of the object that should be used as an audio 
template. Save this as a "clone". The clone may now be applied to the target audio 
material.  

The sound cloner's preset menu also contains a few useful filter settings besides the 
"clone" presets. 

Step 1: The learning process 

Load a song with a sound you would like to use it as a reference. Place the play cursor at a 
location in the song where the elements of the sound to be cloned appear. Don't select the 
intro or a break. All of the instruments involved should be playing at this point. Press the 
"Learn" button. The options "File" or "FX input" specify whether the sound clone should 
originate from the original wave file or from the object that has been processed with effects. 
The sound characteristic of the reference song is now created as a fingerprint. Save the 
sound clone that has been created in the "FX presets" folder. 

Step 2: Transfer frequency response 

Now select the frequency response of the object that should be adjusted. By loading a 
match preset from the preset menu, the sound characteristic will be communicated to the 
sound at the position of the play cursor. The filter curve is calculated via the target audio 
material's spectral analysis, which provides an audio image that is similar to the audio 
image in the preset. If used as an object effect, the target material to be analyzed is taken 
from the associated object, in which case the play cursor specifies the position inside the 
object. The "Level" controller regulates the intensity of the sound transmission. 
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When loading the sound clone, it's important to place the play cursor at a location in the 
object where all of the instruments are playing; the sound cloner uses the audio material at 
the play cursor as the basis for calculation of the filter settings. The selected filter curve will 
not be transferred directly into the FFT filter; initially, a spectral analysis of the target audio 
material is executed at the play cursor before the selected object's filter curve is adjusted. 
By default, 20 seconds will be analyzed, but the length of the area to be analyzed can be 
adjusted by dragging with the mouse on the range in the arranger. 

Sound cloner controls 
Learn:  A frequency analysis is calculated at the playback position. A dialog opens in which 
the result can be saved as a special match preset. 

File: The sound clone's reference is created using the selected object. This produces a 
spectral image of the object. Next, the Sound Cloner preset can be saved and then 
appears at the bottom of the presets list. Real-time effects are ignored in this mode when 
defining the reference. 

FX input:  The input at the effect is used as a reference. Realtime effects looped before the 
FFT filter which is used as a cloner are accounted for  in this mode when defining the 
reference. 

Inverse:  Inverts the filter curve. This function inverts the sample data within the selected 
range along the amplitude axis, i. e. negative values become positive and vice-versa. 

Bypass: The algorithm is removed from the signal route. This way the unedited signal can 
be compared to the result of the algorithm.  

 

FFT Filter/Spectral Analysis (Offline) 
With the FFT analysis filter you have a high-quality tool at your disposal which can be used 
to solve typical problems in elegant and partially completely new ways. The FFT analysis 
filter is a combination of a high-quality FFT spectral analyzer and an FFT filter. The 
calculated frequency response curve can be edited using a freehand tool and then sent to 
the audio material. The real-time preview function allows you to work in an intuitive and 
time-saving manner. 

Some areas of application of this tool are: 

 Checking and correction of the frequency response of the recording or mix. 
 High-precision frequency measurement, e.g. for verifying the tuning of instruments. 
 High-precision filtering of the finest nuances to full sample distortion without any 

changes to the phase response. Phase distortion effects like deteriorated impulse 
response or room impression are minimized with this. Linear-phase filters do not have 
their own sound. 

 Sub-bass precision correction in the low-frequency range between 10 and 50 Hz with 
any increase or dampening without the effects that usually occur with filters of this kind. 
Ideal for bass-heavy pop music or for removing rumbling or footsteps. 

 Selectively dampens or raises the level of individual instruments or pitches from 
recordings. 

 Formant filter 
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 Dynamic filtering: Transition between two filter curves for filter switch effects, hiding 
frequency variables, and much more. 

 Transmit frequency ranges: For example, from other mixes or rooms or loudspeakers to 
your own mix. This option can be very helpful if you want to improve the sound of your 
samples or simulate individual monitoring conditions. 

 Correction of the frequency range from recording and playback areas, loudspeakers, 
amplifiers, etc. 

 
 

FFT-Analysis filter - First step 
To understand the basic operation of the FFT filter, we recommend that you now perform 
the following steps on your computer.  

A small warning: reduce the playback volume before experimenting with the FFT filter as a 
precaution. With this technology you can easily increase the low frequencies to such an 
extent that your speakers may not be able to handle. 

Note: To quickly understand dynamic filtering, we recommend using a sample containing a 
hissing sound. A corresponding sample can be quickly created using the Waveform 
Generator (view page 775). 

1. Filtering and frequency analysis 
Step 1: Select a range of a sample in your wave project or select an object in the arranger 
window of your virtual project. 
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Step 2: Open the FFT Analysis Filter again. A blue curve depicting the current frequency 
response of your sample/object is now visible. The red curve is the frequency 
response filter. By default it is set to 0 dB for all frequencies. 

Under given circumstances, according to the length of the selected range, only a portion of 
the range is analyzed. To examine the entire range or object, click on the "Analyze all" 
button to the top right of the dialog window. 

Step 3: Now use the left mouse button to draw in the graphic display. The frequency 
response of the filter changes according to the drawn curve. The blue curve also changes 
while drawing: it now shows the frequency course almost reached by the sample after 
application of the filter. The blue curve is therefore now referred to as the corrected 
frequency response. 

Note: If you use a faster PC, you can check the result in real time after pressing the 
play/stop button. The changes may be heard immediately. Otherwise, you should use the 
non real-time preview ("Preview" button). 

2. Filtering in Direct Draw mode 
You can also draw the desired frequency response (the blue curve) with your mouse. 
Select "Direct" in "Draw" mode. 

The yellow curve now displays the original frequency response as a comparison. 
Changing the frequency response in this mode is rarely needed and can lead to over 
modulation. For this reason, confirm that you want to "Prevent clipping" by clicking the 
button of the same name after every adjustment to the frequency response. 

By editing the blue curve you will of course indirectly change the frequency response of the 
filter. To observe this, first reset the filter by pressing the "Reset" button. Switch back to the 
other "Draw" mode "Filter". Now you will see that the filter curve is set back to zero. If 
change back to "Direct draw" mode, edit the blue curve again and then switch once more 
back to "Filter" mode; you can see that the frequency response of the filter will have 
changed. 

3. Dynamic Filter mode (fading between two filter curves). 
Select the filter mode "Fade start". The displayed frequency response in this mode 
corresponds to the left border of the selected sample/object. You can also edit this 
frequency response in the Filter or Direct mode, as explained in the previous two points. 
However, filtering will now also directly affect the marked range of the sample or the 
selected object in the VIP. 

Switch to "Fade end" and edit the frequency response the same way. The displayed 
frequency response in this mode now corresponds to the right border of the 
sample/object. In this case filtering affects the end of the marked range of the sample or 
the object selected in the VIP. 

The red filter curve or blue curve with the corrected frequency response changes between 
both range limits and is faded from the first to second curve. Thereby the first curves fades 
into the second curve. 
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There are three different methods for fading available in the "Expert" dialog. 

4. Filtering a sample/object with the frequency response of another 
sample/object 
The procedure for this task can be divided into two basic steps: "learn process" and the 
filtering itself. 

The learning process: 

1.  Mark a range of the sample/object of which you would like to use the filter curve for a 
second sample. 

2.  Open the FFT Analysis Filter again. 
3.  Press the "Analyze all" button. 
4.  Press the button "Analysis -> Filter". 
5.  Save the result as a preset. 
6.  Close the dialog by clicking on "Cancel". 

You have now completed the "Learning process". 

You can now apply the acquired filter curve to another sample/object. 

The filter process: 

1.  Highlight the desired range of a sample/object to which you would like to apply the 
frequency response. 

2.  Open the FFT Analysis Filter again. 
3.  Load the saved frequency response by pressing the "Load" button. 

Hint: For transferring frequency responses, you can also use the "Sound Cloner (view page 
626)" feature integrated into the real-time FFT filter. The workflow in this case is simpler; 
however, you have fewer tools at your disposal. 

5. Transferring the frequency response (spectral envelope) from one 
sample/object to another 
This function is required, for instance, if the frequency response of a track mix (reference) is 
applied to another track. The filter curve is in this case calculated from the reference 
frequency response and the frequency response of the object that is to be changed. 

The procedure for this task can be again divided into two basic steps: "learn process" and 
the filtering itself. To do this you should proceed as follows: 

The learning process: 

1.  Highlight the desired range of the sample of which you would like to use the 
frequency response as a reference for the second sample.  The selected range 
should have the highest "musical density", i.e. all involved instruments should be 
played. Drums or percussion should be available. The range length should not be 
under 30 seconds. 

2.  Open the FFT Analysis Filter again. 
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3.  Press the "Analyze all" button. 
4.  Press the button "Analysis -> Filter". The filter curve now corresponds to the 

frequency response of the sample/object. Individual peaks indicate that the frequency 
response of individual tones has an influence on the result – in this case you should 
use a greater range for the analysis or smooth out the peaks with the freehand draw 
function. 

5.  Save the result as a preset. 
6.  Close the dialog by clicking on "Cancel". 

You have now completed the learning process. It is now necessary that you compare the 
acquired reference filter curve with the frequency response of the sample/object in order to 
be able to calculate a filter function, which allows you to align the frequency response of 
the sample/object with the reference filter curve. 

1.  Highlight the desired range of a sample/object to which you would like to apply the 
frequency response.  The selected range of the track should have the highest 
"musical density" here as well,  i.e. all involved instruments should be played. Drums 
or percussion should be available. The range length should not be under 30 seconds.  

2.  Open the FFT Analysis Filter again. 
3.  Press the "Analyze all" button. 
4.  Open the saved reference frequency range by loading the corresponding preset. 
5.  Press the "Match filter" button. 
6.  If necessary, smoothen steep peaks or drops in the red filter curve by drawing along 

the red curve with the mouse. 

 

FFT filter – graphical view 
Overview of the curves 
There are nine curves to select from in total. The yellow curve represents the original 
frequency response, the red one represents the filter curve, and the blue one represents 
the corrected frequency band. The blue curve therefore represents the frequency response 
of the spectrum after filtering. 

In the "Filter" drawing mode, the red curve is edited, while in "Direct" drawing mode, the 
blue one is edited. 

In the lower dialog of the "Expert" area, you'll have the chance to display all three curves, 
i.e. current frequency response, original frequency response and filter frequency response. 
To do this, select "3" in "Display -> Curve numbers" in the dialog area. 

The first three-curve group is used in the "Static" filter mode, the second is the start setting 
"Fade start" for dynamic filtering, and the third in the end setting, i.e. "Fade end". 

Faders and zoom buttons 
Use the left fader to change the display range of the level of the yellow or blue curve, i.e. 
the original and the current frequency response. The level is shown in the left axis label of 
the graphic in dB. 

 Use the fader on the right to change the filter range (red curve). If the fader is moved up, 
the value range increases in size. The frequency response can be increased to higher 
values or reduced to lower ones. This only involved fine-tuning and making corrections. 
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The smallest and largest values may be set in the "Max. range" and "Min. range" in the 
"Expert" dialog. The precise values for damping/dB increase are shown in the axis 
labeling to the right. 

The volume fader moves the filter curve up or down and can be used to control the entire 
volume. 

 The bottom left features four buttons for the zoom function. "+" changes to the next 
zoom level, "-" changes back a level. There are 10 zoom levels available in total. The "All" 
and "Max" buttons set the display to the smallest/highest zoom levels. Clicking on the 
"Max." button again will return to the previous zoom level. Use the fader beneath the 
display to move the curve section. The selected frequency range is then shown in the 
display in Hz. 

Switch for the display views 
Below the graphic, there are four switches provided to toggle between the different view 
modes. 

Display mode: Displays the frequency response as a curve or line diagram. The line 
display provides a better overview in the low-frequency range, where there are fewer 
frequency ranges.  

Hz/notes: This option allows you to display the graphic in Hz or musical notes. The note 
display is only available in the logarithmic frequency display (Freq: log). 

Freq lin/log: This switches between logarithmic and linear frequency scaling. The 
logarithmic display corresponds to the human perception of volume.  Like on a keyboard of 
a key instrument, the (graphic) spacing of the intervals, i.e. halftones, is uniform across the 
entire range. 

dB lin/log: Select between a logarithmic or linear scale for the level. Logarithmic display 
corresponds with the human perception of volume. 

 

FFT filter – controls 
Filter 
Analyze all: This calculates the frequency response for the entire sample/object. This 
function is only available in "Static" filter mode. Once this function is applied, the button 
deactivates. 

Analysis > Filter: The red filter curve is calculated from the frequency response of the 
sample/object. Use the analysis to filter a sample/object with the frequency response of a 
different one or to transfer the frequency response to a different sample/object. 

Invert filter: This inverts the filter curve. This function corrects the frequency range of 
rooms or loudspeakers. 

Match filter: In this case, a filter curve is calculated that adapts the frequency response of 
the sample/object to the filter curve of a preset. This is useful if the filter curve contained in 
the preset has been acquired from the frequency response of a reference mix, since the 
sound characteristics of the reference mix may be transferred in a certain similar way. 
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Prevent clipping: If you edit the frequency response and the sample is overmodulated, the 
filter curve will be corrected correspondingly after pressing this button. This function is 
independent of volume faders. 

Reset: Click on this button to reset all curves to their default (0 dB) position. 

Filter mode 
Static: In this mode, the edited filter curve is applied to the range of the sample in the wave 
project. When working in a virtual project, the edited filter curve is applied to the selected 
object in the virtual project. 

Fade start: This mode provides dynamic filtering. The first curve (sample start) may be 
edited in this mode. The displayed frequency response in this mode now corresponds to 
the sample at the beginning of the selected range. 

Fade end: Edit the second curve (sample end) with dynamic filtering here. The displayed 
frequency response corresponds with the sample at the end of the selected range. The 
resulting filter curve is now faded in between the two created curves. In the "Expert" dialog, 
three different filter fades are available. 

Draw mode 
Filter: Edit the red filter curve with the mouse in "Filter draw" mode. 

Direct: This setting enables direct editing of the corrected frequency curve (blue curve). It is 
necessary for this setting to be saved in order to transfer the frequency responses of 
samples. 

Expert: Opens a further dialog with additional setting options. 

Play/start: Real-time preview function. 

Preview: Non real-time preview function. In this case, full stereo operation is also possible. 
The result corresponds with the end product. 

Play original: The unedited original sample/object may be played here for comparative 
purposes. 

Help: Displays the "Help" feature. 

OK: The filter is applied to the selected range of the wave project or the object selected in 
the VIP. 

Cancel: The windows close without applying the filter. 

 

FFT filter – expert dialog 
Analysis parameters 
The settings apply to the frequency analysis. They concern highly specific use-cases. 

Analysis precision: During frequency analysis, the sample is split into individual blocks. On 
the "High" setting, the blocks overlap one another by 50%, while at "Normal", they simply 
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border one another. At very high overlapping levels, it's much easier to capture very short 
sounds, e.g. individual 1/32 notes. If you have selected "High", the calculation time for the 
analysis will double, which will become most noticeable when using the "Analyze all" 
function. 

Analysis precision: In the "Noise" setting, analysis results for individual harmonics are 
slightly distorted and the peaks widen. With the "Sounds" setting the entire frequency 
response of noisy samples like drums, cymbals, or high hats may also be distorted a little. 
Inaccuracy occurs mostly at lower filter parameter rate values. 

Channels: In case of stereo samples, select whether or not the right or left channel or both 
should be analyzed.  

Analysis time: Specify how many seconds of the sample should be analyzed after 1.) 
opening the FFT Analysis Filter, 2.) when changing the setting for the rate, or 3.) after 
changing the settings for the analysis parameters. This setting only affects the display of 
the frequency response in "Static" filter mode. 

Note: Every time a change is made to the settings of the analysis parameters or to the rate, 
the frequency response is recalculated. If you analyze the entire range of the sample using 
"Analyze all" before making changes to these settings, the results will be lost if these 
parameters are changed. In this case, select "Analyze all" again. The "Analyze all" button 
will be active once again in "Static" filter mode. 

Filter parameters 
These settings apply to the filter process. 

Filter precision and real-time filter precision: This sets the quality of the precision. If 
precision is high, the calculation time also increases. 

Low: The fastest method. In case of extreme filter settings in the bass area and at a low 
rate, low-level modulation noises will be audible. However, with less extreme filter settings, 
this setting functions without any noticeable loss in quality. 

Normal: A practical compromise between CPU strain and audio quality. 

High: Processing time increases by 30% more than the "Normal" setting. During dynamic 
filtering, fading is smoothest via this setting. 

Max. range (dB), min. range (dB): Set the limit of the maximum increase or the maximum 
damping setting in dB for filtering. Fine-tuning may be applied using the fader on the right, 
beside the graphic display. If you want to hide individual parts of the spectrum, set "Min. 
range" to the lowest value (ca. -120 dB). 

Threshold: When re-drawing the blue curve in "Direct" mode, only those frequencies that 
were originally louder than this threshold setting will be changed. This makes it easier to 
precisely increase or dampen harmonics. 
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Display 
Apply additional settings for displaying the curve here. 

Grid: Switches the grid on and off. 

Number of curves: Set the number of curves to be displayed here. 

Filter transition 
There are three different modes available for dynamic filtering: 

Direct: A simple fade is made directly between two curves. 

Move/direct: In this case, both curves are faded, but the start curve is to the side, i.e. it is 
moved onto the frequency axis. For example, if a band pass is set for the start curve, the 
timing of the mid frequency changes (filter sweep). The corresponding high value of the 
start and end curve specifies the extent of the curve move. If you are working in "Filter" 
draw mode, edit the red curve first. If the entire filter curve is set to 0 dB, a higher value will 
not be available. 

Move: This method can be used to move the start filter curve. Once again, the 
corresponding high value of the start and end curve specifies the extent of the curve move. 
The second curve is used for specifying the "end point" of the move. Otherwise, it doesn't 
have any influence on the result. 

Resolution: This parameter affects the analysis and filtering processes equally. Set how 
many individual analysis frequencies/filter bands should be available, in which case the 
number of filter bands corresponds to exactly half of the value of the "resolution" 
parameter. The higher the resolution, the longer the processing time needed – by approx. 
5%/level. 

 

FFT - Filter - The right settings 
Frequency analysis 
A higher resolution is required for sufficient precision in the low-frequency ranges (from 
8192). The precision of the analysis in Hz at a sample rate of 44.1 kHz can be found in the 
table. 

Resolution  Precision in Hz 

256 172 
512 86 
1024 43 
2048 21.5 
4096 10.7 
8192 5.3 
16384 2.7 
32768 1.35 
Filters 
Here you only need high resolution (8192) for low frequencies or for specifically blocking 
out overtones. For all uses the settings 1024 to 2048 will suffice. Values lower than 1024 
are rarely needed. 
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Notes: 

If you have drawn very detailed filter curves, it is imperative that you save the curve 
parameters. When switching modes or parameters, the curves will appear to be closely 
matched but will not maintain the same details. 

Make sure that when previewing in realtime at a high rate that the value of the program 
buffer in the ("Extended Buffer Settings" (view page 500)) is at least just as high, or even 
better, a bit higher than the set rate. Otherwise real time monitoring is not possible. Rates 
higher than 8192 are hardly useful when previewing in real time, since the internal real-time 
buffer size of the algorithm corresponds to the set rate. In this case, editing while 
previewing in real time will be "awkward". 

Save/Load:  Here you can save or load all parameters and curves. The default file 
extension is *.fff. 

Important: To apply the filter to other samples, the "Draw" mode parameter has to be 
set to "Filter". Only in this case will the red curve be saved. This also applies if the filter is 
indirectly applied by editing the blue curve in "Direct draw" mode. 

However, if you save when "Direct" is selected, the saved frequency range may be 
applied to other samples. In this case the saved blue curve is transformed into the red 
one when loading. 

 

FFT Filter - Problems and solutions 
Modulation effects when using extreme filter settings for low frequency ranges 
Set the "Precision" setting in the "Expert" dialog from "Low" to "Normal" or "High". 

Problems with the realtime preview when using higher rates: 
Make sure that when previewing in realtime at a high rate that the value of the program 
buffer in the ("Extended Buffer Settings" (view page 500)) is at least just as high, or even 
better, a bit higher than the set rate. 

It is not possible to completely hide certain areas of the spectrum. 
Select "Filter" in draw mode and reduce the "Min. range" value in the "Expert" dialog to 
approx. -100 / -120 dB. 

You have corrected the frequency response of a sample and then analyze the 
result once again. The result does not match the corrected frequency response 
(the blue line before performing filtering). 
If you use the "Analyze all" function and set the filter parameter to "Precision: High" in the 
"Expert" dialog when analyzing before and after filtering, an approximate match will be set. 

Also resonance-like sounds arise in wideband band passes. 
Reduce the slew rate of the band passes by not creating any vertical lines while drawing. 
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In the "Fade start" or "Fade end" filter mode, fading is not applied uniformly. 
In this case, select the highest setting for the filter parameter precision in the "Expert" 
dialog. In "Direct" fade mode, the problem is reduced when the rate is reduced. 
Experiment in the other blend modes with this parameter to find a suitable setting. 

 

Brilliance Enhancer 
(Optional as part of the Cleaning/Restoration Suite) 

You can find more information on the Cleaning/Restoration Suite in the PDF document 
"Cleaning/Restoration Suite" included with the program. 

 

Filtox 

More information is available in "Effects -> MAGIX plug-ins (view page 698)". 

 

Delay/Reverb 
Delay 
Use this function to integrate an echo effect into a sample/object. To avoid overmodulation, 
you should set up a certain modulation reserve. 

 

Echo delay/reverb time: This controller sets the delay between the individual echoes or 
the original signal and the first echo in milliseconds. Note that the delay is dependent on 
the sample rate, i.e. a change in the sample rate after creating the echo leads (logically) to 
a change in the echo delay. 

Decay: Set the decay value for the simulation of the size of the room numerically as well as 
using faders. In "Offline" mode, there is also a "ping pong" effect available, and you can 
also set the reverb chamber in the real time dialog. 

Mix balance in %: Enter the ratio of the original signal to the echo/reverb signal in percent 
here. If you switch on the "Link" option, both values always add up to 100%. 
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Room Simulator 
This function allows you to simulate the reverb qualities of various rooms. The impulse 
response or reverb time of a room is calculated with a sample. A room impulse response is 
the reverb of a explosive noise, for example like that of a pistol. It contains all the necessary 
information to simulate room reverb accurately. 

You can manipulate the impulse response using the dialog parameters. In this way you can 
adjust the reverb properties in a similar fashion to how digital reverb-effect devices do this. 
In addition, however you also have the ability to set the reverb character by fundamentally 
defining the impulse response. A graphic representation of the impulse response and the 
envelope allows an optical overview of the impulse response manipulation using the Room 
Simulator parameters dialog. In Samplitude this effect is also available as a realtime effect 
in object, track, AUX bus, and master channel. 

 
 

Room Simulator - general controls 
Room Simulator - banks and presets 
The Room Simulator offers several reverb banks. These "banks" divided into categories like 
"ambience", "drums_percussion", or "small reverb", and these contain the corresponding 
presets and impulse responses.  

Loading a preset loads both the parameters of the dialog field and the impulse response. 
The impulse response may be any sample saved to the hard disk as a WAV, HDP, or RAP 
file. The impulse responses that come with the program have a special file format with an 
*.IMR extension. 

If a file has been deleted or moved in the meanwhile, an error warning will appear when 
loading a preset. Correspondingly, when a preset is being saved, the selected impulse 
response itself will not be saved, but only its path and file name. Presets have the extension 
*.rms. Files with impulse responses from the program presets are located in the 
"RoomSim" directory or in the bank directories. 

The presets can be saved, loaded, or deleted. The load function is only needed if the 
preset files are located in a different directory than the “RoomSim” directory. 
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Room Simulator saving/loading/deleting presets 
Presets can be loaded, saved, or deleted. 

The presets that are located in the "FX-preset" subdirectory are automatically loaded and 
listed in the dropdown menu, where they can be selected. The "Load" function loads 
presets from directories besides "RoomSim" into the Room Simulator. 

 

Impulse response 
File: Select an impulse response here. Impulse responses may be loaded from the 
"RoomSim" directory, the bank directory, and from the wave projects opened in the 
program (Bank: [loaded projects]). 

In case during Samplitude installation you have deactivated the "Install impulse response" 
option, you will have access only to the opened wave projects (Bank: [loaded projects]) and 
"Standard-impulse-response.rap" from the "Room Simulator preset directory" bank. 

Info: This provides information about the length of the impulse response and whether it will 
play back in mono or stereo. 

Play (impulse response) 

To verify the impulse response, this is played after this button is activated. Impulse 
responses from IMR files will be played back only with 16 bits, even if the impulse response 
has a 32-bit float format. 

Load (impulse response) 

The impulse response can be any sample that is saved to the hard disk in any directory as 
a WAV, HDP, or RAP file. 

 

Graphic display 
dB lin: The graphic display with the impulse response has linear amplitude scaling. This 
setting corresponds to the usual sample representation. 

dB log: Choosing this setting will scale the amplitude display of the impulse response 
logarithmically. This corresponds with the way the human ear perceives volume changes. 

Zoom options (all, in, out, max, position): 

These options zoom into the display to select the range to be displayed. 

 

Curves 
Red: Impulse response timeline 

Light blue: 2-segment envelope curve to suppress early reflection and post-reverb. 

Yellow: Freely definable envelope curve 
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Freely definable envelope curve 
The amplitude progression of the impulse response can be manipulated with the yellow 
freely-definable envelope curve. Typically, it is used to dampen or delete early 
reverberations of the impulse response. Using zoom options will aid greatly in this task. 

Reset freehand envelope: Reinstates the curve's original status. 

 

Pre-delay 
The "Pre-delay" function delays the entire impulse response by a time interval variable 
between 1 and 100 ms. 

 

Convert impulse response to mono 
If you choose this option, stereo impulse responses will be recalculated in mono. The 
convolution count remains unchanged in stereo (it corresponds to the count of group 
channels in case of Surround). 

 

Calculate mono 
Convolution is only calculated for one channel which reduces the required processing 
power. The input signal and the impulse response (if stereo) are converted to a mono 
signal before convolution. In the case of Surround sound, all channels of a group are 
added to a mono signal. 

 

Room Simulator - parameters 
Parameter presets 
Select, save, load, and delete presets that consist of parameters for envelope curves, 
frequency sequences, and the mix here. 

The presets are useful for testing various parameter settings without having to change the 
impulse response.   

The parameter presets have the extension *.rsp. 

 

Envelope, EQ 
Early reflect: This parameter lowers or suppresses early reflections by dampening the first 
part of the impulse response. 

Late reverb: This parameter decreases or suppresses the final part of the impulse 
response. 

Length: This setting can shorten the length of the reverb effect to up to 5% of the original 
length by shortening the impulse response pattern. Note that reverb may end rather 
abruptly, which may lead to unnatural decay patterns. Compensate by applying a lower 
late reverb setting to fade the impulse response with the 2 segment envelope curve. You 
can optically control the impulse response envelopes on the graphic display. 

Crossover: Set the time length of the first of the two segments of the envelope curve here. 
This parameter influences the dampening of the earlier reflections. 
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Parameters for editing reverb frequencies 
Lows: This parameter adjusts the low frequency component of the reverb. 

Highs: This parameter adjusts the high frequency component of the reverb. 

FFT EQ: The reverb component can be edited with an additional FFT filter. The graphic 
display includes a real-time spectrum of the reverb component in the FFT filter to provide 
visual control of the frequency characteristics of the room in which the impulse response 
was recorded. This enables unwanted responses to be located and removed quickly. 

On lower settings (< 4096 samples), the FFT filter is not available for the latency parameter. 
This is because its linear function creates increased latency. 

 

Mix, volume, reset 
Original: Set the original signal level in dB here. 
Reverb: Set the reverb level in dB here. 
Volume: Set the master output level in dB here. 
Reset: Set the level to its original position here. 

 

Performance/options 
Quality: In both "normal" modes, the room stimulation will be calculated using only half the 
sampling rate. In most cases, this will be quite enough, since natural impulse responses 
and even impulse responses generated by digital reverb devices rarely posses components 
above 10 kHz (check this in the spectral representation of the integrated FFT filter). Many 
other reverb devices work internally with the half-rate, since calculation over the entire 
frequency range would be a waste of CPU capacity. 

The difference between the two "normal" modes lies only in the quality of resampling that 
leads to sampling rate reduction. In "Normal plus" mode, the resampling quality is higher. 
The required calculation performance is slightly raised in this mode. 

"High" mode calculates the entire frequency scale. The CPU load doubles in comparison to 
"Normal" mode. 

Internal block length: This parameter specifies a block length to calculate the convolution 
function internally. 

Short block lengths raise the count of the required calculation operations, causing CPU 
strain to increase. Large block lengths lead to an uneven CPU loads. The parameter has no 
effect on the calculation result itself. 

The optimum for real-time processing tends to be about 16384 to 32768 samples. 

For use in the AUX, track, or master without low latency, a setting of 8192 or lower is 
recommended on faster systems (Pentium 1800 or Athlon XP 1500+ and higher) for an 
acceptable response latency. 

For use in low-latency conditions, the value can be reduced to 32 on faster systems (from 
Pentium 2800). 
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The value "optimal latency" adjusts the internal block length to keep the latency as low as 
possible without influencing the performance too much. 

The value "optimal latency" adjusts the internal block length to keep the performance as 
high as possible without raising the latency too much. 

Note: Setting a value smaller than the set buffer size is not useful. If the value corresponds 
to the ASIO buffer size, the Room Simulator processing is latency-free (only with "higher 
quality"). 

The FFT filter cannot be used at latencies less than or equal to "4096". Homemade impulse 
responses provide the opportunity to use the FFT filter destructively on the impulse 
response before calculating the room simulation. 

The block length is raised internally when using the Room Simulator for destructive 
processing, since processing at a lower latency would result in an avoidable increase of the 
necessary CPU operations. 

Retrieve, set: Saves and sets the quality options globally. Note that when using this on the 
object and in the track, different settings may be applied for AUX insert effects or master. 

Bypass: The "Bypass" button plays the original signal. 

 

Overview of the impulse response parameter 
Quality 
"High" setting:  Doubles the quality 

 

Internal block length 
Low internal buffer sizes (2048 samples): Increases the internal block length by approx. 50 
percent. 

Very low internal buffer size (128 samples): Increase in the internal block length by approx. 
150-200 percent. 
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Length of the impulse response 
If the length of the sample used as an impulse response exceeds a power-of-two, the CPU 
load doubles. 

The performance required subsequently doubles whenever the following impulse response 
lengths are exceeded: 

11.88  s 
5.944 s 
2.97  s 
1.48  s 
0.74  s 
0.37  s 
etc. 

Note: Make sure that homemade impulse responses are shorter than the next value, 
particularly if the impulse responses are longer than 1 second, since the length of these 
"continuous CPU load intervals" increases exponentially as length increases. 

 

Sample rate of impulse reply 
The CPU load increases proportionally to the sample rate. 

 

Impulse response resolution 
The CPU load is independent of this, since computation is carried out with float precision in 
each case. 

 

Room simulation - Tips and tricks 
By using the numerous functions for destructive sample/object editing in Samplitude, you 
can alter the qualities of the impulse response in countless ways by using the Room 
simulator dialog. 

 If you reverse apply the "Effects > Sample manipulation > Reverse" function to the 
impulse response, you will get a reverse reverb effect. 

 By using the Timestretching function the size of the room can be altered without 
affecting the resonance behavior of the room itself. 

 Employ an explosive envelope on any short samples and use the result as an impulse 
response - a great way of creating exotic reverb effects 

 You can also get interesting reverbs by using the impact on a percussion instrument as 
an impulse response. 

 

Room Simulator – Problems and Solutions 
Reverb sounds unnaturally hard. 

You can control the impulse response by setting the "Reverb" parameter. The graphic with 
the impulse response enables quick optical control in logarithmic display (dB log). 

The signal created contains a strong DC offset. 
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Remove DC offset with the same function; "Remove DC offset (view page 672)" 

Heavy hard disk activity or an error message concerning insufficient memory was 
received. 

This algorithm requires a lot of memory, especially for long impulse response patterns. All 
background processes should be terminated and all RAM wave projects that are not 
needed should be closed. 

CPU power usage is too high. 

 Check the "Internal block length" parameter's setting in the parameter's description. 
 Activate the option "Quality: Normal". 
 Shorten the length of the impulse response. Note the information provided above 

regarding intervals with the same CPU strain. 

Problems with very long impulse responses. 

Real-time operation on modern computers: Impulse responses of up to 11.88 seconds 
may be applied (with 44.1 kHz sample rate). The length is only limited by the CPU capacity. 
For destructive calculation, the upper limit is 380.4 seconds (44.1 kHz sample rate). If this 
upper limit is exceeded, the samples behind will be ignored during calculation. Impulse 
responses of this length are, however, not practical for room simulation. When 
experimenting with very long impulse responses (longer than 1 minute), note that the 
algorithm usually requires a lot more RAM (over 500 MB). When loading long wave projects 
as impulse responses, a warning appears to indicate that the calculation may lead to long 
waiting periods. 

 

eFX_Reverb 

Detailed information on eFX_Reverb can be found at "essential FX > Reverb (view page 
687)". 

 

eFX_StereoDelay 

Detailed information about StereoDelay is available in "essentialFX > StereoDelay (view 
page 689)". 

 

Ecox/Variverb 

More information is available in "Effects -> MAGIX plug-ins (view page 698)". 
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Time/Pitch 
Resampling / Time Stretching / Pitch Shifting 

 

All algorithms in this dialog use the "time factor" and "pitch (semitones)" as input 
parameters. 

Open the "Time factor calculation" section to determine the required time factor from the 
original length and original tempo as well as the desired new length/desired new tempo. 

Tip: To change an audio file's sample rate, e.g. from 48 kHz to 44.1 kHz, use the function 
"Effects -> Sample manipulation -> Adjust sample rate (view page 682)". 

 

Resampling 
Samplers and PCM synthesizers transpose samples using this procedure. Time factor and 
pitch are dependent upon each other: the shorter the audio material, the higher the pitch - 
and vice versa. The effect is comparable with changing the playback speed on record 
players or tape recorders. 

This effect is relatively loss-free; the sound loss is less than with Time Stretching/Pitch 
Shifting procedures. If a pitch change is desired or justified by changing the speed, then 
use this algorithm. 

 

Timestretching/Pitchshifting 
With all other algorithms, time factor and pitch variation are independently adjustable. 
These algorithms create, under circumstances, artifacts which you can balance using the 
Anti-aliasing feature. The preset timestretching/pitchshifting algorithm can be saved via 
Timestretch/Pitchshift Patcher in Wave project (view page 571) ("Object" menu). 

 

Default 
In this case, an algorithm is applied that usually delivers very good results with factors from 
0.9 to 1.1, that works in phase-locked mode, and therefore maintains the spatial effect of 
stereo signals. This algorithm is only partially suitable for drum loops or other "beat heavy" 
audio material since it may affect the "groove". 

Time compression (sample length is reduced) is more successful with this algorithm than 
Time Stretching, i.e. it is better to reduce the longer sample than vice versa. 

This algorithm is especially suited to complex audio material. The CPU load is light. 
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On extreme settings, aliasing effects may occur. An additional anti-aliasing filter may help in 
this case. This filter is also available for all other algorithms that work internally with 
resampling. 

 

Beat marker stretching (smoothed) 
Beat marker stretching (smoothed) represents the standard methods for high quality Time 
Stretching and Pitch Shifting. This algorithm works basically the same way as "beat marker 
stretching". In this case, the stretched material is synchronized with the beat markers so 
that the groove remains perfectly intact. Furthermore, the smoothed algorithm is used in 
between the beat markers. With percussive audio material, good audio quality is possible 
even at very large time factors. The CPU power usage is also increased in this case. 

 

Smoothed 
This deals with a complex algorithm that requires higher processing time. The audio 
material may now also be used at very large factors (0.5 – 2.0) without causing severe 
artifacts. The audio material is "smoothed", which makes the sound softer and produces 
an adjusted phase level. This smoothing is hardly audible, e.g. with speech, singing, or solo 
instrumentation. Problems in the shape of distortions may result with more complex 
spectra (sound mixes from various instruments or finished mixes). This algorithm is less 
suited to drum loops and other audio material featuring strong transients. The groove will 
remain intact, but phase shifting may "smudge" the attack. At smaller corrections (factor 
approx. 0.9 - 1.1), the smoothing degree setting of "very low" is often sufficient. 

The "smoothed" algorithm is especially useful for: 

 Orchestra instruments, string instruments, wind instruments 
 Monophonic and polyphonic speech 
 Speech recordings featuring background noise (e.g. video recordings) 
 Synthesizer areas, guitars 

The "smoothed" algorithm is less useful for: 

 Stereo mix 
 Drum loops, percussion 

CPU power usage is too high. 

 

Beat marker slicing 
This mode is especially useful for customizing drum loops, but it may also be used on other 
audio material like monophonic bass runs or sequencer lines. The algorithm splits the 
material into individual components of notes or beats, which are then selected via the beat 
marker. 

These "audio snippets" are then compiled into the new temporal measure: if the tempo is 
increased, individual beats begin overlapping; if it is slowed down, short pauses between 
the beats become audible. 

Use this algorithm whenever possible, since timeshifting is possible in this case without 
having to sacrifice quality and at minimum CPU usage. 
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The algorithm "Beat marker slicing" is especially useful for: 

 Samples that are able to be split into individual notes or beats 
 Drum loops, provided the beats do not overlap and there is not much reverb 

The algorithm "Beat marker slicing" is less useful for: 

 Signals that cannot feature beat markers. Silence will be the result. 

The CPU load is very light. 

 

Beat marker stretching 
This algorithm works in a similar way to the standard algorithm, the main difference is that 
the stretched material is synchronized with the beat markers. This way, the groove remains 
perfectly intact and doubled or faded out beats will not occur. Unlike the "Beat marker 
slicing" algorithm, absolute silence does not occur when there are no markers or incorrectly 
placed markers; instead, the synchronization quality is reduced or has errors. In practice, 
automatic marker generation is usually sufficient for good results. Avoid short distances 
with sequential beat markers (< 1000 samples). 

 

Long overlap 
If this option is active for "Beat marker stretching", the audio will not be as rough, however 
echoes may result. This option is especially useful for drum loops featuring slight time 
changes. 

The "Beat marker stretching" algorithm is especially useful for: 

 All types of rhythmic samples that are unable to be cut into individual notes or measures 
(beats) 

 Rhythmic samples of all types, although individual notes/hits will not be separated 
 Applications that cannot be used for beat marker slicing or are too complicated for 

perfect beat marker positioning. 

 

Setting and evaluating beat markers 
If beat markers have not been placed yet, these will be generated automatically in real time. 
In the Resampling/Time Stretching dialog, select the "Patched" option to specify whether 
or not saved ("patched") beat markers should be used in the wave project. 

Use the following option to generate beat markers: 

Find and use beat markers: After activating this option, the algorithm will locate the beats 
and mark them as beat markers. 

Note: This function is only available in the wave editor. 
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Attack recognition threshold 
Use this fader to set a threshold for beat recognition. When the wave project displayed, 
you can follow the placement of beats visually. This also works with VIP objects if the wave 
project is open at the same time. 

 

Reset Beat-Marker: All Beat markers are removed. 
Beat markers can be corrected manually. Beat markers can be re-positioned, copied, 
deleted etc. by activating the applicable marker commands. 

Hint: If you wish to set new beat markers manually, right-click on the marker bar and select 
"Save marker -> Markers with names...". Name your new marker as "Beat". 

We encourage you to set the value of the velocity detection threshold  to a high value 
before editing and then to delete the superfluous markers - this is far quicker than trying to 
expand missing markers manually. 

With the Timestretch/Pitchshift Patcher (view page 571) in the "Object" menu you can 
easily set the markers. This give you the option to edit the Beat marker, if the dialog is open 
(non-modal window). Thus you can check the fruits of your labors immediately, without 
having to close the dialog. Moreover in the patcher, the tempo (BPM) and Timestretching 
mode used by the object editor can be saved directly in the wave project. 

 

Monophonic voice 
This is a special Time Stretching and Pitch Shifting function for vocal solos, speech, or solo 
instruments. The audio material should not contain background noise – strong reverb may 
also this method's effectiveness. With suitable audio material, the audio quality will remain 
high. 

The "Use formant correction" option preserves formants during Pitch Shifting, i.e. the 
"Mickey Mouse effect" does not occur. This allows realistic-sounding background choirs to 
be compiled using one solo voice. The formants, however, may also be moved by +/- 12 
semitones in order to achieve desired vocal distortions. 

Typical uses of this algorithm include: 

 Intonation correction: The note with the imprecise pitch should be cut out as an object 
so that it may be manipulated independent of the other notes. 

 Harmonizer effects: Copy the object containing the singing. If the pitch is altered now, a 
second voice will be generated. 

 Creating background vocals from existing vocal samples 
 Time Stretch distortion of a spoken sample, e.g. grandfather's voice. 

The "Monophonic voice" algorithm is especially useful for: Speech, single-voice 
singing, single instruments without overlaps/with low levels of reverb and background 
noises. 
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Universal HQ 
This algorithm provides a high-quality Time Stretching/Pitch Shifting method and offers 
good audio quality with almost any audio material. Especially when it comes to complex 
audio recordings like orchestral recordings, this algorithm delivers high-quality results. 
Stereo properties also remain intact. 

The CPU load can become very high when realtime effects are applied to many 
simultaneously playing objects. 

 

True Resynthesis Timestretching (TRTS) 
How does True Resynthesis Timestretching (TRTS) work? 

The signal is broken down into individual components, with the amplitude and frequency 
modulated oscillators - simple synthesizers -are reproduced faithfully. If these synths play 
longer or shorter a Timestretching effect will be created. 

What is the difference to traditional TS algorithms? 

All traditional algorithms work on the basis of signal-adjusted, automated cut functions 
(Copy, Cut, Fade etc).  

With TRTS however you can stretch timelines when "Resampling". The typical compression 
artifacts and associated non-uniformities will not occur. 

Will Artifacts emerge? 

The artifacts are small in comparison to conventional processes. Linear stretching 
impulses, sibilants and  wide band noises leads to a change in sound characteristics and 
can be produce artifacts. Tonal components can be stretch perfectly. 

Are beat markers used? 

Yes. At recognized beat markers the stretch factor is internally set to 1, so that the beat 
isn't affected. 

What advantages does the algorithm offer? 

 Universally usable. Due to linear work practices TRTS is particularly suitable for very 
small and very large Timestretch factors. 

 Detected transients remain true to the original, undetected transients are only slightly 
changed. 

 It can also be used for material with complex rhythms (Jazz, Salsa etc). Here 
conventional algorithms have more difficulty than in straight disco or techno beats. 

 Particularly well suited to orchestras. 
 No trimming or filtering out of signal components - thick, rich sound. 

Which audio types could cause problems? 

 Speech, especially deep male voices 
 Sibilants 
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 Computer-heavy pop and techno music, due to the discoloration of noisy sections. 

How high is the CPU usage? How much memory is required? 

Multiple CPU cores are used. On faster systems (Intel i7 - Processor 3 GHz) the algorithm 
calculates stereo samples in near realtime at a sample rate of 44.1. 

Memory requirement is dependent on the material and is somewhere in the region of 200 
MB. 

How will stereo behavior and spatial qualities be influenced? 

The stereo position of components remains the same. Since the reverb portion is either 
lengthened or shortened when stretch, the room size will also be correspondingly be 
increased or decreased. 

 

Elastic Audio  
Shortcut:   Ctrl + Shift + E 

 

Elastic Audio – general 
Elastic Audio is a specialized editor for changing the pitch of audio material. A combination 
of automatic resampling and Pitch Shift Algorithms as well as pitch detection for 
monophonic material allows extensive changes top be made to the pitch for audio material. 

Pitch Shifting Algorithms are able to change a melody in the pitch without influencing the 
tempo. Samplitude provides a variety of Pitch Shifting Algorithms, which can be used 
depending on the existing material. 

Elastic Audio offers the following options: 

 Detection of the basic frequency in monophonic audio material. 
 Automation of resampling and Pitch Shifting Algorithms. This also includes an algorithm 

for format-true pitch shifts of monophonic audio material that utilizes results of the pitch 
detection basic frequency analysis. 

 Automatic and manual correction of the basic frequency process in monophonic audio 
material. 

 Automatic and manual correction of the pitch of notes from monophonic audio material. 
 Changing melodies in monophonic audio material. 
 Manual correction of the basic pitch curve. 

Note concerning Time Stretching: Time Stretching cannot be automated, but it can be 
used statically with Elastic Audio. 

 

Elastic Audio -  editing modes 
The Elastic Audio editor may be used in two different operational modes, i.e. Relative and 
Direct mode. If Elastic Audio should always open in "Direct" mode, then select the function 
Open in mode "direct" from the Elastic Audio "View" menu. 
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Elastic Audio – "Relative" mode 
Edit the pitch curve (automation of the pitch's temporal path) as a relative pitch deviation 
here. This corresponds roughly with the pitch bend controller for MIDI data. 

 

Editing can be done with a free-hand curve, quantized "step" curves, or by using the Curve 
Bend tool. The Curve Smooth tool enables equalization of the automation curve. This 
smoothes pitch curve value changes that are too steep during playback. 

Overview of graphics in "Relative" mode 
Y-axis: Displays Pitch Shifting in semitone steps (within a range of -48 to 64 semitones). 

Orange curve: Editable pitch and automation curve as relative detuning of the original 
note. 

Red line: 0 line as a reference for the editable pitch curve. 

 

Elastic Audio – "Direct" mode 
The pitch curve is traced immediately in "Direct" mode, and changes are absolute. To 
customize the pitch correspondingly, the original pitch of the audio material must be 
known. A preceding analysis of the audio material's pitch is therefore required for  "Direct" 
mode. This is basically only for tonal, monophonic material like solo vocals, solo 
instruments, and speech. 
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Start the analysis function with the "Pitch Detection" button. The analysis may take longer 
with larger objects. After analysis, the VIP objects are divided into individual slice objects 
according to the recognized pitches. The medium pitches of a slice object determine its 
position in the graphic, independent of the set progression of the pitch curve inside the 
slice object.  

Select all of the slices first. Click an empty area in Elastic Audio Editor to deselect all of the 
slices. The individual or multiple slices may now be selected via the modifier keys "Ctrl" and 
"Shift".  

Two handles are created for the pitch curve on the borders of the slice objects. These 
handles can be moved in order to produce an increasing or decreasing pitch characteristic, 
but still keeping the small changes in the basic frequency (vibrato). 

Besides the pitch trace feature, this mode also provides you with "Tune!" functions for 
automatic pitch correction. 

Overview of graphics in "Direct" mode 
Y-axis: The piano keys on the left side of the window display the pitch assignment in 
notes. The individual pitches may be deselected by clicking them in this view so that they 
won't be used in the automatic pitch correction or in quantized drawing.  

You can get appropriate scale settings by selecting the tonic keynote and the scale in the 
“Edit slice-object” box. 

Orange line: Displays the editable pitch properties. 
Gray line: Displays the original pitch properties. 
Blue line: Median pitch of a slice object. 

 

Elastic Audio – basics 
Opening Elastic Audio Editor 
Select the objects to be processed with Elastic Audio Editor. The objects may be located in 
several tracks. Elastic Editor is launched via "Effects" or the Time Stretching section in the 
object editor. 

Shortcut: Ctrl + Shift + E 

Interaction between Elastic Audio Editor and objects in the arranger window 
First, make temporal corrections to notes by splitting and moving objects in the arranger 
window. 

Elastic Audio Editor is multi-object capable, which means it can edit a melody that has 
been cut into individual objects as a whole. 

Loading objects into the Elastic Audio Editor 
Elastic Audio Editor loads all objects that were previously selected. However, you can only 
ever view objects from one track and edit them simultaneously. When objects are loaded 
into Elastic Audio Editor from several tracks, switch the track displayed in the editor via 
"Edit VIP objects" via the track selection. 
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Elastic Audio: Description of all control elements 
The control elements available in each mode are available for activation/deactivation in the 
lower section of Elastic Audio Editor's "View" menu. 

View 

 

Waveform: This turns the waveform display on and off. 

Zoom buttons: Save the zoom depth and position for the current window here. Buttons 1-
4 or numbers 4, 5, and 6 of the number block are available for this purpose. These also 
access the zoom buttons 1, 2, and 3 respectively. The fourth zoom button is not assigned 
to any key in the number block. 

Save Zoom Level: 

Shortcut: Ctrl + number block 4 

  Ctrl + number block 5 

  Ctrl + number block 6 

The numbers 4, 5, and 6 on the number block may be used for the first three zoom 
buttons. 

Get Zoom Level: 

Shortcut: Number block 4 

  Number block 5 

  Number block 6 

"Shift" + left click on the zoom button will overwrite the last zoom level. 

"Ctrl" + left click opens only the horizontal position of the corresponding zoom level. 

Zoom 100%: Horizontally zooms the entire material on the currently loaded track. 

Note: The key combination "Ctrl + Alt" + mouse wheel enables simultaneous horizontal 
and vertical zooming. 
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Refresh: This refreshes the graphical display of the material. Any resulting changes to the 
length are adjusted as such. In case synchronization of the arranger and Elastic Audio 
Editor is active (Elastic Audio Editor -> Display -> Horizontal -> Synch. VIP editor), then the 
effects will be displayed in the VIP within the arranger window. 

Edit VIP object 

 

Track selection: If objects from multiple tracks have been loaded into Elastic Audio Editor, 
a track may be selected here. 

Algorithm: Select between "Resample" (preset), "Monophonic Voice", "Standard", 
"Smooth", and "Beat Marker Slicing" modes. 

Detailed information about these algorithms is available in "Effects -> Time/Pitch -> 
Resampling/Time Stretching/Pitch Shifting (view page 647)". 

Smooth: This parameter smoothes the pitch curves entered across a time constant (in 
ms). Peaks in pitch changes become a glissando in case of stronger smoothing. 

Options: These are advanced settings that depend on the selected algorithms. 

Reset: Undoes all changes to automation curves or voices of selected objects. 

 

Options for automatic pitch correction 
Edit slice object (direct mode) 

 

Key: This option sets the basic key of the scale. In the chromatic key, this setting is not 
included in calculation. 



 

E F F E C T S  M E N U  6 5 7   

Scale: Use this option to select the type of scale, i.e. the sound make-up/mode. Choose 
from "major", "minor", "harmonic minor", "pentatonic", and "chromatic". 

Pitch contour: Tune!: This button quantizes ("levels out") the pitch contour of the selected 
slices.  

Contour smooth: Set the strength of the quantization (lower values quantize hard). This 
function removes repeated small pitch alternations in natural sound sources, e.g. vibrato 
("Cher" effect). 

Tone: Quantize the mid pitch of the selected slices. The corresponding sections of the 
pitch contour of a slice object are moved together and adapted to the mid pitch. Pitch 
fluctuations within a slice object remain the same. 

Note: Automatic correction requires the slice's pitch (pitch -> detection). 

The results of the calculation of mid pitches for slices featuring glissandos often do not 
correspond to the pitches that human hearing assigns to them. In this case, automatic 
correction of the mid pitches does not give satisfactory results. Removal of the glissando 
passage by manually changing the slice borders (keyboard shortcut: Ctrl + rubber handle 
tool) or the splitting of slices can help. 

Reset: This command resets the selected slices. The orange curve is superimposed over 
the gray curve and the slice is reset to the original mid pitch. 

 

Harmonizer 
Use the harmonizer to add additional voices to the object. Please note that the harmonizer 
is only available in "Direct" mode via the "Monophonic voice" algorithm. Format correction 
is required for a satisfactory result which is only possible with this algorithm. 

Chord: Select the chord created by the voices if the "Harmonic adjustment" parameter has 
been selected.  

If "Harmonic adjustment" is deselected anyway, the voices are sent so that they are 
overlaid onto the sounds set in "Edit slice object". The set chord then only serves as a 
"guideline". 

Humanize A "human touch" may be applied by moving the individual voices more or less 
subtly away from each other. 

Harmonic adjustment: Activating this field causes voices to run parallel to one another 
and correspond to the set chord. 

Create voices: Use this button to recreate parallel voices. 

 

Pitch (fundamental frequency) 
Detection: Use this button to start the basic frequency analysis. In this case, the absolute 
pitches are displayed graphically in the Elastic Audio Editor. This function is indispensable 
for additional editing steps you may wish to make in "Direct" mode. For this reason, you 
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should only open the pitch recognition before executing pitch corrections or other editing 
processes. 

 

Playback control 

 

Reset: All pitch curves for the entire material loaded into the Elastic Audio Editor are 
reset. 
Bypass: Plays the arrangement without editing. 
Stop/play: Stops/starts the playback of the arrangement. 
Play solo: Only activated objects in the editor are played. 

 

Toolbar 
Several tools are available for processing the slices and pitch envelope. Two tools can each 
be assigned to one of the two mouse buttons. The tool assigned to the left mouse button 
turns blue; the function assigned to the right key is marked in red. Click with the 
corresponding mouse button on the desired console button. The "Zoom" tool is an 
exception: both buttons are assigned automatically. 

 

Selection tool (arrow): Use this tool to move slice objects vertically. This modifies the pitch 
of slice objects as a whole. Slice objects and curve handles may also be selected, and a 
slice object lasso can be dragged out. Multiple selections are possible with the "Ctrl" or 
"Shift" key. 

Freehand drawing function: Use the pencil tool to draw the pitch curve freely. If the 
"Shift" key is pressed, a straight line is drawn from the starting position to the current 
position of the mouse. When the "Ctrl" key is also pressed, the slice objects are combined 
during drawing. 

Pencil tool for quantized drawing: This is the tool for quantized drawing. Quantizing 
means that the line is free horizontally, but snaps into semitone steps vertically in "Relative" 
mode, and to the tones of the scale selected via "tune" in "Direct" mode. 

Drawing a straight line using the "Shift" key and combining slice objects with the "Ctrl" key 
is also possible in "Quantized draw" mode. 

Rubber handle tool: This rubber band tool may be used to bend the pitch envelope 
between two neighboring handles. The range between the curve handles is moved, but the 
handles themselves remain unchanged. The curve is bent inwards at the handle point. In 
combination with moving the curve handles on the slice object's boundaries, you can bend 
the tone envelope and thereby maintain the microtonal structures (vibrato). 

Cut: Use this tool to manually split the audio material into slice objects. After automatic 
pitch recognition has been applied, use the "Cut" tool to split certain passages into 
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individual slices. To recompile slice objects, use the pencil tool to drag along the slice while 
holding down the "Ctrl" key. 

Eraser: The orange curves are set back to their initial values, i.e. the pitch envelope 
corresponds to its original curve again. 

Navigation tool: Use the navigation tool to move the visible selection vertically and 
horizontally. 

Zoom tool: Click with the left mouse button to zoom into the display; zoom out with the 
right mouse button. Left clicking and dragging stretches the range displayed as the zoom 
area. 

 

Controls for global display options 
These buttons have a global effect for the Elastic Audio Editor. 

 

Grid: Use this function to switch the raster on or off. 

"Single object" mode: The maximum horizontal zoom level is limited to one object. 

"Synchronization" mode for VIP and Editor: Horizontal zoom levels of both windows are 
synchronized with each other. 

"Docked view" mode: When "Docked view" is active, the arranger window is located 
below the Elastic Audio Editor. 

 

Using Elastic Audio Editor 
Pitch slice objects and VIP objects 
During the basic frequency analysis, the objects in the pitch slices are split, which ideally 
corresponds with a note of a melody in monophonic music or monosyllabic speech. For 
speech, the pitches correspond with the positions of the vocals. After analysis, all slices are 
displayed in blue. 

The splitting of slices can be corrected manually. Slices are split using the cut scissors tool 
and glued together using the rubber handle tool while holding down the "Ctrl" key. The blue 
line displays the medium pitch for every object, which is the approximate result of the 
average value of the pitches in the slice. 

The functions contained in "Edit slice object" may be used on selected slice objects: 

 Pitch Contour Quantization 
 Tone Quantization 

After pressing the "Tune!" button, the changed setting will be audible. Pressing "Reset" 
undoes corrections made to the selected slices. 
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The functions contained in "Edit VIP object" may be used on selected VIP objects. This 
involves selecting an algorithm and the smoothing magnitude for the pitch or automation 
curves. Pressing "Reset" undoes corrections made to the selected slices. 

 

Elastic Audio: Overview of keyboard commands and configuration of the mouse 
wheel. 
Navigating with the mouse wheel 
Horizontal scrolling Mouse wheel 
Vertical scrolling Ctrl + Shift + mouse wheel 
Horizontal zoom "Ctrl" + mouse wheel 
Vertical zoom  Alt + mouse wheel 
Zoom horizontally and vertically Ctrl + Alt + mouse wheel 
 

Keyboard shortcuts 

Ctrl + space bar Play solo/stop 
Space bar Play/stop 
Ctrl + A Select all 
A Refresh view 
Ctrl + Z  Undo 
Ctrl + 1 - 8  Select tool for the left mouse button 
Ctrl + Shift + 1-8 Select tools for the left mouse button. 
Shift + Alt + P Show/hide pitch curve 
Ctrl + Alt + T Show/hide other loaded tracks 
Ctrl + cursor up Direct mode 
Ctrl + cursor down Relative mode 
Cursor left Move play cursor to left 
Cursor right Move play cursor to right 
Ctrl + Cursor left Horizontal zoom in 
Ctrl + Cursor right Horizontal zoom out 
Shift + R Change scale tuning (Frequency for “A” 

concert pitch). 
Shift + A Show/hide "View" 
Shift + O Show/hide "Edit VIP object" 
Shift + F Show/hide "Pitch" 
Shift + S Show/hide "Edit slice object" 
Ctrl + number pad 4, 5, 6 Save zoom snapshot 1, 2, 3 
Alt + number pad 4, 5, 6 Load zoom snapshot 1, 2, 3 without 

vertical zoom 
Number pad 4, 5, 6 Load zoom snapshot 1, 2, 3 without 

vertical zoom 

 

Selecting slice objects and VIP objects 
Slice objects can be selected/deselected by clicking them with the mouse. The keyboard 
shortcut "Ctrl + A" selects all slices; de-selection is made by clicking on "empty space". 

VIP Objects cannot be selected directly in the Elastic Audio Editor. When a slice object is 
selected, the corresponding VIP object is also selected. 
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Tone pitch automation including changes to the length (resampling) 
 Load objects into "Elastic Audio Editor -> Relative mode". 
 Select the "Resampling" algorithm. 
 Select the drawing tool. 
 Draw the orange automation curve with the drawing tool. 

 

Pitch automation without change in length 
Proceed as previously explained in the resampling section. A pitch algorithm may also be 
selected (standard, smooth, monophonic voice, beat marker slicing). The length of the VIP 
objects remains the same here. 

 

Pitch correction (intonation correction) with monophonic audio material 
 Load the object into the Elastic Audio Editor. Mode -> "Direct" 
 Perform pitch detection ("Detection" button in "Direct" mode).  
 Select desired slices 
 Select suitable algorithm 
 Edit pitch with the mouse tools 

 

Manual correction of the whole pitch of a pitch slice 
 Select the slice with the selection tool (arrow). 
 Move the orange line vertically with the mouse tool. 

 

Automatic correction of the whole pitch of a melody slice. 
 Select the slices with the selection tool (arrow). Mode -> "Direct" 
 Detect pitch 
 Select the scale in the "Edit slice object" group and, if necessary, discard the additional 

tones that are not to be quantized via the keyboard on the left side of the editor by 
clicking and deselecting. 

 Click the Tone "Tune!" button 

 

Automatic correction of the pitch characteristic with quantization 
 Select the slices with the selection tool (arrow). Mode -> "Direct" 
 Detect pitch 
 Select the scale in the "Edit slice object" group and, if necessary, discard the additional 

tones that are not to be quantized via the keyboard on the left side of the editor by 
clicking and deselecting. 

 Click the Tone: "Tune!" button 
 Reduce level of the quantization with the parameter "Contour smooth" 

 

Correct pitch increase or decrease 
 Select the slices with the selection tool (arrow). Mode -> "Direct" 
 Detect pitch 
 Move the orange-colored pitch curve to the edge of the slice object by moving the 

handles or click and drag the orange line 
 

Create frequency modulations like warblers and vibrato 
 Select the slices with the selection tool (arrow). Mode -> "Direct" 
 Detect pitch 
 Select the drawing tool 
 Draw pitch modulation 
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Creating second voices or harmonizing effect 
 Create a duplicate of the object on the track below it in the arranger 
 Selection of both objects in the VIP 
 Open Elastic Audio Editor 
 Select the track via "Edit VIP object -> Select track" 
 Edit each track individually. Do not use the resampling algorithm to avoid different 

tempos in the voices. 

Alternatively, additional voices may be created easily with the "Harmonizer" in "Direct" 
mode. 

 

Distortion 
Distortion 
This effect allows you to distort audio material by using a non-linear transfer reference line. 
The signal becomes louder and overtones are added. 

 

By adjusting the starting point of the distortion (threshold), a soft, analog-sounding 
distortion (overdrive), or a hard, digital-sounding distortion (threshold at 0 dB). The intensity 
of the distortion may be set using "Level". 

 

Amp simulation 

This menu item is hidden by default. To display it again, activate it in the menu 
settings via "File -> Program Preferences > Edit Keyboard Shortcuts and 
Menu (view page 488)". 

 

The Amp simulator is a realtime effect that simulates tube amp sound properties. It is 
especially suitable for guitar sounds, but also for the organ or recordings of vocals. 
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Presets: Here predefined amplifier simulations can be selected. 

Amp: Here you can select from a range of amplifiers whose sound can be simulated. 

Speakers: Here you can select from a range of speakers whose sound can be simulated. 

Distortion (gain): This regulates the distortion amplification. 

Speaker component: Here you can regulate the speaker component present in the 
complete signal. 

Equalizer: A 3-band equalizer for setting the bass, mids and highs. 

Bright (impendence filter): he "Bright" button provides an especially penetrative acoustic 
pattern that sounds like screeching when combined with the input gain. 

Input gain: With this fader you can adjust the volume of the distortion. 

Output: Here you can adjust the master volume of the amplifier module. 

 

Vandal 

Detailed information about Vandal is available in "Vandal (view page 745)". 

 

BitMachine 

 

Audio material can always be edited into high quality with Samplitude. Nevertheless, there 
are some situations, for example, a more imperfect lo-fi sound would perfectly suit a drum 
loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s that usually only ran at 8 
or 12-bit rates and at low sample rates. With the BitMachine, changing the sound with 
such an "antique" device is no problem. 

You can use the BitMachine to bring back to life the times when minimalist and scratchy 
soundchips in home computers were commonplace. 

The BitMachine opens up a gateway to "acoustic time travel" where you can encounter bit 
and sample rate reduction and downstream filters based on analog models.  
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Furthermore, the effect has a modulation section with which you can control individual 
parameters using an oscillator (LFO) or the input signal.  

We have designed a range of "typical" presets to demonstrate the time travel abilities of the 
BitMachine. These can be opened at the top right of the interface 

The following section describes the details of BitMachine: 

 

"Reduction" section 
Bits 

This dial controls the resolution of the audio material. Turning the dial to the left results in 
16-bit quantization (CD quality). The further it is turned to the right, the lesser the signal 
dynamic becomes. In extreme cases (1-bit), there are only "on“ or "off“ states.  

At the intermediate levels, you’ll notice an increase in the background noise and a 
decrease in the dynamics. For example, 8-bit quantization will exhibit dynamics of only 48 
dB. Quieter points in the material sound noisy and very quiet points sound "capped“. This 
effect is amplified the more you turn the dial to the left until it starts crackling or "groaning". 

Sample rate 

The audio material is "down-calculated" with this dial, i.e. the internal sample rate is 
reduced. A new separation ratio between old and new rates is created. In relation to this 
ratio, a sample from the data stream will be "dropped“ at the various points. 

Note: The two smaller dials from this section are explained under Modulation. 

 

"Filter" section 
The filter in the BitMachine is a digital model of one of the most well-known filters in music 
electronics, i.e. the "Chamberlin 2-pole" filter used in old Oberheim synthesizers. These 
types of filters sound exceptionally musical. They can also be used quite creatively in the 
BitMachine, but should not be used exclusively to smooth out existing artifacts.  

The filter works in the so-called "high-pass" mode, i.e. it lets through deep frequency (or 
medium) material according to setting, and dampens highs and medium areas. 

Freq: 

You can specify the cut-off frequency of the filter using "Freq". Filtering starts above this 
frequency. 

Reso: 

The signal in the area around the cut-off frequency can be strongly elevated to just below 
self-oscillation. Sharp, cutting sounds are possible at this level, and the effect becomes 
even clearer when you vary the cut-off frequency. 

Drive: 
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Both of the individual filters of the connections mentioned above have the ability to 
overmodulate themselves internally. With the "Drive“ dial, you can regulate the amount of 
overmodulation. The more you turn this dial up, the more the signal is overmodulated. In 
this case, the parameters of the internal workings of the filter interact with one another. 
Increasing drive weakens the resonance, but, at the same time, the signal gets more 
volume, more bass and becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under "Modulation". 

 

"Modulation" section 
You can automate your effects via the settings in the modulation section. 

Here, you’ll find the so-called low frequency oscillator (LFO), which resonates with 
adjustable speed. You can influence the speed and type of resonance. 

To influence the resonance, use the two small dials in both the reduction and filter areas. 
These four dials display modulation targets.  

Example: You’ve left the dial for the sample rate at its default setting. Change the small dial 
beneath from its middle position to either side. The modulation for the dial value is added to 
the sample rate: The LFO now controls these parameters proportionately and the sample 
rate reduction resonates at this modulation. 

You can use this technique on other dials as well. You just have to make sure that the main 
dial isn’t turned up to full, because then the modulation wouldn’t have any effect. The 
modulation is always added to the set value. 

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) and the one 
beside it (beneath "sample rate") to the right (+50). You’ve now assigned a modulation to 
both parameters with the LFO. They are not changed uniformly, but rather opposite to one 
another: A negative setting is nothing more than an inversion of the modulation, so you’re 
effectively turning down the control signal. 

Waveforms of the modulation section 

We’ve already explained this example with the help of sine oscillation. The LFO can be in: 

 Sine form 
 Square wave (0 or 1, no intermediate level) 
 Random value (an internal randomizer will be queried at the set speed) 

Oscillator speed 

The LFO speed is specified with the "speed“ dial. If the "sync“ button is active, then the 
LFO adapts to the song speed, and the dial locks musical values into place (e.g. ¼ note). 
Rhythmic paths of the sound distortion are therefore enabled. You can also switch off this 
synchronization and set the speed manually (in Hz).  

Modulation with the "Envelope follower“ 
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In the modulation section you’ll find a fourth button, the audio input signal. If this mode is 
active, then the signal itself can be called upon to extract “modulation tension”; a so-called 
"envelope follower" continuously scans the volume of the input signal. 

Note: The BitMachine doesn’t recognize the type of audio signal automatically. For this 
reason, you should set the input sensitivity roughly with the "gain“ dial. To do this, use the 
control LED: With accurate detection of the signal dynamics, assigning the four small dials 
to modulation lows is easier and you can use the full control range.  

In envelope mode, the "speed“ dial is used to control the response speed of the envelope 
(the display now switches to milliseconds). Lower times result in a faster response, higher 
times make the envelope rise (and fall) slower. You should experiment with the signal 
according to its complexity. The presets provided can only point you in a rough direction. 

 

Restoration 
In Samplitude the following restoration tools are available as standard: 

 DeClipper SE 
 DeClicker/DeCrackler SE 
 DeHisser SE 
 DeNoiser SE 

Furthermore, you can remove noise from an object with the mouse mode "Spectral mode 
(view page 72)". Editing can be done directly in the Arranger window. 

With the optional "Cleaning/Restoration Suite" you have access to the full versions with an 
enhanced range of functions. 

 

SE dialogs header 

 

In the presets input field you can load, save or delete presets.  

On the right next to the Preset selection you will find the Bypass and Automation buttons. 

 
Bypass: The algorithm is removed from the signal route. This enables the unedited 
signal to be easily compared to the result of the algorithm. 

 

 
By clicking on this button you can toggle between the selected automation 
write/read mode. By right clicking you can get to the Automation context menu. 

Via "?" you can call up extra help information. 
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DeClipper SE 

(The full version is available as an option of part of the Cleaning/Restoration Suite) 

The De-clipper is a tool for removing overmodulation and distortions. Overmodulated 
passages are recalculated, or interpolated, based on the material immediately surrounding 
them. 

 

The DeClipping algorithm is suitable for material with clearly audible overmodulation, e. g. 
distorted piano or vocals. 

 

DeClipper SE – Presets 
Load, save, delete presets: Here you can save, load, or delete settings. The default file 
extension is *.dcp. 

 

 

 

DeClipper SE – Parameter 
Clip level: Here you can enter the level at which the sample will be considered 
overmodulated, and correspondingly corrected. 

Activity: This LED flashes blue if the signal is altered using the effect. 

Inverse: If this switch is activated, you will hear only the part of the signal that is changed 
by the algorithm. 
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DeClicker/DeCrackler SE 

(The full version is available as an option of part of the Cleaning/Restoration Suite) 

The DeClicker removes crackling and clicking noises, which are typical on scratched 
records, it was also developed especially for louder individual clicking sounds on older 
vinyls. 

 

 

 

DeClicker/DeCrackler SE - Presets 
Load, save, delete presets: Here you can save, load, or delete settings. The default file 
extension is *.dck. 

 
 

De-clicker/De-crackler SE - Parameter 
Intensity: Using this parameter you can influence the intensity with which the 
DeClicker/DeCrackler SE engages with the detected areas of the audio material. 

Activity: This LED flashes red if the signal is altered using the DeClicker SE. The LED 
flashes red if the signal is altered using the DeCrackler SE. 

Inverse: If this switch is activated, you will hear only the part of the signal that is removed 
by the algorithm. If the parameter is optimally tuned you will only hear the bothersome 
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clicks. If the parameters are too high, parts of the music or speech signal will also be 
filtered, which will lead to music discoloration. 

 

DeHisser SE 
(The full version is available as an option of part of the Cleaning/Restoration Suite) 

This command opens the DeHisser SE, which helps to remove noise. The DeHisser SE 
eliminates regular, low-level "white" noise, typically produced by recordings, microphones, 
pre-amplifiers or transformers.  

 

Unlike with noise reduction, a sample of the distortion is not required. 

 

 

DeHisser SE – Presets 
Load, save, delete presets: Here you can save, load, or delete settings. The default file 
extension is *.deh. 

 
 

DeHisser SE - Parameters 
Noise level: With this parameter a threshold value will be set for differentiating the signal 
from noise. The right setting for this parameter is crucial for good results. 

Noise reduction: Set the noise damping here. The highest possible damping value is 30 
dB. 

In practice, extremely quiet passages, like the slow fading out of one instrument prove to 
be critical – here the noise level can exceed that of the audio signal. 



 

6 7 0  E F F E C T S  M E N U   

Limit yourself to one low noise damping (-10, -15 dB) to avoid side effects like artifacts. 

Inverse:If this switch is activated, you will hear only the part of the signal that is removed 
by the algorithm. By optimally setting the "noise level" parameters, you should only hear the 
noise. 

 

DeNoiser SE 
With the DeNoiser SE you can remove noises without discoloring the source material too 
much. To do this, the algorithm requires a noise sample.  

 

The DeNoiser SE function works especially well to remove even, long-lasting noise like 
ventilation noise, artifacts from low-quality sound cards, tape deck noise or feedback. 

 

DeNoiser SE – Presets 
Load, save, delete presets: Here you can save, load, or delete settings. The default file 
extension is *.nr2. 

 

DeNoiser SE – Parameter 
Noise Level 
This parameter brings about a increase/decrease in the noise sample spectrum. Be sure 
that a higher-level of noise does not automatically require a higher correction level. 

Noise Reduction 
Here you can set noise damping in decibels, between 0 dB and -40 dB. 

In many cases it is most definitely advantageous to not completely remove noises: for 
example when working with gramophone recordings, it can be desirable to leave some of 
that "gramophone feeling" in. Removing background noise from on location reports is 
usually not preferable. Besides, any artifacts or discolorations are reduced by the 
incomplete suppression of noises. Think of the process in terms of reduction, not 100% 
elimination. 
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Inverse: If this switch is activated, you will hear only the part of the signal that is removed 
by the algorithm. If the parameter is optimally tuned you will only hear all the noise and only 
a small portion of the used signal  

Noise sample file: In the selection list, you can select a group of noise tests. The noise 
samples displayed in the list can be found in the "fx-preset" folder. 

Wizard: Here you can open the "Noise print assistant" dialog to help you extract a noise 
sample. You can find out more about this assistant below. (view page 671) 

 

DeNoiser SE – Get noise samples from the „Effects“ menu tab. 
1. Select an area in the selected Wave project or an object in a virtual project, where 

only the noise is audible. As a rule, you will usually get better effects with longer noise 
samples. If the length of the noise samples exceeds a minute, only marginal 
improvements can be obtained. 

2. Select "Effects -> Restoration -> Get noise sample".  
3. Select the range of the original sample in the wave project to which de-hissing should 

be applied or select the corresponding object in the VIP. 
4. Open the DeNoiser SE via the "Effects menu -> Restoration -> DeNoiser SE". 
5. If the sample selection list for the noise sample (under "Noise Sample -> File") is not 

already set to "Noise Print", rearrange the list entry accordingly. 
6. Press the "Play/Stop" button for the real-time preview function. Once you are satisfied 

with the result, press "OK". Otherwise, change the parameters. 

 

DeNoiser SE – Noise Print Assistant 

 

Proceed as follows to generate a noise sample with the Noise Print Assistant. 

1. Determine noise print length 

Range length or internal standard value: If a range has been stretched, a range length 
will be used. You should be careful not to select an area longer than necessary, because 
each Noise Sample used in a real-time DeNoiser instance is added to the project. If 
however no range is selected an internal length will be used, which normally produces a 
useful result. 
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Target length: Set an explicit length for the noise sample. 

2. Extract noise print from the audio material 

Extraction at beginning of range or play cursor: The noise sample will be extracted from 
the range available, or otherwise the start position will be determined by the play cursor. 

Extraction at the position of the lowest level: This search function analyzes the audio 
object for soft areas. Set the search area above the search options and click the "Start 
search" button. You can cancel the search by pressing "Esc". 

After at least one quiet range has been found, you can select it using << and >> and listen 
to it using "Play..." 

 

Search options 
Start the search in object – object type: The search area starts at object type 

Start the search in object – area start or the play cursor: Search area starts at the area 
start, if you have defined an area previously. Otherwise the search starts at the play cursor.  

Length of search in the object – until object end: The search for soft passages 
stretches until object end. 

Search length in object – x minutes maximum: Enter the search length in minutes here. 

3. Exit the assistant by clicking "OK". 

 

Remove DC Offset (Offline) 
This function removes the DC offset in a wave project/object. This is useful if the sound 
card overlays a recording of your sample with a constant DC offset, which may cause 
clicks during cutting or editing. 

Options: Enter a minimum DC offset threshold to indicate where DC offset removal will 
engage. If you deselect the corresponding check, the stereo channels will be edited 
together. This saves computing time, especially when working with long files. 
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Stereo/Phase 
Switch Channels 
Use this function to swap the right and left channel of stereo samples in order to correct 
accidentally swapped channels when recording. 

This function may be reversed, e.g. if you don't re-select the range, opening it again will 
restore the original material. 

 

Multiband stereo enhancer 
(Samplitude Pro) 

The multiband stereo enhancer performs detailed modifications and corrections to the 
stereo image in three independent frequency bands. 

Thanks to the FIR complement filter technique, no discoloration of the frequency response 
will be introduced. 

Using multiple bands to affect the stereo image has many important advantages over 
standard solutions without frequency separation. Increasing the width of the mid-range, for 
example, prevents "typical" problems like muddy highs and lows that result from removal. 
The reduction of mono compatibility caused by an increase of the base width is also limited 
to treatment of a specific band. 

Important Multiband Stereo Enhancer applications include: 

 Reduction or expansion of the stereo base width. 
 More powerful bass by reducing the base width in the bass range. 
 Control and correction of problems in the stereo image of a completed mix. 
 Moving the mono section of a stereo recording in panorama (direction mix). This way, 

centered vocal recordings may be moved to the left or right of the stereo balance later. 
 Damping or removing mono signals in the mid-frequency range in order to create room 

in tracks or drum loops. This allows the addition of further instruments or vocals. 

 
 

Overview 
The preset filter settings are located in the top left of the dialog window. 
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The graphic shows you the frequency response curves of the individual curves. The left 
axis labeling shows the damping in -dB, while the upper axis labeling shows the 
frequencies in kHz. 

The parameters for stereo manipulation and the A/B/C buttons for quick switching 
between the three different settings are located to the right of this. 

 

General controls 
Preset: Select from a number of presets here. 

Save, load, delete: Save, load, and delete the various settings here. The preset file ending 
is: *.ste 

A/B/C comparison: To compare different dialog configurations, switch between three 
different settings here.  

Bass, mid, high: Set the three frequency ranges for stereo, panorama, and gain here (see 
below). 

Maximize: Use this controller to compress the sidechain signal, which also increases the 
stereo transparency without influencing the mono compatibility. In "Multiband" mode, this 
setting affects the middle bands. 

Solo mode: In "Solo" mode, frequency bands may be monitored one at a time. This 
simplifies the process of changing filter parameter settings. For example, isolate a specific 
frequency range of a mix and change the aspect of the stereo image for the range. 

Multiband mode: The algorithm works with three frequency bands if this option is 
checked.  "Multiband" mode is not automatically active when using the enhancer in the 
mixer master section,  which reduces the initial load on the CPU when selected in the 
master section. 

Direction pan mode: This switches between two panorama control modes: 

If the option is checked, only the mono portion (the center signal) is included when 
changing the panorama setting. The panorama control functions as a directional mix 
controller. A centered vocal recording may thereby be moved to the left or right of the 
stereo balance later. The difference containing the sound sources arranged outside of the 
center remains unchanged. 

When inactive, the panorama faders work as normal. The complete stereo signal is 
changed (mono and the remaining left and right portions). 

Phasecorrel. (phase correlator): This open the phase correlator. This option is very useful 
when "Solo" mode is active; the base width and panorama setting for each frequency band 
may be checked visually. 

Reset: This button resets all settings. 

Play/stop: Real-time preview function. 
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OK: The algorithm is applied to the selected range of the sample or the selected object. 
When using this in the master area of the mixer, the parameters of the dialog window are 
applied to the entire mix. 

Cancel: Click this button to close the dialog window without applying the effect. When 
using this in the master area of the mixer, the parameters of the dialog window will not be 
applied to the mix. 

Help: Opens the "Help" file. 

 

Parameters for stereo manipulation 
The following is available for each frequency band (bass, mids, highs): 

Base width controller: Set the base width between 0 and 200. 0 indicates "Mono", 100 
corresponds with unchanged base width (Stereo), and a value of 200 produces the 
maximum base width (difference signal). 

Depending on the correlation between left and right, the level may increase when reducing 
the base width. In more extreme cases, this may cause maximum correlation, which 
occurs when the left and right channels are identical. When the base width is set to zero 
(mono), a level increase of 3 dB will occur. 

Raising the bandwidth (values over 100) diminishes the mono compatibility. If the base 
width is reduced, mono compatibility will be maintained. 

Panorama controller: Adjust the individual channels of the panorama here. Dampening for 
left and right is displayed above the controller in dB. 

If the direction pan mode is active, the controllers operate as direction mixers. In this case, 
only the mono component (mid signal) will be included. 

 

Filter setting parameters 
Separation frequencies: Use these two sliders ("1" and "2") to adjust the separation 
frequencies of the three filter bands. The values are displayed in kHz (these correspond 
with the intersection of the neighboring frequency curves). 

Band separation: This parameter influences different filter properties to increase precision. 
Select between "Low", "Normal", and "High".  

Increasing the band separation setting has the following effect: 

 The edge steepness of the filter curves increases and the transition range between two 
bands decreases. 

 Dampening in the cut-off range increases (low setting: approx. 25-35 dB, normal: 
approx. 35-45 dB, high approx. 55-75 dB). 

 The ripple of the frequency range of the bands decreases.  However, this is not a 
problem, since the ripples of the individual filter bands compensate each other after 
combination, thanks to the complementary filter technology. In any case, the output 
signal will not contain ripples.  
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The multiband stereo enhancer in the master area of the mixer: 
Access the stereo enhancer in the master area of the mixer by pressing the "StE" button, 
which is  located above the master faders. Right click this button  to open the stereo 
enhancer dialog window. The knob next to this is connected to the base width controller 
for the mid band. 

If "Multiband" mode is not active in the dialog, the changes affect the entire signal. The 
knob functions as a standard base width fader. 

 

Stereo enhancer - tips & tricks 
General info concerning base width settings and standard use of the multiband 
stereo enhancer 

The human ear is generally incapable of perceiving frequencies below 300 Hz. Stereo 
effects in the bass range can be disruptive as different delay levels often result in 
cancellation, which becomes audible in spongy and squishy playback of the basses. 

The treble range may be important for directional ; however, spreading the base width 
often causes annoying side effects in this case. 

For these reasons, the base width is usually enlarged or the direction of a mono source is 
changed in a middle band. 

In the bass area, the base width is set to mono by default. Enlarging the base width is only 
useful for special applications. 

The treble band is maintained by the following standard applications and is not changed. 

Increasing the stereo base width 

For this task, set the basic width controller of the middle band to a higher value (between 
101 and 200). 

More powerful bass by reducing the base width in the bass range 

Set the base width controller of the bass band to mono. The setting of the lower separation 
frequency is also important for this task. Typical settings for this application are between 
300 and 600 Hz. If the separation frequencies are higher, narrowing in the stereograph will 
already be audible, depending on the properties of the audio material. 

Checking and correcting a completed mix in the stereograph 

To check and possibly correct the base width and the panorama setting in various 
frequency ranges, proceed for all three bands as follows: 
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1. Activate "Solo" mode. 
2. Open the phase correlator during real-time preview. 
3. The base width may be estimated according to the amplitude of the display. The 
horizontal amplitude increases in relation to the vertical amplitude as the base width 
increases. The panorama setting may be verified by the gradient of the display. The display 
tilts to the side of the stereo channel with the higher level. 
4. If necessary, correct each channel with the panorama and base width controllers. 

Positioning a mono source in the panorama (mix direction) 

The first step is to "filter out" the mono source (for example, vocals) so that the remaining 
part of the mix remains unaffected. 

1. Activate "Solo" mode in this case as well and select the solo switch for the mid band. 
2. Change both separation frequencies so that they just about pick up the source. 
3. Now activate "Direction pan" mode so that the panorama controller acts as a direction 
mixer. 
4. With the pan controller of the middle band, you may now position the mono source. The 
differential signal is retained. 
5. Deactivate "Solo" mode to hear the effect of this frequency-selective directional mix on 
the overall signal. 

Dampening or removing the mono signal from the middle frequency range 

For instance, if you want to create space for adding vocals or solo instruments in the 
middle range of playbacks and drum loops, cancel out or dampen the original mid signal in 
the mid range by enlarging the base width. 

As described above, attempt to "filter" out the mid signal well in "Solo" mode. The base 
width should then be set to the highest value (200) in the mid band. 

 

Invert Phase 
This function inverts the sample data within the selected range along the amplitude axis, 
i.e. the phase is inverted. Negative values are reversed to become positive values. 

This way enables customization of samples with differing phase lengths. The function may 
be reversed and applied using both channels, just the left, or just the right in wave projects. 
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Modulation/Special 
Convolution (Offline) 
This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File -> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

Using the convolution function you can mix a sample/object with any other sample. 

 

This means that the original sample will be filtered with the convolution sample: common 
overtones will be amplified, anything else will be softened. FFT Analysis Filter offers a similar 
method which filters a sample using a frequency sequence of another sample that has 
been saved to the clipboard. Thereby however only the frequency responses of two 
samples will be used. When mixed though the frequency response and the phase 
response are linked - which leads to noticeably different results with long samples. 

With the convolution algorithm you can create reverb, echo, filter effects, exotic morphing 
effects and refined sonic fusions made up of different sounds. This function works along 
the same principles as the Room Simulator function. However, convolution calculates the 
exact mathematical convolution function, whereas the Room Simulator is especially 
optimized for reverb calculation. 

Convolution sample: Here you can select the project with the convolution signal. If the 
convolution signal is longer than 1048576 samples, only the first 1048576 samples with be 
used. 

Original (%). This parameter allows you to enter the level (in percent) of the original audio 
signal that will be mixed with the result of the convolution. A value of 0% signifies that the 
edited signal will contain exclusively the result of the convolution function, and a 50% value 
will mean that the convolution result will be mixed with the original signal at equal 
amplitudes. 

Result (dB): This parameter sets the volume of the signal resulting from the convolution 
function in dB. With values exceeding -10dB, modulations can happen. For this reason, 
you should first select lower values. 

 

Convolution – problems and solutions 
After pressing the preview button or the OK button, the program does not seem 
to respond any more. 
On slower computers with long impulse responses, the algorithm responds after a certain 
amount of time with a status display message of the progress of the calculation as it works 
internally on a block-by-block basis. 
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The output signal is overmodulated 
Reduce the value of the "Results (dB)" parameter. 

The resulting signal contains a strong DC offset 
If possible, the convolution sample used should not contain any DC offset. If this is present, 
remove it via the corresponding "Remove DC offset (view page 672)" function. 

Heavy hard disk activity or an error message concerning insufficient memory is 
produced 
The algorithm requires ample memory, especially in case of long impulse response 
patterns. All background processes should be terminated and all RAM wave projects that 
are not needed should be closed. 

 

Vocoder 

 

The vocoder sends a carrier signal (e.g. a string instrument or a synth chord) through a 
modulator (e.g. speech or a song, or even drum loops) to make it seem as if the string 
instrument is speaking or singing. 

This is achieved by transmitting the modulator's frequency characteristics to the carrier. 
The modulator signal is divided into a number of frequency bands and apportioned 
positions at regular intervals in the respective frequency bands. These measurements 
control a filter for the carrier that correspond to the same frequency bands. 

Strictly speaking, a vocoder has two inputs and an output. Since Samplitude effects 
normally only feature one input, the carrier signal will be extracted within the effect to make 
it mixable with the white noise and any wave file. The carrier and modulator may also be 
swapped in order to use the vocoder input as the carrier. 

The vocoder also features a real-time FFT filter for editing the vocoder signal. 
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Filter curves 
The yellow line corresponds to the frequency progression of the modulator, and the light 
blue line represents the carrier signal. The red line is a freely-adjustable FFT filter. The 
frequency progression may be drawn to optimize the vocoder results. The dark blue line is 
the resulting filter curve of the vocoder. 

Reset: This resets the red filter curve to its initial state. 

 

Carrier signal 
Sample selection list: The desired carrier samples may be selected here. All open wave 
projects appear in the selection list as well as some special carrier samples that are loaded 
from the "Vocoder" directory. Preferred carrier samples consist of material with even 
frequencies e.g. orchestral chords, broad synthesizer sweeps, sound of the wind, etc. 

Sidechain: The sidechaining option is now available for the vocoder if the effect is used as 
a track or master effect and the track isn't the Surround master. 

 

Sample (dB): Use this fader to adjust the proportion of the carrier sample. 

Noise (dB): This controller mixes white noise into the carrier. This is especially useful if the 
carrier material can't be modulated well or sounds too uneven. Whispering voices may also 
be produced in this fashion. 

Volume (dB): Adjusts the vocoder output level. 

Vocoder - options 
Modulator <=> carrier: Swaps modulator and carrier signals. This is particularly useful if 
the "stereo channel as carrier" option is used. 

Stereo channel as carrier: If this option is active, the sample from the selection list will no 
longer be used as a carrier signal, but an input signal channel will be used instead. The 
other channel will continue as the modulator. 

This results in a more accurate synchronization of the carrier and the modulation signal, 
which is independent from play start. 
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Bypass: The "Bypass" button plays the original signal. 

 

Dynamic filter 
Response time (release): Affects the speed of the dynamic filter adjustment to the 
modulator spectrum. As the release value increases, the Vocoder follows the modulator 
slower and slower, and the sound changes sound softer and feature more reverb in the 
carrier. To improve the clarity of spoken words, this parameter should be set to a low 
value. 

Dynamic (reduction): This parameter affects the dynamics of the modulator signal for 
reducing the modulation depth of the dynamic filter. 

This prevents two often undesired side effects of modulation: on the one hand, the volume 
change of the modulator signal is added to the output signal in a slightly more moderate 
form, which may improve the power of the Vocoder voice. On the other hand, the low-level 
portions of the modulator signal are ignored in order to prevent modulation of the carrier by 
breathing or noise. 

Instead of using dynamic reduction within the Vocoder, you can adjust the modulator signal 
dynamics (or the resulting signals) with the dynamic tools integrated in Samplitude. 

Resolution (filter bands): Dynamic filter resolution (approximately dependant upon the 
number of filter bands). The best results are achieved with medium to high rates. 

Pitch (filter shift): The dynamic filter of the Vocoder shifts the frequency up or down to 
create certain pitch effects. For the clearest speech results, it is recommended not to 
change this parameter. 

Formant: Stretches the dynamic filter curves to manipulate the formants. This changes the 
characteristics of the Vocoder voice. 

Overlapping: This internal parameter changes the overlapping of the time window for the 
modulator signal spectrum calculation. 

On the "low" setting, the Vocoder sounds softer and more melodic, but some of the clarity 
of speech may be lost.   

 

eFX_Chorus/Flanger 

Detailed information on eFX_Chorus/Flanger can be found at "essential FX > 
Chorus/Flanger (view page 685)". 

 

eFX_Phaser 

Detailed information on eFX_Phaser can be found at "essential FX > Phaser (view page 
686)". 
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Corvex 
More information is available in "Effects -> MAGIX plug-ins (view page 698)". 

 

Backward 
With this function, the data of the sample in the wave project within the selected area/the 
selected object in the virtual project along the time axis is reversed so that it can be played 
from back to front. 

 

MIDI velocity dynamics 
MIDI Velocity Dynamics Settings… 
Detailed information about MIDI velocity dynamics settings is available in "MIDI editors -> 
Velocity dynamics MIDI functions (view page 255)". 

 

Apply MIDI Velocity Dynamics 
This command applies the current MIDI velocity dynamics settings to MIDI objects. 

 

Set MIDI Velocity to Fixed Value 
This command applies the current MIDI velocity dynamics settings next to the "Set value" 
button to selected MIDI objects. 

 

Randomize MIDI Velocity 
This command applies randomly varied MIDI velocity dynamics to selected MIDI objects. 

 

Sample manipulation 
Change Sample Rate... (Offline) 
Use this function to change the sample rate of a wave project. 

 

If the sample rate is increased, the change is almost completely without loss. However, the 
required memory space does increase. 

If, however, you reduce the sample rate, a loss in harmonics quality occurs. When halving 
the sample rate of a 44.1 kHz sample to 22.05 kHz, the frequency response of the 
resulting signal is limited to 11.025 kHz. The frequency response always corresponds to 
half of the sample rate. 

By clicking on "OK", you may enter the file name for the new project. 
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Quality 
Here you can specify, what quality Anti-aliasing filtering or Reconstruction filtering should 
take place when increasing or decreasing the sampling rate. 

Standard: At this quality level, a faster interpolation algorithm is used, which is also applied 
during real-time resampling. 

High: In addition to the "standard" quality level, a filter is set to dampen the alias 
frequencies or to improve the reconstruction (interpolation). When using extreme 
conversion ratios, such as converting from a 48 kHz signal to a 22.05 kHz signal, this 
setting may improve the results. 

Very high: In this case, the linear-phase UTR – "Ultra Transparent Resampling" 
algorithm is used. This is a relatively new resampling algorithm for considerably faster and 
even better linear-phase, high-quality resampling. The speed increase permits use of 
highest quality settings even in realtime use (object resampling) that were previously only 
available for offline processing in predecessor versions. The quality of offline resampling 
also benefits from the new algorithm, since calculation in higher quality stages is now even 
more precise. 

Extremely high 1: In addition to the "Very high" quality level, this algorithm works at a 
higher filter setting. Doing this increases CPU load dramatically. 

Extremely high 2: In addition to the "Very high" quality level, this algorithm works at a 
considerably higher filter setting. This setting is only meant for use with 32Bit float files 
because the maximum possible artifacts from aliasing are below 96 dB. 

 

Note: You can make sample rate adjustments during recording and playback. The quality 
of the resampling used here can be set in the "File > Program Preferences > Resampling 
Quality Options... (view page 502)". 

 

Sample data/2 
Every second sample is removed in the wave project. Once the function has been 
executed, you'll see that the highly frequent components of the audio data are missing. 
These have fallen victim to halving the memory requirements. If you execute this command 
at an original sample rate of 44.1 kHz, a new sample rate of 22.05 kHz will be added. The 
frequency range is halved with a sample rate of 0 - 22.05 kHz changing to 0-11.025 kHz. 

 

Sample data * 2 
Use this function to insert a new sample rate between two adjacent sample rates featuring 
a value average of the adjacent values. The sample rate is doubled in this case. This way, 
the sample rate may be adapted to one another. Please note that despite the higher 
sample rate, no new high-frequency components come about, the frequency range of the 
audio data remains the same. 
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Backward 
With this function, the data of the sample in the wave project within the selected area/the 
selected object in the virtual project along the time axis is reversed so that it can be played 
from back to front. 

 

Makes Loops (offline) 
With this function you can call up a complex algorithm for loop editing in wave projects.  

First, select a range that roughly shows the loop positions. If you have selected "Loop" in 
the transport window and move or edit the range on playback, you'll be able to find some 
good loop points. Select the "Range menu > Split range" view. Here, the sample is 
displayed in three sections.  

"Build Physical Loop" allows the borders of the range top be set to the precise crossover 
point of the sample in order to get loops without any crackling. Moreover a crossfade of 
the audio material at the loop end is performed with the audio material from the loop 
beginning, to ensure a smooth transition.  

If a marker is placed before the highlighted range, the range between the marker and range 
start will be used for the crossfade. Therefore you can also manipulate the length of the 
crossfade, like when sampling. If you move the marker close to the start of the range, you 
will get short crossfades, if the marker is placed far away from the start of the range, long 
crossfades will be the result.  

For a crossfade you should bear in mind that the distance between the marker and the 
range start cannot exceed the length of the range itself. 

 

Plug-Ins... 
Read more information about DirectX/VST plug-ins in "Mixer -> Buses and routing -> Effect 
routing/plug-ins dialog -> Effects sequence/plug-ins (view page 174)". 
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essentialFX 
Chorus/Flanger 
This plug-in offers a simple way to make signals sound more interesting, "spacier", thicker, 
etc. by modulating or delaying the pitch - the classical domain of application is for guitars, 
Hammond organs, electric pianos, or synths. 

Chorus and flanger are two closely related effects, which are combined into a single plug-
in. They normally differentiate in terms of delay time, type of modulation, and degree of 
internal feedback. 

 
 

Chorus flanger parameters 
mode: 

- Mono chorus: In this mode, the signal is fed through a delay unit and the pitch is 
modulated. Original and delay copy are mixed into a monophonic output signal. 

- Stereo chorus:  Compared to mono chorus, two copies of the original are created, 
modulated against each other, and then fed accordingly to the set mix ratio to the left and 
right output channel. 

- Mono Flanger & Stereo Flanger In contrast to the Chorus Effects the lower delay 
periods and a slightly changed modulation are processed. 

 rate: This specifies the speed of the modulation. Lower rates provide slight hovering 
effects, and high speeds produce a wobbling, typically distorted "underwater" sound. 
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 depth: This parameter specifies the depth of the modulation, i. e. the maximum 
deviation of the modulation and the resulting pitch bending. 

 feedback: This parameter defines the portion of the delay that is sent back to the input. 
Feedback causes the effects of modulation to be more drastic and cutting.  

Nullification of the feedback is set at the middle of the fader. Set to the right, the feedback 
is fed to the input equi-phasal; to the left, the feedback occurs. Both variants may sound 
very different depending on the signal, since they prefer different frequency ranges for 
dissonance. 

 mix: Regulates the mix ratio of the original signal and the delayed portion. 

 

Phaser 
The phaser is often mistaken for a flanger due to its typically sharper and cutting effect. In 
any case, the pitch is not modulated. Instead, the modulation process burrows multiple 
notches into the frequency response, somewhat like a comb filter. Just like an airplane 
taking off, the phaser functions with a similar jet effect. It is suitable for enduring signals like 
synth surfaces or for producing sound designs to create atmosphere or distortion effects. 

 
 

Phaser parameters 
mode: The selection includes a number of filter stages. At 4 stages/8 stages, a more 
plastic effect is achieved, and more complex patterns are reached at 16 stages. Please 
note that the more stages are involved, the more computing time will be needed. 

 rate: Speed of filter modulation. The essential effect is the same for both chorus and 
flanger. 
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 depth:  Similar to chorus/flanger, whereby it's the filter notches that are addressed, and 
not the pitch modulation. 

 feedback: The feedback portion produces a more drastic effect in this case. Similarly to 
the chorus/flanger, co-phasal or opposite-phase feedback is possible.  

 mix: Regulates the mix ratio of the original signal and the delayed portion.  

 

Reverb 
This involves a completely algorithmic reverb plug-in. Selectable algorithms produce thick 
and extremely transparent reverberation for all kinds of signals. Processing is therefore 
"true stereo", i. e. the selected algorithm includes the original localization of instruments in a 
stereo signal in the calculation of reverberation so that the das original image will not be 
distorted.  

"Reverb" features algorithms that are set up for natural quality and transparency. A signal 
treated with this reverb retains power at correct dosage in the overall context of the audio 
without perception of a conspicuous effect. The CPU load is also relatively low. 

 
 

Reverb parameters 
 Input (in)/Output (out): In this case, the input level is positioned on the plug-in or its 

output level. The metering precisely displays the level ratios.  

Note: Input/output is available for all preset essentialFX plug-ins. The conditions are always 
identical to the one described here. 

mode: Select the desired algorithm here. You have the choice of:  
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- Plate: Simulates a reverb plate. Very dense reflection pattern, penetrating but musically 
open "metallic" appeal. Very well suited to Drums and Vintage/special effects. 

- Room: Small room reverb. Middle to high signal diffusion, low to middle reverb time. Well 
suited for adding a "dry", natural sound to instrumental, spoken, or vocal recordings. 

- Hall: Mid to large hall. Low to mid diffusion, later response than a "Room". Ideal for 
simulating concert halls and larger soundscapes. 

 size:  The size of the room being simulated or of the reverb plate. This setting has a 
direct effect on the distance of the reflection and indirectly on the resonance behavior: 
smaller rooms/reverb plates possess a larger inclination for natural resonance than larger 
ones. 

 time:  Length of reverberation time (in seconds). This value refers to the RT60 time, i. e. 
how long the reverberation requires for the level to fall 60 dB. 

 damping:  Real rooms and reverb plates dampen certain frequencies according to their 
construction. This is most often audible in upper frequencies. Using this parameter you 
can set the cut-off frequency, above which the reverb will be particularly strong. In some 
cases, the "Time" parameter should be adjusted, since sometimes the subjectively 
perceived reverberation time will also be affected. 

 modulation:  For several critical signals, the reverberation may produce disturbing 
resonance. This can be scattered by temporal modulation of the delay signal used in an 
algorithm. Excessive application may create an effect similar to chorus in tonal signals. 
The liveliness of the reverberations will be emphasized with lower values. In this case, the 
modulation applies a random pattern, the intensity of which may be visualized via the 
"MOD" display.  

 mix: This regulates the ratio of the unprocessed signal to the portion including 
reverberation. 
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Stereo Delay 
The stereo delay is a simple too for typical bread and butter delay effects. The stereo delay 
offers the "analog algorithm", which features the sound of echo devices of yesteryear. 

 
 

Stereo delay parameters 
mode: This selects between the essential algorithms. 

 Digital: Normal, transparent delay 
 Analog: Simulation of a bucket brigade delay (BBD). These devices, which originate 

from the pre-digital era, used analog building blocks for storage. The signal was held for 
a short time in a relatively simple circuit and then moved on to the next. This "bucket 
brigade" principle created a longer signal delay. But since each element of the chain led 
to a loss of the signal and would increase the system noise with longer delays, the 
devices would use a compander: At the input, the signal's dynamics are compressed, 
and then they are expanded again at the output end. The simulation in the eFX_delay 
mimics the loss and compander behavior to produce these typical audio characteristics, 
especially at longer delay periods and higher repetition rates (feedback). 

 delay L/delay R: Specify the delay period for the left and right channels here. 
 tempo sync: If this button is active, the plug-in is directed at the host/sequencer tempo. 

In this mode, changes are made to the delay period via the L/R delay using the musical 
snap grid (e. g. 1/4 note). 

 damping: This specifies the cut-off frequency at which the highs are dampened during 
the delay. This useful for making the delays reverberate more naturally or for creating 
special effects (reggae/dub-style effects). 

 feedback: This parameter regulates the internal amplitude of the delayed signal that is 
fed back to the input. In "Digital" mode, this process is completely transparent; in 
"Analog", on the other hand, higher values, a very loud input signal, or the sum of these 
will make the use of dynamics compression audible. In both modes, the nullification of 
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the feedback parameter is in the center of the fader. To the right, the plug-in works in 
"Dual delay" mode (both sides work independently), and to the left, "Ping pong" mode 
will be activated (the delayed signal alternates between the left and right sides). 

 mix: Regulates the mix ratio of the original signal and the delayed portion. 
 

 

Compressor 
This plug-in is a simple but effective tool for reducing the dynamics of a signal. Percussion 
tracks may be modeled more compactly and with more pumping, vocals may be 
integrated into the mix better, or the entire sum or group or signals may be made denser. 

In contrast to some other plug-ins, this type works the compressor with a comparatively 
soft curve and an adaptable regulation process, it therefore compresses completely 
musically. Additionally a separate input (external sidechain signal) can be defined as the 
regulation source. 

 
 

Compressor Parameter 
Mode:  Select the input signal to be used for detection.  

Internal sidechain corresponds with conventional methods; this selects the actual input 
signal to control the compression process.  
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If another track in the project triggers the compression, select External sidechain here. 
This will use a second stereo track routed to the plug-in. Make the regular adjustments in 
the arrangement to route the sidechain signals. 

 sc filter: This fader determines the application/middle frequencies, that are filtered with 
the control signal for level detection. In many cases evaluating the detection is a good for 
optimizing the leveling process. So, for example "high-pass" filtering enables complex 
sources (drums or sum signals) to achieve consistent regulation without typical pumping 
artifacts, since the process is mainly activated via mids and highs.  

 Using the filter type switch the properties of the detector circle can be drastically 
changed. The speaker symbol is there to preview changes.  

 threshold:  This sets the response threshold for regulation. For example, -20 dB 
indicates that the input/sidechain signal is only compressed once it reaches -20 dB; 
below this level, no change or hardly any change will take place. Note that this plug-in 
deals with the threshold window independent of the program. It can be the case that a 
small regularization has already taken place at -25dB. This so-called soft-knee 
characteristic ensures a soft, musical compression process. 

 ratio:  This parameter regulates the compression ratio. For example, a value of 10:1 
means that when the threshold level is reached, the input level is increased by 10dB, 
while the output is only 1dB louder. A lower compression, e. g. 2:1, is recommended for 
subtle compression of group or sum signals, while 50:1 produces a very hard limiting 
that cannot be made inaudible by even the most transparent compressor. 

 attack/release: This parameter specifies how quickly the compressor responds when 
the threshold is reached (attack) or how quickly the signal applies normal amplitude once 
the signal drops below this level (release). The transient time settings can be defined in 
another area. Note that due to the adaptable plug-in leveling actual times may differ. This 
semi-automatic process favors quick adjustment, without leading to the often dreaded 
artifacts (rough sound image with rushed regulation, overly low/inefficient compression 
with long time constants). 
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Tube Stage 
Preamplifier are still used today, if the signal needs a warm, flattering sound. This is often 
not only about saturation or distortion artifacts, but rather more about getting a compact 
and more vivid sound picture. A tube stage makes things a little more dynamic, this is not 
due to the tubes itself, but rather the entire circuit, which interacts with the tube in a way 
that amplification levels don't do on a semiconducter basis. As with guitar amplifiers, the 
complexity increases with the number of stages. 

 

Optionally inside the eFX_TubeStage plug-in, either one or two tube stages work.  

Tube circuits, especially if they work in the border area and saturate/distort the signal, react 
very sensitively to the input signal's spectral composition.  

Two independent filter circuits accompany this plug-in's tube stage (s). The first (pre-eq) 
acts directly on the input signal. With this you can determine which frequency range should 
be principally edited. The second filter circuit (post-eq) is located behind the tube stage (or 
after the second) and determines the tonal balance of the output signal. 

This enables you to create various sound nuances. For example, you can accentuate the 
high frequency range on the input side, for example, to create Exciter-/Enhancer effects, so 
that the signal appears more "tangible". To avoid overemphasizing this amplified range, a 
reverse process with the post-EQ can be subsequently made. 

Both of the available tube stages can be globally switched in the A or AB operation. In the 
A-circuit the entire signal runs through, as is common with simple tube preamps, through a 
tube. However, since these can only edit a half-wave, the working point of the circuit is set 
approximately in the middle of the reference line. However neither halve will ever be treated 
equally, so that positive displacements are amplified differently to negative displacements. 
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(so-called Class A operation). Thereby odd and even harmonics are created. The typical 
'warm' tube sound to a large extent dates back to the characteristic overtone spectrum. 

For each half-wave in class-AB operation, a separate tube is used, so that in principle there 
is a symmetrical reinforcement. The signal contains predominantly uneven harmonics. The 
sound image appears thinner but more transparent and solid. This is comparable to the 
sound, that tape machines create when they are slightly overmodulated. 

 

Tube Stage Parameter 
stages: In signal section 1 the signal only passes through the tube stages. In the second 
stage two stages are cascaded. This divides up the gain so that both stages are driven 
less 'hotly'. This increases the signal complexity and any tube artifacts. 

class A / AB Optionally, a simple gain stage with asymmetric reference line (Class A) or 
symmetric AB mode. In the A-mode odd and even harmonics emerge, the sound image is 
similar to a 'warm' tube guitar amp. In the AB section only uneven harmonics are created. 
The sound image is somewhat 'colder', but more transparent with complex materials and 
can also be driven louder. 

oversampling: If this switch is active, the virtual tube stages are controlled with one-to 
four-times the project sampling rate,i.e with an internal sampling rate of 176 - 192kHz. 

pre-eq: This knob (called "Tilt" or "Level" on some devices) controls the effect of a soft, 
passive 6 dB filter for prefiltering signals before the (first) tube stage. If turned to the left the 
bass is emphasized and the highs are dampened. To the right the inverted filtering 
happens. With this filter the signal can be correspondingly processed before "Warming up" 
by selecting the prominent of desired section. Compared to a standard EQ the effect of this 
filter is more subtle, but it does possess a high 'musicality', by the internal circuitry and also 
because of the slightly different phase response. 

gain: This set the entire amplification factor. If two two tube stages are selected using 
'stages', the available Gain is divided by two and is distributed equally over both stages. 

post-eq: Operation and function like pre-eq, however, this filter is placed behind the 
(second) stage tube. 
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Gate 
The Gate is operated in much the same way as the eFX_Compressor. In particular, the 
side-chain function, and selecting various filter types can be also be applied here. 

 

The operation is similar to a classic analog gate. Here emphasis was placed on a fast and 
accurate response, where the typical artifacts such as rough, "flat" sounds are avoided by 
digital gates. The eFX_Gate continuously scans the signal and automatically selects optimal 
settings according to the current values. 

 

Gate parameter 
sc filter Works in the same way as the eFX_Compressor. 

sidechain int/ext: As with eFX_Compressor an external control input can be used for 
triggering. 

soft knee: Normally the Gate has a hard characteristic i. e. below the threshold this signal 
is markedly, in addition it is transmitted in an unchanged form. "Hard Knee" deals with 
abrupt transitions. "Soft Knee" however allows the signal to be modified by "Gating" in the 
pass and, so that transitions can be made to be more soft and undetectable. This is 
particularly recommendable for work with acoustic instruments such as drums where the 
signal levels can fluctuate a lot. 

hold: This three way switch controls the time, that the gate process waits after passing 
through the attack phase, before subsequently passing through the Release phase. The 
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Hold Function is useful for signals that need a rather short release time, but shouldn't be 
flattened out.  

threshold: This fader defines the threshold beneath which the gate should be initiated. 

range: Here you can set the Gating strength. Right extreme means that the signal beneath 
the threshold is cut out completely. Subtly attenuating the signal can remove background 
noises or breathing from vocal tracks. Where necessary the process can be attenuated 
even further by switching on the soft knee mode. 

attack: Regulates the attack time from the closed gate to the point at which signal is let 
through again. 

release: Sets the time, that the gate requires to go from a normal state to gating. 

 

Tremolo Pan 
This plug-in is on one hand a Tremolo, that creates typical textures for synths or vintage 
guitars. On the other hand you can create interesting, rhythmic stereo effects with auto 
panning. 

 
 

Tremolo Pan Parameter 
rate: Sets the speed of the internal oscillator in Hz or note value (see "tempo sync").  

shape: The left velocity of the fader corresponds to an oscillator's sine wave. The oscillator 
signal is gradually morphed  to the right in the direction of the rectangular wave. This 
makes the effect sound intense, "harder". 
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phase: This fader moves the right channel's oscillator phasing relative to the left, wave is 
put back to the right. So that the Tremolo effect drifts apart in the stereo field with ever 
increasing values. At 180° both oscillators work in reverse, therefore the stereo effect is at 
its strongest. 

depth: This determines the strength that the oscillator signal has on the Tremolo/Panning 
effects. 

tempo sync: when the switch is activated the "rate" fader snaps to values on the musical 
grid. 

 

DeEsser 
This plug-in filters/attenuates sibilants in vocal recordings in a simple yet effective way. 
Since the underlying process operates on the basis of a dynamic filter, other signals are 
weakened such as cymbals in drum recordings or other signals in a similar frequency 
range. 

 

The eFX_DeEsser works, in contrast to other devices without adjustable thresholds. The 
plug-in constantly evaluates the input signal and recognizes signal peaks that are high 
above in the frequency range of the average levels. Through this comparative analysis with 
the wanted signal, a constant reduction of noisy sections can be adhered to, so a 
traditional threshold often requires adjustments for changing levels. 
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DeEsser Parameters 
freq: Determines the frequency of the filter used for detection, and filter blocking in the 
signal route. Typically the sibilants in speech or singing voices are in the 6 - 8 kHz range. 

Speaker symbol (pre-listen): This allows you to hear the "solo" filter frequency so you can 
locate noisy sections quickly and easily. 

reduction: Regulates the filter attenuation in the signal route. 

 

Vocal Strip 
This plug-in combines several components in one special tool which is ideal for working 
with speech or vocal tracks. Virtually all recurring voice signal edits are integrated in a 
compact, simple interface. 

 

The signal flow is set by the e_FX_VocalStrip and is directly represented by the position of 
the fader. 

 

Vocal Strip Parameter 
highpass: This fader determines the cut-off frequency for a steeply sloped highpass filter 
(24dB/Octaves) to remove part with low frequencies, such as rumbling or noises created 
when touching the microphone. 

gate: With gate you can attenuate the signals that fall below the threshold. Here, a smooth 
curve and a maximum 'softening' of up to 24dB is used to avoid hard transitions. 
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DeEsser: The effect is very similar to that of the eFX_DeEsser. Here, however, the 
application frequency is set. The filter used in eFX_VocalStrip works in another range. The 
fader determines the degree of reduction. 

compression: For the most part, an eFX_Compressor component contributes to working 
parameters for optimizing voice recordings. The further the fader is turned the lower the 
threshold and higher the compression ratio. The Attack and Release times are selected 
according to the program.  

tone: This EQ corresponds principally to the filter network, which is also used in the 
eFX_TubeStage plug-in. With this you can simply and effectively calibrate the sonic balance 
of the voice signal, e. g. for better integration into the mix. 

 

MAGIX Plug-Ins 
Console 
When opened, all MAGIX plug-ins have a global display bar at the top for managing the 
presets as well as for further settings, called the "Console". 

 

A popup menu containing the current preset is located behind the display, thus enabling 
selection. Small up/down buttons for clicking through the presets are situated on the left. 

Presets can be loaded and saved in so-called programs or 
banks. These terms are VST-specific. Programs are individual 
presets while a bank contains the entire preset memory. 

For example, in accordance with the VST standard, you can change the entire memory of 
the plug-in by changing individual presets, replacing them with other saved ones, or saving 
the entire bank. 

 You can return individual presets to their initial settings by clicking the 
"Reset" button. 

 

Further Console Elements: 

 Bypass switch: Routes the signal directly to the output instead and 
bypasses processing. Internally, processing is continued so that you 
can toggle between processed and unprocessed material anytime. 

 A/B comparison: Very useful for trying out settings. The controller 
setting for "A" is normally activated when the interface is opened. 

Because this is the default state, "B" also contains the same settings. If you want to try out 
an alternative setting, simply press the "B" button: It contains the initial setting when 
opened. If you want to transfer the settings of "A" to "B" while testing, simply press the 
copy button between the two letters. 
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"?" button: This opens the online help for the plug-in. 

 

 

Parameter Smoothing 
Each plug-in offers soft controlling. Pot settings are softly faded internally from the old value 
to the new one. This is particularly noticeable when playing in "Live" mode. Due to 
performance reasons, switches (e.g. on/off) and some settings of VariVerb Pro that change 
delay times directly or indirectly are excluded from this action. 

 

Vpot Controls 
Some controllers snap to the middle setting, which may be useful for quickly returning to a 
"neutral" status. It is extremely difficult to adjust the fine settings within close proximity of 
this snap point. You can temporarily deactivate this snap mode by holding "Shift" before 
touching the controller. 

Use the mouse wheel to adjust the controllers. A combination of the mouse wheel and 
"Shift" key reduces the increase/decrease by factor ten. 

Apropos the controller movement, note that all plug-ins follow the host settings regarding 
linear or circular mouse movement.  You can usually choose whether you prefer up/down 
or a circular movement to adjust the value. 

 

Analog Modelling Suite: AM-Track 
Samplitude Pro X Suite 

 
 

AM-Track analogue modeling compressor & tape 
simulation 
"AM-Track" is a combination of an analog compressor and a tape simulator in a single 
device. The plug-in was developed for specifically editing and enhancing input signals 
(instruments, vocals). The audio signal may be enhanced and made more lively with a 
combination of compression and tape saturation in order to assert itself in the entire mix.  

An explanation of the compressor section of the AM-Track, its special advantages 
compared to "conventional" software compressors, and the available parameters follows. 
We will also explain the features of tape simulation. 
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Compressor Section 
Two completely different compressors work in AM-Track, each with their own independent 
control and sound methods. 

You may be wondering why we mention sound when talking about a compressor, since 
compressors merely relate to control actions. This isn't as simple as the idea of "making 
loud quiet".  

Various designs, algorithms, and topologies for solving the actual problem (dynamic 
reduction), which all have their own unique character, have come from the history of analog 
and digital signal processing. For example, pre-filtering in the detector circle and the type of 
detection have a large influence on the audio results. Plenty of hardware compressors have 
the same established VCAs (voltage controlled amplifier), but they all sound different and 
influence a signal, an entire production (or even a genre) with their "signature sound". We 
intend to provide you with acoustic variation via these dynamic tools in the digital world. 

The two operating modes of the AM-Track may be selected using the switch "vca/vintage": 

 

VCA Mode 

 

In VCA mode, the parameter selection and the circuitry design 
correspond to a modern compressor with a VCA element as the 
control circuit and a forward automatic gain control in the detector 
section ("feed-forward design", i.e. the controlling signal for level 
reduction is taken from the input signal). 

The typical basic sound for this category is accurate, largely neutral and, in relation to the 
adjustable parameters, easily predictable. 

In VCA mode, the control signal is accessed at the input where it firstly executes a 
controllable low-cut (which may be set up via  "detector hp freq" in "Expert" mode). The 
filter makes sure that deep-frequency signals have less influence on the adjustment 
settings; this is a popular trick for more power, e.g., when using drums in a sub-group.  
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The filtered signal then arrives at the detector. With the forward gain control, previously set 
parameters apply fully and affect the adjustment settings immediately. 

 

In contrast to this, there is a "feedback" method which provides a second compressor 
mode. 

 

VINTAGE Mode 

 

This mode appears as a preset when AM-Track is started. It 
has less parameters than the VCA mode and has audibly 
less of a "surgical" quality, but more of a trimmed sound 
character. 
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"Vintage" mode simulates a circuit design from the time when VCAs were not yet or could 
not be fully implemented. Instead, a FET (field effect transistor) was often used as a 
controllable resistor. This, together with constant resistance at the circuit's gate, builds a 
so-called voltage splitter, i.e. this forms a resistance change at the FET (caused by a 
change in voltage at its gate), which results in a damping of the input signal. A very simple 
detector circuit is used to activate the FET, which obtains its signal from the output of the 
compressor (behind the whole control circuit).For older designs, this feedback loop 
provides a stabilization of the work parameters and is one of the decisive factors for the 
often-quoted soft and musical compression of exponents of this design, e.g. the Urei 1176 
or 1178. The control circuit sees the layout of its previous work and oscillates to the signal. 

 

The disadvantage: The set time parameters for attack and release depend slightly on the 
program. In some cases, it's actually advantageous with vocals, bass, or even drums (e.g. 
subgroup, ambience, mics). You should rely completely on your ear for this. 

Because of the feedback topology, the maximum gain reduction is usually lower than VCA 
devices with forwards detection, usually 20 dB. This way, there is almost always a level-
matching amplifier in the feedback loop. The "drive" fader of the AM-Track regulates the 
so-called feedback amplification. This can be so high that the detector be saturated by a 
loud input signal, resulting in signal peaks being swallowed up. Simultaneously, the setting 
becomes more intense as quieter signals also start reaching the threshold. You can 
creatively implement this according to the situation to create complex signal compression, 
which doesn't much sound like dynamic compression due to the transients that slip 
through and release at high "drive" levels. 

The stated release of the signal, technically known as a ratio reduction, is also caused by 
the centerpiece of the circuitry: the FET. Level reduction works entirely as a function of its 
characteristic curve, resulting from the non-linear behavior of this element. The FET virtually 
comprises part of the input resistance of the compressor circuit. As a result, the 
input/output response curve does not create a plateau when "drive" is high, which would 
be the case for a reference line featuring a high ratio or even limiting. A saturated FET may 
no longer complete the job it was marked out to do, i.e. to keep its output at low Ohm 
values. Once again, signal peaks pass through the entire circuit unaffected, but the 
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average level may be compressed severely. From a technical point of view, the control 
process appears incomplete, but sounds pleasantly open and airy depending on its 
application.  

The entire detection is dependent on the spectral balance in the virtual AM-Track circuit, 
the highs are automatically less strongly compressed, so that even extreme settings sound 
less flat and more lively. 

It's the same story with deep bass. On closer listening, you'll find that with strong 
compression, the signal still retains its power, which would otherwise be lost if the envelope 
were to follow shortly afterwards. 

"Vintage" mode has another feature: the output of the compressor in the signal flow 
features an emulation of a transformer-coupled matching-level amplifier. This contributes to 
some subtle, non-linear distortions at high levels, but is very much frequency-dependent. 

 

Compression Parameters 
VCA Mode 
The regular set of parameters of dynamic compressors is available in this mode: 

 Threshold: The threshold above which dynamic reduction begins. 
 Check the threshold display if necessary (thr): If the input signal reaches the set 

threshold, the blue dash will move around the arrow symbols. If this dash moves 
upwards, the threshold is below the average level and compression is active. Inversely, if 
the dash moves below the marking, the input signal becomes too quiet to be able to 
reach the threshold; compression will be applied. 

 Ratio: This ratio (1:n) specifies by which factor the signal should be reduced once the 
threshold has been reached. For example, if the threshold is set to -20 dB and the ratio 
to 1:4, an input signal of -10 dB will only be amplified by 2.5 dB (10 dB : 4 = 2.5 dB). 

 Attack: This is the response time, e.g. how long the arrangement takes to execute the 
required level reduction. Short attack times intercept level peaks, and longer ones let 
them through unimpeded (compression only starts past this value). 

 Release: This is the time allocated to the circuit to reach the normal amplification factor. 

Note on attack & release: In general, short attacks are used for moderate compression 
and making the transient response softer; longer times retain the "bite" of a specific 
instrument at larger compression rates or make the sound a bit snappier. With more 
difficult sources, like a very dynamic vocal track (ballads), for example, you can use a 
longer attack so that the arrangement runs more smoothly and quietly; the release time 
may be trimmed audibly to match the pauses or the song speed. 

Shorter release time may be used for modern, aggressive "close up" vocals, e.g. when 
breathing sounds are an important stylistic device and the voice should sound very full and 
compact. 

 Knee: Use this parameter to specify the shape of the characteristic around the 
threshold. A "hard knee" means that the transition of 1:1 amplification for level reduction 
occurs abruptly; a "soft knee" on the other hand starts much lower than the threshold 
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and moves the characteristic softly into the reduction. A "hard" setting is useful for 
effect-filled, acoustic compression, e.g. individual drum tracks. A softer setting is useful 
for complex and sensitive sources like guitars, pianos, or vocals. The more complex the 
signal, the easier it will be to notice a difference. For less sensitive sources, this 
parameter is usually less important. Note that for "soft knee" settings, the "threshold" 
value will need to be re-adjusted, since the compression starts at a much lower level. 

 

Vintage Mode 
In this mode, you can intuitively (by ear) use the dynamic editing features with just three 
knobs. Do whatever you want, but keep in mind: less is sometimes more... 

 Drive: You can use the "drive" potentiometer to control the amplification factor in the 
feedback loop, i.e. the signal strength which the detection circuit calculates. 
Furthermore, the internal "ratio" changes within a limit, the more "drive" there is, the 
higher the compression ratio. 

 Attack and release: The same basic conditions as VCA mode apply here. However, not 
only do you change the actual control response time after detection, but the "temporal 
window" in the detector must be adjusted as well. Additionally, the feedback 
arrangement method does cause a certain amount of unpredictability. You should 
expect less control over the device in this mode, but more leniency on its part.  

 

Compression Expert Settings 
Of course, you can efficiently compress a lot of data with AM-Track without having to press 
the "Expert" button or try out additional options. However, we have added a few "handy" 
parameters behind the front panel. This applies equally to both compression modes. 

 

 Look ahead: AM-Track is always ahead of the signal. You can specify how many 
milliseconds you want to "look ahead". The audio signal path is delayed according to the 
signal route so that the detection circuit is fed first with the input signal (so-called "look-
ahead delay"). You can increase the attack time and still avoid fast peaks. The latency 
compensation in the host program ensures that other tracks in the arrangement are 
adjusted and that no time delay occurs. For percussive signals, you can even set the 
delay all the way to "0". 

 Detector hp filter: This high-cut filter is positioned before the two compressors' 
detection circuit. You can use it to specifically exclude basses and mids from these 
rules. Complex signals with bass and hi information like a subgroup or complete 
mixdown produce fewer "pumping" artifacts. This is because low-frequency signals 
feature the most power and therefore always trigger regulation and modulate other 
frequency ranges in the volume 

 Auto makeup gain: Normally, you have to continuously adjust level reduction to 
generate "compression" at the same maximum level. This is done by activating auto 
makeup gain. The volume difference expected from the set working parameters is 
determined and applied as an output factor after master regulation. If you prefer to 



 

E F F E C T S  M E N U  7 0 5   

adjust the "classic" level reduction and amplification manually, you can deactivate this 
function. 

 Adaptive release: This is "semi-automatic", i.e. you can roughly adjust the release time, 
and AM-Track reduces it according to the current signal power from "a little (1%)" to 
"considerably slower (100%)". In "Vintage" mode, this regulation method is particularly 
intense, since it affects the feedback loop process. For instance, if you are editing vocal 
tracks or dense, complex material, it can sound "calmer" or more "musical" if adaptive 
release is activated. 

 Capacity: Adjusting the "capacity" controller sets the time response of the "adaptive 
release". The greater the capacity, the more sluggish the release adjustment. You can 
therefore influence larger parts of the compensation response. For instance, if you want 
to use vocals that have been "moved forward", you should use a short release time 
(maybe 80-100 ms) and a greater value for semi-automatic (e.g. 80). Vice versa, you can 
reduce automatic feed by switching the relation (smaller capacity, generally greater 
release time). 

 Comp mix: Parallel compression is a popular "studio trick", particularly with complex 
material. Adding the original signal retains the transients and spectral balance of the 
source. You can add compression by turning the mix controller. A mixed signal is 
particularly discreet, more transparent, and less "squishy" with vocals, whereby the 
compressed portion usually has a higher level reduction than without adding the original. 

 

Tape Section 
The tape simulation in AM-Track comes after the compression section and offers you the 
opportunity to give your recordings an "analogue touch" by reproducing typical aspects of 
a tape recording. 

What also happens in this case is that the magnetic storage space of the tape becomes 
exhausted and the signal more distorted when the recording level is increased. There are 
other factors as well however, e.g. pre and de-emphasis. Since saving  on tape happens 
depending on the frequency, pre-emphasis makes sure the dynamic area is used to its full 
extent, according to a normed characteristic curve (e.g. NAB, EBU). This is because the 
signal cannot simply be transferred unfiltered at high levels onto the media via the recording 
head. The pre-filter creates a characteristic harmonic spectrum for possibly intended 
overmodulation by the user, which then changes according to the level of saturation. 

With the de-emphasis circuit, the pre-filter may be undone with an inverse characteristics 
curve on playback. However, distortion caused by tape saturation might shift the spectral 
balance. 

As a result of the enormous complexity of the process of magnetic recording, additional 
factors also influence the acoustic result, like, e.g. pre-magnetization (bias). This relates to 
high-frequency voltage swing (usually in sine form at 150 - 200 kHz) which is then applied 
to the tape via the erase head before the same part passes by the recording head a few 
centimeters later. This erasure current ensures the equal orientation of the magnetic 
particles and keeps the hysterisis loop intact, which is important for the magnetization 
process, and functions qualitatively. Low currents do have a brighter sound picture as a 
result, but magnetization is inefficient and the maximum recording level is therefore quite 
low. On the other hand, a bias current which is too high is associated with losses in highs, 
but does allow for higher levels with less distortion. 
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In addition, memory effects when recording tapes are responsible for a part of the 
characteristic sound, since time-dependent factors play a role in the feeding of the tape 
reel along the heads, e.g. mutual inductance and self-erasure. 

Regarding the simulation of these processes, we have concentrated on some aspects of 
the "real world" and have created a virtual "machine" in AM-Track, which permits the 
following interventions by using the controllers on the interface:  

 

 Level: Sets the input level. This determines when the "tape" is saturated and how strong 
the effect of the coloring/soiling is. You simultaneously gain more loudness. 

 EQ low/hi: Adjusts the frequency response (spectral balance controller). You can 
choose whether you would like to have an output signal of high bass level or whether it 
should have more highs. This alters the pre-emphasis at the "recording end" as well as 
playback equalization. In "Expert" mode, you can vary the employed frequencies for lows 
and highs for distortion and equalization. However, note that the frequency response for 
the simulation will not be neutral, even if the "EQ Low/Hi" controller is neutral. There will 
always be some slight frequency-selective amplification. 

 Bias: Moving the operation point (bias adjust). Increasing the bias will result in a higher 
"recording level", but tape saturation will occur sooner. You will also increase the above 
mentioned loss effects, and the result will be a (dynamic) reduction of the highs. Turning 
the bias controller to the left results in the opposite effect: the highs are not reduced, but 
the signal level stays lower. 

 Tape mix (in the "expert" section): Anything that applies to a parallel compression can 
also be applied to the tape section. Non-edited transients in particular are responsible 
for perceiving "speed", "liveliness" and "freedom", but may be lost in case of too much 
saturation/overdrive. Mixing in the original slightly enables you regulate the band quite far 
while still retaining the so-called attributes. 
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Tips for Applying Tape Simulation 
The harmonics generated during saturation can quickly cause a state of "acoustic fatigue" 
for the listener, particularly for high-frequency rich material and/or a frequency shift at the 
benefit of the highs. A direct 1:1 comparison with the tape section switched off reveals 
slight differences. Subtle settings are generally sufficient for complex signals in order to 
create a slightly "analog touch". 

Use the tape simulation as a "peak stop" if you use one of the two compressors to 
compress the signals: Transients that the compressor allows through (e.g. when using 
longer attack times) may be gently blocked by "taping" the signal afterwards.  

AM-Track also contains a soft clip circuit at the output to block overmodulation. The audio 
result is certainly not the same as tape saturation. In practice, the soft clip function stays 
switched on to provide an emergency brake, especially if the plug-in is in the last station of 
the master slot. The soft clipper limits the signal with a soft characteristic curve at -0.1 
dBFS. It's possible to switch off the function if you can predict good level responses or if 
the following stages in the mixer/master chain will not have a problem with higher levels. 

 

Analogue Modelling Suite: AM-Pulse 
Samplitude Pro X Suite 

 

AM-Pulse is a "transient modeller", a creative tool for editing envelope and sustain 
processes (attack and sustain) on percussive or dynamic signals. 

In particular, the input of the signal is an important factor in the acoustic perception. The 
so-called transients are extremely short oscillations in the make-up of a sound which 
enable the human ear to precisely differentiate sounds from one another and localize where 
they come from. 

Alongside transient modeling this effect also allows you to enhance the signal or even 
distort it. For this to work in the am-pulse, individual steps as "virtual hardware" have been 
set up and designed using elements of models and components "borrowed" from the 
analogue world in order to achieve smooth, organic operation with character. 

Possible instances where am-pulse can be used: 
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 Drums (e. g. kick, snare, toms, subgroup signal): Increasing or decreasing the attack 
leads to a harsher or softer sound respectively, while increasing or decreasing the 
sustain changes the room information with overheads or ambience tracks. 

 Acoustic or electric guitars and basses (accentuate or dampen the attack, e. g. for 
playing with a plectrum) 

 Balance volume fluctuations and explosive sounds for sound recordings 
 Sinking background noises 

 

Working Method of the Transient Section 
At first glance, it seems as if AM-Pulse has a dynamic compressor working "beneath the 
hood". However, this is not the case. In comparison to conventional compressors, AM-
Pulse is level-independent. For example, if you reduce the attack rate of a snare drum by 6 
dB, this is independent of how loud it was played. However, you have to determine a 
threshold as if for a compressor. No editing takes place below this threshold. 

The possibilities mentioned for using AM-Pulse are based on the principle of "transient 
recognition".  

AM-Pulse continuously analyses the input signal by means of so-called "envelope 
followers" that sample the time-based signal. At the attack and sustain phases, there are 
multiple envelope followers working which possess different attack and drop-out times. 
Attack and sustain can be safely recognized by means of continuous comparison 
measurements. 

Internally, the AM-Pulse uses virtual VCAs ("voltage controlled amplifiers") that generate a 
control voltage from the resulting envelopes. You can use the fader to apply its value to the 
attack and decay rate. This voltage may be applied via sliders. This multiplies the input 
signal via the control voltage (controller in positive direction) or divides the signal by the 
voltage (negative direction. 

Based on the principle of transient detection, the dynamic signals described above are 
especially well-suited for editing. The more percussive the audio signal, the cleaner and 
more predictable the control. 

 

Transient Section Parameters 

 

There are three faders on the front plate for processing attack and sustain: 
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 Level (left channel): An increase takes place above the line; moving the fader in the 
opposite direction reduces the level. The signal remains unaffected in the centre 
position. 

 Level (right channel): As above. Normally, both channel faders are coupled together by 
default (as are the internal "detectors"). You may edit the channels separately by 
depressing the button with the padlock symbol. The control voltages for both channels 
are then determined separately. 

 Length: This determines how long the signal is scanned and maintained in the 
respective section. A lower value results only in a short amplification or reduction which 
sounds quite electronic. Longer times mostly sound more homogenous. 

Note: High "length" values in the "attack" phase are especially in danger of being affected 
too strongly. The more complex the initial material, the more carefully "length" should be 
adjusted. 

 

Saturation and HF Details Section 
As a creative tool, AM-Pulse offers an adjustable saturation level and a "high-frequency 
details" module. 

Both sections are located within the circuit after transient processing. Modeled sounds can 
thereby be processed additionally. There are many ways to combine these three sections 
to create unique sounds. We will describe a few of these scenarios below. 

 

For hf details, exciter circuitry may be used to add artificial 
harmonics to signals at the set frequency. 

 

The saturation section works similar to a tube pre-amp. This 
features the typical "tube-like" volume compression behavior and 
"drives" the signal into saturation at high levels. The "saturation" 
controller mainly determines the input gain of the tube stage. When 
turned fully to the left, no saturation occurs and this section remains 
inactive. 

For the amplification of the signal, odd and even harmonics are created. The output signal 
first becomes louder and "richer". It becomes rougher and "dirtier" as the amplification 
increases, and finally sounds drastically distorted at an appropriately high input level. 

The saturation of the signal is frequency-selective in this case: how much has to be pre and 
post filtered depends on the setting of the "saturation" fader. The more "saturation" the 
higher the filtering and sound modification.  The internal degree of distortion is dependent 
on the setting of the level fader. 
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Use the mix fader to set how much of the processed signal is in the entire signal. 

 

Creative Tips for Working with AM-Pulse 
We have added a few presets to AM-Pulse for selection from the preset menu of the 
console. Several of these are ideal starting points for the following experiments: 

 Attack & sustain are often contrary processes. For example, if you would like to add 
more "bite" to electronic drums by accentuating the attack, experiment with reducing the 
sustain level. Both sections then often require less "drive" and the sound generally has 
far calmer effects than only one of the two sections, but at double the level. 

 To increase loudness, sounds with a lot of attack but a low average level may only be 
"tamed" with the saturation level. A few "saturation" dBs are usually sufficient. 

 Try to simulate several amplifier types: combine the transients and saturation section. 
With a slight reduction in attack (about 2-3 dB) and a slight saturation (maybe 6 dB), you 
can achieve results featuring soft signal edges, slightly increased loudness, and a bit 
more "life" in the signal. You could possibly add 1 - 2 dB "HF details". The result would 
then come very close to a tube amplifier. 

 If you would prefer slightly more filtering from the saturation section (the above-
mentioned "loudness") but less "crunch", move the "input" fader down slightly and 
increase the "saturation" controller correspondingly. Keep an eye on the peak meter in 
this case, too. Subtle changes already have a large influence on the overall impulse 
behavior of the signal and slight colorations can even be heard in the A/B comparison. 

 Set the attack and sustain of the left and right channels to opposite settings so that the 
signal "moves" in the stereo field according to its own transient data. This "auto panning" 
function even works with mono sources and is ideal for creating new and unique loops. 

 Drastic changes can be smoothed with the mix fader. Among other things, entirely new 
sounds can also be created. The result usually sounds different than a simply softened 
setting of the fader at 100% mix. For example, you can use sustain with acoustic drums 
to break out of the room, but keep the integrity of the recording with targeted mixing of 
the original. 
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Much like AM-Track, AM-Pulse contains a soft clip circuit at the output for making sure 
overmodulation doesn't occur. The method mentioned with AM-Track also applies here. 

 
 

Analog Modelling Suite: AM-Phibia 
Samplitude Pro X Suite 

 

AM-phibia is a tube amplifier/channel strip. It combines an optical compressor with a pre 
and post filter unit. By selecting the filter presets the suitable setting can be chosen 
depending on the input signal. While interacting with the compressor section am|phibia can 
be used as a vocals pre-amp, tube guitar amp or simply for creating a warm sound when 
mixing or mastering. 
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Typical examples applications of am-phibia: 

 an optical compressor (the classic LDR-based light sources are modeled) 
 a valve pre-amp 
 a sound pre-processor with corresponding EQ and compressor settings 
 valve guitar modeler with pre-amp, sound processor and case simulation 
 a signal processor for warm sound synthesis with all selectable valve settings 
 audio "mincer" 
 Audio refiner 
 Valve exciter 

Many application options can be selected from a comprehensive preset list. 

 

AM-Phibia - Signal Flow and Stages 
AM-Phibia – 1) Reverse phase, input pad, low-cut 

 

 

 

AM-Phibia – 2) optical compressor 

 

The compressor of AM-Phibia is 
one of the most gentle 
compressors available on the 
market and is ideal for difficult 
signals such as vocals. The 
fundamental circuit is an emulation 
of a classic opto-coupling design 
featuring a so-called feedback 
circuit. 

 

For this principle a light source (LED, light bulb, or electro-luminescent panel) is supplied 
the output signal. The emitted light is beamed onto a light-dependent resistor and changes 
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to the resistance result in a change in the amplification factor of the entire circuit 
(controllable voltage divider). The light source is fed from the output instead of the input 
due to historical, practical reasons: the circuit gently oscillates to the signal and is very 
stable without additional settings, and operates very musically so that in hardware reality, 
this type of device can be built with a minimum amount of required components (which 
improves sound quality). Due to the overall lag of the opto-coupling system, optical 
compressors have a relatively sluggish release reaction. This is accompanied by the so-
called memory effect of the opto-coupler.A longer exposure to light also means longer 
return times. Due to the feedback control, the control times and compression ratio also 
highly depend on the control times, and the compression ratio strongly depends on the 
input signal.  

Specify whether you want to tap the feedback signal after the gain stage or the second 
filter. Frequency-dependent compression can also be achieved in combination with the 
pre-filter stage. 

 

The compressor may also be 
switched between compression and 
limiter. 

Note that the ratio of program regulation depends on the program. 

 

AM-Phibia – 3) prefilter 
Different types of EQ are available. 
Each is treated as an independently 
structured circuit. 

- active A/B 
This is an emulation of an analog filter module that operates via positive and negative 
feedback loops. In this case, A and B differ from one another in terms of the input 
frequencies of the bands. B is optimized for use with speech or singing. 

- passive A/B 
This circuit corresponds with the classic Baxandall network and is comparable to stereo 
systems and some guitar amps. Type A and type B differ slightly; the bass and highs are 
spaced out further spectrally for type A, and the mid range is more extensive for type B. 
Variant A is intended for general applications, filter B is optimized for vocals. The mid range, 
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which is also available in this case, is not available in a Baxandall network and has been 
made possible in the existing circuitry as cascading low and high-pass sections, much like 
in common passive equalizers. The interesting thing about this setup is the effect the 
individual steps have on the entire phase response, which contributes to the unique sound 
of this circuitry. 

- guitar passive 
Classic switching such as on Marshall/Fender amps. These parameters are highly 
dependent on each other (more highs = less bass; mids are also influenced). Just like 
general "passive" switches, complex phases are also present in this case, a result of 
variable mixing of individual branches in the filter network and the typical charm of classical 
design. 

- guitar active 
A convertible partner for a typically "American" high gain sound. The parameters do not 
influence each other as much as the passive variant, although a slight amount of internal 
feedback is applied to give the circuit a bit more power. Of course, this also influences the 
phase response, which also provides its own character. 

- bass passive 
A full-tube Peavey bass pre-amp was the source of inspiration for this EQ (T. B. Raxx, 
similar to Alpha), with a circuit that resembles various Marshal/Fender styles. In this case 
however, the bass branch does not depend as strongly on the other settings, but a high 
level of interactivity is present. If the mids are "weakened", the sound turns quite "hollow", 
which is ideal for slap basses. 

- bass active 
Similar to "guitar active". In this case however, the corner frequencies are designed for 
bass guitars. 

 

AM-Phibia – 4) gain 

 

The heart of AM-Phibia is the gain level, an emulation of 
class A tube circuitry. Simply set the gain setting, and the 
"magic" happens inside; the frequency response changes, 
resulting in the right limit containing fewer highs. 

 

A small amount of make-up gain is used to automatically compensate the relatively high 
amplification factor, and typical valve-like distortions and harmonics occur at the upper end 
without becoming too loud. Normally, high-gain circuit simulations feature a weak spot at 
this high a degree of non-linearity, i.e. so-called "aliasing". Harmonics created by 
distortions ideally exceed the audible range. At a sample rate of e.g. 44 kHz, unpleasant 
artifacts can occur due to signal mirroring of the Nyquist frequency (22.5 kHz) in the 
audible range (without harmonic relation). This is particularly annoying in the case of 
distorted guitar sounds, e.g. if you "bend" at the 24th fret when playing solo and aliasing 
becomes apparent via bending in the opposite direction. For this reason, we always leave 
the internal sample rate of the gain stage between 176 and 192 kHz to minimize artifacts. 
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AM-Phibia – 5) postfilter 

 

This section only provides a low and 
high parameters; the cutoff frequency 
point of both may be adjusted, however 
(see "Expert view" below). 

- active 
The same parameters as the pre-filter stage, except that the mid band is missing. 

- passive cut 
Baxandall (cut) network similar to the pre-filter, but without mids. 

- exciter 
Amplifies the low and high frequency ranges via frequency-dependent saturation. The 
control elements mix the saturated part with the original, which is common with traditional 
exciters. Due to the additional harmonics created during saturation, the exciter circuit can 
sound very different than a conventional EQ in case important spectral ranges are not 
present. The bass range may also seem fuller due to the switching applied. Despite the 
immense sound possibilities,  use the exciter carefully, since the ear is fatigued by listening 
to this type of signal and due to the high energy density. 

- cab simulations 
These sound control networks are a departure from "official" EQ settings. The speaker 
cabinet simulations imitate the sound of classic speaker/case combinations familiar from 
conventional collections of guitarists and bass players. In line with the "analog by design 
theory" of AM-Phibia, we've also focused on switch-heavy interaction in this case. AM-
Phibia works with an armada of non-linear amplifier stages, filter circuits for frequency-
response changes, and complex phase-shifting processes. To begin with, we examined 
the sound of the speaker and how it becomes distorted depending on the levels, and we 
also studied its characteristic frequency responses in relation to its environment.This 
speaker emits direct sound from the front, while the back of the cone swings in the 
opposite direction so that the waves enter the cabinet phase-inverted. More sound-altering 
characteristics occur here: the sound is directed at the enclosure, partially absorbed (e.g. 
by insulation material), partially reflected, and mixed with the direct sound. Resonance 
effects such as bass reflex openings, static waves, return effects on the speaker, and so 
on, are also apparent here. We also added properties of typical models to our speakers 
such as bass reflex tubes in the signal transit time, which achieves a "typical" sound that 
would not be achievable with impulse responses alone. An important aspect in this case is 
the distortion created by the speaker at higher levels. 
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AM-Phibia – 6) volume 
Volume is compensated using a valve circuit that 
adds atmosphere. This circuit ensures that the 
output signal does not exceed 0 dB. 

 

AM-Phibia - Expert View 

 

Opening this view mode gives you even more opportunities for editing. Some decisive 
sound parameters of the device are accessible directly from here: 

- opto mem 
This changes how the optical coupling device addresses the compressor and thus the 
related memory effect. You can use the "opto-mem" controller to work directly with the 
parameters for the system latency and influence the degree of program dependency. 
Transients generally have less influence on controlling than longer signals. If set to 
minimum, the circuit will recover relatively fast. If set higher, the release time also increases 
according to the duration of a loud signal. 

- clipping   
This function controls the behavior of all tubes in AM-Phibia. Soft clipping (0) generates soft 
sound characteristics in overdrive. Hard clipping (100) creates a more global volume, 
although it may be high-pitched if handled incorrectly. If this setting is used with guitars, the 
sound of the entire device may change drastically, particularly in combination with 
distortion sounds. 

 

Guitar players can set this 
function correctly by using the 
volume controller of the guitar to 
control the distortion.  
You will thereby most likely find 
the optimal setting at the point 
where AM-Phibia harmonizes 
best with the input signal. 

With different sound sources, these experiments are less difficult and are worth trying out. 
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- character 
This controller works together with clipping and the gain button. Sometimes, however, this 
effect is very subtle, meaning that an immediate effect is not audible with all effects. If AM-
Phibia is used as a guitar amp simulator, the controller can determine most of the sound. 
"Character" only works on the tube bias (control voltage for regulating the electron flow 
within a tube). Capacity changes are also influenced by this reaction, since tubes feature a 
memory effect. This way you can observe a slight bass increase and more constant 
harmonies.  

 

A higher "character" value with loud and high bass signals can easily add "oomph", 
although there is a risk of the sound being rougher in lower ranges. Discreet use of 
moderate gain settings can sound similar to "transformer-linked" devices. 

- pre MF freq 
 This controller allows you to change the mid frequency of the pre-filter section. The 
available range is dependent on the underlying model 

- post LF/HF 
 These controls change the corner frequencies of all controls of the post-filter section 
(basses and highs). 
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Analog Modelling Suite: AM-Munition 
Samplitude Pro X Suite 

 

AM-Munition: compressor/limiter program 

 

AM-Munition is a compressor/limiter for spicing up the mix and giving it more kick. This 
mastering and dynamics tool makes the mix not only louder and adds definition, but can 
also be used as a limiter. In the process, transients are conserved and a compact, but 
nonetheless loud signal is delivered. This occurs via a relatively slow serial compression 
and a soft clipping for the stray level peaks; AM-Munition is sidechain-capable and can also 
be used for M/S processing. 

The AM-Munition plug-in is an extremely versatile, dynamic tool for editing groups or 
signal sums, especially in the area of mastering. It has separate units like compression, 
filtering, sidechain, limiter, and clipper. All modules and parameters are optimized to 
perform their fundamental functions without any compromises: effective enrichment of the 
program material without causing bothersome artifacts, a high maximum volume, and an 
"analog" behavior with an individual sound signature. This follows the maxim of allowing 
volume without distorting important transients. This is especially a problem with excessive 
use of the popular brickwall limiter. In fact, many digital limiters drastically increase the 
average level, but only at the cost of vitality of the sound, usually resulting in a fatigued 
audio effect. In drastic cases, snare hits are perceived as noise or hissing.  

AM-Munition attempts to maintain the attack during increased compression of material. In 
this manner, the plug-in also functions as a trick: the limiter level is slower than it would be 
otherwise. Those transients which occur will be blocked in a multi-step soft clipping unit 
upon output. This clipper works frequency-oriented to enable a relatively high signal level 
already "solo", without sounding unpleasantly distorted. With the proper settings the 
combination of limiting and clipping results in a livelier sound with more punch and 
character. 
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AM-Munition appears inconvenient and complex compared to other traditional dynamics 
tools at first. However, with its combination of available steps, modes, and parameters, the 
plug-in offers creative flexibility and provides a powerful tool in the hands of ambitious 
sound engineers. 

 

Overview of AM-Munition 

 

AM-Munition is composed of the following sections: 

Mode: The basic functionality of the plug-in is specified here. The normal mode is "stereo", 
meaning the input signal is entered on 2 channels (left and right) to the sidechain and 
thereby to the control circuit. In M/S mode, however, encoding the stereo signal will be 
carried out in parts as "center" (left and right) and "side" (left-right, differential signal). After 
this, both parts are sent to the sidechain. The functionality of M/S mode is exceptionally 
well suited to compression of material from the pop and dance genres, where bass 
sources are commonly positioned in the center of the stereo field. Normal compression in 
stereo mode will always produce modulation or "pumping", since the bass drum or the 
bass line reduces the total volume with its own energy. However, the division of the signal 
into center and side information merely makes a stronger modulation in a different range of 
the stereo field more noticeable. 

OPTICAL COMPRESSOR: The heart of AM-Munition is made up of two compressor units 
which are indicated by "1" and "2". Depending on the selected mode, you can edit the left 
and right or the center and side signals. The compressors are based upon a very detail-
oriented modeling of an optoelectrical circuit. The principle in this case is very simple: the 
input signal (Side Chain) is used to control a light source. The simulated light hits a photo 
resistor (LDR, light dependent resistor), which produces changes in resistance depending 
upon changes in brightness. These in turn directly affect the input resistance of the 
compressor switching. One could say that the signal source is its own volume 
potentiometer. In this case, the important factors are system capacity (light source, its 
controls, and the applied photo resistance) and memory effects.Amazingly, circuits based 
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on this principle sound very musical and open, and they are well suited for the compression 
of program material, provided the actions are not supposed to happen too quickly. 

Besides controlling the light source to achieve a specific reference line and envelope curve, 
AM-Munition compressors enable the ratio of the input signal to edited signal to be mixed. 
This parallel compression offers far-reaching possibilities for the subtle compression of 
signals. Because a part of the control circuit is bypassed, important transients of the signal 
spectral information are maintained. The compressed portion can often be output in depth 
simultaneously. 

Both optical compressor units offer the possibility to restrict the frequency response to a 
particular output. In this case, a combination of high and low pass as well as shelving filters 
come into play. For example, filtering is useful for editing the side signals of basses and 
lower mids in M/S mode (keyword: vinyl cutting) or for restricting the cymbals of the 
percussion to the edge of the stereo field. 

SIDECHAIN: As mentioned earlier, the sidechain signal is responsible for what the 
compressor sees. The sidechain value is usually a smoothed mid value of the input or a 
peak. By editing the frequency response of this signal, the relationship of the entire 
compressor circuit changes rapidly. For example, basses which are filtered out in the 
sidechain can maintain controllers against unwanted pump artifacts, and in the ideal case 
this also increases the volume in bass heavy pieces. 

A mix of output signal at the plug-in and an external source offers additional possibilities for 
sound production, especially during a mastering session when single groups are being 
edited. 

MASTER: The master section features one of the most important circuits of the plug-in for 
sound compression and volume enhancement: the limiter. As is the case with the input, 
this is combined at the output with a soft clip stage. This makes a fast reaction time or 
even a look-ahead unnecessary. At the same time, a skilled choice of limiter thresholds 
produces an airy, natural, fundamental sound, even under difficult conditions and high level 
reduction. Similar to the sidechain filter of the regular compressors, the limiter also provides 
the possibility to remove low frequency signals from the controllers. 

The limiter switch in AM-Munition works in two stages (see switch image). The first stage 
has the primary task of extracting an envelope from the input signal. This is transferred to 
the second stage in place of the actual signal, which in turn forms its own envelope. Both 
stages work with different parameters and provide different perceptions of the signal. 
Furthermore, the first step may be switched between forwards and reverse detection. This 
cooperation between the stages makes a very exact temporal image of the amplification 
process possible, especially in difficult situations featuring bass-rich signals, which should 
normally be compensated for, but produce disturbing inter-modulation noise with regular 
limiters. 

The limiter circuit connects the clipping stage, which is composed of two serial units. The 
first forms a dual-band clipper together with a 2-way frequency-separating filter. The 
advantage of separated clipping of basses and highs (mids, too) is a higher achievable 
loudness with fewer perceivable disturbances in comparison to broadband disturbances. 
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This sort of disturbing intermodulation and roughening of the complete sound image may 
be reduced, especially with clearly-defined bass material. 

The applied frequency filter is modeled on the Linkwitz-Riley filter (4th order, 24dB/Octave, 
Butterworth characteristic), which is often found in speaker construction. This produces an 
adequately sharp separation of bands and ensures an exact phase length as the bands are 
combined at the output. The complete phase shift of the 2-band clipping stage amounts to 
360 degrees. This should be monitored when AM-Munition is used parallel to other tracks. 

Clipping at this stage and the broadband which follows at the output has an adjustable 
intensity (see "Config" page below). 

The second clipping stage (output end) provides the output's safeguard, and this may be 
used "solo" for creative intervention. 

The clipping at both stages may be set without stages from hard to soft overmodulation. 
This makes a complete series of "analog" sounding combinations possible. 

MONITOR section: The individual compressors (1 and 2) or those of the sidechain may be 
set to the sum for selective monitoring ("solo"). This makes it possible to adjust the level of 
signals being edited so that in active "match" state the volume complies with the volume of 
the unedited bypass signal. This will produce a psycho-acoustic phenomenon: louder 
signals sound better and can be realistically and easily checked to see if the quality of 
signal being edited is still in tact apart from volume increase. 

Metering: The center of this plug-in interface features several level displays. Among those 
are two VUs, two peak meters, and two stereo meters. 

Both of the outer VU meters display the effects of the main compressors when set to the 
"reduction" position. The centrally placed displays visualize the value of the reduction 
caused by the master limiter. When set to "output", all four level displays show the output; 
the VU meters provide the present RMS value (root/mean/square, average level), while the 
peak displays measure peaks. 

A 0 dB reference value may be set for the RMS value. This is always useful if you would like 
to have a clear view of the average level. For example, to produce a song or an album with 
an RMS of -11 dBFS (a rather conservative value when one considers current chart 
productions, but lower headroom always has a destructive effect). In this case, you would 
set the "RMS 0 dB ref" controller to "-11 dbFS". If you place the metering switch of the 
output level to "output" for monitoring, the VU meters will show the displacement of -11 
dB. If you read -4, then the RMS level is actually at -15 dB. 

Both of the stereo meters are very useful for determining the range of the finally decoded 
stereo image and for comparing it to the unedited input signal in M/S mode. 
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AM-Munition Parameters 
MODE 
M/S/stereo: Selects functionality; 2-channel stereo or middle/side encoded. 

Link: At 0%, both portions of the signal will be treated discreetly by the sidechain (L/R or 
M/S). 100% complies with that of a mono summation of the detector signal. Middle and 
high values are sensible for complex signals, which sometimes show deflection to the side 
of the stereo field. 

The settings of this controller affect compressor 1 and 2 and the limiter in the master 
section. 

OPTICAL COMPRESSOR 
Threshold: This controller defines the threshold at which compression occurs. From a 
technical standpoint, you control (in contrast to the fader) the signal strength used to 
activate the virtual light source with this value. The exact trigger point of the threshold is 
dependent upon the selected compression reference point and internal parameters. For 
more exact control of this threshold, the VU meters can be set to "reduction". 

Output: This parameter is useful for gain increase at high level reduction. We recommend 
setting the output so that the resulting level matches that of the disabled compressor level. 

Slope: This parameter is like the "ratio" when compared to a regular compressor. This is 
not, however, completely correct. In this case, the compression reference point is 
influenced so that the result is a softer reference point for lower values and higher values 
cause limiting or over-compression. Set at maximum, the reference point of lower 
threshold/higher input level even goes a little lower, instead of remaining at a limiter plateau. 
This is one of AM-Munition's specialties and is well suited for compression of percussion 
subgroups, e.g. when room features are supposed to stand out. 

 

The slope controller does not change the reference point itself, but rather the way that 
transients are processed. Set to the minimum position, the compressors will operate in 
"feedback" mode, i.e. the input of the detector switch will be fed from the compressor 
output. This controller works fairly softly and transparently and gauges the signal gently, 
since existing deflections from the envelope are also included. The resulting reference line 
is therefore always quite mild.  
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The more the slope fader is set to the right, the more portions of the signal will be drawn 
into the compressor input. In this way, the controller combines "feed-forward" and 
"feedback". The leads to a higher weighting of the transients to produce an aggressive 
reference line. 

We generally recommend a slope setting in the lower third of the fader for a less 
conspicuous transparent compression. 

Response: The switching principle employed here provides musically sensible control 
times via selection of the "light source" and "photo resistance" system components. The 
combination of these components determines the shortest possible tune-in and tune-out 
times. With the response controller, the transient time may be extended to a wide range, 
since it's as if the image processing time is extended. A variation on this parameter will 
certainly have an influence on the complete functionality of the photo resistor, especially on 
"memory" effects. In this case, the current energy level of the program material decides the 
actual transient time of the compressor. 

Comp mix: Input responsive parallel compression is possible with this controller. This is 
best adjusted to produce the highest sound transparency together with high level 
reduction. Any possible compression artifacts are skillfully masked to bypass portions of 
the signal, and important signal peaks and tuning-in processes of instruments can occur 
unhindered. 

Filter (high-pass/low-pass or shelving filter): The filter switch on the output of the 
compressor unit sets a higher or lower frequency spectrum limit on the signal. For instance, 
this is useful in "M/S" mode, for filtering basses in the side signal, which otherwise 
unnecessarily reduce signal volume and would even lead to problems with phasing of 
stereo sources during vinyl mastering. 

Both filters have gated characteristics (high or low-pass) on their outer ends, and these 
change by altering the cut-off frequency increasingly in a shelving curve with maximum 12 
dB reduction. This results in relatively soft filtering that is ideal for basic corrections to the 
spectral balance. 

Controls (key symbol): Connects corresponding controllers of both compressors and is 
useful in "Stereo" mode.  Separation in "M/S" mode should be deactivated when settings 
on the filters or output controller are adjusted, e.g. to filter out bass signals from the side 
signal or to set the width of the bass 

SIDECHAIN 
Level: This controller allows fine adjustments to be made to the external signal. An 
adjacent level may be monitored with the peak meter. 

Source: Adjusts the mix ratio between the program and an external signal. This mix forms 
the sidechain signal evaluated by the compression circuit. 

Note: To enable external sidechaining, please ensure that "Sidechain input" in the menu 
bar of the plug-in window is activated and that the relevant source is routed to this 
additional bus (stereo). 
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Sidechain filter: Describes the functionality of both controllers for the filter switch in 
relation to the filter network in the compressors. By limiting this the frequency field, the 
ranges may be excluded from detection or weighted less. 

MASTER 
Output: AM-Munition's final output level. Make sure that the soft-clipping switch is located 
at the final stage of the output. The function is to block signal peaks passed on by the 
limiter. 

We mentioned at the beginning that the philosophy of AM-Munition's sound signature is 
based in part on the division of work between limiters and clippers. For high signal 
volumes, the qualitative results are dependent on threshold and output values. A high 
signal level at the output will inevitably be bound with a high portion of clipped signal 
peaks. As the case may be, please use the "clip" display to monitor this. This displays the 
difference between clipped and unclipped signals. The higher the display level, the more 
clipping results. 

Threshold: This parameter defines the threshold for the limiter on the one hand, and also 
increases the output level after successful level reduction ("auto-makeup gain"). This 
corresponds with the conventional operation of brickwall limiters, since only a few 
parameters are needed for quick, targeted loudness. 

Release: Sets the return time of the limiter until the controller achieves the output point 
after falling below the threshold. Note that some kind of program automation monitors the 
signal independent of the set value. For this reason, you will not find any exact controller 
times (e.g. milliseconds). The value entered could be understood roughly as the circuit 
direction. Lower values provide a very fast control response time and weight the program 
automation quite lightly, while higher values produce increased interaction between both of 
the limiter's detector stages and participating envelopes. 

Sidechain filter (high-pass symbol): For difficult tasks during the compression of material, 
for instance with pop or dance productions, it's often useful to reduce bass segments or 
remove them completely. In this way, pumping produced by the limiters can be avoided. 
The sidechain filter of the limiter can be increased in two steps for this. In this case, always 
ensure that the bass range is not subject to limiting like the remaining frequency range; the 
clipping stage needs to intervene and limit the signal as required. 

MONITOR 
Solo: By pressing buttons 1 or 2, one or both of the compressor outputs will be sent to the 
monitor line. In this way, you can bypass the master section on the one hand, and watch 
over the effects of the compressors on the other. This can be very important when working 
in M/S mode. 

The sidechain may be monitored via "SC1" or "SC2" as required. 

Match bypass: A tool for increasing volume is useful for audio projects, since things 
usually sound better when they are louder. In order to properly determine whether your 
material has retained its own quality after these processing stages, it is important to carry 
out a volume comparison with the unedited bypass portion. The "match" button is provided 
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for this purpose. This works together with the corresponding controller as a signal 
dampener. 

Since the match function lies at the final position of the signal path, you can obviously also 
use it to remove audio material with a lower level than that defined by the output clipper as 
0 dbFS via the plug-in. 

 

AM-Munition CONFIG 
Click the "Config" button to access additional AM-Munition parameters. 

 

The regular compressor view will be hidden and a separate display will appear. This 
alternative view shows a series of settings on the right which have a global effect on the 
plug-in (independent of the selected preset): 

Peak-hold time: The displays for output/gain reduction, clipping as well as extreme 
sidechain levels possess memory for top values to display the maximum values. Specify 
the holding period of the top value with this controller. After this time elapses, the peak hold 
display will fall, provided no higher value exists. 

Mouse mode: Normally, AM-Munition is set according to the host's settings in terms of 
how the mouse pointer moves and how controls are executed. You can make these 
settings explicit. The list features a horizontal/vertical and circular mode. 

Mouse wheel inc/dec: Use the scroll wheel of the mouse to make direct changes to 
wheels and sliders. Parameters allow the intensity of the value change to be determined by 
moving the wheel. 

Peak/limit meter range: This setting determines the display range of the output peak 
meter, or the level reduction of the limiter (depending on the position of the "GR/Output" 
circuit). 

The remaining area of the configuration page is reserved for preset-based options: 
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Highpass filter @ input: At the plug-in's input, there is a high-pass filter with variable cut-
off frequency and edge steepness. Especially for mastering applications, this can take over 
the tasks of "cleaning up" the signal before additional processing and filtering out low-
frequency sections which aren't required or could possibly cause overmodulation/reduction 
of the signal's maximum loudness. 

The filter applied features Butterworth characteristics (q=0.707) and may be switched from 
2nd order to 4th, 6th, or 8th order. 

For exact filter settings, we recommend working with subwoofers in good spatial-acoustic 
conditions. 

The following options involve fine settings in the master section: 

Limiter 
Detection (feed forward <> feed back: Limiter switching may be set without stages, 
whether the signal envelopes are to be gained directly from the input signal (forward), or 
whether they are drawn from existing amplitude process generated control voltage (feed 
back). The latter approach often creates a calmer, more balanced sound image and 
weights transients higher than slower signal sections. The resulting threshold of the limiter 
will be simultaneously rounded off a little more (soft-knee). This usually causes a slightly 
reduced total volume. Generally, the sound image in "forward mode" is a little more direct 
and gripping. Sometimes, however, the effects are quite subtle, and in some 
circumstances, these are only perceivable when levels are reduced substantially. 

Attack time: Normally, a limiter should feature an extremely fast response time. For "look 
ahead" circuits that work with delay in the signal path, the attack time may be relatively 
long versus the delay, supplying the limiter with enough room to work correctly. With a 
"zero-latency" design like ours, on the other hand, it basically has to be assumed that the 
limiter does not get any time at all to adjust. Theoretically, it has to be infinitely fast. 

AM-Munition utilizes the cooperation of limiting and clipping. The clipper blocks that at the 
output which the limiter lets through to signal's transient response. Sometimes, the attack 
time can be accordingly generous. Lower values of less than 5 ms are available if small 
level changes need to be smoothed out. Larger values, for instance percussion, may be 
placed at the forefront of the total signal in contrast to complete instruments or groups. For 
example, with an adequately long attack time, a snare can maintain its punch in a complex 
signal and the complete sound can be kept loud and compact. Conventional applications 
include harder rock or metal productions (a clipper at the output is a better partner than a 
brickwall limiter anyway, since a limiter tends to consume important transients). The 
combination applied in AM-Munition, on the other hand, is able to transform amplitude 
energy into spectral energy. 

Dual-band clip stage 
Crossover frequency: This parameter defines the separation frequency at which the signal 
separates into a bass or higher range. 

Upper-band/lower-band saturation: When this controller is set to the minimum setting, a 
hard clipping sound will result as full overdrive is achieved. A high degree of additional 
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overtones/harmonics will appear at the clipping threshold. Below this level, the sound 
image will remain completely neutral. 

Larger values of this parameter produce softer clipping or saturation of the signal. Initially, 
this highlights only even numbered, lower-order harmonics (mainly so-called "k3" 
harmonics). For example, a sine pattern of 1 kHz is added to an overtone of 3 kHz and 
lower amplitude. At 100% saturation, the overtone spectrum is quite similar to that of 
analog reel-to-reel machines, if driven via saturation of the tape as with full overdrive at the 
limit. 

Output clip stage 
This also enables the balance between hard clipping and softer saturation to be fine tuned. 

Auto gain: This function increases the total level prior to the output by 3 dB, depending on 
the clipping settings. This is influenced by the softer saturation characteristic, the maximum 
of which is normally already reached prior to complete overdrive, although in this case, this 
value is raised by this amount to provide the maximum amount of headroom. Without "auto 
gain", loudness will increase as a result of the changed overtone spectrum if the absolute 
level remains the same. 

If "auto gain" is active, this level increase will be avoided and consistent loudness is 
achieved independent of the saturation curve. In this case, the input of the clipper is 
lowered by the expected level gain at the output to reproduce a "consistent ratio". This is 
especially useful for the dual-band clipper, since duplicate saturation of the signal without 
damping may sound overdriven. 

The "auto gain" function therefore ensures a certain degree of room in case additional 
overtones are generated. 
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CORVEX – chorus/flanger 

 

When referring to the chorus and the flanger effects in CORVEX, we aren't discussing only 
one of the two effects, but also the variations between them that go beyond the standard 
concept. 

A chorus generates the typical "floating" sound as known from guitar sounds or synthesizer 
pads. You can add acoustic "depth" to an instrument to add more power to the sound or 
to create the illusion that multiple instances of it are present. 

The chorus sound is created via the so-called Doppler effect. You've probably noticed this 
phenomenon in everyday life: the sound of an approaching ambulance sounds higher than 
when it is moving away. This effect is a result of the speed of the sound which first 
increases and then decreases, thus also changing the sound pitch. The wave length also 
changes relative to the frequency. If there were a second siren at your location, an 
oscillation would develop between both sounds (just like when two instruments are out of 
tune). 

Chorus also splits the signal into at least two components: a direct sound and an effects 
portion, and there are multiple effects components in CORVEX. 

The Doppler effect is created by a short signal delay from the effect. For most equipment, 
this delay is within the range of 10-30 ms (as in this one), this means that it is short enough 
to be perceived as an "echo". The times would also be similarly short if you duplicated a 
guitar track, for instance. A short delay in the mix already sounds "duplicated", but this is 
not authentic. This is where the above-mentioned "out-of-tune" effect comes in: the pitch 
of the effect signal is slightly modulated by gently "drifting" forward and backward in the 
delay curve. The result is a floating effect where the speed is influenced by drifting. 

The "Flange" effect is similar to that of the chorus, but does have a different technical and 
historical background. It resulted by chance: someone (various sources say John Lennon) 
slowed down one of two running interconnected tape machines in a studio with his hand. 
The result was a rather brief delay of the second signal compared to the first, brought 
about cancellations within the frequency spectrum, leading to a so-called comb filter effect 
(the sum of both signals creates "peaks" and "dips" in the spectrum that look familiar to the 
teeth of a comb). 

Flanging is basically a chorus effect with a low delay time (less than 10 ms). "Release" or 
doubling of signals is not the main focus in this case; more creative deformation of the 
frequency response is what we are interested in. 
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A complete flange effect will definitely require feedback: the flange portion is returned to the 
input to increase the effect. People often refer to this as the "jet effect" since it resembles a 
jet on take-off. 

 

CORVEX Parameters 
Delay/Modulation Section 

 

Time: Specify the delay time to set 
whether you want a chorus or flanger 
sound. For the flanger, delay times are 
usually between 1 – 10 ms, since in this 
case, the typical comb filter artifacts 
usually lie within the audible frequency 
area (frequency = 1/delay in ms). For the 
chorus effect, values of 20 - 40 ms are 
normal.  

It is debatable what the actual correct delay times are. However, we don't advise you to 
conform to any strict standards. Just let your ear decide. 

Voices: Use this to set how many internal voices the effect should contain. Two to max. 
eight delay units can be activated here. With more than two voices, the sound becomes 
fuller and fatter. Uneven voices (1, 3, 5, 7) are assigned to the left channel, even voices (2, 
4, 6, 8) to the right. Subsequent elements such as the filter and diffusion units also count 
as part of these voices/delay units. Note that an increase in the number of voices will cause 
increased processor load. 

Span: The time of each delay unit activated per "voices" may be changed with this 
controller. Example: the "time" controller is used to set 10 ms and select four voices. 
"Span" set to 50% would mean that voice 2 would be delayed by 15 ms, voice 3 by 20 ms 
and voice 4 by 25 ms. . For example, you can break up the resonance by increasing the 
"span" value at high feedback rates or break apart the sound field at large stereo width. 

The modulation depth. The depth or intensity may be adjusted here using the small fader 
below "time". You should notice one of the most important properties of these three effects 
here: the small faders on the lower row on the front plate features the same value. These 
are basically modulation targets. If the modulation target of the LFO is applied as the "time" 
fader, this sets the depth of the pitch shift. 

At max, the amplitude is at its largest; in the minimum position, the effect remains static. 
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Modulation speed: The rate of 
modulation. Slow times create a quiet 
beat; high speeds sound like vibrato or, 
in extreme cases, like it's under water. 
The type of modulation may be selected 
using the buttons. 

Waveform selection: sine, square (sqre) and random (rand) are available. The sine wave is 
suitable for rhythmic, quiet sounds. A square wave sounds quite drastic and very rhythmic. 
Random mode is useful for ambient sounds or sound landscapes, since the progressions 
are not foreseeable and can add an interesting accent to the sound. 

The sync button snaps the speed to the song tempo. Alternately, you can set the 
modulation tempo manually in Hz. 

Tone/Filter Section 

 

The low and high-pass filters limit the signal for each voice/delay unit. 

Feedback: Set how strongly the signal in each unit is fed back to itself here. High values 
produce a typical, cutting flanger sound. What makes CORVEX stand out from many other 
digital devices is that high feedback rates will not create overmodulation. For each delay 
unit, the signal is fed at a saturation level to create a soft, analog-sounding threshold. 

Diffusion: This is one of the most interesting parameters of CORVEX, and it's rather 
unusual for this type of effect. Normally, larger delays are audible as discreet echoes. Using 
"diffusion" softens the signal in each voice, scattering its shape. In extreme cases and with 
sufficiently high "time" values, even reverb-like sounds are produced. This enables a small 
room to be replicated using "time", "voices" & "span", and "diffusion" can be applied to 
simulate the natural properties of scattering signals over surfaces. With high feedback 
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values, simply modulate the pitch a little (the small controller below "time") to break up the 
creation of comb artifacts resulting from static repetitions. 

Complex: Usually each voice pairing functions in "PingPong" mode, i.e. the left channel is 
reflected to the right and vice-versa. In "Complex" mode, the feedback & diffusion 
parameters are combined, which produces a quite chaotic sound. In "Complex" mode, 
each one of the eight possible voices affects every other one, i.e. echo repetitions ensure 
that diffusion is even faster. In this case, the maximum number of voices make drastic 
spatial sounds possible. For this reason, CORVEX even manages to eclipse some 
specialized reverb effects... 

After this overview of the main parameters, we still need to explain the other small 
controllers on the lower row.  

As mentioned above, this involves an intensity setting for the modulation depth: each of 
these faders specifies how much LFO affects the relevant parameter above it. 

The following applies: 

 The envelope of the LFO affects the "time" parameter directly, meaning that activation of 
the round LED in the modulation section results in increased delay times. 

 The LFO also affects all other parameters to the right directly. To the left, the inverse 
value of the modulation envelope is taken. For example, if you have selected "sine" as 
the waveform, the inverse curve shape will correspond to a sine wave which is mirrored 
along the X-axis. In practice, this results in a temporal modulation shift of exactly half of 
one period length.  

Basically, the modulation values combine with the settings of the main controller. For 
example, to get a rhythmic stereo width introduction, set the stereo width control to 0%. 
Switch on "sync", adjust the "speed" to "1/4", and set the small fader for the modulation 
target (stereo width) to the right. This opens the stereo picture to maximum every fourth 
note. Now turn the small controller below "stereo width" to the left: the stereo picture now 
plays on the off beats. This is where the inverse envelope is effective and the mentioned 
temporal shift is kept intact. 

Use the exact same method to modify the other modulation targets and get sounds out of 
CORVEX that a normal chorus or flanger wouldn't be capable of. We've created a few 
presets that use heavy modulation to quickly get things cooking... 

 



 

E F F E C T S  M E N U  7 3 3   

ECOX – Echo/Delay 
This delay provides a creative playing style that's different from common delay effects.  

 

On playback, change the delay times without creating scratchy digital artifacts. Instead, the 
times are faded out softly, similar to the old tape echo machines or bucket-brigade circuits 
that used the tape speed to change the delay and when the system was also slightly 
sluggish. 

ECOX can reproduce this type of sound relatively easily, and includes tracking fluctuations 
and loss of highs during each feedback in tape echoes, since these are essentially always 
present. 

Like the CORVEX, the internal feedback features a dual-band filter (low and high-cut) for 
creating dark, light, or mid repetitions (depending on the settings). 

A particular characteristic of ECOX is that the delay cannot be distorted "digitally". Even in 
a "looped" repetition, the signal cannot be distorted indefinitely, but it may be compressed 
by an increasingly slight degree and distorted like a tape. 
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ECOX - Delay Time 

 

left + right: The delay times can be 
adjusted separately for left and 
right. Use the "synced" settings to 
select the note value which the 
controller should snap to. The 
same note values may be selected 
as in CORVEX. You can also leave 
out "sync" and specify free delay 
times in milliseconds. 

 

Link button (lock symbol): Press 
this button to change both 
channels simultaneously with a 
delay knob. The link function also 
affects the two modulation depth 
faders in this section.  

The "sync" button beneath it affects the display of the delay time of the left and right 
channel in the bar grid. 

 

ECOX - Modulation Section 

 

The same features may be 
selected as with CORVEX. The 
same conditions apply as those 
mentioned above to change the 
pitch modulation. 
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ECOX - Feedback Path 

 

Filter section, feedback, diffusion, stereo width: see CORVEX 

ECOX also includes some pretty wacky presets in addition to the regular ones, just to 
prove how much this echo device is capable of - be creative... 

 

FILTOX – Multimode Filter 

 

Much like CORVEX and ECOX, FILTOX is also a "modulation effect". In this case, 
everything relates to frequency response deflection: a modulation source controls two filter 
units. Possible areas of application are synthesizer sounds (filter sweeps on pads) or 
creative distortions in drum loops (e.g. for variations, fills, etc). With guitars, you can create 
typical "wah" effects: either by tempo modulation or in a special mode, i.e. modulation via 
the signal envelope curve. 

The "core" of FILTOX is a stereo multimode filter based on an analog model (Chamberlin 2-
pole filter), which is also known as an "Oberheim" filter. With FILTOX, two of these modules 
were cascaded per channel to achieve a switchable 24 dB slew rate. 

Our digital model of the filter is designed so that it delivers the typical "analog" sound 
character, but it's also useful if you want to apply internal overmodulation. In this case, 
interaction occurs between the cut-off frequency and resonance, which makes the sound 
seem "undigital". 

 

FILTOX – Parameters 
The following filter types are available: 



 

7 3 6  E F F E C T S  M E N U   

 Low-pass 
 Band-pass 
 Notch 
 High-pass 

 

Usually, these filter types are designed so that they are able to 
be toggled. However, a "state-variable" network is used with 
the Chamberlin filter, which means that all filter types can be 
taken from "taps" simultaneously. So why leave these taps 
static when they can be processed dynamically...? 

The actual filter circuit provides the following parameters: 

 Cut-off frequency (freq) 
 Resonance (reso) 
 Internal saturation (drive) 

 
The filter can be set up separately or together with the link 
button. 

You can set up the cut-off frequency or the resonance for each channel as modulation 
targets. Just like with CORVEX and ECOX, the small knobs on the lower row specify the 
modulation level. 

For the modulation source, in general the same applies as with the previously mentioned 
effects. In addition, FILTOX provides the modulation of the filter section via an envelope 
follower. In this case, the input signal itself serves as the modulator. This makes it possible 
to produce well-known "auto wah" sounds. 

To use this envelope follower mode, 
proceed as follows: 

 In the modulation section, press 
the "env" button. 

 The two small "gain" controllers on 
the bottom help customize the 
input level for setting the envelope. 
The LEDs at the top no longer 
show the LFO speed, but rather 
indicate the set sensitivity visually. 

 Usually, the sensitivity is controlled so that signal peaks activate the LEDs more brightly. 
If gain is set too low, you'd have to set the knobs unnecessarily high for the modulation 
targets. If input levels are too high, the behavior will not be noticeable. Additionally, the 
problem of overmodulation arises when the detector circuitry of the envelope follower 
leads to inaccurate tracking as a result of saturation. This tracking is also influenced by 
the following parameters: 
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 "Speed left & right" controller: These set the LFO speed. In "Envelope" mode, these 
may be used to set the attack & release of the envelope for each channel. This means 
that minimum speed settings can cause a quick increase of the envelope to produce 
quick modulation access. Since attack & release are coupled settings, quick attacks 
correspond to short release values. This way, the control voltage for the filter drops more 
quickly than at middle or slower settings. 

 You should adapt the speed as precisely as possible to the signal. Times that are too 
short can cause errors in tracking and fluctuations, while times that are too long will miss 
short signal peaks. Internally, however, the detector works semi-automatically for release 
time, so that the setting is less critical than with a purely manual method.  

 The lock symbol in the modulation section has a special meaning in envelope mode: 
once active, both channels are linked together for detection so that panning effects may 
be based on different controller settings, and not because of a stereophonic input signal. 

 

VariVerb Pro 
With VariVerb Pro (VARIable  reVERB) Samplitude offers you a virtual effect device with 
high quality hall algorithms to lend your recordings depth and space. Unlike the Samplitude 
room simulator the created reverb is not based on impulse responses but is calculated in 
"traditional" manner based on a complex reflection pattern and different software models.  

The benefit of an algorithmic reverb such as VariVerb Pro is that you can influence different 
parameters and design the room impression as you like. Furthermore, many effects such 
as modulation or nonlinear amplification, cannot be realized with convolution, and this 
proves the value of algorithmic processes. The sound coloring of this conventional reverb 
generation in particular are an interesting aspect with regard to the aesthetic of sound. 
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VariVerb - Algorithms 

 

The algorithms in VariVerb Pro specialize in a 
specific type of room creation that may be 
selected from the list of "models" in the display: 

 Room A: Small to medium-sized room, 
dampening of the low frequencies, immediate 
response, high density/diffusion. 

 Room B: Room similar to A, less dampening, 
slightly different reflection pattern, response is 
slightly slower. 

 Hall A: Larger hall, slower reverb buildup, less 
density than the "rooms". 

 Hall B: Similar to Hall A, but features later 
response of the reflection, slightly "colder" 
sound, and less diffusion. 

 Retro room: Classic room effect in the style 
of well-known hardware reverb devices from 
the 80s/90s. More artificial algorithms than 
the previous methods. The vintage/retro 
character takes center stage here, definitely 
an "effect" sound. 

 

 Retro hall: Type of creation similar to retro room, but a classic reverb effect with the 
corresponding reflection pattern. Thick, cloud-like reverberation tail. 

 Plate A: Classic reverb plate, high diffusion, quite "dark" and "heavy", slight panorama 
effects. 

 Plate B: Reverb plate similar to A but with lighter character, faster response, more 
resonance, increased vintage character. 

 NonLin gate: Non-linear reverb, no sustain, but abrupt end instead (classic "gated" 
reverb effect). 

 NonLin reverse: Reverb with reversed amplitude, sound impression played such as 
"backwards". 

 Spring A: Model of a reverb spiral featuring two linked spring systems, typical echo 
effects and excitation noise. 

 Spring B: Similar to spring A, but the vibration is more balanced. 
 HQ room A/B & hall A/B: Extremely high-quality and very complex simulation, but 

subject to high processor strain. Nevertheless, or maybe because of this, it's the 
definitive main reverb algorithm. Very sculpted, tangible room impression featuring free 
positioning of the sound source and the listening location. In this case, the A and B 
models differ slightly from one another like in the regular room and hall algorithms, i.e. 
HQ room A provides somewhat different dimensions and different composition than B. 
With the HQ halls, hall B communicates with A later and sounds slightly more complex. 

The individual models and available parameters are described further below. 
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VariVerb - Overview of Details 
When you open VariVerb for the first time, the device will open in a kind of "Easy" mode. 

 

The Display is the core of VariVerb, since this visualizes the available parameters, their 
current values, and a graphical visualization of the reverberated envelope. 

The preset list is located above the device interface in the console, where you will find the 
typical settings for various everyday studio work tasks. 

 

For general AUX routing, there is a 
separate category featuring all 
models available in a "default" 
setting. This section can be used to 
design reverb (if you want to start 
from scratch). The mixing ratio is 
preset to 100%. 
 

 

The controller for the mix ratio is 
located on the right of the main 
interface (direct signal and reverb 
portion). 

To the left, the "test" section and a "mute" button are provided. 

 
You can use these to temporarily switch off the input 
signal during longer reverb decay periods, i.e. if you want 
to judge the resonating reverb precisely. 

 

On the other hand, a muted input can be useful for more 
complex room design using the test samples: these allow 
acoustic evaluation and fine tuning of the reverb effect 
using three samples: stick (sidestick), snap (finger snap), 
and vocal (short vocal sample).  
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 A "Zoom" controller is located at the top left corner. You 
can use it to evaluate the initial reverb phase. Larger 
zoom steps represent the first milliseconds, and for room 
and hall models, these also indicate the most important 
initial reflections. 

 

The controllers for the actual reverb parameters are 
located below the display. Only the most important ones 
are accessible first, such as room size and reverb sustain. 

You can perform more drastic manipulation by clicking the "Expert" button above the 
preset list. 

 
If you hold the "Expert" setting, VariVerb Pro presents all 
accessible parameters for the model it is based on. 

 

In "Expert" mode, the distances for the room & hall 
models of the first eight reflections are displayed. The set 
"size" and pre-delay are already included. These are 
combined left-right values for a better overview. 

 

Individual parameters of a model are displayed as a "tooltip" if you hover the mouse pointer 
over a controller. You can deactivate these tips with the same button in the display, globally 
if desired. 

 

This state will be saved and is independent of the preset or the current audio project. 

The following concentrates on the available algorithmic models and focuses on the 
individual parameters. Some apply to several models, in which case they are only referred 
to once. 

 

Room & Hall 
The four available room models (room A/B & hall A/B) are quite complex. Unlike the simple 
digital process, reverberation created by VariVerb Pro is not simply produced by adding the 
echoes. Simple systems do not consider that real rooms compress echoes with increasing 
reverb duration. VariVerb Pro uses a network of reflections that very closely resemble 
natural processes. 

The most important settings have already been set without opening "Expert" mode. To 
make things complete, we will list all available parameters here: 
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 EQ low/high: Allows you to "pre-filter" the signal before adding reverb. The filters have 
shelving characteristics. The trigger frequencies vary according to the model type. 

 Predelay: Determines the delay time for the actual reverb process. This parameter is 
ideal for fine tuning in order to convey a feeling of "distance" or "isolation". 

 Size: Determines the room size. Moving the slider to the left means the smallest size, 
moving it to the right extends the reflection times. Smaller "Size" settings also reduce the 
distance between the individual reflections. Resonance may also develop due to the 
short temporal distance between them. Increasing the size of the room creates more 
space,but this also means that the so-called "modal density" decreases, i.e. more time 
will pass before the impression of a confined room develops. 

 Diffusion: With this parameter, you can simulate diffusion on irregular walls and objects. 
The higher the value, the softer and fuller the reverb sounds. 

 ER absorption: VariVerb calculates 16 initial reflections (compiled to 8 in the display). 
This controller lets you specify how broadly the last ones are weighted. A lower value 
results in a more "lively" sound impression, although this may also have a more intrusive 
or unsettled effect. A higher degree of absorption indicates a smaller amplitude as well 
as damping of highs. 

 ER tail: The mixing ratio for the early reflections and subsequent reverberation. These 
reverberations are decisive for perception of the room size. Mixing them into the actual 
reverb improves the possibility of locating voices or instruments. Missing reflections at 
the start often result in "spongy" sound characteristics without orientation in "room" and 
"depth". 

 Decay: The reverberation time. Use this controller to define how fast the reverb tail will 
be absorbed, i.e. the time for the reverb to ring out. Turning this knob to the left 
minimizes the time, you might only hear the first reflections. Turning the knob to the right 
minimizes damping and results in long, sustained reverberation. 

 High freq: The threshold where the "high damp" effect starts. 
 High damp: Allows you to influence the frequency-dependent absorption of the reverb. 

A higher value dampens the highs and upper mids similar to the absorption effect of the 
air and in particular the material composition of walls. 

 Width: Specifies the width of the stereo effect. If set to left, the reverb is monaural. 

 

Plate 
A real plate reverb consists of a large metal plate (often 0.5 to 1 m² or more), that is 
activated by a magnet and coil system (similar to a loudspeaker). The plate is normally 
hung on springs so that it is able to oscillate freely. Various types of damping are possible 
to reduce the reverb time. The reverb plate features so-called "taps" at various locations. 
These are sound pickups similar to those on a guitar. Several of these taps are combined 
to produce a full signal. Reverb plates are usually mono, i.e. a stereo signal is added to the 
plate as a sum. A (pseudo-)stereophonic signal is created by combining taps and their 
position on the plate. 

Real reverb plates are only rarely used today and have been almost entirely replaced by 
software simulation. The sound continues to be very popular due to the very dense sound 
(high diffusion) and inaudible discreet echoes. They are therefore ideal for percussive 
material. In case of vocals, a plate reverb generates a smooth, warm effect. The slightly 
"metallic" resonance of a plate can also be used to generate a vintage effect. 
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Parameter: 

 EQ low/high: See room/hall 
 Pre-delay: See room/hall 
 Size: Size of the virtual reverb plate 
 Buildup: Low values result in a fast reverb increase. If the value is greater, the activation 

phase also increases. 
 Decay: Reverberation time, see room/hall 
 Damp freq/damping: See room/hall 
 Width: See room/hall 
 Modulation: Slightly alters the pitch by automatically varying the internal delay times, 

comparable to a chorus effect. This can reduce possible resonance; however, 
depending on the material (e.g. vocals or piano) it can have a negative effect on pitch 
modulation. 

 

Retro 
As already indicated above, VariVerb Pro also features vintage-like algorithms in addition to 
realistic synthesis, which is used by many well-known manufacturers until today. The used 
processes already have the highest-possible "dispersion" at the start of the reverb phase 
and generate a dense, wide sound. This is anything but realistic, since discreet reflections 
are mainly perceived as flat echoes. This sound is usually ideal for breakthrough power and 
foreground effects. In the past, various manufacturers have attempted to tackle very brief 
repeat loops and static patterns resulting from insufficient memory. An interference occurs 
in this case that also adds charm to this algorithm. 

 

NonLin 
These (non-linear) models are the only ones without a real counterpart in VariVerb Pro. 
Non-linear reverb is based on a sequence of individual delay blocks (so-called bursts). By 
weighting these blocks, you can create envelopes. Two of these typical envelopes are 
"nonlin gate" and "nonlin reverse". These may be set as follows: 

 EQ low/high: See room/hall 
 Pre-delay: See room/hall 
 Size: The size of the individual "bursts" i.e. the length of the total reverb in the sum. 
 Diffusion: Reverb smoothing effect. The greater the value, the more echo blocks are 

blurred and the more reverb occurs. 
 Width: See room/hall 

Please note that no decay parameter exists for these models, i.e. there is no "decay". 
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Spring 
You may be familiar with reverb spirals from guitar and keyboard amplifiers. At the bottom 
of these amps, a unit consisting of two to four spirals is mounted on a vibration-free 
carriage. Like the reverb plate, this uses systems for transforming the electric signal into a 
mechanical one and the other way around. There are different designs and sizes of spring 
reverb; however, they all have the same quite peculiar sound: the typical "bloing" sound 
when the springs are moved, similar to splashing. When the reverb dies away, the basic 
pitch of the spring(s) can usually be heard quite clearly. Furthermore, the frequency range is 
limited due to the losses in the spirals and used pick-up/transmitter. Nevertheless, or 
maybe for this reason, the sound is special. Some music styles such as dub & reggae 
would hardly be possible without reverb. 

The spring reverb is implemented in VariVerb Pro as a digital effect based on so-called 
"physical modeling" algorithms. Based on a mass-spring system, the effect operates similar 
to the physical model of a swinging string.  

Parameter: 

 EQ low/high: See room/hall 
 Pre-delay: See room/hall 
 Size: Size of the spring system, i.e. length of the springs. A smaller value results in a very 

short response time and short echoes, greater values slightly spread the typical 
"oscillation" of the spring. The length of echoes is increased. 

 Decay: Decay length. Please note that unlike the room/reverb and plate models, an 
echo effect remains if the decay times are longer. This corresponds with the natural 
characteristic of a spring, since these continue move during the release phase. 

 Saturation: The spring models also include the processes when "outputting" the signal 
and "receiving" it via the magnet/coil system. The transfer of electrical energy into 
mechanical power and vice versa is non-linear so that (harmonic) distortions may occur if 
the input level is quite high. The saturation parameter more or less increases the output 
volume and switches the system into "saturation". Depending on the material, a very 
interesting organic effect occurs which highlights the vintage character. 

 

HQ (high-quality) models (Room A/B & Hall A/B) 
The above-described room and reverb algorithms are of high quality, very versatile and 
require particularly low CPU power. If you want even more realistic and higher quality 
spaces and the load on your CPU less important, take a look at the HQ modules. These 
simulate a room with rare plasticity and naturalness, almost as if impulse responses were 
the basis. But they are not; VariVerb Pro features an armada of delays and filter stages that 
may require extra processing time, but they are still very useful. 

In comparison to other modules these algorithms cast a far closer meshed net over the 
virtual room. The results are natural, fast diffusion of the signal, a high complexity of the 
reverb signal without echo pattern, and the possibility to freely position the two virtual 
microphones. 

If the HQ rooms are opened in "Expert" mode, you will notice that editing for the first 
reflections is missing. The reason: in normal modules, the artistic and sound manipulating 
effect is in the foreground. A natural room, however, does not differentiate between early 
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and late reflections. These migrate in time. The proportion of first reflections depends on 
the position of the audience. 

In "HQ" mode, a reflection pattern and entire sound impression including stereo positioning 
may be edited via a top view of the selected room. In "Expert" view, the usual section with 
the reverb sustain moves to the right and makes room for viewing from above. 

 

This includes freely positionable 
handles for sound sources ("L" and 
"R") as well as two microphones ("L 
mic" and "R mic"). For instance, if 
you increase the distance between 
the source and the microphone 
("near/far"), you will hear the signal 
move away from you; as the delays 
increase, the sound characteristics 
become more "diffused" and more 
complex in total. At the sime time, 
the previously harsher early 
reflections will disappear. This tool 
contains a lot of potential, and it 
may also be automated. 

 

Plus, in "HQ" mode, you can also 
influence the dampening of highs 
as well as the reverberation time of 
the bass section. 

When interacting with the high band, realistic simulations are possible, e.g. wall surfaces. 
For instance, the wooden panels on the walls always reflect bass less than concrete walls 
(also due to possible gaps), which may also resonate and absorb the force of long-wave 
bass frequencies. The same also applies to the furnishings of a room. Furniture, shelves, 
etc. are traps for bass. 

Parameters of the HQ room/reverb models: Generally identical to those of regular 
rooms/halls. 

Exception: "ER absoptn" and "ER:tail" are not available (see explanation above). 

Also available are: 

 Low damp: Dampening level of the bass range. 
 Low freq: Start frequency of bass dampening. 
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MIDI cc setup: 

 The MIDI CC setup is a relatively simple routing matrix, whereby 
8 of the available freely configurable MIDI controllers can be used 
to control 8 internal parameters. 

 

 

Every "Controller" field corresponds with a "Destination" field. Next, select a MIDI controller 
directly from one of the lists or use the learn function. 

If you activate one of the buttons to learn it, any following external controller movements 
will be used to get the MIDI CC number. This enables one source destination pair to be 
learned after the other. 

 If all parameters have been set, save the setup by pressing the 
"Save setup" button. If you leave the MIDI CC view before doing 
this, the previous settings will be restored. 

This controller setup may be regarded as global, i.e. the settings are independent of the 
selected presets and the current project. 
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Vandal 
(Vandal in Samplitude Pro X  Suite/Vandal SE in Samplitude Pro X) 

Virtual guitar & bass amplifier 

Vandal is a complete simulation suite for guitarists and bassists. This plug-in is capable of 
simulating the entire signal chain, from input to stomp boxes, amplifiers, microphoned 
loudspeakers and post-processing studio effects, all in top quality. 

We focused on several aspects while designing this program, which make Vandal a very 
special plug-in in terms of its amp modeling. 

 

Version limits of Vandal SE versus Vandal: 
1. The SE version of Vandal only includes the following stomp boxes (floor effects): 

 La Crema Overdrive 
 Hellfire Distortion 
 Chorus 
 PhaseShifter / Tremolo 

2.MIDI scenes & MIDI controls are not included. 

3.Guitar and bass amp, detailed microphone settings, and pre and power amps cannot be 
selected manually, rather only via "Presets & templates". 

4. The SE version does not feature "Scene memory"; in this case, a preset only includes 
one individual scene. If a preset was created using the full version, then only the first scene 
will be used. 

 

Special Features of Vandal 
 High-fidelity analog modeling featuring accurate models of tube amplification stages, 

genuine real-world positive characteristics like distortion, dynamics, and audio 
complexity. 

 No use of impulse responses during speaker simulation (usually the case), but instead 
genuine physical modeling that calculates components such as speaker, cabinet, 
recording space, and microphone based on individual physical situations, since this 
offers enormous freedom of sound design and real-time control. 

 Easy-to-learn interface combined with efficient, easy to understand workflows. 
 The focus is on the important components of a guitar or bass setup.  
 Not a copy of a famous amplifier, but rather true "Custom Amplification Design" that 

features a sound of its own and versatility in terms of audio variety. 
 Completely latency-free processing. Vandal does not create any signal delay (primarily 

by omitting impulse responses). Only the audio interface and its driver may be 
responsible for any in and out-going latency during live playing. 

 Control over all component parameters via MIDI 
 4-times oversampling (below 44/48 kHz) for components that create distortion. This 

avoids typically digital artifacts (aliasing) 
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 Comparably low CPU load. Playing live requires the highest-possible drop-out 
prevention and as much "head room" as possible. In the studio, you may require multiple 
instances of the same plug-ins in one song. For example, for one specific metal riff you 
may require 10 guitars instead of two for that real "punch in the gut"; simply let Vandal 
rise to the occasion in 10 separate instances... 

 

VANDAL Quick Start 
VANDAL Overview 

 

We consciously designed the VANDAL interface to feature a realistic look. As bassists and 
guitarists ourselves, it seemed important to us to feel right "at home" here. The only 
unusual detail is that the floor pedals (and the gray carpet) are viewed from above, while 
the other effects are presented from the front. We admit, there was no way around this... 

Also, no one in real life would place an insanely heavy amp on a 19-inch rack. But in this 
case, it seemed logical because the signal path flows just like how you are read these lines 
– from left to right, and from the top down.  

The area at the top of the plug-in is called the "console". This is the so-called 
"switchboard" of VANDAL. The second half of this document (view page 770) will explore 
these areas in more detail. 
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Input level: VANDAL and the real world 

Independent of the preferred software, amp modeling has to feature impeccable integration 
with audio hardware and ASIO drivers. Please ensure stable and latency-free operation and 
the largest possible signal-to-noise ratio of the converter or the complete analog section 
when selecting appropriate equipment. If in doubt, ask your audio equipment dealer for 
advice and consider your entire computer system. On-board sound systems are not 
recommended due to their rudimentary or unsuitable driver sets and the often below-
average signal quality.  

Before making any "serious" endeavors in VANDAL, please make sure that your audio 
interface is supplied with a sufficiently controllable signal level from your instrument. The 
input signal at the audio interface should be "saturated", but it should not be 
overmodulated. Compared to the possibly desired distortions created within the plug-in, an 
AD converter distortion will sound abrupt and horribly digital, and the the worst part is that 
you will never be able to remove it. 

If very loud velocities sometimes reach the upper modulation limits and the average level 
stays at -12 or even -20 dB, everything is normal. The less noise your audio hardware has 
in the process, the better. We recommend working with devices that feature a resolution of 
at least 20 or 24 bits. A simple 16-bit sound card will stop being fun to use at the very 
latest when high-gain sounds come into play. 

If possible, use an interface with a high-resistance instrument input (often labeled "HiZ"). 
Line or microphone inputs are not very well-suited for this; due to the relatively high 
impedance values of (passive) guitars or basses, this sort of input has a dampening effect 
on the instrument. The sound will seem dull and "dead" as a result...  

If the interface does not feature an instrument input, insert a separate guitar pre-amp, a DI 
box, or even a simple pedal (not switched to "true bypass).  

Instruments with active pickups or electronic components are less affected by this 
adjustment problem. 

Please take this opportunity to also check the latency or the buffer size used by your audio 
system. A good ASIO driver should let you play with a latency of only a few milliseconds 
between the stroke and the calculated sound output from the software. Values under 5 ms 
are considered good. You may have to experiment to find the lowest limit at which your 
system functions stably. If you notice ugly crackling or even long drop-outs, then try a 
higher latency.  

 

Input level reloaded: VANDAL's input level 

 

After you have made sure that the external levels are clean, you should take a closer look 
at the input level; this controller is located at the top left of the console. Just like with a 
genuine guitar or bass setup, it's important to ensure the highest possible input level in 
order to be able to work optimally. This is even more important for distorted sounds and 
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natural high-gain playing styles. You should make use of metering for this as well (the LED 
indicator next to the input control). If needed, activate the noise gate and adjust it so that it 
lightly suppresses the input signal during pauses in playing. VANDAL does not cut the input 
as hard as classic gates do, but instead regulates them finely via the signal energy, 
beginning with the highs, at the point where noise is most audible. 

 

Vandal preset and scene selection 
Would you like to know about everything that VANDAL can do as quickly as possible? Just 
start strumming away and listen or flip through some of the included presets. These are 
available via the list in the upper edge of the console.  

 

A preset includes all settings for the main elements of VANDAL, i.e. stomps, amp settings, 
cabinet simulation, studio effects, and a series of control parameters. 

All settings for the main elements (such as the amp) are subdivided into "scenes" within a 
preset. This "scene memory" is located to the right of the preset list. You may create up to 
four variations of a preset using scenes. Numerous included presets make regular use of 
the scene concept. We will examine this working method (view page 771) more concretely 
later on. 

Presets may be switched by clicking on the list or using the arrow symbols. You can also 
use the left and right cursor keys. 

Scenes may be switched by clicking on the adjoining number (1 to 4) or on the name field 
of a scene. Alternatively, you can use the up/down arrow keys. 

Of course, presets and scenes in VANDAL may also be controlled via MIDI (view page 
773).  

Presets are located in a subfolder within the VANDAL folder on the hard drive. These may 
be changed however you like, sounds may be exchanged with peers using VANDAL, and 
your preset library may be expanded without limits. 
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Components 
Stomp Boxes (pedals) 
The real world has produced a series of effect devices popular with guitarists and bassists 
in the "stomp box" format. We've also included a rich palette of these devices.  

 

Vandal includes four "stomp slots" for use with effects equipped from the list. The signal 
flow within this chain runs from left to right. Stomps can be moved around freely, by 
dragging an unused area on a pedal's surface. 

When a stomp is assigned to a slot that's already occupied, the two change their places. 
Dragging while holding the [CTRL] key creates a copy of the pedal at the new location. 

Each stomp box may be detached from the signal path using the "foot switch" or the blue 
button next to the selection list. An inactive device does not utilize the CPU. 

Some stomps may be familiar to you; we reproduced some real prototypes with regard to 
functionality or sound, or simply got some inspiration from others. Some, in contrast, were 
created from the ground up and offer original sound ideas.  

We're constantly developing the selection of existing stomps that are available. With each 
plug-in update, it is our intention to constantly supply you with fresh "food for thought" in 
addition to technical improvements. Look for updates to Vandal at 
http://www.vandalamps.com. 

The following stomps were available at the time this manual was printed (each in its own 
category): 
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Overdrive/Distortion 
La Crema: Inspired by the world's most famous 
distortion pedal: the Ibanez Tube Screamer. La 
Crema offers soft musical overdrive sounds for solo 
parts, or simply serves to provide the amp with a 
prepped, contoured signal. The available gain is 
comparatively moderate; this is a typical pedal for 
classic rock and blues. 

Halvar: The name may sound a bit clumsy and 
coarse. In reality, however, this blue Scandinavian is 
a real softie and is a homage to Yngwie J. 
Malmsteen and his preference for DOD distortion 
pedals. Halvar tidies up nicely in the bass range, 
and it's outstanding for shredding and styles of play 
where crystal-clear response without any bassy 
noise is important. The gain factor is comparable to 
La Crema, but Halvar distorts "harder" and has less 
accentuated mids. 

Hellfire: Welcome to guitar hell! This pedal will roast 
everything, deliver gain until the cows come home, 
basses from the pit, cutting highs, and it easily 
creates the typical "scooped" sound of popular 
metal bands. 
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Fuzz: I can't get no Satisfaction, Foxy Lady. That 
basically says it all... 

The Fuzz effect is famous for its singing-saw sound. 
Where overdrive and distortion effect the signal in a 
comparatively mild way to let it "breathe" within 
limits, Fuzz attempts to rebuild the sound from the 
ground up according to its own principles. 

Bass Distortion: This pedal is of great service for 
bass players in search of juicy & meaty tones. For 
massive, chunky overdrive sounds, it is important to 
reduce low-frequency content from a distortion 
device. With classic fuzz tones, it's quite the 
contrary.  

This distortion device delivers both, and many 
facets in between. It is equipped with a dual filter 
network, located before & after the distortion 
process. Simply tweak your favourite sound texture 
to taste. 

 

Modulation effects 
Chorus:  The application and sound remind us of 
our personal favorites: those good old Boss pedals. 
Our Chorus offers modulation that's soft as butter 
but still crunchy and always assertive. 
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PhaseShifter/Tremolo: A phaser alone is already 
quite spacy, and a tremolo can sound a bit 
psychotic, but both together... Whether soft or 
choppy modulation (->Wave), slightly out of tune, or 
with sharp resonance effects... (-> Shift Q), it can 
sound as if it's up in the clouds or totally sick! 

Flanger: Although technically related to the Chorus 
function, the Flanger uses shorter delay times and 
internal signal feedback to produce slightly edgier 
modulation effects. This Flanger pedal certainly 
sounds soft and wide in the same way that analog 
flanger pedals sound. 

Bass Chorus: The essential sound of this pedal is 
very similar to the "normal" Chorus. Frequency 
response, delay times, and modulation curves are 
certainly optimized for use with bass. The Bass 
Chorus produces enormous width, but it never 
becomes muddy, no matter how deep it gets. 
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Delay / Reverb 
Digital Delay: A simple delay pedal without too 
many frills that features maximum sound 
transparency. Simply set the time (via the delay 
controller), the feedback, and the damp level, mix it 
in, and that's it. As required, the delay time may be 
snapped in to the host software's currently active 
tempo via the sync switch. 

TimeTunnel: Compared to the DigitalDelay, this 
pedal is a real vintage item. The (virtual) switching 
corresponds to that of the built-in "bucket brigade 
delay" in other stomps. Properties such as loss of 
highs in case of long delays or the "compander" 
switch for noise suppression of "breathing" sounds 
created by high feedback settings are clearly 
audible. 
The BBD memory's virtual sampling rate may be 
modulated via the "Mod" controller similar to the 
Chorus effect, which enables very lively delay 
textures. 

TwängBäng Spring Reverb: This is truly an 
authentic recreation of a spring-reverb system, 
incorporating all those lovely boingy, springy & 
slinky noises admired for decades. TwängBäng lets 
you select from a spring system using two seperate 
springs, or from one consisting of three springs. 
Both  have similar delay times as of certain well-
known US spring devices, but each one does have 
a distinct colour and reverb pattern on its own.  

The 2-spring system sounds quite "vintage" while 
the 3-spring mode is a bit more balanced and 
open. Using the "tension" knob, the "springiness" 
and therefore the delay  and attack structure can 
be altered. "Tone" & "damping" decide over the 
overall color and reverb time. Using a fair amount of 
„drive" makes the simulated transducers sweat a 
bit, creating a thick "glue" to the reverb sound. 
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SpaceCake Echo Reverb: This pedal is a perhaps 
unusual amalgam of a muti-tap delay and a reverb 
systems known from the late 1970s. Using proper 
BBD (bucket-brigade delay) emulation techniques 
borrowed from "TimeTunnel", the signal feeds two 
seperate delay lines here. Each delay has 4 taps on 
the output, which have user-adjustable weighting. 
This alone already lets you dial quite unusual 
reflection textures.  

In "reverb" mode, things can go more wild. Now, 
the feedback signal of a delay line is derived from 
the sum of all 4 taps, and the two feedback paths 
are cross-coupled. Depending on the actual delay-
time ratio of the two delay lines, very complex 
echoic and reverberant tails can be created. Just 
keep in mind that by summing the taps in "reverb" 
mode, the system is prone to instability. Luckily, 
you have the "mod" parameter at hand, slowly 
varying the delay times and keeping feedback 
under control. And it greatly enhances that 
"spaced-out" feeling. 

 

 

Volume/Dynamics 

 

Volume Pedal: No explanation needed. Step on 
it, give it some gas. You are, after all, driving with 
tube equipment! If the amp is set correctly, you 
can control distortion levels precisely just by 
varying the volume. Common swelling sounds are 
also no problem when using MIDI controls. 
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Compressor: The heart of this pedal is the 
modeling of a simple floor-board effect's typical 
control circuit, which is based on an FET (field 
effect transistor). FET compressors are famous for 
their speed, high degree of sustain, and above all 
for their character at comparably low switching 
complexity. Of course, the guitar signal may also 
be compressed subtly or only the attacks may be 
enhanced specifically. 

 

Bass Compressor: The basic circuitry of this 
Stomp Box is comparable to the "normal" (guitar) 
compressor. Under the hood, adjusted 
specifications control at decisive positions to 
provide bassists with consistently solid sounds. 
The Bass Compressor works frequency 
selectively, i.e. very deep frequencies trigger the 
process less intensely than mids or highs. This 
enables the Drive controller to be used to produce 
a good foundation and thrust. 

 

 

Twin-C: This compressor pedal divides the 
instrument's frequency range into two ranges (low 
& high) and sends these to separate compressor 
stages. This separation helps to avoid pumping 
artifacts or other typical problems caused by 
broadband compressors. The stomp selects 
control times automatically. Basically, very short 
attack times are applied to the upper band, while 
longer times are applied to the lower band. Twin-C 
enables slap bass sounds with extreme punch to 
be created easily, which offers a very sturdy 
foundation and a sound that "goes straight at 
you". 
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Tube Compressor: This stomp box uses virtual 
tube circuitry. Although in this case, it doesn't 
neccessarily mean the process is about distortion. 
It's more the fact that the gain-reduction process 
is a function of tube operation: like the "variable-
mu" concept used in popular concepts from the 
1950s onward, a tube can be externally controlled 
to change its amplification factor. 

Of course, such a circuit can be driven hard by 
purpose and produce typical tube-like saturation 
textures. 

In order to keep things well-balanced and 
controllable, a (symmetric) push-pull circuit is used 
in this design. 

Using low to moderate "drive" settings, this pedal 
is a very smooth & gentle dynamics compressor. 

 

Filter/EQ 

 

CheWahWah: This little red rebel will prick up 
your ears. It can scream out your solos and fills 
loudly and clearly while keeping its cool and 
staying smooth. This is one of the few digital wah 
pedals that doesn't sound digital. On the normal 
setting, the pedal acts like a regular wah pedal; in 
auto mode, the filter circuit reacts directly to the 
incoming signal's amplitude. In this case, the 
pedal varies the sensitivity of the auto wah effect. 

 

EQ: This pedal enables the guitar signal to be set 
precisely in seven frequency bands. This is not 
only suitable for corrective adjustments, it's also 
great for supplying any subsequent overdrive or 
distortion stages with perfectly prepared sound. It 
also performs well in solo passages, e.g. in case 
the mid range needs to be highlighted. 
The heart of this EQ pedal is a circuit based on an 
analog model which features parallel filter stages. 
In this case, the typical disadvantages of serial 
filters such as phase problems and sound 
degradation are avoided. This EQ features the 
desired properties of real circuits, including added 
harmonics to the input or individual filter stages. 
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TrebleBooster: This effects pedal is ideal for that 
"British" sound or any kind of crunchy style. It 
effortlessly provides crystal clear highs to the amp 
or to other connected stages. Rhythm guitars 
come to life, while leads sparkle out of the 
speakers. 
The underlying circuit remains unique in spite of a 
certain likeness to vintage treble boosters. The 
adjustable corner frequency ("freq" controller) is 
the key player: depending on the setting, dramatic 
changes to the frequency and phase responses 
may also be heard, which makes the booster 
extremely versatile. 

 

FunkFrog: The ideal companion for sixties & funky 
styles, but also great for a lot more. In principle, 
this pedal is an auto wah; however, the frequency 
band is not only controlled by the input signal via 
an envelope follower ("env" controller). The "mix" 
controller allows an LFO (Low Frequency 
Oscillator) to be mixed in as the controlling signal. 
This creates a kind of rhythmically croaking auto 
wah, or maybe an oscillating, whirring filter thingy.. 

 

 

Others 
Octaver: This effect uses classical frequency 
division switching to produce to sub-harmonics 
from the (mono) end signal. The controller "oct1" 
defines the portion of the first sub-octave (-12 
semitones), and "oct2" defines the portion of the 
second one (-24 semitones). The direct portion of 
the signal may be mixed into this. 
Both filter controllers enable the sharpness to be 
removed from the waveform that is produced, e.g. 
in order to thicken it up just for the bass range. 
As usual with octavers, clean tracking requires 
single tones; chords should not be played. In 
general, the selection of the neck pickup is also 
important, since this is where the basic sound is 
transferred most clearly. 
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Amplifier 
VANDAL essentially offers 2 different amplifiers; a guitar amp and a bass amp. These may 
be selected from the list in the "amplifier panel" below the stomp view. 

 

As we mentioned, in VANDAL we found our own way and avoided modeling specific 
amplifier brands and models. The amplifiers are setup variably, allowing you to get a 
number of different sound characteristics out of your VANDAL amp. Internally, these circuit 
designs work exactly the same as the real versions. We improvised at some musically 
decisive points by just relying on our ears. 

 

Amplifier Concept 
VANDAL essentially offers 2 different amplifiers; a guitar amp and a bass amp. These may 
be selected from the list in the "amplifier panel" below the stomp view. 

 

As we mentioned, in VANDAL we found our own way and avoided modeling specific 
amplifier brands and models. The amplifiers are setup variably, allowing you to get a 
number of different sound characteristics out of your VANDAL amp. Internally, these circuit 
designs work exactly the same as the real versions. We improvised at some musically 
decisive points by just relying on our ears. 

 

Amp/Cabinet Template 
The extremely variable concept for amps and cabinets within VANDAL is great for 
individualists, but it would take a bit of time to imitate a band mate's 40-year old Marshall 
with speakers of the same vintage. If you want to use a combination like this often, then it's 
nice to have a library for it, which is exactly what the templates are for. 

Our team of experienced musicians has compiled a multitude of settings for the amp and 
speakers. These templates may be changed at any time, or you may create your own if a 
particular combination of amp and box is especially appealing. 
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Guitar Amp 

 

Circuit Philosophy 
 

 

The VANDAL guitar amp offers three different pre-amp modes and two switchable 
end stage models. This basic configuration may be changed via the wrench 
symbol on the right side of the amp. 

The pre-amp has three modes of operation: 

 

 Classic (think Fender, early Marshalls, or the first Mesa/Boogie amps) 
 British (oriented on Marshall Super Lead / "Plexi") 
 Modern High Gain (design similar to "souped-up" amps like Rectifier, Soldano or Peavey 

6505) 

More about pre-amp modes and their properties resulting from channel selection can be 
found in the chapter "Pre-amp Channels" (view page 761). 

The last stage has two modes: 

 

 Class A, low power: A simple, low-performance, but musically pleasant distortion. In 
"A" mode, only a half-wave of the signal is amplified. To do this, the signal is brought to 
approximately half of the amplification range of the end tube(s) through bias voltage, 
because tubes always amplify only a half-wave of an alternating circuit. A class-A circuit 
may be put together using only a few components and sounds very "warm" because of 
its constantly asymmetrical characteristic curve shape (some even harmonics appear). 
This amplifier, however has the disadvantage of low efficiency or low output performance 
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and a comparatively high liability of erosion. The latter has been left out of the modeling, 
of course...  

 Class A/B, high power: In this case, each half-wave has its own tube, which (almost) 
doubles the efficiency. Class A/B router amps are more complicated to implement (and 
calibrate). Compared to Class A, the sound characteristics include descriptions such as 
"sovereign" and "powerful", but somewhat "colder", because they result in almost 
exclusively odd harmonics. Using positive and negative feedback via the output 
transformer, an additional "sound design" is often added here. For this reason, 
VANDAL's A/B power amp features more juice in its lows and more bite in its highs. 

 Presence: On many amplifiers, this pot is located next to the EQ section, although a 
presence boost actually takes place inside the power amp circuit. Most push-pull amps 
use negative feedback (from the output transformer back to the power amp's input) to 
linearize the amplification process. Lowpass-filtering this feedback signal and mixing it 
(anti-phased) with the input results in boosting the mid and treble region. Using 
presence, the sound takes on a livelier and more up-front character. 

 SAG control: Many older tube amps use rectifier tubes to transform AC current to DC 
(instead of conventional semiconductor diodes used today). However, a tube is a high-
resistance component, and can't produce an even current flow during steep load 
changes. This "sagging" feature of a cranked-up tube amp is the acoustical result of 
these short-lived interruptions. Moderate sagging is initially perceived in the attack; it 
sounds somewhat compressed, but in a "lively" way. If the effect is even stronger, it 
changes the entire signal. Besides the dynamics, the harmonics spectrum also changes, 
because operating point of the tubes is shifted. 

 Sagging occurs in this form only in push-pull end phases; in principle, Class A amps 
always draw constant (maximum) current from the mains.  

 Intensive sagging will result in creating less "presence", as the overall signal gain in the 
power amplifier decreases, thereby generating only small voltage excursions to feed 
back on the power amp's input. 

 

Preamp Channels 

 

The guitar amp is set up with three channels in all preamp 
configurations (Classic, British, Modern High Gain). 

 Clean: This channel should create no distortions. If the incoming channel is "hot 
enough", then it will be distorted in a typical tube fashion. The model will use only half of 
a double triode; in principle, a simple amplification takes place at the "working level". 

 Crunch: Amplification stage number, circuit and, last but not least, the resulting sound 
all vary:  

- Two amplification stages are used in the "Classic" preamp setting. This model 
uses a long-established design that is similar to the classic Fender amps or the 
first Marshalls. The "classic" preamp delivers saturated lows that are only slightly 
dampened by the second stage. As a result, this circuit delivers the typical 
"brown" sounds of older vintage amps. 

- The "British" switch is inspired by dual input stages, such as Marshall "Plexi" 
variants (JTM, "Super Lead", etc.). The signal is sent to half of each triode circuit, 
and these favor different frequency ranges ("warm", "bright", etc). The "British" 
circuit in the VANDAL amp uses a set mixing ratio for both tube portions. In 
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contrast to the "Classic" version, this preamp setting sounds more "alive" and 
reacts much more sensitively to dynamics, pick-up selection, and gain 
settings/guitar volume. 

- "Modern High Gain" delivers the typical fat sound that is rich in highs, similar to 
American amps like the Mesa/Boogie & Co. in 3 cascading amplification stages. 
Before the second and the third stages, the proportion of lows and highs is 
regulated, so that low tunings and quick passages are amplified without any 
"mud" and the signal always remains clear and assertive. 

 Lead: In all preamp modes, the lead channel consists of an additionally cascaded tube 
circuit. In the "Classic" and "British" preamp setting, the lead channel may be viewed as 
more of a modification of "tuning" of vintage aspects. The "Modern High Gain" variant 
really gets going here. In this setting, VANDAL playfully takes on even drop-C or -D 
tunings. 

Tip: Even if you don't want to use up all your gain in the crunch & lead channels, you can 
still try to go "a level higher" and take the (pre) gain level down a little for a slightly distorted 
sound. This increases the sound's complexity, and it will also seem more lively. 

 

Pre & Post Gain 

 

You can set up the desired amplification factor with the pre 
and post gain controllers. The pre-gain controller corresponds 
to the normal "gain" controller on most amps. 

Using the post-gain controller, the currently active channel's overall volume may be 
adjusted to another channel, or a certain channel may be raised (e.g. for a solo). 

Don't worry about switching settings around in the middle of things; the amplifier will 
remember the gain settings when channels are changed. 

 

Voicing 

 

There are a number of more or less open secrets with regard 
to the different signature sounds of guitar amps. This one 
might sound "bluesy", but doesn't sound so great with more 
gain, and the other is contoured for grindcore metal and fat 
sounds, but maybe it's a little anemic otherwise... How does 
this work? 

Most amps in the real world use more or less the same or similar circuitry designs. The 
important thing is the number of amplification stages involved. Each new stage not only 
increases the level of audio complexity, it also has a large influence on how the way the 
signal is treated before and after that stage. Filtering is the key: 

In addition to preset filtering circuits between the amplification stages, we gave VANDAL a 
little something we call "curve EQ". Assuming that you are using an EQ pedal before the 
amp, you can change the distorted sound drastically, because instead on the overall 
sound, you can favor certain frequencies. Curve EQ does something similar: it's located (in 
some cases in multiple instances) at strategic points between individual amplifier stages, 
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and it filters the signal before it is distorted by the next stage. This is known as "voicing". 
For fun, turn a curve in both directions and move around a bit with the frequency controller 
in the spectrum. This will give the amp a completely different character. By combining 
channels, pre-amp modes and voicing, you can create a completely individual amp sound 
and even imitate other amps. 

 

Equalization 
The actual sound control (the "tone stack") 
functions rather conventionally: VANDAL offers low, 
mid & high settings.  

Everything functions like the passive sound regulation network in genuine amps so that the 
controllers influence each other to produce numerous variations. Depending on the preamp 
mode, the activation frequencies are slightly different. 

 

Reverb 

 

Genuine studio reverb devices are great, and VANDAL has two of them 
included in both multi-effect units. However, styles such as surf, twang, 
sixties, and others require a spring reverb. We've drawn on famous reverb 
spirals for our modelling. 

Everything sounds natural with complete authenticity. This means that it has an old-school 
style rattle and typical rippling on the attack. 

 

Master 

 

The master control may be used to determine more than just the total amp 
volume. Since this is located before the end tubes in real amps, you can also 
use it to control the end stage distortion level. 

This is very easily perceived in the class A mode; it doesn't just get louder, it also becomes 
more compressed and distorted. 

If you are used to amps without a master volume, simply leave this at the maximum setting 
and control gain via a pre-stage and the final volume and the cabinet simulation or at the 
console output. 
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Bass Amplifier 

 

During development of the VANDAL bass amp, it was our main goal to create a recipe 
consisting of the best amp designs in a single amp featuring an all-tube design that would 
be simple and easy to use.  

The core features of the VANDAL bass amp are: 

 Multi-stage tube preamp (with extra distortion stage) 
 Contour control for extra-fat bass and glittering highs 
 Controllable optical-electrical compressor 
 4-band sound control 
 Class A/B tube end stage 

 

Gain Control 

 

The input level of the first amplification stage is set in the bass amp via the 
gain controller. Low to medium values leave the signal relatively neutral, and 
high values softly increase saturation. 

 

Contour 

 

The contour circuit is a filter stage that works similarly to the "Loudness" 
function. This control lets you give the bass sound an underlying character 
without additional EQ measures. 

Turned all the way left, no effect will be present. However, the more the control is turned to 
the right, the more the mids will be thinned out and lows and highs raised. It's sort of like 
an "instant slap". 

 

Comp (Opto Compressor) 

 

After the contour circuit, the signal passes through the compressor stage 
(Comp). This is a simple but extremely musical "optical-electrical" design: 
the bass triggers a light source (e.g. an LED or a luminescent film) that is 
coupled with a photo resistor. 
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The louder you play, the more light falls on the photo resistor, which in turn dampens the 
signal. This may already be familiar to you from the most famous studio compressor for 
bassists, i.e. Urei LA2A, which functions according to the same principle. 

There aren't that many settings to change in such a simple compressor. The control times 
are mostly determined by the sluggishness of the photo resistors. The comp control only 
sets the signal strength, which is routed to the light source. 

 

Drive 

 

After any possible compression, "Drive" provides the option to take the bass 
sound to the next level. The drive circuit is an additional amplification stage, 
which is proportionally mixed to the main signal. Signal distortion takes 
place depending on the frequency: 

In spite of a level of distortion, the basses remain relatively clean and contoured. This 
guarantees complete "traction" of the signal when the controller is set all the way to the 
right. 

 

Equalization 
The following equalization stage 
offers 4 frequency ranges, in 
which case the two mid bands 
are variable.  

Some bass amps allow their EQ circuits to have a drastic effect on the signal. We decided 
on a softer filtering with an edge slope of 6 dB/octave to avoid fully counterfeiting the 
essential character of the instrument in spite of the four bands. 

 

Master 

 

The final master volume controller sets the volume at the final stage. Similar 
to the guitar amp, the end tubes are also engaged in this case as much as 
remains sensible. 

Through the interaction of gain, drive & master, countless saturations and distortion 
textures may be modeled as needed. 

 

Cabinet Simulation 

 

As was mentioned at the start, we went our own way in simulating the speakers and 
cabinets. In place of impulse responses from microphoned cabinets, we've calculated the 
individual components of this sort system: 



 

7 6 6  E F F E C T S  M E N U   

 Loud speakers  
 Housing 
 Recording space 
 Microphone 

True to our "custom amplification" philosophy, this process provides total freedom and a 
certain measure of personal dynamics, which is the final deciding factor at the end 
concerning whether the system feels "lively". VANDAL also takes subtle effects into 
account, such as the reaction of the speaker's housing, the effect of this on the end stage 
that is applied, and so on. 

 

Speaker Selection 

 

The speaker selection list allows you to choose from a selection of speakers of various 
sizes and sound characteristics. These are organized according to guitar and bass types: 

Guitar 
 10“ UK Vintage 12“ UK Vintage 12“ UK Modern 12“ UK Blue 10“ US Alnico 15“ US 

Alnico 15“ US Fat 

Bass 
 10“ Custom Rock 10“ Custom Alu 15“ Custom Rock 15“ Custom Alu 

 

Housing Selection 

 

Various housing types may be combined with the available speakers in the housing list. 
This selection list is also organized according to guitar and bass types. 

Guitar 
 1x12“ US Combo Open 1x12“ US Combo Closed 2x12“ UK 4x12“ UK 4x10“ US Tweed 

Bass 
 4x10“ Ported (Bassreflex) 1x15“ Ported (Bassreflex) 

The housing has a significant effect on the resulting sound with a selected speaker. In 
general, open housing types are somewhat weaker on the lows, but go lower and sound 
somewhat more neutral than closed types. Larger housings also sound "bigger" and 
maybe "fatter". However, this is not always desired; for a guitar solo or for certain styles like 
blues, a small combo housing may be much more assertive or simply more "charming". 

It's up to your creativity whether you would like model the cabinets on realistic role models 
(e.g. 12" vintage speakers in a 4 x 12 housing) or place a 10-inch design in a 15-inch box. 
Refer to the "Advanced settings" a little further on for all other variations to help you create 
your own "personalised" speaker. 
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Microphones 

 

Cabinet simulation offers two separate microphones for the recording of the virtual speaker 
in a modeled recording space (MIC 1 & MIC 2). Similar to a real-life situation, you may 
position a virtual microphone stand in a space to achieve interesting mixing ratios and 
stereo effects.  

For each of the two available microphones, you may select from a list which includes 
several popular studio types featuring characteristic sound models: 

 Condenser, Dynamic 1, Dynamic 2 

For each selected microphone, a range of sound design parameters is available: 

 Axis: The "on axis" (controller to the left) setting corresponds 
positioning of the microphone directly in the middle of the speaker 
cone. In this position, the sound will have many highs, but may 
sound piercing. For this reason, the microphone will often be 
positioned a bit "off axis" in order to achieve a softer sound. 

 Distance: This control allows you to remove the microphone from 
the speaker and position it further away in the recording studio. 
This way you can make the sound more alive and loosen it up 
acoustically. Using two microphones with different panoramas (see 
below) enables you to create extremely realistic stereo images 
(note that the axis parameter has a decreasing effect in relation to 
the increasing distance). 

 Pan: This parameter distributes the microphone signal in the 
stereo sum at the output of the cabinet simulation. 

 Level: This adjusts the microphone volume. 

 

Advanced Settings 

 
Clicking the wrench symbol accesses additional cabinet simulation 
parameters: 

Speaker Distortion: As discussed at the start of this manual, we 
have also modeled the non-linear aspects of a speaker. These 
dramatically change the sound, depending on how hard it is 
working. Under heavy loads, not only more distortion is created, 
but the dynamics and the frequency spectrum also change. This 
control allows you to set the effect of the non-linear behavior within 
certain limits. Please note that the acoustic effect of this parameter 
also depends on the amp's end stage. 
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Cabinet Balance: We have already explained that the housing is 
an important part of the overall sound. This parameter allows you 
to set just how much effect this has. Turned all the way to the left, 
the speaker exists almost "free in space", turned to the right, you 
are picking up sound directly "in the box". 

Enclosure Damping: This parameter sets the level of housing 
resonance. The normal value is in the middle of the control range. 
When turned all the way left, the housing sounds "emptier" 
(increased resonance). Turned all the way right, the speaker 
sounds as if it were covered in insulating material, and typical 
resonance features are reduced. 

Room Size: This adjusts the size of the recording space being 
modeled. The more the controller is turned to the right, the bigger 
the recording studio's dimensions become. 

Room Damping: Similar to enclosure damping, the materials 
involved and the room's capacity to absorb may also be changed. 
When turned to the right, the room is dampened to the maximum. 

 

 

MIC 1 / 2 Delay: Turning either knob (or both) delays the 
corresponding mic signal to up to 30 milliseconds. This can 
be handy in creating spatial effects (thereby taking advantage 
of the "Haas effect", allowing localisation through time delay). 
Interesting new tonal textures are also possible by using just 
very small amounts of delay on either mic. 

 

Phase Flip: These switches regulate the phase length ("in-
phase"/"out-of-phase") of both microphones. This is helpful 
in case the signal from Vandal needs to be mixed with others 
or in order to create interesting sounds by changing the 
positions of the virtual microphones. 

 

Rack effects (FX1/FX2) 

 

There are effects that don't always work well when placed before the amp, e.g. reverb or 
delay, especially when they are distorted. Normally, these effects are better placed at the 
end of the signal chain. 

For final processing and enrichment or whatever else you need, we offer two separate 
studio-quality effects units that behave just like real 19" rack devices. 

Many of these algorithms create a stereo signal. As required, make sure that the channel 
strip is being calculated as stereo in the audio sequencer track. 
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Effects units may be selectively operated one behind the other (serial) 
or parallel. Switching may be changed via the mode switch. 

The following algorithms & effects are available: 

 Mono Delay (msec & tempo sync): Selectable as a simple delay with freely adjustable 
delay time or synched to the sequencer tempo with a musical raster. In case of higher 
feedback values, a reduction of the damping frequency is required to provide natural 
echo sound. 

 Stereo Delay (msec & tempo sync): Features two models, just like mono delay. 
Repetitions may take place on separate channels (feedback controller to the right: dual 
delay) or in ping-pong mode (controller to the left), in which case the signal alternates 
between the sides.  

 Chorus: Produces a typical "floating/shimmering sound" via modulated detuning of a 
signal to "thicken" the sound or spread it across the stereo field. Detuning is achieved 
via a short delay, the length of which may be varied via the modulation. This produces 
the so-called "Doppler" effect and broadens the signal. 

 Flanger: Similar in terms of the algorithm that is applied to chorus, but different in that 
the delay time is significantly lower and delay works via repetitions (feedback). The 
flanger sounds more cutting and up-front than chorus. 

 Phaser: A modulation effect just like chorus & flanger, but in this case no detuning takes 
place. Filter components periodically alter the signal's "phase response" (principle of the 
"phase shifter"). When mixed into the original, characteristic notches are produced in the 
frequency spectrum response (comb filter effects). 

 Room Reverb/Hall Reverb: Reverb offers realistic simulation of realistic reverberation. 
Room creates the impression of a small to mid-sized recording room, while reverb 
produces the impression of a concert hall. A particular is that both effects algorithms 
provide a modulation parameter, which may remove possible resonance at low dosages 
and can produce a soft chorus effect at higher values. 

 Vintage Plate Reverb: The algorithms used in this type of reverb are quite similar to the 
ones that popular hardware effects units back in the 80s used to emulate that certain 
dense space of reverb plates. The resulting sound is correspondingly "wide", spacial and 
responds very directly, with immediate dispersion and no single echoes. Modulation of 
the reverb tail is also possible here, to minimize the typical ringing of the underlying 
metal-plate model. 

 LoFi: Depending on its setting, this algorithm adds grit to the sound or a certain 
measure of signal destruction. Turn down the internal sample rate as much as you like to 
steal a few bits from the sound's resolution. Definitely an unconventional method... 

 Vintage Compressor: Ideal for thickening up the signal a little. The algorithm emulates 
an older popular circuit design that is similar to studio legends like the Urei 1176 or 
simple compressor pedals. A so-called "FET building block" simply, effectively, and quite 
musically controls the volume via the input level, the set compression level, the 
compression ratio, and the response responses (attack and release). 

 3-Band EQ: This sound controller works like a conventional mixer with a controller for 
the bass, the highs, and two controllers for the variable mids. This adds the final polish 
to your sound. 
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Console 

 

In the quick start (view page 747) chapter, we mentioned that the console is the central 
switchboard for all of VANDAL's software. This interface is divided into various sections: 

 Controllers for input and output levels, noise gate & limiter 
 Management of all underlying components as a preset file 
 Management of 5 remote controls for steering any parameters 
 Chromatic tuner 
 Advanced settings (MIDI, global) 

 

Preset Menu 

 

Presets are files within the VANDAL folder that consist of four scenes (but not all four must 
me used).  

The default presets are organized in (sub)folders on the hard drive and may be located via 
the navigation structure in the presets menu. 

An altered, but not yet saved preset is marked with an asterisk (*) in front of its name. 

To save a preset, click on the diskette symbol and enter a descriptive name in the dialog 
that opens. Navigate to a subfolder or create a new one as required. 

The number of possible presets available within VANDAL is unlimited. The same applies to 
variations to settings saved as new files. For the sake of preserving a clear overview, we 
recommend saving your own preset files in specific subfolders. The depth of the folder tree 
is unlimited. 

 

Remote Parameters 

 

The five controllers provide an elegant option for adjusting any desired parameter in 
currently activated components. These may be controlled via MIDI and via VST automation 
in the sequencer program. The remote control is also the interface between Vandal and the 
outside world. The controls may be assigned via the advanced settings (view page 771). 
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Scene memory 

 

Imagine you have to put together a set list for a gig. 
A good idea might be to create a list in Vandal in the 
form of presets.  

It might be an idea to create a new folder and enter the location and date of the gig as a 
title. Then save the individual presets for each song in it. 

As a guitarist, you will probably want more than a single setting for each of your songs. If 
more gain or volume is needed in a particular solo section, it wouldn't be very productive to 
create an entire preset for this. 

The solution Vandal offers is a range of four variations for each preset, these are so-called 
"scenes". These may be switched using keys 1 - 4 beside the preset list or by clicking the 
names. All presets which are made from now on will only affect to the currently active 
scene. Scenes can be changed around at any time without discarding settings. 

Settings may be transferred easily to other scenes simply by pressing the copy button for 
the source scene, and then switching to the target scene and pressing paste. 

Copy & paste also works for presets, i. e. the clip board is not cleared when you change 
the presets, this enables settings to be saved easily into a new preset. 

Scenes may be switched externally via MIDI (view page 773). 

 

Chromatic Tuner 
The chromatic tuner in the console has an automatic 
circuit which analyzes the recently played sound and 
shows the note and deviation from the idea (in cents) 
on the display. Simultaneously, the point moves up (too 
high) or down (too low) along the scale or stops in the 
center when the tuning is exact. 

The arrows indicate the direction of the tuning (up or down). 

The mute button switches the output signal from VANDAL to mute for as long as the 
chromatic tuner is activated (tuning fork symbol). 

 

Advanced Settings 
Clicking on the wrench symbol below the tuner opens a separate display. 
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On its right hand side, there is a sub menu for acessing in-depth adjustments of the 
software: 

 remote ctrl (Control): Remote parameters for external control, either from the sequencer 
or via MIDI, can be assigned here. 

 patch list: The underlying sub page serves for mapping MIDI or VST programs to actual 
presets. Because the preset library is a dynamic collection of arbitrary files on the hard 
drive, but the MIDI program scheme is tied to 128 possible programs, a proper mapping 
regime is needed. A "patch list" is used for that exact matter. 

 preferences: Here, global settings can be made, affecting all instances of Vandal, 
regardless of the current preset. 

 about: Shows the current installed plugin version and provides clickable links for the 
product web site and additional downloads. 

 

Remote Control 

 

You can use a standard MIDI controller in conjunction with Vandal to externally control any 
of the program's parameters. For example, preset changes present no problem either 
using program change commands, or using the wah-wah pedal via MIDI control change. A 
MIDI configuration may be set for each preset and each scene saved in Vandal.  

A maximum of ten different control commands may be assigned at the same time 
(assignable in two rows of five). The source for controlling may be external MIDI, but the 
five remote controllers below the preset display are also available. An individual remote-
controller/MIDI controller can control up to four parameters. 

For each target parameter, a selection may be entered for the type and level of the control. 
For example, "Add to param" indicates that the value of the external controller or remote 
controller should be added to the parameter that is being controlled. 

Let's assume that the controller, which is sending MIDI CC 7 (Volume), should also control 
the guitar amp's gain in the lead channel from zero up to the current control setting. 
Simultaneously, the master volume should be reduced to compensate for the volume. 
Proceed as follows: 

 In the Remote 1 view click on MIDI learn in the MIDI controller range or select CC 7 
volume from the list By doing this you have specified that you want to control the remote 
memory with your pedal. 

 In the first target list, select "Guitar amp -> PreGain lead" as the target. 
 In the list next to this, select "Multiply" as the control method. 
 Move the fader right to the 100% mark. This indicates to the control that the depressed 

pedal should match the current controller maximum. If for  example the gain fader is at 
12 o'clock (i.e vertically) then a half-pushed pedal would give you a gain of 25%. 

 In the second list, select "Guitar amp -> Master volume". 
 Select Subtract as the method this time. 
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 Try setting the fader to 10-15%. Of course, the level of compensation depends on the 
concrete sound; if any at all... This is, after all just an example. 

 Enter a sensible name for "Remote 1" by double clicking it, e .g. "Pedal gain". 

The MIDI/Remote configuration may be left again by clicking the wrench symbol. The main 
display will now feature "Pedal gain" in the first remote storage section and the assigned 
MIDI controller (volume). 

 

Patch List 

 

Because the preset library is a dynamic thing and can hold huge numbers of files (sheer 
unlimited), they can't simply be accessed by MIDI program change messages from 
outside. MIDI knows only about 128 programs, and it doesn't have a notion about the 
plugin's file organisation, for instance sub folders, or even multiples of those. For that 
reason, a "connection" between these two worlds is needed. That's where the patch list 
comes in. 

This list is shown as pages of 16 programs / program slots. Each represents a MIDI/VST 
program. 
Using the "edit" menu, the current page to edit is brought up. Alternatively, an external MIDI 
or VST program can be sent; the underlying page is automatically picked and the selected 
program is highlighted in the display. Presets can be simply assigned to programs by 
choosing an existing file from the corresponding menu. 

A patch list can be saved using the disk icon. Just like the presets regime, multiple patch 
lists can be created and you can set up a library of different lists, each serving a particular 
purpose. 
This can be handy for musicians gigging a lot, and changing their set very often. Using 
seperate patch lists makes programming an external controller much easier, as it only 
needs to be fed with the programs you really need for a show.  

A selected / saved list can be stored as your preference, by hitting the "as default" icon. 
This is a global setting, affecting all Vandal instances. You'll find this setting again on the 
"preferences" page, labelled "startup patch list". 

 

Preferences 
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On this page, numerous in-depth settings to the software can be accessed. These act as 
"global" modifiers, which means they affect all (following) instances of Vandal, and they 
work regardless of the current chosen preset. 

 startup preset: Here, the default preset is specified, which will be loaded at plugin 
instanciation. Keep in mind that your sequencer program can freely override this 
preference, by sending a MIDI/VST program change command as last in the boot-up 
sequence, which might trigger a preset from a "patch list". So, this setting should 
probably be considered a fallback, in case no default patch is found. 

 startup patch list: As mentioned earlier, this is the default list of preset files that get 
assigned to MIDI/VST program numbers. 

 direct switch scene ← midi: The 4 scenes of a presets can be switched independently 
via MIDI. You can specify here, which scene is accessed by which command. Possible 
data types are either MIDI note number, or program change messages. 

 scene skip -/+: for external controllers having up/down switching capability, proper 
control commands for skipping scenes can be chosen here. 

 skip mode: You can specify, whether skipping should stop at either end, or whether 
further commands should result in a round-robin fashion (e.g. from scene 4 to scene 1). 

 preset skip & skip mode: Just like with scenes. 
 default preset scene: This menu specifies whether the first scene is activated upon 

preset load, or whether the preset should recall the one that was last selected by the 
time it got saved. 

 input & gate level: Typically, the knob settings for the console's gate and input level are 
read directly from the current preset. Choosing "use current for all", you can specify 
global values as the reference. The values stored are taken directly from the current 
knob readouts. 

 window resize: Normally, the two little buttons on the console's left side (below the "V" 
symbol) switch the stomp and the amp/cabinet/fx section on or off. This manual mode 
can be changed to automatic. Then, presets containing stomps and an amp will 
automatically maximize the window, while the view will collapse as soon as either the 
stomp or amp component slot isn't occupied. 
The window can also be forced to stay always maximised (so that the above mentioned 
console buttons have no function). The maximised mode might be helpful with some 
host programs that show dynamic window resize issues. 

 mouse mode: Choose your favourite method here for handling knob movements. Knobs 
can either be turned in a linear fashion (up/down), or as a circular movement. 

 tuner reference frequency: In case your music asks for a tuning other than standard 
440Hz, the tuner can be recalibrated here. 

 carpet / guitar amp overlay image: You can "skin" Vandal's stomp background (the 
"carpet" as well as the guitar amp's front cover (cloth) to your personal liking, by 
specifying own images. 
A "custom image" has to be in PNG format and reside inside the "_custom" folder (found 
inside the Vandal installation branch). 

 image opacity: "Custom" images with transparency/alpha information are supported. 
Likewise, an image can be softly blended in or replace the background completely. 
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Waveform Generator 
This dialog contains a powerful generator for test tones. 

 

Select RAM or HD as the type in mono or stereo at a resolution of 16-bit or 32-bit float. 
The following sample rates are available: 22050, 32000, 44100, 48000, 88200, 96000, 
176400, 192000, and 384000. 

As a waveform, you choose between rectangle, triangle, sine, sawtooth (upwards), 
sawtooth (downwards), white noise, pink noise, and brownian noise. 

You can specify the length in samples, milliseconds, or SMPTE code. 

The frequency (Hz) and volume (dB) are the final two waveform parameters at your 
disposal. The signal created may then be used as a wave project/virtual project. 

 

SMPTE Generator 

 

If you don't have an external MTC to SMPTE converter for synchronization with analog 
equipment, this dialog allows you to create audio files containing SMPTE audio signals. 
Place the generated SMPTE signal onto an empty track and route the output to the 
SMPTE synch input of the analog recording device. 

You can choose from the following specifications as SMPTE frames per second: 24, 25, 
29.97, 29.97 drop frame, 30, 30 drop frame. 

The SMPTE start value may be entered in hours, minutes, seconds, and frames. 

Specify the length in samples, milliseconds, or SMPTE code. 

You can choose from the following sample rates: 44.1 kHz, 48 kHz, and 96 kHz. 

 



 

7 7 6  E F F E C T S  M E N U   

Process Only Left/Right Stereo Channel 
Choose whether you wish to edit the left or right channel here. Of course, this is only useful 
if the signal you wish to edit is a stereo signal. Clicking again deselects everything. 

 

Process Effects Offline 
All effects opened using this menu are calculated destructively, provided the option "Apply 
effects offline" is active. The option to work with a copy is available in order to preserve 
the original audio material. The "Create copy" option is already selected in the 
corresponding dialog. 

 

 



 

C D / D V D  M E N U  7 7 7   

CD/DVD Menu 
This menu contains special functions for the CD/DVD mastering process like setting CD 
tracks, sub-indices and dialogs for creating CDs or Audio DVDs. 

Samplitude allows you to directly burn CDs from any project virtual project or any stereo 
HD wave project. A sample rate of 44.1 kHz is required. 24 bit objects are converted into 
16 bit objects in the CD burning/CD trackbouncing process. 

"CD arrangement" mode is especially useful if existing wave files or wave projects are going 
to be used to burn a CD. Wave projects are arranged behind one another on one track in 
the VIP when loaded. The distance is set according to the CD pause time ("CD/DVD menu 
-> Set pause time (view page 792)"). 

Tip: If you want a finished virtual project to be burned as a track onto CD, use the 
command "CD/DVD -> Create CD -> Generate completely new file (view page 781)" 
beforehand to convert this multi-track project into a single wave project. Don't put any 
CD's into the drive and end the burning process after bouncing. The newly created Wave 
file can then be placed into the new CD VIP as a track object. 

 

Import Audio CD Track(s)… 
This function allows the import of audio data from CD/DVD drives. The data is imported 
digitally to eliminate loss in sound quality. During import, the CD tracks are created as wave 
files and integrated into the virtual project. 

If you want to import audio CD tracks into a virtual project, follow these steps: 

1. Open the "CD/DVD" menu or via the "File -> Load/import -> Import audio CD track(s) 
(view page 448)" dialog. 
2. If you have more than one drive installed, click the button "CD drive options" to open the 
drive list dialog. Select the desired CD-ROM drive and then close the dialog by clicking on 
OK. 

Note: The name of the currently selected CD-ROM drive is displayed above the button "CD 
drive options" along with read speed and copy mode displays. 

If the drive letter of the CD burner has changed in the meantime, you will have to reset the 
drive list in order to guarantee correct allocation. 
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3. Select the desired track(s) using the keyboard combination "Shift" or "Alt" and the cursor 
keys. 
4. Click on "Copy selected CD tracks..."  
5. Select a file name for the created wave file or HD wave project and click OK. 
6. The audio material is now copied onto your hard drive from the CD. A progress bar 
indicates the status. 
7. Close the track list and the drive list. New objects will appear in your VIP containing the 
audio material of you CD. 

 

The Track List Dialog 

 

Copy selected CD tracks: This button begins the audio copying process. All selected 
tracks are copied into a wave file or into an HD wave project. A new object is created in the 
active virtual project for every track. 

Volume controller: Control the playback volume for the digital preview function of the CD 
tracks here. 

Reverse: Jumps to the previous track. 
Play: Starts audio playback of the first selected track in the list. 
Pause: Stops playback; start again later at the same position by pressing "Resume". 
Stop: Stops playback. 
Forward: Jumps to the next track. 

Read start/end: This defines the read start and read end of the CD track. Isolate the start 
and end points in the CD track progress display by dragging with the mouse.  

Select all tracks: Select all tracks in order to copy the entire CD. Track selection is 
possible by pressing the "Shift" key and arrow keys. "Ctrl + mouse click" allows multiple 
tracks to be selected. 

freeDB title info: Click this button to access the freeDB database, which displays title 
information regarding the selected track. 

CD drive options (view page 779): Configure the system's drive list here. 
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Read ISRC: This option reads the ISRC (International Standard Recording Code) for the 
inserted CD. This is a 12-digit ID number that provides specific information like the 
originating country of the label, the label's company number, the year, and a sequential title 
number. The ISRC code is entered into the subcode when the CD is pre-mastered. 

Text file: Exports all of the information listed as a text file. 

Auto-crossfade mode: Activates "Auto-crossfade" mode when importing audio tracks. 
This adds crossfades automatically between the tracks. 

Import CD marker: If this option is activated, track markers will be placed at the beginning 
of the imported tracks automatically. 

 

CD Drive Options 

 

Configuration: This button opens the configuration dialog (view page 779) for special 
settings. Specify the drive name, host adapter number, SCSI ID, SCSI LUN, alias, copy 
mode, sectors per cycle, and sync sectors. 

Reset: Restores the default settings for the drive. 

Add drive: Creates a new drive in the list that requires special settings. 

Delete drive: Deletes a selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration data in a *.cfg file. 

 

CD-ROM Configuration Dialog 
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Drive name: Enter the name of the drive. 

Host adapter number: Enter the name of the SCSI host adapter. Normally, this value is 0. 

SCSI ID: Enter your CD-ROM drive's SCSI-ID. 

SCSI-LUN: Select the SCSI LUN parameter; this is normally 0. 

Alias: Select your CD drive's manufacturer. 

Copy mode "normal": Copies the audio data without any software correction. 

Copy mode "sector synchronization": Copies the audio data using a software correction 
algorithm. 

Copy mode "burst"" Optimizes the speed of the copying process. No software correction 
is applied. 

Sectors per cycle: View and change the defined number of audio sectors that are read in 
one read cycle from the audio CD. The greater the number, the faster the copying process 
will be. Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: This field shows the number audio sectors used for the software correction. 
A higher number provides improved synchronization, but this also slows the copying 
process. 

 

Import Audio DVD… 

 

This function allows the import of audio data from DVD drives. The DVD tracks are created 
as wave files and integrated into the virtual project during importing. 

To import audio DVD tracks into a virtual project, proceed as follows: 



 

C D / D V D  M E N U  7 8 1   

1. Open the dialog via "CD/DVD" or via "File -> Load/import -> Import audio DVD (view 
page 448)". 
2. If more than one drive is installed, click the "DVD drive" list to open the drive list dialog. 
Select the desired DVD drive. 
3. Select the desired track(s) using the keyboard combination "Shift" or "Alt" and the cursor 
keys. 
4. Click "Copy tracks"  
5. Enter a file name for the resulting wave file and click "OK". 
6. The audio material will be copied onto the hard drive from the DVD. A progress bar 
indicates the status. 
7. Close the track list. New objects will appear in your virtual project containing the 
selected audio material from the DVD. 

Note: Importing the audio track(s) from a video DVD is not possible! 

 

Make CD... 
This dialog starts the CD writing process. Samplitude contains high-quality and constantly 
updated CD burn routines which are licensed from "Point Software & Systems". 

Samplitude creates a so-called "TOC file" (Table of Contents) before the CD burning 
process starts, and this features the name of the current project and the file extension TCX. 
This file is saved via the same path as the project itself. 

 

On the fly: Use this mode if you want to write a CD directly from the project. All necessary 
calculations are made in real time during the burning process. This mainly involves: 

 Object effects, volume, and panorama settings 
 Fades/crossfades 
 Mixing tracks 
 Mixer track effects 
 Effects from the mixer master section 
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 Plug-ins used in the mixer 
 32-bit float -> 16-bit conversion and dithering 

Generate a completely new file for the whole CD: Use this function to create the CD in 
case the computer is not fast enough to burn on-the-fly. This mode calculates your project 
including all effects and creates a new file. Make sure there is enough space on your hard 
disk for this file (approx. 700 MB for a complete CD). 

Burn MP3 CD/DVD: All tracks are exported as individual MP3 files according to the 
selected format options and then loaded into the MXCDR tool. This provides the 
opportunity to load more files or begin burning a data CD. 

Detailed information about dithering options is available in "Dithering options (view page 
498)". 

freeDB title info: This function causes Samplitude to search the freeDB.org database for 
information that corresponds to the track and displays it if found. 

Print Studio: This button starts the external "Print Studio" program. Use this tool to easily 
print the content file of the current CD. Choose between a text style format to print the 
production documentation and a formatted printout for the CD jewel case. 

Show TOC: This button opens a text window with the details of the current table of 
contents. You can also open these current CD details in an external editor. 
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Show TOC... 
This button leads to the TOC (table of contents) dialog. 

 

Under "Display" you can select what extra information should be displayed. 

 Pause 
 Track Flags / ISRC (view page 778) 
 Sub-index position in the Track 

Under "Length calculation" you can select the "CD track length includes pauses" 
checkbox. This means that the time span between CD pause index and CD track index is 
factored into the length of the track. The following measurement units are available: "CD 
MSF", "Hours/Min/Sec" and "Min/Sec/Millisec". 

Using the "External editor" button you can call up a text editor of your choice, in which the 
TOC information should be opened. 

"Sonic Style" displays the TOC information in another layout. You can enter a working 
advice for the pressing plant in "Client/Label" field as well as the "Working order" field. With 
the "Adopt" button, this information will be included in the CD contents. 
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TOC - Export 
Pressing the "TOC export" button saves the information on the CD's contents as a *.toc 
file. 

 

Burn CD 

 

CDR write settings -> Simulate write process: Use this option to test the various write 
speeds. 

Test and compare CD after burning: This writes a temporary wave file to the hard disk 
while burning a CD. 

Note: This function requires increased performance when burning CDs, especially at higher 
burn speeds. The burned CD is then exported digitally and compared with the temporary 
file which is then deleted. 

Prepare CDR for subsequent data sessions: The audio CD is not finalized and data may 
be added to it by an external burn program. 
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Note: The non-final audio CD should not be used as a multi-session disc. Use it as a blank 
disc with less capacity. 

Activate burn proof: This option activates a quantization check after the burning process. 

Burn CD Text: CD text information is saved in the CD audio format for export via the "Load 
audio CD track(s)" function. 

CD-Text settings: This opens the CD-Text/MP3 ID (view page 792) editor. 

Note: Windows Media Player (up to version 10) cannot analyze CD-Text information. 

 

Create DVD-Audio... 
Samplitude enables you to burn DVD audio discs with any DVD burner. +R/-R/+RW/-RW 
formats may be processed. 

Note: DVD audio discs can only be played on players with DVD audio capabilities! These 
players can be identified by a visible DVD audio logo somewhere on the device. 

For Surround sound playback your DVD audio player has to have several analog outputs. 

Samplitude burns so-called "black discs", i.e. DVD audio without graphic menus. You can 
create video DVDs with menus, videos and slideshows using the video editing and DVD 
authoring program "MAGIX Movie Edit Pro". 

Audio may be recorded on a DVD audio disc in 16 and 24-bit rates at sample rates of 44.1 
and 48 kHz, and double and quadruple these rates are also possible. Up to 6 discreet 
audio channels are supported in 5.1 Surround, stereo, or 4.0. 

The only limitation is that the maximum guaranteed data rate of approx. 10 Mbit/s for 
hardware players may not be exceeded. For example, for 5.1 Surround 24-bit sound, a 
sample rate of only up to 48 kHz is possible, since at 96 kHz, the 10 Mbit threshold would 
be exceeded. 

The following playback times are approximations for the available space on a single layer 
DVD-R (44.1 kHz sample rate): 

Stereo 16-bit approx. 7 h 
Stereo 24-bit approx. 4.5 h 
5.1 Surround and 24-bit approx. 1.5 h 

 

Create Audio DVD 
First place CD track markers in your VIP. Audio CDs and DVDs can be subsequently 
burned from the same project. 
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When creating an audio DVD, the "trackbouncing" dialog will open. Select either "Create 
DVD audio" or "DVD video with stereo PCM".  

Note: Note that the creating a "DVD video with stereo PCM" does not provide authoring 
or image information. For extensive authoring options we recommend "MAGIX Movie Edit 
Pro". 

Format: 

You can choose between 16 and 24-bit audio. If "Create DVD audio" has been selected, 
then the sample rate may also be defined. 

An external program will open if "Path" is pressed. The path for this program is set but can 
be changed. 

 

Optionen: 

Calculate maximum amplitude: Display the maximum volume in dB after bouncing in 
order to correctly set equipment for additional editing or to correct the master level. Once 
bouncing has been completed, the corresponding information window will be displayed. 

Dithering: Every trackbouncing process may feature its own dithering process, 
independent of the global settings. This enables dithering to be bypassed or to apply the 
standard dithering (dithering featuring triangular noise).  

 

Use this dialog to apply dithering according to the system options or to access the 
dithering options in the system settings. The button value in brackets (e. g. Triang. or 
POW-r 1) indicates the currently set dithering algorithm. 
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Detailed information on this can be found in the menu reference under "File" -> "Program 
Preferences" -> "Dithering Options (view page 498)". 

DVD-Info: 

Learn details about project length, maximum DVD length, and select either PAL DVD or 
NTSC DVD. 

Source: 

Selected range only: In this case, trackbouncing is only applied to the length of the 
selected range in the arranger. This function does not work track-selectively, i. e. all tracks 
of the selected range, except for muted tracks, are used in bouncing. 

From the project start to the last object: In this case, the bounce process includes all 
objects from the project start to the end of the last object, plus the time it takes for the 
sound to dissipate. 

Complete project: If this option is selected, the entire virtual project is bounced. 

Surround trackbouncing: 

Save the individual tracks in the Surround project as mono tracks or stereo tracks.  

Note: Double the storage space of a DVD is required on the hard drive, since the project is 
bounced first and the DVD image is then created from the complete audio data that is 
burned. 

The burn dialog provides burner selection and speed. The red "Start" button creates a DVD 
image first, and the writing process starts after this is completed. 

 

Indices (Track markers) 
Set CD track index 
Use this function to set a track marker at the position of the play cursor (index makers). The 
numbers of previously set markers are adjusted automatically. Each title of a CD requires a 
track marker, which is typically placed shortly before the track starts. 

Use the function "Set Track Indices on Object Edges (view page 789)" to create a track 
marker automatically at each object in the virtual project. 

To manage the markers or rename them, use the "CD track/index manager (view page 
790)". 

Shortcut:   Ctrl + Alt + I 
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Set CD Sub Index 
Choose this option to place a sub-index marker at the current play cursor position. The 
numbers of the subsequent sub-index markers are customized automatically. 

Sub-index markers are not required for CD creation, but they allow CD players to cue to 
specific points within an audio track. 

 

Set CD pause index 
The CD pause index is a special Sub index (Index 0). Choose this option to place a pause 
marker at the current play cursor position. 

Pause markers allow CD players to switch their output to absolute silence until the next 
Track Marker. and to count backwards to the start of the next track. 

 

Set CD End Index 
This command marks the end of the CD. Setting an end marker corresponds with two 
main applications: 

1. It may be the case with some projects that the last object reverberates after its actual 
ending. To prevent Samplitude from cutting this section of audio during burning, you can 
place the CD end marker at an appropriate distance after the last object. 

2. If you only want to burn a project partially to a CD, place the first track marker at the 
desired position in the arrangement and mark the end of the burn process with the CD end 
marker. Remove all track markers prior to the first track to be burned and then set the end 
marker after the last track to be burned. 

 

Set Track Indices on Silence... 
If you are working with a longer audio file that contains multiple tracks, this function can be 
used to set track markers between the titles automatically. 

Min time: Period that the signal must be below the set level before a marker is set. 

Threshold db: A marker is set at the positions in the arrangement where the signal sinks 
below the threshold volume for the set period of time. 

Start number: Marker number after which automatic indexing starts. 

Prefix: Enter additional characters which will precede the marker numbers set by this 
function. This makes it possible to easily differentiate them from markers that may already 
exist. 

Add time (ms): Use this value to specify how many milliseconds will be set in front of the 
markers in the arrangement. 

Delete all markers with prefix: Deletes all markers in the project featuring the set prefixes. 
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Delete all markers: Deletes all project markers. 

 

Set Track Indices on Object Edges 
Choose this option to place a track marker at the beginning of every object in the VIP. 

 

Set Track Indices on Object Edges - Options 
Set also Pause Indices on Object Ends 
This option automatically generates pause markers at the object ends. This option allows 
you to set an offset for the generated track markers. 

 

Time Offset for Indices on Object Edges 
This dialog provides options for adding an offset before the object edges when placing 
indices. 

 

No indices on Object Crossfades 
This option prevents track indices from being placed between objects that are connected 
by a crossfade. 

 

Remove Index 
This function deletes a previously set track or sub-index marker. First, click the marker and 
access this function. 

Shortcut:  Del 

 

Remove All Indices 
Choose this option to delete all previously set track and sub-index markers. 

Shortcut:  Ctrl + Alt + Shift + I 
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CD-Title-/ Index-Manager 

 

This dialog displays all the CD tracks and sub-indices in the current project in a list. If you 
select the markers, you can change their numerical position in the list via the corresponding 
time input field and name or rename them. 
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CD Index Settings: Here you can set several options for the individual CD tracks, including 
Copy protection (SCMS) ,Pre-emphasis, Second generation protection, as well as 
ISRC code (view page 778):These settings can be transferred to all indices. 
Pre-emphasis means that high frequencies are accentuated before A/D conversion when 
creating a CD's. Even during A/D conversion high frequency quantization noises will 
emerge. Now the Audio signal with high accentuation will be written to the CD. When 
playing the CD player itself will use "Emphasis Bit", which means that the frequency 
accentuation (highs) will be curbed. This guarantees a 'true to original' sound, likewise Pre-
emphasis leads to a reduction in quantization noises. 
In practice Pre-emphasis is rarely used owing to the fact that the signal noise gap in the CD 
creation process already large enough (16 Bit) that quantization noises are negligible 
anyway. 
"CD text" opens a separate dialog field for entering CD text information. 
You can set new markers, CD tracks, CD sub-indices, and CD pauses by clicking on 
the corresponding buttons. 
Use the double arrow buttons to jump to the previous or next marker. 
"Delete selected" Deletes the selected markers. 
"Delete all Markers" Deletes all markers. 
"Play marker" starts playback from the position of the selected marker. 
"Play loop" plays a loop around the marker. 
"Stop" stops playback. 
"OK" Applies your settings. 

 

CD disc options 
This dialog opens the settings for the current CD. 

 

CD title:  The title which will be written to the CD with the CD text. 

UPC/EAN Code: The EAN code (European Article Code) is a 13 digit number which is 
used in retail. The 12 digit UPC (Universal Product Code) is exclusively used in Canada and 
America and can, if necessary, be extended with a final '0'. 

Number of first CD track: Under some circumstances (such as "track at once" writing), 
the title number of the first CD track may be set. This is not important in "disc at once" 
mode, since the CD will always start with title no. 1. 

Allow bonus tracks before track 1: If this option is active, a so-called "hidden track" may 
be burned on the CD. The first track marker will now be applied to the second audio 
object. The "hidden track" may only be accessed on standalone CD players via the "STEP 
BACKWARD" button. 
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CD-Text/MP3-ID-Editor 
Here you can enter text information for the CD you are going to burn. The CD track names 
are adopted from the CD track marker's labeling in the VIP. All information is also 
contained in the project, but in this dialog window you also have the possibility to save all 
entries in a separate file. (*.cdt) 

 

Note: The number of maximum available characters for the entire CD is 2824. 

If you can used MP3s in a VIP that have ID3 tags then using of the "Write ID3 tags to 
original file" button you can ensure that data made in the CD text/MP3 ID editor is written 
back to the corresponding MP3 file without separate export. This will be applied to all 
corresponding MP3s by pressing the "All" button. 

 

Set Pause Time 
Use this function to set the preset pause duration between objects. Audio files that you 
load into your virtual project will be ordered sequentially on one track. The value specified 
here will be set as standard pause. 

 

Set Start Pause Time 
Use this function to set the length of the pause in front of the first track. A regular value for 
the start pause would be about 2 seconds. 

 

CD Arrange Mode 
If this is activated, Samplitude arranges recently added objects to insert a Red Book 
Standard-compatible pause between the objects. 

 Open a new project. 
 Activate "CD arrange" mode. 
 Load wave files, audio tracks, or make a recording using a microphone. 
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You will see gaps between the individual objects in the project. These are the inserted 
pauses. The duration of inserted pauses may be specified in the "Set pause duration" 
dialog. 

 

Get freeDB Title Info 
Use this command to start a search request where the freeDB database searches for and 
provides information on tracks from you project. 

freeDB acquires information on CD track names and artists. 

 In the CD import dialog, you can request information about the desired CD. 
 In the CD burning dialog and in the CD/DVD menu, you can search based on the set 

track markers. 
 An inverse search is also possible with "Online CD search" in the arranger. You can set 

track markers automatically for known albums. 

 

freeDB Options 
Submit CD to freeDB 

 

Enter all of the CD's information into the dialog. Press the "Submit" button to transfer the 
data to freeDB. 

 

freeDB User Data 
The entries for username, local computer name, and email address are used for 
communication with the freeDB server. 

 

freeDB Proxy Options 
Enter server data like server, port number, server list, and timeout here. 
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Clear freeDB Cache 
With this function you can delete the cached data from freeDB. 

 

Search CD Online and Set Track Indices 
Search for a CD online by entering the CD name or artist. The track markers are requested 
from the online database. If the search was successful, click "Disc ID" for the desired CD. 
You'll now see a text page with the track data. 

If you copy the link from your browser into the text field in the dialog, you'll be able to apply 
the CD track markers of the located CD to your arrangement. 

 

Show CDR Drive Information… 
Choose this option to display information about the burner. 

This includes the manufacturer, drive name, hardware revision, cache size, and the 
features supported by the drive mechanism: 

 Supports disc-at-once 
 Supports indices 
 Supports second generation copies 
 Supports catalog numbers 
 Supports ISRC 
 Supports CD text 
 Supports CD RW 

The "disc at once" feature is extremely important for Red Book-compatible audio CD 
production. CDs burned in this way are accepted as masters by CD manufacturers. 

 

Show CDR Disc Information… 
This dialog displays information about the blank CD inserted into the drive, including type, 
track count, session count, total disk space, remaining space, and status. 

The most important value is the maximum length under "Total memory" in minutes and 
audio frames, which cannot be exceeded during production (e.g. 359995 audio frames or 
79 minutes and 59 seconds and 70 MSF). 
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audioid 
audioid is part of the MPEG-7 standard and for identifying audio material. In this case, 
audio data is recognized automatically and associated information, e. g. track or artist 
name, is provided in real time. 

 

Here are the options from which you can choose: 

 Analyze audio at the playback position 
 Analyze selected object 
 Analyze all objects 
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View Menu 
This menu contains tools for changing the screen view of Samplitude. 

 

Mixer 
Use this menu item to open the mixer. 

Detailed information about the mixer is available in the chapter "Mixer (view page 158)". 

Shortcut:  M 

 

Transport Console 

 

Shortcut:  Ctrl + Shift + T 

Detailed information about the transport control is provided in "Screen elements -> 
Program interface -> Overview -> Transport console (view page 52)". 

 

Time Display 
Shortcut:  Ctrl + Shift + Z 

This function shows a zoom-enabled time display. 

 

This lets you read the current time position, even if you're further away from the computer. 
Font and colors of the display may be selected in the context menu by right clicking on the 
time display. 

The number of lines/fields displayed may be set between 1 and 5 in the context menu for 
the time display. 
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Double clicking lets you select and edit most sizes. 

 
 

Time display – current field 
Position/start of range: Displays the current position/current play cursor or the beginning 
of the range. When moving the objects, you can see the starting position of the object 
here. Enter a negative number into the range when editing and the play cursor will be set to 
the end of the range. 

Range length/object length: Specify the range length/object length here. If a negative 
amount is entered, the range end will be displayed instead of the range start. 

Range end: Set the range end/object end here. If a negative amount is entered, the range 
start will be displayed instead of the range end. 

CD position: This displays the following current positions: 

 Position from CD start 
 Position to CD end 
 Position from current CD track 
 Position to CD track end 

Mouse position: This value displays the current mouse position and cannot be edited. 

Mixer value: This value displays the mixer fader that was just changed, as well as the 
volume or pan fader in the track header (cannot be edited). 

Recording position: This value displays the current recording position. 

Remaining recording time: This value indicates how long recording may continue until the 
hard disk is full. 
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Visualization 
Shortcut: Ctrl + Alt + Shift + V 

The visualization screen displays the audio material graphically. The interface allows you to 
design multi-visualizations individually. You can integrate the visualization interface into the 
Docking Bay (view page 51) or open it in its own window. 

 

The visualization is, as standard, sub-divided into five display windows. Choose from the 
following display options for every window: Peak meter (control display), Loudness meter 
(only Sequoia), Oscilloscope, Bit meter, Correlation meter, L/R oscilloscope (phase 
correlation), Surround meter, Direction meter, Spectroscope, Spectrogram  and Tuner. 

The visualization display can be adapted easily to your personal presets. Right click on 
one of the visualization windows to open up a context menu, in which you can change 
the window's settings. The size of the window can be changed by dragging its edges in 
the desired direction. 
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Device: Here you can set which output the visualizations should refer to. With this option 
you can determine which device should be displayed if multiple audio devices available. If 
you, for example, mix more than four submix busses that are each routed to a different 
device, you can display each bus individually. 

Visualization layout: Here you can load preset layouts, save individualized layouts or 
modify layouts by adding or removing columns and rows.  

Reset (All): This resets all the displays of the opened visualization. 

Settings...: Select this menu entry to open the visualization settings dialog.  

 

Now, in the "Instrument" field look for the desired display instrument. According to the 
selection a range of presets is available in the preset list. Confirm your selection with 
"Apply". 

Furthermore you can load or delete the settings using the corresponding buttons. 

Load/Save settings 

If you have saved your own presets in the available "fx-presets" directory, these will be 
available here under "Load setup / Save settings". Various presets are also provided, for 
example the K-metering settings K-12, K-14, and K-20 (view page 803). 

Activate docking for visualizations: With this option you can turn on docking for 
visualizations.  
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Peak meter 

 

The (Multi-) peakmeter (Instrument multimeter) displays the volume during playback in dB. 
The thinner, outer bars show the Program Peak Meter (PPM Meter) whilst the thicker, 
inner bars display the VU meter, as you may still know from your analog equipment. 

If you only want to see either the PPM display or VU display, select the corresponding 
display instrument. 

 

You can also determine the display configuration for Multimeter. 
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PPM-Meter 

 

Headroom (dB): With this you can initiate a level offset which will be globally added before 
measuring. This is the reason why different systems are calibrated differently. A value of 9.0 
(IRT) e.g. ensures that the level with + 9 dB is calculated in such a way that the extra 9 dB 
has got more headroom at its disposal, provided your player is accordingly calibrated. 

Integration time - PPM (Mms): This constant ensures that the peakmeter's reaction time 
is delayed by the set value, so the display doesn't appear quite as fast for individual level 
peaks. The created lag is modeled on the analog behavior of old, traditional peak meters. 

Release time (dB/s): The smaller you select this value, the slower the display bar of the 
peak meter move when returning. A typical value would be e. g. 13,3, which corresponds 
to a release time of 1,5 seconds at 20 dB. 

Peakhold (ms): With this value you can specify how long the level peaks shou´ld remain. 

Cut-off frequency (Hz): With this highpass filter you can filter out the DC component so 
that it doesn't enter the peakmeter measuring. 
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Overmodulation threshold (dB): This values indicates from which dB value clipping is 
displayed, i .e. when the display hits the red. 

Minimum number of overmodulated samples: This value represents the number of 
consecutive samples that are allowed to exceed the overmodulation threshold before the 
display hits red. 

Activate True Peak Measuring: In True Peak mode you can measure the peak meter with 
fourfold oversampling. 

PPM-Meter Scale 

You can choose different display options on this page. 

 

Scale: Select from a range or different scale display settings. 

Reference level (Scale offset): Enter the value for the reference level here. 

Minimum/Maximum: Here you can set the min/max value. You can restrict or expand the 
scale's range value. 
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Color settings: Enter the colors and thresholds for the overmodulated, critical, optimal and 
undermodulated ranges. 

 

Note: If you define a threshold for the optimal range which is higher than the reference level 
minimum, a defined color will be displayed for the undermodulated range, should it fall 
below the set threshold level. 

VU-Meter 

On this page, just as with the PPM meter, the parameters Headroom, Integration time, 
Peak hold DC-Filter andCut-off frequency are available. 

VU-Meter Scale 

On this page you can, just as with the PPM-meter scale, select the display options and 
change the color codes for the bar graph, which employs the same scale representation as 
the external meter. 

 

K-Metering 
In the visualization area of the peak meter, there are a number of presets for the K-
metering system. Load the supplied presets via the "Settings..." dialog of the context 
menu, to implement metering according to K-12, K-14 and K-20 norms. The 
corresponding presets can be found in the "fx-preset > K-12.vis/K-14.vis/K-20.vis" 
folder. Uniform reference volumes on different media can be achieved especially when 
mastering under normalized listening conditions. The peakhold display continues to show 
signal peaks and can be used to avoid clipping. 

The "K-system" refers to the metering system developed by Bob Katz, and it has become 
the standard for monitoring audio signals during mastering. K-System Metering enables 
uniform calibration and monitoring. You can use it to easily exchange audio material 
between different studios and have matching monitoring results. With K-System Metering 
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it's not so much the loudness, but rather the musical dynamics that take center stage. 
Setting the level to 0 dB sets the reference volume which no longer matches the maximum 
level, as often used to be the case. 

According to the program and audio material, three different meter scales can be used: 

K-20 = 0dB reference (83dBSPL) at -20dBFS 
K-20 is especially recommended when using audio with large dynamics like classical 
music or film sound.  
K-14 = 0dB-Reference (83dBSPL) at -14dBFS 
K-14 is especially recommended for rock and pop productions or for Surround Sound. 
K-12 = 0 dB reference (83 dBSPL) at -12 dBFS 
K-12 is especially recommended for radio and television networks. 
 

The corresponding scale for setting up the monitoring volume is calibrated with pink noise. 
If you set pink noise to 0dB, you get a level of 83dB SPL, a volume reference that 
originated in the film world. 

 

Oscilloscope: 

 

The oscilloscope displays the signal amplitude over the time curve. 

 

Bit Meter 
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The bit meter shows you the rate at which the signal is being calculated at and which 
maximum editing rate is possible. 

 

Correlation meter 

 

With the correlation meter you can read phase offsets between the two stereo channels, 
and examine how much has been deleted. A value of +1 corresponds with 0° phase 
shifting. The value -1 corresponds with 180° phase shifting. If the signal display is in the 
left, red area between 90° and 180° the signal will no longer be reproduced properly over a 
mono receiver. 

In the settings dialog you can select the colors for Mono and Stereo and mono compatible 
ranges, threshold values can be set too. 
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Surround meter 
The surround meter displays the signal using the surround settings that are set as global. It 
shows each speaker's level in a polygon on a sound representative area. 

 
 

L/R Oscilloscope (phase correlation): 

 

Phase correlation provides information on the distribution of the stereo image in your 
recording. A mono recording would be displayed as a vertical bar in this view. A song 
produced in stereo is by contrast shown as "diffuse ball," because multiple instruments 
were assigned to the mix in different panoramic positions.  

The wider the display, the wider the stereo field of the recording. Please note, that a 
broadening of the display implies more deletions, and in turn that the signal is not as mono 
compatible. 
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If the signal display tends to be diagonal the stereo mix is not balanced. A channel would 
be accordingly louder than the other. 

In the settings dialog you can access the various grid settings. You can choose between 
Mid/Side, L/R, Hybrid and a mode for measuring signals. 

 

The image is correspondingly increased in pre-amplification mode, to ensure readability. 
You can also switch off this mode and set a constant amplification factor instead. 

Using the "Speed" function you can set the rewind speed at which the curve is dimmed. 

Finally you can set the display color. 

 

Direction meter 

 

The direction meter displays the signal's detection direction. The width corresponds to the 
correlation measurement. 
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In the settings dialog you can select the colors for Mono and Stereo and mono compatible 
ranges, threshold values can be set too. 

 

Spectroscope 

 

In the Spectroscope the signal is divided up into individual frequency ranges. The level 
amplitude of each frequency band displays volume of the relevant frequency range. This is 
a way of telling whether certain frequency bands are being strained.  

 

Spectrogram 

 

In the Spectrogram the signal is displayed as frequency proportions in a time curve. The 
volume of frequencies is visualized by its brightness. 

The spectrogram is designed to be able to immediately detect noise in your recordings. 
Audible distortion noises are mostly louder than the music, and are usually limited to a 
certain frequency spectrum. They are highlighted with colors in the Spectrogram. 

In Samplitude you can remove unwanted noise with the help of Spectral cleaning (view 
page 72). 

 

Tuner 
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The tuner displays the corresponding pitch levels featured by the signal. Use the 
visualization to tune a guitar or other instruments.  

 

Video Window 
This function opens the video window, e.g. to apply a media link. 

 

Track Editor 
This menu item opens the track editor on the left edge of the arrangement window. This 
enables access to all important track parameters for the selected track. 

Detailed information about the track editor is provided in "Screen elements -> Track editor" 

Shortcut:  Ctrl + Alt + Shift + E 

 

Manager/Docker 
You can open the Manager/Docker here. In addition to the Manager windows (view page 
138) now Visualization, Time display, Transport console, Sound pool, Object Editor and 
MIDI Editor are grouped as a tab window by default in a "Docker". 

 

Manager 
The manager features the following sub-windows: 

 File browser (Ctrl + Shift + B) 
 Object manager (Ctrl + Shift + O) 
 Track manager (Ctrl + Shift + S) 
 Marker manager (Ctrl + Shift + Alt + M) 
 Range manager (Ctrl + Shift + Alt + B) 
 Take manager (Ctrl + Shift + Alt + T) 
 VST instruments manager (Ctrl + Shift I) 

Detailed information on the individual manager sub-windows is provided in the "Manager 
(view page 138)" chapter. 

 

New Manager... 
Use this function to open a new manager window. 

 

Control bars 
Main Toolbar 
Use this command to hide or show the toolbar. A check behind the menu item indicates 
that the toolbar is visible. 
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Main Toolbar 2 
Use this command to hide or show the second toolbar. A check behind the menu item 
indicates that the second toolbar is visible. 

 

Positionbar 
Use this command to hide or show the position bar using positioning and zoom buttons. A 
check after this menu point indicates that the status bar is visible. 

 

Positionbar 2 
Use this command to hide or show the second position bar and the positioning and zoom 
buttons. A check after this menu point indicates that the status bar is visible. 

 

Punch/Playbar 
Use this command to hide or show the punch/playback bar using the button for various 
playback functions and punch recordings. A tick after this menu point shows that the 
status bar is visible. 

 

Mouse Mode Toolbar 
Use this command to hide or show the mouse mode bar to select the individual mouse 
modes. A check behind the menu item indicates that the mouse mode bar is visible. 

 

Rangebar 
Use this command to hide or show the range bar for selecting ranges. A check behind the 
menu item indicates that the range bar is visible. 

 

Snap bar 
Use this command to hide or show the grid bar. 

 

Workspacebar 
Use this command to hide or show the workspace bar; this provides various tools for 
button assignment according to application. A check behind the menu item indicates that 
the workspace bar is visible. 

 

Buttonbar 
Use this command to hide or show the button bar featuring the track editor, object editor, 
MIDI editor, visualization, transport control, mixer, and manager. A check behind the menu 
item indicates that the button bar is visible. 

 

Statusbar 
Use this command to hide or show the status bar. A check behind the menu item indicates 
that the status bar is visible. 
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Autoscroll 
Switches autoscroll on/off. 

See "Playback -> Playback parameters (view page 578)". 

Keyboard shortcut:    Scroll lock 

 

Autoscroll Soft 
Toggles between page and soft autoscrolling. 

See "Playback -> Playback parameters (view page 578)". 

Keyboard shortcut:  Shift + Scroll lock 

 

Rebuild Graphic Data 
The graphical display of a project is recalculated in this case. This is usually unnecessary, 
but does help with errors or inaccuracies in the display after offline editing. 

 

Clips 
These Menu items allow you to take advantage of Samplitude's ability to simultaneously 
display one two or three different "views" of the same project. 

 

If you select the option "2 (clips)", two view windows, each of which can be worked in 
independently, open one under the other. This way, for example, you can view the 
complete sample in one window, while magnifying a specific area in the other. 
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The "3 (clips)" mode can be especially helpful when searching for loop points in the wave 
window. In the top large window the entire sample can be viewed, in the bottom left 
window area the beginning can be viewed and in the bottom right window area the 
end of the loop is displayed. This view can also bee seen by using the shortcut "B". The 
corner values of the three windows can be independently adjusted. 

You can determine the areas through window borders once and for all by selecting a start 
of a segment by clicking the clip bar at the corresponding position, and then selecting the 
end of the segment in a different clip with the Shift key held down. 

When using the zoom function on a specific clip, it is necessary to first select it by using 
scroll bars to the right or to the bottom. 

Shortcuts: 
Show range:   Shift + B 
Split range (shows 3 sections)  B 

The menu commands "Activate previous clip" and "Activate next clip" switch the active 
segment. 

 

Activate destination 
This command activates the previous/upper clip. 

Shortcut:  Page up 

 

Activate source 
This command activates the next/lower section. 

Shortcut:  Page down 

 

Hide Submix/AUX Busses 
Use this command to remove the buses from view in the arranger window. This may 
improve the display in case you are working with numerous tricks. 

Attention: This function keeps bus tracks hidden, even if a check is set in the track 
manager next to the "Arrangement" column. 

 

Grid view 
Show Grid 
This command activates the coordinate grid for the project window. 

Shortcut:  # 
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Grid Lines 
This provides a choice between various line layouts for the grid display. The display of the 
grid helps makes the positions in the arranger window more legible. 

 

Units of Measurement 
Specify the units of measurement for the grid view here.   

The following units are available: samples, milliseconds, hours/mins/secs, SMPTE, 
SMPTE/milliseconds, CD-MSF, feet and frames 16 mm (40 fpf) and feet and frames 35 mm 
(16 fpf), noise reduction (meter). 

The units of measurement selection will affect the start and length of the current range in 
the project window, the grid width and the details of the position of the play cursor (position 
line). 

 

Snap Active 
This functions turns the grid on or off. 

Shortcut:  Ctrl + # 

 

Grid 
Here you can set the grid type. To choose from: 

 Object grid 
 Grid range 
 Beat grid 
 Beat grid (relative) 
 Frame grid 

Detailed information on snap and grid settings can be found under "File -> Project 
Properties -> Snap and Grid Setup (view page 467)...". 

 

 

Snap and Grid Setup 

Detailed information on snap and grid settings can be found under "File -> Project 
Properties -> Snap and Grid Setup (view page 467)". 

 

Show 2nd Grid Line 
This command displays a second grid. 

 

Exchange Grids 
This command exchanges the upper and lower grids. 
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VIP Display Mode 
 Definition... 
 Mode 1 
 Mode 2 
 Toggle between mode 

Detailed information on display options can be found via "File > Program Preferences > 
Definition > View Options (view page 491)". 

 

Overview Mode 
"Overview" mode displays all objects in the project clearly arranged below the arranger 
tracks. The mouse pointer becomes a magnifying glass in this area. The section selected in 
"Overview" mode specifies the size of the display and position section displayed in the 
arranger. You can position the section in the overview by clicking the desired location. On 
the other hand, the scroll bar in the arranger allows the selected section to be controlled in 
the overview.  

 

To select the desired section, right click (or left click + "Shift") and drag out a lasso across 
the overview as required in the overview. If another position in the overview is required or a 
new lasso is drawn by left clicking, then the horizontal (i.e. temporal) position in your 
arrangement will change; the vertical range of the section (i.e. the display of the selected 
track) remains preserved. 

In single-track virtual projects (VIP) and wave projects, the waveform will be shown in 
"Overview" mode. 

 

Fix vertically 

This menu item is hidden by default. To display it again, activate it in the menu settings via 
"File -> Program Preferences > Edit Keyboard Shortcuts and Menu (view page 488)". 

If this function is inactive, i. e. the check to the left of the menu item is not set, then ranges 
in Samplitude's wave editor may be moved horizontally and vertically. In this mode, 
additional functions such as amplitude measurement for the De-clipper and the dynamics 
processors are available. Get level from area height: This function sets the DeClipping level 
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according to the height of the selected area in the wave project. This is useful when an 
overmodulated area has been previously selected exactly, and now has to be repaired. 

If you have set "Vertical lock", the range display will include the complete wave editing 
window, like normal. 

 

Store Position and Zoom Level 
Save the current position and zoom level here. These may be retrieved via the menu item 
"Get position and zoom level" in the "View" menu and on the number pad of your 
keyboard. 

The first three numbers on the keypad may be used to save presets. These configure the 
setup buttons 1, 2, and 3 in the arranger window. 

Shortcut:  Ctrl + Num 1 

  Ctrl + Num 2 

  Ctrl + Num 3 

 

Get Position And Zoom Level 
Load the saved position and zoom level here. This may be retrieved via the number pad on 
the keyboard. 

The first three numbers on the number pad can be used to save presets. 

Shortcut:  Num 1 

  Num 2 

  Num 3 

 

Store Zoom Level 
Save the current position and zoom level here. These may be accessed via the menu item 
"Get position and zoom level" in the "View" menu and via the number pad. 

The numbers 4, 5, 6 on the keypad may be used to save presets. These configure the 
zoom buttons 1, 2, and 3 in the arranger window. 

Shortcut:  Ctrl + Num 4 

  Ctrl + Num 5 

  Ctrl + Num 6 
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Get Zoom Level 
Load the zoom level here. This may be retrieved via the the number pad on the keyboard. 

The numbers 4, 5, and 6 on the keypad may be used to save presets. 

Shortcut:  Num 4 

  Num 5 

  Num 6 

 

Horizontal 
This menu contain horizontal functions for clip control, which are also partially represented 
in the bottom position bar as buttons. 
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Shortcuts: 

Half section left Ctrl + Alt + Left arrow 
Half section right Ctrl + Alt + Right arrow 
Cut to play cursor Ctrl + Alt + , 
Clip to the start of field Ctrl + Alt + B 
Clip to end of field Ctrl + Alt + N 
Zoom in Ctrl + Left arrow, Up arrow 
Zoom out Ctrl + Right arrow, Down arrow 
Show all Ctrl + Alt + Up arrow 
Zoom to range Ctrl + Alt + Down arrow 

If you can't see the play cursor in the current VIP's image section, then the command 
"Section to play cursor/Last stop position" moves the visible section to the current play 
cursor position. In a stopped state the picture section jumps to the previous playback 
position. 

 

Vertical 
This menu contains vertical functions for clip control, which are also partially represented in 
the bottom position bar as buttons. 
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Shortcuts: 

Half section up Shift + Page down 
Half section down Shift + Page down 
Zoom into waveform Ctrl + Page up 
Zoom out of waveform Ctrl + Page down 
Zoom Out Volume Automation Ctrl + Shift + Page up 
Zoom Out Volume Automation Ctrl + Shift + Page down 
 

Cascade 
This function arranges all open windows one behind the other. 

 

Tile 
This function arranges all open windows one one top of the other. 

Shortcut:  Enter 

 

Untile 
This function arranges widows in the same way as they were prior to "tile vertically". 

Shortcut:  Shift + Enter 

 

Window 
Arrange Icons 
Arranges the project icons along the lower edge of the monitor. 

 

Close All Windows 
This closes the currently opened project. A confirmation will ask if you want to save the 
project. 

Shortcut:  Ctrl + H 

 

Wave Projects to Icons 
Samplitude will display the wave projects as icons along the lower edge of the arranger 
window. 

 

Hide All Wave Projects 
Use this function to hide the wave project's icons and windows. 

 

Half Height 
This command displays only half of the Samplitude screen. 
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System information 
Use this function to open a new window with the system information. 

Display the date/time, number of open files, the free memory on all connected hard drives, 
the configuration of Windows resources, and the amount of memory used by Samplitude. 

 

FTP Download... 
This menu item opens an FTP download window. Enter your FTP access data and click on 
"Connect..." to establish an FTP connection immediately. Files may be downloaded, but 
not uploaded. 

 

1, 2, ... 
Samplitude shows a list of the currently opened projects in the last section of the "Window" 
menu. A check shows which project is active. Select a project from this list to activate it in 
the project window. 
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Help Menu 
Help Menu 
This command displays the overview page of the help file. You can jump to specific 
commands or read instructions on this page. 

 

Help Index… 
Choose this option to display a list of available help contents. 

 

Context Help… 
This command turns the mouse cursor into an arrow with a question mark. Click any menu 
item or button in one of the toolbars to receive more information. 

Shortcut:  Shift + F1 

 

Open Manual… 
Use this command to open a PDF version of the Samplitude manual. 

 

About Samplitude... 
This displays copyright information and the version number of Samplitude. At the very 
bottom, you can see the serial number required for support purposes. 

 

Start Wizard / Tip of the Day 
This command opens Samplitude's start selection. This command may also be used to 
display the demo project, most recently opened projects, the "tip of the day", or the intro 
video. 

The start selection may be used to add a new multi-track project, load an existing multi-
track project, load a wave project, and access the recording options for a wave project. 

Clicking the corresponding check box ensures that the start dialog will always open when 
the program is launched. 

 

Dongle Activation... 
Detailed information about activation is provided in "Installation" 
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Destructive Effect Calculation….......................................................... 483, 504 
Destructive Wave Edit Mode....................................................................... 473 
Device Address/Driver Communication ....................................................... 474 
Device Setup (Track Assignment, Routing).................................................. 469 
Direction meter........................................................................................... 807 
DirectX and VST effects.............................................................................. 186 
Display automation curves options ............................................................. 338 
Display object automation .......................................................................... 338 
Display quantization ................................................................................... 292 
Display selected curves only ....................................................................... 338 
Display Subtracks ...................................................................................... 534 
Display track automation (default setting) .................................................... 338 
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Distortion....................................................................................................662 
Dithering.....................................................................................................483 
Dithering Options... .....................................................................................498 
Docking........................................................................................................51 
Dongle Activation........................................................................................820 
Draw mode in the Surround panning dialog.................................................240 
Draw Wave .................................................................................................510 
Draw waveform in the wave window .............................................................72 
Drawing automation curves in the VIP track.................................................240 
Drawing Surround automation curves..........................................................239 
Drawing waveforms with the pencil tool.......................................................111 
Driver System .............................................................................................474 
Drum Editor ................................................................................................269 
Drum Map Editor ........................................................................................272 
Drum Maps.................................................................................................271 
Duplicate Objects .......................................................................................546 
Duplicate Objects (in Place).........................................................................573 
Duplicating, copying, and inserting objects..................................................127 
Dynamic filter ..............................................................................................681 
Dynamics (Compressor/Expander/Gate/Limiter) ..........................................607 
Dynamics Effects ........................................................................................606 
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Economy Track.............................................................................................29 
ECOX – Echo/Delay ....................................................................................733 
Edit.............................................................................................................546 
Edit audio file ..............................................................................................545 
Edit automation curves ...............................................................................342 
Edit curve – copy, paste, delete ..................................................................337 
Edit fades in the object editor or by using the handles .................................128 
Edit in the Tempo Track (only BPM Mode)...................................................307 
Edit List (*.EDL)...........................................................................................442 
Edit Menu ...........................................................................................413, 505 
Edit Object Freeze ......................................................................................564 
Edit object parameters................................................................................145 
Edit range parameters.................................................................................149 
Edit Root VIP ..............................................................................................549 
Edit selected curve .............................................................................337, 598 
Edit time display .........................................................................................530 
Edit Toolbars ..............................................................................................490 
Edit Track Freeze........................................................................................535 
Editing an object destructively.....................................................................131 
Editing curves .............................................................................................337 
Editing MIDI data in the score sheet ............................................................285 
Editing MIDI objects ....................................................................................244 
Editing Surround sound automation ............................................................240 
Effect as AUX .............................................................................................183 
Effect as insert ............................................................................................183 
Effect as pre-master bus.............................................................................184 
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Effect routing.............................................................................................. 181 
Effect routing/plug-ins dialog ...................................................................... 174 
Effect routing/plug-ins dialog parameters.................................................... 175 
Effects – organization and workflow............................................................ 178 
Effects - Signal flow...................................................................................... 93 
Effects and Plug-ins in an Overview ............................................................ 185 
Effects in audio objects ................................................................................ 93 
Effects in Surround projects........................................................................ 239 
Effects in tracks............................................................................................ 93 
Effects Menu .............................................................................................. 600 
Effects Sequence/Plug-ins.......................................................................... 174 
eFX_Chorus/Flanger ................................................................................... 681 
efx_Compressor ......................................................................................... 620 
eFX_Phaser................................................................................................ 681 
eFX_Reverb................................................................................................ 646 
eFX_StereoDelay ........................................................................................ 646 
Elastic Audio 

Description of all control elements........................................................... 655 
Overview of keyboard commands and configuration of the mouse wheel. 660 

Elastic Audio .............................................................................................. 652 
End of Range <- 0...................................................................................... 521 
End of Range -> 0...................................................................................... 521 
Envelope, EQ ............................................................................................. 642 
EQ116 ....................................................................................................... 622 
Equalization........................................................................................ 763, 765 
essentialFX......................................................................................... 219, 685 
Event list .................................................................................................... 278 
Exchange Grids.......................................................................................... 813 
Export as Dump ......................................................................................... 454 
Export Audio .............................................................................................. 449 
Export MIDI File... ....................................................................................... 456 
Export project as AAF/OMF........................................................................ 462 
Export Video Sound... ................................................................................ 455 
Extended file search ................................................................................... 143 
Extended MIDI Quantize ............................................................................. 556 
External effects........................................................................................... 469 
External hardware effect integration ............................................................ 181 
Extract ............................................................................................... 517, 573 
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Fade .......................................................................................................... 428 
Fade In/Fade Out ....................................................................................... 119 
Fade In/Out… ............................................................................................ 605 
FFT - Filter.................................................................................................. 634 
FFT Filter/Sound Cloner.............................................................................. 626 
FFT Filter/Spectral Analysis (Offline) ............................................................ 629 
FFT-Analysis filter ....................................................................................... 630 
File browser ............................................................................................... 139 
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File manager options...................................................................................142 
File Menu............................................................................................412, 439 
Filter curves ................................................................................................680 
Filter setting parameters..............................................................................675 
Filter/EQ .....................................................................................................757 
FILTOX – Multimode Filter ...........................................................................735 
Find zero crossings.....................................................................................520 
Fix vertically ................................................................................................814 
FLAC... .......................................................................................................451 
Flip Range Left ...........................................................................................520 
Flip Range Right .........................................................................................520 
Folder tracks.................................................................................................61 
Font for Manager….....................................................................................491 
Font for Time Display…...............................................................................491 
Font Selection… .........................................................................................491 
freeDB........................................................................................................793 
Freeze Objects ...........................................................................................563 
Freeze Track...............................................................................................534 
Freezing VST instruments ...........................................................................325 
Frontier AlphaTrack.....................................................................................380 
Frontier TranzPort .......................................................................................383 
Frozen Submix/AUX Bus.............................................................................535 
FTP Download... .........................................................................................819 
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Gain and AUX sends...................................................................................116 
Gain Control ...............................................................................................764 
Gate ...........................................................................................................694 
General Functions in the Project Window ......................................................97 
General system requirements........................................................................16 
Get  zoom level...........................................................................................420 
Get freeDB Title Info....................................................................................793 
Get position and zoom level ........................................................................420 
Get Position And Zoom Level......................................................................815 
Get Range ..................................................................................................523 
Get Range Length ......................................................................................523 
Get Zoom Level ..........................................................................................816 
Global buttons ............................................................................................167 
Global MIDI devices ......................................................................................32 
Global solo modes......................................................................................171 
Glue Objects.......................................................................................136, 548 
Graphic display...........................................................................................641 
Grid ............................................................................................................813 
Grid Lines ...................................................................................................813 
Grid Position Marker ...................................................................................305 
Grid Tapping...............................................................................................305 
Grid toolbar/snap buttons .............................................................................66 
Grid view ....................................................................................................812 
Grid/marker bar ..........................................................................................428 
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Groove template......................................................................................... 260 
Group Objects............................................................................................ 559 
Group track controls .................................................................................. 533 
Group/ungroup objects .............................................................................. 133 
Grouping mechanism for Surround FX, Surround control group .................. 239 
Groups....................................................................................................... 559 
Guitar Amp................................................................................................. 760 
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Half Height ................................................................................................. 818 
Handles ..................................................................................................... 428 
Hard disk ..................................................................................................... 16 
Hardware Controller ........................................................................... 360, 475 
Hardware Monitoring .................................................................................. 424 
Harmonizer ................................................................................................ 657 
HD Wave (*.HDP) ....................................................................................... 440 
Heal/Unsplit Objects........................................................................... 515, 548 
Help Index… .............................................................................................. 820 
Help Menu ......................................................................................... 420, 820 
Hide All Wave Projects ............................................................................... 818 
Hide Automation ........................................................................................ 599 
Hide Submix/AUX Busses .......................................................................... 812 
Hide Track ................................................................................................. 534 
Hiding and displaying tracks ....................................................................... 147 
Horizontal movement of a range ................................................................. 104 
Hotspot...................................................................................................... 562 
Housing Selection ...................................................................................... 766 
HQ (high-quality) models (Room A/B & Hall A/B) ......................................... 743 
Humanize................................................................................................... 262 
Hybrid Audio Engine..................................................................................... 28 
Hybrid Engine and economy tracks ............................................................ 428 
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Ignore All Tempo Markers / Use Project Tempo .................................. 519, 591 
Import AAF/OMF ........................................................................................ 441 
Import as Dump ......................................................................................... 446 
Import Audio .............................................................................................. 446 
Import Audio CD Track(s)…................................................................ 448, 777 
Import Audio DVD .............................................................................. 448, 780 
Import, record, edit..................................................................................... 242 
Importing MIDI data.................................................................................... 242 
Impulse response ....................................................................................... 641 
Impulse response resolution ....................................................................... 645 
Independence .............................................................................................. 39 
Indices (Track markers)............................................................................... 787 
Initial navigation in the virtual project (VIP) ..................................................... 80 
Input .......................................................................................................... 533 
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Input level – VANDAL and the real world .....................................................748 
Insert ..........................................................................................................515 
Insert Grid Position Marker..........................................................................519 
Insert New Notes ........................................................................................285 
Insert New Tracks.......................................................................................531 
Insert Notation Symbols..............................................................................286 
Insert Objects .............................................................................................546 
Insert Several Tracks… ...............................................................................531 
Insert Silence ..............................................................................................517 
Insert Tempo Change .................................................................................518 
Insert Time Signature Change .....................................................................518 
Insert Track Effect Settings .........................................................................537 
Insert Track(s) .............................................................................................531 
Installation ....................................................................................................18 
Installing VST plug-ins.................................................................................312 
Instruments with multi-channel outputs .......................................................319 
Integrating CD tracks as objects into VIP.....................................................124 
Integrating external synthesizers..................................................................184 
Integrating sections from wave projects as objects......................................123 
Integrating wave files as objects in the VIP ..................................................123 
Internal block length....................................................................................644 
Invert ..........................................................................................................598 
Invert Phase................................................................................................677 

J 

JLCooper MCS-3800..................................................................................385 
Jumping to and playing from marker positions ............................................148 

K 

Keep Current Number (Tracks, AUX and Submix Buses) .............................469 
Keyboard, Menu & Mouse...........................................................................481 
K-Metering .................................................................................................803 

L 

L/R Oscilloscope (phase correlation): ..........................................................806 
Latch mode ................................................................................................331 
Latency ......................................................................................................429 
Latency comparison ...................................................................................429 
Launch Remix Agent...................................................................................565 
Learn controller for plug-in/mixer elements ..................................................372 
Leaving a range ..........................................................................................103 
Left / Right mode........................................................................................510 
Left/Right Move in Page/Scroll Mode ..........................................................585 
Length of the impulse response ..................................................................645 
Length Q ....................................................................................................556 
Level fader..................................................................................................430 
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LFE settings ............................................................................................... 227 
Link curves with objects ............................................................................... 77 
Link objects on active track .......................................................................... 78 
Link objects on all tracks .............................................................................. 78 
Link objects until pause ................................................................................ 77 
Link VIP Q and MIDI editor Q ........................................................................ 33 
Linking objects ........................................................................................... 134 
List Export.................................................................................................. 456 
LiViD - Little Virtual Drummer ...................................................................... 204 
Load Audio File .......................................................................................... 444 
Load files from the file manager into projects .............................................. 141 
Load MIDI File ............................................................................................ 447 
Load plug-ins at master level ...................................................................... 314 
Load plug-ins at object level ....................................................................... 314 
Load plug-ins at track level ......................................................................... 314 
Load software instruments ......................................................................... 313 
Load Track Effect Settings.......................................................................... 537 
Load Video File........................................................................................... 447 
Load/Import ............................................................................................... 444 
Loading routing settings with software instruments ..................................... 314 
Lock .......................................................................................................... 430 
Lock all audio in time.................................................................................... 77 
Lock channel position................................................................................. 227 
Lock Objects.............................................................................. 131, 480, 549 
Logic Control ............................................................................................. 389 
Logic Control XT ........................................................................................ 394 
Loop .......................................................................................................... 122 
Loop Designer............................................................................................ 202 
Loop Mode ................................................................................................ 576 
Loop recordings ........................................................................................... 86 
Looping objects ......................................................................................... 136 
Loudness Adaption .................................................................................... 605 
LR Wave -> 1 Mono ................................................................................... 452 
LR Wave -> 2 Mono ................................................................................... 452 

M 

Mackie Control ........................................................................................... 395 
Mackie Control XT ...................................................................................... 400 
MAGIX Plug-ins ................................................................................... 187,698 
MAGIX Synths ............................................................................................ 205 
Main Toolbar .............................................................................................. 809 
Main Toolbar 2 ........................................................................................... 810 
Make CD.............................................................................................. 95, 781 
Manager..................................................................................... 138, 419, 809 
Manager/Docker .................................................................................. 50, 809 
Manipulate Range .............................................................................. 414, 519 
Manipulating the Tempo Marker in Timestretch Mouse Mode...................... 310 
Marker Manager ................................................................................. 147, 591 
Marker on Range Borders .......................................................................... 587 
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Marker view and selection...........................................................................148 
Markers ......................................................................................105, 430, 587 
Master automation......................................................................................335 
Master Effects ..............................................................................................94 
Master Routing ...........................................................................................468 
Master Section ...........................................................................................165 
Matrix Editor (Piano Roll Editor) ...................................................................266 
Matrix Mode ...............................................................................................234 
Maximize Track...........................................................................................534 
Media link ...................................................................................................470 
Media link/video setup ................................................................................358 
Menu reference...........................................................................................438 
Methods for Working with Objects ..............................................................123 
Metronome...................................................................................................44 
Metronome Active.......................................................................................519 
Metronome Options… ................................................................475, 491, 519 
Metronome Settings .....................................................................................84 
Microphones...............................................................................................767 
MIDI Bouncing ............................................................................................461 
MIDI cc setup: ............................................................................................745 
MIDI Clock..................................................................................................348 
MIDI Controller Automation .................................................................339, 599 
MIDI Controllers ..........................................................................................338 
MIDI Editor Shortcut Keys ...........................................................................298 
MIDI Editor... ......................................................................................247, 545 
MIDI Functions............................................................................................253 
MIDI Humanize Q........................................................................................555 
MIDI in Samplitude......................................................................................242 
MIDI Input Q (global) ...................................................................................557 
MIDI Machine Control (MMC) ......................................................................352 
MIDI Metronome...........................................................................................85 
MIDI Note Quantize (Standard) ....................................................................555 
MIDI Object ................................................................................................430 
MIDI Object Editor ......................................................................................244 
MIDI Options... ...........................................................................................487 
MIDI Panic – All Notes Off ...........................................................................597 
MIDI Quantize Settings................................................................................556 
MIDI Record Mode......................................................................................596 
MIDI Recording.............................................................................................88 
MIDI score settings .....................................................................................291 
MIDI setup ............................................................................................31, 242 
MIDI Velocity Dynamics… ...........................................................................682 
MIDI-Editor – Move events ..........................................................................249 
Minimize None ............................................................................................534 
Mix to file while recording............................................................................166 
Mix with Clip ...............................................................................................516 
Mixer ....................................................................................92, 112, 158, 796 
Mixer effects .................................................................................................94 
Mixer keyboard shortcuts............................................................................159 
Mixer operation with mouse and keyboard ..................................................159 
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Mixer overview ........................................................................................... 158 
Mixer setup ................................................................................................ 468 
MMC Modes .............................................................................................. 352 
MMC Setup................................................................................................ 487 
Mode 1/Mode 2/Switch Modes .................................................................. 491 
Mode switching............................................................................................ 30 
Modulation effects...................................................................................... 752 
Modulation/Special..................................................................................... 678 
Monitoring.................................................................................. 323, 430, 585 
Monitoring Settings .............................................................................. 27, 474 
Mono / Stereo Convert ............................................................................... 452 
Mono Effect Processing.............................................................................. 538 
Monophonic voice ...................................................................................... 650 
Mouse mode.............................................................................. 270, 431, 505 
Mouse mode bar .......................................................................................... 69 
Mouse Mode Samplitude 4.0........................................................................ 70 
Mouse Mode Toolbar ................................................................................. 810 
Move and transpose................................................................................... 285 
Move automation curve with audio/MIDI data.............................................. 343 
Move objects ............................................................................................. 560 
Move play cursor........................................................................................ 418 
Move Play Cursor ....................................................................................... 585 
Move Range End Left ................................................................................. 520 
Move Range End Right............................................................................... 520 
Move Range Start Left................................................................................ 519 
Move Range Start Right ............................................................................. 520 
Move/edit objects/crossfade....................................................................... 416 
Moving audio material below the object ...................................................... 137 
Moving objects................................................................................... 126, 560 
Moving to a defined position....................................................................... 133 
MP3 with external encoder ......................................................................... 450 
MP3... ........................................................................................................ 450 
MPEG... ..................................................................................................... 450 
MS-Processing........................................................................................... 223 
MTC (MIDI Timecode)................................................................................. 349 
Multi object editing (MO-Editing) ................................................................. 280 
Multiband Dynamics ................................................................................... 613 
Multiband stereo enhancer ......................................................................... 673 
Multifunction input field with help-function............................................... 40, 78 
Multi-language version – one EXE for all languages ....................................... 44 
Multiple Object Selection ............................................................................ 604 
Multi-track recording .................................................................................... 87 
Multi-track selection ..................................................................................... 43 
Multi-voice notation .................................................................................... 289 
Mute Objects ..................................................................................... 128, 549 
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Navigation/Favorites ................................................................................... 139 
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Network installation - Program installation .....................................................23 
New AUX Bus.............................................................................................531 
New Folder Track .......................................................................................531 
New MIDI Object ........................................................................................545 
New MIDI object in the range ......................................................................546 
New MIDI Track ..........................................................................................531 
New Object ................................................................................................573 
New Submix Bus ........................................................................................531 
New Surround AUX Bus..............................................................................532 
New Surround Bus .....................................................................................531 
New Synth Object.......................................................................................546 
New Virtual Project (VIP) .............................................................................439 
New wave project via drag & drop...............................................................110 
No automatic record stop in MTC input mode.............................................349 
No effect (Track) .........................................................................................598 
No indices on Object Crossfades ................................................................789 
Non-destructive wave editing ......................................................................110 
NonLin........................................................................................................742 
Normal Object Mode.....................................................................................77 
Normalize ...................................................................................................603 
Normalize (Quick Access)............................................................................605 
Notation symbol .........................................................................................295 
Note allocation in multiple systems..............................................................287 
Note display ...............................................................................................266 
Note editor modes - Linear view..................................................................282 
Note On Chasing ..........................................................................................33 
Note parameters.........................................................................................285 
Note system settings ..................................................................................291 
Notes concerning offline effects editing .......................................................600 

O 

Object (*.OBJ).............................................................................................442 
Object Automation......................................................................................334 
Object Background Color…........................................................................563 
Object Border Left ......................................................................................586 
Object Border Right ....................................................................................586 
Object Color/Name.....................................................................................563 
Object Editor... ...........................................................................114, 431, 545 
Object Effects .....................................................................................116, 557 
Object End to Play Cursor Position .............................................................562 
Object Foreground Color….........................................................................563 
Object Handles ...........................................................................................125 
Object Hotspot to Play Cursor Position .......................................................561 
Object Lasso ..............................................................................................558 
Object Manager... ...............................................................................144, 573 
Object Menu.......................................................................................415, 545 
Object Mode...........................................................................70, 77, 508, 513 
Object Name... ...........................................................................................563 
Object step size 1 .......................................................................................562 
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Object step size 2 ...................................................................................... 562 
Object Synths ............................................................................................ 188 
Object to Original Time Position.................................................................. 562 
Object view and selection ........................................................................... 144 
Object/Curve Mode ...................................................................................... 70 
Object/Fade step size................................................................................. 560 
Object-based Surround panning................................................................. 227 
Object-oriented .......................................................................................... 431 
Object-oriented audio editing...................................................................... 113 
Objects in the virtual project (VIP).................................................................. 91 
Off mode.................................................................................................... 330 
Offline effects ............................................................................................... 92 
Offline effects calculation in wave projects .................................................. 602 
Offset ................................................................................................. 262, 552 
OGG Vorbis................................................................................................ 451 
Open.......................................................................................................... 412 
Open Manual… .......................................................................................... 820 
Open MIDI Editor........................................................................................ 247 
Open Project .............................................................................................. 440 
Open Score Editor...................................................................................... 282 
Options administration................................................................................ 483 
Options administration/Remote/User administration...................................... 42 
Options for automatic pitch correction ........................................................ 656 
Options for loading audio files..................................................................... 445 
Options management ................................................................................... 44 
Oscilloscope: ............................................................................................. 804 
Overdrive/Distortion.................................................................................... 751 
Overdub (MIDI Record Mode) ..................................................................... 596 
Overlapping Objects................................................................................... 134 
Overlapping two objects via the keyboard shortcut ..................................... 134 
Overview Mode .......................................................................................... 814 
Overwrite mode.......................................................................................... 331 
Overwrite with Clip ..................................................................................... 516 

P 

Page format settings .................................................................................. 296 
Pan ............................................................................................................ 117 
Pan setup .................................................................................................. 236 
Pan/Surround Editor (Stereo-Panorama-Dialog) .......................................... 543 
Panning law mode...................................................................................... 232 
Panorama modes in the Surround panorama module.................................. 230 
Parameters for stereo manipulation ............................................................ 675 
Parametric EQ............................................................................................ 621 
Paste Track(s) ............................................................................................ 533 
Paste with Time/Ripple ............................................................................... 516 
Paste/Insert Clip......................................................................................... 515 
Patch List................................................................................................... 773 
Peak Meter ................................................................................................ 800 
Phaser ....................................................................................................... 686 
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Pitch (fundamental frequency) .....................................................................657 
Pitch automation without change in length ..................................................661 
Pitch correction (intonation correction) with monophonic audio material.......661 
Pitch slice objects and VIP objects..............................................................659 
Pitchshift/Timestretch Mode..................................................................71, 511 
Plate...........................................................................................................741 
Play ............................................................................................................418 
Play and Monitor Instruments Live...............................................................323 
Play Cursor.................................................................................................431 
Play Cut..............................................................................................418, 574 
Play from cut end (out point) .......................................................................575 
Play in Range/Loop.....................................................................................574 
Play into Cut ...............................................................................................575 
Play Loop ...................................................................................................574 
Play Once...................................................................................................574 
Play Only Selected Objects .........................................................................574 
Play over cut/crossfade ..............................................................................575 
Play to cut end (out point) ...........................................................................575 
Play to cut start (in point) ............................................................................574 
Play with Preload ........................................................................................574 
Playback control .........................................................................................658 
Playback Menu ...........................................................................................574 
Playback Mode...................................................................................418, 576 
Playback Options........................................................................................470 
Playback Parameters ..................................................................................578 
Plug-in Menu Functions ..............................................................................321 
Plug-in Panel - Graphical Interface ..............................................................319 
Plug-in Parameter Dialog ............................................................................320 
Plug-ins and EQ..........................................................................................117 
Plug-ins at track, object, and master level ...................................................217 
Plug-ins pre or post ....................................................................................175 
Position bar 1 ...............................................................................................75 
Position bar 2 ...............................................................................................76 
Position/Fades............................................................................................119 
Positionbar .................................................................................................810 
Positionbar 2 ..............................................................................................810 
POW-r Dithering/Smart Dithering ................................................................499 
Pre & Post Gain ..........................................................................................762 
Preamp Channels .......................................................................................761 
Pre-delay....................................................................................................642 
Preparing a MIDI recording ...........................................................................88 
Preparing to record.................................................................................82, 88 
Preset keyboard shortcuts ..........................................................................412 
PreSonus FaderPort ...................................................................................401 
Preview audio files ......................................................................................140 
Print notes ..................................................................................................297 
Process Effects Offline ................................................................................776 
Process Only Left/Right Stereo Channel......................................................776 
Program interface – Overview .......................................................................47 
Program Preferences ..................................................................................474 
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Project and Mixer Configuration.................................................................. 468 
Project Auto Save… ................................................................................... 470 
Project Information….................................................................................. 471 
Project options ..................................................................................... 34, 486 
Project Properties............................................................................... 412, 467 
Project Status…......................................................................................... 471 
Project Surround setup............................................................................... 225 
Punch / Playback bar ................................................................................... 68 
Punch Marker Mode................................................................................... 581 
Punch recording with markers ...................................................................... 86 
Punch/Playbar............................................................................................ 810 
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Q grid/Q length .......................................................................................... 260 
Q Threshold ....................................................................................... 261, 554 
Q Window .......................................................................................... 262, 554 
Quantization ............................................................................................... 550 
Quantization - window view ........................................................................ 259 
Quantization in the Drum Editor .................................................................. 272 
Quantization Setting - Soft Q ...................................................................... 552 
Quantization Settings ................................................................................. 259 
Quantize .................................................................................................... 258 
Quantize Note Ends to Grid ........................................................................ 556 
Quantize object position (AQ)...................................................................... 552 
Quantize object position (hard) ................................................................... 552 
Quantize Settings - Grid ............................................................................. 554 
Quick Access ............................................................................................. 605 
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Rack Effects (FX1/FX2) ............................................................................... 768 
RAM Wave (*.RAP) ..................................................................................... 440 
Randomize MIDI Velocity ............................................................................ 682 
Range ................................................................................ 413, 431, 510, 519 
Range All ................................................................................................... 519 
Range Bar.................................................................................................... 76 
Range Bouncing (Internal Mixdown) ............................................................ 460 
Range Editor…........................................................................................... 530 
Range end to right marker .......................................................................... 521 
Range End to Right Object Border.............................................................. 521 
Range Length............................................................................................. 522 
Range Manager… .............................................................................. 149, 523 
Range Mode ........................................................................................ 69, 507 
Range Not Over Tracks .............................................................................. 522 
Range Over All Selected Objects ................................................................ 522 
Range Over All Tracks ................................................................................ 522 
Range Over Current Track.......................................................................... 522 
Range start to left marker ........................................................................... 521 
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Range Start to Left Object Border ...............................................................521 
Range to Beginning ....................................................................................520 
Range to End .............................................................................................520 
Rangebar....................................................................................................810 
Ranges.......................................................................................................102 
Read Mode.................................................................................................330 
Real Audio... ...............................................................................................451 
Real time effects ...................................................................................92, 419 
Real-time effects at track, object, and master level ......................................185 
Rebuild Graphic Data..................................................................................811 
Recall Last Range.......................................................................................523 
Recall Last Stop Position ............................................................................586 
Recent File .................................................................................................504 
Record .......................................................................................422, 475, 580 
Record Mode/Punch In...............................................................................580 
Record offset................................................................................................32 
Record Options ..........................................................................................582 
Record Pause.............................................................................................582 
Record without Playback ............................................................................581 
Recording...................................................................................................539 
Recording and playing back an instrument ..................................................323 
Recording automation in .............................................................................341 
Recording MIDI tracks ................................................................................242 
Recording/playback....................................................................................112 
Remix Agent ...............................................................................................220 
Remix objects in .........................................................................................568 
Remote Control ..........................................................................................772 
Remote Parameters (Vandal).......................................................................770 
Remove All Indices .....................................................................................789 
Remove DC Offset (Offline)..........................................................................672 
Remove Index.............................................................................................789 
Remove Object Gaps..................................................................................553 
Remove Range ...........................................................................................522 
Rename Marker ..........................................................................................588 
Rename Project... .......................................................................................463 
Repeat Last Position(s) ...............................................................................586 
Replace ......................................................................................................597 
Replacing an audio file below the object......................................................137 
Resampling / Time Stretching / Pitch Shifting ..............................................647 
Resampling Quality Options….....................................................................502 
Resampling/Bouncing.................................................................................483 
Reset Audio Object Quantization.................................................................553 
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